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A-1 Introduction to SGO Mistika

The all-in-one solution for top-of-the-range post-production

SGO Mistika provides a comprehensive set of integrated tools that covers all standard post-
production needs:

Multilayer SD / HD / 2K / 4K editing in real time

Specialized conforming  tools,  for both  video-tape  and  tapeless  cameras,  based  on
digital files

Image  restoration  and  elimination  of  grain  &  noise,  including  Motion  Estimation
techniques and a Paint tool

Advanced color correction, with support  for top-of-the-range  control surfaces  and
4K formats in real time

Composing in true 3D settings and with 3D camera

Finishing and presentation to the client

Multimastering to all standard formats 

Planning for post-production projects

Stereoscopic production

SGO Mistika's standard system offers a dedicated interface for each of these tasks, thanks
to its integrated design but  can also evaluate them all interactively and constantly in their
global contexts. 

For example,  a  colorist  can carry  out  all  color correction of  a  large-scale  project  without
needing  to  use  any  other tools  than those  for  color  correction,  whilst  at  the  same  time
viewing the effect this has on the overall composition being carried out by other users. 

As another example, if  an editor wishes to change an edit, the changes made will instantly
be made in the composition and grading.

What's more, the system can, at any time, receive new EDL's and re-conform the montage,
automatically resetting effects to new positions and durations.

Added  to  this,  the  system  supports  all  the  commonest  formats  on  the  market  ,  and
therefore  Mistika  is  the  perfect  system to  use  in  the  production  center,  organizing  and
supplying material to other applications and integrating the results in the master. It  accepts
these formats: HDCAM-SR, RED R3D, Alexa .ari, Phantom .cine, SI2K/Cineform,  DVCPro-HD,
MXF,  AAF,  AVC-I,  Apple  Prores...;  it  can  generate  these  file  types:  DPX,  EXR,  MXF,
Quicktime .mov, AVI, DPX, etc  -  the  list  of  profession formats  that  Mistika  can support  is
endless. 

Similarly,  the  fully  integrated  image  restoration  and  noise-elimination  tools  permits  the
creation  of  specific  versions  in  order  to  carry  out  more  accurate  motion  tracking  when
employing  effects,  can  improve  the  results  of  the  chroma  key  tool  and  provide  richer
chromatic ranges for secondary color correction. By allowing collaboration between users of
each tool, SGO Mistika can achieve results that are impossible on other systems.
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With its open architecture, intuitive interface and capacity for upgrading the system, SGO is
a cost-effective solution for whoever needs the flexibility to produce all kinds of job in any
format: film, advertising, TV series, video-clips, documentaries  and  so  on -  a  system that
can adapt to any situation. 

SGO Mistika is available Linux 32bit  and 64bit  systems. Owing  to  its  features,  stability  and
flexibility, Linux is the most used OS in high-end post-production.

Any kind of job in all formats

SGO  Mistika  is  totally  configurable  in  terms  of  resolution,  frame  rate,  aspect  ratio,
interlaced,  and  color  spaces,  supporting  with  total  user  transparency  any  jobs  from
standard to stereoscopic.

Jobs in any format can be done in the same Node Graph, in a non-destructive environment,
where it is possible to modify and animate any parameter. 

It provides maximum quality conversion between SD, HD, 2K and 4K formats in real time. 

It has hardware support  options to cover all the standard formats, such as PAL/NTSC SDI,
HD SDI 4:2:2,  HD Dual link RGB 4:4:4,  2K DVI realtime  outputs,  and  optionally  in  4K,  and
even stereo 3D dual HD SDI outputs. 

Fully open and integrable in any infrastructure

SGO  Mistika’s  open  architecture  allows  it  to  integrate  natively  with  networks  and  SAN
storage solutions. 

It  can share  all  standard  format  files,  without  need  to  Import/Export,  to  collaborate  with
other open systems. 

When the material derives from digital files, (such as film scanners, cameras which record to
hard drives, etc), SGO Mistika can integrate with any DPX workflow, and thus can carry out
render processes imitating the structure of the original files. 

Hence,  SGO  Mistika’s  render  process  creates  a  directory  tree  which  is  identical  to  the
original, with the same file names, numbering and even replicating the original DPX headings.
In this way, intermediate processes that  either adapt  themselves to  the  standard  of  each
infrastructure,  or that  imitate  structures  required  by  less  flexible  systems,  can be  carried
out.
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Intuitive and integrated interface for immediate results

With  SGO  Mistika's  gesture  recognition  system,  Scribe,  the  user  has  access  to  the
commonest commands with simple movements of the optical pointer.

SGO Mistika’s  Node  Graph  acts  as  an open workspace  in  which the  user  can  experiment,
collaborate with other systems and create different  version of the same project. The Node
Graph is a working structure which is flexible in three dimensions:

Horizontal: time.

Vertical: unlimited audio/video tracks, organization of multiple version and structuring
of effects stacks.

Depth:  nestable  groups  through  which  the  user  can  navigate  and  improve  the
organization  of  the  project.  Each  group  gives  access  to  another  complete  Node
Graph.

While  the  traditional  timeline  of  other  systems  is  only  efficient  for  perfectly  planned
projects,  SGO  Mistika’s  Node  Graph  is  designed  to  allow  experimentation,  improvisation,
encouraging  the  user  to  try  alternatives,  collaborate,  and  re-use  effects  or  previous
sections,  thus  allowing  the  structuring  of  each  project  according  to  its  particular
requirements.

SGO Mistika also allows the commonest  effects to be grouped in  a  non-destructive  way  in
order to create complex patterns safely and smartly. 

With the Graffiti tool, the user can even draw on Node Graph  with  the  pointer in  order to
make complex projects easier to understand and facilitate communication with other users. 

The scalability  of  the  interface  allows  the  user to  work on a  laptop  for looking  at  screen
rushes at one end of the scale and on two 2600x1560 monitors to work in 2K at  a scale of
1:1, or to view complicated effect flows more comfortably. 

Taking care of image quality

The top priority for SGO Mistika's developers has been image quality. 

For professionals in the production field, the real differences between different  systems  lie
the details and in the quality of the algorithms at  the  heart  of  the  system,  rather than in
stunning  accessories  or  overwhelming  branding,  despite  what  the  Marketing  departments
might say!

Thus, the SGO Mistika teams  have been continuously working and  developing  the  product
since  1993,  paying  particular attention to  producing  exclusive  and  top-quality  algorithms:
uncompressed  processing,  advanced  dithering,  3D  LUTS,  real  processing  in  16  bits  per
channel,  HDR support,  support  for resolutions  of  8K  and  above,  noise  &  grain  elimination
through Optical Flow  (Motion Estimation)  techniques,  HD-SDI dual link RGB 10bit  outputs,
Pan&Scan based on Fourier mathematics with optical quality, etc. 

The developers  have  always  borne  in  mind  the  physical media  from which the  images  are
derived,  be  they  negative,  video  or  graphics,  etc.  Hence  SGO  Mistika  provides  genuine
native  support  for  multiple  color  spaces  YUV,  RGB  linear  and  logarithm,  HDR,  XYZ,  and
specialized tools for transforming between the same. 

Extreme features

Thanks  to  the  hybrid  CPU+GPU  64  bits  processing  system,  all  the  basic  post-production
tasks  can be  carried  out  simultaneously  in  real time:  advanced  color  correction  for  each
layer, optical quality Pan&Scan, Composition in 3D environments with antialiasing and Motion
Blur, Motion Estimation Timewarps, Fades and Wipes (even in 2K), Chroma Key, Channels &
Booleans,  Gaussian  Focus  and  Blur,  Titling,  Paint,  Relief,  Morph  &  Warp,  conversions
between color spaces, etc, with many of  these  working  simultaneously  in  real time  in  HD;
 the  combined  results  can  be  transferred  directly  to  tape  without  needing  to  carry  out



12 Introduction to SGO Mistika

SGO Mistika 8.6 © 2018 SGO

render processes. 

In contrast to other systems, SGO Mistika has few processes that  cannot  be carried out  in
real time;  and  even in  these  cases  (such  as  image  restoration,  or  grain  reduction  in  4K
formats via Optical Flow (Motion Estimation)) processing by Hardware GPU is also available,
resulting in reasonable processing times which can be generally used in real production. 

When SGO’s Open Storage features (up to 5 Gigabytes/s for each workstation) are added to
the equation, the system's features are stunning. 

For example,  a  single  4K SGO Mistika  workstation without  associated  render nodes  allows
the  user  to  view  DPX  4K  10bit  images  without  compression,  carry  out  a  primary  and
secondary  color correction,  apply  3D LUT,  carry  out  Pan  &  Scan,  and  even  convert  the
result a HD for its previewing or mastering onto tape in real time. 

Furthermore,  SGO  Mistika  working  in  a  SAN  avoids  slow  transfers  of  material  between
"modules" or applications. 

Optimizing  costs

SGO Mistika  technology  is  provided  only  on a  bespoke  basis,  and  the  client  pays  only  for
what  is required; thus it  can be used in all types of  configurations:  from a  laptop  for field
work  and  viewing  film rushes,  up  to  systems  of  4K+ capacity  with  multiple  disk  arrays,
multiple monitors and color correction surfaces;  it  also  combines  with  low-cost  "Assistant"
systems to share storage and SDI video hardware. 

Having  the  capacity  to  resolve  all  the  usual  task  fields  in  post-production  and  DI,  this
technology is tremendously cost-effective, whatever the type of workload required week on
week.

By eliminating dedicated Hardware, maintenance and updating costs are reduced, since SGO
Mistika  is  based  in  workstations  and  standard  Fiber  Channel  storage  and  in  the  GPU
processor of NVIDIA cards.
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B-1 Conventions used in this document

This section sets out the conventions used throughout this document.

References to files

References to the name of an existing file on system hard-disk, to a  file  extension,  to  the
name of a directory, to the name of an executable file, or to the literal description of a file’s
contents  are  shown  in  red  italics.  For  example,  /MATERIAL  refers  to  the  /MATERIAL
directory. 

References to keys

Key references use Caps and green italics surrounded by the symbols <>. For example: <A>
 refers to  the  key  “a”.  A  combination of  keys  is  shown separated  by  the  symbol “+”.  For
example:  <Ctrl>+<A>  means  pressing  the  keys  “control”  and  “a”  at  the  same  time.
Additional keys and mouse buttons are shown below: 

<Ctrl> = Control key. 

<Shift> = Shift key. 

<Alt> = Alt key. 

<Space> = Space bar. 

<LeftClick> = Click with the left mouse button. 

<RightClick> = Click with the right mouse button. 

<CenterClick> = Click with the middle mouse button. 

<Drag> = Drag with the mouse.

References to documents

References to other chapters within this documentation or to other documents is shown in
blue and underlined.

For example, References to keys, refers to the previous chapter.

References to menus, panels and buttons

References to menu options, panels and panel buttons are shown in grey, and the menu or
panel navigation route is shown with the symbol  "->"

For example:

FX->Comp3D, refers to the Comp3D button in the FX Panel.

Some buttons have their name superimposed and others have an icon. All Mistika icons have
an associated name (these names can be superimposed on the icons via the middle mouse
button). These options are named in the same way in this document. 

Mistika  SGO has  different  types  of  buttons:  command,  drop  down,  state  and  multi  state.
Drop down and multi state buttons show all their options between square brackets and the
selected option between normal brackets .

Example:

The different possibilities of the Notes button are referred to in Edit->Notes[Create,
Delete Stroke, Delete Note, Delete All Notes].

Example:



16 Conventions used in this document

SGO Mistika 8.6 © 2018 SGO

To create a note in the Node Graph, activate the Node Graph Editor->Dashboard-
>Edit->Edit->Notes->Create option.

When  dealing  with  a  state  button  (it  may  be  on  or  off),  the  state  is  also  indicated  in
brackets.

Example:

Edit->Setup->Flow Monitor(On).

References to literals

References  to  Mistika's  interface  parameters  or  to  literals  related  to  the  application,  are
highlighted in blue-green italics.

For example, Primary refers to an option called "Primary" in the software interface.

Parameter Description

In  descriptions  of  effect  parameters,  a  short  description  of  default  values  is  shown.  For
example, the following value: 

[25 (0 /100)]

The syntax should be interpreted as follows: 

[Default (Minimum / Maximum)] 

Square brackets "[]" show the start and end of the parameter description. 

The  first  numbers   those  outside  the  round  brackets   show  the  default  value  (in  this
case, 25). 

Some of the default  values are animated. These default  values use a colon ":" to separate
the initial value from the final value.

For example, for the Grade parameter of a wipe: [0:100 (0 / 100.000)] 

When values are separated by a semicolon ";", this indicates that  the parameter has a set
of associated values, and each default value is differentiated from the following one by this
symbol (such as RGB values, and spatial coordinates).

For example, the description of the RGB parameters of the Solid effect  values is: [0;0;0 (0
/100)] 

The associated values in the description have a common valid range. 

Round  brackets  "()"  show  the  start  and  end  of  the  range  description  valid  for  the
parameter. The forward slash "/" separates the first number (the minimum) from the second
(the maximum). 
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C-1 Working environment

The  basic  concepts  needed  to  understand  Mistika’s  working  environment  are  described  in
the following sections, together with the use of its basic elements.

Software Installation

Mistika  systems  are  usually  delivered  completely  configured,  but  if  it  is  necessary  to  re-
install the existing system or a new one, follow the steps below:

Request  the  latest  version of  the  installation DVD for  Mistika  from SGO.  This  DVD
allows  installation  of  the  operating  system,  the  Mistika  software,  and  many
recommended complements. This tool also carries out  an automatic  configuration of
all  the  important  parameters,  and  is  the  only  recommended  method  for  the
installation of a system with Mistika.

In the case of serious problems,  a  complete  reinstallation can be  carried  out  later.
Before doing so, however, save the following configuration files:

All the files in the directory /usr/cvfs/config 

To  save  work  done  in  a  later  configuration,  take  note  of  the  network
configuration (address, IP etc), and of the edit points defined in /etc/fstab 

The Mistika licensing file /var/flexlm/MistikaV5.dat 

Before  installing  the  DVD,  disconnect  all  the  storage  systems  except  the  current
system disks, otherwise the installer might suggest  installing the operating system in
the  largest  disk  (usually  the  disk  array),  which  would  destroy  all  the  existing
information, were the user to accept this prompt by default.

For systems using z800, first  set  the BIOS as indicated  below  (it  is  essential  that  these
values are correctly set for the performance of the system). To do this, reboot  and go to
BIOS (F10->Setup). If the default  language is  not  English,  change  it  via  F8 so  that  the
names of the parameters coincide and set them so that they are as follows:

OS->RuntimePowerManagement DISABLE

OS->MWAIT-WavareOS DISABLE

OS->IdlePowerSavings NORMAL

HARDWARE->SATA PowerManagement DISABLE

HARDWARE->Intel Turbo boost technology ENABLE

HARDWARE->EnhancedIntelTurboBoost ENABLE

Note:  The  EXACT  name  may  vary  depending  on  which  version  of  the  BIOS  is
employed and which languages re selected.

Once  installed,  recover the  configuration  files  mentioned  above  (in  the  case  of  a
reinstallation), and download the latest available upgrade at www.sgo.es

Before requesting the Mistika licence, check that  the operating system has at  least
an ethernet network card by, for example, running the following commands:

su -
ifconfig

When this command is run, information regarding the eth0 interface should appear. If
it does not, request the driver for the ethernet card from the hardware provider.

For systems with  only  one  interface  monitor (usually  "OnSet" systems),  deactivate
the option MistikaSetup->Interface->Dual Monitor.
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Starting a session

To startup the system, remember that all the peripherals need to be started first; only once
all pilot lights are stable (the disk array may take up to a minute) should the machine finally
be started. 

Once the system has been started up, the first  step is to access the user account  where
Mistika  was  installed.  To  access  an  account,  simply  double-left-click  on  the  required
account  icon  (the  user  Mistika  in  the  illustration).  Next,  if  the  account  has  an  access
password,  this  should  be  keyed  in,  followed  by  <Enter>.  A  working  session  will  then  be
started in the selected account.

Finally, open Mistika Setup to choose a working preset, or open Mistika to begin the session.

Note: The account   “root” refers to the system's super user, and  should  only  be  used  for
system installation and administration.

Ending a session

Modern workstations  can be  shut  down  by  pressing  the  start  button.  This  automatically
carries  out  the  correct  shutdown routine  before  switching  off.  Older  systems  require  the
manual selection of the "Shutdown System" from a menu. If there are any doubts, first  refer
to the hardware provider, since direct shutdown could cause system failure.

Once the workstation has been switched off, the disc  arrays and other peripherals can also
be powered down.

If the system does not  respond and it  is necessary  to  force  the  shutdown of  Mistika,  the
following actions:

On a Linux console, type:

killall -9 Mistika

Mistika  normally  saves  the  active  environment  with  the  name  crash.env,  and  then
closes.

If  this  does  not  work,  press  <Ctrl>+<Alt>+<Backspace>  to  force  restart  of  the
graphics system, without needing to reboot the machine. 

In extreme cases, it may be necessary to force a shutdown of the system by holding
the  "Power"  button  for  five  seconds.  However,  this  method  may  cause  the  loss
recent open files, and should only be used as a last resort. 

The desktop and its tools

Once  the  user is  identified  by  the  system,  Mistika  shows  the  interface  of  the  operating
system. This consists of a desktop where the tools are shown as icons.

The most important tools that appear in the user interface of Mistika are:

Mistika Setup

Mistika configuration, including the format  of the image to be produced and  the  type
of video format to be used in the next session

Mistika

Access to Mistika. Mistika can also be accessed by typing "Mistika" in a Linux console.
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Help

Mistika Documentation

Accessing Mistika

Mistika is the heart of the system. It is the space within which both editing and composition
take place. From within Mistika, the rest of the tools referred to here are accessed; thus it
is the environment in which the user will  usually work. 

The desktop icon

Autodetection of Layout for the work resolution

Mistika automatically detects the maximum resolution of the graphics card and  adjusts  the
"Layout" to this resolution. 

The only variable that must be borne in mind whether to work with one or two monitors. In
both  cases,  Mistika  automatically  adjusts  the  "Layout".  To  choose  between  one  or  two
screens, go to Mistika Setup->Interface->Two Monitors [On,Off].

Mistika requires at least one monitor at 1920x1080, although two 24" monitors at  1920x1200
is recommended.

Another  typical  configuration  to  increase  the  workspace  is  to  use  two  30"  monitors  at
2560x1600. This configuration offers the following advantages: 

It gives more space in the TimeSpace.

It  allows  working  with  HD_1080  images  at  1:1  in  the  Visual  Editor  and  even  2K
images at 1:1 the Paint tool.

However, the size of 30" monitors makes working in spaces using projectors difficult, so it  is
not recommended in these cases.
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C-2 Selection of elements

A range of basic element selection operations exist in all Mistika’s tools. They are as follows:

Simple selection 

Left click the element to highlight the element. 

Multiple selection

Left click and drag to defines a selection area. Release the mouse button to select  all
the elements within the area. 

Additive / subtractive selection

Allows  the  selection  or  de-selection  of  adjacent  and  non-adjacent  elements  in  a
selective way. This type of selection behaves differently according to in which Mistika
panel it is done.

In  the  Project  and  Media  tab,  it  is  possible  to  select  adjacent  elements  by
clicking the first and then, holding <Shift, clicking the last. All elements between
will be selected. To select non-adjacent elements, click each element  individually
while holding <Ctrl>. Elements can be de-selected in the same way, by  holding
<Ctrl> and clicking.

In the Node Graph, the behavior is different. Here  we  use  <Shift>  to  select  or
de-select individual elements

In the Parameters tab, <Shift> is also used for individually selecting parameters
(hold  <Shift>  down and  click  in  each  parameter  required  to  be  added  to  the
selection.  This  type  of  selection  can  be  used  to  modify  the  value  of  various
parameters  at  the  same  time,  using<Drag>+<central  button>  for  example).
<Shift> is also used to add or remove keyframes in  a  selection in  the  curve  of
the parameters.

Undo selection

Simply click in an empty space of the corresponding panel.

Selection of effect clips in the Node Graph

When selecting effect  clips bear in mind that  they consist  of two independent  parts:
the clip pastille and the range. 

By  clicking  only  on the  clip  pastille  and  moving  it  upwards,  the  range  remains  in  its
position, and the original scope of the effect  is thus increased; if, on the other hand,
it is moved downwards, the scope covered by the effect  will be reduced. This is very
useful, as it permits placing the effect  clip by dragging it  to the lowest  clip to fix the
range there and then dragging it up to include all the clips possible. 

However,  if  we  want  to  select  both  the  clip  and  its  range  in  order  to  move  them
together to a different location, remember to select an area that contains both before
moving them: it is not sufficient simply to click and drag the clip. 

Another way  to  select  both  is  to  hold  down <Shift>,  click  on  the  effect  and  click
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again on the lower line which specifies the range.
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C-3 Data fields

All the numerical values and timecodes are modifiable in the following ways:

Select  either the  whole  number (by  double-clicking  on it)  or only  the  digits  to  be
modified (by highlighting them with the mouse) and then writing in the new value. 

Left  click on the value and use the mouse-wheel to increase  or decrease  its  value
progressively.

In the Parameters tab,  simultaneously select numerous parameters by holding down
 <Shift> and then use  the  previous  method  to  modify  them all  at  the  same  time.
This can also be done using the middle mouse button. This technique can be used,
for example, to modify the X or Y position of various layers simultaneously.

Left click on the value to be modified and drag the cursor up, down, left  or right  to
increase or decrease the value. This mode is extremely useful for adjusting  effects
parameters, as the result of the modification is visible without  having to release the
mouse  button.  (This  mode  can  be  deactivated  if  viewing  is  slow  owing  to  its
complexity, in which case the effect  will not  be evaluated until the mouse button is
released or the tablet pen is lifted).

A similar method is to press the <Up> and <Down> arrows while keeping the cursor in
the field to be modified.

The method described in the previous point  can be used in combination with <Alt>,
<Shift>,  and  <Ctrl>  which  modifies  the  first  decimal  place,  the  tens  and  the
hundreds  respectively  instead  of  the  unit  value,  thus  acting  as  accelerators  or
decelerators when adjusting the parameters interactively:

° <Ctrl> + <Shift> : thousands.

° <Ctrl> : hundreds.

° <Shift> : tens.

° <Drag> : units.

° <Alt> : decimals.

° <Ctrl> + <Alt> : hundredths.

° <Shift> + <Alt> : thousandths.

By using the calculator  (see  Edit tab: Node Graph Editor->Dashboard->Edit).

The colors of the modifiable numerical values (on a black background) indicate the following:

Grey: a default value, or one that has not been modified. 

Green: a value introduced by the user or a keyframe. 

Light blue: a value interpolated between two keyframes.
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C-4 Mistika’s buttons

 Mistika has four types of buttons:

Command buttons

These are the simplest  buttons. Clicking, them or using  their related  hotkeys,  runs  a
command. For example: Node Graph Editor->Dashboard->Edit->Edit->Join.

Dropdown buttons

These have a square icon to  the  left  side.  When clicked,  a  list  with  various  options
drops down. The name superimposed in the button is always the same,  regardless  of
the  option  selected.  For  example:  Node  Graph  Editor->Dashboard->Edit->Edit-
>Notes[Create, Delete Stroke, Delete Note, Delete All Notes]

State buttons

These have two possible states activated by clicking them  (or pressing the hotkeys).
Generally  they  are  green  when  activated  and  gray  when  son  deactivated  .  For
example: Node Graph Editor->Dashboard->Edit->Setup->Show Rulers [On,Off].

Multistate buttons

These are buttons in which different variables for the same parameter can be chosen.
When clicked, a list with the possible variables appears. Once the variable is set, this
is superimposed in the button. These buttons have the name of the parameter green
and  the  name  of  the  variable  in  white.  For  example:  Node  Graph  Editor-
>Dashboard->Edit->->EditTrim  Mode  [Mode->Local,  Mode->Global,  Mode-
>Select].

All  Mistika  buttons  have  their name  or an icon superimposed  over  them.  All  Mistika  icons
have an associated name (to see this associated name simply place the mouse cursor over
the icon and click the central mouse button).

Similarly, right-clicking over a panel button shows the  associated  Hotkey,  (until  the  mouse
button is released).

Both methods show information about the button, but carry out no action.
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C-5 Keyboard Shortcuts (edition)

Mistika possesses a series of keyboard shortcuts in order to  make  the  operator's  workflow
easier to  negotiate.  They  can  be  seen  by  hovering  the  cursor  over  the  buttons  of  the
interface. The operator can personalize these shortcuts by editing them with the text  editor
file hotkeys.cfg, found here: Mistika-ENV/etc/pixmap2/hotkeys.cfg. It  is  recommendable  to
make  a  security  copy  of  the  original  file  should  be  default  values  be  required  at  a
subsequent stage. 
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C-6 Scribe (Gestural commands)

Scribe is a novel interface management technique based on the API for the development  of
data input devices.

It  allows  the  running  of  Mistika’s  different  commands  by  means  of  strokes  made  with  the
mouse or graphic tablet.

Traditionally, the graphic  tablet  has been considered the best  device for composition work,
but it is slower than the mouse and keyboard for editing work. Scribe technology gives the
tablet immediate access to a range of commands made by drawing strokes with the pen, so
that  the speed increases considerably when using the tablet,  and  thus  it  can be  used  for
editing. 

This technique also increases working speed with  the  mouse,  for which reason the  use  of
these commands is recommended in all cases. 

Activating Scribe

Scribe is activated by holding down the <Middle mouse button> and drawing a line that  is
recognizable  by  the  symbol  library  in  Mistika’s  Node  Graph.  With  the  <Middle  button>
depressed,  the  system will  recognize  the  different  strokes  that  are  made  on  the  tablet.
Pressing  any  button  or  key  at  the  same  time  as  the  <middle  button>  will  deactivate
symbol recognition.

Using Scribe with the digitising tablet

The first  step is to assign the center mouse  button to  one  of  the  pen buttons,  using  its
graphic  tablet  driver.  Next,  press  the  button  assigned  as  center,  and  draw  the  required
symbol. This will execute the command associated with the symbol drawn. 

Using Scribe with the mouse

Press  the  <Middle  mouse  button>  and  draw  the  required  symbol.  This  will  execute  the
command associated with the symbol drawn. 

Symbol library

The symbols currently recognized by Scribe are as follows:

Note: The change of color in each symbol from black to green expresses the progression in
time  of  the  symbol,  and  shows  the  start  and  end  of  each  symbol.  The  system  has
recognition tolerance that  allows the user a certain margin of error. The library consists, in
origin,  of  regular  geometric  forms,  although  they  are  illustrated  below  with  less  regular
strokes for ease of understanding. 
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C-7 Image formats and color spaces in Mistika

The  audio-visual market  offers  a  huge  number of  image  formats.  An  introduction  to  their
main characteristics and an explanation of their use within Mistika follows. Some knowledge
of their features is key to achieving the most efficient and highest quality work in Mistika. 

Preferred realtime formats: Mistika .JS y .DPX

Mistika is a high-performance system designed to work in real time, but  the correct  use  of
the file and storage system formats explained below in order to achieve the best results.

Mistika  can work directly  with  many  standard  image  formats  (TIFF,  .Targa,  Cineon,  DPX,
AVI, Quicktime, MXF, MPEG4, etc.),  without  the  need  to  convert  them to  Mistika's  native
format  (.js). To do so, simply double click in the Browser  to create Mistika's format   linked
to these media files. 

However,  many  of  these  formats  take  time  to  process,  and  may  be  out  of  order  (their
frames may not be organized consecutively on the disks, which slows reading). 

For this reason, when playout  in real time is required for a  sequence  derived  from another
format  or one  which is  not  stored  in  the  real time  disks,  it  may  be  necessary  to  convert
them to .js format via a render process, or by using .dpx as described below. 

When video  is  captured,  it  is  recommendable  to  store  it  in  the  .js  format;  when it  is  not
necessary  to  maintain  immediate  compatibility  with  other  applications  it  is  also
recommended to use this format since: 

Mistika's  .js  format  is  pre-assigned  to  consecutive  disk  blocks  and  avoids
fragmentation

Mistika's .js format is aligned to memory pages, improving performance

Mistika's  .js  format  corresponds  exactly  to  SDI  video  formats,  so  if  the  variant  is
correctly chosen information is not  lost, it  is not  necessary to convert  color spaces
and  the  size  of  the  file  does  not  increase  (and  therefore  neither does  the  related
process time) unnecessarily.

In the case of needing to work with other  applications, it  is recommended to work in "DPX"
format, since Mistika is also highly optimized to work in  real time in this format  (up to 4K if
adequate storage is available). However, follow the following recommendations:

For best  results, DPX sequences should be arranged consecutively on the  disks.  To
do this, they should come from an un-fragmented locations, and the files should  be
loaded in order via video capture, a render process, or by the command "rsync" (or
similar).

This  "rsync"  command  permits  the  rapid  copying  of  numbered  sequences  in  their
numerical  order,  as  the  continuation  of  a  previously  interrupted  copy.  These
capabilities distinguish it  from a simple copy via the graphic  interface  of  any  OS.  If
possible, never use these systems for loading  numbered  files  if  they  are  needed  to
worked on in real time, nor allow other users to copy files this way to storage via the
network,  since  in  these  cases,  it  is  probable  that  an  additional  render  process  is
required to obtain an optimized sequence. 

The recommended syntax for the command is: 

rsync -Pav SourcePath TargetPath

Generally,  the  DPX  format  only  provides  real time  performance  in  combination  with
the "Storenext SNFS" filesystem. Mistika uses the API of this filesystem to carry out
high-performance specifically for this  format, and it  is not  possible with other types
of filesystem.

The DPX format is only optimum for original RGB formats. It  is not  enough to convert
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YUV images to this format, as they may occupy up to twice the space and similarly
decrease  performance.  For  example,  the  standard  HDCAM  SRW  Stereo  format
codifies  two  YUV  422  10bit  streams,  so  its  transcodification  to  DPX  (RGB  444)
produces a great increase in the size of the file and process times.

Compression vs No compression

High-compression  formats  (MPEG,  DVHDV,  MPEG2,  MPEG4,  etc)  are  suitable  for  final
distribution of images to the consumer, but in general, if  it  can be avoided, they should not
be  used  to  import  images  into  a  post-production  system.  These  formats  give  rise  to
problems when carrying out  color corrections,  chroma  keys,  and  other effects,  since  they
provided very little information. Mistika provides tools to deal with these problems, but  the
best  results will always be obtained from material that  is  uncompressed,  or if  compressed,
with as little compression as possible.

In  general,  for video  sources,  the  highest  quality  is  obtained  through SDI  signal  capture.
However, it is a common mistake to associate the terms SDI and "uncompressed". While SDI
signals  do  not  use  compression,  the  majority  of  VTRs  use  compression  algorithms  with  a
subsequent (greater or lesser) loss of quality for image storage, although later they employ
uncompressed SDI signals for broadcast. Thus, in such cases,  it  it’s  the  compression ratio
used in each VTR that  determines the final image  quality  and  the  information available  for
post-production processing. For example, these ratios could range from the non-aggressive
2:1, as provided by Sony’s SR range of VTRs, to the destructive ratios of 40:1 found in HDV
devices. 

If  the  highest  possible  quality  is  required,  the  following  are  the  main  ways  of  obtaining
images that have not suffered information loss as a result of compression: 

In  the  case  of  using  digital cameras,  capture  the  signal  directly  from the  camera
during filming, ie before it is stored in the VTR. Certain cameras have SDI or SDI dual
link outputs than can be used for this purpose. Generally, for this method, a system
like  Mistika  is  needed  at  the  recording  location.  Low  compression  VTRs,  such  as
HDCAM SR, are also an acceptable alternative.

In the case of using film cameras, use a telecine and  connect  it  to  Mistika  directly
through the SDI output. A film scanner or a datacine can also be used to import  .dpx
or  .cin  images  they  produce.  This  method  produces  the  highest  quality  images,
although it is the slowest and most expensive. 

Whether  using  compressed  images  or  those  derived  from  film,  we  are  faced  in  post-
production with  problems  of  noise:  electronic  noise  in  the  case  of  compressed  video  and
grain in the case of film. Mistika is designed to deal with both cases, having a new Denoise
effect, which employs Optical Flow (Motion Estimation)  techniques  to  eliminate  both kinds
of noise wherever possible. However, it is not  possible to fix problems in all shots using this
technique,  so  it  should  not  be  seen  as  a  substitute  for  using  cameras  and  VTRs  of  the
highest quality. 

Users should be aware that although original noise or grain levels may be acceptable for the
viewer, the efficiency of many tools is improved if  applied to a version processed  with  the
Denoise technique, such as motion tracking, chroma key, secondary vector selection in the
color corrector, etc.)

Once inserted into post-production, it is recommended to work without  applying any kind of
compression. If, when completed, it  is necessary to apply  compression,  it  is  unavailable  in
the Render module of the Output tab.
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Color spaces

SGO Mistika allows the user to work in all the commonest  post-production color spaces, and
it is important to be familiar with this topic to achieve the best results. 

Although the system supports a variety of file formats, from this point  on,  this  manual will
use Mistika’s native image format (".js”) as a reference in the explanations that  follow, as it
is applicable to other file formats, depending on the color space employed. 

The  ".js"  image  format  of  Mistika  is  an  uncompressed  image  format  which  allows  direct
working and storage in the following color spaces: 

YUV 4:2:2 at 8 bits per channel. (2 bytes per pixel).

YUV 4:2:2 a 10 bits per channel. (3 bytes per pixel, equivalent to RGB 4:4:4 linear at
8 bits).

YUV 4:4:4 at 10 bits per canal (3 bytes per pixel)

YUVA 4:4:4:4 at 10 bits per canal  

RGB 4:4:4 linear at 8 bits per channel. (3 bytes per channel).

RGBA 4:4:4 linear at 8 bits per channel. (RGBA, 3 bytes per pixel, plus on extra byte
for the alpha channel).

RGB 4:4:4 linear at 10 bits per channel. (4 bytes per pixel).

RGB 4:4:4 logarithmic at 10 bits per channel. (4 bytes per pixel).

YUV 4:2:2 x 2 (8bit  and 10bit):  Stereo 3D format, equivalent  to 2   8  bit  or 10 bit
YUV 4:2:2 channels.  The  frames  for each eye  are  interleaved,  which improves  the
performance of  access  to  disk and  both streams  are  maintained  in  a  single  file.  In
Mistika  they  appear  as  a  single  clip,  although  both  streams  can  be  extracted
separately later.

In this manual, these complete names are not  normally used, because of their length: they
are abbreviated to YUV, YUV10, RGB, RGBA, RGB10, YUV422x2, YUV422_10x2 respectively. 

The storage of native .js format can be done in two ways: 

Mistika .js is the default  format  for video capture (its variations are defined in
Mistika  Setup->Video  I/O  for  each  preset),  although  at  the  moment  of
capture it can be changed to another format in the VTR panel. 

Render sequences imported in others formats to Mistika's .js format. 

The  characteristics  of  the  native  color  spaces  mentioned  are  described  below.  Detailed
knowledge of them allows us to  obtain the best image quality and to work with the system
in the most efficient way.

YUV 4:2:2

The YUV standard (also known as "Video in components") uses the color space that  is  the
standard in all video systems,  whether analogue  or digital.  Of  all  its  variants  widely  used,
the  digital  YUV  format  4:2:2  is  the  one  that  generally  gives  the  highest  quality  when
bandwidth is limited, and for this reason it  is the one most  used in videos systems oriented
towards post-production. 

The  name  “YUV”  refers  to  the  separation  of  the  video  signals  into  one  component,
luminance (Y) and two color components (U and V). If  the  original signal is  in  the  form of
analogue RGB (as is produced by most CCDs found in video cameras and telecines), the YUV
components are obtained by digitizing the analogue RGB signal in the following way: 

The Y luminance component  is obtained from the sum of the luminance of the three
RGB signals. As the luminance of the three colors are different, the following formula
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is used: 

Y = 0.299R+0.587G+0.114B 

The U and  V  components  are  obtained  by  subtracting  the  Y  luminance  from the  B
(blue) and R (red) signals respectively, for which reason they are also known as "Cb"
and "Cr". The  green component  is  implicit,  as  it  can be  obtained  as  the  difference
between the U and V signals and the Y signal. 

U = 0.493(B-Y) 

V = 0.877(R-Y) 

The  expression 4:2:2  is  to  be  interpreted  as  meaning   "to  obtain  double  the  number  of
luminance samples compared with those of the color components", as will be explained later.
 

Bearing in mind that video cameras (both SD and HD) and telecine systems use one or more
analogue CCDs sensitive to the Red, Green and Blue colors, and thus the original RGB signals
are analogue in origin, why has the YUV format  been chosen as the standard digital video,
rather than use RGB directly? 

The  answer is  because  in  order  to  digitize  and  store  all  the  information  available  in  the
original RGB analogue signals, a large bandwidth is required, which is not  normally  available
in camera and VTR storage systems. Thus it  is  necessary  to  use  a  more  efficient  system,
such as the YUV 4:2:2 format. The reason is that the human eye is much more sensitive to
small changes of luminance than it is to small color tone changes, so that  this format  takes
two  luminance  samples  (Y)  for each one  of  the  color components  (U and  V),  in  order  to
make better use of the available bandwidth.  Many  high-end  VTRs  (such as  Sony  Betacam
Digital and HDCAM, Panasonic D5 HD, etc.) record tapes in YUV 4:2:2 format. 

Alternatively,  some  of  these  devices  also  have  RGB  input/output  ,  although  it  should  be
remembered  that  in  these  cases  it  is  converted  from/into  YUV  which  is  what  is  actually
stored on tape. 

On  the  other  hand,  some  high-end  cameras  and  VTR  do  have  the  capability  to  record
directly in RGB format without compression or with a relatively gentle compression; examples
are  HDCAM-SR,  Redcode  R3D,  Arri  raw  D20  /  D21  /  Alexa,  Phantom,  SI2K,  and  the  cine
scanners.

Each format is studied in more detail below. 

The digital YUV 4:2:2 format of 8 bits per channel contains two bytes for each pixel of the
image: 

The  first  byte  represents  the  luminance  (Y),  and  provides  a  different  sample  for
each pixel. 

The second byte is the color component U of the even pixels and V of the odd ones.
To  reconstruct  the  color of  each pixel that  of  the  adjacent  pixel  is  taken  as  the
missing color component. 

As a consequence of the above point, this format  has half the chromatic  resolution
in the horizontal direction. 

This does not mean that two adjacent pixels will never be equal, as only one of the
UV  components  is  shared  with  another  pixel,  whereas  the  other  color  component
and the luminance component will always be different. 

Since  the  color  components  are  shared  between  alternate  pixels,  an  important
collateral effect  is  that  the  resolution of  the  working  format  used  with  YUV  4:2:2
should have an even number of pixels in each line. This should also be  remembered
when producing images in other formats  that  may  be  later imported  into  Mistika  in
YUV 4:2:2 format. 

The  10 bits  per channel YUV  4:2:2 format  is  stored  in  Mistika  by  means  of  an  additional
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byte, resulting in a total of 3 bytes per pixel.

As a rule, when using  Mistika  with  video  images  captured  via  single  SDI link,  it  is  best  to
work in YUV format, as this YUV 8 bit format is the one stored on the tapes, so it  makes no
sense to convert to other formats unless necessary. For example, the conversion to YUV 10
bit  or RGB implies  a  50% increase  in  storage  space  and  nearly  double  the  render  times,
without gaining any more detail than on the original tape. 

Note that this refers only to the transmission and storage of image, not  their processing. In
normal  circumstances,  Mistika  will  always  process  images  at  their  highest  quality  format
(RGB 4:4:4 at 16bit per channel or even HDR) in order to avoid the possible degeneration or
information loss.

Similarly, clips of different  formats can be mixed in the same composition (YUV, linear RGB,
RGB  10  bits  logarithmic,  etc.),  and  Mistika  will  make  the  necessary  conversions
transparently, for the user to see. In either case, the final output  depends on the following
considerations: 

If  the  video  output  is  activated,  Mistika  will  convert  the  final  result  in  the  video
output to the format selected in Mistika Setup->Video I/O.

If  a  render process  is  being  carried  out,  a  choice  can be  made  as  to  whether  to
store the images in YUV or RGB format. This will depend on the  format  required  for
the final product; for example, if  we are considering a later transfer to HDCAM VTR,
YUV8 is normally used, and if we need to transfer to dual link SRW HDCAM or deliver
file sequences in RGB formats, then we use RGB10 format.

Illegal colors and out-of-range workflows

If images are being viewed on a computer graphics monitor, Mistika  converts  the  result  to
RGB format  (converting  from YUV  to  RGB if  necessary),  since  such monitors  can only  use
RGB. This type of conversion is carried out internally without  any user intervention, but  it  is
necessary  to  bear  them  in  mind  because  the  two  RGB/YUV  versions  may  show  visual
differences, and some colors can only be represented in the YUV video output. 

For example, images captured YUV that  have information that  is  out-of-range  for RGB can
only be seen in their entirety in the YUV video output, eg, in RGB, maximum luminance can
only be obtained for the color white (with RGB components at their maximum value), while in
YUV  format,  both  the  “Y”  luminance  component  and  another color component  may  be  at
their  maximum value,  resulting  in  a  color  brightness  displaying  total  luminosity  and  color
saturation, which would be impossible in RGB. These kinds of situation are usually referred to
as “illegal color” in RGB.

Another conflictive situation concerns out-of-range YUV signals.  The  standard  YUV  format
(rule CCIR_709) reserves values less than 16 and greater than 234 (out  of a  total of  255)
for the superimposition of super white  and  super black in  televisions  and  for other control
information.  However,  some  HD cameras  intended  for  film production  usually  use  gamma
curves  that  exceed  these  values  in  order the  register more  information (especially  in  the
area of highlights). 

In such cases, a loss of information will be noted if the image is captured in standard YUV or
RGB formats.  The  solution to  this  issue  is  to  activate  Mistika  Setup->Video  I/O->Use
Extended  Range  before  capture  in  order  to  store  out-of-range  information  too,  and
afterwards to activate the HDR mode in the color corrector in  Mistika.  Thus,  out-of-range
work can be  done  without  problem,  and  with  the  help  of  Mistika’s  vectorscope  and  wave
form the user can decide to normalize the image or leave it  out-of-range and transfer it  to
video as it is.
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Linear RGB 4:4:4 8 bits

This  format  uses  3 bytes  for each pixel (one  byte  for each channel of  RGB  color).  Being
linear means that, in contrast to a logarithmic  format, the amplitude of the original signal is
represented by a  directly  proportional value.  For example,  "200" represents  100 times  the
intensity of a value of "2". 

The term 4:4:4 indicates that  the same number of samples is taken from the 3 original RGB
signals. 

The use of this format is recommended in the following cases: 

This  format  is  mostly  used  in  graphics  software  applications  because  computer
monitors  function in  linear RGB,  and  it  is  easier to  devise  algorithms  that  use  this
format  (very few applications are capable of working with YUV  or logarithmic  RGB).
For this  reason,  in  general its  use  is  recommended when  the  final  objective  is  to
export images to other software applications or multimedia production. 

Linear RGBA 4:4:4:4 8 bits

This format is similar to the previous one, but  it  has an additional alpha channel to contain
the composition mask,  storing  a  total of  4  bytes  per pixel.  RGBA  should  be  used  in  these
cases: 

When importing images containing an alpha channel (typically .tga files). 

When wishing  to  render an effect  while  conserving  the  alpha  channel  in  the  final
clip. 

Note: The YUV format does not have an alpha channel, although an alternative method can
be used: the mask can be stored in a separate YUV clip, and then the External Key effect
used to associate both clips and produce an RGBA output to use in the composition. 

Logarithmic RGB 4:4:4 10 bits

This format is not  linear like the previous ones, as its stored values represent  a logarithmic
curve that is used to compress the information corresponding to shadows and bright  lights.
The  logarithmic  system  allows  simultaneous  representation  of  luminance  levels  that  are
close  in  shadow  and  very  different  in  lit  areas,  while  maintaining  the  capacity  of
representing the midtones in a similar fashion to a linear format. 

To store this format  efficiently, 10 bits per channel have to be  used,  so  that  a  total of  4
bytes per pixel are stored. 

Note: The RGB 10 bit  logarithm format  can also be used to save images with linear gamma
curves but  in 10 bit,  as  the  archive  format  is  identical.  The  only  difference  is  in  how  the
images were  originally  codified  (ie,  which gamma  curve  was  used).  In  general,  logarithmic
gamma curves are maintained when the final version of the images will pass through a cine
film projector, whilst it will be converted to linear when the final product  will be video. In all
cases, the format  per se will not  change, and for this  reason when references  is  made  to
this, the only mode found will be RGB10. 

Mistika can import RGB 10bit format from SDI dual link captures, DPX or Cineon files, and Tiff
16bit, which are normally generated in one of the following ways: 

With a film scanner: the  emulsion of  film negative  has  a  wide  dynamic  range,  and
under certain conditions, details in areas of extreme illumination (lights and shadows)
can be detected.  High quality  film scanners  digitize  in  Cineon or DPX  format  which
conserved these details. 

Via a high-definition video camera with a wide dynamic  range: Sony F23, Arri  D-20,
Arri D21, Alexa, Red One, Red Epic, Phantom, Weisscam, etc. 
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Using  3D and  effect  applications.  These  applications  can  offer  a  greater  dynamic
range  when  rendering  10bit  log  formats  such  as  DPX  or  Cineon.  Generally,  when
working in film formats, 3D sequences for effects can be called up in these formats.
For these purposes, Mistika can also import the 16bit Tiff format Tiff, although this is
less efficient in terms of speed and disc space than DPX.

Note: given the large storage and processing requirements for these formats they
should never be used indiscriminately, as there will be few cases in which they will
give significantly better results than linear RGB 8 bits.

HDR

It is also possible to work with "HDR" formats (.exr  and .hdr) which are formats with a wide
dynamic  range (16bits per channel) and which can also handle out-of-range values (above
100% and even negative colors). 

These  out-of-range  areas  offer  extra  information  that  is  not  seen  but  which  can  be
recovered when necessary, typically using the color corrector (Color  Grade  effect)  in  HDR
mode. 

Note: The majority of effects can also  treat  these  images  in  transparent  way,  since  they
work in  16bit,  but  the  Color  Grade  color  corrector  is  especially  designed  to  allow  us  to
select the range we want to use.

Mistika  works  internally  in  16bit  format  with  HDR floating  point.  For  example,  a  specific
effect can darken an image, pushing the detail of the shadows towards negative values and
avoiding the loss of this information. Thus a posterior effect (for example, glint) can recover
this information without problem.

Mistika does not have its own specific file format for codifying more than 10bits per channel,
since these formats are very specific to each device. Instead, Mistika supports natively the
most  well-known formats  of  this  type  such  as   .exr,  .hdr,  Tiff16bit,  DPX12bit,  R3D,  J2K
(JPEG2000) etc. 

XYZ

The XYZ color space allows a wider range of colors than RGB and YUV, being able to codify
all  the  colors  visible  to  the  human eye.  Thus  it  is  useful  for  doing  a  master  with  all  the
available color information, from which diverse present  and  future  formats  can be  derived.
Furthermore, there is currently a strong tendency to use this space as reference  in  Digital
Cinema. 

To export to this format, we use the RGB to XYZ effect, and normally run a render to Tiff16
(for DCM) or J2K (for posterior encapsulating  in  DCP),  the  most  common standard  formats
for this color space.

The default parameters of the XYZ effect meet the standards for digital cine (DCI) so we do
not  normally  need  to  modify  them.  However,  on  some  occasions,  it  may  be  desirable  to
calibrate a projection room to  compensate  for its  differences  from the  standard.  In  these
cases, a calibration test  is run in the projection room to obtain the parameters that  should
be applied to the effect. Thus a very precise calibration for said room is achieved, while the
images produced in this way will be valid for projection in said space.

Transformations between linear and logarithmic colour spaces

In general, for the correct viewing of logarithmic  images on a linear device, a LUT3D should
be applied, as these LUT  allow for the correct  calibration of the different  devices (monitors
or digital projectors) involved through to the final positive. 

When converting color spaces between linear and logarithmic, the following specialized tools
are available: 

The Cineon Correct/Export  effects  uses  the  Kodak standard  Cineon for converting
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from logarithm*(1)  space  to  linear and  vice  versa,  with   the  ability  to  compress
highlights  into  a  linear  range  without  losing  detail  (the  parameter  Softclip).  This
Softclip parameter protects the information of bright lighting when passed to a linear
color space.

The effects LogCorrect  and LogExport  offer inverse conversions from logarithmic  to
linear  (LogCorrect)  and  from  linear  to  logarithmic  (LogExport),  according  to  the
mathematic  "logarithm"  function  (and  so  without  following  the  Cineon  standard).
Generally it is less efficient as it does not have the Softclip function, but will have to
be used when the client or other related applications require this conversion formula.
 

These  effects  are  recommended  when  temporary  conversion  from logarithmic  to  linear  is
required in order to compose images that  have been produced in different  color spaces (for
example, linear 3D images) or to insert certain effects that work better in linear color space.
 

If exactly the same parameter values are used for two of these complementary effects, the
final output will have the same gamma curves as the original.

(*1): The main difference between both pairs of effects is that  the effects LogCorrect  and
 LogExport  carry  out  a  standard  logarithmic  conversion  (the  luma  value  elevated  to  the
gamma  function  defined  by  its  parameters),  while  Cineon  Correct/Export  use  a  more
complex  and  specific  formula  created  by  Kodak  and  which  describes  more  exactly  the
behavior  of  the  cine  negative  (the  standard  Cineon  cannot  strictly  be  defined  as  a
logarithmic function, although owing to its similarity, it is often colloquially described thus). 

In general, when dealing with cine images,  use  of  Cineon Correct/Export  is  recommended,
since this  also  makes  available  the  SoftClip  function;  LogCorrect  and   LogExport  are  only
recommended when a standard logarithmic  conversion is expressly requested by the client,
or for compatibility with other application  that do not support the Cineon standard. 

For the sake of simplicity in the following explanations, the term "logarithmic" will be used to
refer equally to both types of conversion, although as mentioned they are not exactly alike.

Sometimes  we  may  wish to  change  the  color spaces  and/or reduce  the  depth  of  bits  of
various clips, in order to unify clips of different  color spaces, to compare different  versions,
to simulate deterioration processes during posterior conversion to  other formats,  or simply
to  achieve  a  posterize  effect.  To  do  so  we  can  us  the  effect  Scope.  We  can  apply  an
effect  of this type to the clips to be unified and choose the color space and depth of bits
desired via the respective parameter. 

For more information, see the chapters on the effects mentioned. 
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C-8 Global production workflow and two-way conforming

This new workflow also allows the integration of dailies with the offline processes. Now it  is
possible to work with them in parallel, while maintaining two-way communication between all
the areas of post production.

Mistika Live cam also be used for realtime adjustments of the camera signal,  production of
dailies  and  VFX  references.  This  combination  allows  the  use  of  all  Mistika's  tools  in  the
phases of pre-production and during the shoot.

Mistika can read most RAW camera codecs. If these types of files are being used in an initial
phase,  it  is  possible  to  prepare  the  camera  material  according  to  the  initial  settings  and
simultaneously produce predefined versions (dailies, quality, offline) that  allow timecode and
sound track.

In  the  next  stage,   Mistika  can be  used  for advanced  color correction and  other  effects
while  the  material  is  edited  in  parallel  material.  Finally,  the  new  EDLs  can  be  conformed
against  the contents of the Node Graph (.rnd files), where all the effects are reset  to the
new values and durations automatically. 

Furthermore, this process maintains access to the original camera  files  and  metadata  until
the end, thus providing the highest possible quality for mastering.

Additionally,  the  use  of  multi-layer  groups  means  different  versions  are  maintained,  or
changed to proxies in realtime when working with codecs that are difficult to process .

Thanks  to  the  DCP  output  module,  DCP  packets  can  be  exported  at  any  point  of  the
process, whether for viewing dailies of revising material printed in the lab.

Example of global workflow

1. Import and initial settings

As a first step, load all the rushes into Mistika by selecting them in the root  directory
and using the commands Import All Sequences or Import All Movies with the Media tab
 (Node Graph Editor->Dashboard->Media). This way, all the media  in the current
folder will be linked in one single operation.  This  operation creates  link-type  clip  files
(with  .lnk extension)  in  the  DATA  directory  of  the  project.  It  is  recommendable  to
organize the material into subfolders within this folder.

If there is material derived form tape, capture this too via the VTR tab (Node Graph
Editor->Dashboard->VTR->VTR Capture).

Carry  out  a  primary  color  correction  and  other  preliminary  adjustments.  For
stereoscopic projects, we recommend setting the geometric alignment, balancing color
and  synchronizing  both  eyes  via  the  Stereo  3D  effect(Node  Graph  Editor-
>Dashboard->Fx->Mistika->Stereo 3D).

2. Creating dailies and clips for offline editing

With the Output tab (Node Graph Editor->Dashboard->Output) create an new 2D
media, or a version in "Side-By-Side" mode if the project is stereoscopic.

To  create  clips  intended  for offline  editing,  Mistika  supports  the  writing  of  timecode
and audio in  MXF-VC3 format.

Activate the Split  to Segments option (an MXF  image  file  is  created  for each clip  in
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Node  Graph)  and  the  Audio  In  Movie  button (an MXF  file  is  created  for  each  audio
track).

The  Virtual Slate  tool can also  be  used  to  overwrite  metadata  of  image  files.  It  is
possible to defined specific  availability of this data by editing the  file  $HOME/Mistika-
ENV/shared/virtualslate/Layouts.xml.

All  these  render  processes  can  be  administered  via  the  Render  Batch  Manager  of
Mistika.

Equally, DCP packets can be created to be shown in a projection room if necessary.

3a. Offline editing

Send the MXF files to the Avid workstation in order to be  begin  the  offline  editing  in
parallel.

In Avid systems, the MXF files must  be located in a directory with  the  complete  and
specific Avid address for the media folders. Next, us the "Media Tool" of Avid to import
the  clips.  In  Avid,  the  import  of  the  media  from "All  Projects"  -  and  not  just  the
current  project  -  must  be  activated.  Then,  from the  import,  Avid  can use  the  MXF
clips without needing transcodification, including timecodes and de audio tacks.

3b. Advanced setting and corrections  

In  Mistika,  it  is  possible  to  continue  fine-tuning  initial  settings  and  move  onto  more
complex corrections. In this stage of the process, different  operations can be carried
out:  precise  stereoscopic  adjustment,  advanced  color  correction,  noise  correction,
image restoration, visual effects and composition.

This whole process can be carried out in parallel and interactively. Each time an EDL is
received, it  is possible to conform it  directly against  the contents of the Node  Graph
in Mistika.

4. Conforming against render scripts (.rnd)

With the Conform  tab,  select  the  Mistika  Clips  conform mode  (Node  Graph Editor-
>Dashboard->Conform->Mistika Clips). This mode allows conforming  against  clips
and scripts such as .clp, .lnk and .rnd.

Next, define the directory that will contain the render script (.rnd) in Mistika. The .rnd
files  are  generated  in  all  the  processes  of  render  or  via  the  Write  Script  Only
command. This kind of file is similar to an environment  file (.env) since it  will recreate
each effect in its correct position and duration as defined by the new EDL. 

When the  .rnd  files  of  the  render  of  the  initial  settings  (Step  1:  Import  and  initial
settings) are created, a copy of them can be saved  automatically  together with  the
original  material  being  processed.  This  is  done  by  activating  the  .rnd  With  Media
button  in  the  Output  tab  (Node  Graph  Editor->Dashboard->Output->Render).
This  makes  it  easier (in  this  stage)  to  carry  out  the  process  of  conforming  without
worrying about finding the .rnd folder that corresponds to the new EDL.

It behaves as if .rnd files in Mistika were metadata from original camera material. So it
is very useful when transporting discs with  original material  to  other Mistika  systems
for re-conforming.

Different  versions of render scripts for the same clip can be  created  at  a  later time.
These versions can be conveniently renamed in order to track changes. Keeping the .
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rnd  files  together  with  the  rushes  is  a  good  way  of  being  sure  that  the  media  in
question can be conformed in any Mistika workstation.

The conform of the  render scripts (.rnd) will load the media in groups whose contents
are the original clip and the effects  applied.  If  it  is  necessary  to  ungroup  them,  use
the  dedicated  macro  Trim  &  Ungroup  (Node  Graph  Editor->Dashboard->Edit-
>Edit->Macros->Trim  &  Ungroup).  This  command  defines  the  cuts  in  a  render
group, respecting the segment  references by the EDL. The command Ungroup (Node
Graph  Editor->Dashboard->Edit->Edit->Ungroup)  simply  makes  all  the  render
script available in the Node Graph without reference to the EDL.

5. Preview and delivery

In any stage of the process, it  is possible to create master formats and DCP packets
to be reviewed in a projection room.

For more information, see the chapter DCP.
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D-1 Insatalación y licencia

After purchasing a subscription you will also receive a (.run) file or you can also  download
this file from the Downloads tab of you SGO account, you can find your downloads in here:
https://www.sgo.es/my-account/downloads/. To install Mistika you will  have  to  run the  (.
run) file and follow the steps of the installer.

After  purchasing  a  subscription  you  will  also  receive  an  activation  code  by  email.  This
activation code needs to be assigned to a particular system in order to get  the license for
it.  This can be done either when starting Mistika software or with  the  SGOActivationTool,
which is a separate tool also installed in the system. 

The  first  step  is  to  verify  that  you  have  access  to  the  internet  since  to  activate  your
license this connection is necessary. Once you have checked the internet access, you must
click Continue and in the new window press the  ADD ACTIVATION CODE button.  Then you
will be asked for an email, you must  enter the email with which you made the  purchase  of
the  license  and  then you must  enter activation code  you will  find  in  your email  or in  the
Activation codes  CODES  section  of  your  SGO  account:  https://www.sgo.es/my-account/
activation-codes/.

To finish it you must validate your code with the Validate & Activate button.

If this process is not working for you,  please check these points:

- In addition to the emails, you can also find your activation codes in your account:  

https://www.sgo.es/my-account/activation-codes/

-  Make sure that  you are running the latest  version.  You can get  the software  at   www.
sgo.es/my-account/downloads  .  Old  versions  are  known  to  fail  with  current  licensing
processes.

-  Check that  internet  connection is  working.  For using  the  activation  code  you  need  an
internet connection.  (once you get  the license no internet  connection is needed until next
renewal). If  you do not  have internet  connection but  you have a  license  file  please  check
the next point.

-  Activation codes and license keys:   An "activation code" is  not  the  same  as  a  "license
key".  An "activation code" is what  you get  first, and it  is generic:  It  permits  to  obtain  a
"license  key" for any  computer (but  only  one).   Once  that  the  activation code  has  been
assigned to a computer then you will receive a "license key" for that  specific  computer. The
license key is not  generic  and it  will only work on that  computer,  and  the  activation code
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can not be used to get  more license keys until it  is unassigned from the previous computer
(which will invalidate the license key that it had). 

From that  point  the  license  keys  are  managed  automatically,  but  if  you  don't  have  an
internet  connection you can also do the process manually by using the SGOActivationTool-
>Offline Mode.

If the email method is not convenient for you, you can also find your license keys in here:

https://www.sgo.es/my-account/licenses/

- If the activation code has been already used, it  needs to be unassigned before using it  in
other system. (See the article about license reallocations) 

If it is not running, try to start it manually.

The license server is called  sgoLicenseServer.bin it is in /var/flexlm/bin.

To execute it, it can be done from the console, writing, as root, the command:

/var/flexlm/bin/sgoLicenseServer start

-  The activation code was purchased with a different  email account,  and  now  you get  an
error that  the activation code belongs to other user . When a user purchase an activation
code it is registered to its email address,  and no other users can make modifications to it.
Please make sure you use the same  email  address  when you are  activating  the  license  or
making any change to its state. For security reasons, using a different  email account  is not
permitted .  

- The license file could be corrupted or not  correct.   It  an happen in rare cases, if  it  was
installed manually or if  the connection went   wrong during the licensing process.   You can
refresh the license file by deleting it  and doing a reboot  (in this way, the license server will
connect automatically to get the license file again).  The license file is named sgoLicenseV5.
dat, and it is in the directory %PROGRAMDATA%/sgo. Delete it and reboot the system.

-  The  license  server  can  not  run  in  a  virtual  machine  or   virtual  mac  address:   Mistika
products  need  a  physical  network  interface  for  the  license  to  work,  virtual  network
interfaces are not supported. However, the licenses are floating licenses, which means that
you can install the software in a physical machine  and  then use  it  as  a  license  server for
the virtual machine. 

For doing this, nothing special needs to be configured in the server system (just  install the
license).  In the client  computer (or virtual machine), our products  permit  to  tell  the  ip  of
 the license server in  the  SGOActivationTool  settings  wheel ,  and  in  the  license  dialogue
that  will appear when opening the application.  In  general,  you can also  do  it  by  creating
this environment  variable in the client  operating  system as  follows:   Environment  variable:
SGO_ELMHOST  Value: The ip address of the license server computer. 

Reubicar una licencia

To move your license to other system  you need  to  deactivate  your activation code  from
the active system, then reactivate it on the destination system. 

If you have access to the active system, the best way to deactivate your code is using the
 Activation Tool. Details can be found here:

https://www.sgo.es/forums/topic/how-to-deactivate-your-mistika-vr-license-from-your-
system/

If  you  do  not  have  access  to  the  system anymore  (broken  system,  etc)  then  you  can
deactivate your code in our web.  Details can be found here:

https://www.sgo.es/forums/forum-search/activation-codes/
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Alternatively,  please   note  that  you do  not  need  to  relocate  licenses  if  the  systems  are
connected in a network: All licenses are "floating", which means that  if a licensed system is
available in your network then you can simply select  it  in the  SGOActivationTool,  or in  the
license  dialog  appearing  when opening  the  application.  (nothing  needs  to  be  done  in  the
server side, just   tell the ip of the license server to the client  computer,  using  the  license
server settings wheel icon). Later, the license will be returned to the server as soon as the
client closes the application. For example, you can also assign several activation codes to a
same license server and then get them from any clients at any time, if you prefer to work in
this manner. 

During all this process, please note that  "activation codes" and "license keys" are  different
things.  The  "activation code" is  what  you purchase  and  it  is  generic  (it  permits  to  get  a
"license key" for any computer, but only one at  a time ) .  Later, when the activation code
is unassigned from that  computer then the existing license key will not  work anymore,  and
you can use the activation code to generate a license key for the next computer.

Both your activation codes and your licenses are sent  by email, but  you can also find them
in your web account: https://www.sgo.es/my-account/

Normally you only use the activation codes and the license keys are managed automatically.
  But  if  you want  to check the licenses manually the SGOActivationTool->Offline permits to
work with license keys manually.
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D-2 Mistika Setup configuration parameters

When it  has started up, use the tool Mistika Setup to  configure  the  system.  The  different
configuration parameters of the application are specified here. 

The tool can be started by: 

Typing mConfig into any Linux shell.

From within Mistika, via the Mistika Setup button in the Attributes tab  (Node
Graph Editor->Dashboard->Edit->Attributes).

Double clicking on the desktop icon.

Many of the configuration parameters of this tool must  be specified before starting up SGO
Mistika:  if  any  are  modified,  it  is  necessary  to  exit  and  restart  the  application  for  the
changes to be recognized.

There  are  other  configuration  parameters  that  typically  require  modification  and  can  be
changed  from within  Mistika  without  needing  to  close  it;  they  are  usually  located  in  the
Setup tab (Node Graph Editor->Dashboard->Edit->Setup). 

Finally, certain configuration parameters are not usually modified, and by default  are hidden,
although they can be activated via the General->Expert Mode button, which makes them
accessible the on next start-up of the mConfig application. (These parameters are intended
for  expert  use  and  are  hardly  used;  some  are  not  detailed  in  this  document.  Their
modification is only recommended after consultation with SGO’s technical department.)
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D-3 General

This area allows modification of different general parameters of the application.

General

Standard Preset

This option allows the simultaneous configuration of all other options, starting  from a
series  of  predefined  configurations  (Presets).  By  default,  presets  for  different  video
formats,  such as  PAL,  NTSC,  1080_24p,  etc.  are  included,  but  the  user  can  specify
new presets in order to save sets of values which are often used, whether or not they
anything to do with standard video format. 

Delete Current  Format... deletes the active  preset  from the  disk permanently  and  it
disappears from the menu. 

Note: The default presets installed by the system cannot be deleted. 

The  second  option of  this  menu is  Create  New  Format...  .  This  option  permits  the
creation of a new preset. When run, the system asks for the name of the new preset
to be created. The current configuration data, indicated with an asterisk  *  ”, will be
saved  in  a  preset  with  this  name.  When  a  preset  is  selected,  all  the  parameters
marked with an * after their name will  be  changed  to  the  new  value  defined  by  the
selected preset. Parameters that  do not  have  the  symbol *  after their name  do  not
depend on the  format,  so  they  remain  the  same  when changing  from one  preset  to
another. 

The next option is Delete Current Preset.... This allows deletion of the active preset. 

To modify an existing preset, select the preset to be modified, change the values and
press the Save Preset button. 
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Important note: If the values of a preset  have been changed and then another one
is selected, the system will show a message to this effect, asking whether the current
preset should be saved before changing the next, since if we do not, any changes will
be  lost.  If  we  exit  by  clicking  OK without  having  clicked  Save  Preset,  the  changes
made will not be saved with the current preset, although they will be in effect  for the
following work sessions in Mistika, until the presets are changed again. 

Autosave time (secs)

[300 (10 / 10.000)]

This defines the frequency  (in  seconds)  with  which the  system makes  an automatic
save  of  the  environment  (the  archive  has  the  same  name,  ending  in  _auto.env).  In
this way, in the case of system failure, the last  automatically  generated  backup  can
be reloaded. 

Note:  In  certain  systems  the  process  of  autosave  can  require  the  temporary
 disconnection of the  video  output,  and  in  these  cases  the  video  monitor image  will
disappear for a short time. This is not of particular importance, as Mistika never allows
this to happen during playback or video capture.

Diagnostics at startup

[True (True / False)]

If  this  is  activated,  when  the  window  opens,  a  series  of  checks  are  run  on  the
coherency of the configuration parameters. It can be deactivated to avoid error alerts
appearing continually, if their solution is not an immediate priority. 

Execute diagnostics

This  runs  a  complete  system check,  including  an  analysis  of  the  coherency  of  the
configured parameters with the available hardware, and the existence of /capacity for
writing  in  all  the  directories  defined  in  the  section FilePaths.  Completed  checks  will
appear  on  the  system  console,  whilst  indications  of  errors/problems  found  will  be
shown in the form of dialog boxes. An example of checked elements as they appear on
the console is shown below:

mConfig checking system: License server is running
mConfig checking system: This machine does not have video board (or the DVS Video
board driver is not loaded)
mConfig checking system: Nvidia driver is installed and ready to be used
testing path: PROJECTS PATH /MATERIAL/WORK
mConfig checking system: Path PROJECTS PATH /MATERIAL/WORK is ok
testing path: AUDIO PATH /MATERIAL/AUDIO
mConfig checking system: Path AUDIO PATH /MATERIAL/AUDIO is ok
testing path: MOVIES PATH /MATERIAL/MOVIES
mConfig checking system: Path MOVIES PATH /MATERIAL/MOVIES is ok
testing path: TMP PAINT PATH /usr/tmp
mConfig checking system: Path TMP PAINT PATH /usr/tmp is ok
testing path: REALTIME STORAGE PATH /MATERIAL/IMAGES
mConfig checking system: Path REALTIME STORAGE PATH /MATERIAL/IMAGES is ok
ret /dev/sda8 /MATERIAL xfs rw 0 0
mConfig checking system: There are 1 CPUs, ready to be used
mConfig: updating previous entry in .cshrc
mConfig checking system:  Info: Double buffer is correctly configured
mConfig: Checking KDE...
mConfig: Diagnostics finished
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mConfig: fsnameservers exists...
mConfig: snfs server: localhost
mConfig: snfssrv is localhost
mConfig: SNFS lic  # Expiration Date: 10/10/2008
mConfig: getDiskDev for /home/odin/Mistika-ENV/.Mistikarc ...

Low Disk Space Warn

If this is activated, Mistika warns the user when the disk space is low.

Version Manager 

[Mistika-ENV]

From version 4 onwards, Mistika has this version control tool available -  it  shows a list
of all the available versions, from which the user can choose the one to be employed
in an upcoming Mistika session.

Note  for  system  administrators:  the  following  explanation  is  given  in  order  to
understand how upgrading functions: 

All the software for SGO Mistika is initially found in the file Mistika-ENV. 

Each time an update is installed, the installing process automatically makes a copy of
the  previous  version  with  the  name  Mistika-ENV.PreVersionNumber.  (or  .
PreviousInstallationDate depending on the case).

This tool shows a list  of the Mistika-ENV.* type  with  all  existing  versions,  and  when  one  is

selected, a link Mistika-ENV is created indicating the selected folder.

Previous  versions  are  not  named  with  their  original  name,  since  there  will  be  no
guarantee that the user has not carried out subsequent updates manually. 

For example, when version 5 is installed, the previous version will be moved to a folder
called Mistika-ENV.PreV5, irrespective of its current update status.

Expert mode

[False (True / False)]

If  this  is  activated,  then  the  next  time  the  tool  is  started  up  infrequently  used
parameters  will  also  be  loaded;  it  is  recommended that  they  are  only  modified  after
consultation with Mistika’s technical department.

User Settings

New  user  sets  can  be  created  directly  in  this  menu  or  by  importing  them  from  a
settings  file.  A  user  set  include  hotkeys,  persistent  buttons,  and  color  panel
preferences. 
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D-4 File Paths

Specifies the work directories that SGO Mistika will use. These fields can be written directly
or  can  be  selected  graphically  using  the  selection  button  accompanying  each  one  (this
latter method is recommended as it helps prevent errors).

File Paths

Create or change all default Paths

Allows the user to change all the paths and directories that Mistika uses by default. 

Project directory

Default value: /home/Mistika/WORK.

Range: text field that indicates a folder in which the user has write permissions. 

Description:  folder that  stores  Mistika  projects.  New  projects  generated  are  stored
here.
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Keep tutorials project

[False (True / False)]

If this is activated, when changing the location of  a  projects  (Projects  Directory),  a
link to the project  "tutorials", included with the SGO Mistika  distribution package,  will
be  created  in  the  new  location.  It  is  recommendable  to  keep  this,  since  future
versions  will  try  to  install  useful  examples,  specifically  relating  to  updates,  in  this
project.

Media Folder Directory

Default Value: /MATERIAL. 

Range: text  field that  indicates a folder in which the user has  write  permissions  and
which has sufficient bandwidth to work in realtime in the required image format.

Directory which holds houses volume of mounted realtime storage, or a subdirectory of
the same that stores material derived from images in SGO Mistika native uncompressed
format (.js). 

It  is  recommendable  to  use  specifically  dedicated  partition  to  avoid  the  discs  being
fragmented.

Select DCP MOVIES Directory

Default Value: /MATERIAL/DELIVERY/DI.

Range: text field that indicates a folder in which the user has write permissions.

Directory where files and folders created by the export  of DCP packets are stored. It
also  serves  as  an obsolete  directory  to  make  projects  prior to  SGO  Mistika  v6.5,  in
which Movie files make reference to this directory, compatible.

Change Global Presets Directory

Default Value: /home/Mistika/Mistika-ENV/global_presets

Range: text field that indicates a folder in which the user has write permissions.

Description:  directory  that  stores  FX-Presets.  These  files  may  be  shared  between
various  SGO  Mistika  users  in  a  network.  This  link  is  available  via  Visual  Editor-
>Canvas->Toggles->FX Presets.

Change Display Filters Directory

Default Value: /home/Mistika/Mistika-ENV/shared/display_filters.

Range: text field that indicates a folder in which the user has write permissions.

Description: directory that stores Dispaly Filters. These files may be shared between
various  SGO  Mistika  users  in  a  network.  This  link  is  available  via  Visual  Editor-
>Canvas->Toggles->FX Presets->Display Filters.
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Change Render Setup Directory

Default Value: C/MATERIAL/WORK.

Range: text field that indicates a folder in which the user has write permissions. 

Description: directory that  stores Render Setup presets. These  files  may  be  shared
between various SGO Mistika users in a network. This link is available viaDashboard-
>Output->Render.

Predefined storage paths (Path Builder)

Path Builder is a tool that  allows the user to define target  directories for render processes
of any type. Once defined here, these different types appear as available in the Output  tab
(Dashboard->Output->Render). These  render targets  allow  the  automatic  construction
of complex directory and name paths, using different useful information such as the name of
the render, the file name of the original media, etc.

It is recommendable the the filesystem chosen is "SNFS", since Mistika especially optimized
for this type of filesystem, as it  is the only one that  offers realtime  performance  with  DPX
2K formats and higher. When this is not  possible (on laptops and training systems), use  at
least  an "XFS" filesystem. Other types  of  filesystem offer performance  that  is  much lower
than those mentioned. 

The window Path Builder contains documentation explaining its use.

PATH BUILDER - Manage storage paths

Button that opens a new window of Path Builder.

Path Builder

Path List

List of all the defined and created directory paths in use.



53Mistika SETUP (mConfig)

SGO Mistika 8.6 © 2018 SGO

File format

Options  that  allow  the  definition  of  the  image  format  to  be  associated  with  the
directory path:

Xfs.dev

Uncompressed .js Mistika clips.

Movie.dev

Movie-type clips, sequences of compressed images in a single file.

Disk.dev

Image-type clips, sequences of numerically ordered images.

Sound.dev

Audio-type clips, .aiff or .wav files.

Symbolic Name

Data field that allows the definition of the names with which the path will be viewed in
 Mistika's  interface,  within  the  Target  menu  (Node  Graph  Editor->Dashboard-
>Output->Render).

Basic fields

This series of buttons allows the construction of  a  master model according  to  which
created files will be named.

Each directory is represented by the name defined by the user (Symbolic  Name) with
an underscore  (_)  used  as  a  separator.  Direct  editing  is  permitted  in  Storage  Path
following  this  syntax,  although  care  is  recommended  for  safety  when  using  the
buttons.

Base folder. Button that opens a new system explorer window, in order to select
the location of the directory.

[project](Project Name) 

[renderName](Render Name)

[segmentIndex](Render  Segment  Index).  Render script  number,  defined  by  Edit
Marks.

[tapeName]  (Source  clip  name).  Original  name  of  the  processed  media  file  (if
there are several, the name of the first to be evaluated is used).

[frameIndex%5](Frame  number  with  padding).  Numbering  of  the  frames  with
padding.

[frameIndex](Frame number with no padding). Numbering of the frames without
padding.

[ext]. File extension.
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Stereo 3D

[eye?labelLeft.laberRight](3D  Stereo  eye).  Defines  the  eye  assigned  when
chosen in Output.

Label for left eye: Left as default, although this can be edited.

Label for right eye: Right as default, although this can be edited.

Other fields

/ (barra), - (guión), _ (guión bajo). Punctuation marks used for improving reading
of the fields defined in the file names to be processed.

[envName](Environment Name). Mistika environment name.

[resolutionX]. Horizontal resolution of the file to be exported.

[resolutionY] Vertical resolution of the file to be exported.

Storage Path

Data field containing the file model as defined by the user, in nominal syntax values.

Create new path

Creates  a  new  directory  path,  once  the  model  master  is  created.  The  new  path
appears in Path List.

Remove selected path

Removes the path selected in Path List.

Update changes to selected path

Applies changes to the path selected in Path List. 

Close

Closes the Path Builder window.

Example:   Each  user  needs  to  adapt  a  structure  and  organization  for  each  working
situation; an example of the construction of a path and where it will store a render is shown
below.

Storage  Path:  In  Base  folder  we  choose  the  folder  in  which  files  are  saved,  /MATERIAL.
Then with  the  buttons  available  in  Path Builder,  we  construct  the  path  which  will  be  as
follows:

/MATERIAL/[project]/[renderName]/[eye?Left:Right].[ext]

We define a Symbolic Name as my_path and the File format as Movie.dev.

We  open the  name  test  project  and  in  the  Output  we  chose  render  for  Movies,  an  AVI
format, and our path in Target -> my_path. We name the file to be rendered as myrender
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and select  in Stereo 3D Mode -> Left  Eye  Only.  We  chose  the  render in  Foreground  or
Background and the where the file will be found (abbreviated for greater ease):

/MATERIAL

/test

/myrender

/left.avi

This  naming  syntax  allows  us  to  have  in  a  single  personalized  path,  a  target  for  each
project,  timeline,  render  name  and  even  define  which  eye  pertains  to  the  file,  without
needing to create a relative path for each project.

Cache files and proxies

Cache Eye

[NO_STEREO (NO_STEREO / LEFT / RIGHT /BOTH)]

Indicates  the  image  or eye  to  be  rendered  as  the  cache  when working  with  stereo
images.

Cache Base Folder

Range: text field indicating a directory in which the user has write permissions. 

Description: directory which stores the media created by the cache function. 

Cache syntax

Range: text field indicating a syntax similar to Path Builder for defining cache folders.

Cache Device

Range: non-editable field in which the final result  constructed with the previous fields
for the cache directory is viewed. 

Sequence Proxie dir

Range: text field indicating a directory in which the user has write permissions. 

Description: directory which stores the media created by the proxies of sequences of
numbered image files. 

VectorParin Temporal Directory

Default value: /usr/tmp.

Range: text field indicating a directory in which the user has write permissions. 

Directory for storing the temporary  files  of  the  cache  of  the  VectorPaint  effect.  For
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HD or  cine  projects  it  is  recommendable  to  redirect  them to  the  fastest  available
storage.  If  the  cache  is  activated  (Visual  Editor->Dashboard->Paint->Setup-
>Cache(Use)) the VectorPaint  effect  stores every modified  frame  here,  so  they  do
not need to be redrawn each time they are evaluated.

Obsolete relative paths for backward compatibility

Parameters that  are  necessary  for reading  environments  from versions  previous  to  Mistika
version 6.5 (new environments  created in versions  posterior to  version 6.5 will  not
use these paths). These parameters will define the realtime storage system for image files,
indicating their location and the best way of accessing them. 

Audio Storage Path

Default value: /MATERIAL.

Range: text field indicating a directory in which the user has write permissions.

Directory where audio files are stored (.aiff  and .wav files) in versions of Mistika prior
to v6.5. These files are generated when capturing clips with audio or when rendering
with audio. 

Rt.Storage Path

Default value: /MATERIAL. 

Range: text  field  indicating  a  directory  in  which the  user has  write  permissions  and
which has sufficient bandwidth to work in realtime with the required image format.

Directory  (or  subdirectory)  in  which  the  realtime  storage  volume  is  mounted,  and
which stores the image source material in native SGO Mistika uncompressed format (.js
 files). 

It  is  recommended that  a  dedicated  partition  is  used  to  avoid  fragmentation  of  the
discs.
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D-5 Master Format

This  area  allows  modification of  the  different  parameters  relating  to  the  image  format  in
which we wish the application to work, both internally and as output via the video card.

SGO  Mistika  can  work  with  input  images  whose  format  differs  from  that  defined  in  this
section. What is defined here is the output format, ie, the image format that ALL effects will
produce, both in playback and when rendering (Master Format, in the upper section)  and
also the configuration of the output of the video board.

For example, if  we have defined  a  format  of  HD 1920x1080 here,  we  can load  2K images,
which will be processed and rendered in HD, even while using PAL or NTSC monitors to view
the content  of the video output. In this example, a  render will  always  produce  1920x1080
images.

Take  note  that  SGO Mistika  has  some  effects  that  allow  the  loading  of  the  whole  image,
even if it has a different size, but that it  will always produce its output  image in the format
defined  in  this  section:  specifically,  the  effects  Framing,  Color  Grade  and  Comp3D  have
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parameters for defining how this conversion should be carried out. The  rest  of  the  effects
simply crop to the center of the image corresponding to the size defined in this section. 

Furthermore,  it  must  be  remembered  that  the  same  environment  can  be  opened  in  a
different  resolution  in  each  session.  So,  to  continue  the  previous  example,  in  the  next
session we can select a de PAL preset  (Render Format  XY  = 720x576) to open SGO Mistika
and produce a render with  PAL dimensions.

Master Format

Render Size X

[720 (2 / 50.000)]

Image width in pixels. In the case of YUV images an even number is recommendable. 

Render Size Y

[576 (1 / 40.000)]

Image height in pixels. 

Frames per Second

[25 (Numerical floating point field)]

Number of frames per second which defines the real-time production of the format  of
the image. 25 for PAL, 29.97 for NTSC, 24 for 24p, etc.

Decimal  values  can  be  introduced,  and  as  well  as  specifying  the  velocity  of  the
graphics monitor (given that  the video output  is defined by the format  chosen in  the
section  Video  I/O)  the  correct  value  is  also  especially  important  to  maintain
synchronism between image and audio tracks. 

It is also possible to specify a speed that does not correspond to any video format. In
these cases the playbacks should be observed in the graphics monitor, since the video
output  may  not  be  able  to  run  at  that  speed  and  one-frame  jumps  may  be  seen
occasionally. 

However,  it  is  very  important  to  remember that  Mistika  is  much  more  optimized  for
real-time in video output, and less so for playback to graphics monitors. 

Note: The Monitor Display will always try to reach the speed specified here, but  the
indicator will show the current  speed at  which the images have been processed (this
indicator updates once a second).

In some cases it  will be observed that  this number is slightly lower, but  this does not
necessarily  mean  that  playback  is  not  happening  in  real-time,  but  rather  that,
temporarily, it  has been unable to calculate the number of frames necessary, since it
always  has  a  precalculated  number of  frames  available  to  tolerate  such situations  (
Ring Buffer parameter). In cases when real-time has actually not been achieved in the
video output, an indicator called “LostSync” will appear until playback is halted. 

Aspect Ratio

[1.33 (1.33 / 1.66 / 1.77 / 1.85 / 2.35)]

This is the aspect  ratio desired for the  output  format  (it  is  the  ratio  of  the  physical
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width  divided  by  the  height).  It  does  not  necessarily  coincide  with  the  result  of
dividing  X  by  Y  (although this  is  most  common),  given that  certain  formats  are  not
based on square pixels. For example, the  format  PAL SDI is  720 pixels  wide  and  576
high, so the result of the division would be 720/576 = 1.25. However, the aspect  ratio
of  the  format  PAL  is  1.33,  since  the  standard  PAL  defines  that  this  must  be  the
relation  between  the  width  and  height  of  a  standard  video  monitor  (and  so  uses
rectangular pixels, not square ones). 

Generally,  for  complex  cases  of  anamorphic  images,  or  ones  that  require  manual
conversions  of  aspect  ratio,  do  not  modify  this  value.  In  these  cases,  it  is
recommendable to apply a Framing effect to modify the corresponding parameters.

SGO  Mistika  also  uses  this  value  to  accurately  warp  the  geometric  patterns  it  is
required  to  generate,  such as  squares,  circles  etc.  Thus  we  can  see  that  a  circle
generated  in  VectorPaint  or  with  Wipe  Circle  does  not  appear  perfectly  round,  but
rather  flattened  at  the  sides,  if  viewed  on  a  graphic  monitor  with  square  pixels.
However,  it  will  appear perfectly  round  on a  video  reference  monitor if  this  has  the
aspect ratio defined here.

Notes

Field which shows warnings about the current configuration of the format of the image
when  anomalies  or  dangerous  situations  are  detected.  To  refresh  this  information,
activate the command Execute diagnostics (Mistika Setup->General->General).

HD Color Space (709)

If activated, this carries out  the color correction of the step from CCIR-601 to CCIR-
709 when doing 3:2 Pull Down renders. This option is only useful for HD versions. 

NTSC Fields

[False (True / False)]

If activated, the dominant, or first, field will  be  the  odd  number (NTSC standard).  If
not activated, the even number will be dominant (PAL and interlaced HDTV standard).

SGO Mistika  allows  the  mixing  of  interlaced  and  non-interlaced  (progressive)  clips  in
the same composition, and  you can always render with or without  fields, so there is
no configuration parameter to specify this aspect of the output format at  this moment
(in the case of captured clips, it  is specified  when they  are  captured).  Thus,  we  do
not decide here if  the clips we are going to produce are going to be interlaced (done
in  the  Output  tab  of  the  Node  Graph  Editor),  but  only  define  which  will  be  the
dominant  field  in  the  output  format  when the  images  are  played  back  interlaced  or
when rendered by fields. 

Note:  this  field  can  also  be  activated  to  invert  the  fields  in  the  output  to  the
interlaced stereo monitors (one eye per field), and these use the  odd-numbered  filed
as the dominant eye. This can be done even in progressive format, and in this case it
only affects the video output, which is what is needed. 

Main Frame Rate

[25 (numeric field within single inverted comma)]

Number of frames per second that define the playback in realtime of the image format:
25 for PAL, 29.97 for NTSC, 24 for 24p, etc. 
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Values with decimal points can be input, and also it  is possible to define the playback
speed of the graphics monitor (given that  the  video  output  is  defined  by  the  format
selected  in  the  central section central if  this  tab),  and  it  is  especially  important  to
maintain synch between image and audio tacks .

Speeds  that  do  not  correspond  to  any  video  format  can  also  be  defined.  In  these
cases, playback should be viewed in the graphics monitor, in the video output  cannot
reproduce at that speed, resulting in periodic skipping by one frame in the image. 

However,  it  is  important  to  remember that  Mistika  is  far more  optimized  for realtime
playback in the video output  than playbacks to the graphics monitor.

Note:  the  Monitor  Display  will  always  try  to  reach the  speed  defined  here,  but  the
indicator will show the speed that it has actually achieved to process the images (this
indicator is refreshed once per second). 

In  some  cases,  this  number will  be  seen to  drop  although this  does  not  necessarily
mean  that  the  playback  is  not  happening  in  realtime,  but  rather  that  it  has
momentarily  not  been able  to  calculate  the  necessary  number of  frames,  but  it  will
always have a certain number of pre-calculated frames to  deal with  these  situations
(RingBuffer parameter). In cases which realtime has been lost  in the output  of video,
another  indicator  "LostSync"  will  appear,  and  remains  onscreen  until  playback  is
stopped. 

Video board format (DVS Centaurus and Atomix)

Use DVS Video Board

[True (True / False)]

If True, the SDI video card (DVS models) is controlled from SGO  Mistika  and  audio  is
reproduced through its audio outputs. 

If  False,  the  SDI video  card  is  not  used.  It  must  be  deactivated  for  configurations
without  video board, or if  problems that  might  be related to the video subsystem are
observed, in order to carry out the relevant tests.

When deactivated: 

The audio is sent  to the audio output  of the mother board or equivalent  output.
If  active,  the  audio  is  sent  exclusively  to  the  video  board  with  its  own  audio
outputs, since this is the only way of achieving an output  synchronized with the
image.

If deactivated, the capture panel of SGO Mistika will try to use the port  Firewire
port to capture from a camera or DV type VTR.

Nota:  if  a  DVS  SDI video  board  has  been installed  in  the  Workstation slot  for the
first  time,  when  Use  Video  Board  is  activated,  it  will  be  detected  and  we  will  be
prompted to install the DVS driver automatically. This process can take more than an
hour, as, being  the  first  installation,  it  is  usually  necessary  to  compile  all  the  kernel
modules (depending on how the system has been installed).

Video Resolution

[PAL (PAL / NTSC / HD formats / 2K formats / 4K formats)]

Indicates  with  which  video  resolution  the  SDI  video  board  is  to  be  used,  both  for
playback and video capture. 
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The  resolution of  this  format  does  not  necessarily  coincide  with  that  of  the  image
selected (Render Format), although they will usually be the same. 

For example, we can work with Render Format  in HD dimensions but  have the output
of  the  video  in  PAL.  In  the  case  that  they  do  not  coincide,  the  parameters  of  the
section Multimastering are used to carry out  a conversion when the images are  sent
to the video output.

When capturing and dumping video, it  is essential  to  correctly  use  exactly  the  same
mode that appears in the VTR display. This is especially important  in HD 1080 formats,
since  for  playback,  some  VTRs  may  use  a  variant  of  the  original  mode  which  is
different to that in which the tape was recorded. For example, if a tape that  we know
was  recorded  in  1080_25p  is  to  be  captured,  and  we  see  in  the  VTR  the  mode
1080_25i displayed,  select  this  latter for this  parameter (or  reconfigure  the  VTR  so
that is does actually produce a 25p signal, if it is capable of doing so). 

For similar cases, remember that  SGO Mistika can capture images that  were  originally
recorded in progressive mode, although an interlaced signal is  used  to  capture  them.

In these cases, the interlaced mode can be  activated  for this  parameter,  but  in  the
tab VTR Capture select  the option No Interlaced (Node Graph Editor->Dashboard-
>VTR->VTR Capture->Fields Mode->No Interlaced).

Furthermore, high resolution formats  (HD,  2K,  4K)  may  require  additional licenses  for
the video board. If these are not  available, Mistika's console will show an error when
opening  the  application in  these  modes,  or alternatively,  Mistika  may  open,  but  the
video output will not work.

Video Frame Rate

[23 (23 / 24 / 25 / 29 /30 /47 /48 /50 /59 /60)]

Indicates the video frame rate with which the SDI video board is to be used, both for
playback and capture. 

Video Mode

[Progressive (Progressive / Interlaced / Segmented )]

Indicates  the  video  mode  that  the  SDI video  board  will  use,  both  for  playback  and
capture. 

Video Connector

[SDI (SDI / QUADSDI / DVI_HDMI )]

Indicates the video output mode to be used.

Color Space

[YUV_422 (YUV_422 / RGB_444)]

Physical input and output signals of the video board. According to the option selected,
the video board will  use an SDI Single Link connection (for YUV_422) or (in the case
of  RGB_444)  a  HD SDI  Dual  Link,  SDI3G or  DVI/HDMI  with  its  external  connectors.
Generally, use YUV_422 for most VTRs, except for models that can work with dual link.

Furthermore, in mode YUV_422, we indicate to the video board that  it  should use the
two outputs to send  YUV_422 (identical signal to  both connectors),  for example,  to
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send one to the VTR and  the  other to  the  reference  monitor.  On the  other hand,  if
RGB_444 (Dual Link) is selected, we indicate that  through input/output  1 a signal 422
is sent and through output 2 the remaining 022 signal.

As well as the VTR model Sony HDSR, it is also possible that we might  wish to use the
mode  Dual Link to  directly  connect  video  cameras  that  can work in  Dual  Link  mode
(such as Arri  D-20/  D-21,  Sony  F.23),  and  also  as  a  direct  connection to  Telecines
with dual link capacity.

With regard to the reference monitor, it is unusual to see better quality images in Dual
Link mode  (at  least  with  the  monitors  available  at  the  time  of  publication),  so  it  is
recommendable  to  use  YUV_422  single  link  mode,  or  the  DVI  output  of  the  DVS
Centaurus card. 

In the case of selecting a color space option different  from that  selected  in  Internal
Video  Storage  (which  is  possible  but  not  recommended  in  most  cases),  the  video
board itself will carry out the conversion, without requiring more resources.

Note:  as  well  as  the  two  SDI  outputs,  other  outputs  in  the  video  board  may  be
available (depending on the model): 

an output marked as "CVBS" for composite video

a DVI output  for monitors or projectors  that  support  low  frequency  DVI.  The
DVI signal transmitted is identical in resolution and frame rate to those of the
mode of video selected (24Hz, 25Hz,  30Hz  etc),  so  this  is  high quality  signal
but does not work with the majority of low/mid range monitors and projectors,
since  these  usually  require  a  minimum of  60Hz  (if  a  low/mid  range  DVI/HDMI
display  must  be  used  as  reference  monitor "Blackmagic  HDLink"  SDI to  DVI/
HDMI  converter  (or  similar)  is  required).  Consult  Mistika@sgo.es  for  more
details.

No analog audio output  is currently supported  with the SDI video board. If it
is  necessary  to  use  analog  speaker,  an  audio  converter  is  required  (for
example,  the  Blackmagic  HDLink  converter  above  has  an  integrated  de-
embedder with analog audio outputs).

Stereo Dual link

[False (True / False)]

Activates multichannel output of the video board for viewing in stereo.

Use 3Gb SDI speed

[False (True / False)]

Activates the support for 3Gbit for SDI. This only works if  the video board supports it
(Atomix for key-in-hand SGO Mistika models) with the format being used.

This option allows us to work with only one SDI with formats that  previously required
two.  However,  this  still  requires  both the  video  board  and  the  processor/s  through
which the image passes to support said format.

Notes

Field which shows warnings about the current configuration of the format  of the video
board and indicates the standard setting closest to the current configuration. 
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Auto adjust settings

[True (True / False)]

If active, this automatically changes a number of variables  when some  video  options
change, to maintain coherence with the standard settings.

Restart DVS video board driver

Tries to unload and reload the video board driver: use only for troubleshooting.

Other Video Settings

Internal Video Storage

[YUV422 (YUV422 / YUV422_10 / RGB_8 / RGB_10 / RGBA_8)]

Note: the values 8 and 10 correspond to the number of bits per channel that  are sent
between Mistika and the video board, as SDI signals are always 10 bits.

This indicates which color space  Mistika  will  use  to  send/receive  images  to/from the
SDI video board. Generally, this should be in the same color space that  the VTR uses
(generally, YUV_422_8 for most VTRs except for models like Sony HDSR and Arri D20 /
D21, and for image formats DPX10, R3D and others with high dynamic  range, for which
it  is  recommendable  to  use  YUV422_10  for  single  link  and  RGB_10  if  a  Dual  Link
connection is available).

For similar reasons, it will generally coincide with the parameter Color Space described
above, in the section Video board format. They will only differ when we  wish to  use
the  video  board  to  carry  out  conversions  between YUV  and  RGB (however,  even  in
these  cases  it  is  recommendable  to  consult  Mistika@sgo.esbefore  carrying  out  this
type of unusual combination, because they are only occasional usefulness).

On the other hand, when capturing images, the color space  defined  here  is  used  for
selecting the file format in which they are to be stored (RGB or YUV).

If Mistika needs to send an image that  is in the same format  as this parameter to the
video board, this step will be automatic. In the case that  it  is in another color space,
Mistika will carry out the conversion internally. 

Sync Source

[SYNC  INTERNAL  (SYNC_INTERNAL  /  SYNC_GENLOCK  /  SYNC_INPUT_1  /
SYNC_INPUT_2)]

Indicates which sync source the video board will use. Generally, we only use the mode
 GENLOCK when a  sync  generator is  connected  to  the  Ref.  connector  of  the  video
board. In other cases, we normally work in INTERNAL mode (the syncs are generated
internally).  Furthermore,  when  capturing  video  it  may  be  necessary  to  select
SYNC_INPUT_# mode  when no  sync  generator is  available,  to  avoid  an  invalid  sync
loop (this occurs if the VTR is trying to connect to the output of the video board while
the video board is trying to connect  to the output  of the VTR, a situation which may
occur depending on the configuration of the VTR).
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Mirror Left Eye

[False (True / False)]

Activates  a  mirror effect  for the  left  eye  when  working  in  Stereo  option.  Some  3D
Stereo displays are based on mirrors or reflective glass which apply only to the image
of one eye, so it must be inverted horizontally to neutralize the mirror effect.

Use Embedded Audio

[False (True / False)]

Activates or deactivates the video board sending or receiving embedded audio in  the
SDI signal. This affects both input signal (capture) and output (playout). 

Use SDI User Data

[False (True / False)]

Provides  support  for cameras  of  non-standard  speeds,  such  as  Panasonic  Varicam;
this eliminates frames duplicated by the SDI signal. These  cameras  record  duplicated
frames to achieve non-standard speeds (since the mechanical speed of tape is always
the  same).  SGO  Mistika  can  use  the  SDI  data  to  eliminate  the  duplicated  frames
automatically, and will also adjust the duration of the clip.

Drop Frame

[False (True / False)]

Activates/deactivates  Drop  Frame  mode  for NTSC format.  Drop  Frame  type  formats
discard a timecode (not a frame) periodically, so that  the timecodes always represent
exactly 30fps, although the true frequency of the NTSC video is only 29.97fps. 

TO find  out  whether the  video  tape  being  captured  is  in  Drop  Frame  format,  simply
look  at  the  TC  display;  traditionally,  a  decimal  point  or  semi  colon  is  used  as  a
separator  in  timecodes  (rather  than  a  colon);  thus  the  VTR  operator  can  easily
confirm whether the tape is in drop frame mode.

Edit Lag

[5 (0 / 20)]

Sets the number of frames of lag that  the VTR have. This value must  be indicated by
the  VTR  manufacturer.  Digital  VTRs  usually  have  a  lag  of  5  frames;  analog  VTRs
usually  have  a  lag  of  3  frames.  In  any  case,  this  value  must  be  correctly  set  for
editing  to  be  accurate.  If  when  transferring  to  tape  a  number  of  fames  of  lag  is
repeatedly  observed,  adjusting  this  parameter by  the  same  amount  will  correct  the
problem.

Restart DVS video board driver

Tries to unload and reload the video board driver: use only for troubleshooting.
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D-6 Codecs

Parameters for controlling the render processes  applicable  to  some  supported  compression
formats. These are typically the codecs  MPEG2,  Flash-FLV,  and  MPEG4,  although in  these
render formats there is also a "Custom" identifier for using codecs installed by the user. 

Note:  Some  user-installed  codecs  are  not  included  with  the  Mistika  distribution  because
they are subject to patents that exclude their use in certain cases. For example, the codec
h264 is  not  usually  included  in  Linux  distributions,  although  the  user  can  install  it  if  the
licence requirements can be met. Consult Mistika@sgo.es for more details about  this kind of
codec. 

Metadata  variables  for  R3D files  are  also  included,  which  can  be  forces  to  be  used  to
overwrite those provided in the file as default, which is  the  values  used  by  the  camera  in
filming.
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FFMPEG Codecs

Video bitrate

Video bitrate that  the render formats that  have  definable  audio  bitrate  (usually  FLV,
MPEG2, MPEG4, and CUSTOM) will use. The  higher the  bitrate  the  better quality  the
image will have; the file will also be larger file.

Note:  If,  when  reducing  this  parameter,  there  is  an  observable  reduction  in  image
quality, consider reducing the  output  resolution instead  of  the  bitrate,  as  the  global
result  will  improve  considerably.  It  is  also  recommendable  to  try  increasing  the
 parameter before reducing the Bitrate.

Note: For material recorded with poor quality or badly maintained cameras, the results
from the available bitrate can be improved by applying a Denoise effect. On the other
hand, for material deriving form graphics  or animation systems,  the  opposite  may  be
recommendable,   and  subtly  adding  noise  or dithering,  or even  blur  for  images  with
hard edges, may be desirable. These  techniques  produce  significant  improvements  in
terms of making the best of he available bitrate.

Audio bitrate

Audio bitrate that  the render formats that  have  definable  audio  bitrate  (usually  FLV,
MPEG2, MPEG4, and CUSTOM) will use. The  higher the  bitrate  the  better quality  the
image will have; the file will also be larger file.

GOP Size

Distance between 2 keyframes in compressed formats that  support  GOP (usually FLV,
MPEG2, MPEG4, and CUSTOM ).

A GOP Size set at 1 produces a file that is easily edited in other applications, because
all  the  frames  are  a  keyframe  (compression only  occurring  between  frames).  Values
other  than  1  define  the  number  of  consecutive  frames  for  which  only  significant
differences  from the  previous  frame  will  be  represented,  taking  better advantage  of
the available bitrate but  losing the possibility of navigating to (or close to) a specific
frame  in other applications. Very high values may cause the opposite  effect  to  that
desired, and worsen image quality. A value of 5 is usually a good starting point.

Intall additional ffmpeg user codecs

Allows the installation of external codecs that  are not  provided by  default  in  Mistika,
as well as versions and profiles of existing codecs sucha s MOV and MXF. To carry out
the installation, the codecs should be compressed in .tar, .gz o .tgz, and be valid for
the version of Linux being used.

Uninstall ffmepg user codecs

Restores  the  codecs  library  to  its  original  parameters,  eliminating  codecs  installed
manually by the user.
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RED

The following parameters  define the default  behaviour when importing R3D files.  They  can
later be  changed  from within  Mistika  individually  for  each  file,  via  the  effect  R3DParams
(Node Graph Editor->Dashboard->Fx->Mistika->Color->R3DParams)..

The variables that appear can be defined in the RED camera, and in Mistika we can decide if
we want to use the value defined by the camera operator, force the variable to a standard
value, or give it a value defined by the user.

RED cameras record sensor information in the most optimized way possible, independently of
the  values  assigned  by  the  operator for  these  settings.  These  values  only  influence  the
previsualization  that  the  camera  provides,  but  do  not  modify  the  data  provided  by  the
sensor which are saved independently in the R3D file. Thus values  are  only  metadata  that
accompany the image file, and so can be changed later without losing information.

Variable

Name of the variable that  defines a parameter provided by  the  metadata  of  the  R3D
file.

Value

Current  value  for the selected variable. This can be  changed  to  a  value  set  by  the
user.

Description

Description of the variable and its possible values.

Force Value

If  forced,  all  R3D clips  will  use  this  value  by  default.  If  not  activated,  the  value
defined by the camera operator will be used. 

Forced

List of variables that are currently forced to a value.

Unforced

List  of variables that  are not  forced  to  any  value  (and  will  therefore  use  the  values
defined by the camera operator).

Force all variables (R3D metadata will not be used at all)

Forces  all  variables  to  the  values  defined  for  them (or  their  recommended  default
values if they have not been changed by the user).

Do not force any variable (only R3D metadata will be used)

Does not force any value, using metadata of the R3D file for all of them.
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Reduce factor

[2 (1 / 2 / 4/ 8)]

Factor  of  reduction  of  when  carrying  out  a  Debayer  process,  as  compared  with
nominal resolution of the Bayer matrix.

RED cameras do not provide pixel map in their file format  but  rather the original image
must be reconstructed from various premises; RED cameras use a Bayer matrix in their
sensor,  which is  to  say  that  each  original  pixel  only  provides  one  color  component
(red, green or blue). Also, part  of  the  original detail  is  lost  when compressed  to  the
JPEG2000 format,  and  also  as  a  result  of  the  noise  signal of  the  electronics  of  the
camera  itself.  As  a  result  of  all  of  this,  the  image  must  be  reconstructed  from
mathematical approximations, and ReduceFactor is the value that gives us the relation
between the number of elements of the Bayer sensor and the number of RGB pixels of
the final image.

The recommended factor is generally a value of 2 (an image shot  in R3D-4K format  in
Bayer  color  space  will  produce  a  2K  image  in  the  final  space  of  the  three  color
components per pixel).

It is sometimes possible to obtain a useful resolution by applying a value of 1 (at  the
cost  of  increasing  render  process  time  by  4  times),  although  normally  this  only
produces additional noise. A way of comparing both versions is to compare the result
in 4K with the 2K version rescaled to 4K (with maximum quality of 15Taps). This way
we can compare and choose the version that gives the best quality. 

A common error is to think it  is necessary to use  a  value  of  1  to  obtain  the  highest
quality, even if  the final format  is 4K or greater. In the majority of cases, there is no
difference between using a value for ReduceFactor of 1 or 2, and in many  cases  the
version resulting  from a value of 2 will be of better quality, as it  will have less noise
than when the  ReduceFactor=1.  Nose  reduction is  especially  important  in  3D Stereo
formats, where it  must  be considered over other aspects. A value of  1  must  only  be
used rarely, in cases where it has been checked that it produces no increase in noise.

Values  of  4  and  8 lose  quality  and  are  only  recommended  for  versions  in  SD (PAL/
NTSC) format and for dailies.

Optimize

This field shows recommendation according to selected values for different  parameters
in MistikaSetup.

Refresh optimization recommendations for R3D files

If we have changed parameters of MistikaSetup, the updates the recommendations.



69Mistika SETUP (mConfig)

SGO Mistika 8.6 © 2018 SGO

D-7 Performance Options

This  area  allows  the  modification of  different  parameters  related  to  render processes.  Its
window is shown below: 

Max Cache Memory

[2048 (0 / 8000)].

The  maximum amount  of  system cache  memory  to  be  used  by  the  software.  This
amount  of  RAM is  used  to  keep  the  latest  images  read  by  Mistika  available  for  any
purpose, avoiding the need to re-read them from disc whenever possible.

Another possible  use  is  when  sufficient  reading  speed  is  not  available  to  view  the
format  being  used  in  realtime.  If  sufficient  memory  is  available  we  can increase  this
value so that the whole shot being worked upon can fit into the cache, so that  it  can
be viewed in realtime.

Furthermore, in cases of system instability, owing to lack of memory, this is one of the
first parameters that should be reduced to the minimum. 

Playout Ring Buffer 

[40 (10 / 128)]

Number of frames stored in the buffer of the video output. 

During video playback, the system tries to process the frames faster than realtime to
have a security buffer to absorb I/O or processing peaks, up to this value, maintaining
it  at  the same if  possible.  This  allows  for a  buffer of  images  for maintaining  realtime
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when otherwise it  would not  be possible, because of peaks in CPU or input/output  to
disc. 

If this value is too high, RAM will be wasted. If it is too low, realtime may be lost. The
default  value  is  usually  sufficient,  although  if  unexplained  Lost  Sync  errors  are
observed it should be increased. 

The  number  of  available  processed  frames  in  this  buffer  is  represented  by  the
character "+" at the top of the Node Graph monitor.

Play Buffer Threshold

[400 (25 / 128)]

Mistika has a guaranteed playback mode called PlayBuffer (a Play icon with a B, in the
Shuttle  of  the  Node  Graph).  In  this  mode,  before  starting  playback  the  number  of
frames defined  in  this  field  are  processed,  so  that  when playback starts,  a  security
buffer is  available  to  help  manage  complex situations,   or  to  carry  out  playback  of
certain clips for which sufficient performance is not available in realtime.

Note: Material transferred to tape will always use this play mode (PlayBuffer).

Note: The default  value is set  automatically when opening mConfig for the first  time,
depending  on the  amount  of  memory  available;  it  may  not  coincide  with  the  value
indicated in this manual.

Hardware Rendering

[True (True / False)]

Activates or deactivates the acceleration of hardware (GPU) during render processes.

When  active,  most  effects  are  processed  directly  in  memory  of  the  graphics  card
using its GPU, which greatly accelerates the process. The amount  of graphic  memory
needed depends on the resolution of the image format, on the number of Inputs of the
most  complex  effect  and  on  the  resolution  of  the  graphic  mode  of  the  interface
(adding together both monitors, if there re two), so the limits to which it is possible to
render by hardware depend on each different case.

Note: Many effects currently only work if this parameter is activated, so it should only
be  deactivated  for  troubleshooting  the  graphics  system under  the  guidance  of  the
technical support team.

Hw. render in monitors

[True (True / False)]

Activates or deactivates the acceleration of hardware (GPU) in the evaluation of  the
Node Graph monitors and render processes. It  should only be deactivated for very old
graphics  cards  or  if  they  originate  manufacturers  other  than  Nvidia,  in  cases  of
observing that effects either produce incorrect results or do not work at all.

Create Proxy Previews

[False (True / False)]

Indicates  whether  proxies  should  be  created  when  capturing  a  video  clip.  If
deactivated,  the  proxies  will  have  to  be  created  each  time  they  are  required  (and
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they  will  not  be  saved  to  disc),  thus  consuming  greater  disc  bandwidth,  so  it  is
recommendable to activate this option whenever sufficient disc space is available, and
especially in the case of using shared storage between several systems. 

Low Res. Ratio

[2 (2 / 4 / 8 / 16 / 32)]

Factor of reduction of the preview images or Proxies in low resolution, and of playback
in low resolution (Mistika Setup->Interface->Playback Resolution). For example, if
we have PAL (720x576) and we set  a value of 2, the proxies will have a resolution of
360x288.

Proxy versions may be obtained in various ways:

Automatically  when  capturing  video  (MistikaSetup->VideoI/O-
>CreateProxyPreviews).

During  a  render if   Proxy  Image  (Node  Graph  Editor->Dashboard->Output-
>Render->Proxy Image) mode is activated. 

If a render is carried out  to create proxies via  the  command Redo  Proxy  (Node
Graph Editor->Dashboard->Output->Render->Redo Proxy).

These  low  resolution versions  are  used  in  the  monitors  and  the  Visual  Editor  if  the
Proxy in Monitor Display is active. 

In these modes, when they are not saved to disc, they are produced on-the-fly in the
RAM  memory  and  are  then  discarded.  Proxies  allow  more  rapid  access  to  disc  or
processing of images, but at the cost of temporary loss of image quality.

The creation of proxies is described in more detail in the chapter about the tab Output
.

Parallel CPU Cores

[2 (2 / 64)]

Number of  system processor  cores  that  we  wish  to  use  (this  requires  SGO  Mistika
licensing,  according  to  the  number  of  processors).  It  is  recommendable  to  set  the
total number of cores of the workstation, although this can be reduced if  we wish to
reserve cores for other simultaneous applications.

Encode Threads (j2k...)

[24 (2 / 64)]

Number of parallel render processes intended to process certain complex codecs (such
as j2k and VC-3).

The most  common use is for creating  DCP.  It  is  recommendable  to  set  this  value  at
the same as Parallel CPU Cores.

Read from multiple disks

[False (True / False)]

Activates  or  deactivates  the  reading  of  sequences  of  files  from  different  storage
discs. It  allows the doubling of I/O Threads, for sequences from different  discs to  be
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read  simultaneously.  However,  it  should  be  deactivated  if  the  sequences  are  in  the
same disc, as it slows the operation if configured to search on other discs.

I/O Threads

Indicates  the  number  of  parallel  processes  for  decoding   sequences  of  images  of
formats  such as  DPX  and  R3D.  Normally  this  should  coincide  with  Pipe  Units.  When
there  are  2  streams  located  in  different  discs,  it  is  recommendable  to  double  the
number of Pipe Units.

Pipe Units HighRes

[8 (1 / 16)]

Indicates the number of consecutive images of a clip that  are read or written in each
simple read/write operation. It is used to optimize input/output to disc. 

Important  note:  this  parameter  affects  the  reading  of  all  images,  not  only  those
contained in the realtime storage buffer, but also those that have been referenced via
links to other locations. 

Its  value  especially  affects  those  effects  that  use  several  clips  at  the  same  time,
such as  Mix & Wipes  and  others,  and  also  the  shared  storage  environments,  so  in
these  cases  it  is  much  better  to  read  several  frames  of  each  clip  in  each  disc
operation. This reduces the seek time of the discs. 

In the specific  case of the DPX format, the value of SNFS->Threads is used to carry
out its parallel reading, so this must be defined in the relevant section.

Furthermore it  is recommendable to leave the value at  the minimum (1) when dealing
with especially large formats (such as 8K) whose buffers may  use  large  quantities  of
memory, and also  for smaller formats  that,  owing  to  the  equipment  in  use,   will  not
provide realtime processing under any circumstances,  as  this  will  free  memory  space
and,  also  allow  playback  speed  to  be  more  or  less  constant,  instead  of  by  frame
packets of the defined size. 

Pipe Units LowRes

[8 (1 / 32)]

Has  the  same  meaning  as  the  previous  section,  with  the  difference  that  it  is  for
reading proxies in LowRes mode.

Render Units

[5 (1 / 16)]

Indicates  the  number  of  frames  that  are  processed  simultaneously  and  in  parallel
during  a  render process.  Generally,  it  is  recommended to  set  a  value  similar  to  the
number of CPUs available, to optimize the processing of formats that  can be done on
parallel, such as R3D.  However, this uses more  memory,  so  when working  with  very
high resolution images,  or little  RAM is  available  it  may  be  necessary  to  reduce  this
value.

This  parameter  does  not  affect  Totem-type  render  nodes  which  have  their  own
equivalent  parameter  TOTEM->cluster  Render  Units.  It  does  affect  Batch  Render
types.



73Mistika SETUP (mConfig)

SGO Mistika 8.6 © 2018 SGO

Backload Buffers

[True (True / False)]

Allows  the  complete  deactivation  of  all  the  image  buffers.  This  should  only  be
deactivated  for extremely  large  formats  that  use  too  much  RAM,  given  that  it  will
impede realtime playback of the image.
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D-8 Batch Manager

This group of options controls how render processes are carried out  in the additional render
nodes (Totem) and the management render queues (Batch Manager).

Batch Manager

Use Batch Manager   

[True ( False / True)]

Activates the Batch Manager.

Note:  When activated,  it  allows  exiting  from an emerging  window  if  permissions  for
other clients are not  configured. A configuration request  will appear, and  a  password
is  needed.  Mistika  is  configured  to  carry  out  the  rest  of  the  required  actions
automatically.

Render when Idle

[True ( False / True)]

Allows the current machine to run as render node when no task is being processed.

Start Batch Manager on boot

[True ( False / True)]

Starts  up  the  Batch  Manager  in  the  current  machine  when  booting  if  it  does  not
detect any other active render node.
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Manage Batch Render Nodes

Opens  a  window  that  allows  the  management  of  the  Batch  Manager  render  clients.
They  can be  activated  or deactivated,  without  needing  to  stop  the  Batch  Manager
that is working at the time (as long as there is at least one always active).

o Render Queues Path

Set  the  path  where  the  Batch  Manager  can  find  the  different  directories  with  the
render queues. 

Queue for Cache jobs

Set  the  path  where  the  Batch  Manager  can  find  the  different  directories  with  the
cache render queues. 

o Batch Manager GUI

Launch the BatchManagerGUI application.

Autorefresh Node Stat.

If selected, the Batch Manager auto-update the  situation of  the  render nodes  when
they succed or fail, for example. 

Render retry attempts

[1 ( 1 / 32)]

Sets a number or retry attempts for failed render processes.

Quarantine failing nodes

[True ( False / True)]

Indicates if nodes that fail after all retried render attempts should be quarantined and
temporarily deactivated.

Deactivate failed nodes

[True ( False / True)]

Indicates if quarantined nodes are deactivated if another node successfully carries out
the same render.
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Batch Manager GUI

Render Queues List

List of all defined render queues with informative columns regarding priorities, pending
(scripts .rnd script yet to be run), done and failed jobs, and those in progress.

Queue folder name

Name to be assigned to the render queue  and  the  folder that  contains  the  different
scripts of the same queue.

Priority

Priory of the render queue  as  ascending  numbers:  the  higher the  number the  higher
the priority for the render queue.  If  render queues  have  the  same  number assigned,
the Batch Manager will alternate between one and the other for render processes. It
is always necessary to define a priority, even if there is only on render queue.

Queue Management

Change priority for selected queue

Allows redefining the render queue priority selected.

Browse selected queue

Opens the system browser of the render queue folder (it  will have the same name as
appears in Render Queues List).
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Browse DATA/RENDER folder

Opens  the  system browser  of  the  /DATA/RENDER  folder  of  the  last  project  opened
(indicated in Node Graph Editor->Dashboard->Project->Current Project).

Create new render queue folder

Creates a new folder and its corresponding queue in the list  with  parameters  defined
for the name and priority.

Remove selected queue folder

Eliminates the selected render queue and its corresponding folder.

Manage Queue content

Allows  the  running  of  actions  for  recycling  information  contained  in  the  folders
indicated  in  the  render queue  list:  delete  files,  file  log,  delete  failed  render  scripts,
delete pending render scripts, and rename failed render files with their original name.

Batch Manager Status

The Batch Manager Status indicates whether any active Batch Manager is working or
not, and if  so, it  indicates messages regarding its status (if  it  is  working  correctly  or
not).

START BatchManager

Starts the BatchManager.

STOP BatchManager

Stops the BatchManager, if it is working.

Manage render nodes

Allows the same window as the Manage Batch Render Nodes to be opened in order to
active render clients, their current status, to add or delete render clients.

Close

Closes the Batch Manager.

Mode of use: When a render script creation is run with the option Write Script Only of
 Output, copy the .rnd files of the different  segments required to be rendered in  one
of the directories created here (if  we have not  already written here directly with the
tool If Write Script, place it->Queue->name_of_queue Output). Once copied, the
 Render Queues List  will update the  new  .rnd  that  we  have  copied  as  pending  jobs.
Once  copied,  click  on  START  BatchManager  and  if  the  queue  where  the  new  .rnd
scripts have been copied has high priority, the renders will  start,  and  a  progress  bar
will appear.

If  a  .rnd  script  fails,this  will  be  renamed  using  the  name  ..unexpectedlyExited  (for
example, a test file called test.rnd would become test.rnd..unexpectedlyExited), giving
us information regarding failed renders. For more information, consult the log.
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Mail Notifications

Mail events

[None  (  None  /  Node  Fail  /  All  Render  Failures  /  All  Failed  and  Successful
Renders / Only Successful Renders)]

Selects the type  of  event/s  required  for sending  email  notifications  (the  failure  of  a
render  node,  failed  renders,  both  failed  and  successful  renders,  or  just  successful
renders).

email addr. for render reports

Field for writing the email address to which the reports/notificationsare sent.

Render Errors

[One Mail per File ( One Mail per File /One Mail per Rendername Batch)]

Allows the selection of whether notifications are sent  for each individual failed render
file or or for each each common render block (contained  in  the  same  folder within  /
RENDER when they are created).

Render Success

[One Mail per File ( One Mail per File /One Mail per Rendername Batch)]

Allows  the  selection of  whether notifications  are  sent  for each  individual  successful
render file  or or for each each common render  block  (contained  in  the  same  folder
within /RENDER when they are created).
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D-9 TOTEM

Use Totem

Default value: False 

Range: True / False

Description: Activates the manager of the distributed system. Once this parameter is
activated, and the clients have been defined, it is recommendable to enter Mistika and
check  that  the  Output  tab  (Node  Graph  Editor->Dashboard->Output->Totem)
shows the render clients that have been set.

Manage Render Nodes

This  opens  a  window  that  allows  the  management  of  render  clients  (as  they  are
defined in the file Mistika-ENV/.clients).

Cluster Render Units

Default value: 3.

Range: from 1 to 25.

Description: Number of consecutive frames sent  to each render client  when work is
distributed. When a client finishes processing the first packet of frames, it  receives an
order to calculate a new packet of a size determined by this parameter.

Every  time  a  client  needs  to  read  an original clip,  all  the  frames  necessary  for  the
packet that is being processed with be read once, so that  this parameter affects the
optimization of disk read speed. In NFS configurations low values should be used (from
1  to  3),  but  it  is  advisable  to  increase  it  significantly  when  working  with  SAN
configurations,  to  take  advantage  of  the  greater  bandwidth  available  with  such
configurations when carrying out sequential readings.

However, if too high a value is used, it  may result  that  when rendering a few frames,
some customers will not receive packets of frames to calculate.

Note: When using the TOTEM render distributor,  we  recommend working  in  an SAN-
type infrastructure, using Mistika’s native image formats, because this allows the pre-
assigning of consecutive space for images and does not  affect  the real-time features.
However,  when  using  numbered  file  formats,  we  lose  reproduction  features,  since
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frames are not stored in their natural numerical order.

Cores per node

Default value: 8.

Range: hardware dependent.

Description: Indicates  how  many  core  processors  (nuclei)  there  are  in  each render
node.

o Default Instances

A physical node can act  as  multiple  virtual nodes,  one  per instance.  Only  increasing
for non GPU render.

Totem Manager

This tool is for managing  render clients, as specified in the file Mistika-ENV/.clients.

Note: if  we wish the Mistika  workstation itself  to  be  another render client  (which is
recommended), it must be added as such in the file. If  it  is activated, it  will be easier
to control its participation in the process: if  render with Totem is done in Foreground
mode,  the  local  workstation  can  also  participate  in  the  calculation;  if  done  in
Background mode it will not.

The  window  that  appears  contains  one  render  client  per  line,  together  with  the
buttons for adding and deleting clients and useful information about  the current  state
of the each client:
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D-10 Interface

This  area  allows  modification  of  the  different  parameters  relating  to  the  user  interface
configuration. The window is shown below: 

Interface

Double Buffer

[False (True / False)]

Activates/deactivates  the  use  of  double  buffer  in  the  graphics  monitors  of  the
interface. It  is important  to activate  this  parameter when the  playbacks  need  to  be
seen  in  the  graphics  monitor  instead  of  in  the  video  output,  if  there  is  sufficient
memory in the graphics card to maintain a double buffer.

If it  is not  activated, during playbacks to the graphics monitor, the scan line may  be
visible, which might be annoying.

When activated, the  images  are  not  drawn directly  in  the  graphics  monitor,  but  are
drawn first  in a virtual buffer, which is instantly seen as it  coincides with the change
in vertical synchronism of the  monitor.  Thanks  to  this,  the  playback to  the  graphics
monitor will be cleaner and free from scan artifacts.



82 Mistika SETUP (mConfig)

SGO Mistika 8.6 © 2018 SGO

This  parameter  only  affects  playbacks  made  in  the  graphics  monitor,  and  not  to
playbacks sent to the video output.

Playback Resolution

[RES_HIGH (RES_HIGH , RES_DYNAMIC , RES_LOW)]

Sets  the  default  mode  for  playbacks  in  Node  Graph,  either  in  high  resolution  (
RES_HIGH)  or  in  low  resolution  proxy  mode  (RES_LOW).  The  mode  RES_DYNAMIC
effects  playback  in  low  resolution  but  toggles  to  high  resolution  when  playback  is
stopped, which is useful for formats that  cannot  be processed in real time but  which
we want to set in full definition in pause mode.

Note: When switching to low resolution, firstly, the low resolution files that  make  up
the proxies of the image are looked for, and if  they are not  available,  high resolution
images are read, and on-the-fly proxies are obtained, and then the rest  of the effects
are processed in low resolution. 

Live Video by default

[False (True / False)]

Sets the  SDI video output as default when opening Mistika.

Two Monitors

[False (True / False)]

Activates  the  two  monitor layout.  If  activated,  Mistika  will  use  one  monitor  for  the
editing  interface  (Node  Graph Editor)  and  the  other for  the  composition  interface  (
Visual Editor).

Note:  In  general  only  “side  by  side”  monitors  are  supported.  In  special  cases,  a
monitor  may  be  configured  on  top  of  another,  but  it  is  recommendable  to  consult
Mistika@sgo.es,  since  this  requires  a  highly  specialized  X-Windows  configuration  (to
allow  the  cursor  to  move  from  one  screen  to  the  other  vertically  rather  than
horizontally, and other details).

Monitor Gamma

[1.0 (0,5 / 2)]

Sets the gamma value of the graphics monitor. Common values are 1.7 to 1.0 for CRT
and LCD,  although generally  this  depends  on each monitor and  lighting  conditions  in
the physical workspace.

In  any  case,  this  parameter only  affects  the  interface  and  never the  render of  the
images or the SDI reference output.

Once set, press the button Load New Gamma, which lies just below the number, for it
to take effect.

Manage Edit->Extras > Buttons

Allows the addition of commands to mConfig via which personalized scripts can be run.
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Rank Mode, British Style

Rotates  the  color trackballs  of  the  Color  Grade  effect  to  appear  as  they  would  for
British colorists' standard use. 

Change settings for Nvidia graphic boards

Runs the Nvidia application, which allows us to configure other values of the graphics
card,  such  as  checking  its  temperature.  Mistika  make  intensive  use  of  render  by
hardware,  so  in  cases  of  stability  problems  it  is  recommended  to  check  that  the
operating temperature is not exceeded.

In  the  case  of  using  video  splitters  for  connecting  a  projector  and  a  monitor
simultaneously, it is recommended to power up the system with only the projector (or
the device which is most  complicated to synchronize), configure it  in  this  panel,  and
finally, connect the splitter. 

One typical use of this tool is when a second monitor is installed or disconnected but
we do not want to reboot the system. The recommended method for these cases is to
activate the following button:

Nvidia-settings->XServerDisplayConfiguration->Configure->TwinView

In the  case  of  wanting  to  change  monitors  for ones  with  a  different  resolution,  the
system will automatically try to adapt, although if it is not successful, use:

Nvidia-settings->XServerDisplayConfiguration->Resolution 

Edit Hotkeys

Allows  the  personalization of  Mistika's  hotkeys.  Take  are  when carrying  this  out,  as
the edting can replace either the originals or the previous ones.

Restore original hotkeys

Restore the default hotkeys map file. 

Checker missing media

If Off, missing media will appear black. If On, there will be a checkerboard warning.

Tablet Device options

Tablet Max. Press

Maximum value for pressure on the graphics tablet.

Tablet Min. Press

Minimum value for pressure on the graphics tablet.
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Min. Move Threshold

Minimum  value  below  which  the  pen  is  considered  not  to  be  moving,  to  avoid
vibrations.

Title Options

Use Unicode

[False (True / False)]

Defines whether Unicode is used as character codification. It  should be activated if  it
is necessary to use non-western characters, such as in Asia alphabets.

Default Font

Editable text field which shows the route for the character type to be used by default
in a working session in Mistika.

Use Input Method

[False (True / False)]

Activate this for characters which need  input  from multiple  keyboards  for creating  a
single symbol, for example when using various Asian languages.

Font Size Default

[10 (0 / 50)]

Defines the default size of the text in a working session in Mistika

VirtualSlate font

Defines the font type that will be used in Virtual Slate function.

Open Fonts Folder

Open the font folder, where the user can install new fonts: /usr/share/fonts/mistika

Render Interface

Render to Video 

[False (True / False)]

If active, the render produced by Mistika is also directly sent to the video output. This
parameter must  be deactivated carefully as the workstation needs to receive correct
video  synchros  (or  at  least  the  functioning  of  internal  synchros),  or  the  render
process will be interrupted or may not  even begin. The main use is for monitoring the
progress of a render from any location connected to the same video patch.
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Render to Graphics

[True (True / False)]

If  active,  the  images  produced  during  a  render  are  shown  in  the  graphics  monitor.
Otherwise, only a small window showing the progress of the render will be shown.

Default render name

[True (True / False)]

Defines the default  name that  appears in the  field  Auto  Name  (Node  Graph Editor-
>Dashboard->Output->Render->Render  Name),  to  which  will  be  added  a
numerical counter (this counter appears in the panel of  the  render as  an informative
title). 

Save before render

[True (True / False)]

If  active,  (recommended),  Mistika  saves  the  environment  before  starting  a  render
process. It can be deactivated for very large environments if the time required for this
operation becomes excessive.
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D-11 License

Licence

Lic. Expire warning

[10 (1 / 15)]

 Number of days warning the system gives before expiry of a temporary user's licence
is due.

The remaining parameters refer to obtaining a licence and are self-explanatory:

To request an SGO Mistika licence, install the software and then provide the following
information to your system provider: 

Exact version of the software for which the licence is required. 

Workstation model and CPU number. 

Videoboard model (SD/HD) and its additional options. 

If Tangent Device correction surfaces are available. 

Maximum render resolution permitted.

The LMdata codes and Mac Address, provided in this section of the mConfig.

Once  the  activation  codes  have  been  received,  follow  the  instructions  provided  in  this
window to activate the software. 

Note: Changes to the system hardware after the application for the licence may invalidate
it.
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Expiration

Data field that shows the expiry date of thee licence.

LMData

Data field that shows the LMData code.

This field can be selected and copied to another application (such as an email) using
the central mouse button.

Mac Addr.

Data field that shows the MAC address.

This field can be copied like the LMData.

Open License File

Allows the MistikaV5.dat  file to be opened: this field contains the activation code for
the licence. Thus it  is possible to renew the licence  via  mConfig,  without  needing  to
replace the old archive. 

The MistikaV5.dat file is found at: /var/flexlm/MistikaV5.dat.

Change License File

Allows the file that will create the licence to be changed without needing to rename or
modify other licences.

Restart License Server

Allows reconnection with the licence server.

Online Mistika licence request

If the Mistika licence expires outside the period of technical support offered by SGO, a
temporary licence can be requested online.
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D-12 SNFS© S.A.N.

SNFS is a top-of-the-range SAN-type filesystem for storage  infrastructures,  integrated  as
an OEM product within SGO Mistika. 

In general, the external storage provided by SGO is configured with this type of  filesystem
and  each  Turnkey-type  SGO  workstation  delivered  with  external  storage  comes  with  a
user’s licence. 

High-speed connections between other workstations such as Linux/Windows/Apple and  the
shared storage of SNFS© requires additional user’s licence, such as a Switch Fibre Channel.

For this  solution to  function properly,  it  is  necessary  to  use  versions  of  SGO Mistika  that
have  extensions  allowing  communication  with  SNFS.  Before  planning  a  new  SAN,  it  is
recommendable to send a full description of the requirements to Mistika@sgo.es to obtain all
the information and recommendations that may be necessary. 

The OEM SNFS© solution is supplied as optional software, and allows  storage  sharing  with
large  bandwidth  between  all  SGO  Mistika  stations,  as  well  as  with  systems  of  other
manufacturers, creating a SAN infrastructure. 

In a SAN, all stations are directly connected to the same disks, thus avoiding file transfers
across  an  Ethernet  network,  therefore  providing  real-time  uncompressed  access  to  all
stations simultaneously. 

The same SNFS© filesystem can be set-up simultaneously in Linux, Irix, Windows XP/Vista,
Mac  OS-X  (X-San),  stations  etc.,  for  which  reason  it  is  recommended  to  include  all
production stations of other systems  that  need  to  share  files  with  large  bandwidth  in  the
SAN. 

It  is also recommendable to include a bridge system for exporting the contents of the SAN
to the network stations that do not have direct access to the SAN.

If there is more than one station connected to the SAN stations SGO Mistika should not  act
as SNFS© metadata servers. It  is  recommendable  to  install  a  dedicated  metadata  server,
usually  through a  Linux MDC system that  manages  the  metadata  of  the  filesystem (until
that moment, SGO Mistika will act both as metadata server and client). 

SNFS© software is currently provided on delivery with all SGO Mistika systems. To install it
onto systems of other manufacturers follow the instructions of the software component  and
acquire the relevant additional licences.
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SNFS©

SNFS Server

Identifies  which  metadata  controller  (MDC)  is  configured  (if  the  SNFS©  option  is
available). This parameter indicates the filesystem server and if  it  is accessible on the
network (it  can be the local machine when there  are  no  other stations  in  the  SAN).
This  parameter is  purely  informative  and  cannot  be  changed  in  this  window.  If  you
need to modify it, see the installation guide for SNFS©.

Use SNFS Storage

[True (True / False)]

Activates/Deactivates  SNFS  service.  When activated,  it  carries  out  various  checks,
autoconfigures certain options on first  use and informs of possible problems, and thus
is a useful diagnostic tool when encountering problems with SNFS©-type storage.

Important Note: Before deactivating this button, close  all  applications  that  may  be
using  the  SNFS©-type  storage,  otherwise  they  will  become  blocked  and  possibly
obstruct the use of this button.

SNFS Vers.

Indicates which version of Quantum Storenext SNFS© filesystem is installed.

Version 3.1 posterior is required. 

SNFS preallocation

[True (True / False)]

If active, before video capture or beginning a new render, Mistika communicates with
SNFS© to  create  a  new  file  optimized  for real-time,  forcing  the  assignation  of  new
disk  blocks  for  successive  frames,  with  this  blocks  also  aligned  to  disk  stripes  to
maximize  bandwidth  and  avoid  disk  fragmentation.  If  you  are  using  SNFS©,  we
strongly  recommend  this  parameter  is  always  active.ndiscriminate  increase  of  this
value may take up an excessive amount of memory.

SNFS Lic.

SNFS© licence expiry date.

SNFS© diagnostic and repair tools

See SNFS labels of the available disks

Displays all the SNFS© disks available. 

A SNFS© filesystem is usually made up a various, and if the connection with one fails,
we can check using this option (the complete list of disks that  appears will depend on
each  SAN  infrastructure,  and  coincides  with  the  contents  of  the  files  for  defining
such, as found in the folder /usr/cvfs/config).



90 Mistika SETUP (mConfig)

SGO Mistika 8.6 © 2018 SGO

Stop/Start SNFS services and mount/umount SNFS disks

Tries to mount  all the SNFS©-type filesystems that  are configured. This is  useful for
diagnostic and maintenance operations.

Before unmounting these filesystems close all applications that are in use.

Diagnose and repair an SNFS filesystem

Provides a list  of SNFS© filesystems available, in order to select  one for analysis.  An
autocheck/repair  process  is  then  carried  out  on  said  filesystem,  which  may  take
several minutes, depending on the number of files contained.

This is a useful tool if the storage system is observed to be functioning incorrectly, eg
after a power down.

Before  activating  this  tool,  close  all  applications  that  are  in  use  by  the  selected
filesystem.
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D-13 Tangent Devices

Two different  types of Tangent  Devices control surfaces can be connected and configured
for color correction: the model CP200 and the model Elements. 

It always is recommendable to use the full set of devices of either surface, since this is the
only way that the color corrector can be used in its entirety.

Note: If two  or more  SGO  Mistika  systems  are  on the  same  network but  only  one  set  of
Tangent Devices control surfaces, activate the following options in only one of the systems
at a time.

Note: If assignations inconsistent with the values defined below are set, common problems
will arise when using DHCP systems in the same network.

Note:  If  neither  of  the  control  surfaces  activates  when  opening  SGO  Mistika,  the  most
probable cause is that  an SGO Mistika licence that  supports  these  devices  is  missing  (this
support is  not included as an option in the most basic SGO Mistika systems).

CP200

Note:  the  IP  addresses  mentioned  below  may  be  any  as  long  as  they  are  in  the  same
segment  of the network as the SGO Mistika station. These  addresses  will  be  automatically
assigned to the control surfaces when starting the SGO Mistika application (to  check their
correct  functioning,  these  addresses  will  be  shown  briefly  in  the  displays  of  the  devices
when starting SGO Mistika and will appear in the color correction menus on their screens).
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Trackerballs (CP200-BK)

Use CP200-BK

[False (True / False)]

Enables use of the CP200-BK.

IP Address

IP Assigned to the CP200-BK.

Identifier

Identifier of the CP200-BK. It is a number assigned by the manufacturer. It  is obtained
by turning on the CP200-BK.

Knobs(CP200-K)

Use CP200-K

[False (True / False)]

Enables use of the CP200-K.

IP Address

IP Assigned to the CP200-K.

Identifier

Identifier of the CP200-BK. It is a number assigned by the manufacturer. It  is obtained
by turning on the CP200-K.

Transport & Selection (CP200-TS)

Use CP200-TS

[False (True / False)]

Enables use of the CP200-TS.

IP Address

IP Assigned to the CP200-TS.

Identifier

Badge of the CP200-TS. It  is a number assigned by  the  manufacturer.  It  is  obtained
by turning on the CP200-TS.
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Common Network parameters

Net Mask

[255.255.255.0]

Describes which subnetmask to use.

Gateway

IP address of the gateway. It is necessary to use this value if  the control surfaces to
be  used  are  on  a  different  subnet  from  that  associated  with  the  SGO  Mistika
workstation.

TANGENT ELEMENT USB SURFACES

Use Element Surface

[False (True / False)]

Activates the use of the Elements model panels or surfaces.

Bt-1, Kb, Tk, Bt-2, Mf, Bt-3

Text  fields  in  which  the  series  number  of  each  Element  model  panel  should  be
introduced in the order indicated.

Restart Tangent Driver

Restarts the drivers or controlers of the Element panels.

Other Settings

Rank mode, British style

[False (True / False)]

The color selection manipulators are rotated, in the style of Rank,  and  the  trackballs
of the control surfaces work consequentially.

Colourist mode

[False (True / False)]

The color selection manipulators are rotated, in the style of Rank,  and  the  trackballs
of the control surfaces work consequentially.
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D-14 Precision

Enable or disable the Precision Panels.

The Precision panels have two ethernet  ports, but  only the upper one is used with Mistika.
The default ip's are 192.168.21.1, 192.168.21.2 and 192.168.21.3. To change the ip's press
the Tools button when power on the panel until the Configuration menu appears (it  usually
take 30 sec). Then use the Joystick to go to IP Configuration and use the 4 knobs near to
the joystick to change ips. Finally select Reboot and put the new Ips in the Ip's fields.

 



95Mistika SETUP (mConfig)

SGO Mistika 8.6 © 2018 SGO

D-15 3D LUTS

A 3DLUT (3-Dimensional Look-Up Table) is a file conversion between RGB values that  allows
previewing an image in the monitor or projector giving it an appearance as similar as possible
to what it will have in its final exhibiting media. 

For example,  it  can show  how  movie  files  will  look  once  filmed,  developed,  converted  to
positive and projected by a film projector. 

As an example, depending on the distribution of SGO Mistika we can find one or more 3DLUT
examples in which SGO Mistika (Node Graph Editor->Dashboard->Fx->LUT 3D).  can be
selected. However, these LUTs will not  be calibrated  to  the  monitor,  but  will  be  based  on
ideal sRGB monitors. To obtain an 3DLUT  that  takes into  account  the  differences  between
our monitor and  an ideal one,  follow  the  steps  described  in  this  section.  In  addition,  an
optional calibration product  (LightSpace  CMS)  is  needed,  as  is  a  spectrometer compatible
with the chosen calibration software. 

Note: The 3DLUTS are stored in $HOME/Mistika-ENV/etc/3DLUTS.

Calibration tools

Live video out

Enables the resending of  a  portion of  the  graphic  environment  to  the  external video
output.  This  calibrates  the  viewing  device  connected  to  the  SDI  output  through  a
spectrometer (see the tool Cinespace Monitor Create Profile). Mistika must  be closed
before activating it.

Stop video out

Disables the resending of a portion of the graphical environment  to the external video
output (activated by the previous button).

Create Cinespace Monitor Profile

If  installed,  this  launches  the  optional  application  Cinespace  (cineProfiler)  which
obtains the profile of a monitor or projector. This tool shows a pattern of images to be
read by a spectrometer applied to the screen connected to the graphics card, or the
screen connected  to  the  external  SDI  video  output  if  the  option  Live  Video  out  is
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activated.

In  the  case  of  using  Live  Video  mode,  we  must  subsequently  move  the  window
showing the pattern of colors so that it fills the video output.

The spectrometer must be connected to a USB port on the SGO Mistika workstation. If
this  is  not  possible  because  of  the  distance  between  computer  and  screen,  use  a
networked laptop with the ports server software supplied by Cinespace.

When calibrating an LCD-type monitor, a elevated number of  "Decoupling" errors  may
be observed in the statistics displayed by the application once the samples have been
taken  by  the  spectrometer.  This  indicates  that  the  intensity  applied  to  one  color
component  also  affects  the  others,  which  is  normal  in  LCDs.  It  mostly  means  that
these monitors can not be gauged by LUTs of one dimension, but require a 3D LUT.

During the spectrometer sampling process (which may take several hours) the lighting
in  the  room must  be  kept  to  a  minimum (something  also  recommended  during  color
correction sessions).  Remember that  if  lights  are  turned  on  in  the  room during  this
process,  it  can  affect  the  measurements,  the  result  thus  far  obtained  must  be
discarded, and the process re-started.

It is generally recommended for calibration to pre-configure the screen to its Factory
Settings,  which is  the  least  forced  way  of  working.  Remember that  factors  such  as
color temperature will be perfectly compensated by the 3DLUT, so there is no need to
force  the  monitor  to  any  customized  values.  For  example,  the  monitor  can  be
maintained in a factory setting of 6500º K, while the 3DLUT may convert  it  to 5400º K
if it is the color temperature of the chosen Target. This is better than trying to force
the monitor to a color temperature for which it is not optimized.

Also, if  possible, preset  the brightness and contrast  controls  to  reasonable  minimums
that we plan to use during the color correction sessions.

LightSpace CMS

LightSpace 

These  options  provide  connectivity  between Light  Illusion  calibration  tools:  see  the
manufacturer's documentation for more details.

Select Default 3D LUT

Select 3DLUT

Permits  the  selection of  the  3DLUT  that  SGO  Mistika  loaded  by  default  in  the  next
session for use by  RGBCor.  It  can also  be  selected  from within  SGO Mistika.  3DLUT
files  can be  converted  to  .itx  format,  which  SGO  Mistika  can  uses  if  they  are  not
encrypted.

To select a LUT, simply put the 3DLUT in the file $HOME/Mistika-ENV/etc/3DLUTS. 

Note:  this  field  only  affects  the  RGBCor  effect  and  not  the  3DLUTS  effect,  which
has its own selection fields for LUT.
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D-16 Utils

The  buttons  in  this  section  allow  various  external  tools  to  be  run,  such  as  defining  the
values  for  the  buttons  Launch  Script  (Node  Graph  Editor->Dashboard->VTR->VTR
Capture->Launch  Script)  and  Script  to  run  after  the  render  (Node  Graph  Editor-
>Dashboard->Output->Render->Script to run after the render).

Utils

Defragment realtime  directory (.js files)

This  only  applies  to  XFS  and  SNFS  (SAN)-type  filesystems.  Enables  the
defragmentation of files in File Paths->Realtime Storage.

Fragmentation  occurs  especially  when  the  disks  are  90%  or  more  full  and  work
continues on them. In these cases, Mistika may not be able to obtain consecutive disk
space  for  new  files  generated,  and  so  are  distributed  across  various  areas  of  the
disks. This situation causes a significant  reduction in the performance of real-time, as
the reading heads and disk burning will have to continuously move from one  place  to
another (seek time).

This process defragments the files if there is enough space available.

For it to function properly, it is necessary first  to exit  Mistika since the defragmentors
refuse access  to  recently  opened  files  for any  application.  Remember that  to  check
whether a  file  is  fragmented,  there  is  the  tool  within  Mistika,  Node  Graph  Editor-
>Dashboard->Edit->Extras->Check Fragmentation.

Note: If fragmentation levels are is high, the defragmentation process can take many
hours. It  is important  to make disk space available (disk occupation of less than 70%
is recommended) before executing, or its progress will be inefficient.

Note: There is a need to differentiate between fragmentation and segmentation.

Segmentation  is  another  problem  with  similar  symptoms  but  different  causes,  and
occurs  when  there  is  a  numbered  sequence  in  which  frames  are  not  arranged
consecutively  in  the  disks.  In  these  cases,  there  may  not  necessarily  be
fragmentation,  since  each file  can be  complete  in  a  consecutive  sequence,  but  the
disks cannot  play them in real-time, because it  requires continuous jumping  from one
head  to  another  for  each  frame.  This  problem  cannot  be  solved  with  the
defragmentor,  but  instead  the  sequence  must  be  copied  again  in  the  correct  order.
The  best  method  is  to  defragment  the  file  first  and  then render the  sequence  from
Mistika.
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In  addition,  this  situation  can  be  avoided  by  following  these  two  rules,  simple  to
implement but critical:

Never  have  two  different  processes  (disk  copies,  rendering  processes,  etc.)
writing frames on the  same  disk partition  at  the  same  time,  as  the  frames  can
become interspersed.

If the progress window of a copy of  files  shows  non-consecutive  numbers,  it  is
because in the original disk this already problem exists, because unfortunately no
operating system takes  this  circumstance  into  account.  If  this  situation arises,
cancel the copy  and  perform it  differently.  The  best  way  to  copy  is  through a
rendering process that reads the original disk and writes in the real-time storage
(see  File  Paths->Predefined  Paths  For  Rendered  Sequences),  and  thus
Mistika  can  perform the  copy  process  much  more  quickly  than  the  operating
system, and also will process the frames in their numerical order. In addition, we
can take advantage of the situation to implement  post-production pre-processes
that may be needed later.

A  good  alternative  is  to  make  a  copy  of  the  files  in  a  Linux  console  with  this  line
command:

rsync -Pav source destination

This command copies the sequences in order, as well as providing statistics and being
much quicker than other commands, such as "cp".

If it  is preferable to use graphics tools, certain ftp tools may be useful as they  allow
the ordering of the files list by name .

Open Mistika fonts folder

Opens a folder of files in the installation directory  of  Mistika  fonts  (/usr/share/fonts/
Mistika).  To  install  a  new  typeface,  open  this  folder  and  drag  within  the  file  .ttf
containing the corresponding TrueType font. For example,  to  import  a  typeface  that
we have in a Windows PC, simply find it in c:\windows\fonts  and drag it to this folder.
In  the  next  SGO Mistika  session,  this  will  be  available  for  the  VectorPaint  and  Title
effects.

Dailies logo and burn TC

Controls of the aspect  of the logo and timecode (TC) that  are superimposed on the  image
when carrying out  render with the option Virtual Slate (Node Graph Editor->Dashboard-
>Output->Render->Virtual Slate) activated.

TC Size Factor

[3 (1 / 4)]

Size factor of the TC to be superimposed.

TC Left Offset

[50 (0 / 2050)]

Horizontal position of the TC (calculated from the left)



99Mistika SETUP (mConfig)

SGO Mistika 8.6 © 2018 SGO

TC Bottom Offset

[20 (0 / 2050)]

Vertical position of the TC (calculated from the bottom)

Logo Right Offset

[20 (0 / 2050)]

Horizontal position of the logo (calculated from the right)

Logo Bottom Offset

[20 (0 / 2050)]

Vertical position of the logo (calculated from the bottom)

Change Copr. Logo

Allows the changing of the company logo to be superimposed on the image. 

After Sripts Data

After script mail address

This provides the email address to be used with the after-script mail_After. This script
can be activated with the buttons Launch Script  (Node Graph Editor->Dashboard-
>VTR->VTR Capture->Launch  Script)  and  Script  to  run  after  the  render  (Node
Graph Editor->Dashboard->Output->Render->Script to run after the render).
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D-17 User Login

La ventana User Login le permite crear diferentes perfiles de usuario con configuraciones
personalizadas. 

Se les puede dar el nombre que usted quiera y darles una foto de perfil, que se puede
cargar desde los archivos de la máquina o directamente buscándola en internet y
arrastrando la al espacio de imagen.

Con  uno  de  los  usuarios  seleccionado  y  activando  la  casilla  EDIT  USERS  MODE  se
despliegarás una pestaña con diferentes opciones.

MistikaUser´s Config Files:  

Contiene el acceso a diferentes archivos de configuración.

-Hotkeys:  le  permite  acceder  al  archivo  de  configuración  d  elos  Hotkeys  y
modificarlos.

System Config Files (Global)

- Mistikarc: abrirá el mConfig pudiendo modificarlo y guardar los ajustes.

NOTA:  desde  ambos  accesos  Hotkeys  y  mistikarc  con  click  derecho  podemos  generar
presets  (Flavours)  de  mConfig  y  de  hotkeys  personalizados  para  el  usuario  o  para  un
determinado workflow.

Auto Login

Por  defecto  aparecer  desactivado,  pero  si  lo  modificamos  podemos  configurar  la
ventana de usuario para que inicie sesión automáticamente.

Las carpetas de cada usuario se crean en la ruta home/MISTIKA-ENV/shared/users y los
usuarios se pueden borrar o copiar tanto desde la ventana de usuario como desde esta
ruta.
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E-1 Starting up Mistika

To start SGO Mistika, simply double-click the following icon on the desktop:

It  is also possible to run the software by typing Mistika in any Linux terminal.  This  method
recommended in  cases  of  problems,  since  the  messages  that  appear  help  with  diagnosis.
These messages indicate the possible lack of essential software, the lack of licence, etc.

If no SDI video board is available, deactivate the Mistika Setup->Video I/O->Use Video
Board, otherwise Mistika will not be able to boot.

For correct  boot-up of Mistika, it  is also necessary for the user to have done a login via a
KDE-type desktop (Gnome-type environments are not supported).

Finally, it  is  very  important  not  to  open inadvertently  more  than one  Mistika  at  the  same
time,  since  the  performance  will  be  drastically  reduced  and  boot-up  may  not  even  be
possible. Other unnecessary applications should not  be opened either (the Linux bar shows
information  regarding  the  number  of  applications  open).  In  any  case,  when  in  Mistika
Setup->Video I/O->Use Video Board->On mode, it  is only possible to open one  Mistika
application at a time.
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E-2 The interface structure

The main interface of SGO Mistika works with  three   modes  which are  complementary  and
interactive: the  TimeSpace Editor, the Node Graph Editor and theVisual Editor.

There are four dependent  submodes  of the Visual Editor: the Tracking Editor, the  Warper
Editor, the Paint Editor and the Title Editor. The definition of parameters area (Parameters)
and its animation curves editor (Curves) are shared by both modes (Node Graph Editor  and
Visual Editor).
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The Node Graph Editor mode is used basically for working in the Node Graph Editor, to load
clips and effects into it and carry out editing. The Node Graph Editor is where the project  is
constructed,  and  the  Visual Editor  mode  provides  access  to  parameters  and  manipulators
that are used to compose and adjust  effects assigned in the Node Graph Editor. By means
of dedicated tools, the Visual Editor is the interface used for detailed work and polishing the
project.

In all cases, both modes, Node Graph Editor  and Visual Editor, are available simultaneously
at all times to work on the project. 

SGO Mistika  works  with  a  minimum resolution  of  1920  x  1200  pixels  and  the  use  of  two
monitors  is  recommended  in  order  to  be  able  to  take  full  advantage  of  the  possible
interaction between the  two  main  modes.  The  activation of  dual monitor use  is  done  via
Mistika Setup (Mistika Setup->Interface->Two Monitors).

It is also possible to use the following functions to deactivate evaluation of the mode that
we are not using, and thus obtain better performance in the other mode:

If work in the Visual Editor  is finished and we want  to deactivate it  to  obtain
better performance in the Node Graph Editor,  double-click in  any  empty  area
of  the  Node  Graph  Editor.  Furthermore,  this  action  sets  (dedicates)  the
second monitor to showing the monitor of Node Graph in full resolution. This is
fundamental  if  an  SDI  external  video  monitor  is  not  available  to  show  the
contents.

When we  are  in  the  Node  Graph  Editor  and  want  to  re-activate  the  Visual
Editor  to  work on an effect,  double-click on the  effect.  The  Visual Editor  is
optimized for adjusting effects, not  to launch playbacks in real time, although
even  in  this  mode  we  still  have  buttons  for  navigating  from  clip  do  clip
synchronously with the monitor of the Node Graph Editor, and can even send
playbacks from it to the external SDI output without needing to return to Node
Graph Editor mode. 
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E-3 Node Graph Editor

Ref. Mistika: Node Graph Editor

This mode is used for constructing the edit  and administrating the position and behavior of
the clips applying specific  tools. In other words, in Node Graph Editor, the whole of Mistika
is organized.

One  of  the  unique  characteristics  of  Mistika  is  that  the  functioning  of  the  Node  Graph  is
different  from other post-production programs.  In  Mistika,  the  Node  Graph  should  not  be
thought of as a two-directional line in time, but  rather as an infinite field in which the user
can work as they wish, according to their own preferences. 

The Node Graph Editor  is composed of four complementary areas: TimeSpace, Node  Graph
Editor, Dashboard and Monitor Display. 

In the Node Graph, the duration of all types of clips and the hierarchical organization image
processes are arranged.

The Node Graph Editor is the node based compositor of Mistika. 

The Dashboard is the main control panel that  contains access to the majority of commands
and tools in Mistika.

In the Monitor Display, the  active  monitors  for evaluating  images  and  effects  are  viewed.
There is an internal mode for configuring its behavior.

timeSpace

Ref. Mistika: Node Graph Editor->Node Graph

The Node Graph of SGO Mistika is the workspace in which editing and effects construction
takes place, and is central to the organization of the project.
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This Node Graph is considerably  different  to  those  of  other systems.  On the  one  hand,  it
uses standard and traditional concepts to carry out simple editing; on the other, it  also has
other characteristics that differentiate it:

The same Node Graph allows both integrated editing and compositing. 

Mistika's Node Graph is designed as a flexible workspace, in which the user can
freely  experiment,  carry  out  tests,  and  have  different  versions  in  the  same
Node Graph. 

It  offers a time-animated compositing scheme: other systems are based  on a
connected node tree whose connections cannot be changed in time. In Mistika
,  however,  an entry  layer to  an effect  can,  simultaneously,  be  an  edit  that
varies with time, empty in places, an image layer in other places and even be
formed by a complex composition at other times. 

Mistika's  Node  Graph  can be  seen as  a  three-dimensional  workspace;  in  the
horizontal  direction,  editing  of  clips  is  carried  out;  in  the  vertical  direction,
composition and effects are carried out; via nested group clips, navigation to
other Node Graph environments can take place, with the same capabilities  as
those found at the first level.

SGO Mistika's Node Graph  provides  a  multitude  of  tools  oriented  towards  the
organization  of  audiovisual  projects  in  which  various  different  systems
participate.  Thus,  the  Node  Graph  is  designed  to  exist  at  the  center  of
production, as a system for sharing out  work, receiving new versions  of  each
piece, and provide a global vision of the  evolution of  all  the  pieces  together.
To do so, it possesses various organizational tools, such as exportable groups,
notes  and  Graffiti  on  the  Node  Graph,  user's  marks,  remote  clips  linked  to
other systems, and scripting capabilities for the automatization of processes.

There  is  also  additional  support  for  stereoscopic  work,  where  clips  for  both
eyes can be grouped and treated together or separately at any time.

Total support  for combining clips with different  resolutions, aspect  ratios, and
color spaces in the same Node Graph.

Editing and compositing workflows

From an editor’s  point  of  view,  SGO Mistika's  Node  Graph  is  more  flexible  than  any  other
known GUI, since it has an infinite number of tracks which are not  dedicated to a particular
type of media: thus any type of clip can be placed in any track. 

This makes possible, for example, the coexistence  of  multiple  versions  of  the  same  edit  in
the same Node Graph since the vertical and horizontal dimensions are infinite.
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From  the  compositor's  point  of  view,  this  kind  of  Node  Graph  provides  a  schematic
representation of the accumulated process  flow,  which,  unlike  other compositing  systems,
allows  the  duration  of  all  effects  to  be  viewed  at  the  same  time.  Other  representation
systems  based  on  node  trees  do  not  show  the  process  duration,  and  are  only  able  to
represent the hierarchical order of the processes in the same flow, since the node system is
intrinsically one-dimensional. 

Mistika’s workflow is based on effect  clips that  are nestable and infinitely accumulative and
processed  by  GPU,  in  which  any  process  can  be  related  to  any  other,  providing
unprecedented  flexibility  and  performance  compared  with  other  compositing  systems,
without ever needing to make an intermediate render. 

Mistika  provides  a  three-dimensional  scheme  (horizontal/vertical/nested  grouping)  that
shows the duration of each process, the effect relationships, and even different  versions at
the  same  time,  in  a  much  more  complete  and  interactive  way,  since  each  process  is
represented as an additional clip, which can be edited in the  same  way  as  any  other clip,
changing its duration, copying it, dividing it, etc. 

When effects clips are added together, or to image clips, they form vertical stacks,  which
can be collapsed to a single group that  will contain all of them, to facilitate its organization
in the Node Graph. This characteristic of the system will be explained in more detail later.

To view the result of editing or composition of an area of the Node Graph, the monitor bar (
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Monitor)  is  used,  by  placing  it  over the  clip  to  be  viewed.  The  Monitor  will  evaluate  the
process of the frame where its bar has been placed.

The creation of processes and image flows is done by adding clips to the Node Graph. Many
effect  clips  have  a  range  of  action,  specified  by  a  dropdown,  into  which  other  image  or
effect  clips  should  be  introduced  as  inputs.  These  scopes  define  the  links  between  the
processes.  These  links  can be  seen in  a  vertical hierarchy  scheme  (similar to  a  directory
explorer), with the help of interfaces and auxiliary monitoring options, explained later.

Once the flow has been defined, the parameter values for each process  can be  defined  in
Visual Editor  mode to work in an interface that  is better oriented towards compositing  and
effects, although the user can return to the Node Graph at  any time, to make changes, as
both  modes  (Visual  Editor  and  Node  Graph  Editor)  are  interactively  integrated  and  are
complementary.

Elements of the timeSpace

A large number of different elements appear in the Node Graph, as described below. 

Grid

Horizontal and  vertical lines  that  divide  the  Node  Graph  into  squares.  The  horizontal lines
subdivide the project area into tracks. The vertical lines divide the space into units of time
depending on the zoom factor of the  Node  Graph.  The  timecode  values  are  shown at  the
bottom of the project area. 

Cursor

This  is  represented  by  a  single  frame  sized  rectangle  with  a  red  vertical  line  down  the
middle. It appears if any part of the Node Graph is clicked. It is used as the default  location
for the following operations, such as adding a clip to the Node Graph or editing, etc.  
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Monitor

The Monitor mark is a vertical line with two small control boxes at  the top and bottom that
specify where the evaluation of the contents of the Node Graph starts and ends. 

The beginning of the mark is called the monitor head, and  is  the  direct  manipulator of  the
monitor. To drag the monitor, left  click and hold the monitor head and move the mark over
the clips to be evaluated. The timecode of the current frame of the Node Graph is shown on
the monitor head. 

The monitor, by default, can only evaluate a limited number of tracks. This number is shown
in  the  scope  of  the  monitor  mark,  which  begins  in  the  head  and  ends  in  its  Range
manipulator.

If monitor evaluation needs to be interrupted  while  dragging  a  mark,  it  can temporarily  be
inhibited by <Shift> + left click.

When the monitor is evaluating only image clips, only the clip that  it  finds in the top  track
crossed by the monitor mark will be visible. This is because an image clip does  not  have  a
scope, and it cannot be associated with clips that are below it. This allows the definition of
different  versions  by  placing  clips  in  different  tracks,  without  the  need  to  place  one  clip
after  another,  as  the  monitor  will  read  the  clip  of  the  top  track,  and  when  the  clip  is
finished, it will then read the next clip below it.

To  compose  several image  clips,  it  is  necessary  to  apply  composition  effect  clips,  which
have scopes that specify process flows. 

When viewing a playback of the Node Graph material  on the  monitor,  the  contents  of  the
area of the Node Graph being evaluated will be processed from left  to right  and from top to
bottom. 

When the monitor is in play mode, it advances from left to right (although physically what  is
seen in the interface is a still monitor and the Node Graph moving  from right  to  left  below
it), and when it  passes over an effect  clip it  activates the process of that  clip and  of  the
effect or image clips that are associated with and below it. 

If real-time view is lost when the monitor is working, a “Lost  Sync” message box will appear
above the monitor head. 

Play Marks

These restrict the monitor reproduction area when Play mode is activated. They are colored
violet, and initially are hidden. To add or delete them, use the Play Marks commands in the
Quick Access bar.
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Edit Marks

Yellow in color, these specify the two editing points used in various editing operations. They
carry out  the function of selecting the area for Output  operations. To add or delete them,
use the Edit Marks commands in the Quick Access bar.

TC Mark

This is the timecode track marker of the Node Graph. The default  value of the mark is  the
zero timecode (00:00:00:00), although this value can be modified to any other. The mark is
light  gray,  and  dragging  its  tail  will  move  the  timecode  without  altering  the  Node  Graph
contents.

There  are  several  ways  to  insert  and  control  the  TC.  By  default,  the  numerical  values
(inserted by typing) will appear from left to right, returning to the start  when the last  code
value  is  reached.  If  the  value  in  a  TC  field  (frames  ,  seconds,  or  minutes)  needs  to  be
edited, simply double-click on this field to select  it  and edit  it. Similarly, we can select  the
entire TC with a triple-click.

Finally, there are several useful keyboard shortcuts for controlling the TC:

Left/Right arrows: to move through the timecode.

Up/Down  arrows:  to  increase/decrease  values  in  a  TC  field  (frames,  seconds,  or
minutes) by one unit. To control a specific field, first position the cursor over this area.

+/-  Buttons:  to  increase/decrease  the  value  in  the  frames  field  by  one  unit  without
previously needing to be positioned in this area.

Enter: to navigate to the indicated TC.

User Marks

These indicate timecodes of interest  created by the user; they can be  added  even during
playback.

These marks can be global or local, and are added or deleted via the User Marks commands
in the Edit tab of the Dashboard.

These  are  placed  in  the  Node  Graph  at  the  position  of  the  Monitor  mark.  If  no  clip  is
selected, the mark will appear on the Node Graph (global marks); if  a clip is selected, it  will
be placed in the selected clip and is moved with it (local marks).

The global marks are shown in green throughout  the vertical dimension of the Node Graph,
and the local clip marks are created inside the clip container.

It  is  possible  to  jump from one  user mark to  another via  the  Prev/Next  commands  in  the
Quick Access bar.

Vumeters

The  vumeters  can  be  viewed  via  Edit->Setup.  2,4,8  or  16  channels  can  be  viewed  in
realtime  in  the  Node  Graph.  When options  8 or 16 are  selected,  different  options  can  be
selected for more comfortable viewing and analysis of these in the Node Graph.
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Notes & Graffiti

This  displays  notes  with  texts  and  drawings  that  can  be  used  as  documentation  on  the
Node Graph (see Notes).

Individual Clips

Before beginning the description of each type of clip, it  is necessary to explain in detail the
concepts of “cut”, “head”, “tail” and “position” of clips in a non-linear editing system. 

In  any  editing  system,  the  Out  Point  of  an  editing  event  is  an  exclusive  timecode.  This
means  that  the  timecode  selected  as  output  indicates  a  time  value  where  the  event  is
excluded from the editing, corresponding to the frame following the last frame of the event. 

In  a  non-linear editing  system represented  by  a  Node  Graph,  each  event  is  shown  as  a
segment or clip. 
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Due  to  the  read  direction of  the  Node  Graph  (from left  to  right)  these  segments  have  a
head and a tail. 

The Head is at its left edge, and corresponds to the timecode In Point value of the event.

The Tail is at its right edge, but  the timecode output  value of the event  is really the frame
after the tail, since the Out  Point  of an event  is, according  to  the  timecode,  an exclusive
point. 

Therefore,  if  the  tail  of  a  clip  follows  the  head  of  a  clip,  both  clips  will  have  the  same
timecode, since the Out Point  (expressed in timecode) is the same value as the In Point  of
the following clip. The coinciding of editing points is called a Cut. 

An editing cut is shown in the Node Graph as the border that  joins the tail and head of two
different clips. These cuts can be adjusted, which will modify at  the same time the tail and
head of clips that are in the selected cut. Finally, it is important to note that  Mistika’s Node
Graph  allows  the  placing  of  clips  in  infinite  tracks;  this  should  be  borne  in  mind,  since
several cuts, heads and tails of clips that  are in different  tracks can be edited at  the same
time for some adjustment functions. 

However, a cut (outside the definition to be used in this documentation) can be specified as
the end of an image clip, and the start  point  of another clip in a  lower position,  or as  the
start of an image clip that obstructs the reading of another clip in a lower position. This also
specifies  a  cut  in  the  edit,  although by  using  this  term in  this  documentation  we  do  not
refer to this possible situation. 

The interval between the head and tail of the same clip is called the Duration. 

A clip, in addition to starting and finishing,  is  found  in  one  of  the  Node  Graph's  lines.  The
absolute  location of  the  clip  in  the  Node  Graph,  both  vertically  and  horizontally,  is  called
called Position. 

This  difference  from the  term Head  should  be  borne  in  mind,  since  Head  refers  to  the  In
Point of the clip in relation to its timecode and original duration. If the position of the clip is
altered, the Duration of the clip is maintained without change. In other words, a clip can be
“moved”, but  its head and tail can only be “adjusted”, consequently changing the duration
of the clip. 

Image clips:

These are dark green clips, without  scope.  They  represent  the  duration of  a  sequence  of
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images.

This clip can be of various types: subclips, master clips or link clips.

To  view  more  details  of  a  clip,  such  as  for  example  the  media  to  which  is  refers,  the
Attributes  tab  (Node  Graph  Editor->Dashboard->Edit->Attributes)  can  always  be
used.

If the clip extends beyond the duration of its media, the color of the excess segment  of the
duration will change to a darker green. In this excess, the first  or last  frame  of  the  media
will be viewed as a frozen frame, depending on whether the excess is respectively head or
tail. When it  is a subclip, the media is considered finished from the  In  Point  and  Out  Point
marks with which it was created. 

It  is also possible to view the clip as a strip of images by activating the option Show Strip
Video (Node Graph Editor->Dashboard->Edit->Setup->Node Graph View->Show Strip
Video).

Within an image clip, the following two elements can be distinguished:

Name of clip

This indicates the original name of the clip. The clip name can be modified in the Node
Graph, for organizational purposes. This clip is associated with specified media.

More  information about  a  clip  can be  obtained  via  the  Attributes  tab  (Node  Graph
Editor->Dashboard->Edit->Attributes). 

Active frame

This appears when the  zoom factor allows  a  proxy  image  of  the  active  frame  to  be
viewed within the clip. To view a different frame in the clip, simply right  click and drag
over the clip. 

At  the  bottom  of  the  active  frame  mark,  the  frame  number  can  be  seen.  This
information  can  be  viewed  as  timecode  by  activating  the  option  Timecode  (Node
Graph Editor->Dashboard->Edit->Setup->Node  Graph  View->Time  Code).  For
clips derived from capture with  defined  timecode,  the  original timecode  will  be  seen.
Clips derived from a render, a link or capture in Start  Free mode do not  conserve the
original timecode.

Right-clicking on the clip and dragging  the  mouse  cursor shows  another proxy  image
with  the  current  frame,  and  this  image  can  be  sent  to  the  active  monitor  via  the
option  Select  Monitor  (Node  Graph  Editor->Dashboard->Edit->Setup->Node
Graph Monitor->Select Monitor)

Editing  clips  is  non-destructive,  and  their  original  duration  can  be  restored  at  any
moment, since they can be shortened or extended from their head or tail as often as
required. 

Changing  the  duration of  a  video  clip  by  any  editing  technique  allows  more  or  less
original material to be viewed, by increasing or reducing its duration, while maintaining
its normal playback speed. 

Note: In an image clip without  media, a black and  white  chessboard  pattern  will  be  seen.
This is to indicate that  the clip has no image media. For more information on the  scope  of
an effect, read the chapter Manipulation of an effect clip with scope.
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Audio clips:

These  are  very  pale  green  clips,  without  scope,  although  audio  clips  do  not  need  be
associated with other clips to be evaluated. This means that all audio clips in the evaluation
range of the active monitor will, in principle, be evaluated. This can be modified via the pan
and mix tools in the Audio tab (Node Graph Editor->Dashboard->Audio->Router).

To view more details of an audio clip, such as the referenced media , go to the  Attributes
tab (Node Graph Editor->Dashboard->Edit->Attributes) can always be used.

If the clip extends beyond the duration of its media, the excess  segment  will  change  to  a
darker green, and in this excess no audio will be evaluated at all.

Audio clips are affected by the same editing operations as any other type of clip except  for
Reverse  (Node  Graph  Editor->Dashboard->Edit->Commands->Reverse)  and  the
operations of Timewarp.

It is also possible to view the clip as a waveform by activating the option Show Strip Audio
(Node  Graph  Editor->Dashboard->Edit->Setup->Node  Graph  View->Show  Strip
Audio).

Audio clip view has the two following elements:

Name of clip

This indicates the referenced audio file name.

More  information about  a  clip  can be  obtained  via  the  Attributes  tab  (Node  Graph
Editor->Dashboard->Edit->Attributes).

Active frame

When the  zoom factor allows,  the  audio  is  viewed in  a  waveform in  a  proxy  image
within the clip. 

To  view  the  waveform of  another  frame  in  the  clip,  right  click  and  drag  on  it.  In
addition, the audio of the clip will be played, allowing the  desired  points  to  be  found
more easily. 

At  the  bottom  of  the  active  frame  mark,  the  frame  number  can  be  seen.  This
information can be  viewed as  timecode  by  activating  the  option  Time  Code  (Node
Graph Editor->Dashboard->Edit->Setup->Node  Graph  View->Time  Code).  For
clips derived from capture with  defined  timecode,  the  original timecode  will  be  seen.
Clips derived from a render, a link or capture in Start  Free mode do not  conserve the
original timecode.

Changing the duration of an audio clip by any editing technique allows more or less original
material  to  be  heard  by  increasing  or  reducing  its  duration,  while  maintaining  its  normal
playback speed. 

Via the option Show Strip Audio (Node Graph Editor->Dashboard->Edit->Setup->Node
Graph View->Show Strip Audio) the audio waveform of each frame will be shown on the
clip.  The  vertical  axis  represents  the  wave  amplitude,  while  the  colors  represent  the
frequency spectrum (basses, mid, high).
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The parameters of audio clips can be animated in the Parameters tab:

There is one Master folder for controlling all audio tracks of the selected clip simultaneously.
In addition, each audio track has a separate local folder Track_n for animating  each audio
track separately. Both types of  folder have  two  parameters,  and  both parameters  have  a
similar function (volume  control).  The  difference  is  that  Fade  behaves  in  a  linear fashion,
while Gain_Db has logarithmic behavior. 

The choice of using one or the other parameter will depend on the situation:

The human ear reacts in a “logarithmic” way to sound.  If  the  volume  is  very  high,  we  will
only detect big volume variations, while if it is very low we will detect  very small variations.
Due to this, we recommend using Gain_Db in most cases; the Fade parameter, with its linear
behavior, will be less effective.

However,  a  very  common  situation  exists  in  which  the  linear  scale  (Fade)  is  preferable:
when animating a cross fade between two audio clips, it is more convenient to work in linear
scale,  because  we  need  to  work  with  the  concept  of  “percentage”  so  the  transition  is
independent of the volume in each of the two clips.

Note: In the cases  where  a  simple  linear cross  fade  between two  audio  clips  is  required,
remember that  there is a simpler method  than manually  animating  the  curves:  overlap  the
two audio clips in the Node Graph and  the  transition  will  automatically  occur (explained  in
more detail below).

One case in which we want to animate both parameters simultaneously is a “Fade to black”
(from sound to silence). In this case, Gain_db will provide the feeling of a more gradual fade
than if we used Fade in a linear form, but it cannot  ultimately result  in total audio fade out.
To achieve this, set the Fade parameter to zero.

In  general,  to  set  an appropriate  constant  level  for  each  audio  track,  do  not  use  these
parameters.  It  is  easier  and  more  convenient  to  use  the  tools  of  the  Audio  tab  (Node
Graph Editor->Dashboard->Audio).  In  addition,  use  the  Gain_Db  parameter to  set  the
correct volume at any moment, and the Fade parameter to animate the volume of one audio
track in relation to others. 

The animation parameters described for audio clips also exist for mixed audio/video clips. 

The  editing  functions  never affect  parameter animations  curves,  which are  cut  when  the
length of clip is adjusted.
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Fade

[100 (-100 / 100)]

This controls the gain level (and therefore audio volume) in a linear scale, ie the value
of this parameter modifies the wavelength proportionally. It  is  often used  to  animate
fades between two or more audio tracks, and to eliminate completely the sound of  a
track by setting this value at zero.

Gain_Db

[0 (-60 / 6)]

This controls the gain level (and therefore audio  volume)  in  a  logarithmic  scale.  It  is
the  volume  control  method  recommended  in  general,  except  for  fades  between
different  audio clips. By way of reference, we can say that  an increase of 6 decibels
produces an increase in  audio  wavelength of  around  double  the  original (in  fact  this
would mean four times the power, although such issues fall outside the scope of this
document).

Audio mixes:

To carry out  a linear audio mix between two audio clips, simply overlap  them on the  same
Node  Graph  track.  The  mix  happens  automatically,  having  the  length  of  the  overlapped
segment.  This  mix  is  done  internally  without  using  the  parameters  of  audio  animation
described above, which are therefore available to other user settings.

When  we  align  two  audio  clips  on  the  same  track  on  the  Node  Graph  (without  any
overlapping) the system will automatically generate a small 10ms mix between the two audio
clips. This automatic audio mix is designed to avoid the annoying clicks that  typically result
if the audio clips are not mixed in this way. 

Note:  The  explanations  in  this  section  regarding  audio  clips  are  all  applicable  to  mixed
audio/visual clips, except for the display of the waveform of the clip.

Mixed clips:

This is a two-colored clip: the top half is dark green and the bottom half is pale green. 

This type of mixed clip contains an audio track within the image clip.

These clips can be mixed from their original capture,  or combined  later in  the  Node  Graph
with  the  command  A/V  Combine  (Node  Graph  Editor->Dashboard->Edit->Edit-
>Commands->A/V Combine).

This command is useful, once an image and audio clip are synchronized, for combining them
into a single mixed clip and editing it  as if  it  were a single one. To combine clips, remember
that they should have the same duration and be vertically aligned. 

To  view  more  details  of  a  clip,  such  as  the  referenced  media,  go  to  the  Attributes  tab
(Node Graph Editor->Dashboard->Edit->Attributes).
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However,  in  the  Node  Graph only  the  proxy  images  are  seen and  not  the  waveform that
corresponds to the audio. The editing done in the clip will affect the image and audio at  the
same time.

Note:  Remember that  the  operations  Reverse  (Node  Graph  Editor->Dashboard->Edit-
>Edit->Commands->Reverse) and  Timewarp  will  not  affect  the  audio  or its  parameter
curves. 

If these limitations need to be avoided, the mixed clip should be divided into  two  separate
clips,  one  for  the  image  and  another  for  the  audio,  via  the  command  A/V  Break  (Node
Graph Editor->Dashboard->Edit->Edit->Commands->A/V Break) 

Group clips

Clips of the group type are a useful feature for collapsing an indefinite number of clips so as
to view them as a single one, facilitating vertical navigation in the Node Graph. It is possible
to navigate  within  the  groups,  and  edit  them internally  without  having  to  view  any  other
part of the Node Graph around it. 

A group can contain effects, images, audio clips or even other groups. Since groups can be
saved individually as files, with the .grp extension, they are considered as an ideal means of
transporting stacks of effects that  may be reused in the same Node Graph or in any other
project, or even between project workstations with centralized storage. 

The reasons for collapsing clips into a group are usually the following: 

To simplify the representation of one part  of the editing or a stack of effects
on the Node Graph by visualizing them as a single clip. 

To isolate a set of effects for reuse and subsequent editing. 

To extend a clip by freezing its head or tail and preventing the remaining time
being used. 

To  increase  or  reduce  the  reproduction  speed  of  its  contents  (Timewarp
Groups). 

To create a flow pattern that  can be edited and reused later,  and  applied  to
different clips on each occasion (Template Groups).

To  obtain  a  Stereo  Group  (group  of  two  clips,  one  for  each  eye),  managed
automatically  via  Monitor  Display  (Node  Graph  Editor->Monitor  Display-
>Record Monitor->Menu->Stereo Mode) 

Mistika’s groups can exist in three different states: Normal, Timewarp and Template. 

The  three  states  are  viewed  within  the  Node  Graph  with  a  different  clip  color,  and  the
behaviour of each with relation to edition functions also changes.

All  three  group  states  can be  saved  as  a  file  with  the  .grp  extension.  To  carry  this  out,
select the group and apply the command Creating Group from the Media tab (Node Graph
Editor->Dashboard->Media->Misc->Creating Group).

To undo a group and return to a view of the original clips, run the editing command Ungroup
 (Node  Graph  Editor->Dashboard->Edit->Edit->Commands->A/V  Ungroup).  The
command will drop down all the clips contained in the group. 
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If  the  group  has  been  moved  on  the  Node  Graph,  and  then  ungrouped,  its  clips  may
superimpose  clips  in  the  lower  tracks.  To  avoid  superimposition  of  clips  on  others  when
ungrouped, reposition the clips below the group track, activating the function Auto Expand
(Node Graph Editor->Dashboard->Edit->Setup->Edit->Expand).

The groups, like the clips described earlier, can be viewed as a proxy slideshow of images by
activating the option Show Strip Video (Node Graph Editor->Dashboard->Edit->Setup-
>Node Graph View->Show Strip Video).

Common Group characteristics:

When viewing a group clip, two common elements are shown: the name and timecode of the
active track (regardless of the whether this group contains other clips).

Name of clip

This indicates the default name of the group, which is extracted from the name of the
group clips. The name of the  group  clip  can be  defined  in  the  Attributes  tab  (Node
Graph Editor->Dashboard->Edit->Attributes)  making  its  identification  within  the
Node Graph easier.

Active frame

When the zoom factor allows, a proxy image of the active frame is shown in the clip.
To view another frame in the clip, right click and drag on it. 

The number of the active frame is shown at  the bottom of its mark.  This  information
can be viewed as a timecode by activating the option Timecode (Node Graph Editor-
>Dashboard->Edit->Setup->Node Graph View->Time Code). 

Right-click  and  dragging  in  a  clip  will  show  another  proxy  image  with  the  current
frame, and also this image can be sent  to the active monitor by activating the option
Select  Monitor  (Node  Graph  Editor->Dashboard->Edit->Setup->Node  Graph
Monitor->Select Monitor). 

Navigation:

Every group can be navigated to view its contents, by changing the depth level of the Node
Graph view.

To navigate a group, it  is necessary to select  it  in  the  Node  Graph  and  run the  command
Navigation In (Node Graph Editor->Quick Access->Navigation->Navigation In).

The following image shows a typical view when navigating a group: 
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The clips contained within the group are shown inside it, and it  is possible to select  a new
group  there  and  navigate  to  deeper  levels.  The  number  of  navigation  depth  levels  is
unlimited. 

Within a Normal group, the exterior duration, indicated by dotted vertical lines in magenta,
can be  viewed.  However,  we  can locate  clips  outside  these  limits,  working  with  unlimited
space, when the Node Graph is set in the zero navigation level.

If the Normal group has its duration reduced (by moving its head or tail), vertical red dotted
lines  will  be  seen within  the  Normal  group  which indicate  the  range  used  in  the  previous
navigating level. 

Groups of other types will only show vertical red dotted lines when navigating inside them,
as when editing a Timewarp or Template groups the total duration of the clips contained in
them can always be used. 

At  the  bottom of  the  Node  Graph  a  message  will  be  seen  indicating  the  current  level  of
navigation. In addition, as the navigation depth level is  increased,  the  color of  the  line  at
the bottom of  the  Node  Graph  will  darken,  as  a  visual reminder of  the  navigational depth
being used. 

The active monitor mark will be shown in all the navigation levels. 

To move to a higher level, thus “exiting” the group, run the command Navigation Out  (Node
Graph Editor->Quick Access->Navigation->Navigation Out).

However, if clips in the group have been edited, and the total duration of the contents has
been modified, whether from the head or tail of the group, then Mistika will ask what  should
be done with these changes. When Navigation Out is pressed, and before taking any action,
a dialog box will  open showing  the  possible  options,  depending  on the  state  of  the  group
being edited.
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Group in Normal state:

To  create  a  Normal  group,  select  one  or more  clips,  and  run  the  editing  function  Group
(Node Graph Editor->Dashboard->Edit->Edit->Commands->Group).

A Normal group clip is bright green.

A Normal group is edited in a similar way to an image clip, although instead  of  referencing
the  media,  it  references  the  editing  of  the  clips  that  it  contains,  including  the  processes
organized as flows within it. 

A Normal group clip, when its duration is changed by any editing technique, allows viewing
of more or less of the material contained in it, maintaining its normal playback speed. 

If a  Normal  group  extends  beyond  of  the  duration of  its  contents,  the  segment  with  the
excess duration will change to a deeper green. The first or last frame of the contents of the
group  will  be  shown  frozen  in  this  excess  content,  depending  on  whether  the  excess  is
respectively in the head or tail. 

One consequence is that the technique of grouping a clip and then later extending it  is the
easiest way to achieve "frozen" first or last  frames of the clip, avoiding the excess material
that it might have.

Saving changes when exiting a Normal group:

When exiting a Normal group in which the total duration of its contents has been modified,
a dialog box will open at the cursor position with the four possible actions shown below: 

No actions

The view exits the navigation level without  changing the duration of the group, while
the modifications made inside the group from outside  it,  without  having  affected  the
total duration of the group or its remaining time, can be seen.

Adjust Trimming

The  view  exits  the  navigation  level  without  changing  the  group  duration,  but  the
timecode is redefined. For example, if  the group is extended later, it  will then use the
material contents that exceeded the group duration beforehand. 

Reset Trimming

The view exits the navigation level and resets the duration of the group based on the
new duration specified by the clips inside it. 

Remember that if the duration of the interior of the group is extended on the left  side,
the  group  duration will  be  redefined  by  extending  the  tail  of  the  clip,  and  not  the
head. 
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Cancel

This cancels exiting the navigation level, without taking any action.

Groups in Timewarp state:

To change the state of the group Normal to Timewarp, run the function Timewarp (Node
Graph  Editor->Dashboard->Edit->Edit->Commands->Timewarp).  To  return  to  the
normal group state, first ungroup and then regroup. 

It is not possible to create a Timewarp group without starting from the Normal state. 

A group clip in the Timewarp state is mid-green. 

A  Timewarp  group  is  edited  in  a  similar way  to  an image  clip,  but  instead  of  referencing
media, it references the editing of the clips that it contains, including flow processes. 

Unlike  a   Normal  group,  when a  Timewarp  group  clip  has  its  duration  changed  with  any
editing technique, all the material inside it are shown, increasing or reducing its duration but
modifying its playback speed. 

Next to the group clip name, there is a number that indicates the percentage of the original
duration that the altered duration of the Timewarp group has. This is useful for knowing the
approximate  playback  speed  of  the  Timewarp,  provided  that  its  parameters  that  are
described below have not been altered. 

A Timewarp group is the only type of group that has parameters.

Time-Time

[0 (0 / X)]

The internal frame number of the group that is viewed outside it. 

Speed

[0 (0 / 100.000)]

Percentage parameter that scales playback speed.

Width

[0 (0 / 100.000)]

Amount  of mixing between frames. This parameter is useful to smooth irregular speed
changes,  and  when  the  playback  speed  is  so  low  that  a  jump  between  different
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images is visible. The greater the width value, the more frames are mixed together to
obtain each new resulting frame. 

The  curve  of  the  Time-Time  parameter  symbolizes  the  passage  of  time,  which  can  be
specified  in  a  non-linear  way.  The  curve  can  be  modified  with  complete  flexibility,  as
explained in the chapter Parameters.

Dropdown folder that contains the parameters that control the Optical Flow algorithm. 

MinLevel

[1 (0 / 8)] 

Factor that  halves  the  resolution  of  the  flow;  the  higher  the  value,  the  lower  the
resolution, accelerating the speed the effect is calculated.

Levels

[7 (1 / 8)] 

Refines the direction of movement vectors.

Iterations

[25 (0 / 1.000)] 

Revises movement in areas with little detail.

Smoothness

[10 (0 / 1.000)] 

Smoothes the direction of crossed vectors, making them more parallel.

Saving changes when exiting a Timewarp group:

When  exiting  a  Timewarp  group  in  which  the  total  duration  of  its  contents  has  been
modified, a dialog box will open at  the cursor position with the four possible actions shown
below: 

No actions

Exits the navigation level without changing the group duration, while being able to see
from outside the modifications made.

Reset Timewarp

Exits the navigation level and resets the group duration according to the new duration
specified by the clips inside it. 

The modifications made inside the group will be shown outside it, and the total group
duration will have been affected. 

Remember that if the duration of the interior of the group is extended on the left, the
group duration will be redefined  by  extending  the  tail  of  the  clip,  and  not  the  head.
The Timewarp curve will be replaced with a default curve, with linear advance. 
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Adjust Curve

Exits the navigation level without changing the group duration, but  its playback speed
is changed, since  the  duration is  maintained  at  the  expense  of  scaling  the  curve  of
advance  in  time  in  X  (Time-Time),  so  that  all  the  contents  of  the  group  will  be
reproduced by it. 

Cancel

Cancels, exiting the navigation level, without taking any action. 

Group in Template state:

To create a group in  Template  state,  it  is  necessary  to  group  clips  of  the  same  duration
that are aligned vertically together with, at least, a Dummy Clip effect.  This type of group
allows the creation of editable patterns to be able to re-use workflows  and  apply  them to
other clips  in  the  future  (for more  information about  the  effect  Dummy  Clip,  consult  the
chapter Dummy Clip).

It is also possible to convert  a Normal group into a Template group if  we add at  least  one
Dummy  Clip  to  a  Normal  group.  In  this  case,  when  the  group  is  refreshed,  we  can
reconstruct the group in a Template (Rebuild Group).

The  state  Template  cannot  be  transformed  to  Timewarp.  To  undo  the  group,  use  the
command  Ungroup  (Node  Graph  Editor->Dashboard->Edit->Edit->Commands-
>Ungroup).

If  the clips are not  aligned, or do not  have the same  duration,  or a  Dummy  Clip  does  not
exist between the clips we want  to group, what  will be created by grouping them will be a
Normal group.

A Template group is dark cyan, and is the only type of group that has a scope.

The  Template  group  is  edited  in  a  similar  way  to  an  image  clip,  although  instead  of
referencing media, it  references the editing of the clips that  it  contains, and added  to  the
flow processes. 

To create a Template group, it is necessary that the grouped clips have the same duration.
When the  duration of  a  Template  group  is  changed,  the  duration  of  all  the  clips  that  it
contains  are  redefined.  Although  it  is  technically  possible  to  navigate  in  the  group  and
specify  different  durations  for each clip,  we  do  not  recommend modifying  the  total group
duration from that moment, since the clips contained in them can become disorganized. 

To learn about  the working of the Template group and the cases when it  should  be  used,
read the chapter on the Dummy Clip effect.

Saving changes when exiting a Template group:

When  exiting  a  Template  group  in  which  the  total  duration  of  its  contents  has  been
modified, a dialog box will open at the cursor position with the three possible actions shown
below: 
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No actions

Exits the navigation level without  changing the total group duration,  or changing  the
duration of the clips contained in it. 

Realign

Exits  the  navigation level maintaining  the  group  duration,  but  vertically  aligning  and
redefining  the  duration of  all  the  clips  contained  in  it  with  the  value  of  the  original
group  duration.  This  option  should  be  avoided  when  it  is  necessary  to  maintain
different durations for each of the clip contents. 

Cancel

Cancels, exiting the navigation level without taking any action.

Effect clips

Mistika’s  effects  are  represented  by  clips.  These  clips  can be  processes  of  very  different
natures, or even system tools that do not directly affect the images of the clips associated
with the effect. 

Common characteristics of effects clips:

The effects clips in Mistika are color-coded according to their functions.

Animations, 3D manipulations and image deformations are identified with reds.

Color  corrections  and  operations  for  extraction  and  correction  of  the  alpha  channel  are
identified with blues.

Boolean operations and color space conversion operations are identified with purples.

Image generators are identified with dark cyan.

The Timewarp effect identified with mid-green.

Transitions are identified with yellow.

Spatial filters and image restoration operations are identified with pink.

Effects that affect the behavior of image fields are identified with light cyan.

Filters to manipulate stereoscopic images are identified with gray.

Many effects can work without the need to interact  with another clip, generating synthetic
images, such as the majority  of  the  effects  of  the  Generate  family  (Node  Graph Editor-
>Dashboard->Fx->Mistika->Generate). For this reason, several of these effects cannot
be  associated  with  other clips  by  a  process,  and  it  is  for this  reason that  they  have  no
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scope. 

The majority  of  the  remaining  effects  must  have  a  scope,  which is  a  field  with  the  same
duration as the clip, which can be extended indefinitely to tracks below. 

Manipulation of  the  scope  of  effects  is  explained  in  detail  in  the  chapter,  Manipulation of
effect clips with scope.

To add an effect to the Node Graph, it is necessary to run the command of the effect  from
the FX tab in the Dashboard or via a keyboard shortcut or from the Scribe.

Depending on what  is selected in the Node Graph, the effects will  be  added  in  one  of  the
following ways: 

If  one  or more  clips  in  different  horizontal positions  in  the  Node  Graph  have
been selected additively (see “Selections” in the chapter Selection of elements
), an effect clip whose length will be the same as that  of one it  has below will
be  created  for each one  of  them.  Its  scope  will  be  extended  to  cover  the
selected clip. 

If one or more vertically placed clips have been selected in a single area that
covers them, an effect  clip will be created whose  length will  be  the  same  as
that covered by the selected clips. Its scope will be extended to cover all the
selected clips. 

If  nothing  is  selected  in  the  Node  Graph,  the  effect  will  be  placed  in  the
current  position of the Node Graph cursor and will have a  length specified  by
the editing panel calculator. If  this is inactive, the duration of the new effect
clip will be 1s (one second). 

The scope can be modified at  any moment  by left  clicking and dragging it. In addition, the
length of the effect can be also modified or any standard editing function can be applied as
with any other type of clip. 

In any view of the effect clips, three common elements can be seen: 

Effect Name

This defines the name of the effect, which cannot be redefined. 

Active Frame

At  the  bottom  of  the  active  frame  mark,  its  frame  number  can  be  seen.  This
information can be  viewed as  timecode   by  activating  the  option  TimeCode  (Node
Graph  Editor->Dashboard->Edit->Setup->Node  Graph  View->Time  Code).  It
should be remembered that the timecode of the clip of an effect will restart  from zero.
 

When the factor of zoom allows, a proxy image of the active frame within the clip can
be viewed. 

Evaluated proxy

A group clip with a proxy evaluation has a horizontal orange line at  the top. For more
information  about  this  characteristic,  consult  the  information  about  the  group
Attributes in the Edit tab. 

Effects,  unlike  the  other types  of  clips  described  above,  cannot  be  viewed  as  a  strip  of
proxy images (group it or render it if this feature is needed). 
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When a head or tail is adjusted, or the duration of an effect  clip changed, the curves of its
parameters will be scaled in X (if the effect has any parameters).

Effect  clips  can be  freely  copied,  moved  or deleted  from the  Node  Graph,  since  they  are
processes that are only evaluated when the monitor passes over them or when rendering. 

The effects are  infinitely  cumulative  each over the  other,  forming  vertical stacks  of  large
proportions without need for an intermediate render at any time.

To  use  a  naming  convention,  each effect  clip  within  a  flow  will  be  called  a  Process,  and
each  set  of  processes  that  result  in  one  image  that  can  be  placed  in  the  space  and
composed on a similar image will be called a Layer. 

Both processes and layers of a composition can be accumulated indefinitely, with no  other
restriction than the amount of memory in the hardware where Mistika is installed. 

Some  effects  (such  as  Comp3D)  have  the  ability  to  add  a  set  of  parameters  to  each
composite  layer,  and  to  assign  composition  parameters  to  each  effect  input.  See  the
chapter Parameters.

The viewing and editing of the parameters of the effects and their animation curves is done
from the Parameters tab which can be controlled by special compositing manipulators from
the Visual Editor.

Order of effect inputs:

Effects that create a composition with several inputs always use the first  input  (the one at
the top of the Node Graph) as the background (or first layer if there is no background), and
the following inputs are the composited through the alpha channel until the bottom input  is
reached, which will represent the first plane. 

Effects that  allow the use of an external mask use the first  input  as  the  background  (if  it
exists), those following as images to superimpose successively on the background, and the
last as an external mask. 
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Manipulation of an effect clip with scope:

These types of effect clips, as with a group clip in Template state, have a scope of action,
which is shown as a dropdown. If a clip with scope is selected, it  will be drawn as a central
semitransparent gradation, in order to see it better. 

The scope is the system of process association within Mistika. 

These  associations  between image  clips,  groups  and  effects  create  process  flows,  which
should be defined by extending or reducing the scopes of the effects. 

The scope of a clip can be extended downwards by any number of tracks, and will have the
same horizontal size as the clip from which it was extended. 

The scope cannot  be in a track above the clip to which it  belongs,  although it  can be  on
the same clip track.

To move a scope, its bottom edge can be selected and dragged to lower tracks. 

When the effect clip is directly selected and then moved upwards, the bottom edge of the
scope will not be selected, and it will remain in its place. In this case the clip can be moved
vertically, extending and reducing the scope, as it has not been selected. 

If the clip container is dragged below the track containing the  bottom edge  of  the  scope,
they will both be pushed together towards the bottom edge  of  the  scope  and  dropped  at
the spot  where the downward movement  stops;  if  dragging  of  the  clip  container is  in  the
upwards direction without  releasing the clip, the scope will stay in the  lowest  track in  the
clip drag path. 

On the  other hand,  if  both  clip  compositions  are  selected  at  the  same  time  (by  using  a
selection area,  or by  pressing  the  clip  container and  then the  bottom edge  of  the  scope
while pressing <Shift>) the scope will move with the clip without changing its length. 

Each clip within the scope of another effect  is considered an Input  of the effect  above  it.
The frames of the tracks that  do not  contain  any  clip  are  not  considered  “empty  inputs”,
but  rather are directly not  considered as input. Many  effects  need  several Inputs  to  work
correctly, or to use certain project modes of the effect. 

For  example,  a  Wipe  effect  needs  at  least  two  inputs,  to  be  able  to  mix  both  inputs
together and connect them with a set of wipes. The top clip will be the first  input, the next
will be the second, and so successively for the third input, etc. 

In this way, the process flow of a stack of effects is specified by the scopes, in the same
Node Graph. 

With  the  help  of  the  flow  monitoring  option  (Node  Graph  Editor->Dashboard->Edit-
>Setup->Node Graph Monitor->Flow Monitor), these flows  can be  viewed next  to  the
monitor mark in  a  vertical hierarchical scheme  similar to  a  directory  explorer,  making  their
definition easier. 
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Furthermore, the toggle Eval Tree is available to view  the  flows  in  a  more  specialized  and
complete way, and amongst other features, it  permits navigating via groups and provides a
visual icon in each node to help understand the contribution of each effect.

Once a flow is created, we can set the value of the parameters of each process more easily
from the Visual Editor.

The Alpha Channel

The Alpha channel is the image channel that normally contains the Mask, Matte or Key of an
image. All of these terms can be used to designate either this channel or its contents, and
in this manual will be used in this sense. 

An image  mask  or  Alpha  channel  is  an  image  that  specifies  the  intensity  with  which  an
effect  is applied on each pixel of the original image. Pixels that  have  a  zero  alpha  channel
value  are  not  affected,  and  the  intensity  of  the  effect  will  increase  to  100%,  which
corresponds to the alpha channel pixels with the maximum value.

The  alpha  channel is  used  in  many  types  of  operation.  In  general,  it  can  be  said  that  it
expresses the transparency of each pixel, although in many  occasions  effects  use  it  for a
different purpose. 

Whether or not  the clips are of RGB or YUV format, another clip in the Node Graph can be
associated with it as an alpha channel (for example by using the External Key effect). 

In addition, RGB clips can store this alpha channel within the clip itself  together with other
channels, by rendering to a RGBA clip. However, YUV cannot  contain an alpha  channel,  so
that it is necessary to associate it  with a separate clip (by using the External Key effect).
When a render in RGB format  is specified with an alpha  channel,  a  single  RGBA  clip  will  be
generated, whereas if a YUV clip is rendered and the alpha channel is to be conserved, two
render processes must  be done -  one to obtain the image clip and another to obtain a clip
with the Alpha channel contents.

Mistika  provides  different  effects  that  permit  the  generation  of  an  alpha  channel  in  the
output  from the  contents  of  the  input  images.  This  type  of  effects  is  typically  known as
Keying. For example, the best  known Keying function is  the  Chroma  Key  (in  Mistika  called
Color Key) that  generates a mask for the areas of an image that  are in a certain  range  of
colors. 

Once the alpha channel is specified, it  can be viewed in the Record Monitor, in the Source
Monitor or in the Visual Editor, and we can work with effects that  only affect  this channel
(for example Blur, Color Grade, etc), or else transform this channel into a gray scale  (with
the Show Alpha effect), and even process the mask as any image. 
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timeSpace tools

The  Node  Graph  has  a  series  of  tools  that  give  more  information about  its  elements  and
modify their behavior.

Info Bar

Ref. Mistika: Node Graph Editor->Node Graph->Info Bar

The information and commands area consists of a line containing messages that refer to the
current  version  of  Mistika,  the  current  project,  environment,  confirmation  and  error
messages.

Version

Indicates the currently running version of Mistika. 

Project

Name of the current project.

Node Graph

Name of the currently open environment.

Note: if no environment is open, the default name that will appear is Unnamed.

Video Settings

Information abut the resolution of the current project (Res) and the type output signal
(Video Out).

Message line

Message line generated by Mistika for information and errors.
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Max

Maximizes the Node Graph area.

TC Slider

Ref. Mistika: Node Graph Editor->Node Graph->TC Slider

The TC Slider control area has different tools to move within the Node Graph.

Global Ruler

This shows the total time, and  contains  a  sliding  bar that  indicates,  with  its  length,
the timecode range of the Node Graph being viewed.

The bar can also be moved to the left  and right  to scroll and view other areas of the
Node Graph, or directly select another part of the ruler slider, jumping instantly to the
selected timecode.

Note: Displacement of Node Graph view can also be also done by moving the mouse in
any direction, while the holding down the right button on the Node Graph background.
If you wish to avoid monitor evaluation while  dragging  the  Node  Graph  over complex
evaluation  areas,  hold  down  <Shift>  and  the  right  button  on  the  Node  Graph
background.

Ruler Range

This indicates the duration of the Node Graph segment being viewed.

Local Ruler

Activated via Setup->Show Rulers and located in the in lower part  of the Node Graph,
just above the Global Ruler.

It  is used to show the local timecodes corresponding  to  the  part  of  the  Node  Graph
being viewed onscreen at greater amplification. It is an extension of the Global Ruler.

Note:  Mistika’s  Node  Graph  can work in  a  negative  area  of  time.  This  provides  the
flexibility  to  anchor the  Node  Graph  timecodes  with  different  video  tapes,  with  the
ability to move the Timecode mark to any position of the edit at any time.
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Offset controls

Ref. Mistika: Node Graph Editor->Node Graph

Free horizontal and vertical offset 

Displacement  in  Node  Graph  view  can  also  be  done  by  moving  the  mouse  in  any
direction, while holding the right button down over the Node Graph background.

If, for ease of movement, monitor evaluation while dragging the Node  Graph  views  is
to  be  avoided,  hold  down  <Shift>  and  the  right  button  over  the  Node  Graph
background. 

Vertical offset bar 

This is found on the right of the Node Graph, and permits navigation up or down in the
 Node Graph.

The  hotkeys  <Keypad  Up>  and  <Keypad  Down>  are  also  available  Node  Graph
offset  up  or down one  track level (note  that  this  refers  to  the  cursor  keys  of  the
number pad of the keyboard, not  those  of  the  normal cursor used  for the  horizontal
zoom). Also, the number pad should be deactivated via <Num Lock>). 

Note: Placing the monitor mark over a clip and alternately clicking the keys <Keypad
Up> and <Keypad Down> quickly compares one clip with another above or below it,
for example, to compare an image clip with the resulting effect  applied to it  (for more
elaborate  comparisons  it  is  more  efficient  to  use  the  Snapshot  toggle  of  the  Visual
Editor).

Locking Tracks

The locks are buttons found at the left  of the Node Graph and are only viewed in the
in  the  tracks  containing  clips.  When clicked,  the  editing  of  all  clips  in  that  track  is
blocked.

To unlock a track, press on the lock button again. 

To lock all the tracks except one, hold down <Shift> while pressing the lock button of
the selected track. This converts it into the Active track for editing operations, and it
is marked with a red box, while other tracks are still darkened (see the image above).
For example, when inserting clips from the Source Monitor, this method can be used to
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force the inserted clips to be placed on the same track. 

Internal shuttle

By using the hotkeys <Ctrl>+<Alt>+<LeftClick> we can move the Node Graph right
or left according to the drag direction.

The combination <Alt>+<Shift>+<LeftClick>  works in a  similar fashion,  but  faster.
It is very useful for moving rapidly in the Node Graph.

If Tangent Devices or Precision Panels are in use, their Jog control can also be used to
advance and retreat the Node Graph in a similar manner to the Jog function of a VTR,
and can offer greater sensitivity and accuracy. 

Zoom Controls

Ref. Mistika: Node Graph Editor->Node Graph

The zoom controls are divided into two groups according to whether they affect  vertical or
horizontal viewing values.

The first group of Zoom Controls is a group of buttons located in the top right corner of the
 TimeSpace. It allows us to scale vertically the representation of the tracks within the Node
Graph via a number of preset scales. 

Each button represents a level preset  scale. In modes with more zoom, image icons appear
superimposed over the clips.

The second group of Zoom Controls is a horizontal group of buttons located next  to the TC
Slider.

It has five buttons, described below:

Locking X or Y scroll

This locks the X or Y  offset  of the Node Graph. When editing horizontally,  it  is  often
useful to block Y to prevent the Node Graph from changing its height, and thus losing
sight  of  the  current  edit  view  while  scrolling  trough  the  Node  Graph  with  the  right
mouse button.

Furthermore, when working on an effect, it  helps to lock X scroll, since when working
on what occurs in a certain timecode it will avoid involuntary horizontal movements.
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Zoom to selected

Adjusts  the  value  zoom to  the  selection.  The  zoom is  adjusted  to  display  all  the
selected clips

Zoom In

Increases the horizontal zoom value.

Dynamic Zoom

By  clicking  and  dragging  to  the  right,  the  zoom level  in  time  is  increased.  In  other
words, reduces the amount of time displayed on the front end. 

By moving in the opposite direction (left), the zoom level is reduced by increasing the
amount of time displayed on the interface. Thus it  is possible to view several hours of
Node Graph simultaneously.

Zoom Out

Reduces the horizontal zoom value.

Note: the most convenient method for adjusting horizontal zoom is usually to use the
mouse wheel, since it connected to the hotkeys <Up> and <Down>.

Quick Access

Ref. Mistika: Node Graph Editor->Node Graph->Quick Access

The Quick Access buttons provide direct  access  to  a  series  of  frequently  used  commands
and tools common to the different processes in Mistika.

These commands are divided into groups according to their functions.

History:

Commands for undoing (Undo) or redoing (Redo) changes.

Undo

Undoes the last editing function or selection made.

Redo

Redoes the last undone function.
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Edit:

In this group are found the common functions of editing: Cut, Copy, Paste and Delete.
These buttons are applicable to clips via direct selection with the mouse. They are not
applicable to other types of selections such as those done with editing marks (Edit Marks).

Cut

Cuts the selected clips. 

Copy

Copies the selected clips. 

Paste

Pastes the copied clips at the cursor position in the Node Graph.

Delete

Removes the selected clips from the Node Graph.

Pack:

Horizontally locates selected clips, eliminating any empty space between them. Only clips in
the same track can be relocated, and at least two clips must be selected. 

Pack Left

This snaps the selected clips consecutively to the previous clip. 

Pack Right

This snaps the selected clips consecutively to the subsequent clip. 

Navigation:

Navigates one level in and out from the selected group in the Node Graph. 

Navigation In

This moves the Node Graph navigation level in the selected group one level in. 

Navigation Out

This moves the current Node Graph navigation level one level towards the top.

Align:

Vertically aligns the selected clips, to the right or left edge of the whole selection. 

Only clips that  are in different  tracks can be aligned to each other, and a minimum of  two
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clips must be selected. 

Align In

This vertically aligns the selected clips to the left, and consequently all  the  selected
clips will have the same In Point.

Align Out

This vertically aligns the selected clips to the right, and consequently all the selected
clips will have the same Out Point.

Prev/Next:

Relocates the Node Graph to the previous/next mark found.

The marks considered are editing marks, clip marks, user marks and play marks.

Next Mark

Moves the Node Graph forward to the next mark.

Prev Mark

Moves the Node Graph back to previous mark.

Prev Edit

Moves the Node Graph back to the previous cut. 

A cut  is the first  frame of the head of a clip, or the  one  following  its  tail,  no  matter
which track it is in.

Next Edit

Moves the Node Graph back to the previous cut. 

A cut  is the first  frame of the head of a clip, or the  one  following  its  tail,  no  matter
which track it is in. 

Edit Marks:

Sets editing marks that can be taken as references by means of their activation in the Edit
tab (Node Graph Editor->Dashboard->Edit->Active).

Edit In

Sets the input point.

Edit Out

Sets the output point.
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Edit In/Out

Sets  the  input  and  output  points.  If  this  command  is  applied  to  an  active  clip
(selected  by  clicking  with  the  mouse)  the  editing  points  will  coincide  with  the  head
and tail of the clip. If  at  the moment  of  being  applied  there  are  no  active  clips,  the
editing  points  to  be  taken as  references  as  follows:  the  tail  of  the  clip  immediately
before and the head of the clip immediately after the position of the  cursor.  For this
calculation,  neither  the  vertical  position  of  the  cursor  nor  the  clips  are  taken  into
account.

Remove Edit In

Eliminates the input point.

Remove Edit Out

Eliminates output point.

Shuttle:

These functions controls the playback of the Monitor. 

Go To Start

Positions the monitor at the Play In mark.

Prev Frame

Moves the Node Graph back to the previous frame. 

Play Reverse

Activates reverse playback.

Stop/Shuttle

Dynamic control of playback speed of the Node Graph. 

Play/Stop

Starts or stops the playback of the Node Graph. 

Play Buffer

Activates the playback buffer.

Next Frame

Moves the Node Graph forward to the following frame. 
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Go To End

Positions the monitor at the Play Out mark.

Note: If  when applying the commands Go To Start  or  Go  To  End  there  are  no  Play  Marks
present, the monitor locates in the first or last clip of Node Graph.

Play:

The group Play contains the three modes of playback in Node Graph. These modes behave
according to the active references (Edit Marks, Play Marks, Clip Select).

Single

Linear playback from the input mark to the output mark.

Swing

Continuous playback alternating between the modes Play and Play Reverse. 

Loop

Continuous playback from the input mark to the output mark.

If the marks are not active, the range is defined as the complete Node Graph.

Play Marks:

Sets playback marks that  can be  taken as  references  by  means  of  their activation in  the
Edit tab (Node Graph Editor->Dashboard->Edit->Active).

Play In

Sets the input point.

Play Out

Sets output point.

Play In/Out

Sets  the  input  and  output  points.  If  this  command  is  applied  to  an  active  clip
(selected by clicking with the mouse) the playback points will coincide with the head
and tail of the clip. If  at  the moment  of  being  applied  there  are  no  active  clips,  the
playback points to be taken as references as follows: the tail of the  clip  immediately
before and the head of the clip immediately after the position of the  cursor.  For this
calculation  neither  the  vertical  position  of  the  cursor  nor  the  clips  are  taken  into
account.
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Remove Play In

Eliminates the input point.

Remove Play Out

Eliminates the output point.

Save:

Saves a copy of the environment of Mistika.

Save

Saves the changes, overwriting the active project with the same name.

Save As

Saves the changes in a new project which must be named. This will be the new active
project.

Render:

Render Foreground

This  creates  the  script  render  (.rnd  file)  and  the  resulting  new  clip,  initiating  the
rendering task in Foreground. 

The new clip will be created as a .clp file in the RENDER folder and a copy of the clip
will be placed in the Node Graph, over the  selected  Range  or clip  from which it  was
generated. 

Processes  in  Foreground  have  priority,  inhibiting  almost  all  interactivity  with  the
interface until the rendering process is complete, in order to use all existing resources
and finish the process in the shortest possible time.

This  command  is  combined  with  the  Auto  Name  tool  of  the  Output  tab  of  the
Dashboard,  which  activates  a  numerical  field  that  increases  progressively  as  the
render processes are run.

For more information, consult the section Render in the chapter Output. 

Render Background

This  creates  the  script  render  (.rnd  file)  and  the  resulting  new  clip,  initiating  the
rendering task in Background. 

The new clip will be created as a .clp file in the RENDER folder and a copy of the clip
will be placed in the Node Graph, over the  selected  Range  or clip  from which it  was
generated. 

Processes  in  Background  have  low  priority  and  can  maintain  a  high  level  of
interactivity and continue working with the interface while the render is calculated in
the background.
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This  command  is  combined  with  the  Auto  Name  tool  of  the  Output  tab  of  the
Dashboard,  which  activates  a  numerical  field  that  increases  progressively  as  the
render processes are run.

For more information, consult the section Render in the chapter Output. 

Mute:

Mute Audio

Deactivates  the  audio  evaluation  of  all  the  monitor  marks.  Normally  this  is  used  in
complex situations, to facilitate the construction of effects towers without  their being
evaluated ad hoc.

Mute Video

Deactivates the image evaluation of all the monitor marks.

Overview

Ref. Mistika: Node Graph Editor->Node Graph->Overview

When activating the Overview command button, a whole view of the content  of  the  Node
Graph is seen in order to be able to navigate it quickly.

This window gives a complete view of all the clips contained in the Node Graph, and vertical
lines that  represent  the positions  of  the  editing  marks  and  monitors.  A  red  rectangle  that
specifies the limits of the current  visible area is shown on the  clips.  It  is  a  useful tool for
rapidly locating clips and moving the display to a particular area of the Node Graph.

The  area  of  the  Node  Graph  that  is  viewed  can  be  relocated  via  Overview,  by  simply
dragging the red rectangle with the left mouse button. 

When navigating within a group, the Overview window changes the navigation level to the
contents  of  this  group.  The  active  monitor  is  the  only  one  constantly  in  view  during
navigation,  while  the  other  monitors  remain  outside  the  group,  so  it  possible  to  view
changes made inside and  outside  the  group  at  the  same  time.  It  is  possible  to  open new
monitors once inside a group. These monitors will be transferred to the previous level when
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navigating up.

Dashboard

Ref. Mistika: Node Graph Editor->Dashboard

In the Dashboard area, the majority of commands and tools in Mistika are accessed. These
commands are organized by categories according to their use.

Access to these categories is via the corresponding tabs, called Main Tabs.

The Main Tabs are horizontally aligned at the top of the Dashboard.

Some tabs  (such as  Edit  or FX)  contain  subcategories  grouped  according  to  the  function
carried out by the commands in the main category. These subcategories also provide direct
access, via Options Tabs.

Conform

Ref. Mistika: Node Graph Editor->Dashboard->Media->Edit

The Conform functionality is ran by  dragging  the  .EDL,  .AAF  or .XML  files  to  the  Timeline.
This procedure will open the conform window. Its first  tab varies depending on the type of
file to be conformed.
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GENERAL OPTIONS

Start conform at:

Marks the TC’s point where the 00:00:00:00 position of the content to be conformed will be
placed.

Get from List

Initial TC’s reference that will be a part of the file to be conformed.

FIND MEDIA OPTIONS

Search for media after timle import

If this option is selected when entering into the next step, after pressing the button “Next”,
a new dialogue box will appear. There you will get  to choose between different  options for
the imported media.

Do not link to media

The file will be uploaded to the timeline with empty clips, being able to link the media later
with the “relink” tool.

Conform: EDL

Edl frame rate

It allows the frame rate from the EDL format to be conformed.
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Use high frame rate conversion

It activates the option to convert the frame rate from the EDL.

Fps mutiple

CDL/SDL OPTIONS

Use colour decision list

None  |  Use  ASC  CDL from  comments  |  Use  CCC  sidecar files  |  Dedicated  CCC
folder + Media Name | Dedicated CCC folder + ASC_CC_XML

When EDL contains colour values it allows to choose the prefered kind of importation.

Apply CDL values in

ASC_CDL node | Colorgrade Node

After choosing one of the options above, you can decide how the colour values of the
CDL or SDL will be displayed

Use stereo decision list

No | Yes (frame, value format) | Yes (value,frame format)

Establishes that  the tapes to be captured have stereoscopic  images recorded in Side
By Side format. 

This  option  is  especially  useful  in  order  to  take  advantage  of  Mistika's  automatic
processing of stereoscopic images derived from tape via the effect Stereo3D.

Conform: AAF

Include effects from AAF

Allows  to  include  the  effects  that  come  integrated  in  the  AAF,  generating  a
corresponding nod effect on the timeline.
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Flatten AAF effects

Groups the clip and the associated effect in a Mistika group. 

Import multicamera

Simulates Avid’s multicamera mode, importing mulitcamera clips and showing the image
that is visible at each moment in the conformed environment. 

Import unsupported effects

Inserts an empty effect  in  the  location of  the  unsupported  effect  in  order to  inform
the user of its existence in the conformed environment. 

All Video Tracks

Conforms all clips independently from the video tracks in which they are found.

V1, V2, V3, V4, V5, V6, V7, V8

Selects the video tracks to be conformed. 

Conform: XML

Include Effects from XML

Allows  to  include  the  effects  that  come  integrated  in  the  XML,  generating  a
corresponding nod effect on the timeline.

Flatten effects

Groups the clip and the associated effect in a Mistika group. 

Import Unsupported Effects

Inserts an empty effect  in  the  location of  the  unsupported  effect  in  order to  inform
the user of its existence in the conformed environment. 
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All Video Tracks

Conforms all clips independently from the video tracks in which they are found.

V1, V2, V3, V4, V5, V6, V7, V8

Selects the video tracks to be conformed. 

Media Conform

MEDIA CONFORM

SEARCH PATH

Enables to search media in various directions simultaneously with “Add Path” tool.  

ADD PATH

It will create a new instance to select the path and the type of media to search.

Clips Extension

Specifies the type of extension of the files that  will  be  selected  for conforming.  The
clips can be links to media files (.lnk), image and audio clips generated in Mistika (.clp
), or render scripts (.rnd). (Remember that in Mistika, .rnd files are stored in the same
directory with the .clp clips they produce, so  we  have  to  indicate  which of  the  two
types we wish to conform.)

If  we  need  to  obtain  .rnd  files  (in  order  to  conform the  effects  of  Mistika  already
applied to the clips) it  is not  necessary to do a complete render process;  simply  use
the command WriteScriptOnly in the Output panel.
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WITH PREFIX

Data field for specifying whether the referenced clips have any kind of  prefix.  This  is
indicated for occasions when conforming based only on timecode, and is a last  resort
for distinguishing clips with similar timecodes, when the first  part  of their file  name  is
different. For example, if  we have clips such as Monday_XXX, Tuesday_XXX,  we  can
write "Monday"  in this field to restrict  the conform to the  clips  that  begin  with  that
character sequence.

Path

It  defines the path where Mistika will search for the  media.  The  software  will  search
for the selected files and its subfiles. 

MATCH RULES

Take editname from

Clip Name: Dialog box that  names the folder to be created by the conform, and the
clips that will be created within this folder.

Tape name: a reference to the tape’s name. 

 None, Only TC: The pathname of the clips that  appear in the AAF, EDl or XML is not
taken into account as reference, only the timecode.

Use TC

When locating the media, the time code will be considered.
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Clip Tc to use

Specifies the origin of the timecode to be interpreted for the  conform.  We  normally
use  the  option main TC,  although some  files  may  contain  various  possibilities  (as  in  the
case of .r3d files).

In the case of conforming numbered sequences (.dpx, etc), if  the  option main TC  is
selected, the timecode will be deduced from the number of  the  frame  present  in  the
name. If the activated option is Use clips TC  Aux 1,  the  timecode  will  be  extracted
from the internal head of the file

Match exact name only

Sets the original media filename as appears in the AAF, EDL or XML as reference.

EDITNAME

Ignore first

Sets  the  number of  characters  at  the  start  from which  the  clip  name  is  generated
when editing for conforming.

Ignore last

Sets the number of characters at the end from which the clip name is generated when
editing for conforming.

Max

Limits the number of characters to be taken into account, since some offline systems
add terms to the original name given by  the  cameras.  Zero  ("0")  denotes  no  limit  to
the number of characters.

TAPENAME/CLIPNAME

Ignore first

Sets  the  number of  characters  at  the  start  from which  the  clip  name  is  generated
when conforming.

Ignore last

Sets the number of characters at the end from which the clip name is generated when
conforming.

Max

Limits the number of characters to be taken into account, since some offline systems
add terms to the original name given by  the  cameras.  Zero  ("0")  denotes  no  limit  to
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the number of characters.

Project_Manager

Ref. Mistika: Node Graph Editor->Dashboard->Project Manager

The  project  manager  window  allows  to  explore  the  directory  that  contains  the  Mistika
projects. In this tab you will be able to administrate the interface of the creation, to upload
and eliminate the projects. 

List Project

This  is  a  list  of  all  existing  projects  from the  directory.  Defined  in  Mistika  Setup  (
Mistika Setup->FilePaths->Projects). 

Set Project

Load the selected project from the list. 

New Project

This button deploys a new floating window that will  ask for a name in order to create  a new
project.  The  project  configuration  will  be  granted  by  the  parameters  that  were  previously
configured in the mConfig utility.

Delete Project

Deletes the selected project from the list. 

SHOW USER PROJECTS

When activating this  tickbox the  projects  that  were  created  by  the  active  User will
appear in the upper panel. 
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Media

Ref. Mistika: Node Graph Editor->Dashboard->Media

The Media button displays the Mistika file browser. In previous versions, two separate browsers

were used: one for importing material and another for managing media files already imported into

a project. In the current version, these two browsers have been merged into one, providing greater

versatility and flexibility. 

Interface panels

The Media panel is the interface for project management, navigation, selection, loading and saving

clips and files. 

For  specific  tasks,  this  panel  interacts  with  different  panels,  especially  with  the  Source
Monitor, which is  explained  in  detail  later in  this  document.  It  is  also  used  in  conjunction
with the window VTR Capture of the VTR tab.

The Media window is divided into different areas that can be enabled, disabled, and configured by

the user:
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Top Menu

It includes the most important Browser commands, such as Import, Refresh Directory, Save

Project, etc. Some of these commands have a quick access for ease of use in the form of icons.

Filter Box

This controls the Browser’s filtering tools, including pre-defined lists of formats, types of clips, and

a Setup in order to set more specific parameters. 

Browsers

These are the fundamental elements of the Media panel, allowing navigation through the different

directories and management of material. They include important tools such as viewing modes, the

routes and history panel, information about the storage system, etc. 
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Bookmarks

These panels manage Bookmarks saved by the user, whether they are independent Directories or

groups of directories.

Properties

Displays all information relating to the properties of the selected file.

Directories structure:

Mistika projects consist of standard directory structures, where files are organized so as to
be visible in any operating system. 

In addition, all Mistika metadata files are in plain text (ASCII) that can be interpreted by any
text processor. 

Other systems use encrypted databases, or require special applications to be able to share
their projects.  Mistika’s  projects  are  totally  transparent  to  other systems,  and  can  share
metadata without  the need to acquire additional applications, allowing  other developers  to
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work with this data to create their own project routines. These characteristics make Mistika
as the most open system of all software products in its category. 

When creating a project, Mistika generates a  standard  directory  structure,  which can  be
partially redefined by the user: 

The  user must  designate  a  unique  directory  to  contain  all  the  projects.  Initially,  Mistika
creates the /home/Mistika/WORK directory as the project directory, but the user can modify
it later in Mistika Setup (Mistika Setup->File Paths->Projects).

The user can modify this at  any time if  the  directory  has  been moved,  or if  projects  that
exist elsewhere are required to boot with Mistika. 

Within  this  projects  directory  (WORK),  each  project  that  is  created  generates  a  basic
directory with the same name as the project, and all the subdirectories that  it  contains are
considered part of it. 

In the design of  this  structure,  the  following  tools  provided  by  Mistika  should  be  borne  in
mind: 

The  Browser  distinguishes  between  each  type  of  file  by  writing  their  names  in  different
colored letters, as well as placing a distinctive icon to their left. 

The Browser permits files to be sorted by different  criteria: alphabetical order, type of file,
date, input and output timecode, video tape source, media size on disk, length, format, etc.
 

This  means  that  it  is  not  necessary  to  design the  subdirectory  structure  to  organize  the
files on these lines, but  that  it  should be used in a more abstract  sense,  to  represent  the
meaning of each element  of the environment  (for example, directories  could  be  created  to
divide the clips according the shooting location, and then subdivided again by the scene or
effect to which they pertain). 

It  is  not  usually  necessary  to  create  subdirectories  to  store  the  subclips  (.sub)  that  are
generated in the Browser or the Node Graph, since the subclips have file names that  begin
with  the  same  name  as  its  master  clip,  displayed  with  a  different  color.  It  is  therefore
sufficient  to sort  the Browser  by field name, and thus a very useful list  will be  obtained  in
which each master clip will be shown followed by its subclips in a different color. 

When  a  new  backup  to  video  is  created,  Mistika  generates  a  subdirectory  for  the  new
backup, in which the following files are saved: 

An environment (.env) containing all the clips of the project  that  coincide with
the  current  resolution  specified  in  Mistika’s  configuration,  which  must  be
loaded in the Node Graph to be transferred to video with the VTR tab. 

A disk cleanup file (.cln) which, when double-clicked, runs a process to delete
the media from all the clips included in the backup. 

A restore file (.res) for each clip of the project that contained media when the
backup  was  created.  These  files  are  similar to  normal clips,  but  their  In/Out
Points refer to the location of the clip in the video tape  that  will  contain  the
backup. 

Note: remember that  in backups to video only clips captured on  video  and  those  derived
from Mistika  renders  with  be  included.  To  backup  other  files,  use  the  tool  Sequencer  (
Sequencer->Backup).

All the project metadata that the user will use are stored in this directory, i.e.:

All  image  and  audio  clips  of  the  project  (.clp  -  reference  clips  created  when
capturing  or rendering).  Remember that  these  files  do  not  contain  current  images,
but  rather  metadata  for  referencing  the  current  image  and  audio  files  stored
elsewhere.   
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Linked  clips  -  these  are  generated  when  image  or  audio  sequences  in  external
formats (.tga, .dpx, .wav, .tiff, .cineon, etc.) are imported. These clips have the .lnk
. extension. This type of clip is also created when importing a Mistika  image  source
file  (.js)  that  pertains  to  another project,  in  order to  be  able  to  indicate  that  its
management  in terms of  backups,  deletion,  etc.  does  not  in  principal relate  to  the
current project.

Work carried out in Node Graph, both editing and compositions (.env files). 

The clips that are saved from within Mistika, such as subclips (.sub files) effects (.fx
files) and groups (.grp files). 

The subdirectories created by the user to organize clips.

The RENDER folder is located within the DATA folder.

Each time  a  render is  run,  this  folder is  used  to  save  both the  scripts  generated  by  this
action (.rnd)  and  the  clips  resulting  from the  process  (.clp).  These  files  are  organized  in
subfolders,  each  one  containing  the  results  of  each  render  operation.  (including  all  the
segments that are put in order in the same operation).

The  render  scripts  can  be  reloaded  in  Node  Graph  to  repeat  a  render  process,  and  its
parameters or duration can be modified if  necessary. The structure of a render script  (.rnd
files) is identical to that of a group (.grp files). 

Within the DATA folder we can create  as  many  subfolders  as  we  wish,  which can contain
new levels of subfolders if desired. This allows us to create the structure that  is best  suited
to the project in hand.

This directory is reserved for maintaining compatibility with versions of Mistika  prior
to version 6.5; it is obsolete with the new directory, file path and links structure.

This directory contains links to sequences of files or directories external to the project  with
other types of file that may come from:

Render processes  to  numbered  formats,  with  each  sequence  stored  in  a  in  a  different
subdirectory.  This  is  the  default  storage  location,  although  this  will  usually  be  reset  in
Mistika Setup. 

   It  may  also  contain  references  to  remote  image  sequences  (.tiff,  .tga,  .cineon,  etc.)
stored in numbered files that have been linked.  

It  may often be necessary to save a local copy of small user files such as EDL's, logos,  or
isolated images that  need to be saved in a folder that  pertains to the project's  structure,
in order to keep the work well-organized.

It is recommended to use this default  folder in order to copy small files to be imported and
even create the subfolders considered necessary.

When dealing with sequences of large files, the system allows importation via direct  linking
to sequences found in any directory that is accessible to the OS, and so they should not  be
placed  here,  but  rather  in  locations  that  have  sufficient  storage  and  the  appropriate
features for the chosen format. 

This directory stores: 

Files  that  the  user  can  save  voluntarily  from  different  interfaces,  such  as
tracking files (.trk), warping files (.msh) and vectorial shapes  (.shp)  amongst
others.

Groups (.grp) that have been saved manually.

Compressed type groups (.grpz) that have been exported manually.
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This directory contains the presets (.pcc and .pfx) generated via the tool FX Presets.

In  the  GLOBAL_PRESETS  subdirectory,  the  presets  to  be  kept  for  use  in  other  Mistika
projects are stored.

This  directory  stores  files  for  the  internal  use  of  Mistika’s  effects,  such  as  Metadata
generated by some effects and plugins (it is essential for the animated mesh of Warper, the
vectors created in VectorPaint, and the texts in Title).

As  the  groups  and  environments  saved  so  not  contain  this  data,  when  copying  them to
another system, use the button Packaging Group to create a .grpz group which will contain
this data.

Top Menu:

The upper menu of the Media panel is divided into 5 groups:

File

This includes the following commands:

- New Folder: creates a new folder in the selected directory.

- New TimeLine: generates a new Node Graph.

- Save: saves the current project.

- Save As: saves the project with the name set by the user.

Edit

Incluye los siguientes comandos:

- Cut: cuts the selected file/files.

- Copy: copies the selected file/files.

- Paste: pastes the contents of the clipboard.

- Delete: file delete command.

This  command  deletes  a  directory  with  all  its  contents,  which  will  be  viewed  in  a
confirmation  list.  For  this  reason  this  tools  has  confirmation  windows  containing  a
description of the files to be deleted.

Each type of file is differentiated in the deletion confirmation list, and the deletion of
each type of file can be activated or deactivated. 

Clip links (.lnk), subclips (.sub), groups  (.grp),  renders  (.rnd)  or environments  (.env)
refer indirectly to the media being used.

Image  clips  (.clp),  as  with  the  mixed  audio  and  video  clips  generated  in  a  capture,
have different  deletion options as they refer directly  to  a  media  file  (the  system will
ask before deletion).

The  confirmation  windows  are  divided  in  Master  Clips,  Other  files  related  with
Mistika, Directories  and files  NOT related with Mistika  y  Linked Clips  and their
links to media.

Master Clips:  Permanently  deletes  both the  referenced  media  and  the  metadata  of
selected clips; it  is impossible to recover the data in order to  recreate  the  clip  after
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this command is run.

High Res. Deletes the image media of selected clips.

Low Res. Deletes the media of the proxy assigned to selected clips.

Audio Media. Deletes the audio media associated to selected clips.

Note: It  is not  possible from within Mistika to delete only the metadata of a clip and
keep  the  media  on  disk  without  reference.  This  prevents  the  user  deleting  files
mistakenly, and avoids the existence of un-referenced media.

The Low Res delete option is very useful on critical occasions in order to free storage
space, as is the deletion of media of clips, which can be recovered by Metadata, and
the media recover or processed again in the workflow where the media derives from at
a later time.

Other files related with Mistika: Deletes other types of file that  are not  media with
the  .js  extension but  pertain  to  the  Mistika  environment,  eg,  render  groups  (.grp),
render scripts (.rnd), presets (.pfx) and output formats Movie and Images.

Directories and files NOT related with Mistika: Deletes folders and files that  do not
pertain to the Mistika environment , eg, directories where renders are stored.

Linked Clips and their links to media: Deletes files the with .lnk extension  and  the
references to media they contain.

- Refresh: refresh the content of the selected Browser.

- Find and Select: Find and select  in the Node Graph the selected material in the Browser.
This  command can  be  activated  in  the  Node  Graph,  so  works  in  the  opposite  direction,
showing the media in its directory.

- Relink: Allows the relinking of files that  have previously been imported that  appear offline.
To  do  so,  select  the  clip  in  the  Node  Graph  and  click Relink.  A  window  appears  with  the
path defined for the  clip  selected  in  the  Node  Graph  (the  filepath is  refreshed  by  clicking
another clip in the Node Graph) and selecting the new folder via the Browser.

Import

Import  commands  only  work for supported  file  formats.  For more  information,  consult  the
chapter compatible Formats.

-Import/Load:  

Links the selected file by creating a link clip (.lnk) in the Project  folder. This command
can also be run by double-clicking any image or audio file.

In Mistika, it is possible to create link clips that refer to image and audio files that  are
not necessarily found in the real-time storage of the workstation. In the link clip, the
original location  in  the  network  is  indicated  (subsequently,  the  decision  to  make  a
render in order to bring it to real-time storage can be made).

In the case of image files, a dialog box permits the following options:

Link single image only

Creates a clip for each image selected file.

Link as interlaced sequence
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Creates an interlaced video clip for each sequence of the selection that  is  numbered
consecutively. 

Link as progressive sequence

Creates an progressive image clip for each sequence of the selection that  is numbered
consecutively.

This method permits the selection of multiple files to be  imported  en masse  (keeping
<Shift> depressed during the selection). In this case, they must be the same format.

- Import All Movies:

Allows  the  linking  of  the  Movie-type  files  in  the  current  folder  in  a  single  operation
without  needing  to  select  them.  This  operation  creates  link-type  files  (with  the
extension  .lnk)  in  a  new  folder  within  the  DATA  directory  of  the  project,  and  also
incorporates them into the current edit. A window indicates the progress of the task.

Note:  Before  conforming  an EDL against  numbered  files  or Movies,  it  will  usually  be
necessary to use these commands, since the conforms against  these files is based on
clips that have already been imported. 

- Import All Sequences: 

Allows the linking of all existing image sequences in an external directory tree with just
one click. To do so, select  them (or the directory that  contains  them)  and  click this
button.

This operation creates links in a new folder within the DATA directory  of  the  project,
and  also  incorporates  them into  the  current  edit.  A  window  appears  indicating  the
progress of the task. 

When importing multiple files simultaneously:

Separator to use

It allows us to choose the graphic  element  to use as separator in the imported media
name.

Use to generate Clipname / Tapename

When generating  the  name  Clipname  or Tapename,  we  can  indicate  the  number  of
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folders in the location path that  we want  to  be  added  to  the  name.  We  can also  in
the case of Clipname include the extension of the file or in the case of Tapename the
tapename that the file contains.

Follow links

When importing symbolic links instead of clips this option must be active.

Replicate the Folder Tree

It allows to replicate the folder structure where the media files are located, generating
a exact copy of it in /DATA.

Interlaced

The  media  is  by  default  imported  as  progressive.  To  import  it  as  Interlaced  the
Interlaced button must be activate.

Export

- Export Copy Buffer y Create Packaging from Group: 

In  certain  situations  when  working  collaboratively,  it  may  be  necessary  to  transfer
part  of  a  job  to  another Mistika  workstation  that  does  not  share  storage  with  the
current  one  in  use,  for  example  when  working  with  rotoscopes  done  with  small
systems that then have to be taken to the main system. 

To achieve this, group files group (.grp) can contain part  of the contents (or even a
complete environment). But  these groups  cannot  always  be  transported  as  they  are
to other Mistika systems, since the metadata files associated  with  some  effects  and
plugins  (such  as  vectors  drawn  in  VectorPaint,  vectored  texts  in  Title,  and  mesh
animations  in  Warper)  are  found  in  separate  .dat   files  in  the  project's  PRIVATE
 directory.

The Creating Group button allows the user to resolve this problem as follows:

1. Save a group .grp (select the group, press Edit->Copy and then Browser->Creating
Group).

2. The  group  will  appear in  the  OUTPUT  folder  in  the  Browser.  Next,  select  it  and
press Packaging Group.

3. Step 2 creates a compressed export  group (.grpz file)  which contains  the  original
group and all the related .dat files. This file can be transported to another system,
and then imported by double-clicking on it in the Browser.

Note:  images  and  media  files  used  in  the  group  are  not  included;  if  required,  they
should  be  copied  or  recaptured  separately  in  the  new  system.  For  more  complex
cases,  use  the  tool  Sequencer,  which  allows  recompiling  the  project  with  the  files
media it use.

- Source Monitor:

Load in Source

Loads the selected clip in the Source Monitor. 

This function is implicit when selecting a clip, although certain types of file (.env, .grp
and  .rnd)  with  complex evaluation are  not  automatically  loaded,  in  order  to  reduce
loading times,  as  it  is  necessary  to  calculate  the  processes  that  they  may  contain.
For these types of file, this function should be used, or double-left-click on it.
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Save from Source

Saves the contents of the Source Monitor to a file in the Browser.

The duration of the file generated will be defined by the value of the In/Out  Points in
the Source Monitor.

The purpose of this function is  to  export  a  whole  clip  or part  of  one  of  any  type  in
separate  files,  and  facilitate  distinguishing  rapidly  between  project  files,  making
possible their later reuse in the same or in any other project, and even from another
workstation.

The type of file created will vary according to  the  type  of  clip  loaded  in  the  Source
Monitor. 

The types of file  that  can be  saved  in  the  Source  Monitor  in  accordance  with  their
type of clip contents are listed below: 

A single image or audio clip or mixed clip (.clp): saved in a subclip file (.sub)
in the Browser, in order to distinguish them by their name or to divide a  clip
into several parts. To load a single image or audio clip or a mixed  clip  in  the
Source Monitor, any clip can be selected in the Browser, or copy a clip from
the  Node Graph with the function Copy of the Edit tab.

Note:  the  file  name  of  the  subclip  will  be  set  automatically,  using  two
different  criteria  depending  on  its  origin:  if  the  clip  comes  from  the  Node
Graph with a modified name (which can be  modified  from the  tab  Attributes
tab of Edit), this name will be repeated. If the clip comes from the Browser, a
numerical  extension  will  be  added  to  the  original  name  of  the  clip  to  be
automatically  incremented  in  order  to  avoid  overwriting  another  subclip.
Example: MyClip_001.sub.

Various clips  whose  file  type  is  irrelevant,  an effect  clip  or a  group  clip:  to
load a group in the Source Monitor, first select a group clip or various clips of
any type in the Node Graph, and then run the Copy function of the Edit  tab.
Then Save and a group file (.grp) will be saved in  the  OUTPUT  folder of  the
current project, which will contain all the clips loaded to the Source Monitor.
The  name  of  the  file  must  be  specified  by  the  user  in  the  dialog  box  that
appears.

An  importable  image,  audio  or  movie  type  file:  saved  in  a  link  file  (.lnk),
containing  a  clip  directly  related  to  the  selected  file  in  the  Browser  and
viewed in the Source  Monitor.  When an image  file  is  selected  from within  a
numbered  sequence,  the  Source  Monitor  will  load  the  entire  sequence.  The
user can create a link to the entire sequence or to the selected frame  only,
and choose this option in the same dialog window that  will ask for the  name
of the link. 

Note: In principle, the link file name will be automatically proposed based on
the original name of the selected file, although the user can modify this name
or choose another. 

Note: When the Source Monitor  views a multiple selection in the Browser, a
single link file will be created including the entire selection.

View

- Home: redirects the active Browser to the project folder.
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- Folder Tree: activates/deactivates the Folder Tree.

- Path Bookmarks: activates/deactivates the Path Bookmarks.

- Selection Bookmarks: activates/deactivates the Selection Bookmarks.

- Properties: activates/deactivates the Properties panel.

- Split View: divides the Browser into two independent panels.

- Detail View: changes the file display mode to detailed mode.

- Icon View: changes the file display mode to icon mode.

- Collapse Image Sequences: collapses the image sequences into a single file. 

Filter Box:

This set of tools and commands allows the user to filter the contents of the Browser in order to

locate certain files more easily. The most basic filtering system is one that uses the file name as a

search item. This is the default search mode, but there are many more options in Filter Settings:

Filter Settings

To select the fields to be used as filters:

Name: Name given by Mistika to the file.

Tracks:  Image  or audio  tracks  assigned  for this  clip.  Only  the  clip  files  (.clp)  will
show data in this column. They will show if  video is assigned to them (V),  and  the
number of audio channels (A). 
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Length: Length of the clip. 

Start: Timecode of the start  of the clip, both  for captured  clips  and  imported  DPX
file sequences. 

End: Timecode of the end of the clip, both for captured clips and imported DPX file
sequences. 

TC Aux 1 and TC Aux 2: Auxiliary timecode of the clip, as in the case of .R3D files.

Size: specifies the space occupied on disk. Clips will show file size of their media, if
they have any. 

Date: Date of creation or last modification of the file.

Tape:  Name  of  the  tape  which  the  clip  originates  from.  Only  recoverable  clips,
created  via  the  VTR  tab  (Node  Graph  Editor->Dashboard->VTR),  or  from  the
importing of an EDL, will show data in this column.

Tape Header: Internal name of the file that  supports some formats (como .dpx). Its
main  function is  to  make  easier the  conforming  of  this  type  of  file  when  the  EDL
shows that it was the internal name and not the name of the file.

Path: File path.

File Name: File name.

Format: Format of the media. 

Comment: User comments on the clip, inputted in the capture panel.

Otras opciones:

- Case Sensitive: if active, the filter system will use the detection of capital letters.

- Clear History: clear the search history.

 Filter List

A quick way to find a content type is to use the Filter List. This list  includes the most
common formats, including Mistika’s internal formats, and the following types of files:

- All Files: displays all kinds of files (both supported and unsupported).

- All Supported Files: displays files supported by Mistika.

- Raw Camera Files: displays only Raw files.

- Movies: displays only movie files.

- Image Sequences: displays only image sequences.

Browsers:

There are two types of Browser in Mistika:

- Folder Tree: displays the hierarchy of folders in an expandable tree. This is mainly manages the

browsing of directories.
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- File Manager Browser: displays the contents of the directory selected in the Folder Tree. This

mainly manages the browsing and management of files. 

File Manager Browser

The main Browser of Mistika has a number of unique features, in contrast to the Folder Tree
:

-  Browsing  history:  in  the  field  where  the  active  route  is  displayed,  a  list  of  routes
previously visited may be seen as a dropdown, for faster access.

- Organizational System by Columns: the Browser organizes content in columns according to
different kinds of information. These columns can be activated or deactivated: right-clicking
on one of them to will  display  the  list  of  options.  There  are  two  functionalities  in  this  list
worthy of note:

AutoFit: automatically adjusts the width of the Name column to the width of the longest

name in that directory.

Unlocked: locks the display of the column name so that it is always visible. 

The remaining fields will be familiar:

Name: Name given by Mistika to the file.

Tracks:  Image  or audio  tracks  assigned  for this  clip.  Only  the  clip  files  (.clp)  will
show data in this column. They will show if  video is assigned to them (V),  and  the
number of audio channels (A). 

Length: Length of the clip. 

Start: Timecode of the start  of the clip, both  for captured  clips  and  imported  DPX
file sequences. 

End: Timecode of the end of the clip, both for captured clips and imported DPX file
sequences. 

TC Aux 1 and TC Aux 2: Auxiliary timecode of the clip, as in the case of .R3D files.

Size: specifies the space occupied on disk. Clips will show file size of their media, if
they have any. 

Date: Date of creation or last modification of the file.

Tape:  Name  of  the  tape  which  the  clip  originates  from.  Only  recoverable  clips,
created  via  the  VTR  tab  (Node  Graph  Editor->Dashboard->VTR),  or  from  the
importing of an EDL, will show data in this column.

Tape Header: Internal name of the file that  supports some formats (como .dpx). Its
main  function is  to  make  easier the  conforming  of  this  type  of  file  when  the  EDL
shows that it was the internal name and not the name of the file.

Path: File path.

File Name: File name.

Format: Format of the media. 
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Comment: User comments on the clip, inputted in the capture panel.

Other options:

- Case Sensitive: if active, the filter system will use the detection of capital letters.

- Clear History: clear the search history.

- Visualization Tools: icons as a shortcut to different display modes include:

- Split View: divides the Browser  into two independent  panels. A green border around
its edge identifies the active panel. This is especially important  because  the  tools  of
the upper menu are generic  for all Browsers, so there needs to be a  way  of  knowing
which Browser is active and, therefore, which one the user will be working with.   

- Detail View: changes the file display mode to detailed mode.

- Icon View: changes the file display mode to icon.

- Collapse Image Sequences: collapses the image sequences into a single file.

- Interactive Zoom controls the display size of the various elements of the Browser

- Information elements: along with visualization tools, there is a graphic representation of
the general storage system, which in  turn  can be  used  as  a  progress  bar when loading  a
particular directory. There is also a numeric field showing the number of folders and files in a
given directory. 

-  Contextual menu: right-clicking on any file accesses a  contextual menu containing  the
Browser’s most common tools. 

Bookmarks:

Mistika allows the saving of paths of files and folders as Bookmarks for later use. Depending

on whether it is a single path or a Selection of directories, Bookmarks are saved in the

panels Path Bookmarks and Selection Bookmarks respectively.

Right-clicking accesses a number of functions relating to bookmarks: 

- Add Path/Selection: adds a route or set of routes manually.

- Edit Path/Selection: allows the editing of a route or set of routes previously added to the

Bookmarks panel. In both the previous case and this one, a floating window will open: here,

the name of the Bookmark (Description), the routes contained in this Bookmark (Location),

and the icon to be used as a graphic representation (Choose an Icon) can be set.
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- Hide Path/Selection: hides the selected route / set of routes.

- Remove Path: deletes the selected route / set of routes.

- Show Hidden Paths: displays previously hidden routes / set of routes. 

Properties:

The Properties panel displays the properties of the selected file. The Properties fields are:

File

- Name: filename.

- Path: file path.

- Size: file size.

- Created: date the file was created.

- Modified: last date the file was modified.

Clip

- Image: information about the properties of the image.

Resolution: XY resolution of the image.

Aspect Ratio: aspect ratio of the image.

Codec: image codec of the file. Sometimes this will  also display information about the color
space.

Format: image format.

Audio: information about the properties of the audio.

Codec: audio codec of the file.

Sample rate: audio sampling rate.

Channels: number of audio channels.

Bit Depth: audio bit depth.

 Time

- Length: duration of the clip.

- Start: start timecode of the clip, whether captured or imported sequences of DPX files.
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- End: end timecode of the clip, whether captured or imported sequences of DPX files.

- TC Aux 1 y TC Aux 2: auxiliary timecode of the clip, as in the case of .R3D files.

-  Tape  Name:  name  of  the  tape  from  which  the  clip  is  to  be  recaptured.  Only  files  from
recapturable  clips created via the VTR tab (Node Graph Editor->Dashboard->VTR)  or  via  the
import of an EDL, will display data in this column

-  Tape  Header:  internal  name  of  the  files  that  supports  certain  formats  (eg.  .dpx).  Its  main
function is to facilitate the Conforming of  this kind of  file  when the EDL displays the internal  name
and not the file.

- TimeCode: the timecode of the clip.

- FPS D: shows the value of the denominator of the frames per second of the clip.

- FPS N: shows the value of the numerator of the frames per second of the clip.

Using double-click with files:

Most  file  types  are  capable  of  running  functions  when  they  are  double-clicked  in  the
Browser. 

These have the .clp, .cln, .grp, .env extensions, and any kind of image or sound file can be
imported into Mistika. 

When double-left-clicking on an image  or audio  clip  file,  or mixed  clip  (.clp),  its
information will  be  loaded  in  the  Capture  Panel.  For  more  information,  see  the
chapter VTR Capture.

When double-clicking  an image  or  audio  file  that  is  compatible  with  Mistika,  a
dialog  box opens  in  order to  create  a  linked  clip  indicating  said  file;  the  clip  is
then loaded into the Node Graph at the cursor's position in Node Graph.

Compatible formats

Note: Some of these formats may not  be included in the basic  version of  Mistika  and  may
require additional Mistika modules or licences respective and pertaining to said file format.

The  following  is  a  reference  list  of  media  formats  that  SGO  Mistika  is  able  to  read  and
import.

Audio Interchange (.aiff)

Waveform Audio (.wav)

Wave64 (.w64)

Audio Interchange Compressed (.aifc)

Text (.txt) (in the Title manipulator)

EDL Text (.edl)

Digital Picture Exchange: DPX 8bits /DPX 10bits / DPX 16 bits in all variants (.
dpx)

Cineon (.cin)

Generic Picture (.pic)

Bitmap (.bmp)

Joint Photographic Experts Group (.jpg)
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QuickTime PICT Image (.pict)

Targa (.tga)

Vista Targa Bitmap (.vst)

Flexible Image Transport (.fit)

YUV Encoded (.yuv)

RGB Bitmap (.rgb)

Tagged Image File (.tif) 

Portable Network Graphic (.png)

PIX Bitmap(.pix)

Graphical Interchange Format (.gif)

Photoshop Document (.psd)

Maxwell Render (.mxi)

JPEG 2000 (.j2k)

Moving Picture Experts Group (.mpg)

IRIX Movie (.mv)

Audio Video Interleave (.avi)

Material Exchange Format (.mxf)

Quicktime (.mov)

Redcode Media (.r3d)

Ogg Vorbis Compressed Audio (.ogg)

Ogg Vorbis Video (.ogv)

High Dynamic-range (.vr2)

Vision Research Phantom (.cine)

ARRI RAW (.ari)

Sony RAW (contained in .mxf)

HDR High Dynamic Range (.hdr, .exr)

Apple ProRes 444 (.mov)

Apple ProRes 422 (.mov)

WEISSCAM RAW (.fhg)

CineForm 2D and Stereo (.mxf)

AVC-Intra (contained in .mxf)

MXF VC-3 in all its progressive and interlaced variants (.mxf)

DV25 / DV50 / DV100 / DVCPRO-HD (.mxf)

Flash Video (.flv)

Compressed Movies MPEG1, MPEG2, MPEG4, H264 (.mov, .avi, .mxf)
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Uncompressed Movies (.mov, .mxf, .avi)

Canon Raw (.rmf)

Embedded 48khz Audio in movies (.mov, .mxf, .avi, .r3d).

Note:  Timecode  is  supported  for  .mov,  .mxf,  .dpx,  and  .r3d  formats  and  for  numbered
sequences.

Note: Long gop-type Movies can be read but playback must be from the first  frame or they
must be rendered to other formats, since otherwise the intraframes ("iframe") cannot  locate
a specific frame without reading the previous ones.

Note:  Some  formats  contain  Bayer matrixes  which  must  be  decodified  with  the  Debayer
effect (they can be imported but not viewed correctly until this is done). This is the case of
formats  derived  from  Phantom  and  Weisscam  cameras.  Others  have  their  own  effects
decodifiers, such as Arri D20/D21/Alexa (ArriParams) and RED cameras  (R3DParams),  Sony
F65, F55, F5 (SonyRawParams) and Phantom (PhantomParams).

Note: This list may differ by the time of publication: please read the Release Notes for the
latest available update.

Edit

Ref. Mistika: Node Graph Editor->Dashboard->Edit

Editing functions, such as copying, inserting, cutting or adjusting  the  duration of  clips,  do
not  in fact  work with the original images and audio,  since  the  clips  are  only  references  to
the original material. For example, when making a copy of a clip, the new clip "indicates" the
same material, but  never copies the original material to disk and, in fact, the  new  copy  of
the  clip  keeps  the  same  name.  Similarly,  cutting  a  clip  does  not  physically  divide  the
material that  is being worked  on.  Thus,  all  editing  functions  are  non-destructive,  and  any
function therefore can be undone. 

The only way to  delete  original material  physically  from within  Mistika  is  with  the  deletion
tools in the Browser, or by deleting the entire project via the Project tab.

For a process to generate a new material source, a render should be done (via the options
Render in the Output  tab). This operation is not  generally necessary for editing operations,
since Mistika can play back and save the final edited version in real-time without  needing to
render.  This  render  is  only  necessary  when  a  combination  of  effects  that  cannot  be
maintained in real-time is applied. 

The Edit tab of the Dashboard is only one part  of the editing interface, and although it  can
be  used  with  almost  all  the  editing  operations,  remember  that  there  are  more  dynamic
editing methods.

The editing methods in Mistika are:

Classic NLE Editing 
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The  Browser  has  two  monitors:  a  preview  monitor  called  Source  Monitor  and  program
monitor called Record Monitor. This allows both visual search of a new clip and the defining
of its  Input/Output  points  in  the  preview  monitor,  while  in  the  program monitor the  Input
point is established in the Node Graph. Thus we can insert  a clip in the edit  via three-point
editing. Edits can therefore be carried out  in a traditional way  without  needing  to  use  the
Edit tab.

Direct Editing

The Node Graph allows the most basic editing operations to be done with the mouse cursor
(duplicating clips, adjusting position and duration, etc.) without needing to use the Edit  tab.
If we wish to carry out  these operations manually and interactively, use the Direct  Editing
of  the  Node  Graph;  if  we  wish to  use  references  to  specific  timecodes  or  existing  marks
(monitor mark, editing marks, play marks, global or clip marks) then use the buttons of the
Edit tab. Remember that many functions of the panel can be activated from Scribe.

Advanced Editing (tab Edit)

All  other editing  functions  not  contemplated  in  other  methods  are  found  in  the  Edit  tab
which provides the additional advanced tools that are described below.

Classic NLE editing

The classic NLE mode of editing is based on working with two editing monitors, defining two
editing points in the Source Monitor, and a third editing point  (or even a fourth) within the
Node Graph in the active monitor. This system is  very  useful for starting  any  edit,  adding
image  clips  to  the  Node  Graph  with  the  Media  tab  (Node  Graph  Editor->Dashboard-
>Media). This is also especially convenient  for editors  used  to  classical non-linear editing
systems 

To work in this mode, it  is  recommended to  activate  the  Autosnap  function  (Node  Graph
Editor->Dashboard->Edit->Setup->Edit->Auto Snap) and the function to block vertical
 movement  of  the  Node  Graph  (Node  Graph  Editor->Dashboard->Edit->Setup->Edit-
>Constrain Y) to make it behave like a classic editing Node Graph.

Via  the  Media  tab  (Node  Graph  Editor->Dashboard->Media)  we  have  access  to
previously captured clips, by browsing the project  folders to select  any image or audio clip.
When  a  clip  is  selected,  it  is  viewed  in  the  Source  Monitor  (for  more  details,  read  the
chapter Source Monitor).

Within the Source Monitor, select  the Input/Output  of the clip. With the Input/Output  set,
it is possible to carry out  editing using the position of the Monitor by defining Input/Output
points in the Node Graph.

Subclips which are added in the Media tab using the command Creating Group (Node Graph
Editor->Dashboard->Media->Misc->Creating Group) can also be created.

Three point editing:

Once the two editing points for the selected clip are defined in the Source Monitor, select
with the active monitor the input  point  in the Node Graph, moving as required  the  Monitor
mark with  the  Shuttle  function  of  Quick  Access,  or  moving  the  background  of  the  Node
Graph, selecting and dragging with the right button of the mouse.

After defining the third editing point via the position of the Monitor, run the required editing
function via the editing button of the Source Monitor: Insert, Paste On Top or Overwrite.

The Paste On Top function is recommended for adding audio clips to the Node Graph, since
audio  clips  can be  read  by  the  monitor  without  obstructing  the  evaluation  of  the  image
clips. 
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Four point editing:

Also, two points in the Node Graph can be specified instead of only working with one point
specified by the Monitor. To do this, specify the positions of the editing marks,  by  placing
the active monitor in the desired frame, and by pressing the  corresponding   hotkey  (Input
mark <I> and Output mark <O>) while the cursor over the Node Graph. 

Note: the editing marks are only visible in the Node Graph in navigation level 0.

When an editing function from the Source Monitor, the clip will now be added to the  Node
Graph, but modifying the playback speed to adjust it to the duration specified by the editing
marks in the Node Graph by a Timewarp group. Remember that the Timewarp Group will not
affect audio reproduction. 

Active track:

If there are several versions of the edit in different tracks of the Node Graph, we can select
which of  these  is  the  active  editing  track.  To  do  this,  left  click  the  lock  button  of  the
desired track, while holding down <Shift> In this way, the editing of all the remaining tracks
that have clips will be locked. The lock button of the active track will change to red. From
this time, the editing functions of the Source Monitor will only be run in this track. 

To turn off the active track, <Shift> + left click the lock button of the active track.

Direct editing

The  method  of  direct  editing  on  the  Node  Graph  is  the  most  flexible  and  interactive,
although less precise for defining changes in the  editing  with  mathematical accuracy.  This
method is accessible at  any moment, as it  is based on the direct  selection of  the  clips  on
the Node Graph, by using the active frame of the clips.  This  method  works  very  well  with
the  Scribe  system,  which can activate  advanced  editing  functions,  thus  enabling  working
without the need to view another panel and maximizing the visible area of the Node Graph.

This method is available at  any time, by selecting the clips directly in the Node  Graph  and
working with its active frame. 

All the direct  editing functions can be run both in  a  single  clip  and  in  a  multiple  selection,
although  for  simplicity,  the  following  documentation  always  refers  to  the  selection  of  a
single clip. 

Clip position:

The definition of clip position in the Node Graph is the start  of the clip in a edit. To change
the position of any clip, or move it to another track, select the clip, left-click and drag it  to
the new position or desired track. When moving a clip, its duration is  maintained,  while  its
input and output relative to the edit in the Node Graph are modified.

The  selected  clip  will  appear  semitransparent  while  dragged,  thus  making  viewing  the
remaining clips contained in the Node Graph easier. 

If the user wants to suspend temporarily the evaluation in the monitors while dragging a clip
(for example  when  dealing  with  complex  evaluations),  press  <Shift>  before  starting  the
drag operation.

Trimming:

The absolute Input Point of the clip, which may have been specified before in, for example,
the Source Monitor, is the head of the clip in the Node Graph, whereas the end of the clip
is called the tail. To adjust  the head and tail of the clip, or both  at  the  same  time,  direct
editing trimming techniques are used.

First, indicate what is to be adjusted. If it  is the head, select  the clip and move the active
frame  of  the  clip  to  its  head,  by  right-clicking  and  dragging  the  active  frame  to  the  left
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edge of the clip. When the active frame is in the head, and with the right  mouse button still
held down, left-click at the same time, to drag the head and expand or reduce the selected
clip. This will affect the total duration of the clip. 

To adjust  the tail of the clip, use a similar procedure, but  place  the  active  monitor at  the
right edge with the right  mouse button, before left-clicking to begin to adjust  the tail. This
will also change the total duration of the clip in the Node Graph. 

These trimming functions can be applied to any type of clip. When adjusting image clips, it
is  usually  best  to  send  the  image  of  the  active  frame  of  the  selected  clip  to  the  active
monitor,  by  using  the  Select  Monitor  (Node  Graph  Editor->Dashboard->Edit->Setup-
>Node Graph Monitor->Select Monitor).

Trimming functions only affect  selected clips. When changing the duration of  a  clip,  a  gap
may  be  generated  between  the  edited  clip  and  the  previous/following  one,  or  one  may
overlap the other. To  avoid  this,  the  clip  can be  adjusted  in  Global  mode  (by  moving  the
position of later clips at the same time). This is achieved by holding <Ctrl> when trimming. 

Note: When extending or reducing the clip from its head in Global mode, the adjustment  will
always push all the clips on the left  of the edited clip to the left, since the duration of the
total edit  should be relative to the Node Graph timecode.  So,  when adjusting  the  head  of
the clip in this way, the timecode mark view, like the view of other marks and the grid from
the bottom of the Node Graph will be moved simultaneously, the same as the affected clips.

Effect clips and the Timewarp groups contain parameters, which can be animated with the
animation curves. When adjusting the duration of an effect  clip, its animation curves will be
adjusted to the new duration, and the keyframes that control the curves may be positioned
at  intervals  of  less  than one  frame.  So  that  the  duration  adjustment  does  not  alter  the
length of  the  animation curves,  the  clip  can be  modified  in  Keep  mode,  by  holding  down
<Alt> as well as the mouse keys.

Local Trimming:

In an edit, the most usual transition between two clips is the cut. In the Node Graph, a cut
is specified by the end of a clip and the start of the following clip. In this case, the tail of a
clip is pasted to the head of the following clip.

To adjust the point that joins the tail of a clip with the head of the following one: 

1. Select both adjacent clips. 

2. Place the active frame in the cut  position,  by  right-clicking  on any  clip  and
dragging the active frame to the clip join point. 

3. Once the active frame is  at  this  point,  the  respective  active  frames  of  the
two adjacent  clips will be shown, the tail  of  one  and  head  of  the  other,  as
visual  reference  to  help  the  trimming  (remember  that  to  view  the  active
frames on the clips it is necessary to have sufficient  zoom in the Node Graph
view). 

4. Next, while holding down the right mouse button, left-click as well, and when
the mouse  is  moved,  the  position  of  the  cut  is  moved  interactively,  adding
frames  to  the  tail  or  head  of  the  clips,  according  to  the  direction  of  the
mouse.
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Shifting:

If  the  duration of  the  clip  is  to  be  maintained,  but  the  In  and  Out  Points  need  to  move
simultaneously  (and  thus  incorporating  remaining  material  if  it  exists),  position  the  active
frame of the clip by right-clicking in any central frame of the clip, then left-click and move
the cursor. The active frame of the clip will then be seen moving when the mouse is moved
with  both  buttons  held  down,  always  showing  the  same  image  although  in  a  different
position, and maintaining the head and tail of the edited clip in their original positions. 

Note:  The  <SHIFT>  function  cannot  be  applied  to  effect  clips,  or  to  Template  or
Timewarp groups.

Duplicating clips:

To duplicate clips:

1. First, select the clips to be copied. 

2. Press <Alt> and then left-click on one of the selected clips.

3. Drag the cursor to the target copy position and release the mouse button at
that point. 

Advanced Editing

The Advanced Editing method permits precise adjustment  of the head  and  tail  of  any  clip,
with  selection  commands,  aligning,  locking,  etc,  and  advanced  Node  Graph  functions
specific to Mistika, such as grouping, inserting tracks between clips, activating proxies, and
many  other functions.  The  Advanced  Editing  commands  are  found  in  the  Edit  tab  (Node
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Graph Editor->Dashboard->Edit), below the Node Graph, and can be  combined  or used
with the panel timecode calculator. A large number of editing functions can thus be created
by combining different panel commands, using a fairly simple syntax.

The  majority  of  Advanced  Editing  commands  are  accessible  from Scribe  system symbols,
allowing us to work with the Node Graph in fullscreen.

Edit:

Ref. Mistika: Node Graph Editor->Dashboard->Edit->Edit

The Edit tab shows (in the Dashboard) tools for editing clips in the Node Graph.

It  also contains detailed  information about  clips  being  evaluated,  access  to  tools  external
and global configuration parameters.

The Edit  Panel, instead of  having  a  button for every  possible  operation,  has  buttons  that
represent different basic editing concepts, which when combined through an editing syntax,
specify more complex operations. 

The  buttons  of  the  Active  group  establish  the  element  of  the  Node  Graph,  defining  the
application as a specified function of advanced editing:

Clip Selection: the clip selected with the mouse.

Edit Mark In: the Edit In editing mark of the Node Graph.

Edit Mark Out: the Edit Out editing mark of the Node Graph.

Node Graph Monitor: the Monitor of the Node Graph.

Play Mark In: the Play In playback mark of the Node Graph.

Play Mark Out: the Play Out playback mark of the Node Graph.

These buttons  operate  with  the  calculator if  Use  is  selected,  allowing  a  relation between
value and application range to be defined for the executed function.

For example,  if  we  wish to  move  a  clip  selected  via  the  Set  Position  button we  have  six
options:

in Active select the button Edit Mark In and run the command Set Position: the
clip is moved to the mark Edit In, with the mark coinciding with its Head.

in Active select  the button Edit  Mark Out  and run the  command Set  Position:
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the clip is moved to the mark Edit Out, with the mark coinciding with its Tail.

in Active select the button Monitor and run the command Set  Position: the clip
is moved to the mark Edit Out, with the mark coinciding with its Head.

in  Active  select  the  button Play  Mark In  and  run the  command Set  Position:
the clip is moved to the mark Play In, with the mark coinciding with its Head.

in Active select  the button Play Mark Out  and run the command Set  Position:
the clip is moved to the mark Play Out, with the mark coinciding with its Tail.

Set  a  timecode  value  in  the  calculator  (Calc)  and  activate  Use:  the  clip  is
moved to this timecode in the  Node  Graph,  with  the  mark coinciding  with  its
Head.

Bear in mind that  the buttons in adjustment  modes for head and tail of clips (Local, Global,
Select) only affect trimming and extending of clips. Other editing functions are independent
to the adjustment mode activated.

Buttons that run advanced editing functions. 

All these functions are non-destructive, and can be undone with the command Undo. 

Group

This groups the selected clips in the Node Graph in a Normal group clip. 

Note:  if  the  selected  clips  have  the  same  duration,  and  there  is  a  Dummy  Clip
between them, the group will be created in the Template state. 

Ungroup

This undoes the selected group, dropping all the clip’s contents from the current  track
of the group to tracks below it. 

Note: The contents of the group may have a longer duration than that  specified  by
the group clip. This  is  possible  due  to  the  fact  that  the  groups  can be  edited  after
having been created. It is also important to note that  a .rnd file can be loaded in the
Node Graph as a Normal group clip, which when ungrouped can contain clips that  are
longer than the total of the flow with which it was created. 

Timewarp

This changes the group selected to  the  Timewarp  state.  For more  information,  read
the chapter Groups in Timewarp state.

Reverse

This reverses the playback direction of the selected clips. 

Note:  Audio  clips  are  not  affected  by  this  function.  Effect  clips  will  have  all  their
parameter curves reversed. 
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Join

This simplifies the view of the selected edits, joining clips that  can be displayed as a
single one, and  changing  the  effects  placed  in  different  tracks  to  continuous  tracks
(transition mode). 

This command is very useful for preparing an edit  to be exported to an EDL. It  is also
useful for simplifying Node Graph views, removing cuts that divide a clip unnecessarily.
 

Note: This command cannot  join two different  clips, or a two parts of the same clip,
that do not have correlative timecodes. We also do not  recommend this command for
simplifying transitions made with Template groups to transition mode. This function is
recommended for clips of the family Edit->Transitions.

AV Break

This breaks up the selected mixed clip, transforming it  into  separate  audio  and  video
clips. 

For more information on mixed clips, see the chapter Mixed Clips.

AV Combine

This combines an image clip with an audio clip, which should have the  same  duration
and be aligned vertically, in a mixed clip. 

For more information on mixed clips, see the chapter Mixed Clips.

Audio Break

This  breaks  the  audio  clip  into  distinct  independent  clips,  one  for  each  audio  track
that it has.

Audio Combine

This combines various independent  audio clips that  constitute separate tracks: these
should be the same duration and be aligned vertically.

Stereo Break

This  undoes  the  selected  stereoscopic  group,  transforming  it  into  two  image  clips,
each one corresponding to one of the source cameras.

Stereo Combine

This combines two image clips derived from a stereoscopic  group. These clips must  be
the same duration and be aligned vertically.

Lock

This  locks  the  modifications  that  the  editing  functions  can  perform in  the  selected
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clips.

Note: Locked clips are indicated with a small gray padlock in their center.

Unlock

This unlocks the selected clips. 

Hide

This hides the selected clips.

Reveal

This reverses the Hide attribute of the selected clips.

Note: Hidden clips are not evaluated either by the monitors or render processes. Bear
in mind that when hiding a clip, the flow of a process pile might  be stopped, making it
necessary to stretch the field to the clip above to maintain the flow.

A hidden clip may be edited like any  other clip,  since  its  invisibility  refers  only  to  its
evaluation, and not to editing functions.

Hidden  clips  are  viewed  in  the  same  color  as  the  background  of  the  Node  Graph,
although they are visible thanks to  the  way  that  the  clip  is  shown.  Hidden clips  are
also visible in the navigation panel.

The dropdown Mix contains transitions via fades and the Page Turn effect.

Inputs

Single  input:  Some  transitions  (Fade  Up,  Fade  Down  and  Non  Linear-M)  can  work
with one input, in which case the image combines with the background.

Double input: All transitions can combine two inputs.

Multiple input: The Multiple Mix transition can combine infinite layers.

Outputs

Single input (Fade Up, Fade Down and Non Linear-M) 
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Image: Combination of input with black (Black).

Alpha: Opaque mask. 

Double input 

Image: Combination of the two inputs according to the transition.

Alpha: Opaque mask. 

Multiple input

Image: Combination of the multiple inputs according to the transition.

Alpha: Opaque mask. 

Fade Up

Pre-defined configuration corresponding an Input fade-up.

If this transition is applied to just one clip, it enters from black.

Note: Since it is pre-defined, this transition has no parameters.

Fade Down

Pre-defined configuration corresponding an output fade-out.

If this transition is applied to just one clip, it goes to black.

Note: Since it is pre-defined, this transition has no parameters.

Creates a fade from a user-defined color to the original clip. 

Red, Green, Blue

Selects the color from which the fade enters.

Grade 

[100 (0 / 100)]

Controls the animation of the curve. By default, the first  frame is at  100, and the last
frame is at 0. 

Permite generar una transición desde un clip a un color. Creates a fade from the original clip
to a user-defined color. 

Red, Green, Blue

Selects the color to which the fade enters.
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Grade 

[0 (0 / 100)]

Controls the animation of the curve. By default, the first  frame  is  at  0,  and  the  last
frame is at 100. 

The Non Linear-M transition is the result  of the superimposition of two inputs. The  opacity
of the first input decreases simultaneously as the opacity of the second input increases.

If this transition is applied only one clip, the superimposition combines with black (Black).

Blend

[50 (0 / 100)]

Sets a percentage value of the final state of the transition.

The Multiple Mix transition allows the combining of multiple inputs in order to assign to each
one of them an opacity value. To control the layers independently, add the same number of
folders  as  inputs  via  the  command  Add  Folder  (Node  Graph  Editor->Dashboard-
>Parameters->Layer->Add Layer).

Index

[100 (0 / 10.000)]

Sets the value of opacity of the image during the transition.

The Alpha Mix transition uses the luminance mask of the images in order to assign different
values of opacity to different areas of the frame.

Blend

[50 (0 / 100)]

Sets a percentage value of the final state of the transition.

Clip

[400 (0 / 100.000)]

Sets the value of opacity of the mask generated.

ByLuma

[Yes (No / Yes)]

Option to activate the use of the luminance mask.

Creates a page-turning effect, switching from the output image to the input image.

Ang

[90 (-900.000 / 900.000)]

Sets the angle of the page.
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Line

[ 0 (-10.000 / 10.000)]

Sets the position of the edge of the page.

Rad

[15 (0 / 10.000)]

Sets the curve (Radio) of the page.

Hilgt

[50 (0 / 10.000)]

Sets the intensity of reflection of light of the page.

Shadow

[0 (0 / 100)]

Sets the opacity of the shadow of the page.

Shift

[ 0 (-10.000 / 10.000)]

Sets the horizontal position of the image within the area of the page.

The Wipes dropdown button contains SMPTE wipes.

Starting with these basic wipes it is possible to obtain an infinite variety. 

Both types of effect can generate wipes with smooth edges.
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Inputs 

Can be used without input, with one input  to assign it  a mask as a wipe, or with two
inputs (with optional alpha channel) to be used as a transition between them. 

Inputs 

Without inputs: 

Image: Will contain the shape of the wipe as a black and white image.

Alpha: Opaque mask

Single input:

Image: No changes.

Alpha: Mask with the shape of the wipe. 

Double input: 

Image: Combination of the two inputs depending on the wipe. 

Alpha: Combination of the alpha channels of the two inputs depending on the wipe. 

The parameters that  control the wipes  of  the  Wipes  button are  the  same  for all  of  them,
except Wipe Circle. The two possible types of parameter set are described below.

Wipes  of  the  band  type  are  the  same  for  all  the  wipes  of  the  Wipes  button  (with  the
exception of the circle wipe), and are formed by means of different preset values.

Each Layer  added to the effect  in the Parameters tab represents a set  of  stripes  with  its
own set of parameters. If several layers are used, the image area will only be white in areas
where all the sets of stripes are superimposed. 

Dropdown folder containing the parameters of the default wipe. 

Layers created later will be added after it,  as  an identical folder although identified  by  its
number,  which  increases  as  they  are  created.  The  creation,  duplication  and  deletion  of
layers  is  controlled  from the  commands  tab  located  in  the  Folder  tab  of   Parameters,
accessible from the Node Graph Editor and the Visual Editor.

Angle

[270 (-900.000 / 900.000)]

Sets the angle in degrees of the set of stripes. 

Soft

[0 (0 / 100.000)]

Softens the edges of the stripes. The higher the value, the softer the edges. A value
of 0 represents a hard cut. 

Strip

[200 (0 / 100.000)]
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Thickness of the stripes of the effect as a percentage of the image size.

Phase

[25 (-100.000 / 100.000)]

Phase of the stripes. It  is used to specify  the  starting  position  of  the  stripes  before
any move, or to animate its position.

Grade

[0:100 (0 / 100.000)]

Controls the animation of the stripe patterns, normally used to specify progress of the
wipe effect. 

When animating  Grade  from 0  to  100  (or  vie  versa)  the  white  area  of  the  stripes
increases or decreases. With a Grade value of 0 the  stripes  will  no  longer be  visible,
whereas at 100 there will be no black space between them. 

The parameters that manage the Wipe Circle wipe are different from the other Wipes. In this
wipe, all the white surfaces of each circle specified in each layer are added together. 

Dropdown folder containing the parameters of the wipe created by default. 

Layers created later will be added after this one as identical folders, although identified by
its number, which increases as they are created. The creation, duplication and  deletion of
layers  is  controlled  from the  commands  tab  located  in  the  Folder  tab  of   Parameters,
accessible from the Node Graph Editor and the Visual Editor.

Rad

[0:63 (0 / 300)]

Sets the radius of the circle as a percentage of the horizontal size of the frame.

Soft

[0 (0 / 300)]

Sets  the  size  of  the  softening  of  the  edge  of  the  circle  as  a  percentage  of  the
horizontal size of the frame.

This softening consists of a  circular gradient  that  grows  from the  perimeter towards
the center.

CentX; CentY

[50; 50 (-400 / 500)]

Sets the position of the center of the circle as a percentage of the image.

Wipes are normally used for transitions between split  screen shots and effects, or simply to
generate image patterns for other uses. 

The default  values produce stripe transitions  of  symmetrical growth,  but  by  animating  the
Phase parameter from 0 to 50 at  the same time as the Grade  parameter from 0 to  100,  it
produces a sideward growth.
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Grade can also be set as a constant, only using Phase to animate the position of the stripes
without changing their thickness. 

These wipes, with a single input, can be used for any effect  with an InAlpha parameter to
change a  specific  part  of  the  image,  for example  to  change  color in  just  one  part  of  the
image

The parameters of these effects are illustrated in the following images.

Subtitle

Mistika supports the standard subtitling files .srt, .sub, .txt and .xml, and applies them
directly in the Node Graph as Title effects.

To import  a  subtitle  file  to  a  video  clip,  select  the  clip  and  click Subtitle.  An import
window  appears  where  the  desired  file  can be  chosen.  It  is  created  on  top  of  the
video  clip,  and  a  series  of  Titleeffects  can  be  selected  with  the  duration  of  each
subtitle segment defined. 

If  the  subtitle  file  supports  the  settings  for  the  letter  size,  color  and  font,  these
parameters  are  automatically  configured  in  the  Title  effect  created.  If  they  are  not
defined by the file, the default values of Title will be used.

Information  about  the  functioning  of  the  Title  effect  in  Mistika  is  explained  in  the
chapter Title.

Razor

Divides the selected clips in two at the active mark. If no mark is active, the clips are
divided at its active frame. 

Note: The active mark is specified in the marks panel. The active marks that  interact
with  this  function can be  the  active  frame  of  the  clip,  the  monitor  mark,  the  play
marks and the editing marks. To interact with the global marks or clip marks, move the
active monitor to that mark (with the commands Next/Prev in Quick Access) and then
divide the clip by using the monitor mark. 

Clone

Makes identical copies of the selected clips in the Node Graph, and leaves the copies
selected so they can be moved immediately to another position on the Node Graph. 

The number of copies to be generated can be indicated in  the  calculator,  where  the
Use button should be on. If this button is off, only one copy will be made. 

Remember the direct  duplicating method  by  pressing  <Alt>  and  then clicking  on the
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clip to be copied, and dragging the copy to a new position. 

Note:  The  position  of  the  duplicate  is  exactly  the  same  as  the  original,  and  we
recommend moving the new copy immediately to another position in the Node  Graph,
to avoid their superimposition. 

The calculator of the Edit  tab allows numerical values to be read and  applied  to  advanced
editing functions, interacting with the buttons of the Active group.

Base

Field  that  specifies  the  time  format  used  by  the  calculator.  The  button  to  its  right
opens a dropdown list with all the existing time formats. 

Mistika makes its internal calculations in floating point  numbers, allowing the results of
the calculation to be viewed in different time formats, which can be switched between
existing ones at any moment during the calculation. 

The default formats are:

Float

Permits floating point values. 

Note:  This  value  is  shown  in  cyan  to  distinguish  from  the  other  values,  since  in
multiplication and division operations, this type of value is automatically used. 

Frames

Only permits integer numbers.

TimeCode

Provides  values  in  Timecode  format  (HH:MM:SS:FF).  The  base  of  the  Timecode
depends  on  the  number  of  frames  per  second  (frame  rate)  as  specified  in  Mistika
Setup,  so  the  same  measure  will  give  different  values  for  the  timecode  in  different
Mistika sessions, if this value is changed.
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Value

Editable numerical field where the current value of the calculator is shown. 

Use

Button that activates the use of the calculator in the editing syntax. 

Functions

Mathematical functions of the calculator. The buttons are a little lighter in color than
the other calculator buttons. The possible functions are:

/ : Divide. 

* : Multiply. 

Note:  These  two  functions  permit  a  floating  point  value  to  be  entered
temporarily, whatever time format is being used.

- : Subtract.

+ : Add.

Note:  These  two  functions  do  not  permit  floating  point  values  in  operations
expressed  in  time  code  format  or  by  the  number  of  frames,  since  they  only
permit adding of times to each other. 

.  : Adds a point to floating point  number. If the time format  of the calculator is
frames, this button will not  work.  If  the  time  format  is  frames  per second,  the
button will add a semi-colon (:) specifying a timecode figure. 

+/- : Inverts the sign of the current number. 

AC : Deletes the contents of the calculator field.

= : Shows the result of the calculation being made. 

Keypad

Buttons that function as the calculator numerical keys. 

Get Position

Inserts  into  the  calculator  the  horizontal  position  of  the  selected  clip  as  timecode
value (corresponding to the input point of the clip).

If instead selecting of a clip an active mark is activated (commands group Active) this
will be the position value copied into the calculator.

Note: For this command to make use of the  value  in  the  calculator,  the  Use  button
must be active.

Set Position

Moves or pushes the clips selected in the time of the Node Graph to the value defined
in the calculator.
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If instead of selecting a clip an active mark is activated (commands group Active) this
will be the position value copied into the calculator.

Note: For this command to make use of the  value  in  the  calculator,  the  Use  button
must  be active. If the clip is to be linked to the active mark in order to move it,  the
Use button must be deactivated.

Get Duration

Pastes the value of the total duration of the selected clips into the calculator. 

Set Duration

Modifies the duration of the selected clips to the value indicated in the calculator. 

Move Left

This  pushes  the  selected  clip  to  its  left,  by  the  number  of  frames  indicated  in  the
calculator. If the calculator is not in use, the clip will only be pushed a single frame to
the left. 

Move Right

This pushes  the  selected  clip  to  its  right,  by  the  number of  frames  indicated  in  the
calculator. If the calculator is not in use, the clip will only be pushed a single frame to
the right.

Shift Left

Moves the input  and output  points  of  the  clip  simultaneously  in  a  negative  direction
(towards the start  of  the   Node  Graph)  by  the  amount  expressed  in  the  calculator,
maintaining the  head an tail of the clip in the same position of the Node Graph.

If the calculator is not activated or has a zero value, the selected clips will be shifted
by one frame. 

Note: this function is not affected by the selected mode of adjustment, nor can it  be
applied to effect clips, Template groups nor Timewarp groups. 

Shift Right

Moves  the  input  and  output  points  of  the  clip  simultaneously  in  a  positive  direction
(towards  the  end  of  the  Node  Graph)  by  the  amount  expressed  in  the  calculator,
maintaining the  head an tail of the clip in the same position of the Node Graph.

If the calculator is not activated or has a zero value, the selected clips will be shifted
by one frame. 

Note: this function is not affected by the selected mode of adjustment, nor can it  be
applied to effect clips, Template groups nor Timewarp groups. 
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The  adjustment  functions  that  change  the  duration  of  selected  clips  can  work  in  three
modes as described below.

Global

Activates the global adjustment mode. 

In  this  mode,  when  the  tail  or  head  of  a  clip  is  adjusted,  it  will  affect  the  total
duration of the edit  in the Node Graph. For example, if  the clip is extended, either by
its tail or by its head, the total time of the edit will be extended, due to the fact  that
in  this  mode  the  remaining  clips  existing  in  the  trimming  direction (and  that  are  not
locked) will be moved as well by the same amount of time as the clip trim or extension
made by the adjustment. 

Note:  The  clips  will  change  position  according  to  where  they  are  in  relation  to  the
edge of the clip that  is being adjusted.  For example,  all  the  clips  in  the  Node  Graph
whose head is to the right of the extended clip head will also be moved to the right. 

Local

Activates the local adjustment mode. 

In this mode the editing cuts are adjusted. 

When adjusting the tail  or head  of  a  selected  clip,  only  the  heads  and  tails  of  clips
that  coincide with the head and  tail  timecodes  of  the  selected  clip  will  be  affected,
and the heads or tails of the adjacent  clips, without  altering the total duration of the
edit in the Node Graph. 

For example, if  the selected clip is extended by its tail, the tail of clips that  coincide
vertically with this tail will also be extended, whereas all the heads of clips that  are in
the frame following the tail of the selected clip will be contracted, thus compensating
the  duration of  the  selected  clip  by  making  a  contrary  adjustment  to  the  adjacent
clips. 

Note: This mode of adjustment  is the best  for adjusting cuts,  and  also  for adjusting
transitions  in  zigzag  mode,  by  selecting  in  this  case  the  effect  that  makes  the
transition. When the head or tail of the transition effect  clip is modified, the  head  or
tail  of  the  corresponding  input  clip  will  be  adjusted  at  the  same  time,  automatically
compensating  the  necessary  clip  duration  so  that  the  flow  of  the  transition  works
correctly. 

Selected

Activates the selection adjustment mode. 

In  this  mode,  only  the  selected  clips  are  adjusted,  without  affecting  the  remaining
clips, or the total duration of the edit. 

These are adjustments that change the animation of the keyframes contained in the clips in
the Node Graph when their duration is changed.

Stretch

Maintains the absolute animation of the  keyframes,  and  as  such the  original position
within the new final duration of the clip.
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Extend

The animation of the keyframes changes proportionally to the new duration of the clip.

Ext Head

Extends the heads of selected clips by the amount of time expressed in the calculator.
If the calculator is not  activated or has a zero value, the head  of  the  selected  clips
will be extended by one frame. 

This  function can interact  with  the  active  mark,  by  adjusting  the  clip  head  to  the
frame where the mark is. 

Note: the active mark is specified in the marks panel. The active marks that  interact
with this function can be the monitor mark, the play marks and the editing marks. To
interact  with  the  global marks  or clip  marks,  move  the  active  monitor  to  that  mark
(with the commands Next/Prev in Quick Access) and then adjust  the clip by using the
monitor mark. 

If a pair of marks are activated (the two editing or play marks) when this function is
run, both the head and tail will be adjusted to both active marks at the same time. 

Trim Head

Trims  the  selected  clips  by  their  heads  by  the  amount  of  time  expressed  in  the
calculator.  If  the  calculator is  not  activated  or  has  a  zero  value,  the  head  of  the
selected clips will be trimmed by one frame. 

This  function can interact  with  the  active  mark,  by  adjusting  the  clip  head  to  the
frame where the mark is. 

Note: the active mark is specified in the marks panel. The active marks that  interact
with this function can be the monitor mark, the play marks and the editing marks. To
interact  with  the  global marks  or clip  marks,  move  the  active  monitor  to  that  mark
(with the commands Next/Prev in Quick Access) and then adjust  the clip by using the
monitor mark. 

If a pair of marks are activated (the two editing or play marks) when this function is
run, both the head and tail will be adjusted to both active marks at the same time. 

Trim Tail

Trims  the  selected  clips  by  their  tails  by  the  amount  of  time  expressed  in  the
calculator. If the calculator is not activated or has a zero value, the selected clips will
be reduced by one frame. 

This function can interact with the active mark, by adjusting the clip tail to the frame
where the mark is. 

Note: the active mark is specified in the marks panel. The active marks that  interact
with this function can be the monitor mark, the play marks and the editing marks. To
interact  with  the  global marks  or clip  marks,  move  the  active  monitor  to  that  mark
(with the commands Next/Prev in Quick Access)  and then adjust the clip by using the
monitor mark. 

If a pair of marks are activated (the two editing or play marks) when this function is
run, the head and tail will be adjusted to both active marks at the same time. 
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Ext Tail

Extends  the  selected  clips  by  their  tails  by  the  amount  of  time  expressed  in  the
calculator.  If  the  calculator  is  not  activated  or  has  zero  value,  the  head  of  the
selected clips will be extended by one frame. 

This function can interact with the active mark, by adjusting the clip tail to the frame
where the mark is. 

Note: the active mark is specified in the marks panel. The active marks that  interact
with this function can be the monitor mark, the play marks and the editing marks. To
interact  with  the  global marks  or clip  marks,  move  the  active  monitor  to  that  mark
(with the commands Next/Prev in Quick Access)  and then adjust the clip by using the
monitor mark. 

If a pair of marks are activated (the two editing or play marks) when this function is
run, the head and tail will be adjusted to both active marks at the same time. 

This numerical field defines the position of the timecode mark of the Node Graph (TC Mark).
When this value is modified, the Global Ruler is updated.

If  the  mark is  moved  via  direct  selection with  the  mouse  from the  Node  Graph,  the  new
value of the timecode track will be seen in this box.

All

Selects all the clips in the Node Graph.

Up

This selects all the clips that  are in the tracks above where the Node Graph cursor is
positioned. 

Down

This selects all the clips that  are in the track below where the  Node  Graph  cursor is
positioned. 

Left

This selects all the clips  with  a  head  to  the  left  of  where  the  Node  Graph  cursor is
positioned. 

Right

This selects all the clips with a head to the right  of where  the  Node  Graph  cursor is
positioned. 

Unselect

Unselect all the clips of the Node Graph.
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Invert

Inverts the current selection of clips. 

Track

This selects all the clips that are in the same track in which the Node Graph cursor is
positioned. 

Tools  for creating  and  deleting  notes  and  drawings  on the  Node  Graph.  These  notes  are
useful for annotating the Node Graph, leaving notes for other users, and generally assisting
organization.

Notes  are  indicated  with  a  yellow  icon like  a  “Post-it”,  and  can be  associated  with  text,
Graffiti (a drawing) or both.

Occasionally, notes can cause excessive visual information. To  avoid  this,  it  is  possible  to
hide them by deactivating Setup->Node Graph View->Show Graffiti).  In  this  mode,  the
gray icon remains visible, while the associated text and Graffiti is only shown when a note is
selected.

The notes can be moved in the Node Graph dragging them by their yellow icon.

When  horizontal/vertical  zoom of  the  Node  Graph  is  changed,  the  Graffiti  drawings  are
similarly scaled, since they form part  of  the  Node  Graph.  Therefore,  it  is  important  to  the
notes at the in the level of zoom that will be most useful.

The notes are a kind of mark, and so it  is  possible  to  jump from one  to  another similar to
other marks (via <Shift>+<Left> and  <Shift>+<Rigth>).

Create

Creates  a  new  note  on  the  Node  Graph.  The  background  is  darkened  until  it  is
completed, and the cursor can be used to write and draw on the  Node  Graph.  Press
Esc when finished.

Delete Stroke

 Deletes the last stroke drawn in a note.

Delete Note

Deletes the selected note, including both text  and  its  associated  Graffiti.  Select  the
note by clicking on the yellow icon.

Delete All Notes

Deletes all the notes in the Node Graph.

Via the commands of the dropdown button Group Layers it  is  possible  to  specify  which of
the layers included in a groups will be  evaluated  in  the  monitor.  This  layer is  then termed
the active layer.

When one of the layers is specified, the color of the group clip changes from green to blue.
The  tone  of  the  color blue  will  vary  according  to  the  layer  selected.  Also,  each  time  an
active layer is defined, the group clip adopts it name and timecode.
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Despite including in infinite number of layers, access to the layers that  contain this type of
group via the Group Layers commands is limited. Evaluation can only be assigned to the top
four layers that are not darkened.

Use Layer 1-4

Specifies which of the first four layers is active.

Use Prev Layer

Specifies the layer immediately before the current one as active.

Use Next Layer

Specifies the layer immediately after the current one as active.

Note. Both the commands Use Prev Layer and Use Next Layer are cyclic. This means that  if
Layer 4 is active, and Use Next Layer is pressed, the new active layer will be Layer 1.

Thanks to these commands, it  is possible to convert  a normal group  clip  to  multi-layer  or
multi-camera. These types of group are especially useful for:

- Multicamera editing

- For viewing quality control, maintaining reference versions within the group

- Maintaining multiple versions

-  Using proxies. For Raw formats  that  cannot  run in  real time,  it  is  recommended to  do  a
render in order to generate Mistika formats, and include them in a group, together with the
original clip. This way, we can shuttle at  any  time  between the  real time  version and  the
original camera file.

Add Mark

Adds a User Mark. This mark can be local or global.

Delete Mark

Eliminates the active User Mark.

Delete All Marks

Eliminates all the User Mark global.

Note: For more information about the use of these marks, consult the chapter User Marks.

In  global mode,  the  editing  functions  affect  all  the  clips  or those  parts  within  the  Range
specified  by  the  editing  marks,  regardless  of  whether  they  are  selected  or  their  vertical
position in the Node Graph tracks. 

Note: If the editing marks are not in the Node Graph, each function will use the time range
specified by the selected clips. 

The traditional editing functions in global mode are the following: 
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Global Cut

Moves  to  the  clipboard  all  the  clips  or  those  parts  of  clips  that  are  in  the  range
specified by the editing marks. The editing marks will also be removed from the  Node
Graph. 

Note: If the editing marks are not  in the Node Graph,  the  function will  use  the  time
Range specified by the selected clips. 

Global Copy

Copies  to  the  clipboard  all  the  clips  or  those  parts  of  clips  that  are  in  the  range
specified by the editing marks. The editing marks will also be removed from the  Node
Graph. 

Note: If the editing marks are not  in the Node Graph,  the  function will  use  the  time
Range specified by the selected clips.

Global Paste

Replaces the clips or those parts of clips that are in the Range specified by the editing
marks  with  the  contents  of  the  clipboard,  pasting  its  contents  but  respecting  the
duration specified by the editing marks. 

Note: When the clipboard contents are inserted depending on the range specified by
the editing marks, the duration of the Range can differ from the total duration of the
set of clips contained in the clipboard. In this case, the set  of clips will be pasted to
the  Node  Graph  as  a  Timewarp  group  that  will  contain  them,  thus  changing  its
playback speed in a linear fashion. 

After running this Global function, the In mark will be placed in the timecode where the
 Out mark was, and the Out mark will be removed from the Node Graph. 

If the editing marks are not specified in the Node Graph, the clipboard contents will be
inserted  at  the  mark  of  the  active  monitor,  maintaining  the  original  duration  and
playback speed of the set of clips in the clipboard. 

Paste Top

Pastes the clipboard contents to the Node Graph, respecting the duration specified by
the editing marks, to the first free track from the top. 

Note: When the clipboard contents are inserted depending on the range specified by
the editing marks, the duration of the range can differ from the total duration of  the
set of clips contained in the clipboard. In this case, the set  of clips will be pasted to
the Node Graph as a Timewarp group that  will contain the set  of clips, thus changing
playback speed in a linear fashion. 

After running this Global function, the In mark will be placed in the timecode where the
 Out mark was, and the Out mark will be removed from the Node Graph. 

If the editing marks are not specified in the Node Graph, the clipboard contents will be
inserted  at  the  mark  of  the  active  monitor,  maintaining  the  original  duration  and
playback speed of the set of clips in the clipboard. 
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Global Insert

Inserts  the  clipboard  contents  in  the  Node  Graph,  in  the  position  and  duration
specified by the editing marks, and adds the necessary time in the Node Graph. 

Note: When the clipboard contents are inserted depending on the Range specified by
the editing marks, the duration of the Range can differ from the total duration of the
set of clips contained in the clipboard. In this case, the set  of clips will be pasted to
the Node Graph as a Timewarp group that  will contain them, thus changing playback
speed in a linear fashion. 

After running this Global function, the In mark will be placed in the timecode where the
 Out mark was, and the Out mark will be removed from the Node Graph. 

Note: If the editing marks are not specified in the Node Graph, the clipboard contents
will be inserted at the mark of the active monitor, maintaining the original duration and
playback speed of the set of clips in the clipboard. 

Global Razor

Cuts in two all the clips at the active monitor mark, whether or not  they are selected.
The clips that do not coincide with the active monitor will not be cut. 

Match and paste:

Mistika provides quick and automatic adaptations of the footage corrections and editions. It
is applicable to the shorter or longer versions of the assembly and also to a single clip. 

Values  of  the  effects  and  animation  parameters  and  also  keyframes  can  be  copied  and
adapted to the new assembly. To realize this operation, it is necessary to select all the files
of the edited  material  including  the  effects  first  and  then copy  them using  the  hotkey  or
through the interface button. Then you have to  select  the  files  where  you want  to  apply
these corrections and paste them with the hotkey ALT+V or by Match and Paste button on
the interface.  

The effects to copy can be applied in different ways: 
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MATCH CLIP OPTIONS

Select the reference that Mistika will use to link the effects with the new clips:

-  Match Media Source Path: the path of  the  media  location will  be  the  reference  to
link the media.

- Match Timecode Range: it will consider the time code of the media

- Match Reelname: it will consider the name of the media.

-  Reelname  Max:the  selection of  the  characters  number  will  be  possible,  which  will
have to be taken into the account when linking the media. 

PASTE OPTIONS

If the media, to which the  effects  will  be  copied,  already  contains  any  modification,
Match and Paste will be possible with the following functions:

-  Replace  them  with  pasted  effects:  this  will  delete  the  existing  effects  and  it  will
replace them with new ones.

-  Append pasted effects on top: this will generate  a  new  effect  node  on top  of  the
existing ones, adding their effect on the existing ones.

-  Do not  replace: when the existing effects are equal to  the  ones  to  be  added,  the
existing ones will be kept; only the ones that do not have an equal will be added.

ANIMATION OPTIONS

- Ignore animated keyframes: it will prevent the copying of the keyframes.

- Keep original keyframes: it will keep the original animation, independently of the new
assembly and duration.

-  Scale animation to fit  target  slot:  It  will rescale the original animation to  the  new
version’s duration and assembly.

NOTE:  Be  careful when using  “Keep  Original Keyframes”  case;  when the  clip  where
the Match and Paste will be performed is trimmed, the animation of the keyframes will
also be copied the original although it is not a single clip. If the new clip is shorter, the
keyframes that were trimmed within that range will also be trimmed.

Remove Time

Removes all the clips or those parts within the  range  specified  by  the  editing  marks,
and  also  the  time  within  the  range,  thus  bringing  the  editing  marks  of  a  frame
together, which are also eliminated. 

Note: the clips or the parts affected are removed from the Node Graph and placed in
the clipboard, enabling other editing functions related with the clipboard to be used. If
the  editing  marks  are  not  in  the  Node  Graph,  each function will  use  the  time  range
specified by the selected clips. 
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Insert Time

Pushes all the clips or those parts that are in the Range specified by the editing marks
to  the  Out  Point,  thus  inserting  “empty”  time  in  the  Range  specified  by  the  editing
marks. 

If the editing marks  are  not  specified  in  the  Node  Graph,  the  Range  will  be  inserted
defined by the clips in the clipboard  will be inserted at the active monitor mark. 

Unstrip

Strips the selected clips into clip fractions with duration of one frame each. 

Linearize

Orders all the clips used in an environment  by the original timecode of each clip (from
the  original EDL).  No  information is  lost  because  the  effects  clips  are  sorted  at  the
beginning of the reel. 

The  main  use  is  to  be  able  to  conform an EDL,  apply  the  necessary  postproduction
processes in Mistika, and transfer a tape containing all the resulting clips, but  so that
they  can  be  reconformed  in  another  system using  the  original  EDL.  To  learn  more
about  the  conforming  process  using  this  tool  in  Mistika,  see  annex  Transfer  with
Original Timecode (Crash Record).

Split Conform

Recreates every cut in the Node Graph in all other tracks 

One important function of this tool is to cut a clip with information from an EDL. 

To do this, it  is necessary to load the video clip without  cuts  and  the  corresponding
EDL  into  the  Node  Graph.  We  import  the  EDL  generating  an  environment,  and  we
include the clip cutting another track. Once aligned, the button Split  Conform inserts
the EDL cuts in the video clip.

In the case of having a clip with multiple scenes and no EDL, use the scene detector
(Visual Editor->Dashboard->Detect Scenes) instead of this tool. 

Group Segments

Creates a group clip for each pile of clips of the same length and position selected in
the Node Graph. A typical use is, when finishing  a  render by  segments  to  group  the
original segments together with their renders in new ,multilayer groups.

Note: If any of the selected clips is a Clip Dummy the state of the group created will
 be Template.

Trim & Ungroup

When ungrouping via this macro, the cuts in  a  render group  are  specified  respecting
the  segment  originally  referenced  by  the  EDL.  This  is  unlike  the  command  Ungroup
(Node Graph Editor->Dashboard->Edit->Edit->Ungroup) which simply makes the
whole render script  available in the Node Graph without  cropping heads  or tails.  It  is
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usually used after a conforming operation.

Load RawParams

Revises  the  metadata  of  the  r3d  and  mxf  files  (Sony  Raw),  and  .rmd  file  that  may  be
associated,  re-loading  their  values  in  the  R3DParams  and  SonyRaw  Params  effects  for
selected  clips  (with  effect  of  the  type  Node  Graph Editor->Dashboard->Fx->Mistika-
>Decode->R3DParams/SonyRaw Params).

Go to Next Blip

Checks the TimeSpace for "Blips", which are misalignments of between 1 and 3 frames
within the same effects, which Mistika will consider as an editing  error.  The  operator
can this rapidly check the project in order to manually solve this kind of problem.

Go to Next Overlap

Checks the TimeSpace for clips and effects that  are  superimposed  which Mistika  will
consider as an editing error. The operator can this rapidly check the  project  in  order
to manually solve this kind of problem.

The cache function for clips in the Node Graph is  a  tool  that  allows  clips  to  be  rendered
temporarily (intended to allow realtime playback without  halting the work in  progress),  and
is normally carried out  in Background  (low  priority)  for the  workstation,  using,  if  available,
Batch Manager or Totem. 

It is important  to remember when using the cache function that  it  is a temporary function,
ie, its use is focused on providing continuity for the work in  progress  without  the  need  to
stop to render or export  certain clips which cannot  be played back in realtime (for example
when modifying  effects or when there are many processes in a clip in a color correction).
Furthermore,  this  helps  when  structuring  the  project,  as  it  is  not  necessary  to  create
folders, names or directories; the  cache  is  organized  almost  automatically,  and  overwrites
whenever possible, thus optimizing memory.

The cache will be identified as a letter "C" in a colored circle  (indicating  the  status  of  the
cache of the given clip). When the symbol appears over a clip, it  indicates that  the cache
function is active. Then, depending on the color of the circle, it  indicates that  the cache is
not created (red), that it is in process (yellow) or that it has been done (green).

To optimize memory, the position and parameters of the clip are taken into account, and so
there  exists  the  possibility  of  automatically  activating  the  creation  of  new  caches  when
changes  are  made  to  a  clip.  Furthermore,  when  doing  the  internal  organization  of  these
caches,  they  will  be  seen  as  relative  to  their  position,  overwriting  previous  caches  that
coincide with the position or clip in which they are to be newly created.

The resolution of the cache files will coincide with the output to video selected.
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Selected Cache On

Activates the cache function for selected clips. When active, the letter "C" appears in
a red circle indicating that this status (the circle becomes green when the cache has
been made).

Selected Cache Off

Deactivates  cache  function for selected  clips.  The  clip  loses  its  cached  status,  but
will remain until it is overwritten.

Selected Invalidate

Marks as invalid the  caches  of  the  selected  clips.  Thus,  all  clips  that  have  a  cache
marked as made will return to the pending state.

Selected Extract

Extracts the caches from the selected clips as media clips. When selected, a warning
that the clips will be overwritten if the cache is overwritten appears.

Render Pending

Starts the render of the clips with the cache function activated. The clips show their
pending status with a yellow circle until the render is done, when the circle becomes
green.

Reload Cache

Reloads the cache of selected clips, in the case that, after any change or overwrite,
it has not refreshed correctly.

Attributes:

Ref. Mistika: Node Graph Editor->Dashboard->Edit->Attributes

The Attributes tab shows all the available information on the selected clip in the Node Graph
. It also permits modifying some of the selected clip's values. 
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Name

The name of the clip. This name can be modified if  this  field  is  edited  and  confirmed
with <Enter>. 

Editing  this  field  does  not  make  any  change  to  the  stored  clip  name,  thus  avoiding
inconsistencies  with  references  to  the  same  existing  clip  in  other  edits.  Only  the
selected  clip  changes  its  name  in  theNode  Graph,  without  affecting  other copies  of
the  same  clip  even in  the  same  Node  Graph.  This  can be  useful  to  identify  certain
clips, especially group clips. 

The definition of the Fields attribute is indicated at the moment of capture or render.

Interlaced

Indicates whether the clip has the interlaced attribute. 

Progressive

Indicates whether the clip has the progressive.

Note:  The  state  of  fields  of  the  clips  must  be  defined  by  the  user.  This  allows  the
incongruence that  a clip, although it  has fields, does not  have the interlaced attribute, for
example.

This  group  shows  the  timecode  values  of  the  input  and  output  of  the  clip  defined  in  the
edit.

In

Position of the Node Graph where the head of the clip is situated. This value  can be
edited, moving the clip by its head without modifying its duration. 

Out

Position  of  the  Node  Graph  where  the  tail  of  the  clip  is  located.  This  value  can  be
edited, moving the clip by its tail without modifying its duration. 

Duration

Duration  of  the  clip  in  the  Node  Graph.  This  value  can  be  edited,  modifying  the
duration of the clip by its tail.

Head; Tail

Shows the number of remaining frames not  being used by the clip in the Node Graph.
The  higher  the  value,  the  shorter  the  clip  duration.  Negative  values  are  possible,
shown in red, indicating repetition of the head or tail frame of the clip. 

Clips can be edited from this numerical field, by modifying their head of tail.

Note: Timewarp group and effect clips do not  have a fixed duration, so in these cases the
field cannot be edited.
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Folder that  contains  read-only  fields  with  information regarding  the  media  of  the  selected
clip. Only image and audio clips can show information in the fields of this folder.

In; Out

If the material was captured with timecode information, this shows the start  and end
of capture timecodes relative to the original tape.

This field is  useful for working  with  lists  of  timecodes  written in  a  previous  preview,
permitting the user to confirm that  the used clip coincides with the timecodes one in
the list. 

Note:  Clips  captured  in  Start  Free  mode,  or  generated  by  a  render,  will  have  a
timecode that  is restarted from zero.  Group  clips,  link clips  and  effects  do  not  have
original timecodes either. 

Duration

Shows the total duration of the clip media.

Tape Name

Number of audio tracks in the clip.

Audio Channels

Number of audio tracks in the clip.

Image File

Shows the name of the image media to which the clip refers.

Proxy File

Shows the name of the media to which the clip refers for the proxy image resolution. 

Format

Shows information about format of the image.

Audio File

Shows the name of the sound media to which the clip refers.

Editable numbered information field that  shows the original comments of the clip that  have
been added.

In addition to the user comments, comments generated automatically by Mistika can exist.
Such is  the  case  of  clips  coming  from conforming  an  EDL  against  a  numbered  sequence.
Mistika uses this field to store the original information of the EDL line corresponding  to  the
clip.

Editing this field has no effect  on the  stored  clip  comments,  avoiding  inconsistencies  with
the  references  to  the  same  existing  clip  in  other  environments.  Only  the  selected  clip
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changes its comments in the Node Graph, without  affecting  other copies  of  the  same  clip
even in the same Node Graph.

Extras:

Ref. Mistika: Node Graph Editor->Dashboard->Edit->Extras

The Extras tabs facilitates access to scripts for automization of tasks.

These  scripts  can  be  created  or  modified  via  Mistika  Setup  (Mistika  Setup->General-
>General->Edit Mistika <App. Panel> Buttons.Available in Expert mode only)

In addition to being able to launch external applications  is  also  possible  to  set  parameters
for  such  applications,  as  seen  in  the  default  scripts  included  with  the  delivered  Mistika
package.

Note: External applications run in their own window and not in Mistika’s panels, so that they
may be hidden by them. In this case, remember that  the Linux bar can be used for access
of to manage different desktops.

Setup:

Ref. Mistika: Node Graph Editor->Dashboard->Edit->Setup

This tab is part  of the configuration of Mistika. It  contains those configuration values  that
can be changed without needing to reboot the application for them to take effect. 

The rest of the configuration values are set via Mistika Setup and it  is necessary to restart
Mistika to apply these changes.

The  commands  and  configuration  values  of  the  panel  are  grouped  according  to  their
functionality.

Controls that affect the view of the Node Graph.

Show Grid

Shows  the  vertical lines  that  divide  the  space  into  units  of  time  depending  on  the
zoom factor. 

Show Rulers

Activates viewing of the local ruler of the Timecode.
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Time Code 

Activates viewing in timecode format  of time values corresponding to the Monitor, to
the marks of theNode Graph and the active frames of the clips, instead of showing the
whole number of the frame.

Show Strip Audio

Shows audio clips in waveform.

Show Strip Video

Activates  viewing  of  image  and  audio  clips  in  image  strip  mode.  When  active,  this
parameter improves  the  view  of  the  Node  Graph,  but  at  the  possible  cost  of  losing
speed of interface redraw. 

This speed is optimal if a proxy version of the clips has been generated (Node Graph
Editor->Dashboard->Output->Render->Proxy Image).

Show Graffiti

Activates permanent viewing of notes made with the Graffiti tool of the Edit tab.

Saturation

Numerical field  that  allows  the  definition  of  the  saturation value  of  the  icons  of  the
elements in the Node Graph Editor and in the Visual Editor for the user's greater visual
comfort.

Groups TC source (Left Eye; Right Eye)

Determines which if the two image sequences of the stereo pair defines the timecode
value, if they are different. This value is taken into account  when creating new media
via  a  render  by  generating  a  render  script  via  Output  (Node  Graph  Editor-
>Dashboard->Output).

Show Overlaps

When  activated,  this  button  shows  clips  that  are  overlapped  TimeSpace  as
semitransparent red, so the operator can easily view this kind of editing problem. 

Scroll and Zoom as separate Undo events

When this  button  is  activated,  Mistika  registers  and  stores  the  operator's  actions,
except  those  related  to  viewing  the  TimeSpace  (such as  Scroll  and  Zoom),  so  that
when actions are undone, these latter ones are ignored.
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Options that affect the behavior of the monitor. 

Flow Monitor

Activates  a  schematic  view  of  the  process  flow  in  the  frame  that  the  monitors  are
evaluating.  

Raise Monitor

Activates  an  ordering  mode  for  panels  that  brings  area  of  Monitor  Display
corresponding to the monitor selected to the  front.  To  select  a  monitor,  click on its
mark in the Node Graph.

Select Monitor

Sends  the  image  of  the  active  frame  of  the  selected  clip  to  the  active  monitor
(typically  by  right  clicking  and  dragging).  If  the  active  monitor is  in  Live  mode,  this
frame will be viewed directly in the  external video  monitor.  This  option is  ideal when
working with the direct editing method.

Auto Save 

Activates  automatic  saving  of  the  Node  Graph.  The  time  interval  is  defined  in  the
parameter Autosave Time in Mistika Setup->General->Autosave Time (secs). The
auto-saved  environment  will  have  the  name  of  the  active  Node  Graph,  with  the
addition of the ending ".auto". 

Options for the creation mode of caches.

Autobatch Just Modified

Activates the automatic  creation of caches when changes are made to any clip  with
the  cache  function  activated.  Thus,  each  time  a  clip  is  exited  (either  moving  to
another clip  or unselecting  the  current  clip),  if  the  cache  function  is  active  where
changes have been made, it  will move from the list  of pending cache renders. If  it  is
not  active,  this  must  be  done  manually  via  the  Edit  tab  with  the  option  Render
Pending.

Render

Changes the mode of render to produce the caches of the clips:

Render  Caches  in  Foreground:  starts  the  creation of  caches  in  high  priority,  in  the
case that it is not  necessary to use the system until all the caches are ready and to
accelerate  the  process,  or  as  a  way  of  evaluating  the  correct  functioning  of  said
process

Render  Caches  using  Totem  in  Foreground:  starts  the  creation  of  caches  in  high
priority using Totem, in the case that  it  is not  necessary to  use  the  system until  all
the caches are ready and to accelerate  the  process,  or as  a  way  of  evaluating  the
correct functioning of said process.

Render  Caches  using  Totem  in  Background:  starts  the  creation  of  caches  in  low
priority (Background) using Totem, to enable normal work to continue while  they  are
being created.
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Batch the Cache Renders: starts the creation of caches, which will be sent  to the de
render queue of caches in the Batch Manager.

Options that affect clip movement in the Node Graph. 

Constrains X; Constrains Y

Options  that  block  the  movement  of  all  the  clips  in  the  horizontal  or  vertical  axis
(these  functions  are  also  accessible  from  the  right-hand  side  of  the  Node  Graph
panel). 

Auto Snap

Activates  automatically  repositioning  by  snapping  a  clip  that  is  being  placed  near
another  clip,  depending  on  the  distance  threshold  specified  by  the   Magnet  Snap
parameter in Mistika Setup->General->Magnet Snap (pixels).

Auto Expand

Modifies the behaviour of the Edit->Ungroup, function, so that as well as ungrouping
clips, the necessary number of tracks for the group contents to be  positioned  in  the
Node Graph without upsetting their flow are also added. 

Auto Sync Editor to Timeline

Modifies  the  behavior of  the  Edit->Ungroup function  which,  as  well  as  ungrouping
clips,  adds  the  number of  tracks  necessary  so  that  the  contents  of  the  group  are
positioned in the Node Graph without upsetting its flow.

Mark Offset

Parameter for on-the-fly mark creation, based on a time offset  to compensate for the
user’s reaction delay (user marks are  inserted  via  a  button in  the  Editing  panel,  and
are specified on-the-fly during playback). 

Length considered an Edit Blip

Adjusts the number of frames that  Mistika will consider as an editing "Blip", a  vertical
misalignment  in  a  clip  in  relation  to  an  effects  stack.  Mistika  will  treat  this  as  an
editing  problem,  but  will  never  correct  it  automatically  unless  indicated  by  the
operator. The default value for the number of frames is 3. 

Options that  affect  the adding of effects in Transition  mode.  In  this  mode,  each effect  is
applied  to  the  join  between  two  selected  adjacent  clips,  as  specified  by  the  following
values:

Align: Left, Center, Right

Three possible alignment modes for added transition clip, with respect  to the cut  that
joins two adjacent clips.
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Duration

Numerical  field  that  specifies  the  default  duration  of  a  transition  added  to  two
adjacent clips. 

General interface view options. 

Hide Texts

Hides the text of the button names. The name of any button can be seen by clicking
it  with the center mouse button. This can be deactivated whilst  learning how  to  use
Mistika in order to  memorize  each button’s  function.  However,  it  is  recommended to
activate  it  later,  as  the  constant  involuntary  reading  of  button  texts  can  become
tiring after many hours of use.

Text Shadows

Option for adding  shadows  to  the  texts  in  the  interface  for ease  of  reading  by  the
user.

Text Saturation

Sets the saturation value of the texts and the color trackballs in the interface.

Text Opacity

Sets the transparency values of the texts in the interface.

Background Luma

Sets the value of background brightness of the interface.

Numbers of Vumeters to Show

Indicates  the  number  of  vumeters  to  be  seen  in  the  Node  Graph,  with  up  to  16
channels simultaneously.

Auto Key State

Defines the behavior of the button or the function of the Auto key of the Visual Editor
. It can be in classic mode, which will deactivate the Auto Key each time an effect  or
clip  changes  (Auto  Off);  it  is  also  possible  to  link  the  state  of  Auto  Key  to  the
selected  object,  maintaining  each object  in  the  state  found  in  Auto  Key  (Auto  Key
state per Object); the final possibility is to maintain the state independently from the
selected objects or clips (Auto Key keeps state).

GUI Magnify Filter

Allows the setting of the mode in which Mistika treats an image when zooming over it
to view effects. This configuration only affects the interface, not  the material, render
or video output. There are 2 modes:
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Nearest:

When zooming on an image larger square pixels  are  produced:  ie,  the  original size  of
the pixels is increased. This mode is recommended for analyzing mages pixel by pixel.

Interpolate:

In this mode Mistika generates new interpolated pixels between adjacent  ones, giving
a  better  zoom  quality,  although  less  faithful  to  the  original  pixels.  This  mode  is
recommended for large images.

FX

Ref. Mistika: Node Graph Editor->Dashboard->FX

Information  abut  the  functioning  of  the  effects  in  Mistika  are  explained  in  detail  in  the
chapter Mistika FX.

Curves

Ref. Mistika: Node Graph Editor->Dashboard->Curves

This  panel shows  and  edits  the  parameter  values  of  any  effect  clip,  Timewarp  group  or
audio clip selected in the Node Graph.

All the parameters of clips in Mistika can be animated in time using editable animation curves
in the Keyframe Graph area.

To  set  many  of  Mistika’s  effect  parameters,  manipulators  can  be  used  that  interactively
specify several parameters at the same time.

Curves

In the Curves area, the curves of the visible exported parameters are viewed and edited.

The curves are viewed on a provisional grid, and are composed of different  elements, which
can be directly edited. 

A horizontal ruler marked in frames appears in the top margin of  the  grid,  where  a  vertical
guide  or dial moves  to  indicate  the  current  frame.  This  guide  corresponds  to  the  current
frame defined by Current Frame, the active frame of the clip and to the Keyframe Slider  of
the Visual Editor mode. 
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Note: a frame after the  last  one  (after  last)  can be  selected  with  the  dial of  this  panel.
This box specifies a value in the clip Out  Point  timecode, thus enabling parameter animation
to be sustained up to the second field of a video sequence. 

To navigate within the curve views, drag them with the right mouse button. 

The components of a curve are: 

Control point (Keyframe)

Control points can have or not have tangents, and can be of different classes. These points
can be manipulated directly or in blocks. 

Curves

Interpolation  between  keyframes  calculates  intermediate  values  to  draw  curves.  Any
number of control points can added to these curves.

Direct editing method:

The selected curve is shown in cyan, and its control points in green. The  tangents  to  the
points are drawn in white. The points or curves that are not selected are drawn in white. 

To modify the position of a point or its tangent, select it with the left mouse button. 

To select a curve, double-click on one of the curve control points. After selecting it  drag it
with the left mouse button. 

A selection block can be created to specify a  multiple  selection,  by  drawing  a  rectangular
area  that  selects  all  the  points  within  it.  To  specify  a  block,  left  click the  mouse  on the
background  and  draw  the  rectangle  by  dragging  the  cursor over the  control points  to  be
selected. This multiple selection can be moved to another position.

To add  a  control point  to  a  curve,  left  click the  button on the  curve  while  holding  down
<Alt>.  This  technique  can also  be  used  to  draw  a  freehand  animation  curve,  since  until
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<Alt> is released more control points can be added at the positions where the left button is
clicked. 

To remove a control point, left click the point to be removed while holding <Ctrl> down. 

Viewing options:

This window has a series of commands for adjusting the viewing of the curve with in order
to be able to carry out evaluation and editing of the animation conveniently and accurately.

Max

Expands the Parameters area to full screen. To return it  to its normal size, press this
button again.

Zoom X

Zooms the view of the curves in the horizontal axis. 

Zoom Y

Zooms the view of the curves in the vertical axis. 

Zoom Reset

Resets the zoom to view all the curves of the effect. 

Zoom Fit

Resets the zoom to view the selected curve to the maximum possible size. 

Zoom In

Increase the zoom step by step.

Zoom Out

Reduce the zoom step by step. 

Curves Tabs

The area Curves Tabs is composed of five subpanels grouped according to their functions.
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Points:

A subpanel that has functions for specifying the type of control point. 

Smooth

Specifies the selected point as a smooth interpolation control point. 

Sharp

Specifies the selected point as a hard interpolation control point. 

Smooth Tangents

Specifies  the  selected  point  as  a  connected  tangents  control  point.  The  input  and
output  tangents  are  connected,  therefore  when one  is  moved  the  other  is  as  well.
Tangents are very useful for creating animations of complex parameters. 

Sharp Tangents

Specifies the selected point  as an independent  tangents control point. The input  and
output  tangents  are  independent,  and  therefore  they  can  be  specified  separately.
Tangents are very useful for creating animations of complex parameters.

Constant

Establishes that  the curve from the selected point  to the following  control point  is  a
constant value. If, after the point  marked as a constant, there are no control points,
the constant value extends to the end of the curve.

Curve:

A subpanel that has the functions that affect the whole selected curve.

Hide

Hides the selected curve. 

Note:  the  curve  can  be  selected  by  clicking  in  the  parameter  name  in  the  Value
section, or several curves can be selected at  the same time from a folder. When the
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curve  is  hidden,  the  name  and  the  value  of  the  parameter  will  be  shown  as
semitransparent. 

Reveal

Reveals the selected curves that are hidden. 

Reverse

Reverses the selected curve in the horizontal axis. 

Flip

Flips the selected curve in the vertical axis. 

Fit

Fits the duration of the curve to the total duration of the effect. 

Note: the duration of the curve is calculated from the first to the last control point. 

Filter

Filters the selected curve, by smoothing sudden differences between frames. 

Note: This filter adds a control point in each frame of the curve.

Flat Tang

Resets  the  selected  control point  tangents  to  flat  values.   This  way,  flat  tangents
that  represent  acceleration  or  deceleration  of  the  animation  of  a  parameter  are
specified.

Note: For this command to function, the selected control points must  have tangents
before applying the command.

Block:

A subpanel that has functions that affect the control points selection block.

Duplicate

Duplicates the control points selected by the selection block, and moves them to the
dial.
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Move

Moves the control points selected by the selection block to the dial.

Time:

Transport functions of the panel dial. 

Go To Head

Positions the dial in the head of the clip. 

Go To Tail

Positions the dial in the tail frame of the clip. 

Previous Frame

Moves the dial to the previous frame. 

Next Frame

Moves the dial to the next frame. 

Previous CP

Moves the dial to the previously found control point. 

Next CP

Moves the dial to the next control point found.

Scale:

A subpanel that has functions for scaling curves. 

For these functions to work optimally, a selection block must first be defined. 

After specifying  the  selection block,  press  one  of  the  Scale  buttons  and  drag  the  cursor
while  holding  down  the  left  mouse  button,  and  moving  it  in  either  of  the  two  possible
directions. 
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ScaleH / ScaleV

Moves the selected control points in the horizontal and vertical axes.

ScaleL(eft) / ScaleR(ight) / Scale U(p) / ScaleD(own)

Modify the size of the selection, taking as the center of  the  scale  the  margin  in  the
opposite direction to that of selection block.

For example, using ScaleR, if  scaling is done towards the right, the distance between
the control points towards the right increases. If scaling is done towards the left, the
distance  between  the  control  points  is  reduced,  and  they  will  meet  in  the  in  the
margin where scale axis is found. If the scale axis is exceeded, the  positions   of  the
control points are inverted.

Scale0

Carries out a vertical scaling of the selection, taking zero as the scale center, ignoring
the lower margin of the  selection block.  If  the  scaling  axis  is  exceeded,  the  relative
positions of the control points are inverted.

VTR

Mistika Ref: Node Graph Editor->Dashboard->VTR

This tab operates in two work modes: Capture and Play Out.

VTR Capture  allows  control  of  the  VTR  connected  to  the  workstation  intended  for  the
capture  or recapture  of  media  clips  selected  in  the  Browser  or to  create  new  image  and
audio clips, and is also essential for the restoration of a backup.

VTR Play Out  provides remote access to the VTR connected to the workstation in order to
transfer the edit in the Node Graph to video.

The effects can be run in real time  and  can be  played  back in  the  process  of  transfer to
video, taking full advantage of the performance of the system. 
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VTR Capture

Mistika Ref: Node Graph Editor->Dashboard->VTR->VTR Capture

The VTR Capture tab gives control of the VTR connected to the workstation, to capture or
recapture media clips selected in the Browser, or create new image and  audio  clips,  which
are also essential for restoring a backup. 

The capture format  of a clip is specified by the format  of the project. This format  must  be
specified  via  the  dropdown  button  Standard  Preset  in  Mistika  Setup  (Mistika  Setup-
>General->General->Standard Preset).

Note: Sometimes, when working in NTSC at  29.97 fps,  it  is  necessary  to  compensate  the
differences between the value of the time code and current  time of production via the use
of "drop frames". In this case, before capturing the clips, the option  Drop Frame en Mistika
Setup (Mistika Setup->VIDEO I/O->VIDEO I/O->Drop Frame) must be activated. 

Mistika supports the control and capture via firewire. To do so the option Use Video board
in Mistika Setup (Mistika Setup->VIDEO I/O->VIDEO I/O->Use  Video  board)  must  be
activated.

Via the VTR Capture buttons, it's possible to specify or modify the attributes of  the  image
and audio clips.

These data can create a new image or audio clip in different ways:

Defining  the  characteristics  of  the  clip  and  capturing  it  in  free  mode  (Free),
marking the start and end of the capture on-the-fly.

Defining the characteristics of the clip and capturing it  according  to  its  input
and output points.

Defining  the  characteristics  of  the  clip  in  order  to  capture  it  later  in
accumulative mode (Batch).

Modifying the characteristics of a clip and overwriting it.

To  load  the  information of  a  clip  in  the  capture  panel,  the  .clp  file  to  be  edited  must  be
selected in the Browser. 

When definition  of  the  new  values  for  the  clip  is  completed,  press  the  Login  or  Capture
button of the capture panel, which then overwrites the information of the clip.

The buttons of the panel are grouped according to their functionality.

The buttons of this are grouped according to  their functionality.  Each group  of  buttons  is
described in detail below:
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Tracks:

An area with the fields that specify the characteristics of the clip. 

VTR Timecode

VTR timecode value of the current frame of the tape in the VTR. 

Go To In

Moves the video tape to the timecode specified as In Point. 

Go To Out

Moves the video tape to the timecode specified as Out Point. 

Tape In

Numerical field that indicates the In Point  timecode of the editing operation to be run
on the video tape. 

Tape Out

A numerical field that  indicates the Out  Point  timecode of the editing operation to be
run on the video tape. 

Rewind

Rapidly rewinds the tape in the VTR. 

Play Back

Plays back the tape in the VTR in the reverse direction. 

Prev Frame

Goes back one frame in the tape in the VTR. 
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Stop

Stops the playback of the tape contained in the VTR. 

Pause

Pauses the playback of the tape in the VTR, stopping the tape at the current frame. 

Next Frame

Advances one frame in the tape in the VTR. 

Play

Starts the playback of the tape in the VTR. 

Forward

Rapidly advances the tape in the VTR. 

Mark In

Sets the input point in the VTR.

Mark Out

Sets the output point in the VTR.

Shuttle

Dynamic transport control of the tape contained in the VTR. It  consists of a dial that,
after  selecting  it  with  the  left  button,  accelerates  or  decreases  playback  speed:
clockwise advances and counter-clockwise goes back. 

Note: An alternative method to toggle between Shuttle and Jog mode (advance frame
by frame) is to double-click on the dial. 

Jog

Button that  indicates  and  activates  or deactivates  Jog  mode  for the  tape.  Another
method for alternating between Shuttle and Jog mode (advance frame by frame) is to
double-click on the dial.

Note:  The  functions  Jog  &  Shuttle  also  are  available  from  the  optional  Tangent
Devices.

Eject

Ejects the tape in the VTR. 
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Control of clips:

Area where the fields that define the characteristics of the clip are found.

Time Codes:

In Point

Specifies the current timecode of the VTR as the start value of the clip capture. 

Duration

Sets the duration of the clip to be captured. This value is related to the Out  Point  in
such a way that the modification of one affects the other.

Keep

Activates a mode that  keeps the specified duration unaltered. In this mode, if  the  In
Point  value is changed,  the  Out  Point  value  will  also  be  altered,  or vice-versa,  thus
maintaining a constant length. 

Out Point

Specifies the current timecode of the VTR as the Out Point of the clip capture.

Tape Name

The name of the tape corresponding to the clip capture timecode. 

Note: It is very important  to identify correctly the original tapes with this field, since
a tape identification error can make the recapture of a clip difficult,  or even prevent
the correct export of an EDL. 

Clip Name

Field that specifies the clip name. Mistika does not allow two clips of the same project
to have the same name, although it allows the overwriting of the clip. 
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This field must  be completed, although Mistika automatically increases the  number of
the last name, automating this task. 

Note: For the automatic  numerical increment  to  work correctly,  any  name  should  be
defined, and then an underscore (_) added with any figure (for example: MyClip_005).
When one of the capture functions (Capture, Start Free, or Capture Selection) is run,
this number will be increased automatically (in the  example,  the  new  name  would  be
MyClip_006).  The  initial  zeros  of  the  number  will  be  respected,  although  none  are
obligatory.  If  the  name  contains  numbers  before  the  underscore,  these  will  not  be
increased (For example: MyClip6_3 will be increased to MyClip6_4).

Video, A2, A4, A8

Buttons  that  specify  the  number  of  media  tracks  that  the  clip  should  have  when
captured. 

Note:  The  audio  indicators  specify  the  number  of  tracks  that  the  audio  media  will
have, and  not  the  channels  required  in  a  stereo  pair.  A2 means  stereo  audio,  A4 is
quadrophonic audio and A8 is multitrack audio type ADAT; each type of audio creates
different types of audio file. 

Fields Mode

Indicates in the attributes of the clip that this has Interlaced or No Interlaced fields. 

Note: The interlaced state of the clips should be specified by the user. This allows for
the  possible  incongruence  that  a  clip,  while  having  fields,  might  not  have  the
interlaced attribute, and vice-versa. 

Stereo3D

Indicates in the attributes of the clip whether the left channel (L), right channel (R) or
both channels of the stereoscopic stereo is to be captured.

Target Folder

Field that indicates the last folder selected in the Browser, which will receive the clips
created by the capture commands. 

By default, the target folder of the active project is DATA, although the user can (and
should) create the subfolders needed for better organization of the material, and then
select one of these folders in the Browser to specify it as the new target. 

Note:  for  the  destination  folders  created  by  the  user  to  be  recognized  by  VTR
Capture, they must always be created in the DATA subdirectory and selected directly
in the Browser  before beginning capture. The RENDER folder cannot  be selected as a
destination folder.

Available time

Estimated  capture  time  available  in  the  storage,  expressed  in  hours,  minutes  and
seconds (HMS).
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Status

Name of the current command running in the VTR.

Comments:

Comments

Field where comments about  a clip can be  added.  This  information can be  viewed in
the Comments column in the Browser.

Format:

Type of File

Dropdown menu that allows selection of the file type of the image format to which the
input  signal will be converted. This  information can be  viewed in  the  Format  column
from the  Browser.

Note: This function of Mistika allows signal input  and the format  of the captured clip
to be dissociated, with the aim of  avoiding  later conversions  to  others  formats  (and
the resulting consumption of resources).

Video Target

This  dropdown  allows  the  selection  the  destination  directory  of  the  video  media.
These directories are named as defined in Mistika Setup (Mistika Setup->File Paths-
>Predefined paths for rendered sequences).

Audio Target

This  dropdown  allows  the  selection  the  destination  directory  of  the  audio  media.
These directories are named as defined in Mistika Setup (Mistika Setup->File Paths-
>Predefined paths for rendered sequences).

Perform:

Capture

Runs the clip capture specified in the clip creation area of the capture panel. 

Abort Capture

Cancels the capture command in process. 

Note: When canceled, the clip in the capture process cannot  be partially stored, and
its media is automatically deleted in its entirety.

Start Free

Free  capture  button  (Free  mode).  Remember  that  this  mode  creates  a  new  clip
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without timecode values. 

This button instantly starts the capture of the media shown in the clip creation area
when pressed.  If  the  clip  name  coincides  with  another project  clip,  the  capture  will
not begin, since the user should respond first if the existing clip should be overwritten.
For this reason we recommend following the automatic naming criteria described above
(add suffix _number). 

To finish on-the-fly capture, press Start Free again.

Note:  Depending  on  the  amount  of  free  time  in  storage,  there  may  be  a  delay
between giving the  command and  its  execution.  This  is  due  to  the  fact  that  before
starting  capture,  Mistika  needs  to  reserve  all  the  free  time  on  disk,  in  order
subsequently to specify on-the-fly the end of the capture and defines a real duration
for the new clip. The more free time is available, the longer this delay will be.  

Stop Free

Stops the on-the-fly capture.

Batch Capture:

Create Clip

Creates a new clip  without  media  in  the  target  folder,  saving  the  capture  data  in  a
new .clp file, which can be captured later. 

Note:  This  command  also  activates  the  automatic  numerical  increase  of  the  clip
name, and can specify new In and Out  Points of capture without  needing to create a
new name for each new clip. 

Capture Selected

Runs the capture or recapture of files and folders selected in the Browser. 

The  types  of  file  that  have  capture  data  are  the  .clp  (original  clips)  and  the  .res
(Backup restore files). Other types of file are ignored in the capture. 

Selection of clips in the Browser  can be  multiple,  or single  or several subfolders  can
even  be  selected  for  the  capture  or  recapture  all  the  clips  contained  in  them.
However, their capture order does  not  correspond  to  the  selection or sort  orders  of
the Browser, but to the ascending order of the tape and input timecode. 

If clips of different  types of tape exist  in  the  selection,  the  VTR control will  request
the necessary tapes in alphanumerical order. 

This  method  permits,  for  example,  setting  up  of  several  EDLs  in  the  same  capture
session. Simply select the folders that contain the clips generated by the EDL import. 

The same method of folder selection can be used to restore the media of a backup. 

This capture mode is commonly called Batch Digitize. 

Abort Captures

Cancels the capture command in process. 



218 The Interface

SGO Mistika 8.6 © 2018 SGO

Skip Capture

Cancels the current clip capture and jumps to the next. 

This command is very useful in cases where the  capture  being  processed  contains  a
timecode  range  that  does  not  exist  on the  tape  or  which  does  not  have  sufficient
margin to make the starting pre-roll, and can delay this problematic capture until later,
continuing with the following event. 

Note:  This  command button can only  be  used  during  the  capture  process  in  batch
mode (Batch Digitize). 

After Capture:

Launch Script

When the capture session is finished, this permits the running of a programming script
for the automation of tasks.

The  intention is  to  provide  users  with  a  means  of  detecting  the  end  of  a  capture
session,  without  their  needing  to  be  present,  by  informing  that  the  capture  has
finished or by running other pending tasks when it ends.

The configuration is simple. First add the name/s of the scripts to be run at the end of
a capture session in the file: $HOME/Mistika-ENV/etc/setup/CaptureEndScript.cfg

The script must be in the directory: $HOME/Mistika-ENV/bin/scripts

The script must have run permission.

In order that a specific script is run at the end of the capture session, simply select  it
from the dropdown which shows the names of the configured scripts.

One example of this is to have a script  called "SendMail", which sends a mail to an e-
mail address informing of the end of  the  capture  session and  whether it  was  carried
out correctly or if it produced errors.

The  creation of  the  script  is  beyond  the  scope  of  this  manual,  and  the  creation  of
scripts that may be useful for workflows or for operators lies in the territory of system
administrators.

Last Captured Clips:

Captured

Indicates  the  last  captured  clip.  This  is  useful  for  knowing  the  progress  of  the
capture.

Capture by firewire

The type of capture is controlled via the option Use Video Board in Mistika Setup (Mistika
Setup->Video I/O->Use Video Board).

If  this  parameter is  activated,  control of  the  video  board  will  be  activated  (DVS  models)
from SGO Mistika, and the audio will be sent exclusively via the video board that has its own
audio outputs, since this is the only way of synchronizing output with the image.

If Use Video Board is deactivated, SGO Mistika's capture panel will try to use a Firewire port
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to capture from a camera or DV-type VTR. In this case, the audio is reproduced exclusively
via the audio output of the motherboard, and not the SDI board.

Once use of the SDI is deactivated, the VTR can be  connected  via  the  firewire  port,  and
the capture module should be operated remotely. In the case that  Mistika cannot  connect
with the device, a warning message will be displayed.

After  Mistika  connects  to  the  VTR  device,  follow  the  procedure  described  in  previous
sections  of  this  chapter.  For  example,  a  capture  list  can  be  defined  and  captured
automatically.

The clips captured will be of movie-type, with the codec DV25 and .avi.

Troubleshooting video capture and playout problems

If  when  carrying  out  a  transfer  we  observe  that  it  is  not  exactly  synchronized,
check the value of the Edit Lag variable (found in the VTR tab and in the I/O options
of Mistika Setup. This value must  be set  at  that  recommended by the manufacturer
of the VTR, although we also can find it  manually by increasing and decreasing the
number of frames by which it is out of phase.

The timecode observed in the VTR and that which we see in the VTR Capture  must
always be identical. If  any difference is seen between them, check that  the VTR is
configured to be paused in Still mode and not in Stop mode.

If the VTR is not  connected, the capture interface will appear deactivated  (except
for the on-the-fly capture options without  timecodes or Free mode). If this occurs,
check that, 

° The VTR is in Remote mode (refer to the documentation of the VTR)

° The  remote  cable  is  correctly  connected  between  the  VTR  and  the  video

board. 

° In cases of capture, check that  the VTR has a tape inserted and  is  ready  to

record, and not in "write protect" mode. 

If  when trying  to  capture,  the  VTR  moves  to  different  positions  but  the  capture
does not start, works randomly, or only responds to some remote control commands
of remote control, check: 

° If  capturing  is  normally  correct  but  there  are  problems  in  certain  cases,  the

most  probable cause is that  the In Point  of the clip  to  be  captured  does  not
have sufficient  time on the tape  in  order to  make  the  pre-roll  (5  seconds  as
default value, as well as the Head value that should be added when setting up
and EDL). Also check that  the timecodes of the tape  before  the  In  Point  are
continuous and that they are in the format specified in Mistika Setup->Video
I/O->Format). 

° Check that  Mistika Setup->Video I/O->Format  contains  exactly  the  same

format  as  that  which  appears  in  the  display  of  VTR.  A  common  error  is  to
configure Mistika to the same format as the one in which the tape is recorded,
without  checking  the  VTR display,  and  it  is  usual  that  if  the  VTR  does  not
support  the same format, it  will  autoconfigure  to  the  closest  (for example,  if
we insert  a 24p or 25p tape in  a  VTR that  only  supports  25i);  thus  it  is  this
last one to which Mistika should be configured (once the capture is complete,
change it to the correct value to work with the clips).

° A common case is that of tapes that have been recorded with timecode jumps

at  each  camera  stop/start  (many  cameras  avoid  this  problem  if  configured
correctly,  although many  camera  operators  seem to  ignore  it).  In  this  case,
the timecode jumps will at  least  be ascending up , so it  is possible to capture
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the clips if at least sufficient pre-roll has been left before each clip . 

° If descending timecode jumps are observed (a typical case  of  tapes  recycled

by inexperienced operators)  then the  VTR will  move  backwards  and  forwards
trying  to  find  the  In  Point.  The  last  resort  in  this  case  is  to  make  the  VTR
remote by hand to go into the clip to be captured and then order the capture,
so that the VTR will not collide with the invalid timecodes. In this way it will be
able to find the In Point, if sufficient pre-roll is available.

If  capture  starts  well  but  stops  halfway  (and  the  storage  is  definitely  not  full),
check  the  error  messages  of  the  VTR  Panel  and  of  the  system  console.  This  is
usually due to the fact that the storage system has problems or that it cannot  write
at  the  necessary  speed  for the  format.  The  available  speed  can be  checked  with
Mistika Setup->Utils->Test .js disk speed.

Another possible cause of the same problem is that  the storage is very fragmented
(due to continuously working at the limit of its capacity, which greatly increases the
fragmentation of  the  disks).  In  general,  storage  can  be  defragmented  by  running
Mistika Setup->Utils->Defragment realtime directory.

Stability problems in the signals, including a system crash in extreme cases:

° If working with an external sync  signal, the cable of the sync  signal should be

connected to a reliable source of generated sync. If on the other hand we are
working with internal sync, it is a good idea to disconnect  the sync  cable from
the workstation (this type of contradiction can produce problems).

° To discard external sync signal as the cause of a problem, is recommended to

do a test capture changing to internal sync. 

VTR Play Out

Mistika Ref: Node Graph Editor->Dashboard->VTR->VTR Play Out 

The VTR Play Out  tool allows control of the VTR connected to the workstation, to transfer
the Node Graph to video tape. The effects that  can be run in real-time can be reproduced
in the video transfer process, taking full advantage of the performance of the system. 

If real-time is lost  during reproduction, a Lost  Sync  message will appear on the  bar of  the
Node Graph monitor, stopping the editing run in the VTR. 
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Tracks:

Group of buttons that control the tape transport in the VTR. 

VTR Timecode

Timecode value of the current frame of the tape in the VTR. 

Go To In

Moves the video tape to the timecode specified as In Point. 

Go To Out

Moves the video tape to the timecode specified as Out Point. 

Tape In

Numerical field that shows the In Point timecode of the editing operation to be run on
the video tape.

Tape Out

Numerical field that  shows the Out  Point  timecode of the editing  operation to  be  run
on the video tape.

Rewind

Rewinds the tape in the VTR rapidly. 

Play Back

Plays the tape in the VTR in the reverse direction. 

Prev Frame

Goes back one frame in the tape. 

Stop

Stops playing the tape in the VTR. 

Pause

Pauses playing of the tape in the VTR at the current frame.

Next Frame

Advances one frame in the tape. 
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Play

Starts playing the tape in the VTR. 

Forward

Advances the tape in the VTR rapidly. 

Mark In

Sets the input point in the VTR.

Mark Out

Sets the output point in the VTR.

Shuttle

Dynamic  control  of  the  tape  transport  in  the  VTR.  Consists  of  a  dial  which  when
turned  (after  selecting  it  with  the  left  button),  accelerates  the  playing  speed:
clockwise to advance and anticlockwise to go back.

Note:  Another  way  to  toggle  between  Shuttle  and  Jog  mode  (advance  frame  by
frame) is by double-clicking on the dial. 

Jog

Button that  indicates  and  activates  or deactivates  Jog  mode  for the  tape.  Another
method  for alternating  between Shuttle  and  Jog  mode  (advance  frame  by  frame)  is
double-clicking on the dial.

Note:  The  functions  Jog  &  Shuttle  also  are  available  from  the  optional  Tangent
Devices.

Eject

Ejects the tape in the VTR. 

Time Line:

Group of buttons that show the Range of the Node Graph to be inserted in the videotape. 

Start / End

Values of the Play Marks, whose numerical fields can be edited. These values can also
be redefined by moving the Play Marks in the Node Graph. 

The duration of the range shown by the Play Marks will always be equal to that  shown
for the videotape. Therefore,  the  modification of  one  or other range  will  reciprocally
modify their in-points, maintaining a common duration.
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Set VTR TC in Node Graph

Copies the current timecode value of the VTR to the timecode mark of the Node Graph
. This function is very useful for equalizing the current  timecode of the VTR with  the
timecode mark of the Node Graph and comfortably transferring it  with the option Sync
Node Graph-Tape.

Sync Node Graph-Tape

Anchors the Node Graph timecode to that of the VTR. 

This mode makes the Node Graph timecode "parallel" to the video tape, thus avoiding
the  need  to  specify  In  and  Out  Points  in  the  VTR,  since  the  In  and  Out  Points  are
specified in the Node Graph, by the Play Marks. 

Tape Positions:

Group of buttons that show the videotape range where the contents of the Node Graph will
be inserted. 

In Point

Makes the current timecode of the VTR the In Point value. 

Out Point

Makes the current timecode of the VTR the Out Point value.

Tape transfer mode:

Group  of  buttons  that  show  the  videotape  tracks  to  be  replaced  by  theNode  Graph
contents. The Assemble mode can also be selected, provided that the other insertion tracks
are turned off. Similarly, turn off the Assemble mode before switching video or audio mode.

Video

Specifies that  the  track of  the  videotape  is  replaced  by  the  image  clips  of  the  edit
Range selected in the Node Graph. This insertion mode requires the videotape to have
a sync base with a continuous timecode.

A 1, 2, 3, 4,5, 6, 7, 8

Specifies the audio tracks of the tape which are to be replaced by the audio tracks of
the edit range selected in the Node Graph. This insertion mode requires the videotape
to have a sync base with a continuous timecode. 

Note:  Video  formats  have  different  numbers  of  audio  tracks.  Any  track  can  be
specified  for insertion,  provided  that  it  has  access  to  it.  The  workstation  can  also
have different types of audio output, each one with different number of audio tracks. 
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TC

This function is rarely used, for which reason most  users  will  keep  it  deactivated.  It
defines  forced  recording  of  the  original  timecodes  with  which  the  clips  to  be
transferred were captured. In order to use this mode, activate the Assemble mode. 

The TC tool works in combination with the editing tool Linearize (Node Graph Editor-
>Dashboard->Edit->Macros->Linearize),  which  puts  the  clips  in  chronological
order according to the original timecode of each clip. In the transfer to video process,
a  black image  is  inserted  into  the  tape  with  cautious  preroll  and  postroll  times  and
between the clips. This allows later recapture in SGO Mistika or in any other system.
The  preroll  and  postroll  time  is  defined  in  the  menu of  Setup  (Node  Graph  Editor-
>Dashboard->VTR->VTR Setup) in the Pre Handle and  Post  Handle  boxes  where  a
numerical value  that  sets  the  number of  seconds  of  space  there  will  be  before  and
after each clip is inserted.

This recording method is known as "Crash Mode Record", and requires the connection
of an extra BNC-BNC cable to the TC-In connector of the VTR, to be able to force the
recording of the external timecode.  With  respect  to  the  other end  of  this  cable,  for
DVS Centaurus videocards, use the Out 7/8 Audio connector, the prior reconfiguration
of a Jumper of the card labeled for this purpose, which allows us to send the timecode
via that cable rather than using the last two audio channels. 

For more detail on this transfer mode, see the annex Transfer with Original Timecode
(Crash Record).

Assemble

Specifies Assemble as the editing mode. Remember that  to  activate  Assemble  mode,
all the video and audio insertion buttons should be turned off. 

Note: Assemble mode, apart  from recording video and audio, records the sync  track.
When  recording  synchronism,  the  end  of  recording,  or  Out  Point,  will  have  a
discontinuous  synchronism,  and  for  this  reason  we  only  recommend  working  in  this
mode in the case of wanting to continue recording to a tape without  sync  to transfer
the duration of the Node Graph. 

There are some other occasions in which this recording mode can be useful (although
in general we advise avoiding it as much as possible): 

in  urgent  situations,  when it  is  not  possible  to  wait  until  the  whole  tape  is
recorded with the timecode base before starting the transfer 

to save recording head costs. In  certain  VTRs,  the  recording  head  costs  are
extremely high, and users sometimes consider that  working  in  assemble  mode
can be justified by the saving in the cost  of heads required by prior recording
of timecodes in the whole tape

some old VTR models only support transfer in Assemble mode

A disadvantage  of  this  mode  is  that  recording  in  Assemble  mode  does  not  generate
timecodes beyond the Out  Point,  so  the  tape  will  not  have  continuous  timecodes  in
later recordings. For this reason it  should be avoided except  for reasons that  can be
fully justified. 
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Perform:

Group of buttons that run the editing functions on the VTR.

Play Rec

Direct recording command, without preroll. This command can be used to start  a virgin
tape. 

Preview

Makes an editing simulation on the tape, using the specified editing ranges. 

Edit

Runs the editing of the tape according to the mode Insert or Assemble defined.

Cancel

Cancels the editing function being processed.

Note: The tape in the VTR can be  protected  against  recording  (Rec  inhibit).  In  this
case,  the  editing  functions  of  the  VTR  will  all  function  as  Preview,  without  in  fact
recording to the tape. The recording inhibition should either be removed with the tape
protection button, or by deactivating the inhibition function in the current VTR. 

To work in Assemble mode, it is essential that the tape has the number of seconds of
sync  base  recorded  to  make  the  preroll,  necessary  for  reading  and  continuing  a
synchronism base. It is also very important  to configure the physical VTR so that  the
timecode  recorded  by  Assemble  continues  the  previous  timecode  (Regen  timecode
option).

VTR Setup

Mistika Ref: Node Graph Editor->Dashboard->VTR->VTR Setup

Preroll

Sets a time margin previous to the In Point  for accurate capture or transfer to video.
Most  tape based VTRs recommend a  value  of  around  seven seconds  to  stabilize  the
mechanics of tape drag before having "Frame  Accurate”  precision.  Consult  the  VTR’s
documentation for more information.

Edit Lag

Sets  the  number  of  frames  that  the  video  internal  buffer  stores  in  the  transfer
process.  This  value  varies  with  each  VTR,  and  the  manufacturer  must  provide  its
exact value for accurate transfer. If  video transfer is constantly out  of phase, adjust
this  value  by  the  same  number  of  frames.  The  default  value  is  usually  7,  which  is
appropriate  for Digital Betacam and  many  other models.  The  intermediation of  video
matrixes, external converters, etc. may also affect this value.
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Pre Handle

Sets the behavior of the TC transfer mode (VTR->Play Out->Tracks->TC).

Sets a prudent  number of seconds previous to the In Point  in which Mistika inserts  a
black image  on the  tape  between  each  two  clips,  to  provide  sufficient  preroll  time
between timecode jumps.

Post Handle

Sets the behavior of the TC transfer mode (VTR->Play Out->Tracks->TC).

Defines  a  prudent  number of  seconds  after the  Out  Point  in  which Mistika  inserts  a
black image  on the  tape  between  each  two  clips,  to  provide  sufficient  preroll  time
between timecode jumps.

Max Free

Sets the maximum duration of each segment  of  a  captured  clip  in  Free  mode.  When
this duration is exceeded, Mistika will automatically start to write a new file.

Note: Mistika keeps in reserve the  maximum space  necessary  before  beginning  each
capture, although the unused part is later free up. IF very large values are set, other
applications working from the same storage may be  led  to  believe  that  there  is  little
space  on disk and  so  Mistika  stops  the  capture  and  frees  the  rest  of  the  reserved
space.

Free with TC

When this option is activate, an internal timecode in the clip captured in Free mode  is
generated (only for certain VTRs that support the appropriate VITC).

Audio

Ref. Mistika: Node Graph Editor->Dashboard->Audio

The Audio tab of Mistika contains tools for redirecting audio clips in the Node Graph to the
audio  outputs  of  the  workstation  and  controlling  their  levels.  It  works  in  the  manner  of
traditional  audio  routers  and  mixers,  with  a  track  mixer,  support  for  groups,  panning
settings, audio VU meters etc.

Mistika supports audio formats up to 24bit.

Each Mistika  clip  may  contain  up  to  16 audio  tracks  as  well  as  the  image  channels.  It  is
usual for clips with audio to have 2 audio tracks, it  is possible to have clips just  with audio
derived from captures or from audio files.
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By  default,  Mistika  runs  playback of  all  the  audio  tracks  in  the  clips  contained  within  the
area  marked  by  the  frame  of  the  monitor.  So  when  there  are  various  clips  with  sound
stacked we use the tool Router to redirect the audio tracks of each clip to the inputs of the
 Mixer,  which  is  the  que  tool  that  definitively  mixes  the  signals  and  sends  them to  the
physical audio outputs de audio available. 

To  work  with  reference  to  the  audio  wave  form,  activate  the  option  Show  Strip  Audio
(Node  Graph  Editor->Dashboard->Edit->Setup->Node  Graph  View->Show  Strip
Audio). Also, increase the zoom of the Node Graph in order to view the wave form over the
audio clips. This method only works over pure audio clips, so if  we are dealing with a mixed
clip (image and audio) we need to  apply  the  edit  command Edit->A/V  Break to  obtain  the
audio clip separately.

We can also activate the option Audio Wave of  the  Monitor  Display  (Node  Graph Editor-
>Monitor Display->Record Monitor->Menu->Audio  Wave)  to  view  in  detail  the  wave
form of up to 16 audio tracks corresponding to the segment of audio of the current frame.

Mixer

The Mixer allows the defining of levels for each of the 8 inputs in order to mix them before
sending them to the audio output, as well as the the master level of the output.

The buttons  on the  left  of  the  Mixer  control the  input  channels  assigned  via  the  Router.
Each of these channels has:

Level

A vertical slider for setting the channel volume.

Mute

If the M button is depressed, the channel is muted.

Solo

If the S button is depressed, this will be the only channel sent  to the output, muting
all the other channels.

Pan

This dial allows the balance of the audio channel to be set.

On the  right  of  the  window  there  is  a  vertical  slider  for  controlling  global  gain  for  each
physical output channel.
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The mixer controls cannot  be animated. If we wish to animate the  gain  of  an audio  track,
we  must  do  it  directly  over  the  audio  clip.  To  do  so,  select  the  clip  and  open  the
Parameters tab.

The sliders of the audio channels defined in Router as pertaining to the same group (A, B, C,
or D) will move together.

Mute All

Silences the global output of the mix.

Reset 

Resets the parameters of the mixer to default values.

Router

The controls of the tool Router allow the redirecting of up to 16 audio tracks that  each clip
may possess to any of the 8 available inputs of the mixer.

To work with the Router first select the clip with audio in the Node Graph.

Generally, if there is only clip with audio in a segment of the Node Graph, we do not need to
use the Router. But when there are various audio clips in different  tracks, they would all be
heard simultaneously when running playback or rendering;  it  is  therefore  necessary  to  use
the  Router  to  correctly  assign  the  tracks  to  the  Mixer  tool.  we  then  use  the  Mixer  to
control the mixing levels and send the definitive audio to the output.

There  are  also  available  four  color-coded  groups  (A,  B,  C,  and  D),  for  moving  the  gain
parameters of audio channels simultaneously. All the channels that  we define in the Router
as pertaining to a group  will be synchronized in the Mixer  (when one is moved, the others
in the group will move to the same degree).

As  well  as  being  able  to  modify  the  gain  parameters  before  redirecting  them,  Router  can
also apply the functions Mute and Pan.
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Setup

In this tab, the following audio configuration options are seen.

Sample Rate

These buttons allow a new value of frequency of the audio  clip  to  be  assigned,  also
permitting the creation of a personalized value. DVS video boards only support  48Khz
formats,  so  another  sample  rate  can  only  be  selected  is  mConfig->VideoIO-
>UseeVideoBoard is inactive.

File

Allows  the  application of  changes  (Apply),  saving  (Save)  of  changes  made  to  Audio
configuration. 

Previous values can be loaded (Load), as  can default  values  (Get  Default),  and  new
defaults saved (Set Default).

Audio Channel Number

Its main function  is to define the number of input (Input Audio Channels) and output  (
Output Audio Channels) channels to be used.  The Output  Audio Channels button also
defines the number of channels to be created when rendering audio. For example, if  it
is  set  at  8  while  only  2  audio  tracks  are  present,  the  resulting  render will  be  a  clip
whose first 2 tracks contain the sound of the clip and the other 6 will be created, but
with no value.

DVS CentaurusII and Atomix cards have 8 AES/EBU channels or audio embedded in the
SDI signal.  When no  video  board  is  available,  only  two  channels  are  available  (line
connectors from the motherboard of the computer).

Note: If a DVS audio card is available it  will always be sent  exclusively to this, since
this is of much higher quality and it is necessary to synchronize the sound and image.
However, for special situations, it  may be possible  to  force  the  use  of  the  audio  of
the motherboard despite a DVS video board being available, including the following line
in the file .cshrc (doing logout/login afterwards). 

setenv USE_PC_AUDIO 1
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Defeat Audio Processing

When activated, this function overrides any Mistika process regarding the audio of the
project. Formats such as Dolby E can only be captured and reproduced in the Mistika
environment  if  this option is activated. (Mistika cannot  codify or decodify them, they
can be captured and transferred transparently.)

Tools

This tab contains tools for creating a new audio file by  modifying  its  frequency  and  speed
parameters and and for creating a audio file for each channel contained.

Note:  This  only  works  with  audio  clips  derived  from individual audio  files,  not  from mixed
clips with embedded audio.

Change Audio Ratio:

The  Change  Audio  Ratio  function allows  the  creation of  a  new  audio  file  with  a  different
frequency from the original file.

Dest Name

Field  for naming   the  new  file  to  be  created.  The  extension  .aiff  (or  .AIFF)  can  be
specified. If not specified, Mistika adds the extension .wav.

Ratio Dest

[48000 (32000/44100/48000)]

Tab that sets the frequency of the new clip to be created.

Change Ratio

Processes the selected clip and creates the  new  audio  file  using  the  origin  folder as
the target folder.
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Change Audio Speed:

The Change Audio  Speed  function allows  the  creation of  a  new  audio  file  with  a  different
speed from the original file.

Dest Name

Field  for naming   the  new  file  to  be  created.  The  extension  .aiff  (or  .AIFF)  can  be
specified. If not specified, Mistika adds the extension .wav.

Get Video Duration

Takes  the  duration  of  the   video  clip.  The  right-hand  field  shows  the  duration  in
frames; this can be edited or redefined directly.

Set Audio Duration

Creates  the  new  audio  file  with  the  specified  length.  The  target  folder  will  be  the
origin folder of the original audio.

Split Audio Channels:

The Split  Audio Channels function allows the creation of a  new  audio  file  for each channel
contained in the original file.

Dest Base Name

Field for giving a base name the new files to  be  created.  If  nothing  is  specified,  the
original file name will be used.

Split Channels

Creates one audio file per channel, naming them according to the base name and the
standard 5.1, although it  is possible to create audio files with clips with fewer than 6
channels.

Note: For example, an audio file with 6 channels called test.wav will generate 6 audio
files in the same folder as the original with the following names:

Channel 1 -> Ltest.wav

Channel 2 -> Rtest.wav

Channel 3 -> Ctest.wav

Channel 4 -> LFEtest.wav

Channel 5 -> LStest.wav

Channel 6 -> RStest.wav
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Change Audio Bitrate:

The function Change Audio Bitrate allows the creation of  a  new  audio  file  with  a  different
bitrate from the original file.

Dest Base Name

Field for naming the new new file to be created. The extension can be specified as  .
aiff (or .AIFF). If nothign is specified, Mistika creates a .wav.

Status:

Indicates the Mistika's state  in  terms  of  audio  operation,  indicating  READY  no  audio  file  is
being and  PROCESSING while a new file with specified parameters is being created.

Cancel

Cancels the task being performed on the audio file at that moment.

Optimizing volume for best audio quality

The sequence of audio production usually means that  material passes through several audio
interfaces, each one with its corresponding volume or gain controls. If an abnormally high or
low volume is encountered, the interface causing the problem must be found, and the sound
must not be adjusted using the audio controls that are closet to hand.

For example, and audio track might come out of a VTR, pass through a sound desk, arrive at
a Mistika workstation, and then be controlled  by  Mistika's  audio  Mixer.  Once  processed,  it
may then go on a similar journey via the same  or different  interfaces.  This  does  not  even
take into account the treatment the sound may have received before arriving at  this stage
of the process. 

So, if digital (or at least balanced) signal is not  available for the whole of the audio's route,
the  minimum requisite  is  that  all  gain  and  volume  controls  of  the  interfaces  are  set  at
optimum levels,  but  neither  very  high  nor  very  low.  Setting  a  high  level  in  the  current
interface does not  compensate for a low level in the previous interface, so both should  be
kept  at  optimum levels. Both cases might  produce  a  similar volume,  but  the  first  case  will
result in loss of audio resolution, and noise will have increased. 

The audio panel contains a series of VU meters, and efforts should be made to see that  the
highest levels are only reached in peaks of sound, and that they enter the red zone as little
as possible to avoid audio saturation. The same process should be applied to the other VU
meters in the other audio systems involved.

As  well  as  the  audio  tools  included  in  the  system,  remember  that  other  systems  with
specialized audio  processing  tools  can be  connected  to  create  a  collaborative  a  network,
since Mistika uses standard references to audio files found in any open file system and can
be shared with no difficulty.
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Output

Ref. Mistika: Node Graph Editor->Dashboard->Output

The Output tab gives control of the output modes (delivery) of the Mistika project.

This tab is divided into five groups: Render, Export EDL, Export EDL2, DCP and  Totem.

The commands of the group Render allow the processing of a selected item selected (a clip,
group or effect) or a complete area of the Node Graph located between the Edit Marks. It is
also used to obtain clips in Mistika native format (.js) derived from clips with source material
in others formats (tga, tiff,  cineon, etc.) and vice versa.

The Export EDL tab contains commands for the export of EDL files.

The Export EDL 2 tab performs a function similar to Export  EDL; however, the differ in their
capabilities.

The group DCP contains the fields necessary for preparing export  in Digital Cinema Package
format.

Totem provides control over the "cluster render" equipment (Totem) for distributed render.

Render

From this  tab,  the  Render  scripts  (files  with  extension .rnd)  and  process  instructions  are
created  that  can be  run immediately  or  left  for  later  use,  and  that  when  processed  will
create clips with new media. These new clips will always be placed in the RENDER folder of
the current project. 

Many of Mistika’s effects can be evaluated by the active monitor in real-time,  without  the
need to store the result of its evaluation on disk. 

However,  many  very  complex processes,  or even the  accumulation  of  many  simple  ones,
cannot be evaluated in real-time by the monitor. 

In  this  case,  it  is  better  to  create  a  new  clip  that  has  media  with  the  result  of  this
evaluation and read the result  of  a  processed  flow  directly  from disk.  The  procedure  that
generates this new media file is called a Render process. 

A render process is also required in order to export  to  certain  file  formats  that  have  been
requested.
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Mistika’s  render,  besides  being  able  to  create  new  media,  automatically  stores  the  orders
used  for  its  creation.  These  orders  are  called  Render  Scripts,  and  have  an  identical
structure  to  a  group  of  clips.  Mistika’s  scripts  are  stored  with  the  .rnd  extension,  in  the
DATA/RENDER folder of the current project, together with the clips generated by the render
of these scripts. 

Both render scripts (.rnd) and generated clips (.clp) are stored in independent  folders within
the RENDER directory of the current  project. In the case that  these files are generated via
the Split To Segments mode, all the clips generated from the multiple selections are stored
in the same folder.

Newly-generated   clips  inherit  the  timecode  selected  in  Split  To  Segments  options.
Furthermore, new clips will have the name of the render file and will be stored in the same
RENDER  folder,  with  the  .clp  extension  (note  that  what  is  stored  is  the  .clp  with  its
metadata and not media files in themselves, since these are stored in destinations specified
in Mistika Setup (Mistika Setup->File Paths).

To defines the segment of the Node Graph to be processed, there are two options:

Selecting the clip  to  be  processed.  If  the  selected  clip  is  the  last  clip  of  an
effects flow, the result  of the flow in the whole  duration of  the  selected  clip
will be processed. If the selected clip is a group, all the contents of  the  flow
within it will be evaluated. 

Note:  It  is  not  possible  to  process  a  multiple  selection  directly,  although  in
this  case  the  render  process  offers  the  option  of  putting  editing  marks  to
group the whole entire selection automatically. 

Defining  a  range  of  the  Node  Graph  with  the  editing  marks.  This  method
specifies  the  render of  several flows  at  the  same  time  without  the  need  to
group them first. 

Note: If there are editing marks in the Node Graph and at  the same time clips
that  are  selected,  Mistika  will  not  know  which of  the  two  methods  is  to  be
used, in which case a dialog box will ask for this to be selected. 

Channels:

Image

Activates the evaluation and storage of the image track for the created clip (channels
RGB or YUV). If off, only audio render will be possible.

Audio

Activates the storage in a new audio media the result  of the mix of the  audio  tracks
included in the render. 

In this case, the clip generated will have in its data details the resulting audio tracks,
just as they are evaluated when using active monitor.

Note:  the  number of  audio  tracks  will  correspond  to  the  audio  output  configuration
defined  in  Output  Audio  Channels  (Node  Graph  Editor->Dashboard->Audio-
>Setup->Audio Channel Number->Output Audio Channels).

The new audio media created will be stored:

in the directory defined in Mistika  Setup  with  extension .aiff,  if  the  Audio  In
Movie button is off; 
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within the image media file itself as an associated audio stream, if  the button
Audio In Movie is on (except for .mxf, files, as explained in the following section).

Audio In Movie

This causes the audio to be stored within the clip instead of  separately.  This  is  only
available for Movie family formats. 

To maintain compatibility of  files,  the  configuration value  must  be  present  in  Output
Audio Channels (Node Graph Editor->Dashboard->Audio->Setup->Audio Channel
Number->Output  Audio  Channels)  since  many  applications  can  only  read  files
Movie type files with two audio channels.

In the specific  case of Flash .flv format, it  is necessary to define the sample  rate  at
44Khz in the Audio->Setup panel. To  do  so,  deactivate   MistikaSetup->VideoIO-
>UseVideoBoard

Not all Movie formats support audio.

Mistika supports audio embedded for Quicktime.

Media in MXF format generated by Mistika are stored in order to maintain compatibility
with Editing systems. When exporting in this format, an MXF image file is created with
timecode on one side, and both MXF audio files and tracks that  have been configured
by  another and  stored  in  the  same  render destination.  As  MXF  audio  files  have  the
same identifier at their head as the MXF image files, when loaded in an Editing system,
they should be related.

Audio With Movie

Causes  the  audio  to  be  stored  in  the  same  directory  as  the  image  clip,  but  in  a
separate .aiff file. This is only available for formats in the Movie family format. 

Full Res Image:

Specifies the high resolution image format for the media of the new clip generated. 

These  image  formats  are  divided  into  three  families,  with  the  additional  option  of  not
selecting any of them:

Mistika

Mistika's  .js  format  is  an  especially  designed  image  format  for  working  without
compression and in real time. Its use is similar to that  of Movie-type files, but  as well
as  greater  speed,  it  allows  high-quality  formats  (RGB  10bit)  and  stereo  pairs
(2xYUV422) which is not possible with traditional formats like Movie.

The file formats are selected via the dropdown button Format:

YUV  (4:2:2)  in  8  bits  (YUV422  8b),  as  well  as  it  double  stream variant  (if
Stereo3D is active)

YUV (4:2:2)  in  10 bits  (YUV422 10b),  as  well  as  it  double  stream variant  (if
Stereo3D is active)

RGB (4:4:4) in 8 bits (RGB  8b)

RGB (4:4:4) in 10 bits (RGB  10b)
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RGB (4:4:4:4) in 8 bits with alpha channel ((RGBA  8b)

Note:  Some  other  formats  are  also  quick,  but  if  we  do  not  need  to  maintain
compatibility  with  other applications  it  is  recommendable  to  use  Mistika's  .js  format,
since: 

In  Mistika's  .js  format,  data  is  aligned  with  memory  pages  and  can  be
transferred quickly via the system buses.

This format is also preassigned in consecutive disk blocks, which also improves
performance and avoids fragmentation of the disks.

In the case of needing similar speed but with a format  that  is more compatible
with other systems, use DPX,  since  this  format  can offer similar performance
to Mistika if and when it is used with a “SNFS” type filesystem and that care is
taken not to write other sequences while renders are being done (simultaneous
copying processes should not  be carried out, but  this is  not  a  problem is  the
render is to .js format).

For more information  on the variations of this format  (YUV, RGB, etc) see the section
on color spaces in the chapter Basic Concepts.

The dropdown Target  allows the selection of the directory where the files are saved,
with the defined destinations shown in Mistika Setup->File Paths.

The  option Default.Mistika_Media  establishes  that  material  created  will  be  stored  in
MATERIAL/Mistika_MEDIA/[project[]/Mistika_JS/. This default  value can be  modified  in
Mistika Setup (Mistika Setup->File Paths-).

Movie

Movie type files are sequences  of  images  stored  in  a  single  .file  which could  include
audio and timecodes (in the case of .mov and.mxf files). 

The formats of Movie files supported for writing are selected via the dropdown Format
:

AVI RGB Uncompressed 10 Bit (Avi RGB)

AVI RGB Uncompressed 10 Bit with alpha channel (Avi RGBA)

AVI DV25 (Avi DV25)

AVI DVCPRO50 (Avi DV50)

AVI UYVY Uncompressed (Avi UYVY )

AVI MPEG-1 (AVI Mpeg1)

AVI MPEG-2 (AVI Mpeg2)

AVI MPEG-4 (AVI Mpeg4)

AVI Custom Settings (Avi Custom)

MPEG Transport Stream Custom Settings (MPEG .ts Custom)

Quicktime RGB Uncompressed 10 Bit (Mov RGB)

Quicktime UYVY Uncompressed (Mov UYVY )

Quicktime DV25 (Mov DV25)

Quicktime MPEG-4 (Mov Mpeg4)
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Quicktime Prores 444 with Alpha

Quicktime Prores Proxy 

Quicktime Prores LT

Quicktime ProRes

Quicktime ProRes HQ

Quicktime ProRes 444

Flash Video Custom Settings (FLV Custom)

Quicktime Custom Settings (Mov Custom)

MXF Custom Settings (MXF Custom)

MXF VC-3 Low Resolution

MXF VC-3 Hi Resolution

XAVC (especially recommended for UHD)

This type of format  is  constantly  being  developed  so  it  is  possible  that  the  list  may
have changed since the publication of this document; please see "Release  Notes" for
the latest updates.

Note:  Mistika  supports  writing  timecode  and  audio  both  in  the  format  MXF  and  in
Quicktime.

To  specify  personalized  configurations  (Custom Settings)  edit  the  file  Movie.dev  in
Mistika-ENV/etc/devices/Movie.dev.

Remember that most Movie type formats imply compression and loss of quality (except
those marked Uncompressed),  so  they  should  not  be  used  for later post-production
processes.

The dropdown Target allows the selection of the directory where the files are saved.

The  option Default.Mistika_Media  establishes  that  material  created  will  be  stored  in
MATERIAL/Mistika_MEDIA/[project[]/MOVIES/.  This  default  value  can  be  modified  in
Mistika Setup (Mistika Setup->File Paths).

Images

This type of file provides numerically ordered image sequences. 

The formats of image files supported for writing are selected via dropdown Format:

DPX RGB 10b

DPX RGB 8b

DPX RGBA 8b

Cineon RGB 10b

J2K  2k@24 RGB 12b

J2K  2k@24S RGB 12b

J2K  2k@48 RGB 12b

J2K  2k@48S RGB 12b
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J2K  2k@60 RGB 12b

J2K  2k@60S RGB 12b

J2K  4k@24 RGB 12b

J2K  RGB 12b

TIFF RGB 8b

TIFF RGBA 8b

TIFF RGB 16b

TIFF RGBA 16b

TGA raw RGB 8b

TGA raw RGBA 8b

TGA rle RGB 8b

TGA rle RGBA 8b

SGI RGB 8b

SGI RGBA 8b

JFIF(jpg) RGB 8b

BMP(win) RGB 8b

BMP(win) RGBA 8b

PNG RGB 8b

PNG RGBA 8b

Photoshop RGB 8b

Photoshop RGBA 8b

Alias pix RGB 8b

GIF RGB 8b

SoftImage RGB 8b

SoftImage RGBA 8b

RAW YUV422  8b

EXR RGB Half

EXR RGBA Half

Note: Mistika can read many other numbered formats not  cited in this list, which only
refers to the supported formats for writing in a render.

The dropdown Target allows the selection of the directory where the files are saved.

The  option Default.Mistika_Media  establishes  that  material  created  will  be  stored  in
MATERIAL/Mistika_MEDIA/[project[]/SEQUENCES/. This default value can be modified in
 Mistika Setup (Mistika Setup->File Paths-).
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None

This  button prevents  the  render of  the  high  resolution  version.  It  will  only  process
proxy resolution and/or audio. 

Regardless  of  the  chosen  format,  the  dropdown  Target  allows  the  selection  of  different
directories for saving generated media.

These files should be previously defined in Mistika Setup, via Path Builder  (Mistika  Setup-
>File  Paths).  For  more  information  about   how  to  create  buttons,  see  the  chapter  on
Mistika Setup (mConfig). 

Video_Setup:

To access these audio configuration panel we must use the wheel button next  to the Video
button.

The  renders  that  we  are  about  to  generate  will  be  saved  in  the  path  that  we  have
previously created  in  the  mConfig  by  default;  nevertheless,  we  can change  the  rendering
route in this window.The drop-down “Target” button allows selecting different  directories to
save  the  video  media  that  will  be  generated  by  exporting  it.These  folder  needs  to  be
defined previously in Mistika Setup via Path Builder  (Mistika Setup->File Paths). To learn
more about the buttons creation take a look at the chapter Mistika Setup (mConfig).  

User defined

It allows navigating through the computer’s folders to select a path.

DEFAULT.Rendername

The  rendering  path that  will  be  used  is  the  one  that  was  previously  created  in  the
mConfig or was configured in the Path Builder. Render name can be created in the box
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“Render name”.

DEFAULT.Tapename

The rendering path that will be used is the one that  was previously established in the
mConfig or configured in the Path Builder. Render will use the Tapename of the media.

NOTE: we can choose between different render paths for video and audio, as long as
we do not render the Audio in movie option.

During the render process, Mistika allows the creation of superimposed metadata information
 (Virtual Slate) that can be used as reference in other post-production processes.

When Burnon Virt.  Slate  is  activated,  the  fields  that  specify  the  information  that  will  be
seen superimposed on the image are activated.

The  information  superimposed  on  the  image  is  specified  in  the  file  Mistika-ENV/shared/
VirtualSlate/Layouts.xml and can be edited by the user in order to change its position  and
appearance to include/exclude specific metadata fields.

Slate 1 / Slate 2

Clip_w_TC. The information superimposed corresponds to the name of the clip and and
current timecode.

TC_Only. The information superimposed corresponds only to the current timecode.

During

First frame. The information only appears in the first frame of the sequence.

First 5 frames. The information only appears in the first five frames of the sequence.

All frames. The information appears in the whole sequence.

Stereo 3D Mode

This  dropdown button allows  definition  of  which  type  stereoscopic  clip  will  be  processed
according to the viewing mode.

No Stereo 3D

The resulting processed clip will not be stereoscopic.

Left Eye Only

The  resulting  processed  clip  will  correspond  to  the  image  to  be  interpreted  by  the
viewer's left eye.

Right Eye Only

The  resulting  processed  clip  will  correspond  to  the  image  to  be  interpreted  by  the
viewer's right eye.
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Dual YUV422

The result  will  be  a  single  clip  whose  content  will  correspond  to  a  stereoscopic  pair
(left  and right  eye). This format  allows render to be done for both eyes at  the  same
time, and also optimizes the storage to disk, as both eyes  are  stored  in  consecutive
blocks  (as  they  will  later be  read).  This  requires  Mistika  .js  YUV422  archives  to  be
selected as render format.

Anaglyph

The  resulting  processed  clip  will  correspond  to  the  viewing  mode  for  color  anaglyph
glasses, red for the left eye and cyan for the right eye.

Line Interlaced

The  information from the  stereoscopic  pair will  be  shared  in  interlaced  vertical  lines
within the same frame. 

Note:  Do  not  confuse  the  term  Line  Interlaced  with  Field  Interlaced.  The  Line
Interlaced process can be applied to a clip with interlaced fields as well as to an un-
interlaced one.

Side By Side

The resulting processed clip  will  correspond  to  the  viewing  mode  that  scales  to  half
the resolution of the stereoscopic pair, to locate both images side by side.

Note: Many devices recognize this mode, in order be activated automatically by their
own system.

.rnd With Media

Stores  a  copy  of  the  render script  generated  in  the  same  directory  as  the  original
media. This makes possible conforming  processes  in  other Mistika  systems  at  a  later
time,  since  this  way  the  work  and  processes  applied  are  stored  together  with  the
original  media,  and  do  not  depend  on  the  project.  Thus,  when  arriving  at  a  new
system all  the  media  can be  directly  linked  and  conformed  against  the  .rnd  scripts
(note:  effects  which  require  additional  files  (Morph,  Paint,  Title)  also  require  the
project to be available, since they store additional data in the PRIVATE folder). 

For more details about the use of this button, consult Example of a global workflow.

Export to Nuke: .nk With Media

Allows the exporting of basic  geometric  corrections  (in  the  folder Balance  Geometry,
modified with the tool Match Geometry) of the Stereo3D effect  carried out  on stereo
images as the equivalent set of nodes for Nuke, that  can be opened without  difficulty
and modified using that software.

Progressive

Activates the processing in progressive sweep format (render by frames).

This option must be activated if the resulting clip is to be used in progressive formats
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such  as  HD24p,  cine  formats  or  multimedia  formats  for  viewing  in  RGB  graphics
monitors .

Interlaced

Activates  render  in  interlaced  sweep  format  (render  by  fields).  This  option  is
recommended for processing  images  that  come  from interlaced  video  formats  (PAL/
NTSC 1080_25i, 1080_30i, etc). 

It  is  also  possible  to  evaluate  processes  that  evolve  by  fields  on  clips  that  non-
interlaced  clips  (such as  type-face  movement,  to  enable  their  reading  on  video),  if
and when the final viewing mode is a monitor or interlaced.

This mode should not be used unnecessarily, as render times reach nearly double that
of when it is deactivated. 

In any case, render by fields should only be used if  the result  is to be transferred  to
video in an interlaced format, whether the original clips are interlaced or not

Pulldown  allows  two-directional  conversion  between  video  clips  interlaced  at  30fps  or
29.97fps and cine or HD format clips at 24p (24fps progressive or 23.97fps progressive).

Note: In order to simplify the explanation,  on occasions  reference  is  made  to  "NTSC" and
"cine", although the same is applicable to other formats of similar structure in terms of frame
rate and interlaced / progressive format).

Sequences derived from standard  cine  and  HD 24p  formats  have  24 frames  per second  in
progressive (not interlaced). To convert  them to PAL (or HD 25fps) formats no modification
is  usually  made  in  the  duration,  since  24fps  is  a  very  similar  value  to  the  25  frames  per
second of PAL video signal and normally there is no perceptible change playing them back a
frame per second quicker.

In these cases, it is usually enough to apply a de-interlace effect to convert  them from PAL
to cine or from interlaced to convert them from cine to PAL, and similarly the corresponding
audio  conversions.  For more  information  about  the  interlace/de-interlace  effects,  consult
the information about the Fields group of effects ( Node Graph Editor->Dashboard->Fx-
>Mistika->Fields).

However, the formats NTSC and  HD60i,  for example,  use  30 interlaced  frames  per second
(and so 60 fields per second).

If a cine sequence (24fps) needs to be converted to NTSC, this sequence at  24fps must  be
stretched to last 6 frames more per second (30 frames in total). This cannot simply be done
by repeating some frames, as it  will be too visually obvious. This conversion is usually done
via a process called "3:2 Pulldown". 

The "pulldown" consists of dividing each original progressive frame into two fields (one with
odd-numbered  lines  and  one  with  even-numbered  lines)  in  order  to  obtain  48  fields  per
second  (2x24fps).  These  resulting  48  fields  need  to  cover  the  60  fields  per  second
corresponding to an NTSC second. This is done by repeating a field when necessary (first  at
three frames, that  two frames later, then after three frames again,  and  so  on,  alternating
the field that  is repeated between odd and even, from which process the names "3:2" and
"2:3" come.)

This system achieves an acceptable visual effect  for playback, but  must  be applied at  the
end of the post-production, otherwise the material that  undergoes this process  can cause
problems in editing and post production:

When a 3:2 Pulldown is carried out, NTSC or HD_30i frames may be generated
in which each field pertains to a different  original frame,  and  if  this  coincides
with  a  change  of  shot  (which  should  be  always  avoided,  although  material
received is not  always  as  may  be  desired)  there  will  then be  two  fields  with
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very different information in the same frame, which will produce an undesirable
flash effect  when viewed. This can also occur if  an offline edit  is to  be  made
for later editing of a film reel, since if  we have material that  has undergone a
3:2 Pulldown process,  the  cut  points  may  be  ambiguous  in  the  frames  that
have one field of each shot. Another problem related to the same case is when
applying effects, since in those  frames  with  fields  of  different  shots  it  is  not
normally desirable to apply the same effect to both fields. 

The quality of effects can suffer, since the original images do not  have fields,
and if a 3:2 pulldown process has been applied and the clip is marked as being
interlaced, Mistika is forced to work with fields when it  should be working with
frames. 

In addition, render times with the frame process are twice as fast  as with the
field process. 

If  there  are  several  clips  that  have  undergone  a  3:2  pulldown  process  and
they have to be combined in the same effect, there is a risk of their becoming
desynchronized, ie, that  they are placed in such a way that  the  fields  added
to each of these clips do not coincide in time. 

For all of this, it  is best  to apply the option Pulldown Remove before working with NTSC or
HD60i material  that  derives  from a  telecine,  or that  has  undergone  a  3:2  Pulldown.  It  is
recommended to carry out  this conversion even it  is required that  the material is  delivered
at 30fps (and to a carry out this process again as a last step). 

On  the  other  hand,  if  a  3:2  Pulldown  has  been  undone,  we  can  obtain  more  faithful
playbacks by changing the playback speed to 24 fps. This can be modified via Mistika Setup
selecting  24fps  format  (Mistika  Setup->General->Standard  Preset)  and  observing
playback in an un-interlaced monitor.

While the clip is not modified or edited, the 3:2 Pulldown process is 100% reversible via the
button Pulldown Remove (equivalent to the 2:3 Pulldown process). 

Render 3:2 Pulldown Mode defines the Pulldown and field discrimination.

Pulldown Insert

Carries  out  a  3:2 Pulldown to  a  cine  clip,  adding  fields  to  the  sequence  so  that  it
coincides with the duration that it must have in NTSC.

Pulldown Remove

Carries  out  the  reverse  process  to  an  NTSC  clip,  eliminating  the  fields  that  were
inserted during a prior 3:2 Pulldown.

To eliminate the Pulldown correctly, it  is necessary to locate the active monitor mark
active in the first frame without fields that the sequence has. 

Only Even Frames

For the creation of the new clip, only even-numbered images will be considered. Thus
the resulting new clip will have half the duration of the one processed.

Only Odd Frames

For the creation of the new clip, only odd-numbered images will  be  considered.  Thus
the resulting new clip will have half the duration of the one processed.
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Processing only alternate frames may be done for various reasons:

One is to create versions of clips at half the frame rate, to be used in high-speed cameras.
For example, we can work with masters at 48fps and produce versions a at  24fps for offline
systems. These cases are detected by Mistika when conforming, so the EDL can be done at
half the speed, to be able to work in the offline system in standard formats. 

Another use may be to separate interleaved streams in a stereo clip.

If none of these buttons is active, all the frames of the clips are processed.

When  the  Active  button  is  active,  this  dropdown  menu  allows  the  configuration  of  the
output resolution via similar parameters to those of the Framing tab in Visual Editor.

This parameter is especially useful when needing to create different resolutions for deliveries
other than the resolution of the project. Thanks to this menu, it is possible to do so directly
in the Output tab without  needing to reconfigure these values, applying new effects in the
Node Graph or Visual Editor.

Mistika always produces images in the working format (mConfig->RenderFormat) before they
pass through this  output  filter,  so  generally  these  options  should  not  be  used  in  order to
increase resolution, but rather to produce smaller versions. 

For more  information on the  use  of  these  parameters,  see  the  chapter  dedicated  to  the
Framing tab.

Audio_Setup:

To access these audio configuration panel we must use the wheel button next  to the Audio
button. The wheel button only appears active if in format  for rendering we have selected is
Uncompressed Audio.

This option allows to select the files that will be generated when rendering:

As one mutichannel file

It will generate a single file that will contain all the channels to render.

Split channels in mono files

it will generate a mono file for each rendered channel.

Split channels in stereo files

It will generate a stereo file for each rendered channel.
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By default  the renders that  are about  to be generated will be saved  in  the  path that  was
previously  created  in  the  mConfig;  nevertheless,  we  can  change  rendering  route  in  this
window.  The  drop-down Target  button allows  selecting  different  directories  to  save  the
audio  media  that  will  be  generated  by  exporting  it  (only  when  we  have  selected  the
Uncompressed audio option.) 

These files must  be defined previously in Mistika Setup in the Path Builder  (Mistika Setup-
>File Paths).. To learn more about the buttons creation take a look at  the chapter Mistika
Setup (mConfig). 

User defined

It allows navigating through the computer’s folders to select a path.

DEFAULT.Rendername

The  rendering  path that  will  be  used  is  the  one  that  was  previously  created  in  the
mConfig or was configured in the Path Builder. Render name can be created in the box
“Render name”.

DEFAULT.Tapename

The rendering path that will be used is the one that  was previously established in the
mConfig or configured in the Path Builder. Render will use the Tapename of the media.

NOTE: we can choose between different  render paths for video and audio, as long as
we do not render the Audio in movie option.

Render_Presets:

The  Setup  panel  in  the  tab  Output  gives  the  user  the  option  of  saving  common  export
presets.  Clicking  in  the  first  field  shows  a  list  of  different  presets  created  (as  DEFAULT,
because as no preset will be defined).

Each  time  one  of  these  presets  is  loaded,  the  other  fields  in  the  Output  tab  will
automatically load the parameters defined in this preset.

Save

Saves the options selected  in  any  given moment  in  the  preset  defined  in  the  list  of
presets.

Save As

Saves the options selected  in  any  given moment  in  the  preset  defined  in  the  list  of
presets with the option of renaming.

Delete

Eliminates the selected preset.
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Proxy Image:

Specifies  the  low  resolution  image  format  of  the  media  for  the  proxies  of  the  new  clip
generated. 

Low resolution has the same image formats as high resolution and also the None option. The
size of the low resolution is specified in Mistika Setup->Render Format->Low Res. Ratio.

The  proxies  are  used  when RecordMonitor is  in  Proxy  or Dynamic  mode  (if  they  have  not
been created, they are done so on-the-fly in RAM during playback).

Render Segments Mode:

Segments Mode

This dropdown allows the selection of the amount  of render media or render clips that
result from clips to be processed derived from a multiple selection.

As One Segment. Specifies that all types of clips are included in a single render. 

Split To Segments. Specifies that one render is generated for each clip selected. This
command can be applied both to the image track and the audio track. In this mode, all
the clips generated from the multiple selection will be stored in the same folder.

First seg. index

Specifies the initial nominal numeric  value  nominal of  the  segment  of  clips  generated
via the Split To Segments mode.

This value allows, for example, the precise replacement  of segments of a render that
were later modified. To do so, specify the same numeric value used before, in the first
frame of the segment to be replaced.

Split To Segments options:

Tape Name Sources

Use source clip tape name

Names the clip files (.clp) or render scripts (.rnd) with the original file name.

Use source clip tape name from Header

Names the clip files (.clp) or render scripts (.rnd) with the internal file name.

Use timeline name

Names  the  clip  files  (.clp)  or  render  scripts  (.rnd)  with  the  name  defined  for  the
environment.

Use render name

Names the clip files (.clp) or render scripts (.rnd) with the name defined in the render
field User Name.
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Time Code Sources

Use source clip Time Code

Defines  the  timecode  as  the  same  as  that  of  the  original  media.  In  the  case  of
numbered sequences this will be the internal timecode.

Use source clip Time Code Aux1

Defines  the  timecode  as  that  of  TC  Aux  1  when  this  is  defined.  In  the  case  of
numbered sequences, the frame numbers are obtained by converting the timecode to
whole frame numbers according to the current fps.

Use source clip Time Code Aux2

Defines  the  timecode  as  that  of  TC Aux  2  when  this  is  defined.  This  normally  only
supports .red files.

Use timeline Time Code

Defines  the  timecode  based  on  the  TC  of  the  Node  Graph.  A  specific  case  that
requires  this  render  mode  is  that  of  the  playback  of  JPEG2000  (.rnd)  files  for  the
subsequent  production of DCP packets, since generally these  require  a  start  position
of 00:00:00:01

Preferred source clip

Auto

Takes  previous  values  deriving  from  the  file  that  has  produced  and  geometric
deformation in the effect  Stereo3D. If  none  is  specified,  the  left  is  taken default  by
default.

Preferred Left

Takes previous values deriving from the file that  corresponds to the left  image of the
stereo pair.

Preferred Right

Takes previous values deriving from the file that corresponds to the right  image of the
stereo pair.

Filter Source Clips

Filter that ignore any clip in Mistika's native format (.js). The most common use of this
option is for using the name and TC of clips imported from tapeless formats (.r3d, .ari,
etc). If the media to be processed is multilayer and contains more than one version of
the same clip (generally a clip RAW and a clip in  .js working as a proxy), by selecting
this option, Mistika will process the information of the original clip in RAW.
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Sequence Render Options:

Delete Sequence Before Render

Activates the deleting, before the render, of all the media  contained  in  the  folder to
be overwritten, although all the contained files are to be overwritten.

First Frame Index

Defines the numeric value of the first frame of the sequence of images to be rendered.

Render Name:

Specifies the render name script (.rnd), which will also be the name of the new clip (.clp).

Auto Name

The  practical  purpose  of  the  Auto  Name  button  is  to  be  able  to  launch  render
processes from the Node Graph with the same name as the previous one but  ending in
a new number to avoid the need to open the render modules to write it. This use can
makes  the  work  of  carrying  out  many  render  processes  much  easier.  It  also  helps
avoid errors of overwriting files.

When the  Auto  Name  button  is  active,  two  boxes  are  enabled:  a  text  field  and  a
numerical field.

text field 

In this box, the name of the render script is defined.

numerical field

This field is increased by  one  with  each render process  with  the  same  name  that  is
done.  Thus,  it  automatically  avoids  the  problem of  the  names  of  successive  render
processes coinciding, which would produce jumps in the numerical sequence.

User Name

When this  button is  active,  a  text  field  is  enabled  in  which the  name  of  the  render
script can be defined manually by the user.

This command also offers another practical use: replacing the previous render of a clip
by carrying out another with the same name. To do so, select a clip or group from the
 Node  Graph  and  run  the  Get  Clip  Name  command  to  copy  the  name  of  the  clip
selected in the User Name text field.

This command also has another practical use: the substitution of the previous render
of  a  clip  when  a  new  one  with  same  name  is  produced.  When  a  clip  or  group  is
selected from Node Graph, the name is copied in the User Name text field.

Via this tool, it  is possible to run the processing of  a  sequence  time  and  time  again,
overwriting the previous render, thus avoiding accumulation of multiple versions in disk
space. The new render maintains the name and replaces the previous one in the same
the disk space.
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Also,  errors  when writing  names  are  thus  avoided.  It  is  common that  a  user has  to
produce  successive  versions  of  a  clip  that  is  being  used  in  another  Node  Graph  by
another user. For the render of each new version to be updated automatically in  the
second Node Graph it is essential that they have exactly the same name, so that  this
tool can make the process easier and help avoid errors.

Note: Mistika allows to clips to be overwritten, updating all the instances of their media in
the Node Graph by overwriting them. If a name of clip already used is specified,  a  window
will open with an overwriting warning. In these cases take care never to use a name that  is
also that  of a clip  necessary  for the  render,  since  Mistika  will  destroy  it  media  file  before
starting the new render processes. 

Do Render:

Foreground

Creates the render script  (.rnd) and the resulting new clip, staring the render task in
the Foreground. 

The  new  clip  is  created  as  a  file  .clp  in  the  RENDER,folder  and,  depending  on  the
format,a copy of the clip will be placed  in  the  Node  Graph,  in  the  range  or selected
clip from which it was generated. 

The  render in  the  Foreground  is  run at  high priority,  and  practically  all  interactivity
with the interface is inhibited until the render process is ended, using all  the  existing
resources and finishing the process in the minimum time. 

Foreground rendering also has the advantage  that  the  images  being  created  can be
seen  in  a  window  (if  the  option  Mistika  Setup->Render  Options->Render  To
Graphics is activated).

Background

Creates the render script (.rnd) and the resulting new clip, and starts the render task
in the Background. 

The  new  clip  is  created  as  a  file  clp  in  the  RENDER  folder  and,  depending  on  the
format, a copy of the clip will be placed in the Node Graph, in the  range  or selected
clip from which it was generated. 

The render in the Background  is  run at  low  priority,  and  a  high level of  interactivity
can be maintained, which permits users to  continue  working  with  the  interface  while
the render is calculated in the background. 

Write Script Only

Creates  and  saves  the  render  script  (.rnd)  but  without  creating  the  new  clip  or
starting the render process. 

Note: this script can be run later from a command line (see explanation below) or from
another workstation.  However,  remember that  all  the  format  and  target  parameters
defined when creating the script  will be used, not  those specified at  the start  of the
render.

Render scripts  can also  be  opened  as  if  they  were  normal environments,  since  they
contain the same information as well as the render parameters. In fact, this can serve



250 The Interface

SGO Mistika 8.6 © 2018 SGO

as a last resource if the original environment  has been lost  due to errors when saving
or a system crash. 

Redo Proxy

Reevaluates  the  proxies  of  the  selected  image.  This  function allows  the  creation  of
new proxies in order to select multiple image clips.

Note: It may be the case that  an image clip possesses media for its proxy resolution
that  does  not  correspond  to  its  high-res  media,  owing,  for  example,  to  only
overwriting the high-res with a new render, or by changing the proxy size from Mistika
Setup. This function allows the user to refresh the proxy resolution. 

Remember  that  Mistika  allows  the  capture  of  images  without  generating  low  res
proxies  ad  hoc  (this  is  optional),  in  which  case,  the  user  can  generate   then
subsequently using this option. Generating these proxies helps  playbacks  of  effect  in
low  res  (although more  disk space  is  used),  and  if  these  proxies  do  not  exist,  they
need to be created ad hoc during playbacks in this mode, which may slow them down
significantly, especially when they are large images, such as  those  derived  from cine
or HDTV formats. 

It  is  also  convenient  to  generate  them  when  storage  is  shared  with  other
workstations,  in  order not  to  produce  excessive  and  unnecessary  traffic.  It  is  also
possible to defines a disk with a different  target  to that  which contains the high res.
images  in order to store the proxies via Mistika Setup (Mistika  Setup->File  Paths-
>File  Paths->Sequence  Proxies  Dir),  for example  to  defines  a  local disk local  for
them and thus not  interfere with other stations that  need to read high res  images  in
real time.

In the same workstation, one Foreground render and another in  the  Background  can
simultaneously be run, but no more. 

In  any  case,  bear in  mind  that  render processes  consume  a  great  deal  of  graphics
card  resources   (if  Mistika  Setup->Render  Options->Performance  Options-
>Hardware Rendering is activated, which is the most  common), and if  use of these
resources  reaches  capacity,  incorrect  images   may  be  produced,  or  even  stopped.
Extremely complex cases for the hardware being used can cause problems (shown as
black or strange images, or even the original images with no changes at  all), in which
case the following measures are recommended:

Reduce  to  minimum (1)  the  value  of  Render  Units  in  Mistika  Setup  (Mistika
Setup->Render Options->Performance Options->Render Units).

If this is not sufficient, exit Mistika and run the render from a command line, as
explained below. 

If this still does not  resolve the problem, it  is  probable  that  the  system does
not  have  an Nvidia  graphics  card  with  sufficient  memory,  so  the   Hardware
Rendering  mode  in  Mistika  Setup  (Mistika  Setup->Render  Options-
>Performance Options->Hardware Rendering) should be deactivated.

The render process opens a progress window that is described below:
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Priority

Process priority, which can be Foreground or Background. 

Name

Name of the generated clip.

Length

Total number of frames to be processed. 

Done

Percentage of the current process completed. 

Elapsed

Time elapsed since the start of the process.

Remaining

Estimated time remaining to finish the process. 

Note: this time is estimated in proportions of the elapsed time, so that  the estimated
time may be incorrect if the process varies in complexity. 
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Progress Bar

Indicates graphically the percentage  of  the  current  process  completed  in  relation to
the total number of frames to be processed. 

Cancel

Button to stop the render process.

Note:  this  button stops  the  render,  but  does  not  remove  the  clip  that  was  being
produced, in case it is required. The media of the new clip will be viewed correctly up
to the frame where the render was canceled. However, for formats .js or "movie" the
clip  will  occupy  the  same  amount  of  space  as  if  it  were  complete.  If  this  occupies
more space than is desirable, run another render to extract  the useful part  and delete
the original.

Script to run after the render:

This dropdown button is the option that provides Mistika the possibility at  the end of render
to execute the previously configured script.

The  idea  is  to  provide  users  with  the  means  to  detect  the  conclusion of  render,  with  no
need for their physical presence, since they are informed that render has finished, or equally
to  be  able  to  run other tasks  that  are  pending  its  conclusion (some  examples  of  use  are
given later). 

The  configuration  is  simple.  First  add  into  the  file:  $HOME/Mistika-ENV/etc/setup/
RenderEndScript.cfg

the names of the scripts to be sent when the render has finished.

Then the script itself must be in the directory: $HOME/Mistika-ENV/bin/scripts

The script must have run permission.

To run a specific script at the end of a capture session, simply select  it  from the dropdown
that shows the names of the configured scripts.

When  the  render  is  finished,  it  will  automatically  name  the  script,  with  two  parameters
[Status] and [Name], that have been specified for use.

Below are described some of the scripts that are provided with the software. As well as the
function they have, they also serve as examples for users with programming know-how. 

mail_After

A  simple  tool that  sends  a  mail  to  the  user when the  render has  finished,  informing
them of the result.  The email address is configures in Mistika Setup (Mistika Setup-
>Utils->After Scripts Data->After script mail addr.).

matchOrigStruct_after

Modifies  the  directory  structure  and  names  of  the  files  produced  by  the  render  to
mimic  the structure of  the  original directories   and  the  names  and  numbering  of  the
original files.  This is only useful for render processes  to  numbered  formats  (typically
to DPX).

The  main  use  for  this  tool  is  to  allow  the  integration  with  other  applications  or
workflows. This way, Mistika can be used to process the images from a directory tree
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and  obtain  an  identical  tree,  so  that  other  applications  or  workflows  can  continue
working in a transparent manner with the new tree, without causing interference.

From  this  point  on,  the  depth  of  directories  also  defined  Mistika  Setup  (Mistika
Setup->Utils->After Scripts Data->matchOrigStruct nodes) will be replicated.

Render  mode  Segments  By  TC  must  also  be  activated,  since  if  not,  only  one  clip
without timecodes can be obtained.

It  is recommendable that  both the  original structure  and  the  new  files  generated  by
the render process share the same disk. If not, the script  need to move the rendered
files physically to the others disks, with the consequent additional processing time.

Flush Mistika Image Cache:

Mistika keeps a cache in RAM with the last  images read from disk, to avoid having  to  read
them again if  they are needed. However, occasionally it  might  be desirable to Flush Mistika
Image Cache to force Mistake to read them again.

For example, during a background render, the clip that  is being rendered can be worked on,
although the process has not finished. However, if the monitor is passed over areas that are
still not calculated, incorrect frames can remain in the cache when trying to view it  and this
button must be clicked to refresh them. 

In general, if the media of clips that are being used in the Node Graph is externally modified,
it  may be necessary to use Flush Mistika Image Cache to refresh the changes. This is  the
case, for example, if  the media of  a  clip  is  modified  from another Mistika  workstation with
shared storage, or if  the  .tga  files  referenced  by  a  remote  clip  are  modified  from another
application. 

Syntax for render script definition:

Within  the  text  field  of  the  command User Name  it  is  possible  to  define  more  specifically
certain variables when processing a clip or group.

By  means  of  these  definitions,  the  destination,  the  names  and  the  numbering  of  files
numbered images (Images) is possible.

To do so, there is a special syntax:

Clipname:StartNumber:Basename%0digits.extension

The section :StartNumber  is optional, and can be used to defines an initial frame number.

%0digits  defines  the  position  of  the  number of  the  frame  and  its  "lead  zeros",  that  is,  it
defines how many digits the frame numbers should have.

Given the complexity of this syntax it  is easy to make mistakes, so it  is recommendable  to
use the predefined targets in  Mistika Setup (Mistika Setup->File Paths) instead of writing
the targets in this field using the syntax. In any case, an example of use follows:

If we write as the clip name: Clipname:20000:/ROLLS/roll1/shotname%06d.dpx

files called Clipname.rnd and a clip called Clipname.clp will be created, as normal, but also: 

the numbering of obtained frames begins at 20000.

The images are stored in the folder: /ROLLS/roll1.

The  images  are  called:  shotname020000.dpx,  shotname020001.dpx,
shotname020002.dpx, etc.

If the creation of proxies (Proxy Image), is also requested, these files will be located in the
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same  place  with  the  prefix  "L_":  L_shotname020000.dpx,  L_shotname020001.dpx,
L_shotname020002.dpx, etc.

Unlike normal renders, the target  folder is not  deleted before doing the render (unless  it  is
empty), since this could be problematic. In these cases a warning message will appear. 

A  folder will  not  be  created  if  it  does  not  already  exist.  It  is  the  user's  responsibility  to
create and manage it. 

Running render from a command-line Shell:

Mistika allows the render script to be run in the background from any Unix-Shell. Enter these
commands to run a render from a console: 

Mistika –r RenderScript 

"RenderScript" is the name of the render script, but without the extension .rnd.

Note: before beginning the render,  be sure that  Mistika  configured  to  work ion the  same
project  in  which  the  script  was  generated.  This  can  be  done  via  the  commands  of  the
Project  tab  (Node  Graph Editor->Dashboard->Project)  or by  modifying  the  content  of
the file Mistika-ENV/Mistika_PRJ. Otherwise, the script will not  be found and the process will
end, showing an error to that effect.

Remember that  all the parameters related to the target  format  (image format  and size) will
be  those  defined  at  the  moment  of  creating   the  script,  and  not  those  that  exist  when
running the command. 

However, the location of the source images  will be those defined in Mistika Setup (Mistika
Setup->File Paths) when the render is run. This allows the render to be done on another
workstation that  has  the  source  images  somewhere  else,  or  even  repeat  a  render  after
making a backup, deleting the clips and restoring the backup in another Mistika station with
other storage paths.

Render files are stored in the RENDER subdirectory  of  the  current  project,  and  are  always
created when a render is started. To create this file without  doing a render and to be able
to run it  later with the command explained, use the option Write Script  Only (Node Graph
Editor->Dashboard->Output->Render->Do Render->Write Script Only).

If  several render processes  have  to  run consecutively,  a  unix script  that  contains  all  the
commands can be written. 

For example,  if  the  render  scripts  render1.rnd,  render2.rnd  and  render3.rnd;  have  been
saved and the three renders need to be run consecutively:

1. First use a text editor to write a new script:

kate MyScript

2. Include the following lines in the file: 

Mistika –r render1

Mistika –r render2

Mistika –r render3

3. Save the script and convert it to an executable file with: 

chmod a+x MyScript

4. Finally run the script: 

./MyScript

Progress  information will  be  displayed  in  the  console,  including  the  current  frame  and  the
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time taken for each packet of frames.  The size of these packets  is defined in Mistika Setup
(Mistika Setup->Render Options->Performance Options->Render Units).

Export EDL

EDL  (Edit  Decision  List)  is  a  file  format  for  the  interchange  of  edits  between  different
applications. 

It  consists  of  a  long  list  of  clip  In  Point  and  Out  Point  timecodes,  which specify  an edit.
Information can be extracted from this list in order to recapture used clips, and also In Point
and Out Point in relation to the Node Graph. 

The timecodes of the original tapes of each clip  are  used  to  recapture  the  media  of  each
clip  in  any  other  system,  and  the  information  regarding  the  order  of  clips  and  other
attributes of the clips, such as variations of speed and transitions, will be used to recreate
the edit in another system. 

Mistika is an Online editing system, which means that  the material being worked on can be
definitive,  and  not  just  a  low  quality  reference.  However,  it  also  allows  an  EDL  to  be
exported and used in any other system, or in another Mistika workstation. 

In the case of needing to import an EDL derived from another system in order to conform an
edit, proceed via the Conform  tab  and  the  Browser,  as  explained  in  detail  in  the  chapter
Conforming EDLs.

Mistika  can generate  an EDL from the  current  contents  of  the  Node  Graph.  This  EDL  will
include the basic  transitions, such as  linear fades.  Complex effects  will  not  be  included  in
the EDL information. 

Before creating the EDL, prepare the part of the Node Graph to be exported, eliminating the
effects  that  cannot  be  included  and  simplifying  the  Node  Graph  with  the  function  Join
(Node Graph Editor->Dashboard->Edit->Commands->Join) by applying it  to the clips
that  have  been  unnecessarily  divided,  and  changing  the  zigzag  transitions  to  transition
mode. Then select  the clips that  make up the edit  to  be  included  in  the  EDL and  add  the
editing marks to the selection. These are the  characteristics  that  differentiate  it  from the
following tab, Export EDL2; so, although it may not be possible to export information relating
to the  audio  or the  transitions,  it  is  not  necessary  to  simplify  it,  as  Mistika  automatically
analyzes the timeline in order to generate the appropriate EDL, without  needing to eliminate
the effect that are not included in the exported EDL.

After preparing the Node Graph, select a name for the exported .edl file, choose a standard
 EDL format, specify a start  timecode for the edit  created in the EDL, indicate the type  of
media to be included in the EDL, and finally generate the file.
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Commands:

Name

Alphanumerical field where the name of the .edl file will be entered. 

Format List

The  Format  dropdown menu specifies  the  type  of  format  in  which the  EDL is  to  be
generated. The button to its right opens a dropdown list  with all the EDL formats that
Mistika can export.

The export format most generally supported by editing systems is CMX340, and is the
most  recommended  format  for  both  export  and  import.  To  export  edits  that  have
multiple simultaneous audio tracks, we recommend using the GVG-SE format. 

The following EDL formats are supported:

RED 16

SONY 900

SONY 910

SONY 5000

SONY 9000

SONY 9000 PLUS

SONY 9100

CMX 340

CMX 3600

GVG 4

GVG 4 PLUS

GVG-SE

Time Code In

The TC In field defines an initial timecode value within the edit contained in the EDL.

Config

In this group the references included in the EDL are specified.

Video. Indicates if references to images are to be included in the EDL.

Audio. Indicates if references to audio are to be included in the EDL.

*FROM  Statements.  Allows  the  use  of  a  commentary  field  of  the  EDL,  in  order  to
indicates  the  name  of  the  original  file  and  other  useful  metadata.  With  this,  other
systems  can conform an EDL against  image  files  without  needing  to  resort  to  video
tape.



257The Interface

SGO Mistika 8.6 © 2018 SGO

Generate and Save

Generates the EDL file, and saves it  in the  OUTPUT  directory of the current  project,
with the specified name, but always with the file extension .edl. 

EDL Created

Field where the EDL created in the selected format will be shown, also it also the error
messages that may be generated in the export process.

Note:  if  the  range  of  the  Node  Graph  contains  any  clips  that  cannot  be  exported,  the
process  will  be  interrupted,  indicating  the  export  error  in  the  EDL  created  field,  and
automatically selecting the unexportable clip on the Node Graph. 

Export EDL2

This  second  EDL export  tab  is  characterized  by  the  combination  of  a  series  of  different
functions and behaves to the previous one. 

The main difference is in its ability to analyze automatically which image clips correspond to
the information of the EDL to be exported; so it does not need (as the previous model does)
the  timeline  to  be  completely  free  of  effects.  Mistika  analyzes  and  exports  only  the
information of the clip which the effects indicate.

However,  owing  to  its  transitory  nature  for a  system composed  of  both  models,  this  tab
does  not  support  the  export  of  information from the  audio  tracks  or transitions  (which  is
conserved from the previous model). 

A  number of  options  for naming  clips  and  the  timecode  has  been  added,  coinciding  with
those found in the tab Render  for the export  of new media. An option for creating  CDLs  is
also included in this tab.
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Commands_2:

Name

Alphanumeric field  for defining the name of the .edl file to be generated.

Tape Name Source

Use source clip tape name

Names the files indicated in the EDL with the original name of the file.

Use source clip tape name from Header

Names the files indicated in the EDL with the internal name of the file.

CLIP NAME Source

No CLIP NAME statements

Will not indicate the EDL files as a commented field of each line of the EDL.

Use source clip tape name

Names  the  files  indicated  in  the  EDL  with  the  original  name  of  the  file,  after  the
commented field" * FROM CLIPNAME ".

Use source clip tape name from Header

Names  the  files  indicated  in  the  EDL  with  the  internal  name  of  the  file,  after  the
commented field " * FROM CLIPNAME ".

Time Code Source

Use source clip Time Code

Defines the timecode as the same as that of the original media. In cases of numbered
sequences, this will be the internal timecode.

Use source clip Time Code Aux1

Defines the timecode by taking the TC Aux 1 if  this is defined. In cases  of  numbered
sequences, the  frame  numbers  are  obtained  by  converting  the  timecode  to  a  whole
number of frames, according to the current fps speed.

Use source clip Time Code Aux2

Defines the timecode as the by taking the TC Aux 2 if  this is defined. Normally, only .
red files are supported.

Use timeline Time Code
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Defines the timecode by taking the timecode of the Node Graph. 

Preferred source clip

Auto

Takes  the  previous  values  derived  from  the  file  that  has  correction  as  geometric
deformations  in  the  effect  Stereo3D.  If  none  is  specified,  it  takes  the  left  one  by
default.

Preferred Left

Takes the previous values derived from the file corresponding to the left  image of the
stereo pair.

Preferred Right

Takes the previous values derived from the file corresponding to the right image of the
stereo pair.

Filter Source Clips

Filter that  ignores any clip Mistika's  native  .js  format.  The  most  common use  of  this
option is for using the name and timecode of  clips  imported  from tapeless  formats  (.
r3d, .ari, etc). If the group to be processed is multilayer and contains more than one
version  of  the  same  clip  (which  will  generally  be  a  clip  in  RAW  and  another  in  .js
 format working as a proxy), by selecting this option Mistika processes the information
of the original clip in RAW.

Create CDL

Creates the .ccc  files (CDL, ie Color Decision List). These  files  are  similar to  an EDL,
but  also  have  precise  information  about  the  primary  corrections  of  each  clip.  Thus
Mistika can grade material and transfer the information to VFX system; these can then
reapply the correction and also have the access to the original files. 

No export ASC lines

Will not export any associated color value as CDL.

Export Color Grade as ASC lines

Activates the export of the CDL. Creates a .ccc  file for each file indicated in the EDL
that has this CDL export  activated. Also, this information will be contained within the
EDL itself.

Create SDL

Saves Stereo3D data in the .edl file. The data is related with the parameters HIT  and
Floating Windows, because both of them are common parameters in  other softwares.
The rest of the parameters are specific only to Mistika, so they are not  saved in the .
edl file. 

No export ASC lines
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Will not export any associated Stereo value as SDL.

Export Color Grade as ASC lines

Activates the export of the SDL in the .edl file.

Format List

The  dropdown Format  defines  the  formats  in  which the  EDL will  be  generated.  The
button at  the  right  opens  a  dropdown list  with  all  the  EDL formats  that  Mistika  can
export. 

The export  format  most  generally  supported  by  editing  systems  is  the  CMX340,  and
this  is  the  most  recommendable  format  for  both  export  and  import.  If  edits  with
simultaneous  multiple  audio  tracks  are  to  be  exported,  the  format  GVG-SE  is
recommendable.

The supported EDL formats are:

RED 16

SONY 900

SONY 910

SONY 5000

SONY 9000

SONY 9000 PLUS

SONY 9100

CMX 340

CMX 3600

GVG 4

GVG 4 PLUS

GVG-SE

Export EDL

Generates the EDL file, saving it  in the OUTPUT  directory of the active project, under
the defined name, with the file extension .edl.

DCP

The Digital Cinema Package (DCP) module of Mistika is found in this tab.

The main function of this tool is to create DCPs for their use in projecting material, dailies,
tests and general post-production.

This module can function independently of the Node Graph. It is for this reason that it is not
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necessary to specify any environment  in particular if  the contents of the DCP have already
been prepared. 

The  DCPs  generated  by  Mistika  can be  shown in  projections  rooms  with  homologous  DCP
projectors.

The supported formats and image resolutions are:

2K 24 fps

2K 48 fps

4K 24 fps

2K Stereo 3D (24S, 48S and 60S)

The audio formats supported are WAVE (.wav) and AIFF (.aiff) at 24 bits per sample and 48
kHz.

If the  material  contained  in  the  DCP  derives  from Mistika,  it  is  recommendable  to  prepare
this material in the following way:

Specify the color space: Given that  the color space  in  the  DCPs  is  XYZ,  as  a  first  step,
convert  the  material  to  be  exported  using  the  Convert  effect  (Node  Graph  Editor-
>Dashboard->Fx->Mistika->Color->Convert). 

Specify the image format and padding: Image clips  must  be  in  JPEG 2000 format  (.j2k)
before they can be used by the DCP module. Therefore it  is recommendable to process the
clips converted to XYZ directly in this format  (Node Graph Editor->Dashboard->Output-
>Render->Full Res Image->Images).

The supported .j2k are:

2k scope 2048x858

2k flat 1998x1080

2k full container 2048x1080

4k scope 4096x1716

4k flat 3996x2160

4k full container 4096x2160

Stereo3D formats require the selection of one of the j2k presets terminating in S  (stereo);
three options are available: 24S for 24fps projects, 48S for 48fps projects and 60S for 60fps
projects. 

The  DCP  module  requires  the  sequenced  numbering  ("padding")  of  the  j2k  files  always  to
start with 1 (one). For example: NAME.000001.j2k, NAME.000002.j2k, NAME.000003.j2k, etc.

 To do this, it is recommendable to align the first  frame of the clip with the Timecode Mark
in  order  to  make  the  timecode  of  the  TimeSpace  coincide  with  that  of  the  clip  to  be
exported. To do this, activate Use timeline name and  TC  in  the  group  of  options  Split  To
Segments options (Node Graph Editor->Dashboard->Output->Render).

Prepare the audio files: One audio channel will always be included per channel, and must
have the same duration as  the  image.  For example,  for a  5.1 configuration,  five  separate
audio channels must be assigned.

To  do  this,  use  the  tool  Router  in  the  Audio  tab  (Node  Graph  Editor->Dashboard-
>Audio). Via this tool, it is possible to select  each audio channel independently and export
them as mono audio tracks.

Finally, with the image and sounds files prepared,  specify  their location in  the  fields  Video
Paths and audio Paths of this module.

When we  generate  a  DCP  packet,  a  new  directory  will  be  created  in  /MATERIAL/MOVIES/
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DCP/PROJECT_NAME/DCP_LONG_NAME.  In  PROJECT_NAME  will  be  the  name  of  the  current
project;  DCP_LONG_NAME  is  the  name  of  the  DCP  created.  For a  DCI  compatible  delivery
disc, the use should copy the folder DCP_LONG_NAME  to  the  root  directory  of  a  disc  with
ext3 format.

Subtitle files: When adding subtitle files to the DCP, be aware  that  they  may  derive  from
sources based on two different  standards. In the tab MXF Creation it  is possible to choose
between the standards INTEROP and SMPTE. In the first  case, the subtitles must  be in xml
and the image files in png; in the case of SMPTE, xml is used with the subtitles font (.ttf).

DCP creation Mode: The tab DCP contains 4 panels that  allow the creation of the packet
in a logical, ordered way. The panels are ordered from left  to right, with the aim of moving
step by step, starting with the panel DCP Name on the left, and ending with KDM Creation
on the right, for an encrypted DCP.

DCP Name:

The pulldown fields of the panel DCP Name are a series of options for the correct  naming of
a DCP packet  according to the syntax defined  by  the  "Digital Cinema  Naming  Convention",
created by the production studios and the Inter-Society Digital Cinema Forum. 

Name

Specifies the name of the DCP file.

Content

Specifies the type of content of the packet:

FTR (Feature)

TLR (Trailer)

RTG (Rating Tag)

TSR (Teaser)

POL (Policy Trailer)

PSA (Public Service Announcement)

ADV (Advertisement)

SHR (Short)

XSN (Transitional)

TST (Test)

Content Version

Specifies the version of the contents of the packet.
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Content Type (2D / 3D)

Specifies whether the contents of the packet is 2D or 3D.

Ratio

Specifies the aspect ratio of the contents of the packet.

F - Flat (1.85:1)

S - Scope (2.39:1)

F - Full Container (1.90:1)

Language

Specifies the language of the audio of the contents of the packet.

Subtitles

Specifies the language of the subtitles of the contents of the packet.

Territory

Specifies the geographical area where the contents will be shown.

Ratings

Specifies the type of audience classification of the contents of the packet.

AE (Exempt from classification)

G (General audiences)

M (Recommended for mature audiences)

M5 (Viewers over 15)

PG (Parents Strongly Cautioned)

R (Restricted)

Audio

Specifies the audio system for which the contents of the packet is intended.

51 (5.1). (Note: the similarity of the nomenclature should not  be confused  with
standard  Dolby  5.1.  This  number  refers  to  the  separate  channels  without
recoding.)

20 (Stereo)

XX (un-specified)
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Resolution

Specifies the image resolution of the contents of the packet.

2K (2048x858, 1998x1080, 2048x1080; according to the aspect ratio)

4K (4096x1716, 3996x2160, 4096x2160; according to the aspect ratio)

48 (2K at 48 fps)

Note: In order to export a packet in Stereo 3D format  with 2K resolution, the option
48 must be selected. 

Studio

Specifies the studio where the content of DCP was created. The list of studios can be
modified in the file de Mistika-ENV/config/listStudios.cfg with any text editor.

Year

Specifies the year the DCP packet was created.

Month

Specifies the month the DCP packet was created.

Day

Specifies the day the DCP packet was created.

Facilities

Specifies the company or facility where the content  of DCP  was  created.  The  list  of
companies can be modified in the file Mistika-ENV/config/listFacilities.cfg with any text
editor.

3D Specs

Specifies whether the content of the packet has ghostbusting.

i3D-gb (with ghostbusting, to be shown in theaters with Dolby 3D)

i3D-ngb (without ghostbusting, to be shown in theaters with Real D)

i3D (the content has been corrected, so ghostbusting is not relevant)

DCP Types

Specifies  whether the  DCP  contains  the  whole  of  the  material  or just  a  part  of  the
material as part of a set of complementary DCPs.

OV (Original Version)

VF (Version File)
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File Version

Specifies the number of the version of the DCP file.

Set DCP Folder Name

Creates the DCP folder with the name based on the parameters defined, following the
syntax established by the "Digital Cinema Naming Convention".

MXF Creation:

The  MXF  Creation  panel  allows  us  to  select  the  media  that  the  DCP  being  created  will
contain. This process is the complicated: it  is only done once per version (of media and/or
audio), and to do so, the following two steps are separate, so the same media can be used
with different metadata.

To  activate  the  selection of  the  media  of  each  of  the  groups,  select  the  corresponding
button (VIDEO, AUDIO or SUBs).

VIDEO

Central Eye Path

Path for the main image. When dealing  with  stereo  pairs,  this  will  correspond  to  the
left eye. 

Right Eye Path

Path for the image of the right eye, when dealing with stereo contents.

AUDIO

Left Audio Path

Path for the left audio channel.

Right Audio Path

Path for the right audio channel.

Left S Audio Path

Path for the secondary left audio channel.



266 The Interface

SGO Mistika 8.6 © 2018 SGO

Right S Audio Path

Path for the secondary right audio channel.

Central S Audio Path

Path for the central audio channel.

LFE Left S Audio Path

Path for the LFE (Low Frequency Effects) audio channel. 

Subs

Route path to the subtitle files. The xml file must be in the same directory as the png
(image files of the subtitles) or text (.ttf).

Generate MXFs

DCP Type

Indicates the DCI standard that  will be used for the creation of the DCP (INTEROP or
SMPTE).

Crypt MXFs

Encrypts the MXFs so they can only be used with a  decrypting  password  specific  to
each projector.

Generate MXFs

Starts the process of generating the media of the DCP (MXFs).

Framerate

Allows  the  selection of  the  framerate  of  the  resulting  MXF.  It  is  highly  advisable  to
bear this in mind before rendering J2K to avoid possible bitrate problems.

Add to reel num.

Adds specified media to the selected reel. 

Reset Fields

Resets the fields of the routes marked for the media.
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XML Creation:

The XML Creation tab is where the user creates the necessary DCP metadada files (XMLs).

Select Reel

Selects the reel to which the DCP is to be added. 

Load Video MXF

Loads the path of the video media defined in the previous panel.

Load Audio MXF

Loads the path of the audio  media defined in the previous panel.

Load Subs MXF

Loads the path of the subtitles defined in the previous panel.

Specify XML name

Names the XML data files contained in the DCP.

Certs list

Load certificates for digital signatures of the XML files.

Generate XMLs

Creates the XMLs of the DCP.
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KDM Creation:

Panel for  creating  the  information  file  necessary  for  projectors  to  playback  the  media  if
encrypted.

Validate from

Year 

Year from which the de-encrypting of the DCP will be valid.

Month

Month from which the de-encrypting of the DCP will be valid.

Day 

Day from which the de-encrypting of the DCP will be valid.

Hour 

Hour from which the de-encrypting of the DCP will be valid.

Minute

Minute from which the de-encrypting of the DCP will be valid.

Validate to

Year 

Year from which the de-encrypting of the DCP will be invalid.

Month

Month from which the de-encrypting of the DCP will be invalid.

Day 
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Day from which the de-encrypting of the DCP will be invalid.

Hour 

Hour from which the de-encrypting of the DCP will be invalid.

Minute

Minute from which the de-encrypting of the DCP will be invalid.

Dest Name KDM

Name of the  KDM.  It  is  named automatically  according  to  the  parameters  previously
defined, although this is editable.

Certs list

Loads certificates for digital signature.

Pem Cetificate

Loads the certificates specific to the projector for which the DCP is intended.

Generate KDM

Generates the KDM de-encrypting file.

Totem

Mistika supports the Totem render distribution system.

This  system  allows  the  use  of  render  nodes  that  pertain  to  the  same  clip  during  an
interactive session. Its configuration is described in a separate section in mConfig.

Overlay Burn

Information relating to the clip (Framerate, Timecode, Tails,  etc)  that  appear in  the  video
output  when  working  on  said  clip  are  configured  in  this  panel.  The  viewing  of  of  these
elements is via Source Monitor  or Record Monitor, while their visual configuration is set  via
these options.
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Commands:

Global Options

Font Name

Allows the selection of the font to be used in the viewing.

Font Size

Selects the font size.

Draw Shadows in Live

Adds a shadow to the font to aid its visibility.

Edit Options

Edit Field

Allows the selection of the information field to be viewed. Any change made to one of
these elements is maintained although another is selected for editing. 

Active

Activates/deactivates the viewing of the chosen field.

Cursor

Cursor Line

Positions the information field on the specified line.

Cursor Column

Positions the information field in the specified column.

Screen Name

The user can edit  the content  of the information of a field to be  shown in  the  video
output in this panel. The required field must first be selected in Edit Field.

Show Path Options

Show From Level

Shows the path of the clip from the specified Level.

Show Level

Shows the folder of the clip from the specified Level.

None

Disable the view of the clip path.

Level

Indicate the level used for showing the clip path.
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Save

Allows a specific configuration set by the user to be saved.

Reset

Resets the configuration to its initial values.

Monitor Display

Ref. Mistika: Node Graph Editor->Monitor Display

Monitor Display is the area where the evaluation of the Monitor in the Node Graph is viewed
 and is composed of two evaluation windows: Source Monitor and Record Monitor.

By  default  these  windows  are  found  superimposed,  and  the  corresponding  tab  must  be
selected to activate them. However, it  is possible to view both windows at  the  same  time
by applying the command Move Win in the options menu of both windows.

The  button  to  close  the  application  is  found  in  Monitor  Display:  Exit  Mistika.  If  the
environment  has  not  been  saved,   the  system  prompts  the  user  to  save  the  current
environment.

Access

Depending  on the  Main Tab  selected  in  the  Dashboard,  the  Monitor  Display  may  not  be
visible.  However,  it  is  possible  to  position  it  in  front  of  the  other  panels  by  clicking  the
mouse cursor on the Monitor  bar of the Node Graph.  For this  to  happen,  the  option Raise
Monitor (Node Graph Editor->Dashboard->Edit->Setup->Node Graph Monitor->Raise
Monitor) must be activated.
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Source Monitor

Ref. Mistika: Node Graph Editor->Monitor Display->Source Monitor

The Source  Monitor  is  used  to  view  the  content  of  the  clips  within  a  context  of  specific
operations specific:

Clipboard.

View  the  content  of  the  clipboard.  The  clipboard  is  a  temporary  memory  able  to  store
elements of any type. For example, to copy a  selection of  clips  from the  Node  Graph,  via
editing commands (Copy, Cut, Global Cut, Global Copy, Remove Time, etc.).

Media tab

View a file from the Media tab. 

When selecting an importable image file, this creates a  clip  (.ink)  which is  loaded  into  the
Source Monitor, making it possible to view image files in external formats.

Edit tab

The Source Monitor is also used to specify In and Out  Points for running editing commands
on the Node Graph, since the Source Monitor  has editing commands in its top bar, instead
of the simple playback commands found in normal monitors. 

These editing commands permit  the definition of In and Out  Points, which can be  used  for
different purposes: 

Create a subclip  (.sub)  with  the  intention of  distinguishing  between different
segments of a clip by means of a specific name, or to divide a clip into various
subclips.

Add the range specified by the In and Out Points of the Source Monitor to the
Node Graph, by using the different  editing functions that  can be run from the
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Source Monitor or from the Edit  Panel (for more information, read the chapter
Edit).

Commands

The editing buttons of the Source Monitor are described below: 

Timecode command:

Timecode In

Numerical field that  can be edited, and which specifies  the  timecode  value  of  the  In
Point of the Source Monitor. 

TC

Numeric field that shows the value of the current timecode.

Timecode Out

Numerical field that can be edited, and which specifies the timecode value of the Out
Point of the Source Monitor.

Overwrite / Insert / Paste On Top:

Editing  button  that  adds  the  contents  of  the  Source  Monitor  to  the  Node  Graph  via
different editing functions. 

Overwrite

Overwrites  the  Node  Graph  with  the  contents  of  the  Source  Monitor,  replacing  the
Node  Graph  clips  as  from  the  timecode  specified  by  the  active  monitor,  for  the
duration specified in the Source Monitor by its Out Point. 

If the Node Graph has activated editing marks, the range of duration specified by the
In and Out  Points of the Source Monitor  will overwrite the Node Graph, but  adjusting
its  speed  of  playback  to  the  duration  specified  by  the  editing  marks,  creating  a
Timewarp group. (Remember that the Timewarp will not  affect  audio playout). This is
called "Four-Point Editing". 

Insert

Inserts the contents of the Source Monitor  in the Node Graph, adding the necessary
time and pushing the Node Graph clips to the right, from the timecode specified by the
active monitor for the duration specified in the Source Monitor by its Out Point. 

If the Node Graph has activated editing marks, the range of duration specified by the
In and Out  Points of the Source Monitor  will  be  inserted  in  the  Node  Graph,  pushing
the  remaining  clips  up  to  the  output  mark,  and  modifying  the  playout  speed  of  the
inserted clips to adjust it to the duration specified by the editing marks, by creating a
Timewarp group. Remember that the Timewarp does not affect audio reproduction. 
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Paste On Top

Adds the contents of the Source Monitor  to the Node Graph, from the position of the
active  monitor and  in  the  first  free  track  that  it  finds,  starting  from the  top.  This
process does not  modify the positions of the clips in the Node Graph, but  due to the
way that the monitor is evaluated (starting with the top track) the result  is similar to
overwriting.  For more  information on monitor performance,  read  the  chapter  Monitor
Evaluation. 

If the Node Graph has editing marks, the range of duration specified by the In and Out
Points  of  the  Source  Monitor  will  be  added  to  the  Node  Graph,  but  modifying  its
payout  speed to adjust  it  to the duration specified by the Node Graph editing marks,
by creating a Timewarp  group.  Remember that  the  Timewarp  does  not  affect  audio
reproduction.

For  more  information  on  the  editing  methods  that  can  be  used  from  the  Source
Monitor, read the chapter Classic NLE Editing. 

Editing marks:

Commands that define the editing points of the Source Monitor  in the position of its active
frame. 

Edit In

Sets or redefines the input point in the active frame.

Remove Edit In

Eliminates the input point.

If the input point is not defined, the start  point  of the content  of the Source Monitor
will be considered as the input point.

Set Edit Out

Sets or resets the input point in the active frame.

Remove Edit Out

Eliminates the input point.

If the input point is not defined, the end of the content  of the Source Monitor  will be
considered as the input point.

Playback controls:

Starts or stops the playout of the contents evaluated by the Source Monitor.

Play

Playout in the normal direction. 
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Play Backwards

Playout in the reverse direction. 

Stop

Stops playout. 

Slider:

Below  the  editing  functions  is  the  active  frame  control  slider.  The  width  of  the  slider
represents the total duration of the contents of the Source Monitor. Within this Range, the
following elements can be accessed: 

Active frame

A light  grey rhombus, which can be directly manipulated, by selecting and dragging it
with the left mouse button

This frame can also be edited by using the monitor Jog function. To do this, left  click
the monitor image, and drag the cursor to the left  or right.  The  monitor mark moves
slowly along the slider, frame by frame. 

In Point

Yellow triangle that  visually specifies the In Point, which can be  directly  manipulated
by selecting and dragging it with the left mouse button.

Active range

Light  blue segment, that  indicates  the  duration of  the  range  of  the  contents  of  the
Source Monitor that will be used in an editing function, or the creation of a subclip. 

Out Point

Yellow triangle that visually specifies the Out Point, which can be directly manipulated
by selecting and dragging it with the left mouse button. 

Menu / Maximize:

Menu

The Menu button shows the options menu of the Display Monitor.
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Maximize

When the Maximize button is activated, the window  of  the  Display  Monitor  occupies
the whole computer screen. Exit this mode by double clicking the window.

Record Monitor

Ref. Mistika: Node Graph Editor->Monitor Display->Record Monitor

Permits  viewing  the  evaluated  clips  in  the  Monitor  of  the  Node  Graph.  A  monitor  allows
evaluation of all the types of clip of the Node Graph, whether they are image, audio, group
or  effect.  For  more  information  about  the  evaluation  of  the  Monitor,  read  the  chapter
Monitor.

Commands

In the upper area of the window, a group of buttons  with  a  series  of  playback and  offset
controls can be found:

Begin

Moves the Monitor to the first frame of the Node Graph.

Previous Frame

Moves the Monitor back to the previous frame. 

Play Backwards

Activates reverse playback. 



277The Interface

SGO Mistika 8.6 © 2018 SGO

Stop / Shuttle

Stops the current playback. Dynamic control of playback speed.

Play / Stop

Activates forward playback. 

Play Buffer

Activates playback of the information stored in the buffer.

Next Frame

Moves the Monitor forward to the following frame. 

End

Moves the Monitor to the last frame of the Node Graph.

Previous Edit

Moves the Monitor to the previous editing point.

Next Edit

Moves the Monitor to the next editing point.

Menu

Menu shows the menu of options of the Display Monitor.

Maximize

When Maximize is active, the window of the Display Monitor occupies the whole of the
computer screen. To exit this mode, simply double click in the window.

Stop / Shuttle

Permits the viewing of evaluated images with a Shuttle-type control in its top bar.

In  addition  to  the  Shuttle  control,  it  is  possible  to  move  the  monitor mark from the
panel, in Jog mode. To do this, left click the monitor image, and drag the cursor to the
left or right. The monitor mark will move slowly to the width of the Node Graph, frame
by frame. This movement is restricted to the area of the Node Graph that  is shown on
the screen at a given moment. 

Remember that  the  monitor mark can be  moved  manually,  and  the  Node  Graph  can
also be moved below the monitor mark, in both cases causing evaluation of the image
in the monitor panel. 
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Option menu

To view the menu of options of the Monitor Display, click Menu.

The buttons of the panel are grouped according to their functionality.

Resolution button

Controls the evaluation monitor resolution.

Proxy

Evaluation in low resolution (Proxy).
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Dynamic

Evaluation in dynamic mode, switching automatically between high resolution for image
clips, and low resolution for effect and group clips. 

Full

Evaluation in high resolution.

Burn button

This dropdown button allows the viewing of extra information in the display.

Tape Name

Shows the name of the clip being viewed in the monitor (the name of the archive).

Header TapeName

Shows  the  internal name  of  the  clip.  This  name  may  not  always  coincide  with  the
Tape Name (the real name of the archive).
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Record TC

Shows the Node Graph timecode in the monitor image.

Record Frames

Shows the playing time of the Node Graph composed  on the  image  in  the  monitor in
Frames.

Source TC

Shows the original clip timecode in the Monitor Display image.

Media Name

Shows the name of the media that the clip being shown in the monitor references.

Absolute Path

Shows the absolute route of the clip being shown in the monitor.

ClipName

Shows the name of the link that Mistika uses to reference the clip being shown in the
monitor.

Frame rate

Shows the frame rate at which the monitor is reproducing new frames at each moment
in the monitor image. This value is also always shown at  the side of the head  of  the
monitor cursor. 

Note: Depending of the system's performance, the ratio of frames per second can be
slower than real-time. The will monitor always try to run at  the speed determined  by
the configuration tool, but if it cannot  because of the complexity of the effects being
evaluated, it will run more slowly (and will show the message “Lost  Sync”), but  it  will
never run faster than this speed.

Moreover, output in Live Video (SDI) mode is always quicker and more stable than the
interface graphics monitor. In general, all Mistika's specifications  with  regard  to  real-
time processes refer to LiveVideo output mode.

On the other hand, during  playback in  Live  Video  mode,  the  f.p.s.  value   may  begin
corresponding to that  of the current  real-time format, but  may later lose units during
short  time  lapses,  but  subsequently  recovering  without  displaying  the  “Lost  Sync”
message in the monitor head. This means that during this time lapse not all the frames
corresponding to real time have been processed, but  that  thanks to the output  buffer
they have all been played back and so the playback has happened in real time with its
exact duration (if  this is not  the case, the “Lost  Sync” will appear). This indicates to
the user that the system is operating at  close to real-time capacity before a problem
arises.
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Ring Buffer

Shows  the  number  of  frames  stored  in  the  buffer  of  the  video  output,  and  which
Mistika will use as a buffer in order to maintain a smooth playback.

Duration Frames

Duration of the clip being shown in the monitor in frames.

Duration Timecode

Duration of the clip being shown in the monitor in timecode.

Head Frames

Duration of the head of the clip being shown in the monitor in frames.

Tail Frames

Duration of the tail of the clip being shown in the monitor in frames.
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Interlaced Display

Interlaced Still

Specifies that the evaluation mode of the monitor that  is stopped should be done in a
single field, and not in the whole frame. 

This  option  is  especially  useful  when  the  monitor  evaluation  is  sent  to  the  video
output, avoiding  the  flickering  between fields  that  is  generated  when the  monitor is
stopped on an interlaced clip. 

FX Interlaced Play

Sets the of mode of evaluation of effects in the monitor when in play as by fields, ie.
 that  the  first  field  is  the  first  to  be  evaluated,  then  the  second  and  the  resulting
evaluation of both fields is interlaced again before being sent  to  the  video  output  or
graphics monitor.

It  is  important  to  bear  in  mind  that  activating  this  option  doubles  the  processing
requirements.  Also,  it  only  makes  sense  to  activate  it  when working  with  interlaced
material and the image is being taken from the video output.
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Show Alpha

Show Alpha 

Shows the alpha channel in place of the color channels.

When Show  Alpha  is  activate,  a  wipe  can be  specified  between  the  viewing  of  the
alpha channel and the other image color channels. The border of  the  wipe  is  defined
by pressing <Ctrl> and dragging on the monitor image with the left mouse button. 

For this  option to  work,  the  clip  being  evaluated  should  have  an  alpha  channel,  as
occurs in the following cases: 

The clip is of  type  RGBA  (if,  when importing  a  sequence  or making  a  render,
the RGBA format was chosen) 

The clip is an effect that has RGBA output with alpha channel. For example, an
alpha channel could be associated with a normal clip by using the External Key
effect.

The following example, imported one from a  graphics  source,  consists  of  a  red  circle
with an alpha channel covering  part  of  the  circle.  The  left  monitor shows  the  color,
and in  the  right  monitor Show  Alpha  has  been activated  and  dragged  with  the  right
mouse button over the image to show part of the alpha channel (th white area).

Audio Wave

Audio Wave

Activates the audio evaluation representation as a waveform. 

The waveform of an audio clip will only be visible in the monitor panel and not  in  the
video  output,  and  provided  that  the  monitor  is  only  evaluating  audio  clips,  and  no
other type of clip  at  the  same  time.  Also,  it  is  only  seen when scrubbing  and  audio
clip, and not during playback.

Live Video

Live Video

If activated, this sends the monitor evaluation to the video output. In other cases, it
is shown in the monitor panel in the interface. 

To avoid loss of functions the evaluated image will only be shown in one of these two
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places at  a time. If it  is necessary  to  see  them in  both the  interface  and  the  video
monitor at the same time, this can be done in Visual Editor mode.

Stereo Mode

Stereo Mode

Activates stereoscopic viewing  of the image.

This button only appears when has been activated before opening Mistika. Activating
it  causes  Mistika  to  separate  the  clips  contained  in  a  Stereo  group,  to  apply  the
effects that are applied to the  group to both clips separately and to send the result
to the corresponding SDI output.

This viewing mode also works together with editing command Stereo Combine  (Node
Graph  Editor->Dashboard->Edit->Edit->Commands->Stereo  combine).  For
more information, consult the command Stereo Combine.

Ratio Cor.

Ratio Cor. 

Corrects  the  proportions  of  the  monitor  image  in  the  graphic  interface  for  NTSC
formats (rectangular pixels) and PAL PLUS (images   that  should  be  viewed in  aspect
ratio 16/9 but have been recorded in anamorphic PAL  4:3).  

When the  evaluation is  not  sent  to  the  video  output,  the  images  are  shown  in  the
monitor panel within the computer screen. In these cases, if  working in NTSC format,
the  images  will  appear  deformed,  since  the  NTSC  standard  signal  is  formed  by
rectangular pixels, whereas in the graphics  monitor of  the  computer these  pixels  are
seen as square. This option stretches the image, making an aspect  correction to view
it with the correct proportions in the computer graphics monitor.

Correction  of  aspect  proportions  is  also  available  for  the  “PAL  PLUS”  format  by
activating it  in the Mistika configuration tool. This option will correct  in the computer
screen the aspect ratio of images that should be seen in 16/9 but have been recorded
in PAL , and so have an anamorphic 4:3 aspect ratio.

These corrections  only  affect  the  interface  and  not  the  external SDI video  monitor,
which can only show the Aspect Ratios that can be configured via its own controls. 

In the case of needing to correct   from Mistika, is recommended to  use  the  Framing
tab  in  the  Dashboard  of  the  Visual  Editor.  They  can  also  be  combined  with  the
Mistika  Setup->Multimastering  for  cases  which  there  are  also  hay  a  format
conversion of different resolutions). 

Save Image

Save Image

Exports the active frame to an image in .vst format.
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Follow Dial

Follow Dial

Synchronizes the movement of the monitor with the dial of the Parameters tab and at
the same time with  the movement of the Keyframe Slider of the Visual Editor.

Center Monitor

Center Monitor

Centers  the  mark in  the  Node  Graph  view,  and  changes  the  monitor  mark  into  a  vertical
evaluation fixed line, which evaluates from the top track to the bottom.  In  this  mode,  the
monitor mark has no header or end of Range. 

Its main use is to enable working in a traditional editing manner, in jobs which only  require
horizontal editing, color correcting or simple effects.

Safe Area / Grid

Controls for viewing reference guides in the image of the monitor.

The lines drawn by  these  options  will  only  be  visible  in  the  monitor panel,  and  not  in  the
video output. 

Safe Area X; Y

Buttons that activate the viewing of a safety area that  can be specified by the user,
changing the percentage value in numerical fields shown beside the X and Y buttons. 
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Grid X; Y 

Buttons that  activate the viewing of a  grid  that  divides  the  monitor horizontally  and
vertically.  The  grid  can be  specified  by  the  user,  changing  the  percentage  value  in
numerical fields beside the X and Y buttons. 

Zoom

Enlarges or reduces the view of the image evaluated in the panel. 

Zoom In

Enlarges the view of  the  image  evaluated  in  the  panel.  As  well  as  the  mouse  wheel
(the  usual zoom method  in  most  panels  considered)  the  hotkey  <Up>  can  also  be
used.

Zoom Out

Reduces the view of the image evaluated in the panel.  As  well  as  the  mouse  wheel
(the usual zoom method in most  panels considered) the hotkey <Down> can also be
used.

To reposition the image view, right click on it while dragging the cursor.

Note: This enlargement, reduction or repositioning is only visible in the monitor panel
in the interface, and not in the video output.  

Bear in mind that this zoom amplifies only pixels that  have already been processed, ie.
if  the  original image  has  a  greater resolution than the  working  format  (MistikaSetup
RenderFormat), non-visible details will not  be recovered by this  type  of  enlargement.
This is a common conceptual error which should be understood in order to be avoided.

For example,  if  we  have  a  PAL (720x576)   preset  and  a  2K (2048x1556)  image  has
been imported which has been reduced to PAL size (for example via  the   Comp3D or
Framing)  effect,  the  zoom of  the  monitor panel  cannot  carry  out  a  quality  rescale
filter  or  show  more  detail  than  the  original  resolution  (both  of  which  can  only  be
achieved through the parameters of the current  rescaling effect); rather, the monitor
zoom can only  enlarge  the  pixels  to  which  the  effect  has  been  applied,  shown  as
larger squares. 

Zoom Center

Restores only the center of the image evaluated in the panel. 

Zoom Reset

Restores the default  value  of  the  zoom factor and  the  center position  of  the  image
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evaluated in the panel. 

Hide

Hides the options panel of the monitor, making the evaluated image totally visible.

Move Win

Permits the repositioning of the  active  display  window  (Source  orRecord)  to  another
part  of the interface: left-click, drag and release  in  the  area  desired.  A  permanently
activated autosnap function means it  is possible to return the window  by  dragging  it
to its original position.

Node Graph Editor

The Node Graph Editor is the main tool de composition of Mistika. As its name indicates, it  is
based on nodes and the interaction between themselves via links and effects.

When compositing, we will generally deal with two types de workflow: one based on layers
and  the  other  based  on  nodes.  While  layers  offer  greater  control  when  working  with
animation and Motion Graphics, when compositing,a node-based system is much faster and
accurate.

A node editor allows us to organize the various elements of  the  final image  independently,
link and interact with them as we wish, without  being concerned that  one node may affect
others, as would happen with a layer-based system.

A  node  editor  also  offers  us  a  very  graphic  and  clear  perspective  of  our  composition,
reducing  the  possibility  of  repeating  graphic  elements  when  using  multiple  inputs  and
outputs for each of the nodes.
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The Node Graph Editor of Mistika is made up of two elements: Workspace and Toolbar.

Workspace:  this  is  the  main  work  area  of  the  editor.  It  offers  total  flexibility  for
positioning, moving, selecting, linking and eliminating nodes as we wish. 

Toolbar: this is a tool set  associated to the Node Graph Editor  (for more information see
Node Graph->Node Graph Editor->Toolbar).

Types of nodes

Mistika has three major types of node:

Source Nodes

These  exist  in  their  own  right,  as  a  source  of  content  to  which  we  apply  the  different
effects of Mistika. They can be video clips, such as Solid, Fractal, Circle, Title... (all which
pertain to FX->Mistika FX>->Generate, except Stripe).



289The Interface

SGO Mistika 8.6 © 2018 SGO

FX Nodes

These  are  the  majority  of  nodes,  and  as  their  name  states,  the  carry  out  some  kind  of
effect  on the  content  nodes  being  used  (for more  information about  the  different  effects
see FX->Mistika FX).

Multi-input Nodes: 

Within FX Nodes there is a wide variety of multi-input  nodes, with Comp3D standing out  as
being the main composition nodes for Mistika. The particularity of these nodes is that  they
allow  multiple  simultaneous  connections,  which  may  present  problems  with  regard  to  the
order  of  the  inputs.  In  order  to  resolve  this  situation,  this  type  of  node  automatically
creates inputs each time nodes are linked to them. An example is shown below:

This  example  shows  3  nodes  connected  to  a  Comp3D  in  the  desired  order.  If  we  later
discover  that  the  order  is  incorrect  for  whatever  reason,  we  can  disconnect  the  three
nodes from the Comp3D. Mistika automatically creates the three inputs in the Comp3D node
so  that  when we  connect  again,  we  can  do  so  in  the  order  required  without  causing  a
change in the order of the inputs in Comp3D itself.
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Connect Nodes

These  are  found  in  FX->Mistika  FX->Compose,  and  are  used  to  manually  connect  one
node  to  others  at  the  same  time,  since  by  default  in  Mistika,  nodes  do  not  have  various
outputs, and so they have to be created using this type of link.

Toolbar

The Node Graph Editor incorporates a tool bar for carrying out basic operation with nodes.

Organization of nodes

These buttons carry out operations for organizing the node tree.

Graph Reload

Refreshes the node tree when changes have not been processed visually.

Center View

Positions the node tree in the center of the Workspace. 
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Reset Layout

Organizes the nodes automatically in the Workspace.

Reset Subtree

Works like Reset Layout, but organizing the nodes preceding the selected node.

Set Root Node

Allows the user to indicate which node is in the uppermost position in the composition.

Display Links

If activated, allows the viewing of links as a node that  can be manipulated, or as a normal
link, if deactivated.

Basic operations with nodes

These buttons carry out basic operation with nodes:

From left to right the buttons will cut, copy, paste and delete the selected nodes.

Groups of nodes

With these buttons we can carry out operations with grouped nodes simultaneously:

Group

Allows  the  grouping  of  selected  nodes  into  a  single  node  in  order  to  organize  the
composition.  To  view  the  content  of  the  group  click  over  any  node  in  the  group  while
holding down CTRL+SHIFT.

Ungroup

Ungroups previously created groups of nodes.
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Timewarp

Allows the editing of the speed of the nodes contained in the group. This editing is carried
out in the Visual Editor.

Reverse

Reverses the direction of playback of the selected clips.

Time and Trim

With these commands we can change the duration and trim the selected clip.

Length

The number of frames of a clip is established automatically when it  is imported to the Node
Graph Editor, but this number can be increased or decreased manually using this field. If we
increase the number of frames, the video clip will be reproduced more slowly; fewer frames
increases the speed. 

Trim

With this command we establish where changes in the number of frames will happen, either
at the Head or Tail of the clip.

Viewing nodes

With these commands we can select viewing different options of the node tree.

Root on

Selects  from four possibilities  the  position  of  the  output  icon  of  the  link  of  each  of  the
nodes: left, right, top and bottom. The default position is at the top of the node.
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Icons

Allows the previewing of the content of a node by means of an image inserted into the node
itself. This is not a realtime preview, so a video clip cannot be played in this mode; the first
frame of the clip will be seen.

We can select the preview to be only in the Source Nodes, or in all.

Zoom

With these  four buttons  we  can select  the  level of  zoom desired  in  the  Workspace,  and
center the view in the selected node tree. 

Keyboard commands

In the Node Graph Editor we can carry out certain operations from the keyboard:

<CTRL+SHIFT>: allows us to develop a previously created group and view its content .

<CTRL+ALT>: allows us to rotate a node tree in the direction we wish, using the selected
node as the axis.

<CTRL>: allows us to move the selected node together with its subtree.

<ALT>: allows us to duplicate the selected node/s. If the command is run over the output
icon of the node, a Link is generated (see Link)

<SHIFT>: allows us to select various nodes manually.

<DEL>: allows us to eliminate the selected node/s.

Basic functions

The basic general function of the Node Graph Editor is as follows: 

A  video  clip  is  imported  to  our  project.  This  clip  appears  as  a  content  node  in  the
Workspace  of  the  editor.  The  duration  of  the  clip  establishes  the  duration  of  the
composition,  although  this  can  be  changed  manually  in  Frames  (Node  Graph  Editor  -
>Toolbar->Frame). If  the node does not  appear in  the  Workspace,  click Graph Reload  (
Node Graph Editor ->Toolbar->Graph Reload)

From here we can connect effects and link nodes in two ways: automatically or manually.

The  automatic  mode  consists  of  selecting  the  source  to  which  the  new  node  which  we
insert  into  the  Node  Graph  Editor  is  to  be  connected.  By  this  method,  the  new  node
connects automatically to the selected node. If we select  several nodes at  the same  time
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and then add a new node, all the selected nodes will connect  to the new node, although it
is not  a multi-input   node, and  it  will  affect  only  the  last  node  connected  (ie  the  highest
number in the input icon). If the selection is complex, and we select a node which is already
connected at the same time as a second independent node, the new node will only connect
to the  free  node,  ignoring  the  connected  node.  If  we  wish to  link the  already  connected
node to the newly  created  node,  we  need  to  use  Connect  or manually  create  a  link with
<ALT>.

The manual mode consists of inserting the nodes in the composer without  having previously
selected any element. The nodes will then appear in the editor independently, allowing them
to  be  connected  manually.  To  do  so,  simply  click and  drag  the  gray  circle  on the  left  of
each node to the node to which we want to connect it.

This  operation can obviously  NOT  be  done  between Source  Nodes,  as  the  material  would
overlap. If we wish to combine different clips and material, we have to use nodes that  allow
multiple  input,  of  which  the  best  example  is  effect  Comp3D  (FX->Mistika->FX-
>Compose->Comp  3D),  which  allows  us  to  compose  these  graphic  elements  in  a  3D
environment (see Comp 3D).
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E-4 Visual Editor

Ref. Mistika: Visual Editor

This mode is used to compose layers and to work interactively with all types of effects. In
other words, all the material organized and  derived  from the  Node  Graph Editor  is  finished
and polished in the Visual Editor. The Visual Editor is the means of  expression for the  VFX
artist.

To access this mode, double left click on an effect clip.

The  Visual  Editor  is  formed  by  three  complementary  areas:  Canvas,  Dashboard  and
Parameters.

The Canvas  is  the  area  where  the  result  of  the  processes  applied  to  the  selected  effect
clip, and allows us to work on it via interactive manipulators.

The  Dashboard  is  the  main  control panel which has  the  interfaces  that  interact  with  the
visual  manipulators,  such  as  the  management  of  motion  trackers,  the  color  correction
spheres, the composing manipulators in 3D,  etc.  Depending  on the  type  of  effect  applied,
the  permitted  manipulation  modes  will  appear  active,  and  those  not  allowed  will  appear
semitransparent, and cannot be selected. 

In  the  Parameters  area,  the  values  of  parameters  of  any  selected  clip  or  group  can  be
viewed and edited.

The Back button allows the activation or return to the Node Graph Editor mode.

In double monitor configurations, there will be the panels corresponding to the Node Graph
Editor mode in one monitor and that  corresponding to the  Visual Editor  mode in the other.
To avoid waiting time due to  double  evaluation,  the  Visual Editor  should  not  be  activated
when  we  are  working  in  the  Node  Graph  Editor.  In  these  cases,  as  well  as  the  modes
buttons  (and  their associated  hotkeys),  we  can use  the  following  method  to  indicate  to
Mistika that we want alternate the evaluation between modes:
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Node Graph Editor: double click on the background of the Node Graph.

Visual Editor: double click on the effect to be worked on.

Canvas

Ref. Mistika: Visual Editor->Canvas

The Canvas has an image area with an evaluation zone and inactivate zones. A manipulator
can  be  placed  in  any  part  of  the  image  area,  but  only  the  result  of  the  effect  will  be
viewed. 

Note: the evaluation zone coincides with the image aspect  ratio specified in Mistika Setup.
If  the resolution configured in Mistika Setup cannot  be viewed because it  exceeds the size
of the Visual Editor, the default  zoom value  by  will  be  automatically  specified  so  that  the
entire evaluated image will be viewed. For example, in the case of HDTV, the default  image
zoom is ½; the image can be enlarged at any time to see the true resolution. 

Below the area of the image are the tools specific to Canvas. 

Toggles

Ref. Mistika: Visual Editor->Canvas->Toggles

The  Toggles  set  of  buttons  contains  a  series  of  controls  for  the  visual  evaluation  and
manipulation of the clip.

FX Presets

Ref. Mistika: Visual Editor->Canvas->Toggles->FX Presets

The  purpose  of  this  panel is  to  make  saving  and  the  application  of  predefined  effects  (
presets) easier. 
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This panel interacts with the Visual Editor, by keeping the active clip as a preset, or loading
a previously stored preset, replacing the selected clip  or adding  it  on top  of  the  specified
clip. 

The panel consists of a browser similar to Media. It also contains, a special group of buttons
with the special save and load commands.

Its function is to make it easier to apply user-defined effects.

For example, one recurring task is to apply the same  color correction to  different  clips.  In
this case, the panel offers the same  functionality  as  the  "color note" system in  telecines.
The panel has ten memories into which the user can load predefined  effects  to  be  applied
on the viewed image with a simple keyboard shortcut (the ten numerical keys) replacing the
effect by selecting or adding the new effect over the existing ones. 

The panel has 10 memories (PR0-PR9 ) which the user can load with predefined effects for
their later retrieval to apply these effects to the viewed image,  re-employing  the  selected
effect or adding the new effect to the existing ones.

The  browser can navigate  through any  directory,  but  its  start  directory  is  the  /PRESETS
subdirectory of the current project. 

Commands:

Navigation commands  

Recover Snapshot

Assigns the icon image of the preset for the Snapshot tool.

Set Destination Folder

Sets the directory where the presets are saved. To do so, it  is necessary to locate it
in the desired directory (via the browser) before defining the command.
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Max

Expands  FX  Presets  to  fullscreen.  To  return the  panel to  its  normal size,  press  this
button again.

Hide Ctrls

Hides the group of buttons which has the commands special of the panel. To un-hide
the group of buttons, press the keyboard shortcut of this command.

Creation commands 

Create

Saves a copy of the viewed effect  in the explored directory, opening  a  dialog  box in
which  the  user  specifies  the  name  of  the  preset  created.  Also,  the  name  will  be
preceded by three automatically created numbers.

Note:  The  Eval  Tree  evaluation  level  is  saved,  not  the  manipulation  level.  If  the
selected effect is a color corrector, the extension of the saved preset is .pcc  whereas
for other effects, including groups and templates, the extension is .pfx. In both cases,
the file saves the current  viewed image as an icon from the created preset, to make
identification of the saved effect easier.

Cr. Auto

Saves  a  copy  of  the  viewed effect  in  the  explored  directory,  generating  a  name  of
three automatically created numbers 

Replace

Replaces  the  selected  effect  as  Eval Tree  evaluation level with  the  effect  selected
from the panel explorer.

On Top

Adds  the  selected  in  the  panel explorer on  top  of  the  highest  clip  of  the  stack  of
effects evaluated by the Tree.

Note: the user can also access the Replace and On Top commands directly  way,  by
double clicking on the desired preset icon. 

If the clip selected in the evaluation level of the Eval Tree  is  an effect,   the  preset
selected  in  the  explorer by  double  clicking  replaces  this  effect.  However,  if  it  is  an
image  clip  or  a  group,  the  preset  will  be  added  on  to  of  the  highest  clip  of  the
evaluated stack of effects.
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Assignation commands 

The  PR  buttons  are  described  next:  these  are  10  memories  for  quick  access  to
presets. The 10 memories are numbered 0 to 9.

Def

Loads  the  preset  selected  in  the  browser  in  the  selected  memory,  and  remains
assigned permanently for later Mistika sessions working  in  the  same  environment.  On
the Control Surfaces it is assigned with to Alt+Number. 

Def Temp

Loads the preset  selected in the browser in the selected memory temporarily (it  does
not  remain  associated  to  the  environment),  and  will  only  work  during  the  current
Mistika session. On the Control Surfaces it is assigned with to  Mode+Number. 

Use

Replaces  the  clip  selected  in  the  evaluation level of  the  Eval  Tree  with  the  preset
selected in the explorer.

On Top

Adds the preset  selected in the explorer on to highest  clip of the evaluated  stack of
effects.
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Eval Tree

Ref. Mistika: Visual Editor->Canvas->Eval Tree

This panel shows the flow of the current frame as a vertical schematic  similar to a directory
tree. An evaluation level and an independent level of manipulation can be selected from this
flow 

Note:  Bear in  mind  that  if  the  same  flow  contains  clips  of  different  durations,  the  flow
representation will vary when moving the active frame, so that  certain branches in the tree
will appear and disappear. 

In  this  tool,  clips  are  represented  in  a  simplified  version  with  an  icon  for  each  clip  that
conforms to the evaluation stack, thus helping to identify each process.

The  evaluation level  appears  with  the  flow  line  highlighted  in  purple.  This  level  must  be
defined by double-left-clicking the branch of the process to be evaluated. 

The  manipulation level appears  with  the  flow  line  highlighted  in  green.  This  level must  be
defined by single-left-clicking on the branch of the process that  is to be manipulated.  The
indicated  branch  of  the  process  is  a  clip,  which  is  selected  for  editing  either  from  the
manipulators or from its parameters viewed in the area Parameters.

Note:  Within  the  Eval Tree  tool,  it  is  not  possible  change  the  associations  in  a  process
flow. It  is necessary to manipulate the effects clips and their environments  from the  Node
Graph Editor.
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If the effect  selected  by  the  manipulation level is  an effect  with  multiple  definable  inputs
(for example  Comp3D)  an  additional  input  indicator  will  be  seen,  in  the  form of  a  green
triangle.

Group clips can be a-collapsed within the Eval Tree, allowing them to be navigated, keeping
the evaluation outside the group. Each group has a symbol on its right-hand side which a-
collapses its contents. 

Note: Given that the groups can be edited, the Keyframe Slider  only shows the duration of
the edited group and not the total duration of the clips it contains.

If the flow size is greater than the panel, it  is possible to slide the view, right-clicking and
dragging  on the  panel.  To  control other aspects  of  the  view,  this  panel also  has  a  small
button panel at the bottom whose commands are as follows: 

Width Fit

Modifies the width of the panel to the total content of the tree being viewed.

Width More

Increases the width of the panel. 

Width Less

Reduces the width of the panel. 

Show Alpha

Shows the alpha cannel of the icons of the clips. 

Storyboard

To activate this toggle, select  one of the viewing  modes:  SB Split  (one  or several images
will appear below the canvas) or SB Full (maximized to fullscreen). This does not  appear by
default, as the command SB Off will be active.

The  Storyboard  allows  navigation  through  the  different  shots  contained  within  the  Node
Graph without needing to exit the Visual Editor.
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Note:  Storyboard  can  ignore  Mistika  effects  that  are  not  strictly  Color  Grade  color
correctors by using the option Colourist  Mode  in  Mistika  Setup  (Mistika  Setup->Tangent
Devices->Colourist Mode).

For  this  tool  to  work  correctly,  it  is  recommendable  to  organize  the  Node  Graph  with
adjacent clips which have only one Color Grade corrector.

Storyboard consists of a limitless image strip, which grows according to the number of edits
detected in the Node Graph. It  can grow  horizontally  and,  if  there  is  more  than one  row,
vertically.

Each clip is represented by a reference frame (Poster Frame), which shows the last  frame
viewed by the Visual Editor, or, if this is absent, the first frame of each clip.

The viewing tools SB Less and SB More are used to navigate through the Storyboard,, and
they  allow  the  addition  and  removal  of  new  viewing  rows,  automatically  positioning  the
poster frames  in  the  lower rows  according  to  their order in  the  Node  Graph  (from left  to
right  and  from top  to  bottom).  These  rows  correspond  in  size  to  those  selected  for  the
poster frames (from SB Z1 to SB Z4, from smaller to larger, respectively). 

To  move  the  image  strip  and  see  more  distant  edits,  use  the  right  mouse  button,  or the
secondary  button  in  other  devices;  this  can  be  done  for  either  horizontal  or  vertical
navigation according to the viewing mode set for the Storyboard.
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Scroll  Active  and  Scroll  Selected  fix  the  position  of  the  active  selector  and  the  Select
respectively, so the storyboard is the one that moves, not the selectors. 

Lock Offset locks the relative position of the clip in use (white frame) and the selected clip
(red frame) for ease of navigation for correction of clips between alternating shots, such as
dialogue  sequences.  In  combination with  Lock  Head,  the  user  can  permanently  keep  the
relative position between the shot  in use and HeadB; or set  HeadB in a reference shot  and
lock the  relative  position  between the  clip  in  use  (white  frame)  and  the  selected  clip(red
frame), and be able to return at any time to the clip assigned as HeadB.

Lock Head locks the position of HeadB as selected clip (red frame).

The Autosnapshot  function generates snapshots automatically when we move  the  selector
in  the  Storyboard.  Basically  it  joins  the  Select  Prev/Next  function  in  Bring  and  Snapshot
Selected in the Snapshot menu

Create All Icons generates all the images of the Storyboard and save them in .rgb format  in
PRIVATE folder inside the Project directory. This command allows to speed up the movement
in the storyboard, which loads instantly when the  icons  are  created.  With  Flush Icons  we
can eliminate these images.  

To skip to the next  color corrector,  use  the  commands  Next  Edit  /  Prev  Edit  of  the  Node
Graph Shuttle, skip to another clip directly using the Storyboard, selecting the poster frame
within the image strip,while holding <Shift> clicking the desired image.

Another main function of Storyboard is as a shortcut to run the command Bring, by double-
clicking any poster frame which brings the selected correction to the clip being viewed and
edited in the Visual Editor. 

The commands Snapshot Selected and Bring->HeadB to Selected can also be run directly
in  the  Storyboard.  Hold  <Ctrl>  and  click a  poster frame,  which takes  a  snapshot  of  the
frame being viewed in this poster frame  (this  can also  be  done  with  the  Snapshot  toggle,
selecting the poster frame and the command Snapshot Selected). To set HeadB, hold <Alt>
and double-click the poster frame where we want HeadB to be set.

Scopes

With these  Toggles  it  is  possible  to  activate  up  to  four monitors  in  order to  evaluate  an
image via vectorscope-type graphics, waveform monitors or RGB, YUV and Luma histograms.

In  the  case  of  the  evaluation of  a  stereo  clip,  the  active  Scope  differentiates  the  signal
from each eye with the colors red an cyan.
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Mode

This dropdown button defines the type of monitor the evaluation of the image will use.

Vectorscope

Vectorscope  mode  which  shows  a  statistic  of  colors  present  in  the  image.  In  the
center  of  the  circle  are  the  unsaturated  colors,  and  around  the  edge  are  the
saturated colors. Vectorscope has orientative boxes that represent the position of the
primary and secondary colors in their maximum saturation.

Wform RGB

RGB waveform mode showing brightness levels in three columns corresponding to each
channel, Red, Green and Blue.

Wform RGB Overlap

RGB + Luma  waveform mode,  superimposing  the  luminance  graphic  to  the  brightness
level of the three channels separately: Red, Green & Blue.

Wform YUV
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YUV waveform mode showing brightness levels in three columns corresponding to each
component, Luminance (Y), Red minus Luminance (R-Y=U)  and  Blue  minus  Luminance
(B-Y=V).

Wform Luma

Classic waveform mode showing brightness levels. 

Histo RGB

RGB histogram mode which shows the statistic  of number of pixels  according  to  their
value for each channel: Red, Green and Blue. 

Histo YUV

YUV histogram mode which shows the statistic  of number of pixels according to  their
value  for each component:  Luminance  (Y)  ,  Red  minus  Luminance  (R-Y=U)  and  Blue
minus Luminance (B-Y=V).

Histo Luma

Histogram mode which shows the statistic  of the number of  pixels  according  to  their
Luminance value.

Stereo Channel

Dropdown button that sets whether the evaluation graphics of the monitor correspond
to Left Eye, Right Eye or to both eyes of a stereoscopic image (Both Eyes).

Brightness

Graphic  brightness control. This button should be  clicked  and  dragged  to  the  edges:
to the left reduces brightness, to the right increases it. 

It  is  also  possible  to  control  graphic  brightness  by  left-clicking  on  the  graphic  and
dragging to the edges.

Zoom

Controls the degree of zoom of the scopes, allowing the visualization of values above
1024  or  below  0  (if  NP  is  active).  This  very  useful  for  controlling  superwhites/
superblacks, and for workflows with HDR material.

Positive and Negative values

Allows the visualization of values below 0.

Scope Size

Controls the size and the quality of the scope.
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Quality

Switches  between  Best  quality  and  Fast  quality  (Fast  quality  requires  fewer
resources).

Move

Once the graphic view is enlarged, this repositions it by right-clicking and dragging

Snapshot

Snapshot  is a useful tool for comparing color corrections of  different  clips,  helping  balance
colors in different shots.

To create a snapshot, simply run Snapshot  Current  from its dedicated interface or select  a
poster frame  from within  the  image  strip  of  the  Storyboard,  via  the  command  Snapshot
Selected. These  commands  save  an image  in  a  memory  that  can be  viewed in  the  full  or
split screen.

To  see  the  snapshot  in  fullscreen,  run  Show  Snapshot  (it  will  mark  at  the  foot  of  the
Snapshot image indicate that a capture is being viewed).

If we wish to share the Snapshot  with the clip active in Storyboard on a split  screen,  use
one of the three following modes: Show Split  (the  last  viewing  configuration used),  Preset
Split Wipe (a generic split screen view) and Preset Split SBS (Side By Side viewing in order to
have both images whole). To modify the dividing line of the Snapshot, use the Wipe Position
and Wipe Angle tools (with the tool Draw Outline we can view the edge that indicates which
image is the snapshot). The relative sizes  of  the  two  images  being  compared  can also  be
modified  with  Snap Position,  Snap Zoom  (for the  memorized  image)  and  Live  Position  and
Live Zoom (for the image being worked upon). 

It  is  also  possible  to  control  this  dividing  line  and  change  its  angle  of  rotation  via  the
Tangent  Devices  control  panels.  For  more  information,  see  Annex  3:  Mistika  Tangent
Devices.

Depth Graph

The Depth Graph toggle invokes the stereoscopic evaluation tool of the Stereo3D Editor.

For more information, consult the section Depth Graph in Stereo 3D.



307The Interface

SGO Mistika 8.6 © 2018 SGO

Keygrame Graph

The   Keyframe  Graph  toggle  invokes  the  curve  animation  editing  tool  of  the  area
Parameters.

For more information, consult the section Keyframe Graph of the  Node Graph Editor.

Zoom Controls

Ref. Mistika: Visual Editor->Canvas->Zoom Controls

Zoom In

Enlarges the view of the evaluated image in the Canvas.

Zoom Out

Reduces the view of the evaluated image in the Canvas.

The most convenient method for adjusting horizontal zoom is usually the mouse wheel,
since it is linked to the hotkeys <Up> and <Down>.

Panning: Once the image is  zoomed,  reposition  it  by  left  clicking  the  mouse  on the
image and holding down <Alt> and <Ctrl> whilst dragging the cursor.

Note: The enlargement, reduction or repositioning  of  the  image  is  only  visible  in  the
Canvas, and not in the video output.

Zoom Center

Repositions the evaluation area of the Canvas in its central position, independently of
value the of zoom or the position defined with the right mouse button.

Zoom Reset

Restores the default zoom factor and centers the evaluated image in the panel.

Display Filters Shortcuts

T1, T2, T3, T4

Allows  the  combining  of  and  switching  between  the  use  of  various  Display  Filters
previously  created  and  selected  for  each  shortcut  in  the  Visual  Editor->Display
Filters.
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Keyframe Slider

Ref. Mistika: Visual Editor->Canvas->Keyframe Slider

The Keyframe Slider is a offset control for the duration of the effect selected. 

The  ruler  represents  the  totality  of  the  duration  of  the  clip  and  is  especially  useful  for
evaluating the position of the keyframes in an animation.

This  slider  has  a  manipulator  with  the  number  of  the  active  frame  of  the  effect.  This
manipulator should be left clicked, and then dragged horizontally

To move the manipulator frame by frame, left-click at the sides of the manipulator. 

The Keyframe Slider  controls offer the possibility of carrying out  dynamic  color corrections
(using  all  the  manipulators  of  Color  Grade)  without  needing  to  use  the  Curves  tool  or
defines the values in Parameters.

Dynamic  color correction is defined by one input  point  and one  output  point.  These  points
generate  a  correction range  represented  by  a  green bar.  The  duration  of  this  correction
range  can modified  by  moving  the  input  and  output  points  selecting  them with  <Ctrl>+
<LeftClick>.

Key In

Sets the input keyframe for the color correction. It is represented by a green triangle.

Key Out

Sets the output keyframe for the color correction. It is represented by a red triangle.

Neutral Key

Inserts a keyframe in the current frame with the default values of the color corrector.

Note: The aim of this command is to remove the values applied to the input  or output
point  of the dynamic  correction. To do this, it  is only necessary to  position  it  in  any
previous or later frame in range of the dynamic correction.

Delete Key

Eliminates the keyframe  found  in  the  current  frame  within  the  range  of  the  dynamic
correction.

AutoKey

Activates the no-animation mode of parameters. 

If activated, this mode establishes that any modification carried out  from the fields of
values will displace the curve in its totality. 

If deactivated, a keyframe is automatically inserted in the active frame each time we
modify a value.
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After Last

Specifies the active frame to be located in the frame after the end of the effect  (the
clip Out  Point). This allows parameters to be edited with the  manipulators  in  a  frame
after the last one, thus making it possible to maintain a parameter animated up to the
second field of a video sequence. 

Feedback

Activates  constant  updating  of  the  evaluation.  When  this  option  is  turned  off,  the
image is only evaluated when a manipulator is released or the dragging of a value from
the Parameters area is stopped, but it will not be evaluated during modification.

If deactivated, the Keyframe Slider  will also cease to update the image until a frame
is released. 

When  the  effects  are  complex,  it  is  advisable  to  deactivate  this  option,  to  avoid
delays due to constant evaluation during the modifications.

Quick Access

Ref. Mistika: Visual Editor->Canvas->Quick Access

The  Quick  Access  button  bar  provides  direct  access  to  a  series  of  frequently  used
commands and tools that are common to the different working modes in Mistika.

These commands are divided into groups according to their functions.

Timeline Shuttle

These  functions  allow  control  of  the  offset  of  the  Node  Graph  belowMonitor,  without
needing to exit the Visual Editor.

Prev Edit

Moves the selection in the Node Graph to the previous cut  found in the range of the
monitor, updating the duration of the Keyframe Slider to the new selection.

A cut is the first frame of the head of a clip or the one following its tail, regardless of
the track it is found in.

Play Reverse

Activates  playback  of  the  Monitor  of  the  Node  Graph  in  reverse.  Only  the  active
monitor of the Node Graph will carry out the evaluation and not theVisual Editor.
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Stop

Stops the progress of the Monitor  of the Node Graph. When topped, the selection of
the Visual Editor is updated to the top clip superior of the last evaluated pile.

Play

Activates playback of the Monitor  of the Node Graph. Only the active monitor of the
Node Graph will carry out the evaluation and not the Visual Editor.

Next Edit

Moves the selection in the Node Graph to the next  cut  found within the range of the
monitor, updating the duration of the Keyframe Slider to the new selection.

A cut is the first frame of the head of a clip or the one following its tail, regardless of
the track it is found in.

Play Buffer

Activates playback of the information stored in the buffer.

Bring

The  Bring  commands  interact  with  the  toggle  Storyboard,  making  especially  possible   the
navigation and propagation of color corrections within a previously conformed Node Graph.

The  color correctors  and  effects  of  Mistika  are  capable  of  keeping  a  record  of  changes,
which can be recalled via the Bring Older / Bring Newer commands. The color corrector that
has created the history will possess on its poster frame two numbers separated by a slash.
The  first  number  indicates  the  current  memory  being  viewed,  while  the  second  number
indicates the total quantity of memories that the current effect has.

To create memories, bring previous or later corrections, new or old, use the commands Bring
, which are described below.



311The Interface

SGO Mistika 8.6 © 2018 SGO

Select Prev

Selects  (with  a  red  mark)  the  next  poster  frame,  following  the  read  order  of  the
Storyboard.

Select Next

Selects (with a red mark) the previous poster frame,  following  the  read  order of  the
Storyboard.

Bring Prev

Brings the  correction of the previous clip to the clip active in the Storyboard.

Bring Next

Brings the correction of the next clip to the clip active in the Storyboard.

Bring Original

Brings  the  correction  that  the  clip  initially  had  when  defined  as  active  in  the
Storyboard, restoring the previous values to the navigation.

Bring Modified

Brings the last correction that was modified in the clip active in the Storyboard.

Bring FX

Brings the effect or color correction selected in the Storyboard to the active clip.

Note: the selected clip, indicated with a single click, is marked with a red frame, while
the active clip is marked with a white frame.

Bring Ok

Saves in a memory  the color correction present  in the clip active in the Storyboard.
Each time this command is used successive numerically identified memories are saved .

Swap Playheads

Swaps HeadB and the  clip  in  use  (white  frame),  allowing  the  alternate  correction of
both clips. The default keyboard shortcut is <keypad¨.¨>

HeadB to Selected

Defines the selected clip (red square) as HeadB.
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Go to Selected

Changes the selected clip (red frame) to clip in use (white frame), as well as  moving
the Monitor of the Node Graph to this clip (positioning it  over the frame viewed in the
Frame Poster).

Delete Current H

Deletes the memorized correction in use, renumbering the remaining memories.

Lock Selection

Locks the relative position of the clip in use (white frame) and the selected  clip  (red
frame) for ease of navigation for correction of  clips  between alternating  shots,  such
as dialogue sequences. 

In combination with  Lock Head,  the  user can permanently  keep  the  relative  position
between the shot  in use and  HeadB;  or set  HeadB in  a  reference  shot  and  lock the
relative  position  between  the  clip  in  use  (white  frame)  and  the  selected  clip(red
frame), and be able to return at any time to the clip assigned as HeadB.

Lock Head

Locks the position of HeadB as selected clip (red frame).

Bring Preview

This functionality allows the previewing of a color correction in the  active  shot  while
we have the button pressed. When the button is released the preview will disappear.
For ease of use there is a shortcut  in the  Storyboard  accessed  by  mouse  or pen:  if
we click and hold in the shot  with the color corretcion we  wish to  view,  we  will  see
the  active  shot  with  the  correction  applied  to  it.  When  we  release,  the  preview
disappears.  If  we  want  to  apply  a  preview  to  the  shot,  simply  follow  the  previous
procedure to preview, and while maintaining the  shot  clicked  drag  the  mouse  or pen
up. 

Bring Older

Navigation  mode  that  recovers  a  memory  previously  defined  in  the  corrector.  The
direction is towards the first saved memory (Older).

Bring Newer

Navigation  mode  that  recovers  a  memory  previously  defined  in  the  corrector.  The
direction is towards the last saved memory (Newer).

Bring H1, H2, H3, H4, H5, H6, H7, H8, H9, H10

Navigation  mode  that  recuperates  a  memory  previously  saved  in  the  corrector
according to its numbering,with H1 representing the first  (or oldest) and H10 the last
(or newest).
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Gang

The functions in Gang act directly on the Storyboard tool, enabling navigation through, and
organization, comparison and propagation of color corrections within a previously conformed
 Node Graph. It is also essential in its interaction with the Propagate tool.

The  use  of  Gang  is  focussed  on  the  grouping  of  shots,  principally  for  color  correction
(although it can also be used with any kind of clip), making it  easier to compare, propagate
and  navigate  between the  selection of  shots  that  have  been  classified.  It  is  possible  to
create  gangs  (groups  of  shots  under  the  same  indicative  name)  as  required,  with  their
classification appearing in the Storyboard with Gang superimposed over the thumbnail of the
shot.

The  same  shot  may  have  more  than  one  Gang  indicator;  if  so,  the  different  names  will
appear over the thumbnail in the Storyboard.

Gang

In this  first  tab  it  is  possible  to  choose  the  desired  gang  from a  dropdown list  that
shows all the gangs that have been created.

New Gang / Delete Gang

Allows the  creation of  new  gangs  and  the  elimination of  those  selected  in  first  tab.
When creating a new gang, a window with a write-field will appear fro name the gang.

Solo

Activates only the mode of the selected gang. When using this mode, the Storyboard
will  show  only  the  shots  associated  to  this  Gang,  and  the  navigation  functions  will
obey this shot restriction. On the other hand, the functions related to the Node Graph
, such as Play are not subject to Solo mode.

Add / Remove

When adding  or eliminating  any  shot  to  or from a  Gang,  there  are  three  modes  for
grouping this shot shown in the Storyboard under the given gang. To add or eliminate
it, left-click on it in the Storyboard while holding down <Ctrl>+<Shift>.

Add / Remove from gang only for the edited layer

Adds or removes from the gang only the layer of the shot being edited. 

Add / Remove from gang all effects of the current stack

Adds or removes from the gang all  the  layers  of  the  current  stack of  effects  of  the
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shot.

Add / Remove from gang all effects of the current stack of the same type as the
edited effect

Adds or removes from the gang all  the  layers  of  the  current  stack of  effects  of  the
shot that are the same type as that being edited.

Composer Shuttle

Functions for playback and evaluation of the Visual Editor.

Go To Start

Moves the Visual Editor back to the first frame of the selected clip.

Prev Key

Moves the evaluation back to the first frame with a keyframe.

Play Backwards

Activates playback of the Visual Editor in reverse for the duration of the clip selected.

Stop

Stops playback of the Visual Editor in the duration of the clip selected.

Play

Activates playback of the Visual Editor in the duration of the clip selected.

Next Key

Moves the evaluation forward to the next frame with a keyframe.

Go To End

Moves the Visual Editor forward to the last frame of the selected clip. 

Play All

Activates  playback  without  pausing  at  the  end  of  the  clip  that  is  loaded  into  the
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Visual Editor. When stopped manually, the current clip is loaded.

Loop

Activates  continuous  looped  playback of  the  selected  clip.  This  button  is  especially
useful when used  in  conjunction  with  Mistika  Live  to  enable  on-set  viewing.  When
activated, the Mistika Live input can be refreshed continuously in the Visual Editor.

Full Screen

Display the image of the Visual Editor to full screen.

Options

These affect these viewing  mode the evaluated images.

View

Sets the channels of the image viewed in the evaluation of the Visual Editor.

RGB

Shows the RGB channels of the image.

R

Shows the red channel of the image.

G

Shows the green channel of the image.

B

Shows the blue channel of the image.

Alpha

Shows the alpha channel alpha in grayscale.
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RGBxA

Shows the alpha channel multiplied by the channels of the image.

This  option  does  not  affect  how  the  image  is  composed  although  it  allows  us  to
evaluate visually how the image would be when pre-multiplied by its alpha channel and
composed on a black background. This evaluation is especially useful in effects which
have the parameter "Premultiply" activated. 

Res

Controls  the  evaluation  resolution  of  the  Visual  Editor,  which  allows  us  to  choose
between better image quality or more interactivity when making changes.

Proxy

Sets the evaluation of the Visual Editor in low resolution (resolutionProxy).

Dynamic

Sets the evaluation in dynamic  mode, automatically switching between low resolution
during the editing of a  parameter and  returning  to  high resolution when releasing  its
manipulator or stopping dragging the value from Parameters.

This also activates the switch to low resolution while dragging the Time Slider

Full

Sets the evaluation of the Visual Editor in high resolution.

Interlaced

Sets  the  evaluation done  in  the  resolution to  only  one  field,  and  not  to  the  entire
frame.

Note: This option is especially useful in the case  of  the  evaluation from the  monitor
being  sent  to  the  video  output,  avoiding  the  flicker between fields  generated  when
the monitor is stopped on an interlaced clip.

Live

Sends the evaluation of the Visual Editor to the video output.

Parameters

Ref. Mistika: Visual Editor->Parameters

This area shows and edits the values of parameters of any effect  clip, Timewarp  group  or
audio clip selected from the toggle Eval Tree or derived from a selection made in the Node
Graph.

For more information, consult the chapter Parameters of the Node Graph Editor.
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Dashboard

Ref. Mistika: Visual Editor->Dashboard

The Dashboard area contains various interactive manipulation interfaces  whose  application
modifies  the  parameters  of  effects  and  the  behavior  of  clips.  It  also  contains  evaluation
tools and submodes pertaining to some effects.

Depending on the effect parameters selected, different manipulation modes will be available.
The tabs (Manipulators Tab) that are not available for the selected effect will deactivate,
and only those available will be shown.

The  manipulation modes  of  the  Dashboard  are  organized  according  to  their functions  and
are accessed via the Manipulators Tab:

Set Color

Specifies the color values for different  manipulators in effects  with  color parameters.
They can also be specified by selecting an image color. 

Pick Key

Specifies ranges of tolerance and transparency  (softness)  of  the  mask being  edited,
which can be specified in the image or from a manipulator in the graphical histogram. 

Framing

In  effects  that  possess  cut  (Crop)  parameters,  the  values  of  these  parameters  are
defined via  manipulators  on the  image  assigned  to  each side  of  the  frame.  This  tab
also  contains  tools  to  assist  the  user  in  the  calculation  of  standard  letterbox-type
aspects and masks.

Stereo3D

Tab with manipulators dedicated to work on stereoscopic  images. To use these tools,
it is necessary activate the stereo mode (Use Stereo Mode) in the Quick Access bar.

2D
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In effects with XY  position parameters, this specifies the two-dimensional position by
using a cross-hair image manipulator that can be dragged over the image. 

Comp3D

This  is  used  exclusively  by  the  Comp3D  effect  and  specifies  the  three-dimensional
position  and  rotation of  each layer by  using  manipulators  on  the  image,  as  well  as
camera views, lights, and other functionalities associated with this effect. 

RGBCorrect

Specifies the values of an RGB color correction with a manipulation interface based on
knobs, balls and rings that emulate the behavior of a telecine interface. 

Color Grade

Specifies the values of an RGB color correction via a manipulation interface based  on
knobs, balls and rings structured in successive layers or nodes called vectors.

Open FX

Enables the viewing of Open FX plugins directly in the Visual Editor.

Shapes

Interface for generating and modifying vectorial forms (Shapes) that  modify the alpha
channel of the selected clip.

Paint

Access to the  submode  Paint  Editor.  This  tool contains  manipulators  that  pertain  to
 the effect VectorPaint.

Title

Access to the submode Title Editor. This tool contains commands that  pertain to the
effect Title.

Warper

Access to the submode Warper Editor. This tool contains manipulators that  pertain to
the effect Warper.

Tracking

Access  to  the  submode  Tracking  Editor.  This  tool  extracts  information  about
movement  of  an image  to  be  applied  to  two-dimensional  parameters  of  any  effect.
This mode is always accessible independently of a clip of an image  or type  of  effect
selected.

Set Color

Ref. Mistika: Visual Editor->Dashboard->Set Color

This manipulator is  accessible  from all  the  effects  with  color parameters,  and  is  shown in
Red, Green and Blue, as also in Hue, Saturation and Lightness.

Some  effects  have  more  than one  set  of  color parameters.  To  work correctly  with  these



319The Interface

SGO Mistika 8.6 © 2018 SGO

effects, it  is necessary to  choose  explicitly  one  of  their folders  with  color parameters,  by
selecting the folder from the folder list with the left mouse button. On the other hand, if  the
selected effect has only one set  of color values, the manipulator will always work with this
set without having to select it. 

The manipulators of this mode are viewed in the Dashboard.

The color selector will initially show the color values that  the parameter being edited has at
that moment: 

The  Sliders  viewed  in  the  manipulator  show  the  value  of  the  color  component  at  each
moment.

The user can specify the active color with the following different procedures:

Pick Color

Select  the  current  color from an image  pixel.  To  use  this  button,  press  and  drag  it
with  the  left  mouse  button,  and  without  releasing  it  until  the  pixel  whose  color  we
wish to obtain as been reached. 

WYSWYG  (What You See Is What You Get)

Specifies that  the background of each unedited slider changes its color interactively,
which helps the user to position the slider on the color waned. 

RGB Sliders

Controls that specify a color by its percentage red, green and blue. The value of each
channel is shown at  the right  of each slider, expressed as an editable 8 bit  numerical
value (256 levels). 

HSL sliders

Controls that specify a color by its percentage tone, saturation and value. 

Color Wheel

color wheel that  specifies the saturation (radius vector) and the  hue  (vector angle),
together with a vertical slider that controls the color value. 
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Color Store

Library where the user can save or load colors. To save the active color, click on an
open library cell. To load a color to the library, click on one of the saved colors. 

The library also has two small buttons:

Delete

Eliminates the selected color.

Pack

Orders the boxes of colors used.

The Set Color manipulators can be used for different purposes:

Specify a color.

In  certain  effects,  specify  levels  of  black  and  white,  or  carry  out  a  white
balance (for more information, see the chapter Color Grade).

Note:  For the  Color  Key  effect,  select  the  crop  colors  in  the  image  with  successive  left
mouse  button clicks  on  the  image,  without  needing  to  use  the  sliders  or  the  Pick  Color
button.

Pick Key

Ref. Mistika: Visual Editor->Dashboard->Pick Key

This specifies the values of the Toler and Soft parameters for the selected effect. 

These  parameters  specify  the  transparency/opacity  values  of  the  generated  mask,
generating  a  decreasing  slope  of  opacity  between the  values  specified  by  the  Toler  and
Soft parameters, which is interpreted as the hardness or softness of a specified mask. 

The user can choose either of the two following methods to specify these parameters.

The user can choose either of the two following methods to specify these parameters.

From the Histogram panel
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This Histogram represents the number of pixels (Y  axis) in the image for each possible tonal
value used by the effect  (X axis), and has two marks to manipulate the range of values to
be used to create the mask. All the pixels with tonal values to the right of the Soft  mark will
produce a totally transparent mask, while values to the left of the Toler  mark will produce a
totally  opaque  mask.  Values  between  the  two  marks  specify  the  values  for  semi-
transparency, decreasing from left to right.

From the image

Where values can be directly selected on the image, click first  on one  of  the  two  buttons
on the panel (buttons  Pick Transparent  and  Pick Solid)  and  then select  any  value  on the
Visual Editor image  by  left  clicking  and  dragging,  which selects  the  average  value  of  the
pixels included in the block.

Framing

Ref. Mistika: Visual Editor->Dashboard->Framing

This  tab  contains  the  parameters  for  rescale  and  crop  (functions  also  known  as  “Pan  &
Scan”)  if  the  clip  to  be  corrected  has  a  different  resolution  to  that  of  the  job,  these
parameters allow reframing of the material for the correction.

The  tools  of  the  Framing  tab  defines  the  values  of  the  parameters  of  the  folders  Crop,
Offset and Scale

These functions can scale the original resolution, thus avoiding use  of  an additional effect
for this task.

Canvas

In the Canvas, this manipulator has four dotted lines drawn on the image that  represent  the
position of each cut margin of the effect.

These  manipulators  can  be  individually  specified  by  dragging  them  with  the  left  mouse
button. The crop can also be transformed using the corners and the rectangle can even be
moved by left clicking in the center.

Dashboard

In this manipulation mode,  the  Dashboard  has  a  button panel to  assist  the  user with  the
crop expressed according to aspect relation of values expressed in current pixels.
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Rescale:

Rescale Apply

Activates/deactivates the rescale and crop function.

Quality

[Bilinear (Nearest/Bilinear/3 Taps/Bicubic/5 to 15 Taps)]

In  the  dropdown  parameter  list,  the  available  qualities  are  ordered  from  lowest  to
highest  from top  to  bottom.  It  is  recommendable  to  specify  the  lowest  quality  that
gives  visible  improvements,  as  the  higher the  quality  specified,  the  more  calculation
time required.

Auto Resize:

Fit X; Fit Y

Automatic rescale commands that adjust the original resolution of the image to values
defined by the horizontal or vertical resolution of the Mistika project,  maintaining  the
aspect ratio.

Set Crop:

This  group  contains  buttons  that  apply  preconfigurations  for  cuts  that  are  adjusted  to
norms used in the audiovisual industry.

The text field Apply Custom allows the application of value defined by the user.

Source Size:

Source Size X

Shows the horizontal resolution of the original image.

Source Size Y

Shows the vertical resolution of the original image.

Source Ratio

Shows the value of relation of the aspect ratio of the original image

Note: These numerical fields are not editable.

Result Size:

Result Size X

Shows the horizontal resolution of the resulting output image.
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Result Size Y

Shows the vertical resolution of the resulting output image.

Result Ratio

Shows the value of relation of the aspect ratio of the resulting output image.

Note: These numerical fields are not editable.

User Crop in Pixels:

Left; Right; Up; Down

Sets cropping for an image form its four margins, drawing in black the exterior area to
be cropped and cropping the alpha channel.

Lock Ratio

If this state button is active, the XY relation of the aspect ratio is maintained.

Reset

Command that restores the crop to its original values.

User Resize and Offset in Pixels:

Scale X; Y

Defines the rescale value in pixels of the output image.

Offset X; Y

Specifies a two-dimensional offset output image, expressed in percentage units.

Lock Result Ratio

If this state button is active, when rescaling a image, the XY  relation of the  "aspect
ratio" is maintained according to the value shown in the box Result Ratio.

Lock Current Ratio

If this state button is active, when rescaling a image, the XY  relation of the  "aspect
ratio" is maintained according to the values set in Scale X and Scale Y.

Reset

Command which restores the rescaling to its original values.
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Stereo3D

Ref. Mistika: Visual Editor->Dashboard->Stereo3D

This set of manipulators is especially designed for stereoscopic effects. 

This Manipulator Tab is activated by selecting the group Stereo3D. 

For a detailed description of this panel, read the chapter on Stereo3D.

2D

Ref. Mistika: Visual Editor->Dashboard->2D

In effects with XY  position parameters, this specifies the two-dimensional position by using
an image manipulator that can be dragged over the image. 

Some effects have more than one set of two-dimensional position parameters. To work with
these  effects  correctly,  one  of  its  folders  with  two-dimensional  parameters  must  be
explicitly chosen, by selecting the folder from the folder list with the left mouse button. 

However, if the selected effect only has one set of two-dimensional values, the manipulator
will always work with it without needing it to be selected. 

The  manipulator  appears  on  the  image  as  a  cross  that  specifies  the  two-dimensional
position. This manipulator can also be placed in the inactive area of the Visual Editor.

Comp3D

Ref. Mistika: Visual Editor->Dashboard->Comp3D

This specifies a three-dimensional position for the all components of the Comp3D effect.
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This  manipulation mode  has  manipulation options  and  different  types  of  manipulators  that
are controlled from the Canvas and from the Dashboard.

Canvas Manipulators

The  types  of  visual manipulator shown below  correspond  to  each  object  type  existing  in
three-dimensional space, and are as follows:

Layer

Manipulates a selected layer. The layer can be moved, rotated or scaled in one or all
its axes from its manipulator.

Note:  A  layer  is  effect  input  that  can  be  manipulated.  The  input  specified  as  the
background  (if  it  exists)  cannot  be  manipulated.  Thus,  if  Options->Background  of
the Comp3D effect  is activated, the first  input  will be the background, which cannot
be altered. 

It is also important to remember that the successive inputs added to the range of this
effect require  Folder->Add Folder  to be run to add a new parameter folder to the
Comp3D  effect,  before  they  can  be  changes  with  the  manipulators.  For  more
information see the chapter Comp3D.

Axis

Manipulates the selected global axis. All the layers can be changed at  the same time
with  this  manipulator  in  relation  to  this  axis:  moving,  rotating  or  scaling  the
manipulator in one or all its axes. 

Note:  the  effect  has  two  global axes  that  can be  selected.  The  transformations  of
these axes move all the layers of the effect  at  the same time, but  not  the lights nor
the camera. For more information see the chapter Comp3D.

Light

Manipulates the selected light. For each type of light  there is a manipulator different.
The Directional light  can  be rotated, the Point  light  can be  positioned  and  the  Spot
light can be positioned and rotated. 

Note: The lights cannot be scaled. However, the target  of the Spot  type light  can be
moved  away  from its  origin  with  scaling.  For  this  type  of  light,  the  position  of  the
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target is specified in the manipulator by the end of the arrow. For more information on
the behavior of each type of light, see the chapter Comp3D.

Camera

Manipulates the camera. The camera position and rotation in X and Y  can be changed
with this manipulator. 

Note: The camera manipulator is visible except  in the view from its own camera. The
manipulator shows the rotation in its Z axis, and  also  the  visual field  of  the  camera,
but  these  parameters  cannot  be  modified  with  the  manipulator.  Their  values  can,
however, be modified dynamically in the the Parameters  tab.  The  camera  cannot  be
scaled, but the camera target can be moved away from its origin with the scaling. The
position of the camera target is specified in its manipulator by the rectangular plane of
the  pyramid.  For more  information on the  behavior of  the  camera,  see  the  chapter
Comp3D.

Floor

Guide grid that represents a floor, situated at the level of the bottom line of the image
as it appears by default.

Global Axis / Transform Axis

All the manipulators have one  element  in  common:  the  transform axis  of  the  object.
This axis responds to direct manipulation orders. 

Direct  manipulation can be  done  by  selecting  the  axis  directly  with  the  left  mouse
button, and dragging it in any direction. 

Depending on the keys pressed, manipulation can accomplish move,  rotate  and  scale
as detailed below: 

Move

Left-click directly  on the  axis,  and  drag  it  to  a  new  position.  The  movement  of  the
axis will be relative to the projection of the current view. 

Rotate

Left-click on the axis while holding down <Alt> and drag the cursor in  any  direction.
The movement of the cursor will rotate the selected object depending on the direction
moved, emulating a spherical rotation in all the axes. 

Scale based on the horizontal movement of the mouse

Right-click on the  axis  while  holding  down <Ctrl>  and  drag  the  cursor  horizontally.
The  object  will  be  enlarged  in  all  its  axes  by  dragging  the  cursor  to  the  right,  and
reduced  by  dragging  to  the  left.  This  method  of  scaling  is  the  easiest  and  most
intuitive to use. 

Scale by defining a scaling radius

Left-click on the  axis  while  holding  down  <Ctrl>  and  drag  the  cursor  towards  the
center or the edge of the object. The object will be scaled in all its axes depending on
the distance of the cursor from the center of the object. 
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This method of scaling is somewhat  less  intuitive  until  the  user is  accustomed to  it,
although it  is much more flexible, since the scaling is done in relation to the distance
of the cursor from the center (local axes) of the object: This allows the user: 

To make  very  fine  adjustments,  clicking  on a  point  away  from the  center of
the  object  (represented  by  the  local  axes)  and  dragging  it.  The  object  will
move very slowly.

To  make  more  aggressive  adjustments  (large  changes  with  little  cursor
movement), clicking on a point near the center and dragging it, either towards
or away from the center. 

For example,  this  method  is  very  useful  when  "navigating"  in  an  image  with  a  high
Zoom factor,  and  that  therefore  needs  both fine  and  rough adjustment  at  different
moments. 

On  the  other  hand,  both  scaling  modes  can  be  combined  with  <Shift>  to  force
restrictions to certain axes, as described in the  Axis Constraint section.

Note:  if  one  of  the  manipulation  buttons  is  activated,  direct  manipulation  will  be
inhibited. 

This axis is composed of lines and arcs:

The red line represents the horizontal axis (X) of the object. 

The green line represents the vertical axis (Y) of the object. 

The blue line represents the depth axis (Z) of the object. 

The  red  arc  represents  the  plane  opposite  the  horizontal  axis  (-X)  of  the
object. 

The  green  arc  represents  the  plane  opposite  the  vertical  axis  (-Y)  of  the
object. 

The blue arc represents the plane opposite the depth axis (-Z) of the object. 

These lines and arc  can be activated to restrict  the  direct  transformation of  an object  to
one of its axes or planes, pressing the combination of  move,  rotate  or scale,  the  <Shift>
key being accurately used to select the axis or arc to be restricted. 

Dashboard Manipulators

Manip Axis:

Buttons that specify the editing mode of the manipulator of the selected object.

Move

Movement  manipulation mode. Movement  of the axis will be relative to the  projection
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of the current view, except when a constrain function is activated. 

Rotate

Rotation manipulation mode.  Movement  of  the  cursor will  rotate  the  selected  object
depending on the direction in which it  is  moved,  simulating  a  spherical rotation in  all
the axes, except when a constrain function is activated. 

Size

Size  manipulation mode.  The  object  will  be  scaled  in  all  its  axes  depending  on  the
distance  of  the  cursor  from  the  center  of  the  object,  except  when  a  constrain
function is activated. 

Pivot

Pivot  point  manipulation  mode.  The  pivot  point  is  a  three-dimensional  coordinate
relative  to  the  layer,  which  is  taken  as  the  center  of  the  layer  in  order  to  make
changes to sizes and rotations. 

Manip Cam / View:

When a view  is  edited  (group  View),  direct  editing  keys  can also  be  used.  A  view  reacts
differently to an axis, and its manipulation options also vary: 

Free Transform

<LeftClick> directly on the image, and drag it  to a new position. This transformation
moves the position of the view, and its objective at the same time, in a similar way to
a lateral camera travel. 

Orbit

<LeftClick>  on  the  image  while  holding  down  <Alt>  and  drag  the  cursor  in  any
direction. This transformation rotates the camera around the objective. 

Dolly

<LeftClick> on the image while holding down <Ctrl> and drag the cursor up or down.
This transformation moves the camera nearer to or further from the objective.

Rotate

<LeftClick> on the image while holding  down <Alt> and  <Shift> at  the  same  time,
and  drag  the  cursor in  any  direction.  This  transformation rotates  the  target  around
the camera, in a similar way to a camera header movement.

Note: if one of the manipulation buttons mode is activated, direct manipulation is inhibited.



329The Interface

SGO Mistika 8.6 © 2018 SGO

Axis Constrain:

Buttons that specify a transformation restriction in the selected axis.

X; Y; Z; YZ; XZ; XY

Restrict  the  defined  transformation  by  the  manipulation  mode  to  the  axis/axes
activated.

View:

Dropdown whose controls defines the active viewing angle.

Camera

Camera view. This is the view evaluated when a render is run. 

Note: the other views are guides only, and are not  considered in the evaluation of a
render.

Persp

Auxiliary  view  that  can be  edited.  Its  default  value  shows  a  panoramic  view  of  the
three-dimensional environment.

Front; Back; Left; Right; Top; Bottom

Auxiliary  editable  views.  Its  default  values  correspond  to  the  view  direction  of  its
name. 

Note: Editing the view can disorder all views, and any can be returned to its default
values with the View Reset function.

View Reset

Returns the view to its default value. 

Note: Camera is the only view that  can be  animated.  When this  function is  used,  a
keyframe with the default values will be added to the current frame. 

All the views can be edited via the Manip Cam/View manipulators. The buttons of the  Axis
Constrain group do not influence the editing of a view. 

Free Transform

Movement  manipulation mode. Movement  of the view will be  lateral to  the  projection
of the current view, simulating a lateral camera travel. 

Rotate

Rotation manipulation mode. Movement of the cursor will rotate the view depending on
the direction in which it is moved, simulating a camera header movement. 
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Dolly

Approximation manipulation mode. Movement  of the view  will  be  perpendicular to  the
projection of the current view, simulating a dolly camera travel. 

Note: this movement  moves  the  camera  position  towards  the  target.  If  the  camera
overshoots it, it will invert its direction. 

Orbit

Orbit  manipulation mode.  Movement  of  the  cursor will  rotate  the  view  depending  on
the  direction  in  which  it  is  moved,  simulating  an  orbital  travel  around  the  camera
objective. 

Note: to change the  orbit  center,  the  target  must  be  edited.  For more  information,
see the chapter Comp3D. 

Display:

This controls the appearance of different types of manipulators on the image.

Layers

Activates view of the layer manipulators. 

Axis

Activates view of the global axes manipulators. 

Lights

Activates view of the lights manipulators. 

Camera

Activates view of the camera manipulators. 

Floor

Activates view of the floor grids. 

Background

Activates view of the input specified as background. 

Note:  this  function  is  only  a  viewing  control,  and  does  not  modify  the  effect
parameters. The background can only be shown in the Camera view. 

Hide Arcs

Hides arc manipulators view in all object axes. 
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Note: when the position of a arc interferes with the selection of an axis, this function
helps to select the axis, as the arcs are hidden. 

Hide All

Hides view of all manipulators and elements of the 3D environment, showing  only  the
images.

Aspect:

Command for restoring size.

Resize 1:1

Command that  applies  values  of  Size  necessary  to  return  it  to  its  original  size  the
selected  layer,  since  by  default  the  Comp3D effect  (with  background)  rescales  the
resolution of each file to the work resolution as specified in Mistika Setup 

Selection:

Object selection mode. 

Auto Select

Direct  selection mode. With this mode, the user can select  an object  by  left  clicking
the mouse directly on its manipulator. 

Note:  objects  are  often  superimposed  in  three-dimensional  space,  making  direct
selection difficult.  In  these  cases,  we  recommend selecting  the  desired  object  from
the folder list of the Parameters tab.

Color Grade

Ref. Mistika: Visual Editor->Dashboard->Color Grade

This set of manipulators is especially designed for RGB color correction effects.

The Manipulator Tab is activated when selecting the color corrector Color Grade.

For a detailed description of this panel, see the chapter Color Grade.
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Open FX

Ref. Mistika: Visual Editor->Dashboard->Open FX

This tab does not  have options, but  is a manipulation mode for viewing Open FX  plugins  in
the Visual Editor. 

The OpenFX tab is only activated when selecting an Open FXPlugin effect.

For more information on Open FX manipulators, see  the  relevant  documents  accompanying
the purchased plugins or the manufacturers’ websites.

Multilayer

These  manipulators  allow  the  user to  interact  with  EXR  or  Stereo3D in  Spatial  Key  using
advanced  effects  (Spatial  Key  is  also  integrated  within  Color  Grade;  see  Spatial  Key  for
more details)

There are two groups of manipulators:

Spatial Key:

Pick object ID

Allows interactive selection of the object  we wish to mask in the Canvas by using its
ID.

Pick Position

Allows interactive selection of the object/s we wish to mask in the Canvas by using its
position in the XYZ axes.

Pick Depth

Allows interactive selection of the object/s we wish to mask in the Canvas by using its
position in the Z axis.

Pick Direction

Allows interactive selection of the areas of  light  incidence  in  an EXR scene  by  using
the reflection of its diffuse component.
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Layer Tools

Reload Layer Lists

Reloads  the  information layers  of  the  EXR  file  being  used,  if  they  have  not  loaded
automatically. 

Reload layer Lists - Stereo

Reloads the information layers of the Stereo3D clip being used, if they have not loaded
automatically.

Basic Function

The use of these automatic selection tools in Multilayer is the same for all. Starting with an
EXR or Stereo3D file, we choose the desired selection mode. Then, in the Canvas, click on
the object  we cant  to choose from with in in  the  image.  Mistika  automatically  selects  the
correct information layer to be able to carry out the required selection. Finally, we can fine-
tune the resulting mask with the parameters of the Spatial Key effect, also found within the
effect Color Grade.

Shapes

Ref. Mistika: Visual Editor->Dashboard->Shapes

This panel allows the creation and editing of animated vectorials (Shapes) which only affect
the alpha channel of the selected clip.



334 The Interface

SGO Mistika 8.6 © 2018 SGO

When the manipulation mode Shapes is activated, a special button panel with commands for
creating modifying, animating editing and setting attributes of shapes  is  seen.  Also,  in  the
tab Parameters, the parameters corresponding to the selected shape are seen;  these  can
be defined in terms of position, rotation, and  global size.  These  parameters  can be  edited
like  any  effect  parameter,  and  can  even  apply  tracking  coordinates.  Furthermore,  it  is
possible  to  use  de  offset  or  horizontal  offset  when  working  with  stereo  images,  thus
avoiding the need to create a vectorial shape for each image.

Note:  When  creating  shapes  on  an  image  with  an  original  size  different  from  the  work
resolution in Mistika Setup, the image will be viewed as adjusted to be able to draw shapes
in  any  part  of  the  original  image.  When  viewed  in  a  different  resolution  to  that  of  the
current work, the word "Scaled" will be superimposed on the Canvas.

Create

Create Shape

When active, this mode  indicates  that  a  new  shape  is  being  created  (rather than a
pre-existing one being edited). 

To  create  a  new  shape,  simply  click  this  button  and  then  left-click  on  Canvas  to
create the first point  of the shape. When left-clicking a new control point  is created,
although  while  the  button  is  held  down,  this  control  point  can  be  dragged  to  the
desired  position.  Only  when the  left  mouse  button is  released  will  the  control  point
defined  in  position.  Consecutive  clicks  create  the  control points  necessary  to  make
the desired shape; double-clicking exits  the creation mode,  finalizes  the  shape,  and
returns to modification mode. 

It  is also possible to exit  creation mode by clicking in an area  that  is  not  involved  in
the creation or edition of  shapes (eg, on the Keyframe Slider).

Note: from Version 7, Mistika will create each shape or set  of shapes in the vector in
which  we  are  working  at  any  given  time;  thus  we  can  create  different  layers  of
shapes,  each  related  to  a  vector.  These  cannot  subsequently  be  redirected  to  a
different vector, but should rather be copied into the desired vector. 

Insert Point

When active,  this  mode  inserts  control  points  on  any  vectorial  line,  permitting  the
editing of a pre-existent shape.



335The Interface

SGO Mistika 8.6 © 2018 SGO

Points Softness

Softness consists of a pair of tangents called Radials in each control point  of  the  selected
shape. These define a gradient of opacity towards the exterior and interior of a shape. 

Softness has exterior and interior limits, viewed as cyan-colored lines that  join the ends of
the radial tangents. 

The  radial  tangents  can  be  edited  like  any  other  tangent  or  via  the  Width  and  Offset
manipulators.

Width

Knob-type button: softness can easily  be  set  with  this  button by  dragging  to  the  edges,
increasing/decreasing  the  length  of  the  radial  tangents  of  the  selected  control  points,
proportionally to both the internal and external radials. 

Offset

Knob-type button: softness can easily be positioned towards the interior or exterior of
the shape with this button by dragging to the edges, increasing/decreasing the length
of the radial tangents of the selected control points, inversely proportional to both the
internal and external radials.



336 The Interface

SGO Mistika 8.6 © 2018 SGO

Points Mode

Default  creation  modes  that  define  the  shape  to  be  created  or  to  modify  one  already
created (ie previously selected).

Smooth

The shape created to be formed by B-Splines. Since tangents have less control than
Bezier  splines,  manipulation  and  work  with  B-Splines  is  easier.  Furthermore,  the
precision of B-Splines is usually sufficient when adjusting a shape.

Sharp

Eliminates the tangents of the selected control points. If dealing with a shape, this is
transformed into a polygon.

Connected Tang

The  shape  created  will  be  formed  by  Bezier  splines,  whose  nodes  can  be  edited
communally.

Independent Tang

The  shape  created  will  be  formed  by  Bezier  splines,  whose  nodes  can  be  edited
independently.

Points Reset

Dropdown that  allows the return to default  values  for the  tangents  or radials  of  a  control
point.

Tangents

Assigns  default  values  to  the  tangents  of  the  selected  control  points,  without
changing the radials.

Radials

Assigns default  values to the radials of the selected control points, without  changing
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the radials.

Radials Angle

Assigns default  values only to the angles of the control points, without  changing  the
tangents or the length of the radials of the selected control points.

Reset All

Returns default values of the tangents or radials of a control point.

Shape Priority

This tab allows each shape of a specified layer or vector to  be  moved  or have  its  priority
changed. The shapes will have a numerical identification, showing the depth or order of the
shape (this is especially important when carrying out boolean operations) in a given vector.

Move Up

Assigns  a  higher  priority  to  the  selected  shape.  The  remaining  shapes  will
automatically be reassigned.

Move Down

Assigns a lower priority to the selected shape. The remaining shapes will automatically
be reassigned.

Animation

Commands for controlling the animation of shapes.

Auto Key

Automatic  local keyframe creation mode  with  each modification of  the  shape  control
point position. 

Add Key

Adds a local keyframe to all the control points of the selected shape. 

Note: even if only one control point of a shape is selected, a local keyframe is added
to all it control points. 

Prev

Moves the Keyframe Slider back to the previous local keyframe of the selected shape.
 

Next

Moves the Keyframe Slider forward to the next local keyframe of the selected shape.
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Delete Key

Deletes the keyframe in the current frame of the selected shape.

Edit

Commands for editing shapes used to delete and move shapes from one effect to another.

Delete

Deletes the selected control points.

Note: to delete a shape completely, first select all the points of the shape by double-
clicking or using a multiple selection rectangle.

Cut All

Moves all the shapes of the selected clip to the memory, or clipboard.

Copy All

Copies in the memory all the shapes of the selected clip.

Cut Selected

Moves the selected shapes to the memory.

Copy Selected

Copies all the selected shapes in the memory.

Paste 

Pastes a copy of the shapes in the memory in the selected clip.

Effect Input Alpha

Dropdown button that modifies the behaviour of the alpha channel of the edited clip.

Keep

Keeps all the original information of the alpha channel of the edited clip.

Invert

Inverts the original values of the alpha channel of the edited clip.

Clear

Eliminates all the original information of the alpha channel of the edited clip, leaving a
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totally transparent mask.

Fill

Eliminates all the original information of the alpha channel of the edited clip, leaving a
totally opaque mask.

Shape Combine

Shapes added to the current  clip will  be  applied  on the  alpha  channel through one  of  the
four following application modes. The following image of a DVD player is an example to show
the operation of each mode: 

The idea is to trim the DVD player, and also the screen of the player. To do this, one green
mask and one black mask will be extracted. Both masks need to be improved, to do which,
for each one, a shape with its different application modes is used.

Add

Adds the area of shape to the original mask. 

Therefore, this is ideal for improving  the  filling  of  the  shape  of  the  player,  since  the
original  silhouette  of  the  extracted  green  mask  has  gaps   that  can  be  filled  with
shapes.

Intersect

Restricts the area of the mask to the intersection between the area of the shape and
the shape of the original mask. 

Therefore, it  is ideal for eliminating everything that  it  is not  part  of the shape  of  the
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player, since  the  original silhouette  of  the  extracted  green mask includes  a-required
objects, such as the revolving base, cables and hands. Simply eliminate from the mask
the a-required objects by tracing around the object that is to be preserved..

Add Inverted

Adds opacity to the original mask outside the area of defined shape.

Therefore  it  is  ideal for adding   opacity  to  anything  outside  the  area  of  the  player
screen,  since  the  extracted  black mask  includes  shadows  that  are  not  part  of  the
screen  and  must  be  eliminated.  Everything  that  is  outside  the  new  shape  can  be
defined as opaque by simply tracing around the area of the screen.

 

Subtract

Reduces opacity of the original mask within the area of the shape defined. 

Therefore,  it  is  ideal  for  eliminating  the  applied  tracking  crosses  applied  within  the
screen that  have been left  opaque  in  the  mask extracted  by  black.  This  way,  holes
can be  made  in  the  mask,  adding  shapes  that  defines  transparent  zones  within  the
mask.
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Default Shape Softnes Width

Numerical field where the value Softness is defined.

Default Softness

Defines  the  default  value  of  the  gradient  of  opacity  of  the  visible  shape,  once
created.

Shape Parameters

When a Shape is created in a node or effect, a series of parameters related to the selected
Shape is automatically activated.

Position X

Moves the Shape in the X-axis. 

Position Y

Moves the Shape in the Y-axis.

Rotation Z

Allows the Shape to be rotated.

Size X

Scales the Shape in the X-axis.

Size Y

Scales the Shape in the Y-axis.

Pivot X

Moves the Pivot in the X-axis.
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Pivot Y

Moves the Pivot in the Y-axis.

Offset X Left/Right

Offset values added between the position of the window in the left and right images in
stereo images.

Opacity

Controls  the  opacity  of  the  Shape,  or,  in  other  words,  the  opacity  of  the  alpha
channel generated by a given Shape.

Detect scenes

Ref. Mistika: Visual Editor->Dashboard->Detect Scenes

Manipulation mode for the automatic  detection of  scenes.  This  allows  the  division of  clips
into several parts according to the detection of cuts indicating scene changes.

The  commonest  situation  that  may  require  the  use  of  this  tool  is  when  a  media  clip  is
available but no EDL defining the cuts is available:

when video has been captured in Start Free mode

when  the  material  is  derived  from  a  Telecine  or  scanner  without  EDL,  for
example,  a  scan  of  a  complete  film  intended  for  restoration  in  which  the
original EDL is not available.

The  detection  is  very  accurate  and  is  based  on  Optical  Flow  (Motion  Estimation)
techniques, ie, it follows all the scenes details to find the change of scene. 

Run Scene Detection

This button runs the detection process for the selected clip.

When it  is  finished,  the  scene  detection graphic  appears:  the  horizontal axis  shows
time, and for each frame a vertical grey mark represents the percentage of elements
that have disappeared with respect to the previous frame. 

Clearly, the first  frame after a change of scene will have this value much higher than
the  normal  intra-scene  frames,  since  the  tracking  process  will  possibly  barely  find
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differences within the scene.

The user should then drag the orange horizontal threshold mark to defines the limits of
the scene. All the vertical marks that  are above this threshold mark indicate a cut  in
the frame, and will be shown red for clarity.

Important: Occasionally frames may have significant  changes of lighting,  flashes,  or
moments of darkness that  may incorrectly be considered as  cut  points  depending  on
the threshold values specified. 

To check how this affects the cut in the clip, the user can drag the  Keyframe Slider
of the Visual Editor to view the frame in question. The cursor of the Keyframe Slider is
represented synchronously in the graphic detected scenes by means of a gray vertical
bar.

Once the adjacent  frames have been viewed, if  the user decides that  a no cut  need
be made, simply drag the threshold mark upwards, until corresponding mark leaves the
frame in question completely at the bottom (and vice versa).

Cut Detected Scenes

This button causes the selected clip to be  cut  in  all  the  frames  with  red  showing  in
the scene detector (orange marks that are above the threshold bar).

Once in the Node Graph, this action can undone via the command Undo (Node Graph
Editor->Node Graph->Quick Access->History->Undo). It is also possible to rejoin
erroneously cut segments with the command Join (Node Graph Editor->Dashboard-
>Edit->Edit->Commands->Join).

Note: The process Run Scene Detection can take a considerable amount  of time, but
the  resulting  information is  maintained  in  the  scene  detection panel until  Run  Scene
Detection  is  run  again.  This  allows  the  user  to  change  the  threshold  and  re-cut
without having to recalculate the scene detection.

The  following  example   shows  a  clip  before  cutting  (above)  and  a  copy  of  the  same  clip
after cutting with Cut Detected Scenes.
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Paint

Ref. Mistika: Visual Editor->Dashboard->Paint

This Manipulator Tab allows access to the submode Paint Editor.

Paint  Editor  is  an interface  especially  designed  to  work with  the  VectorPaint  effect.  Thus
this tab is activated when applying this effect in the Node Graph.

For a detailed description of this submode, read the section Paint  Editor of the VectorPaint
effect.

Title

Ref. Mistika: Visual Editor->Dashboard->Title

This Manipulator Tab allows access to the submode Title Editor.

Title Editor is an interface especially designed to work with the Title effect. Thus this tab is
activated when applying this effect in the Node Graph.
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For a detailed description of this submode, read the section Title Editor of the Title effect.

Warper

Ref. Mistika: Visual Editor->Dashboard->Warper

This Manipulator Tab allows access to the submode Warper Editor.

Warper Editor is an interface especially designed to work with the Warper effect. Thus this
tab is activated when applying this effect in the Node Graph.
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For a detailed  description of  this  submode,  read  the  section Warper Editor of  the  Warper
effect.

Tracking

Ref. Mistika: Visual Editor->Dashboard->Tracking

This Manipulator Tab allows access to the submode Tracking Editor.

Tracking Editor

Motion Tracking manipulation mode, that  allows the moving  of  a  pixel pattern  selected  via
an image sequence, creating animation curves that  can be used to stabilize the movement
of  an image,  to  compose  new  layers  in  movement  or to  apply  the  path  obtained  to  any
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effect with two-dimensional positioning parameters. 

This mode has two types of control:

Manipulators  that  appear  superimposed  on  the  image  in  the  area  of  the  Canvas  and
manipulators that are controlled via the Dashboard of the Tracking Editor.

Canvas:

These  manipulators  can be  used  to  specify  the  pattern  to  be  tracked,  specify  a  search
area,  view  the  path of  the  tracked  movement,  modify  the  position  of  this  path,  visually
specify a offset between the search pattern and the path obtained and view segments that
join several tracked points. 

The manipulator that specifies the search pattern is called “tracker”. 

The tracker is a rectangular area, shown as a dotted blue line, which can be  positioned  in
any part of the screen, by left-clicking inside it dragging it to any other position. The size of
the tracker can also be  changed  via  its  size  manipulators  (the  small  squares  found  in  the
top right and bottom left corners).

The tracker contains the pattern or set  of pixels that  the  tool will  try  to  recognize  in  the
images  that  compose  the  sequence.  The  tracker  content  is  commonly  called  “tracking
point”. 

The criteria used for choosing a good search pattern must follow  certain principles: 

The pattern should be present  in the entire range of frames where the search
will  be  run (for example,  do  not  select  a  pattern  that  will  not  be  visible  in
subsequent frames due to disappearing from shot or of being hidden). 

The pattern should be an area of the image that  can be  clearly  distinguished
(for example, part  of a smooth wall is  not  a  good  tracking  point,  ,  since  one
part  of a smooth wall can be identical to another; a nail in the wall is a good
tracking point). 

The smaller the pattern, the faster the search. 

Lines are not  good tracking points, since their parts may be identical and  the
tracker may slip. 

If  the  sampled  area  is  confusing  or  has  insufficient  contrast,  the  tracking
result can be improved by applying a previous color correction, to provide the
maximum  contrast  in  the  details  to  be  tracked  and  eliminate  unnecessary
information. 

If  there  is  noise  in  the  image,  before  doing  motion  tracking,  the   Denoise
(Node  Graph Editor->Dashboard->Fx->Mistika->Denoise)  effect  can  be
applied to improve the quality of the patterns to be tracked.

It may also be useful to try the Channels (Node Graph Editor->Dashboard-
>Fx->Mistika->Boolean->Channels) effect  to  eliminate  the  channels  with
most  noise,  since  in  many  occasions  noise  comes  more  from some  channels
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than other.

The following image is an example of search pattern selection and of the path obtained.

The Path consists of the linear union of the positions where the search pattern is found  in
each  frame  of  the  sequence.  These  straight  lines  are  linear  interpolations  between  the
positions  of  each  frame  tracked  by  the  process.  These  segments  can  be  clearly
distinguished in the path as they are drawn alternately in light blue and orange. 

The path obtained by the tracker will be applied to the original center of the tracker, called
Target, which is shown as an orange circle at the center of the tracker. 

The user can add any number of required trackers at  any time, which will be identified by a
number or name accompanied by a letter T, and will appear at  the bottom of each tracker
rectangle. 

To  optimize  the  search pattern,  a  search  zone  can  be  specified.  This  zone  is  a  second
rectangular  area,  similar  to  the  tracker,  but  with  the  size  manipulators  in  the  opposite
corners. 
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This zone specifies the search zone of the next  frame, and it  can be moved by left  clicking
on it,  although bear in  mind  that  the  tracker may  be  inside  it  and  it  is  not  necessary  to
press  on the  tracker itself.  When the  tracker  is  moved,  the  search  zone  moves  with  it,
maintaining its relative position. The Search Zone accelerates the tracking process, since it
restricts the search to a small part of the image, and not the entire image, as occurs if  this
zone is not specified. 

The  smaller the  search  zone,  the  faster  the  tracking,  but  bear  in  mind  that  this  should
predict the zone where the search pattern will be found in the next  frame. For this reason,
in the second image of the previous example,  the  search zone  is  moved  to  anticipate  the
path direction shown by the tracker. 

The search area prevents the tracker confusing between two similar patterns found  in  the
same frame.

The  tracker Target  is  by  default  centered  in  the  search pattern,  although the  latter can
later be moved outside  the  Target  by  pressing  <Alt>  at  the  same  time  as  the  tracker is
selected and dragged with the left mouse button. 

A blue line is shown between the Target and the search pattern which indicates the tracker
offset. 

The purpose of the Offset is to momentarily select another search pattern, but continue the
original  path.  This  is  useful  when  the  chosen  search  pattern  is  temporarily  hidden  by  a
figure, which is when another nearby pattern can be chosen and the movement  of the new
pattern applied to the original Target, completing the path of the first pattern selected. 

It  is also possible to move the tracker and its path together, by selecting  the  tracker and
pressing <Ctrl> This method is also valid to achieve the purpose as the offset. 
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A single tracking point will only provide two-dimensional movement information.

If rotation information is needed, it  is necessary  to work with a minimum of  two  trackers,
since the angle that  determines the line joining these two points will be the  rotation angle
obtained, 

The same occurs if  zoom or size information is needed. The zoom size or value  is  obtained
from the length of the line joining two trackers. This line is shown in yellow. 

It  is possible to add all the tracking points required, although only  two  tracking  points  are
needed  to  extract  rotation  or  zoom.  When  working  with  more  than  two  trackers,  the
rotation or zoom value will be calculated as the average of all the join lines that exist. 

When using  many  tracking  points,  the  join  lines  form a  shape  which can be  saved  as  an
animated  vectorial  shape  that  can then be  loaded  and  used  in  the  VectorPaint  effect,  in
which the shape can be modified and perfected, specifying tangents for each point, defining
attributes, etc. This process is useful for the creation of animated masks based on tracking
points. 

When working with the CornerPin effect, there should be four tracking points, which can be
shown with their names at  their corresponding corners. The foreground layer of  the  effect
will be deformed according to the square formed by the lines joining the four tracking points.
It  is often convenient  to specify the tracking points in the frame  with  the  largest  possible
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composing area is. In the following example, the  tracking  points  were  specified  in  the  last
frame, and then dragged back in time. 

The tracking search speed is much faster than real-time. Even viewing the sequence in the
interface monitor can reduce  the  tracking  speed.  For this  reason,  a  mode  exists  in  which
the sequence progress is not visible, thus utilizing the full speed of the tracking process. 

To take advantage of all the tracking performance, it is important to select  in the Eval Tree
for the evaluation of the original image without additional processes, since if images of other
effects are tracked they will also have to be evaluated, and this will slow down the search
of the tracking points. 

To avoid this delay, it  is always advisable as the first  step to double-click in the Eval Tree
on the clip to be tracked, and then to  select  the  effect  with  a  single  click and  apply  the
tracking obtained. 

Many effects, such as Comp3D, have many folders where the tracking coordinates  can be
applied. To do this, first select one of the parameter folders by specifying the target  of the
tracking coordinates, and then apply the tracking result. 

All paths obtained by a tracker can be corrected, and even manually modified. 

The  tracking  interface  slider  is  used  to  select  the  current  frame.  Moving  a  tracker
immediately  updates  the  current  point  of  the  path,  specifying  a  new  position  for  the
selected frames. 

In  frames  with  no  specified  positions,  the  tracker will  move  through the  segments  (linear
interpolation) that  join the specified positions  (frame  position).  When applying  tracking  to
the parameters of an effect, only the specified positions will create keyframes in the curves
formed by  the  two-dimensional coordinates.  The  type  of  interpolation of  these  keyframes
can be specified in the Parameters area.
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Dashboard:

The Dashboard of the Tracking Editor contains many functions, modes and viewing controls.

To the right of the Slider is the Back button to exit the  Tracker Editor  and return to Visual
Editor  mode.  No  information is  lost  when exiting,  since  the  position  and  trajectory  of  the
trackers is remembered for the following  time  this  panel is  accessed,  but  we  need  to  exit
when we wish to work on others effects.

In the lower part  is the message line  (Message).  This  field  gives  us  information about  the
functions run from the panel or keyboard shortcuts.

This group brings together definable values numerical box or from the buttons Set  In and Go
To which copy the value of the current frame defined by the Keyframe Slider. These values
define a range of time within a sequence, in which the search pattern is done. 

The definition of this range works similarly to that of input  and output  points in a non-linear
editor.

The numerical fields From and To show the first  and last  frame of the search range. These
fields are editable and the values can be specified manually.

Set

Defines the value of the input  or output  point  of the range taking as a reference the
active frame in the Slider.

Go To

Moves the Keyframe Slider to the frame defined in the numerical fields From or To.

Buttons for managing the trackers.

Add Tracker

Adds a new Tracker manipulator. 
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Hide Tracker

Hides  the  path of  the  selected  tracker,  and  is  ignored  by  the  commands  of  the  Go
Forward button. 

Remove Tracker

Removes the selected Tracker manipulator. 

Reveal Tracker

Undoes the Hide function of the selected tracker.

Restores the values of the time range to the default, previously defined in Tracking Ranges,
allowing  the  tracker to  act  over the  whole  duration duration of  the  clip  or until  the  user
decides to stop the analysis.

Mode that uses the tracker Search Zone instead of using the entire image.

Group  of  buttons  that  defines  the  application mode  of  the  animation  curves  obtained  by
tracking.

Position

Mode that applies the tracking result to the XY position parameters. 

These  coordinates  are  applicable  to  all  effects  that  possess  two-dimensional
parameters (position in X and Y), such as Comp3D, Title, Vector Paint, Noise, Fractal,
 Circle, Wave, Radial Blur, Twirl, Bump, Refract (Distort), Flare. 

If there is more than one tracking point, the movement  coordinate will be the average
of all the tracking point positions. 

The most usual use of this mode is to animate the position of an image layer so that  it
moves in the same way  as  an element  in  another image,  although its  uses  are  very
varied. 

Rotation

Mode that applies the tracking result to the rotation coordinates. 

This  information  about  rotation  is  applicable  to  all  effects  that  possess  a  rotation
parameter in Z, angle or cycle, such asComp3D, Noise, Stripe, Radial Blur, Twirl, Liquid
Bump, Refract, Brush Stroke, Kaleido.

For this mode to work correctly, there must  be  a  minimum of  two  tracking  points.  If
there are more than two points, the rotation information will be the average of all the
angles specified by the tracker join lines. 

This is normally used to animate the rotation of a layer by making it  coincide with the
rotation of an object present in the image. 
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Size

Mode  that  applies  the  tracking  result  to  the  scale  parameters.  This  information  is
applicable to the Comp3D effect. 

For this mode to work correctly, there must  be  a  minimum of  two  tracking  points.  If
there are more than two  points,  the  scale  information will  be  the  average  of  all  the
lengths specified by the tracker join lines. 

It  is  normally  used  to  animate  the  scale  of  a  layer  by  making  it  coincide  with  the
change of scale of an object present in the image. 

Corner Pin

Mode that applies the coordinates of four tracking points as the result  of the position
of the corners of a rectangle. This mode is used to fit  in movement  one image layer in
an area of another image defined by four points.

Group of buttons that work on the path of the selected tracker. 

Cut

Moves the path of the selected tracker to the clipboard. 

Copy

Copies the path of the selected tracker to the clipboard. 

Paste

Pastes a copy of the path in the clipboard into the selected tracker. 

Remove

Deletes the path of the selected tracker. 

Load

Opens  the  selected  points  and  paths  of  a  tracking  file  (.trk)  and  adds  them to  the
current tracking. 

Save

Saves the selected points and paths as a tracking file (.trk).

This  group  of  buttons  contains  those  that  run tracking  of  the  search  pattern  during  the
sequence.

Go Forward

Runs  the  tracking  of  the  search  patterns  in  the  direction  of  the  frames  after  the
current one. 
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Go Backward

Runs  the  tracking  of  the  search patterns  in  the  direction  of  the  frames  before  the
current one. 

Go Both

Runs  the  tracking  of  the  search patterns  in  the  direction of  the  frames  before  and
after the current one. 

Stop

Stops the tracking of the search patterns. 

Group of buttons that work on the points that form the path of the selected tracker. 

Remove Point

Removes the tracker position in the current frame. 

Remove Range

Removes the tracker positions in the range specified by From and To. 

Remove Forward

Removes the tracker positions from the current frame to the end of the sequence. 

Remove Backward

Removes  the  tracker  positions  from the  beginning  of  the  sequence  of  the  current
frame.

Group of buttons that  apply  the  tracking  coordinates  to  the  selected  effect  or parameter
folder.

Move

Applies the tracking information positively (copies the animation curve to the selected
parameter as it has been calculated). 

Stabilize

Applies the tracking information negatively. 

The applied movement  is the inverse of that  extracted  from the  sequence,  and  thus
stabilizes the movement  of the original sequence, leaving the tracked  search pattern
fixed at the center of the screen. 

This process is very useful for stabilizing a sequence and hold it  steady while working
with other effects such as VectorPaint or Warper, and the later returning to apply the
tracking coordinates positively and thus recover the original image movement. 



356 The Interface

SGO Mistika 8.6 © 2018 SGO

Smooth

Applies the tracking information to cancel only small abrupt movements in the selected
search pattern, thus smoothing them out. 

This application command is ideal for removing small camera shakes, without  removing
the selected movements. 

Shape Mode

Activates the masks to be used to define  tracking  areas.  Instead  of  using  the  usual
tracking  points,  the  masks  establish  the  areas  where  the  tracking  will  be  applied,
ignoring any outside the mask in question.

Enable Tracking

Activates tracking within the selected mask.

Populate On Start

Activates a search for tracking points when starting movement analysis. When a mask
is  used  to  define  a  tracking  zone,  Mistika  will  automatically  movement  points
throughout the clip in order to carry to said tracking.

Enable Pruning

Activates  the  deletion of  tracking  points  that  are  outside  the  specified  area  of  the
mask,  so  that  points  that  lose  their  movement  reference  and  could  thus  ruin  the
tracking are automatically eliminated.

Populate Now

This  functions  in  the  same  way  as  Populate  On Start,  except  that  Mistika  runs  the
analysis  when tracking  begins,  so  that  the  user  can  see  the  movement  points  and
choose those that are unnecessary from the start.

Go Backward

Runs  the  tracking  of  the  search  patterns  inside  the  shape  in  the  direction  of  the
frames after the current one.

Go Forward

Runs  the  tracking  of  the  search  patterns  inside  the  shape  in  the  direction  of  the
frames before the current one. 

Go Both

Runs  the  tracking  of  the  search  patterns  inside  the  shape  in  the  direction  of  the
frames before and after the current one. 
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Reset Shapes

Reset all the shape trackings to default values.

Move

Mode that applies the tracking result to the XY position parameters of the shape.

Rotate

Mode that applies the tracking result to the rotation coordinates of the shape.

  Size

Mode that applies the tracking result to the scale parameters of the shape.

Size XY

Mode that applies the tracking result to the XY scale parameters of the shape.

Round

Optimize the search and the application of the tracking for rounded elements.

Fine

Enable  a  mode  of  analysis  and  application  of  the  tracking  more  accurate  than  the
normal one. This mode is designed for big tracking areas, and it  uses a big  resolution
for the search patterns, so it  is slower. Any  mask with  an area  of  less  than 10% of
the image uses by default this tracking mode.  

History

This is the tracker progress tolerance value. 

Small values specify that the search pattern is the one originally selected in the frame
in which tracking  began.  Large  values  specify  that  the  search pattern  is  continually
updated with the current content in the following frames. Intermediate values cover a
tolerance range that mixes the original pattern with the image of the pattern found in
each frame. 

For  points  that  change  their  appearance  during  a  sequence,  a  high  History  value
(such as the corner of a  rectangle  for example)  is  recommended;  for points  that  do
not  change  their appearance  much during  a  sequence,  low  values  are  better,  thus
achieving a more exact result. 

Safe Area

Specifies  the  percentage  of  the  image  area  total  where  tracking  will  take  place.
Outside this area, the tracker applies extrapolation values. In this way, collision of the
tracker with the image margins is avoided, keeping the linear path of the tracker when
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it goes out of frame.

Silent Tracking

Search mode which,  by  hiding  playback of  the  frames  that  appear in  the  sequence,
allows tracking to be run faster. 

Track

This  dropdown  button  selects  if  the  tracking  mode  will  work  on  the  original  high
resolution images (Track Full Res) or over a proxy (Track Proxy).

Track Eye

This dropdown button allows the selection of which of  the  images  that  compose  the
stereo pair the tracking will work on (Left or Right) or when not a clip of stereo images
 No Stereo.

Scrub

This dropdown button selects if the viewing mode in the Keyframe Slider  will evaluate
the  original high resolution  images  (Scrub  Full  Res)  or  will  evaluate  a  proxy  (Scrub
Proxy).

Control buttons for viewing tracker components. 

Show Trajectory

Activates the viewing of the trajectories of the trackers.

Show Shape

Activates viewing of the tracker join lines. 

Display Filters

This Manipulator Tab allows access to the Display Filters.

Display Filters work like presets that  can be  created  from different  effects  that  we  insert
into  the  Node  Graph,  and  they  can  be  saved  in  relation  to  a  specific  environment  or  a
preset or specific configuration (from mConfig).
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Displays Filters for Current Timeline

Allows the creation, selection and manipulation of filters we  create  in  relation to  the
current environment.

Display Filters for mConfig Preset

Allows the creation, selection and manipulation of  filters  we  create  according  to  the
configuration preset  in  mConfig,  and  which  therefore  are  available  for  a  project  or
various complete projects, not just for a specific environment. The folder in which the
filters  we  create  in  this  section  are  found  is  accessed  via  mConfig->FilePaths-
>Display Filters.

Create Display Filters

This button allows us to create a new Display Filter. 

Note: To create  a  new  Display  Filter,  select  the  last  effect  of  the  stack of  effects
that  is to be converted into a  Display  Filter  and  then click Create  and  and  a  name.
The stack of effects will disappear, and a new Display Filter  with the same result  will
be  created;  this  will  be  accessible  from this  tab  of  Display  Filters  or  from  Visual
Editor->FxPresets.

Filter

In this column, we select the filters we want to use.

Apply On

The selected filters may be applied to different outputs:

GUI: 

The filter is applied to the Visual Editor.

Live:

The filter is applied to the video output.

Scope:

The filter is applied to the different Scopes accessible via Visual Editor.

Render:

The filter is processed when the selected clip is rendered. 

Eye

This allows us to select to which eye in a stereo clip the selected filter is applied (Left
, Right, Both).
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Comment

Allows the addition of a description or indications that  may help identify the selected
filter.

Active

Allows the selected filter to be muted.

Toggle

This tool allows us to compare quickly up to 4  filters  (T1,  T2,  T3,  T4),  that  we  can
alternate between from the Visual Editor.



FX

F
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F-1 Mistika FX

This  chapter  includes  information  about  the  functioning  of  the  effects  in  Mistika,  with
practical examples and tutorials.

Compose

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Compose

The Compose group includes composing effects and tools.

Comp3D

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Compose->Comp3D

Comp3D is Mistika’s main composition effect. It  permits  composition  in  a  three-dimensional
multi-layer space, unlimited inputs respecting their alpha channels, specifying animations for
the camera, different light types, and three-dimensional deformations for each layer. 

This effect has specialized manipulators, described in the chapter Visual Editor.

I/O

Inputs

Multi-input:  A  background  as  first  layer  (with  optional  alpha  channel),  and  an
unlimited  number of  inputs  (with  image  and  optional alpha  channel).  The  use  of  the
first input as background is optional, and it is possible to replace it  with a transparent
alpha channel black background, via the parameter Backgr.
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Inputs

Image: Background image (optional) composed with  the  other inputs  repositioned  in
the three-dimensional scene. 

Alpha: The addition of the masks repositioned in the three-dimensional scene.

Parameters

Options:

Folder that contains parameters for controlling evaluation options:

Quality

[Bilinear (Nearest / Bilinear / Bicubic )]

Defines the quality of the rescale filter.

In  the  parameter's  dropdown  there  is  a  list  of  available  qualities,  from  lowest  to
highest  quality  downwards.  It  is  recommendable  to  define  the  lowest  quality  that
obtains the best visible results, because the higher the quality, the greater calculation
time required. 

Result Size as

[Input (Input / Project]

Defines the  output  resolution of  the  effect.  Input  sets  the  output  resolution as  the
same as the original resolution of  the  clip.  Project  sets  the  output  resolution as  the
same as the current resolution of the work in hand (mConfig->RenderFormat ).

Input is especially useful when a clip has a higher resolution than the project  and this
resolution is desired for later application to other effects capable of working in its full
resolution and extracting greater detail than the working resolution.

Samples

[x1 (x1,x2,x3,x4,x8,x15,x24,x66)]

Number of samples of render processes. High values set  a higher number of  samples,
notably improving the resulting image quality and the Antialiasing, which is very visible
in the details of an image, the edges of composite layers and in layers that  have been
reduced in distance or size. This parameter interacts with the parameter Shutter.

Shutter

[0 (0 / 360)] 

Controls the shutter angle of the virtual camera, simulating the Motion blur produced
by an object in movement filmed on photographic film.

Simulating  the  behavior  of  a  film  camera  shutter,  this  parameter  creates  render
samples in the positions between frames as a real shutter would show. If the value is
at  its maximum (360) the  shutter is  completely  open,  and  the  motion blur will  cover
the whole movement  between two frames. If the value is 180, the length of the  blur
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will be half of the movement between frames, and if the value zero (the Default  value)
there  will  be  no  blur,  and  all  samples  will  be  in  the  same  position.  Since  the  blur  is
created by the offset  of the samples, it  is  necessary  that  the  parameter Samples  is
not  at  x1,  as  there  would  not  be  samples  for  the  Shutter  to  work  correctly;  high
values are recommended.

Background:

Folder that contains the different options for the background image.

Background

[Solid (Input1 / Solid)]

Defines whether the first  input  of the effect  is used as background. In this case, the
background will not  function as a layer, since it  cannot  be manipulated, because it  is
set as a two-dimensional background of a three-dimensional composition. If the value
is set asSolid, the first input of the effect  will be the first  manipulable layer, and have
a solid background definable via the usual parameters.

Red; Green; Blue, Alpha

[0; 0; 0; 0 (0 / 100)] 

Defines RGBA value of the solid color. 

Shadow:

Folder that contains the parameters that  generate a shadow projected by all layers on the
background (this effect needs the Background option in the On position). 

This  shadow  is  a  two-dimensional  projection  of  the  total  off  the  masks  of  the  layers
repositioned, with parameters of two-dimensional offset, focus, opacity and color.

OffsetX;Y

[2; -1 (-100/100)]

Specifies two-dimensional offset of the projected shadow.

Intensity

[0 (0/100)]

Specifies opacity as a percentage of the shadow.

BlurType

[Box (Box, Gauss)]

Specifies the type of blurring applicable to the shadow.
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BlurRad

[0 (0/100)]

Specifies the quantity of blur applicable to the shadow.

Spread

[0 (0/200)]

Extends the opacity of the shadow from its interior. This parameter acts together with
 BlurRad.

Red; Green; Blue

[0;0;0 (0/100)]

Specifies the color of the shadow. 

Camera:

Dropdown folder that contains folders with parameters that control the camera. 

Position X; Y; Z

[0; 0; 500 (-1.000.000 / 1.000.000)]

Three-dimensional coordinates of the camera position. 

This parameter can also be changed through its manipulators. 

With the camera in orbit  view mode, the manipulator specifies a circular movement  of
the position coordinate around the target  coordinate, simulating an orbital movement
that keeps the lens pointed towards the point specified by the target. In dolly camera
view  mode,  the  manipulator  moves  the  coordinate  along  a  straight  line  joining  the
target to the position, thus simulating a forward or backward camera travel. 

With the  manipulator in  move  camera  view  mode,  it  moves  both coordinates  at  the
same time, simulating a camera travel in the plane perpendicular to the view. 

Target X; Y; Z

[0; 0; 0 (-1.000.000 / 1.000.000)]

Three-dimensional coordinates of the point towards which the camera lens is pointed. 

The  position  of  the  objective  is  specified  by  the  three-dimensional alignment  of  the
camera, thus permitting  for example  that  the  camera  is  kept  pointed  at  a  particular
layer by copying its position parameters to the target. 

With the camera manipulator in rotation mode, it  specifies a circular movement  of the
target  coordinate around  the  position  coordinate,  simulating  a  panning  movement  of
the camera objective. 
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Camera Roll

[0 (-1.000.000 / 1.000.000)]

Specifies a rotation angle of the camera on its depth axis, determining the inclination
of the horizon. 

Camera FOV

[22.6 (0 / 180)]

Specifies the Field Of View of the camera. 

This  field  is  measured  in  degrees  with  higher  values  representing  wide-angle  lenses
and lower ones zoom lenses.

Camera InterOcular

[0 (0 / 100.000)]

This attribute is applicable to stereoscopic  images. It  modifies the values of interaxial
separation of the stereoscopic image. The higher the value of Camera InterOcular, the
more exaggerated will be the stereoscopic effect.

Ambient:

Ambient R; G; B

[33; 33; 33 (0 / 100)] 

Specifies a color for ambient  lighting that  will affect  all the layers, regardless of their
position or alignment. Specifying minimum lighting of any color for all three-dimensional
scenes avoids totally darkening the polygons not  affected  by  the  lights.  The  default
value  complements  the  default  light  to  maintain  the  layers  of  the  three-dimensional
composition illuminated so that their original colors or brightness do not change.

Light_1:

Folder containing the parameters of light created by default. Lights created later are added
subsequently,  as  an identical folder with  its  own  automatically  incremented  number.  The
creation,  copying,  and  deletion  of  lights  is  controlled  from the  command  tab  located  in
Mistika->Node Graph Editor->Mistika->Main Tabs->Parameters->Folder.

Position X; Y; Z

[0; 0; 200 (-1.000.000 / 1.000.000)]

Three-dimensional coordinates of the light position. 

Target X; Y; Z

[0; 0; 100 (-1.000.000 / 1.000.000)]

Three-dimensional coordinates towards which the camera objective is pointed. 

This parameter does not  affect  lights specified by  the  type  parameter with  its  value
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set to 1. 

Color R; G; B

[100 (0 / 100)]

color of the light. The default color is white. 

Intensity

[67 (0 / 1.000.000)]

Intensity of the light, in percentage values. The RGB value of the color is multiplied by
this parameter. 

Type

[Directional (Directional / Point / Spot)] 

Type of light. The three types are: 

Directional: Directional light. This type of light  produces parallel rays in the direction
specified by the straight  line joining the Position and  Target  coordinates,  as  the  real
information provided  by  the  three-dimensional coordinates  is  of  little  relevance.  The
intensity of this type of light  does not  decay with distance: the values of the Decay,
Spread and Falloff parameters are ignored. 

Point:  Point  light.  This  type  of  light  is  created  from  an  emission  point  in  three-
dimensional  space  specified  by  the  Position  coordinate,  emitting  spherically-shaped
light: the Target  coordinate and the Spread  and  Falloff  parameters  are  ignored.  The
light  intensity  decays  with  distance  according  to  the  value  specified  by  the  Decay
parameter.

Spot: Spotlight. This type of light  is created from a point  in three-dimensional space
specified by the Position coordinate, emitting spherically-shaped light, although limited
by  a  cone  oriented  towards  the  position  specified  by  the  Target  coordinate.  The
appearance of the cone is specified  by  the  Spread  and  Falloff  parameters.  The  light
intensity  is  maintained  constant  in  the  range  of  distance  specified  by  the  Target
coordinate, and after that, it  begins to  decay  with  distance  depending  on the  value
specified by the Decay parameter. 

Cutoff

[90 (0 / 90)]

Specifies a cutoff limit of the light cone for lights of type 2. 

Exponent

[32 (0, 128)]

Specifies the light intensity concentration in the center of the cone for lights of type
2. 
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Decay

[0 (0 / 2)]

Specifies a decay exponent of the light intensity depending on distance. 

Depending  on  the  distance  between  the  layers  and  the  positions  of  type  1  and  2
lights,  the  light  intensity  drops,  affected  exponentially  by  this  parameter,  whose
default  is  0  (zero),  inhibiting  the  distance  decay.  A  value  of  1  indicates  decay
proportional to  the  distance,  and  a  value  of  2  indicates  decay  proportional  to  the
square of the distance, emulating in the later case  the  behavior of  a  real light.  This
parameter also permits decimal values for setting intermediate values. 

Axis_1:

Folder containing  the  information of  a  first  transformation  axis  which  affects  the  second
transformation axis and all the layers and ambient lights of the three-dimensional scene, via
position, rotation, size and pivot coordinates. 

Position X; Y; Z

[0; 0; 0 (-1.000.000 / 1.000.000)]

Three-dimensional position coordinates. 

Rotation X; Y; Z

[0; 0; 0 (-1.000.000 / 1.000.000)]

Three-dimensional rotation coordinates. 

Size X; Y; Z

[100; 100; 100 (0 / 1.000.000)] 

Sizes as percentage values. 

Pivot X; Y; Z

[0; 0; 0 (-1.000.000 / 1.000.000)]

Specifies a offset of the rotation and scaling pivot, which by default is centered.

Axis_2:

Folder  containing  the  information  of  a  second  transformation  axis  which  affects  all  the
layers and ambient lights of a three-dimensional scene, by position, rotations, size and pivot
coordinates. 

Position X; Y; Z

[0; 0; 0 (-1.000.000 / 1.000.000)]

Three-dimensional position coordinates. 
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Rotation X; Y; Z

[0; 0; 0 (-1.000.000 / 1.000.000)]

Three-dimensional rotation coordinates. 

Size X; Y; Z

[100; 100; 100 (0 / 1.000.000)] 

Sizes as percentage values. 

Pivot X; Y; Z

[0; 0; 0 (-1.000.000 / 1.000.000)]

Specifies a offset of the rotation and scaling pivot, which by default is centered.

Layer_1:

Dropdown folder containing the parameters of the layer created by default. Layers created
later will be added here as an identical folder, recognizable by its incremental number.

 

If  control layer transformation is  needed,  the  number of  layers  should  correspond  to  the
inputs of the effect, bearing in mind the Backgr  and  Disp  Enable  (displacement  map layer)
parameters of each layer, as they may require inputs in addition to those  specified  by  the
number of  layers  of  the  effect.  The  creation,  copying  and  deletion of  layers  is  controlled
from the  command tab  located  in  Mistika->Node  Graph  Editor->Mistika->MainTabs->
Parameters Panel->Folder.

Note: If the number of inputs is greater than the  number of  layer controls  created  within
the effect, the last  layer transforms all the inputs at  the same time, as  if  it  were  a  single
input with all the images  pre-composed in it.

Folder containing the information for transformation of the layer, with its position, rotation,
size and pivot coordinates. 

Position X; Y; Z

[0; 0; 0 (-1.000.000 / 1.000.000)]

Three-dimensional position coordinates. 

Rotation X; Y; Z

[0; 0; 0 (-1.000.000 / 1.000.000)]

Three-dimensional rotation coordinates. 

Size X; Y; Z

[100; 100; 100 (0 / 1.000.000)]

Sizes as percentage values. 
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Pivot X; Y; Z

[0; 0; 0 (-1.000.000 / 1.000.000)]

Specifies a offset of the rotation and scaling pivot, which by default is centered. 

Parameter folder specifying  attributes,  which affect  the  behavior of  the  layer in  a  three-
dimensional scene. 

Attributes Subdiv

[3 (1 / 7)]

Specifies the polygonal subdivision index that constitutes the layer. 

A  high  index  increases  the  number  of  polygons  that  make  up  the  layer,  achieving
greater  detail  in  deformation  effects.  The  repositioning  of  the  polygons  make  the
three-dimensional deformations  visible,  therefore,  the  more  polygonal  subdivisions  in
the  layer,  the  better  reproduction  quality  of  these  deformations,  although  the
increased complexity of the process should be noted. 

Attributes DispMap

[Off (Off / On)]

Specifies the luminance of the input  according to  the  current  corresponding  layer as
its displacement map. The default setting of this parameter is 0, without assigning any
displacement map. 

A displacement  map is  an image  which,  based  on the  luminance  values  of  its  pixels,
moves the polygons that  conform a three-dimensional object  in depth. In this effect,
the objects are the layers, made up of polygons, which can be displaced in the depth,
or Z, axis.

Attributes Blending

[Normal (Normal / Premultiplied / Blending Modes)]

Specified the mode in which the layer is blended with respect to the one behind it.

Normal.  Specifies  the  composition  mode  in  the  layer  as  normal  for  occlusion.  The
resulting color is the original color of the layer; this mode ignores the hidden color.

Premultiplied. Specifies the composition mode in the layer as without  multiplication of
the alpha channel.

This is recommendable for images or sequences derived from 3D or graphics that  have
been created  over a  black background,  which do  not  need  to  be  multiplied  by  their
alpha  channel  before  being  added  to  the  composition  since  this  has  been  done
previously in the previous program.

Blending  Modes.  Specifies   modes  of  composition  in  the  layer  according  to  variants
widely used in other image composition systems. These  modes  are:  Darken,  Multiply,
Color  Burn,  Linear  Burn,  Lighten,  Screen,  Color  Dodge,  Linear  Dodge,  Overlay,  Soft
Light,  Hard  Light,  Vivid  Light,  Linear  Light,  Pin  Light,  Difference,  Exclusion,  Hue,
Saturation, < /text>Color and Luminosity.
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Attributes Specular

[0 (0 / 1.000.000)] 

Specifies the specularity of the surface of the layer. 

The  higher  the  value  of  this  parameter,  the  more  the  brightness  produced  by  the
lights of a three-dimensional scene will be reflected. 

Attributes Gloss

[20 (1 / 1.000.000)] 

Specifies the gloss of the surface of the layer. 

The higher this value, the more the intensity of the gloss produced by the scene lights
will be concentrated. 

Attributes Blend

[100 (0 / 100)]

Specifies  the  composition  opacity  of  the  layer  in  a  three-dimensional  scene,
respecting its transparency values specified in the optional alpha channel. 

Dropdown folder that  contains  the  three  dimensional deformation parameters  of  the  layer.
These deformations are processed in the same order as they appear in the effect.

Folder containing the parameters that specify the offset  of the polygons of the layer in the
Z axis. 

Ampl

[10 (-100.000 / 100.000)] 

Specifies the amplitude range of the displacement  map, permitting negative values to
interpret the map inversely. Its units reflect the distance of the maximum offset  in the
local coordinate Z of the edited layer.  This  parameter will  not  reflect  changes  if  the
displacement map if this is not activated by the DispMap parameter. 

Zero

[50 (-100.000 / 100.000)] 

Specifies the value of the offset range in its position in the original plane of the layer.
If this parameter is set at 100, the white value of the displacement map is specified at
the original position of the plane of the layer, thus  only  displacing  the  polygons  that
are affected by lower values, with 0 being equivalent to black. The parameter accepts
values  outside  the  range  of  the  displacement  map  (0  to  100)  by  the  use  of
extrapolation. 

BlurR

[1 (0 / 100.000)]

Specifies a reduction of detail in the displacement  map using a blur filter calculated in
32 bits.
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Normally, a displacement map contains details that  sharply displace the polygons of a
layer. On the one hand, this produces the  original contrast  of  the  input  specified  as
the displacement  map, and on the other by the 256 maximum luminance levels of the
video images. To smooth this contrast, a blur is used, but  with 32 bits, to generate in
this way more than 4 billion levels interpolated by the filter. 

Folder containing the parameters that specify a cylindrical three-dimensional deformation for
the X and Y  axes of the layer, that  make  spherical or toroidal deformations  possible  when
combined. 

 CilAng

[0 (-100 / 100)] 

Specifies the vertical cylindrical deformation by a percentage  value.  The  deformation
can be negative, inverting the cylinder face. 

CilCuad

[0 (0 / 100)]

Specifies  gradually  the  formation  of  four  right-angles  in  the  vertical  deformation,
changing the appearance of the cylinder outline into a square. 

TorAng  

[0 (-100 / 100)]

Specifies  the  horizontal  cylindrical  deformation  by  a  percentage  value.  The
deformation can be negative, inverting the cylinder face. 

TorCuad

[0 (0 / 100)]

Specifies  gradually  the  formation  of  four  right-angles  in  the  horizontal  deformation,
changing the appearance of the cylinder outline into a square. 

TorRad

[0 (-100.000 / 100.000)]

Sets a radius for the deformation obtained  by  the  TorAng  parameter.  The  setting  of
this radius permits spherical or toroidal deformations to be achieved. 

Folder containing the parameters that  specify three-dimensional deformation in the form of
horizontal or vertical waves. 

X-Ampl

[0 (0 / 100.000)]

Specifies the offset amplitude for the waves in the horizontal axis of the layer. 
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X-Shift

[0 (0 / 100.000)]

Specifies a offset of the wave position in the horizontal axis of the layer. 

X-Num

[2 (0 / 100.000)]

Specifies the number of waves in the horizontal axis of the layer. 

Y-Ampl

[0 (0 / 100.000)]

Specifies the offset amplitude of the waves in the vertical axis of the layer. 

Y-Shift

[0 (0 / 100.000)]

Specifies a offset of the wave position in the vertical axis of the layer. 

Y-Num

[2 (0 / 100.000)]

Specifies the number of waves in the vertical axis of the layer. 

Folder containing parameters that  allow the surface of the layer to be cropped at  the four
sides of a frame. 

Left

[0, (0 / 100)]

Left edge as a percentage of the image width. 

Right

[100 (0 / 100)]

Right edge as a percentage of the image width. 

Up

[100 (0 / 100)]

Top edge as a percentage of the image height. 

Down

[0 (0 / 100)]
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Bottom edge as a percentage of the image height. 

Folder that contains parameters that deform the layer by repositioning its four corners. This
function permits CornerPin tracking in any layer from the Motion Tracker. 

Positioning of the corners of  this  effect  can be  made  in  Tracker mode.  After the  tracking
has  been applied  to  the  effect,  the  offset  parameters  of  each  corner  can  optionally  be
adjusted. 

Note: this distortion is two-dimensional, within the original plane of the layer without  three-
dimensional  deformations.  The  distortion  is  applied  equally  to  color,  its  mask  and
displacement map if available.

UpLeft-X; Y

[0; 100 (-10.000 / 10.000)]

Position of the top left corner. 

UpRight-X; Y

[100; 100 (-10.000 / 10.000)]

Position of the top right corner. 

DownLeft-X; Y

[0; 0 (-10.000 / 10.000)]

Position of the bottom left corner. 

DownRight-X; Y

[100; 0 (-100.000 / 100.000)]

Position of the bottom right corner. 

Use and Comments

The units of this effect are not always expressed in percentage values. 

The rotations are expressed in degrees, as with a camera shutter. 

In the case of Position Y, a value of 200 is equivalent  to placing a layer exactly  above  its
original position, this value being the equivalent  to the distance specified by a value of 100
in Y. 

The Position Z parameter behaves in a similar way to the previous one: specifying a value of
200 moves forward a distance equivalent to a value of 100 in Y. 

However, in the case of Position X, a value of 266 is equivalent to placing a layer exactly to
the right of its original position, this value being the equivalent  to the distance specified by
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a value of 100 in X. 

This is because the values of Size are percentages, but  in order to respect  the appearance
specified  in  Mistika  Setup->Render  Format->Aspect  Ratio,  the  anamorphism  is
respected without converting the position units into percentages. 

The values of Crop are also specified as percentages, although the Crop of this effect  not
only  crops  the  surface  of  the  layer,  but  also  resets  its  edges,  which  is  taken  into
consideration when the deformations are  applied.  If  no  deformations  are  applied,  Crop  will
behave like the other effects of the system. But cylindrical deformations are made by joining
the opposite edges, and in this case Crop resets the edges  of  the  rectangle  of  the  layer.
Thus,  if  a  layer  has  been  deformed  to  a  spherical  shape  and  the  values  of  Crop  are
modified, the edges will be reset without changing its spherical shape since these are joined
by the deformation, but the image area that  is enclosed in the deformation of the layer will
be reset. 

The  following  example  shows  that  crop  has  removed  the  black  bands  in  the  foreground
image, but  when a cylindrical deformation is applied, the new  borders  have  been joined  to
form the cylinder.

With respect to rescaling and repositioning images that  do not  need composition (basically,
conversion of  formats),  Fx->Mistika->Framing  is  often the  most  suitable,  since  it  give
greater quality, speed and has a specialized manipulator to help with cropping, scaling  and
positioning calculations 

For tracking  and  stabilizing,  the  use  of  Comp3D,  is  recommended,  preferably  applying  the
tracking coordinates in Axis_1, leaving the later deformations in the hierarchy of the effect
without  change:  for  example,  the  layers  in  the  Z  axis  could  be  moved  to  simulate  the
parallax of a camera, thus scaling the tracking coordinates. 

Displacement  maps  are  images  in  which  only  the  luminance  information  is  important.  In
accordance with the luminance of the image pixels, the polygons that  constitute the plane
of the layer will be displaced in the depth axis of the object. If  the offset  needs fine detail,
the polygons that constitute the layer must be increased, by using the Subdiv parameter. In
the example, any image can be used as a solid white displacement map. 

Excess  detail  in  the  displacement  map  can  be  softened  with  the  Blur  parameter.  Also,
negative  values  of  the  Ampl  parameter  can  be  specified,  reversing  the  offset  direction.
Displacement  maps are  applied  before  the  other three-dimensional deformations,  and  they
can be combined with cylindrical or wave deformations simultaneously. 
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The  animations  of  positions  of  composed  layers  in  this  effect  are  made  by  specifying
keyframes. Between these  keyframes  are  the  intermediate  positions,  which are  calculated
by interpolations. Several samples can be taken from any position by increasing the Samples
parameter, improving the quality of the result  of the effect. But  a frame is really a fraction
of time, and in that small time range the samples can be specified to be taken from different
positions, if  the layer is moving. The Shutter  parameter specifies a time  range  (between 0
and 360) within the same frames so that the samples are made in movement. 

It  is important  to note that  the render speed of this effect  is  closely  linked  to  parameters
that  increase the resulting image quality, such as  the  Samples  and  RenderMd  options  and
the layer parameter Subdiv, all of which should be carefully set  at  the minimum values that
give  the  desired  quality,  since  the  misuse  of  these  values  can  markedly  reduce  system
performance. 

The three-dimensional space created by this effect  is very large but  finite, and a layer can
even be enlarged or reduced to the point  of leaving the space, resulting  in  total or partial
disappearance of the  layer that  exceeds  this  limit.  A  layer can also  totally  or partially  go
past the camera position. For this reason, it is recommended that the size and its position in
the depth axis are clearly differentiated, since, if  an  image  is  to  be  enlarged,  the  position
value  in  the  Z  axis  can  be  increased,  although  this  method  is  no  more  convenient  than
increasing the size values. 

When a virtual perspective with a multi-layer composition is to be created, first  maintain a
common scale, specifying as a first  step the sizes of each layer as  if  they  were  all  in  the
same  plane.  Then  position  the  layers  in  the  depth  axis.  This  way,  when  the  camera  is
moved, a perspective with a consistent parallax is achieved. 

The following image contains the deformation values for creating different primitive forms: 

Comp3D has a special manipulation mode in the Visual Editor, which permits  the  specifying
of  positions,  rotations  and  sizes  for the  layers,  lights  and  camera,  and  m for  interactive
repositioning (dragging the image) the transformation pivot of each layer. 

It is also advisable to know about the operation of the ActualPixels manipulator (1:1), which
helps  deal with  images  of  size  different  from the  work format.  In  order to  work  with  this
type of image, it  is  important  to  remember that  the  first  layer must  as  large  as  the  work
format  (MistikaSetup->RenderFormat->RenderFormat->X/Y) since this gives  the  size
reference on which the other layers are made up. If there is no background image, include
an effect  without  n put  as first  layer (a Solid, for example), whose output  will provide  this
size reference to begin composing. 

Also, remember that when including layers of nonstandard size, a red frame will appear when
selecting them, indicating that  the complete frame is viewed but  that  a  decision regarding
its rescaling is pending. In the situation in which we see (the complete  image,  it  does  not
have to match the output  of the  Node  Graph monitor (this  will  trim them to  the  standard
size  in  case  of  no  action  being  taken).  This  warning  will  disappear  once  any  value  of
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transformation is established, (by pressing the ActualPixels (1:1)),

From  Version  3.0,  the  tracking  software  in  3D  Boujou  can  export  its  result  to  Mistika
environment. Boujou generates an environment  with  a  Comp3D where  the  camera  layer is
animated  according  to  3D  tracking  done  in  an  original  camera.  This  allows  automatic  to
integration of  new  image  layers  within  another image  (the  one  from the  original  camera),
without  having to animate them manually. To do this, Boujou provides an animation of  the
Comp3D  camera,  so  that  it  moves  the  same  as  the  camera  that  recorded  the  original
images.

It is possible to edit  the colors of the lights by using the color Chooser  manipulation mode,
and selecting in advance the folder containing the light to be edited. 

When using Corner parameters, image movements can be extracted with manipulation mode
 Tracker, using four trackers, one for each corner of the image.

Even if not using motion tracking, this mode is helpful for positioning graphically four corners
for  specifying  transformation,  and  Move  must  be  applied  to  the  tracking  coordinates
whenever it is necessary to refresh the position. 

HaloComp

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Compose->HaloComp

Composes  a  layer with  a  background,  adding  a  luminous  halo  created  from a  copy  of  its
mask to the foreground. 

I/O

Inputs

Double input: The first  input  will be the background and the second the foreground,
using the alpha channel of the latter to generate the halo. 

Inputs

Image: second input composed on the first, with a luminous halo around it. 

Alpha: No change. 
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Parameters

Blur

[2 (0 / 100)]

Halo blur. The copy of the  mask of  the  foreground  generated  by  the  halo  should  be
blurred so as to give it the appropriate look. 

Inside

[50 (0 / 100)]

Sets the percentage level of mixing of the halo in the interior of the mask. 

Higher values indicate greater visibility of the halo in the foreground interior. 

Red; Green; Blue

[0; 0; 0 (0 / 100.000)] 

Specifies a gain correction of the halo color. 

Values higher than 100 are allowable, increasing the halo potential. 

Use and Comments

This effect can be simulated by combining other effects of the system, although it  is faster
to work with this effect, since it has all the parameters necessary in one single effect.

Feedback

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Compose->FeedBack

This effect is not in itself an image process, but rather one of the system tools. 

It  sends the input  to memory and to the output  of all the Feedback effects without  input,
either evaluated by the monitor, or in the frame being processed in a render.

I/O

Inputs

Can be single input (image with or without alpha channel) or without inputs. 

Inputs

No input: 
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Image: The image in memory.

Alpha: The mask in memory.

Single input: 

Image: The input image.

Alpha: The input mask. 

Parameters

None.

Use and Comments

This effect allows the creation of instances of one part  of the flow in different  branches of
the same flow tree to which they belong, without needing to evaluate them repeatedly. 

When the Feedback effect  has no input, its output  shows the last  input  that  was read (of
the same effect  clip or another Feedback effect),  thus  for example  permitting  lengthening
the duration of the result  of a shorter effect, which has been memorized by  the  Feedback
input and will be repeated during all the remaining duration of the Feedback clip as long as
there is no new input. 

In this example, it  can be seen that  the stacks  on the  left  contain  an animation with  the
appearance of a logo (made with  the  LiquidBump  effect).  When it  is  necessary  to  extend
the duration of the static end of the animation, it  would be possible to continue processing
the last frame. However, this would force the evaluation of all the additional frames, which
would  be  pointless  as  they  are  identical.  To  avoid  unnecessary  evaluation  of  these
additional frames,  render  and  then  extend  the  tail  of  the  new  clip,  or  use  Feedback  to
repeat the last frame from memory. 

This effect updates its output whenever any parameter of any effect  is changed, making it
an effect  that  is  very  useful when there  is  a  need  to  see  the  changes  in  many  created
instances interactively. 
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Bear  in  mind  the  order  of  evaluation  of  the  stacks  when  using  this  effect,  since  poor
organization  can  prevent  its  correct  functioning,  as  it  will  continually  insert  the  original
Feedback effect  (with input) obtained in a previous  order of  evaluation,  in  the  successive
instances  of  the  Feedback  effect.  A  new  original  Feedback  with  input  will  update  the
temporary memory used by the effect. 

The  effect  can  also  be  used  for  creating  a  trail  during  movement.  For  example,  if  a
Feedback effect  is created with a Comp3D as input  (it  will  be  the  original Feedback),  and
another Feedback without  input  is created as background input  of the Comp3D, the layers
in movement in the 3D composition will leave a trail of copies of its previous positions. This
is because the background of the  composition  is  being  fed  back with  its  result.  If  a  small
color correction that slightly darkens the composition is now added to the original Feedback
in a previous order of evaluation, the Feedback copy created as background  will  show  the
feedback with  the  color correction that  has  been recursively  run  on  the  movement  trail,
having repeated the same color correction several times in the older tracks left by the trail. 

Special attention should be paid to the monitor, since Feedback is an effect, unlike  almost
all the other Mistika  effects,  whose  result  may  depend  on how  it  is  evaluated  previously.
The  result,  therefore,  depends  of  the  order  in  which  the  frames  are  evaluated,  and  the
result of normal playback can be very different from that of reverse playback. 
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Scope

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Compose->Scope

This effect   is  useful for grouping  together layers  that  are  not  otherwise  related  to  each
other,  thus  avoiding  manual  offset  of  the  monitor  mark  in  the  vertical  axis  of  the  Node
Graph. 

 

It can also be used to force the conversion of an image to a specific internal format in order
to control quality. 

I/O

Inputs

Multi-input: Image with or without alpha channel. 

Inputs

Image: No changes, unless the input is YUV, in which case it is converted to RGB.

Alpha: No change.

Parameters

Format

[NO CHANGE (NO CHANGE / YUV422 / RGB8B / RGBA8B / RGB10B / RGBA16B / HW-HDR)]

Defines the output of the effect.

Use and Comments

This effect is useful for grouping a part of the timeline, and activating its Proxy, thus making
it behave as a low resolution temporary clip. 

In this example, it can be seen that  the Scope effect  has the Proxy active and calculated.
This speeds up the monitor in the timeline,  since  the  effect  avoids  the  monitor evaluating
the  effects  of  this  part  of  the  timeline,  maintaining  constant  real-time  speed.  Remember
that the Proxy is not visible if the monitor is only evaluating in high resolution. 

It  also  allows  the  monitor to  view  tracks  that  cannot  be  contained  in  the  height  of  the
monitor bar, which in this example has a height of six tracks, and the effect  allows a further
four tracks below it to be viewed due to its scope. (There is no need to use this tool if  the
Center Monitor option is activated). 
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Dummy Clip

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Compose->Dummy Clip

This effect is not in itself an image process, but rather one of the system tools. 

Dummy is a type of clip that is used in a group as a replacement  for a layer, which may be
outside the group as an input  to the group, or also in combination with  the  Dummy  Comp
effect. 

When a  set  of  effects  of  the  same  duration  are  grouped  with  a  Dummy,  the  group  will
change  into  a  template  group,  which  as  compared  with  other  groups,  has  a  scope  for
placing inputs. 

These  inputs  will  be  evaluated  instead  of  the  Dummy  clips  within  the  template  group,
activating the use of a template. 

Another  way  to  activate  the  use  of  a  template  is  by  using  the  Dummy  Comp  effect,
without the need to group. 

Dummy clips have a number corresponding to the input  number of the template group that
will be assigned as its replacement. 

In order to  assign an identifying  number to  the  Dummy  clip,  a  number should  be  entered
into the calculator, with the Use button active, and then press the button in the gallery of
effects that  adds a Dummy in the Node Graph. The number in the calculator will appear in
the Dummy clip that is created. 

The Dummy clip identifying numbers correspond to the inputs of the template group in the
following order: 

Dummy 1: first input. 

Dummy 2: second input. 

Dummy 3: third input, and so on successively. 

Bear in  mind  that  the  identifying  numbers  of  Dummy  clips  should  consist  of  a  successive
numbering starting with 1. Otherwise  it  is  impossible  to  assign the  inputs  correctly  to  the
template group. 

Within  a  template  group,  several  Dummy  clips  can  coexist  with  the  same  identifying
number,  thus  working  as  instances  of  the  same  template  group  input,  which  is  only
evaluated  once,  sent  to  memory  and  then  replaces  all  the  Dummy  clips  with  the  same
identifying number, in this case resulting in similar behavior to the Feedback effect. 

Each  Dummy  clip  evaluated  without  having  an  assignment  produces  an  image  that
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symbolizes its number with squares specified by its index similar to the numbers on a  dice,
with a different  color for each identifying number, so  that  there  is  a  reference  to  the  clip
and the lack of an input in the template group can be detected. 

The following example shows the steps to follow to construct an effect template. 

In  the  example,  it  can be  seen that  the  same  input  will  be  repeated  three  times  in  the
original  stacks.  This  repetition  can  be  avoided  by  using  the  assignments  generated  by
Dummy clips. 

In other systems, the vertical flow of the first  two steps of the example could be shown in
the following way: 

Remember that, in order to create a template group, it is necessary to group aligned clips of
the same duration, with at  least  one Dummy clip inside the group. Otherwise the template
group is not created and a normal group is specified instead. 

However, once the template group is created, it is possible to navigate in it  and modify the
duration of the clips. When exiting the group, Mistika will ask if any additional actions should
be  taken first,  or if  all  the  durations  of  the  clips  in  the  group  should  be  adjusted  to  the
original duration. 

When the duration of the template group is specified again in the Node Graph, the duration
of all the clips inside the group will also be specified again. 

The template groups can be combined in an infinite number of ways, and a template group
can be used as the input of another. 

This  means  that  this  effect  can be  used  to  create  templates  from any  stack  of  effects,
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creating groups that  can be stored for later use, thus optimizing tasks that  repeatedly use
the same stack of effects preconfigured by the user. These can be modified at any time. 

A more complex flow will be used as another example, also using the Dummy Comp effect: 

This flow is also shown on the right  in  a  one-dimensional diagram,  since  it  does  represent
the duration of each process,  to  understand  how  the  Dummy  effect  creates  instances  in
another part  of the flow. The blue lines indicate the assignments in the first  flow,  and  the
green lines those in the second. 

Dummy Comp

Ref.  Mistika:  Node  Graph  Editor->Dashboard->Fx->Mistika->Compose->Dummy
Comp

Activates  Dummy  clip  templates,  without  the  need  to  group  the  flow  with  Dummy  in  a
template group, thus making visible the parameters of the generated templates. 



386 FX

SGO Mistika 8.6 © 2018 SGO

I/O

Inputs

Multi-input: the first  input  should  be  the  flow  with  Dummy  clips,  and  the  following
inputs the layers that will replace the Dummy clips. 

Inputs

Image: Image derived from the effect templates generated by the Dummy clips. 

Alpha: Mask derived from the effect templates generated by the Dummy clips. 

Parameters

None.

Use and Comments

This effect is not in itself an image processor, but rather one the system tools. 

This effect activates the Dummy clips templates without the need to group the effects and
the Dummy clips in a template group. 

In order to work correctly, this effect should have within its scope as first  input  the flow of
the  effects  of  the  Dummy  clips,  and  then  the  images  (or  flows)  that  will  replace  the
Dummy clips in the order indicated by the numbers of the Dummy clips. 

If Dummy  Comp  is  grouped  with  the  flow  of  the  Dummy  clips,  the  effect  will  be  ignored
within the group because it  only has one  input,  thus  permitting  correct  functioning  of  the
template group. 
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This effect  is ideal for interactively specifying the parameter values of a template, since  it
activates  it  without  the  need  to  group  and  lose  the  possibility  of  modifying  parameters,
while viewing immediately the result in the image. In addition, the effect can remain grouped
in  the  template  group  without  interfering  with  its  functioning,  and  be  reused  when  the
template group that contains it is ungrouped. 

Boolean

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Boolean

The effects of the Boolean menu add Boolean operations to clips.

Channels

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Boolean->Channels

Reassigns or combines  the  RGB and  Alpha  channels  that  come  from the  same  or different
images by using Boolean operations.

Clip naming system

The   majority  of  the  parameters  of  this  effect  are  expressed  with  words  to  make  their
interpretation  easier.  These  values  are  not  usually  animated,  as  they  express  modes.
Certain combinations of parameters defines standard functions that  the system recognizes.
These  standard  functions  (such as  assigning  an  external  mask)  automatically  modify  the
name of the effect  being viewed  in the  Node Graph (for example,  Channels  automatically
changes to ExternalKey when the external mask is defined).

If the values detected by the system in order to change names are found to be animated, it
is viewed as the name of the combined parameters specified in frame 0.

This effect  can be accessed from the effects gallery, via  presets  with  associated  hotkeys
and its own button within the gallery, but  in reality only this  effect  is  invoked  as  it  brings
together many possible functionalities.

Parameters

This effect has four dropdown folders, one for each channel (red, green, blue and alpha). It
also has a mode folder described below.

Mode

[HW-HDR (SW, HW, HW-HDR)]

Defines the processing mode of  the effect.

SW specifies that the calculation is done by software.

HW  specifies  that  the  calculation  is  done  by  hardware,  in  8-bits  color  depth  per
channel.
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HW-HDR specifies that the calculation is done by hardware, in 16-bits color depth per
channel.  (HDR  stands  for  “High  Dynamic  Range”).  This  mode  is  recommended  for
images that  have  more  than 8 bits  per channel,  such as  those  obtained  from a  film
scanner.

Note:  the  default  option  (HWare)  is  recommended  as  modern  graphics  boards  are
optimized for calculating depth at 16 bits per pixel color.

The  folders  of  the  four channels  contain  identical parameters,  with  differing  default
values in order initially to maintain the input  image without  changes. Below there is a
description of the Red folder, since the only difference with the other folders (Green,
Blue and Alpha) is in its default value.

Red:

Along with Mode, this effect  has  four dropdown folders,  one  for each channel(red,  green,
blue and alpha).

Its parameters are defined here using the red channel as an example (Red folder).

X

R1 (R1, G1, B1, A1, Luma1, R2, G2, B2, A2, Luma2)

Reassigns the channel that is interpreted as the current  channel (in this example, red
channel). The default value specifies that the red channel is that of the first input).

R1 assigns the red channel of the first input as the current channel.

G1  assigns the green channel of the first input as the current channel.

B1  assigns the blue channel of the first input as the current channel.

A1 assigns the alpha channel of the first input as the current channel.

Luma1 assigns the luminance of the first input as the current channel.

R2 assigns the red channel of the second input as the current channel.

G2 assigns the green channel of the second input as the current channel.

B2 assigns the blue channel of the second input as the current channel.

A2 assigns the alpha channel of the second input as the current channel.

Luma2 assigns the luminance of the second input as the current channel.

Operation

X Only (X Only, Only Y, Plus, Minus, And, Or, Xor, Min, Max, Diff)

Specifies the mathematical operation that  combines the first  assigned  value  (X)  with
the second (Y).

Note:  the  second  assigned  value  (Y)  can  also  be  multiple,  so  Y  specifies  the
combination of the inputs from the second on, so it  is possible for example to add the
values of the multiple inputs to the first input.

X Only specifies that  the current  channel comes from the channel assigned by the X
entry, without changes.
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Only  Y  specifies  that  the  current  channel comes  from the  channel  of  the  entry  Y,
without  changes. In the case of multiple inputs, only the second input  is  taken in  to
account.

Plus adds the values of the pixels of X and Y.

Minus subtracts the values of the pixels of Y from X.

And multiplies values of the pixels of X and Y.

Or specifies an Or operation with the values of the pixels of X  and  Y.  This  operation
inverts  the  values  of  the  inputs  before  multiplying  them,  and  then  the  result  is
inverted again, thus functioning in an opposite fashion to And.

Xor specifies  an  Xor  operation  with  the  values  of  the  pixels  of  X  and  Y.  The  Xor
combination is an operation that  is  achieved  by  combining  with  Or the  result  of  the
two  previous  multiplication operations:  multiplying  the  first  by  the  second  selection
and multiplying the second by the first selection.

Min specifies that the lowest value of pixels between X and Y remains in the results.

Max specifies that the highest value of pixels between X and Y remains in the results.

Diff specifies as a result the difference between the pixel values of X and Y.

Invert X

No (Yes/No)

Inverts the assigned values in the current channel.

Invert out

No (Yes/No)

Inverts the values of the result of the combination of the current channel.

Invert Y

No (Yes/No)

Inverts the assigned Y values in the current channel.

Scale 

[100 (–1.000.000 / 1.000.000)]

This  parameter multiplies  by  percentage  units  the  result  of  the  combination  of  the
edited channel, scaling the final result of the specified mathematical operation.

Bias R;G;B;A

[0 (–1.000.000 / 1.000.000)]

This  parameter  adds  a  constant  value  (positive  or  negative)  to  the  result  of  the
combination of the edited and scaled channel,  behaving  like  an offset  control of  the
final result.
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Thus the new value of the channel is the result  of the  mathematical operation,  then
multiplied in percentage units by the Scale factor, then added to the Bias value.

I/O

Inputs

Multi-input: from one to unlimited inputs, with or without alpha channel. 

Inputs

Image: Combination of the RGB channels. 

Alpha: Mask altered by the combination. 

Use and Comments

This  effect  has  a  very  generic  use,  since  it  allows  the  combination  of  each  channel
separately using mathematical operations,  which makes  it  a  very  versatile  effect  both  for
combining different images and for combining channels of different images. 

For example, to restrict an effect to a single channel, the red, for example, Channels can be
used. The original image should be used as  the  first  input,  and  then the  same  image  with
filter as the second input, specifying in the effect  parameters that  the  red  channel should
come from the second input (R2). 

Another  common  use  is  the  one  of  the  mathematical  Diff  operation  to  make  a  cut  by
difference in static takes in which the camera does not  move. Thus, we can insert  an input
with a clean background and another one with a character moving on the same background,
and use the Diff  operation to subtract  the two images, obtaining the cut  of the character.
Thus we obtain an image in which all the pixels are black except  those corresponding to the
character. These pixels show a random color, which is why we have to process them later
(for example, by means of the Color Grade effect) to obtain a valid mask (well contrasted in
black and white) and to apply a slight blur effect smooth the edges.

The  clip  name  system  recognizes  the  following  standard  combinations:  Add,  Subtract,
Multiply, Or, ShowAlpha, InvertAlpha, ClearAlpha, ExternalKey.

Add

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Boolean->Add

Add combines the pixel values in an addition result. 

Although Or   gives  a  similar visual result,  Add  is  the  most  appropriate  for composing  light
sources, such as car headlights, or the sun in the sky for example. Since  a  source  always
adds light to a scene, this effect behaves in an analogous way. 

This effect is also often used for combining images representing masks.
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Or

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Boolean->Or

Or  inverts the input  values  before  multiplying  them,  and  the  result  is  inserted  again,  thus
working in the opposite way to And. 

Because of its behaviour, Or  is the recommended operation for composing light  reflected on
transparent objects, such as the reflection of a driver on a car windscreen, for example. It
is also highly recommended for use as a color corrector of the second input, which will work
as a composition control. 

And

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Boolean->And

And (Multiply) combines  the pixel values by multiplication. Bear in mind that  the values of a
pixel are measured in percentage units, and so the units must  be normalized to understand
that this is what is multiplied. 

As an example, suppose that  a pixel of the first  input  has a value of 80 (%). In normalized
values,  this  is  equivalent  to  0.8.  The  pixel  of  the  second  input  that  corresponds  by  its
position  has  a  value  of  50 (equivalent  to  0.5  normalized).  Then  the  value  of  the  first  is
multiplied by the second: 0.8 x 0.5 = 0.4. 

The first input is then obscured by the second. If the normalized value of the second were
the  maximum (1),  the  operation would  be  0.8 x 1= 0.8.  Therefore,  this  operation  always
obscures the first input based on the values of the second. Because of its behavior, Multiply
is appropriate for composing shadows. 

In the example, it can be seen how the second input  only adds darkness to the first  input,
in this case emulating a tattoo. The second image of the example was  made  by  deforming
an image with the Refract effect. 
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The use of a color corrector, which will work as a composition control, in the second input is
also recommended. 

This effect is also often used to combine images representing masks, in this case obtaining
as a result the opacity intersection area of both masks. 

Sub

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Boolean->Sub

Sub (Subtract) combines pixel values by subtraction. Its use is not  specially recommended,
since there is no natural effect that is analogous to it. 

Subtracting two identical images gives a  black frame.  For this  reason,  this  effect  is  often
used  to  evaluate  the  differences  between  two  images,  and  also  to  obtain  masks  by
difference. 

This effect is also often used to combine images representing masks.

Decode

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Decode

The  Decode  menu  includes  decodification  effects  in  order  to  natively  process  different
image formats.

Arri Params

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Decode->Arri Params

This color correction effect is oriented for processing shapes from native images shot  in Arri
Raw (.ari) format. This format is used for Arri cameras such as Alexa.
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Since Arri Raw is a RAW format  (ie, it  contains the entirety of the image data captured by
the camera sensor), the  ArriParams effect can modify the values of any of the parameters
established in the Arri camera during the shoot.

I/O

Inputs

Single input: image

Output

Image: color corrected image

Alpha: opaque mask

Parameters

ASA

[Source(Source/160/.../3200)] 

Modifies the ASA value to be used. 

Kelvin

[Source(Source/2.000/.../11.000)] 

Modifies the Color temperature be used.

Tint

[0 (-8/8)]

Works as a  complementary  white  balance  corrector,  compensating  the  magenta  and
green components derived from certain light  sources such as fluorescents and sodium
lights.

Sharpness

[100 (0/300)]

Defines the sharpness level to be used in each pixel.

Color Space

[Wide  Gamut+LogC(Camera  Native+LogC/Wide  Gamut+LOGC/ITU  709
+Gamma 2.4/P3+Gamma 2.6/Film/ACES)]

Selects the desired color space as defined by ARRI.

Filter Chroma

[None, (None/3x3/5x5/7x7/9x9)]
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Filters Bayer moire color artifacts on edges. The larger the value,  the  more  thorough
the filter, but at cost of loss of color detail resolution. 

The recommended value is 3x3.

It can be left Off if no undesired artifacts are observed. 

R3DParams

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Decode->R3DParams

This  color correction effect  is  oriented  for processing  shapes  from native  images  shot  in
REDCODE (.R3D) format. This format is used for RED cameras such as RED ONE and EPIC.

Since REDCODE is a RAW format (ie, it  contains the entirety of the image data captured by
the camera sensor), the  R3DParams effect can modify the values of any of the parameters
established in the RED camera during the shoot.

I/O

Inputs

Single input: image

Output

Image: image corrected de color.

Alpha: mask opaca.

Parameters

Kelvin:

Use

[Source (Source/Value)]

Option for maintaining the values established in the camera during a shoot  (Source) or
to modify them via Value.

Value

[6500 (1700/100.000)]

Modifies  color  temperature.  The  default  value  corresponds  to  the  temperature  of
Daylight  (6500K).  The  lower the  value,  the  less  "warm"  the  resulting  image  will  be,
compensating, for example, for Tungsten light (3200K). 

Generally  its  function is  to  compensate  for  the  excess  of  "warmth"  to  achieve  the
most neutral result possible.
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Tint:

Use

[Source (Source/Value)]

Option for maintaining the values established in the camera during a shoot  (Source) or
to modify them via Value.

Value

[0 (-100/100)]

Functions  as  a  complementary  corrector  of  white  balance.  It  compensates  for  the
magenta and green components found in certain light  sources  such as  those  derived
from fluorescent or sodium.

ExposureCompe:

Use

[Source (Source/Value)]

Option for maintaining the values established in the camera during a shoot  (Source) or
to modify them via Value.

Value

[0 (-7/7)]

Raises or reduces the luminosity in units of exposure range (ƒ-stops).

Gain:

Use

[Source (Source/Value)]

Option for maintaining the values established in the camera during a shoot  (Source) or
to modify them via Value.

Red; Green; Blue

[1 (-10/10)]

Permits the individual adjustment of the gain of the RGB channels. The modification of 

Saturation:

Use

[Source (Source/Value)]

Option for maintaining the values established in the camera during a shoot  (Source) or
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to modify them via Value.

Value

[1 (0/4)]

Defines the intensity of color of the image.

Contrast:

Use

[Source (Source/Value)]

Option for maintaining the values established in the camera during a shoot  (Source) or
to modify them via Value.

Value

[0 (-1/1)]

Defines  the  value  of  contrast,  raising  or reducing  symmetrically  the  values  of  white
and black while leaving the values medium (midtones) at around 50 percent.

Brightness:

Use

[Source (Source/Value)]

Option for maintaining the values established in the camera during a shoot  (Source) or
to modify them via Value.

Value

[0 (-10/10)]

Defines the brightness of the image.

DRX:

Use

[Source (Source/Value)]

Option for maintaining the values established in the camera during a shoot  (Source) or
to modify them via Value.

Value

[0 (0/1)]

By modifying the  value  of  DRX  (Dynamic  Range  Extension),  it  is  possible  to  increase
the dynamic range of the image to avoid clipping problems in bright lighting (highlights)
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owing  to  overexposure  of  camera  material.  To  obtain  results,  it  is  necessary  for  at
least  one of the three color RGB channels  not  to  have  been overexposed  (generally,
blue), since DRX uses this information to reconstruct the rest.

Shadow:

Use

[Source (Source/Value)]

Option  for  maintaining  the  values  set  in  the  camera  during  the  shoot  (Source)  or
modify them via  Value.

Value

[0 (-2/2)]

Defines the low values of the FLUT, that  is to say, those close to black (shadows or
low light).

FLUT:

Use

[Source (Source/Value)]

Option  for  maintaining  the  values  set  in  the  camera  during  the  shoot  (Source)  or
modify them via  Value.

Value

[0 (-8/8)]

Defines the settings of the mid-tones.

R3DParams:

ISO

[Source (Source / 50 / 80 / 100 / 125 / 160 / 200 / 250 / 320 /  400 /  500 /
640 / 800 / 1.000 / 1280 / 1600 / 2000 / 2500 / 3200 / 4000 / 5000 / 6400 /
12800)]

Like  the  parameter ExposureCompe,  this  modifies  the  gain  values  of  the  image  in  a
linear way, increasing or decreasing  the  value  of  white  and  maintaining  the  value  of
black at 0%.

GammaCurve

[Source (Source / Linear / Rec.709 /  REDspace  /  REDlog /  PDlog 685 /  PDlog
985  /  CustomPDlog  /  REDgamma  /  SRGB  /  REDlogFilm  /  REDgamma2  /
REDgamma3 / REDgamma3)]

Defines the color space of the values of the gamma curve.
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ColorSpace

[Source  (Source  /  CameraRGB  /Rec.709  /  REDspace  /  REDcolor  /
ImageColorSRGB / ImageColorAdobe1998 /  ImageColorREDcolor2 /  Unused /
ImageColorREDcolor3 / DragonColor /  ImageColorREDcolor4 / DragonColor2 )]

Defines the color space of the image.

Detail

[Source (Source/Low/Medium/High)]

Defines the level of detail of the image.

OLPFCompensation

[Source (Source/Off/Low/Medium/High)]

Permits increase of the value clarity to compensate  blur generated  in  a  shoot  by  an
optical low pass filter.

Denoise

[Source (Source/Low/Minimum/Milder/Mild/Medium/Strong/Maximum)]

Defines the intensity of the denoise of RED.

Reduce

[mConfig (mConfig/1:1/1:2/1:4/1:8)]

Defines the  resolution relation with  respect  to  original image.  To  respect  the  values
established in mConfig->Codecs, select the option mConfig.

Bit Depth

[10 bit (mConfig / 8 bit / 10 bit / 12 bit / 16 bit / 16-HDR)]

Defines the bit depth of the image output. To use/restore the preset  values in Mistika
Setup, select mConfig.

Track

Sets the Track to be used in the case of a file derived from a HDRx recording (allowing
us to capture 2 Tracks with different expositions, stored in the same .r3d file).

DEB

[ON/OFF]

DEB ("Dragon Enhanced Blacks") is an antinoise filter which works only in  RED Dragon
files, lowering the noise of the red channel to offer cleaner black and shadows. 
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Use and Comments

Mistika's  main  color correction is  the  effect  Color  Grade  (Mistika->Node  Graph  Editor-
>Dashboard->Fx->Mistika->Color->Color Grade).  Unless  specifically  indicated  to  use
the setting employed during the shoot, the recommended workflow is the effect  R3DParams
in order to prepare material to be subsequently corrected with Color Grade. 

Color Grade works with  a  bit  depth values  specified  in  the  effect  R3DParams.  This  allows
maximum manipulation of  color if  values  of  16 bit  or 16-HDR are  defined  in  the  Bit  Depth
parameter  (Node  Graph  Editor->Dashboard->Fx->Mistika->Color->R3DParams-
>R3DParams).

However,  in  order  to  obtain  the  best  results  and  optimize  process  times,  certain
considerations must be taken into account to correctly define the bit depth:

The  8  bit  option  is  only  useful  for  comparing  with  other  values,  as  it  results  in  loss  of
quality. 

Generally, 10 bit is that which gives the best results. 

The 12 bit option is only supported in those systems that have a RED ROCKET card.

The 16 bit-HDR option ignores most  of the parameters of the REDRAW codec,  allowing  the
user to interpret  the range, gamma, color space etc  employed. This is the  only  mode  that
produces an image with pixels with values above 100%. 

The  12  bit  and  16  bit  modes  are  only  useful  when  working  within  a  linear  color  space
(instead  of  a  "REDLOG"  logarithmic  color  space,  which  is  the  most  typical).  It  is
recommended  to  use  these  two  options  very  carefully,  as  they  will  rarely  produce  an
improvement  in  the  image  quality,  while  they  negatively  affect  the  performance  of  the
system. Their use must be for specific reasons, and never "just in case".

The R3DParams effect  can modify  the  decompression parameters  of  the  original .R3D file,
even after a color correction has been done, as they remain editable at all times.

Before  starting  a  color  correction  with  Color  Grade,  it  is  recommendable  to  set  the
parameters of R3DParams with the aim of obtaining the best  dynamic  range possible and a
neutral  color  temperature.  Generally,  this  can  be  achieved  by  modifying  the  values  of
ExposureCompe, Gain and ISO (with the help of a vectorscope in W-Luma mode), to widen
the  dynamic  range  and  set  the  Kelvin  parameters  to  compensate  the  color  temperature
(with the help of the vectorscope in Vscope mode). If the material from the shoot  presents
overexposure problems, these can be  adjusted  with  the  DRX  option to  obtain  results  that
are  within  legal  values  for  the  image  (Mistika->Node  Graph  Editor->Dashboard->Fx-
>Mistika->Color->R3DParams->DRX->Value).

Another point to bear in mind is the sharpness of the corrected image. As R3DParams has a
native compensation for the optical low pass filter (OLPF) housed in al camera sensor, it  is
best  first  to  correct  the  sharpness  of  a  R3D image  with  this  parameter  before  using  the
effect Sharpen. If  the correction with 3RDParams is not  sufficient, Sharpen should then be
used. 

On  workstations  with  reduced  processing  capacity,  it  may  be  useful  to  work  in  lower
resolution (at  least  temporarily)  to  ease  the  post-production  process.  Via  the  parameter
reduce  (Mistika->Node  Graph  Editor->Dashboard->Fx->Mistika->Color-
>R3DParams->R3DParams->Reduce)  it  is  possible  to  reduce  the  maximum theoretical
resolution  (1:1)  to  a  half  (1:2),  to  a  quarter  (1:4)  or  to  an  eighth  (1:8).  At  any  time
subsequently this can be returned to the original state, usually to obtain the final render.

From Mistika Setup it is possible to redefine all the R3D parameters by overwriting the values
set of the shoot. For example, if  a High OLPF compensation is required on all the .R3D files,
this  can be  done  via  Mistika  Setup  (Mistika  Setup->RED) instead  of  modifying  the  clips
one by one. In this case, the values overwritten by  Mistika Setup will be the  new  Source
values of R3DParams.
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It  is important  to bear in  mind  that  the  majority  of  digital  cameras  (including  RedOne  and
Epic) use Bayer matrix sensors, in other words each element of the sensor (or resulting pixel
before processing the image) is only sensitive to one color component  (R, G, or B,  typically
distributed  in  a  pattern  with  more  elements  sensitive  to  green  than  the  other  2  colors).
Thus  the  effective  resolution of  the  camera  image  is  always  less  than a  format  with  the
same resolution (but real RGB) in Mistika. There are also other factors that reduce the detail
that it will possible to obtain, such as the signal/noise ratio of the sensor, the compression
algorithms (JPEG2000) used by these cameras, exposure time, the  lenses  used,  or a  lower
resolution in the format delivered than was requested. 

For this reason it  is usually recommendable  to  work with  a  Reduce  factor of  1:2,  and  not
increase it to 1:1 unless there is a specific reason to do so (and never "just  in case"). Also,
if  greater sharpness results from using 1:1 mode,  the  image  should  be  magnified  to  check
that  noise  has  not  correspondingly  increased,  since  in  this  case,  quality  is  lost  when the
image  has  movement,  and  especially  in  Stereo3D  formats,  where  noise  is  especially
uncomfortable (since each noise element is visible in one eye and is not consistent). 

The  reverse  may  also  happen,  and  that  when  changing  to  1:1,  the  image  is  softened,
depending  on  the  other  parameters  of  the  effect:  a  softer  image  can  result  if  the  the
blurring filters that  use this codec  are augmented. If it  is desired that  noise is eliminated it
is  usually  more  effective  to  use  Mistika's  effects  Blur  and  Denoise,  as  they  give  greater
control, quality and are much quicker to process. 

Finally, it  must  be stressed that  1:1 mode mode should only be used to see greater detail,
and not to resolve problems of noise or sharpness. 

Also bear in mind that que there is a macro in the editing panel to force this effect to reload
the metadata parameters of the R3D files and their associated RMD files, if they exist.

SonyRawParams

Ref.  Mistika:  Node  Graph  Editor->Dashboard->Fx->Mistika->Decode-
>SonyRawParams

This decoding effect is oriented to the native processing of images captured in RAW format,
developed by Sony (packaged in .mxf). This format  is used by Sony cameras, such as F65,
F55, etc.

Given that  it  is  a  RAW format  (ie  it  contains  all  the  data  of  the  image  captured  by  the
camera sensor), the effect SonyRawParams can modify the values of any of the parameters
for the processing and development of the final image.

I/O

Inputs

Single Input: image to be processed.

Outputs

Image: color corrected image

Alpha: opaque mask.

Parameters

Exposure ISO

[Source(Source/80/.../10000)] 
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Selects the value of ISO to be used. 

Kelvin Use

[Source(Source/Value)] 

Indicates whether the value to be used is already selected from source or is the value
indicated in the following field. 

Kelvin Value

[5500 (2800/10000)]

Kelvin value for the color temperature of the image.

Tint

[0.00 (-1/1)]

Works as a  complementary  white  balance  corrector,  compensating  the  magenta  and
green  components  that  derive  from certain  light  sources,  such  as  fluorescent  and
sodium lights.

Source Gamut

[S-Gamut/S-Gamut3/S-Gamut3.cine]

Select the input color gamut of the image.

Output Gamut

[Camera Native/XYZ/709 sRGB/ACES/P3DCI/P3D60]

Select the output color gamut of the image

Gamma Curve

[709  (709/709(800)/HG8009G40/HG8009G33/S-Log2/2.2/2.4/Linear/
CineLog)]

Selects the desired gamma curve.

Reduce

[mConfig (mConfig/1:1/1:2/1:4/1:8)]

Defines  the  resolution  relation  with  respect  to  the  original  image.  To  respect  the
values established in mConfig->Codecs, select mConfig.

Quality

[mConfig (mConfig/Standard/High)]

Defines the quality of the image processing.
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Use GPU

[Off (Off/On)]

Activates processing by GPU.

CanonRawParams

This  decodifying  effect  is  intended  for native  processing  of  images  in  RAW  developed  by
Canon (captured in .rmf). This format is used by cameras such as Canon C500.

As  this  is  a  RAW  format  (containing  all  the  data  of  the  image  captured  by  the  camera
sensor),  the  effect  CanonRawParams  may  modify  values  of  some  parameters  in  order  to
process and develop the final image.

I/O

Inputs

Single Input: image to be processed.

Outputs

Image: color corrected image

Alpha: opaque mask.

Parameters

Sharpness

[100 (0/300)]

Sets the level of Sharpness to be applied to each píxel.

Color Space

[ACES A-D65 / ACES A-Tungsten / ACES C-D65 /  ACES C-Tungsten /  ACES D-
D65 / ACES D-Tungsten]

Sets the color space of the image.

Filter Chroma

[5x5 (3x3 / 5x5/ 7x7 / 9x9]

Filters color artifacts: the higher this value, the greater the degree of filtering applied
to the image, which causes loss of detail in the color.
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PhantomParams

Ref.  Mistika:  Node  Graph  Editor->Dashboard->Fx->Mistika->Decode-
>PhantomParams

This decoding effect  is oriented to the native processing of images recorded in .cine  RAW.
This format is used by hight speed Phantom cameras.

Via  the  effect  PhantomParams  it  is  possible  to  modify  the  values  of  various  of  the  data
parameters that  come with the file, such as black point, and choose the quality or form of
debayer of the image.

I/O

Inputs

Single Input: image to be processed.

Outputs

Image: color corrected image

Alpha: opaque mask.

Parameters

WhitePoint:

Use

[Source (Source /Value)]

Indicates whether the white point is from source or has been defined, as below.

Red Gain

[1 (0 /100)]

Defines the value of the white point in the red channel.

Blue Gain

[1 (0 /100)]

Defines the value of the white point in the blue channel.

Debayer:

Filter Chroma

[5x5 (3x3 / 5x5/ 7x7 / 9x9]

Filters color artifacts created  by  the  Bayer pattern.  The  higher the  value,  the  more
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the image is filtered, with the resulting  loss of detail in the color.

Correct:

Gamma

[1.7 (1 / 10)]

Defines the gamma value of the image. Lower values set  a darker color, so  the  color
correction lifts the brightness of the image.

Gain

[100 (0 / 3200)]

Adjusts  the  gain  of  the  image.  The  modification  of  these  parameters  increases  or
decreases the white value, scales the midtones y and fixes the black value at 0%.

Saturation

[100 (0 / 1000)]

Defines the intensity of the color of the image.

Debayer

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Decode->Debayer

This effect  converts a RAW  image  derived  from the  codecs  of  certain  cameras  based  on
Bayer-type sensors in an image with RGB color space.

When converting by means of hardware, using the GPU, Debayer  decodes  codecs  such as
Phantom Cine (from Phantom cameras) and Weisscam in real time .

Other cameras with Bayer sensors (such as RED and ARRI) may have their own specialized
effect  of  transparent  supports  available  from codec  libraries  such  as  ffmpeg.  Thus,  this
effect should only be used with cameras specifically supported by the effect, although this
is an area that is constantly evolving. Supports are constantly added for new cameras and
new specialized effects are created for others so this documentation may be obsolete. We
recommend consulting SGO in case of doubt.

I/O

Inputs

Single input: RAW image derived from cameras supported by the effect.

Inputs

Image: Image in RGB color space.

Alpha: Opaque mask.
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Parameters

Debayer:

Pattern

[Auto (Auto / GRGR / RGRG / GBGB / BGBG)]

Specifies the disposition of the R, G and B filters in the fabric  of the Bayer mosaic  to
be converted.

Filter Luma

[Type 3 (None / Type 1 / Type 2 / Type 3]

Filters the jigsaw artifacts of luminance created by the Bayer pattern. The higher the
value,  the  more  the  image  is  filtered.  If  the  image  is  reduced  in  resolution,  it  is
recommendable  to  set  this  parameter at  None,  and  set  a  high value  for Tap  in  the
Framing tab.

Filter Chroma

[5x5 (3x3 / 5x5/ 7x7 / 9x9]

Filters  the  color artifacts  created  by  the  Bayer  pattern.  The  higher  the  value,  the
more th image is filtered with a resulting loss of detail in color.

Flop

[No (No / Yes]

Allows the application of a predefined rotation of 180 degrees in Y.

BlackPoint:

Red

[0 (0 /100)]

Sets the value of black in the red channel.

Green

[0 (0 /100)]

Sets the value of black in the green channel.

Blue

[0 (0 /100)]

Sets the value of black in the blue channel.

Note:  These  can also  be  set  via  the  manipulator  Set  Color  in  the  Visual  Editor  (Visual
Editor->Dashboard->Set Color).
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WhitePoint:

Red

[0 (0 /100)]

Sets the value of the white point in the red channel.

Green

[0 (0 /100)]

Sets the value of the white point in the green channel.

Blue

[0 (0 /100)]

Sets the value of the white point in the blue channel.

Note:  These  values  can  also  be  set  via  the  manipulator  Set  Color  in  the  Visual  Editor
(Visual Editor->Dashboard->Set  Color).  It  is  normally  recommended to  use  it  to  do  a
white  balance  (clicking  Pick Color  in  a  "neutral"  area  of  the  image)  and  then  adjust  the
luminance manipulator to establish the white point. 

Correct:

Gain

[100 (0 / 3200)]

Sets  the  gain  of  the  image.  The  modification  of  these  parameters  increases  or
decreases the white value, scales midtones and fixes the value of black at 0 percent.

Gamma

[1 (1 / 10)]

Sets the gamma value  of the image. Lower value define a darker color, so  the  color
correction lifts the brightness of the image, and vice versa.

Saturation

[100 (0 / 1000)]

Sets the intensity of the color of the image.

Use and Comments

To convert  .cine archives, derived from Phantom cameras, it  is  recommendable  to  use  the
following settings:

In the group WhitePoint, set Red at 75, Green at 100 and Blue at 75.

In the group Correct, set Gamma at 1.7 and Saturation at 150.
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HDRMerge

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Decode->HDRMerge

This decodification effect  is designed to combine 2 exposition levels  of  a  single  image  (via
Track  in  R3DParams),  resulting  in  an  image  with  shadows  and  bright  lights  exposed
precisely.

I/O

Inputs

Double  input:  A  pair of  images  that  will  be  used  to  create  a  new  image  that  will
maintain the desired final exposure, combining the shadows of  one  of  the  inputs  and
the bright  lights of the other. The first  input  should always correspond to Track 1  of
the R3DParams and it  will normally this which has a correct  exposure in the  shadows
(even if  the bright  lights are burnt); the second input  should correspond  to  Track 2,
underexposed in order to preserve detail in the bright lights.

Output

Image: Final image with greater depth of color in bits than either of the two original
exposures;  this  allows  for  a  subsequent  etalonage  in  which  shadows  can  be  lifted
without  introducing  much  noise,  and  preserving  detail  in  the  high  lights.  If  the
parameter  Show->Mask  is  selected,  the  effect  will  show  the  mask  of  the
combination.

Parameters

ExpositionRatio

[3 (0/100)]

This  value  represents  the  ratio  of  the  codified  values  of  the  normal  and  the
underexposed  versions  of  the  same  image.  If  the  values  are  linear,  this  value
corresponds to the ratio of the exposition time; however, for logarithmic  scales, which
are more usual, this value is more similar to the difference between f-stops. 

Clip

[90 (0/100)]

The  values  of  the  first  input  (Track  1,  normal  exposure)  which  are  above  this
percentage  are  considered  "burnt"  and  will  be  replaced  by  pixels  corresponding  to
second input.

Transition

[20 (0/100)]
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For values  below  the  threshold  defined  in  Clip,  a  transition  zone  can  be  defined  to
avoid the banding that may be caused by an abrupt transition. It  is recommendable to
set this value temporarily at 0 (zero) to make the transition visible and then reset  the
value of ExpositionRatio until the separation of the dark and light  zones is less visible.
Once the desired for ExpositionRatio is found, Transition should be set as desired.

Show

[Merge (Mask/Merge)]

The user can choose between showing the combined result  of  the  effect  (Merge)  or
the mask of the combination (Mask). The mask is not  in this case a  simple  grayscale
image, since the combination is done independently for each channel (R,G,B).

Color

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Color

The  Color  menu includes  color correction effects.  Furthermore,  it  contains  the  effects  of
format conversion and parameters settings for depth of color.

Color Grade

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Color->Color Grade

Mistika's  color corrector contains  all  the  features  of  high-end  color  correction  systems  ,
such  as  high  dynamic  range  (HDR)  processing,  support  for  control  surfaces  (Tangent
Devices), integrated functions of Pan&Scan (Rescale) and LUTs  3D applications.  It  can do
all this in realtime hardware processing in 4K, 2K and HD SDI dual link formats, with output
to YUV, RGB 10bit, and even HDR color spaces.

This effect  corrects  color in  a  structure  of  nodes  or layers  (called  Vectors),  basing  each
new step on three simultaneous chain-linked instants.

Thus, different color corrections can exist within the same Color Grade effect, each working
independently  (ie,  adding  to  a  previous  correction,  if  one  exists)  or  in  relation  to  others
(taking as reference, and even recovering, previous corrections).

Within each node or layer, which have the functions as a new step in the final correction of
the image, we find the following corrections ordered in the within the effect:
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The first  correction (Primary) redefines white points,  gamma  value  and  and  black towards
any new RGB value, and controls for color printer lights that modify these parameters.

The second correction (Bands) processes the result  of the first, subdividing the total range
of luminance into five definable  bands,  for each band  to  be  corrected  individually  later;  it
also  has  controls  for  tone,  saturation  and  contrast  (HSL),  and  masters  for  the  three
luminance ranges.

The third correction (Fixed Vectors) corrects the tone, luminance and saturation of the six
principle areas of the color spectrum (red, green,  blue,  cyan,  magenta,  yellow)  separately
via six independent vectors.

Also, at the start of each Vector there is a tab that allows the defining of a color Range by
means of HSL controls and masks, for the corrections to work only on the given selection,
and also to be able to recover previous colors and modify them with the current correction.

I/O_5

Inputs

Input simple: image with or without alpha channel. The alpha channel can be used to
mask the color correction carried out.

Double input: image with or without  alpha channel. The second input  is usually used
to generated a mask to be applied to the first input.

Outputs

Image: color corrected, and optionally, rescaled, image.

Alpha: without  changes, and optionally with the mask generated  by  one  of  the  free
vectors.

Parámetros

Options:
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Channels

Output channels of the selected correction.

Clamp

Option for legalizing luma. By default  this  is  Off;  when On it  can be  used  to  legalize
the whole range of luma (Whites and Blacks) or only the two extremes.

Recover Mode

Activates the recovery mode for the interior or exterior of the mask created, in order
to make available areas of tones, ranges or parts of the image that  have been lost  in
previous vector corrections, or to use them as a second input. When active, the tab
Recover Source will be visible (to  select  the  source  from which the  recovery  will  be
made).

Recover Source

[Base (Source / In2 / Previous / Base / V2-V48)]

Defines the source of the set of colors to be recovered when Recover Mode is active.
Base makes reference to the first  layer of the effect, Source makes reference to the
original input, In2 makes reference to the second input  of the effect, Previous makes
reference  to  the  previous  vector  or  layer  (ie,  the  complete  correction  up  to  that
point), or any previous vector.

Overlay mode

It allows to choose the form of mixing or addition of the current vector with the image
coming  from the  previous  vector.  All  the  forms  of  mixture  are  defined  and  coincide
with those that can be found in the Comp3D effect.

Defocus type

[Gauss, Box, Circle, Median, Grow, Shrink]

Define el tipo de matriz que se aplicará como filtro.

Gauss es un clásico filtro de desenfoque o difuminado suave.

Box es un clásico filtro de desenfoque o difuminado suave, más rápido en cálculo que
Gauss, pero con una matriz cuadrada reconocible con valores de radio altos.

Circle es un filtro de desenfoque que utiliza una  matriz  circular,  más  lento  en tiempo
de procesamiento, pero recomendada para emular desenfoques de cámara.

Median es un clásico filtro de reducción de ruido.

Nota:  algunas  placas  gráficas  no  soportan  el  tipo  de  filtro  median,  por  lo  que  se
recomienda en ese caso utilizar el modo de render SWare.

Grow es un clásico filtro de expansión de las zonas brillantes de los canales de imagen.
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Shrink es  un clásico  filtro  de  encogimiento  de  las  zonas  brillantes  de  los  canales  de
imagen.

Nota: el tipo de matriz definida será visualizada como la primera parte del nombre del
clip de efecto en Node Graph.

Nota:  El  tipo  de  desenfoque  elegido  no  será  visible  sino  se  aumente  el  valor  de
Defocus.

Defocus

[0 (0/ 100.000)]

Permite controlar la cantidad de Defocus type.

Defocus Gamma

[0 (0/ 100.000)]

Gamma value applicable to the blur via the tab Select to produce a Glow effect.

Defocus Blend

[0 (0/ -100.000)]

Cantidad  de  enfoque  o  desenfoque  del  efecto.  Los  valores  negativos  se  entienden
como enfoque (sharpen) y los positivos como desenfoque (blur).

Layer Blend

[0 (0/ 100.000)]

Valor  de  la  transparencia  del  vector  actual,  siendo  100  el  opáco  del  vector  y  0
transparencia completa.

Keyer:

This tab defines the values that  restrict  the color selection that  is  made  to  be  used  as  a
vector mask or to  retrieve  colors  from both previous  vectors,  as  well  as  from the  source
image or from a second entry.

In Keyer we find three types of Keyer: Keyer HSL |  RGB Keyer |  3D Keyer that  we can use
alone  or  together,  each  one  with  its  unique  parameters,  but  there  are  also  parameters
common to all three.

The first group of parameters common to the three types of Keyer arranged at  the left  end
of the Keyer tab, allows to define calculation values prior to the selection of values of luma
and chroma of the image.
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The  intermediate  space  of  the  Keyer is  where  the  tools  of  the  three  types  of  Keyer  are
available.

The  different  keyers  have  common  parameters  that  remain  visible  even  if  we  navigate
between the three tabs.

 

   

Invert

Inverts the selection we have made or if  we activate it  before making our selection it
will invert the functions of the ADD and REMOVE buttons

Proportional

Activating the Proportional button will take  into  account  the  saturation value  of  the
selected pixel, thus allowing a more smoothed correction of the value.

Add

Add values to the key.

Add Soft

Add softness to the key selection.

Remove
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Remove values from the key.

Note: to display the selection we must activate the Highlight button

Highlight Selection

Activates a temporary viewing mode, highlighting the range of color according to  the
mode we have selected in Grade Setup: saturated colors, in white and  black or over
black.  This  button is  very  useful for distinguishing  in  the  processed  image  the  total
effect  of  the  range  included  in  the  correction  of  the  active  vector  (this  function
highlights only the vector being edited).

Pre-Key Options:

The first  group of parameters, that  are common to the three types of Keyers, arranged at
the  left  end  of  the  Keyer  tab,  allows  defining  calculation values  prior to  the  selection  of
luma and chroma values of the image.

Pre-Key Options

These parameters define the origins of the selector/ colour keyer and  determine  the  mode
and origin of the recovery tool to recover any colour. 

Key Source

[Base (Source / In2-In5 / Previous / Base / V2-V48)]

Selects the source for the color selection to be  used  for defining  the  mask that  the
various parameters and corrections of a given vector will affect. Base makes reference
to  the  first  layer  of  the  effect,  Source  makes  reference  to  the  original  input,  In2
makes reference to the second input  of the effect,  Previous  makes  reference  to  the
previous vector or layer (ie, the complete correction up to that point), or any previous
vector, or one of the other four inputs available to the color corrector.

Key Channels

[All (All / Red / Green / Blue/ Alpha)]

Defines the channels that will be used to make the color selection.
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Pre-Key Blur

These parameters also serve to define a blur of the image prior to the selection of the key,
eliminating noise from the image and allowing a cleaner selection of the values.

Type

[GAUSS|BOX|CIRCLE|MEDIAN|GROW|SHRINK]

Allows selecting different types of blur.

RAD X

Defines the amount of blur that will be applied to the X-axis of the image.

RAD Y

Defines the amount of blur that will be applied to the Y-axis of the image.

NOTE:  Both  parameters  RAD  X  and  RAD  Y  can  be  used  either  separately,  given
different  values  or simultaneously,  by  activating  the  padlock  button  places  next  to
both parameters.

HSL Keyer:

The  HSL  Keyer  (HUE/SATURATION/LUMA)  allows  making  colour  selections,  modifying  the
three values separately.
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Reset

[Reset Hue / Reset Sat / Reset Lum /Reset HSL]

It resets hue, saturation and luma qualifiers to the default  values: separately by using
the different resets or simultaneously using the “Reset All” function.

Solo 

[Solo Hue / Solo Sat / Solo Lum / Solo HSL]

Activating the “solo” button will allow visualizing the chosen parameter selection; The
rest  will be muted. When using more than one  keyer,  Solo  HSL  will  activate  only  the
effect of the HSL Keyer selection, ignoring the RGB and 3D Keyer selection. 
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Lock

[Lock Hue / Lock Sat / Lock Lum]

It blocks the parameter, preventing its modification

Wheel Qualifier

Four pointers are drawn on the qualifier in the form of a color wheel; the pointers are
manipulated  directly  on the  color wheel,  in  order to  define  the  range  of  hue  to  be
transformed by the color correction indicated in the same subfolder. 

Initially only two pointers are seen; they turn together when clicked and dragged with
the main mouse button. These two pointers represent  the hue values included in  the
tolerance of the  corrector (Select  H Toler),  forming  a  cone  that  is  centered  on the
source hue value (Select  H Source).  Together both pointers  therefore  represent  the
combination of two parameters that must be visualized together. When clicking on the
cone  with  the  main  button   button,  it  can  be  turned  towards  other  values.  When
clicking on the cone with <Ctrl> simultaneously held down (or with the third button),
the angle of the cone increases. 

Two other pointers outside the central cone represent  a decreasing tolerance,  which
is  asymmetric,  as  these  two  pointers  are  manipulated  separately.  In  order  to  turn
either of  the  two  pointers,  click in  the  margin  of  the  desired  central cone  with  the
main button and <Alt> at the same time (or with the secondary button), dragging the
pointer  to the desired position. 

Similarly,  it  is  possible  to  isolate  from these  selected  hue  values  a  saturation  and
luminosity range for these colors, with another two qualifiers:

Saturation Qualifier

This  qualifier is  a  slider  with  the  function  of  specifying  the  saturation  range  to  be
transformed by the color correction indicated in the same subfolder. To its left there is
a reset button and an invert button, to invert the selected saturation range. 

Luminance Qualifier

This  qualifier  is  a  slider  with  the  function  of  specifying  luminance  range  to  be
transformed by the color correction indicated in the same subfolder. To its left there is
a reset button and an invert button, to invert the selected luminance range.

RGB Keyer:

It allows making a colour selection based on the information of each of the R G B channels.



417FX

SGO Mistika 8.6 © 2018 SGO

Reset

[Reset R / Reset G / Reset B /Reset RGB]

It  returns  the  R,  G and  B channel values  to  default  ones.  This  can  be  done  either
separately, using different resets or simultaneously, using the “Reset All” function.

Solo 

[Solo R / Solo G / Solo B / Solo RGB]

Activating the “solo” button will allow visualizing the chosen parameter selection; The
rest  will be muted. When using more than one keyer,  Solo  RGB will  activate  only  the
effect of the HSL Keyer selection, ignoring the RGB and 3D Keyer selection.

Lock

[Lock R / Lock G / Lock B]

Blocks the parameter, preventing its modification.

Channel Qualifier

[Channel R / Channel G / Channel B]
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The function of this  slider-shaped  qualifier is  defining  the  channel range  that  will  be
transformed by the previously determined colour correction in the same subfolder. The
reset, solo and lock button can be found on its left side.

3D Keyer:

3D Keyer shows a 3D representation of the colour area.

Solo 3D

When using more than one keyer, Solo 3D will activate only the effect of the 3D Keyer
selection, preventing the selections of the HSL and RGB Keyer

Strokes

It  shows  built  selections  and  allows  to  generate  the  smooth  in  them,  muting  or
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eliminating them from the total selection. To smooth a selection, we must  press the S
button and by dragging right or left, we can smoothen (right) or return it  to the initial
status of the selection (left). The smoothing effect can be seen either in a total result
(when Highlight  command is  activated)  or in  the  3D representation of  the  selection.
Each selection can be unique by clicking on the colour to  be  selected  and  using  the
Add tool or it  can contain various colour values if  we  drag  the  Add  tool when taking
the colour reference.  

Colour Cube

It shows the created selections in a 3D space. 

The second group of the parameters that  are common to the three types of the Keyer  are
placed at  the right  end of the Keyer  tab. This  group  contains  tools  to  work on the  Keyer
selection and export tools of a key.   

                 

Tweak
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Key Blur

[0 (0/ 100.000)]

This last  parameter is  a  post-process  that  is  applied  to  the  generated  mask by  the
qualifiers, softening the selection by means of a spatial filter that  blurs the restriction
generated,  hiding  the  generation  of  possible  noise  that  may  be  highlighted  by  the
applied correction. It  is recommended to use  this  parameter in  all  cases,  but  always
after defining the best  mask possible  with  the  tolerance  and  softness  parameters  of
the qualifiers.

The  second  group  of  manipulators  described  are  those  which  define  the  correction
applied  within  the  range  of  colors  defined  by  the  qualifiers,  or  by  Windows  as
described below. 

Filter 

[Shrink / Grow / Fill holes / Move Sparks / Median]

Defines a spatial blur of  the  area  defined  by  the  previous  parameters,  softening  the
mask generated  by  the  qualifiers,  and  thus  avoiding  the  appearance  of  noise  when
applying the correction.

Filter Rad

[0 (0/ 100.000)]

Valor en el que afectará el filter al key.

Profile

Key-Key Curve

Internal curve that represents the curve of contrast of the selection mask.

Key Tolerance

[0 (0/ 100.000)]

Defines the opacity of the mask: 0 (zero) defines a totally  opaque  mask;  and  100 is
transparent.

Key Softness

[100 (0/ 100.000)]

Controls the range of  soft  transparencies  from total transparency  defined  parameter
tolerance to total opacity. Low values define less range of intermediate transparency.

Output

These  folder contains  values  and  parameters  to  combine  and  restrict  the  key  more  than
what has already been defined. 
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Enable Ext Key

Activates the option of using an external key as a Key for the current Vector.

Ext Key Source

[Base (Source / In2-In5 / Previous / Base / V2-V48)]

Selects the source for the color selection to be  used  for defining  the  mask that  the
various parameters and corrections of a given vector will affect. Base makes reference
to  the  first  layer  of  the  effect,  Source  makes  reference  to  the  original  input,  In2
makes reference to the second input  of the effect,  Previous  makes  reference  to  the
previous vector or layer (ie, the complete correction up to that point), or any previous
vector, or one of the other four inputs available to the color corrector.

Ext Key Channel

[Alpha (Red / Green / Blue / Alpha)]

Defines  the  selected  source  channel,  with  which to  operate  for  combining  with  the
selection of the current vector. 

Ext Key Mode

[None (None / And / Inv And / Or / Inv Or )]

Operation mode for the selected source channel with the current  selection or mask of
the vector. If None is selected, none of the previous parameters are activated.

Other operations are defined in Ref. Mistika: Node Graph Editor->Dashboard->Fx-
>Mistika->Boolean->Channels.

Outside Mode

Defines  the  inversion mode  for the  mode  Outside  of  Color  Grade.  According  to  the
selection made, the 'inverse' of the mask will vary, following different parameters.

Export Key

Applies the selection of the qualifiers as mask in the output  of the effect  in the alpha
channel. This generated mask may be edited with the manipulators of Mask Toler  and
Mask Soft, in a similar way to that of Pick Key for Greenscreen elements and so on.

Window:

Folder that  contains the values of the windows used to restrict  the correction or selection
to a specific part of the image.
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Window CenterX; Y

[0; 0 (-100.000 / 100.000)]

Defines the offset from the center of the window that restricts the correction.

Window Angle

[0 (-100.000 / 100.000)]

Defines the angle of the window that restricts the correction.

Window Width

[100 (0 / 100.000)]

Defines the width of the window that restricts the correction. 

Window Height

[100 (0 / 100.000)]

Defines the height of the window that restricts the correction.

Window Soft

[0 (0 / 100.000)]

Defines  a  range  of  transparencies  for  the  edges  of  the  window  that  restricts  the
correction.

Window Type

[None (9 modes)]

Defines the type of window that restricts the correction.

None: Defines that there is no window of restriction.

Line: Defines  a  window  that  divides  the  screen with  a  straight  line  like  a  wipe.  The
correction is restricted to one half of the screen.

InvLine: Works like the mode Line, but with the area of restriction inverted.

Ellipse: Defines an ellipse-shaped window inside which the correction is restricted.
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InvEllipse: Works like the mode Ellipse, but with the area of restriction inverted.

Shape: Activates the window as a vectorial shape previously defined in the tab Shape.

InvShape:  Works like the mode Shape, but with the area of restriction inverted.

Rectangle: Defines a rectangular window inside which the correction is restricted.

InvRectangle:  Works  like  the  mode  Rectangle,  but  with  the  area  of  restriction
inverted.

Offset X Left; Right

 [0; 0 (-100.000 / 100.000)]

Offset  values added between the position of the window in the left  and  right  images
when working in stereo.

Line

Restricts  the  correction  by  dividing  the  screen  with  a  line,  specifying  half  as  an
excluded  area.  This  line  can  be  manipulated  interactively,  through  the  visual
manipulator.

To move it, hold down the main  button;  to  rotate  it,  hold  down <Alt>  at  the  same
time. 

The line has a cross at  the  center that  indicates  the  rotation pivot  point.  It  is  also
possible to manipulate a gradient (softness) that extends from the edge of the defined
window, by clicking the main button and holding down <Shift>. The limit of softness is
viewed as a second line.

Ellipse

Restricts the correction to within  an ellipse,  which can be  manipulated  interactively,
through the visual manipulator.
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To move it, hold down the main  button;  to  rotate  it,  hold  down <Alt>  at  the  same
time. To scale the ellipse, hold down <Crtl> at the same time.

The ellipse contains a guideline with a cross at  the center that  indicates the rotation
pivot  point. It  is also possible to manipulate  a  gradient  (softness)  that  extends  from
the  edge  of  the  defined  window,  by  clicking  the  main  button  and  holding  down
<Shift>. The limit of softness is viewed as a second line.

Rectangle

Restricts the correction to within a rectangle, which can be manipulated interactively,
through the visual manipulator.

To move it, hold down the main  button;  to  rotate  it,  hold  down <Alt>  at  the  same
time. To scale the rectangle, hold down <Crtl> at the same time.

The  rectangle  contains  a  guideline  with  a  cross  at  the  center  that  indicates  the
rotation  pivot  point.  It  is  also  possible  to  manipulate  a  gradient  (softness)  that
extends from the edge of the defined window, by clicking the main button and holding
down <Shift>. The softness limit is viewed as a second line.

Shape

Restricts the vector correction to  within  the  area  defined  by  the  shapes  associated
with the free vector.
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Shapes are created, modified, combined, and animated  from the  Shapes  manipulation
mode.  In  this  manipulation mode,  the  assignation  of  the  shapes  created  to  the  six
different  vectors  is  defined.  In  Shapes  mode,  all  created  shapes  are  seen together,
and when one shape is selected, its association is seen from the Vector attribute. 

If the Shape window mode  is  selected  from one  of  the  color corrector manipulators,
the  Visual  Editor  only  shows  the  shapes  assigned  to  the  selected  vector,  hiding
shapes unassigned to the free vector being viewed, to help with editing.

Ellipse/Rectangle and Shapes contained by an effect can be animated and/or tracked. 

Remember that  both windows (Ellipse/Rectangle)  and  Shapes  contained  by  an effect
can be animated and/or tracked. 

Invert Window

A mode for inverting the modes of previous windows can be added to one of the four
previous restriction modes. 

The following example shows an ellipse with Invert Window activated: 
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Remember that the qualifiers can be combined with window to correct  colors identified
by their values within specified areas. 

Grade Inside_2:

The  Grade  Inside  folder  contains  the  values  for  modifying  the  effect  Color  Grade  for  an
image defined by the selector or for the whole image if All Hues is selected.

Primary:

Folder that  contains parameters for the  primary  correction,  which can be  used  for making
initial adjustments of black and white points, and also for a primary correction similar to that
of a telecine.

WhitePt R; G; B

[100; 100; 100 (0 / 200 )]

Defines  the  RGB  value  that  will  be  corrected  to  white.  Lower  values  define  darker
colors  as  white,  so  the  color correction lifts  brightness  in  the  image  if  this  value  is
decreased, and viceversa.
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Gamma R; G; B

[50; 50; 50 (-50 / 150 )]

This parameter is a gamma value expressed in non-conventional units. 

BlackPt R; G; B

[0; 0; 0 (-100 / 100 )] 

Defines  the  RGB  value  that  will  be  corrected  to  black.  Higher  values  define  lighter
colors as black, so the color correction darkens  the  image  if  this  value  is  increased,
and viceversa.

Soft Clip / Superwhites R; G; B

[50; 50; 50 (-50 / 150 )]

It  allows  saving  the  white  values  that  go  beyond  the  visual  range,  allowing  the
normalization of the image both SDR and HDR environments.

NOTE: Soft clip corresponds to an SDR mode and Superwhites to an HDR Mode.

Pivot

[Pivot Black / Pivot White / Pivot Softclip and Superwhites]

A value that controls the action range of the trackballs.

Kneesoft

It generates smoothing of the range affected by the trackball White, allowing more or
less marked transition of Whites to Superwhites.

NOTE: Kneesoft will only appear active when working in Color Grade HDR Mode.

Rolloff

It generates a smoothing of the range affected by trackball Softclip or Superwhites.

This first correction uses classical correction operations for controlling the black point,
the gamma value (standard gamma parameter) and the white point (multiplying all the
pixels by a constant value, also called Gain or Brightness).

On the left there is the Printer Lights panel, which allows us to modify each parameter
individually, according to the values of printer light  in the logarithmic  color space,  as
well as other controls that  do not  pertain  to  these  parameters  but  are  located  here
for ease of use. The relationship between the values of Mistika and the printer lights
can be defined in the Setup panel  of Color Grade.

In this panel, there are modification command buttons for simplifying the setting of the
different primary and secondary tones (R+,R-,G+,G-, etc); also there are modifiers for
Gain and contrast  (All+,All-). The command buttons  add  or subtract  a  specific  value
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(defined  in  Printer  Lights  Steps);  the  relative  knobs  of  Level  and  Cont  allow  the
modification of gain and contrast  of each color, as well as two general relative knobs
(with  white  letters)  which  affect  the  three  channels,  thus  simplifying  the  most
common operations. 

The Level-type controls (gain) add or subtract the same value for the Black Point  and
the White Point, while the Cont  (contrast) controls manipulate both points in opposite
directions, to increase o reduce contrast.

The buttons 1, 1/2 and  1/4  indicate  at  what  magnitude  the  value  defined  in  Printer
Lights  Step  will  be  used  to  modify  the  gain  or  contrast  of  any  of  the  previously
indicated  parameters  (at  the  whole  value,  half  or a  quarter).  B+W+,  B+,  W+.  B-W+
allow the selection of the range over which the command buttons will operate:

B+W+

Values  of  printer lights  in  the  logarithmic  color  space  for  the  total  gain  (black  and
white points).

B+

Values of brightness in Mistika parameters affecting the black point.

W+

Values of printer lights in the linear color space affecting the white point.

B-W+

Values of contrast in Mistika parameters affecting black and white points.

Below the Printer Lights panel there are two pick buttons which are used for selecting
a value in the image of the Canvas and redefining the black/white point.

Bands:

Folder that contains parameters for advanced correction, which divides the total luminance
range into 5 definable bands, so that each band can be corrected individually, and provides
three additional HSC controls.

After the first  settings correction, the luminance range is divided into five bands, definable
by the user (the term "band" interpreted as a fraction of the luminance range). 

Each  band  has  a  trackball  (Black,  Shadows,  Midtones,Highlights  and  White).Additionally,
there are four sets of HSC (hue, saturation and contrast) controls. 

The  first  affects  the  whole  range,  the  second,  dark  colors,  the  third,  midtones  and  the
fourth, light colors.
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HSC/Hue

[0 (-100.000 / 100.000)]

Redefines the initial value of hue. The units of hue are expressed in degrees, referring
to the angle of a chromatic circle.

HSC/Sat

[100 (-100.000 / 100.000)]

Redefines initial saturation.

HSC/Cont

[100 (-100.000 / 100.000)]

Redefines initial contrast.

White/ R; G; B

[0 (-100.000 / 100.000)]

Corrects color affecting only colors defined as white tonal range.

Highlights/ R; G; B

[0 (-100.000 / 100.000)]

Corrects color affecting only colors defined as tonal range of highlights.

Highlights/HSC

[0 (-100.000 / 100.000)]

Corrects hue, saturation and contrast  affecting only colors defined as  tonal range  of
highlights.

Midtones/ R; G; B

[0 (-100.000 / 100.000)]

Corrects color affecting only colors defined as mid-tonal range.
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Midtones/ HSC

[0 (-100.000 / 100.000)]

Corrects  hue,  saturation  and  contrast  affecting  only  colors  defined  as  mid-tonal
range.

Shadows/ R; G; B

[0 (-100.000 / 100.000)]

Corrects color affecting only colors defined as tonal range of shadows.

Black/ R; G; B

[0 (-100.000 / 100.000)]

Corrects color affecting only colors defined as black tonal range.

Black/HSC

[0 (-100.000 / 100.000)]

Corrects  hue,  saturation  and  contrast  affecting  only  colors  defined  as  black  tonal
range.

Ranges/Lo/Lo_Limit

[0 (0 / 100 )]

Defines  a  percentage  value  of  brightness  which is  considered  the  end  of  the  black
tonal range.

Ranges/Lo/Lo_Slope

[250 (0 / 100.000)]

Defines a slope value for the tangent of the curve of separation for the bands in their
lower zone,  which,  together with  the  parameters  of  the  folder  Hi  defines  the  three
central bands. 

Ranges/Hi/Hi_Limit

[100 (0 / 100 )]

Defines  a  percentage  value  of  brightness  which is  considered  the  end  of  the  white
tonal range.

Ranges/Hi/Hi_Slope

[250 (0 / 100.000 )]

Defines a slope value for the tangent of the curve of separation for the bands in their
higher zone, which, together with  the  parameters  of  the  folder Lo  defines  the  three
central bands. 
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Range:

The five bands are defined through this subpanel. 

The subpanel is an image that has two control points with tangents.

The horizontal axis defines the input  value (black to white, from left  to right) already
transformed by the primary correction.

In order to  modify  the  control points,  press  and  drag  them towards  their edges.  To
modify the tangent of these points, press the edge of the tangent. 

The control point in the upper left (Lo) draws a curve that  joins the lower right  edge.
The control point of the upper right (Hi) joins a curve with the lower left  edge. A third
curve without control points is drawn joining the lower edges. 

These curves and their intersections define the five bands to be corrected by the five
trackballs. 

The first band is defined from the left  control point  towards the left: this is corrected
by the Black trackball. 

The second band is defined between the left control point and the first  intersection of
curves: this is corrected by the Shadows trackball. 

The third band is defined between first  and the second intersection of curves: this is
corrected by the Midtones trackball. 

The  fourth  band  is  defined  between  the  second  intersection  and  the  right  control
point: this is corrected by the Highlights trackball. 

The  fifth  band  is  defined  from  the  right  control  point  towards  the  right:  this  is
corrected by the White trackball.

Fixed Vectors:

Folder that  contains parameters for a secondary correction (correction by predefined  color
vectors), of the primary and secondary colors: red, green, blue, cyan, magenta and yellow. 
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 Red R; G; B

[100; 0; 0 (-100.000 / 100.000)]

Defines RGB gain for colors reds.

Green R; G; B

[0; 100; 0 (-100.000 / 100.000)]

Defines RGB gain for greens.

Blue R; G; B

[0; 0; 100 (-100.000 / 100.000)]

Defines RGB gain for blues.

Cyan R; G; B

[100; 0; 0 (-100.000 / 100.000)]

Defines RGB gain for colors close to cyan.

Magenta R; G; B

[100; 0; 100 (-100.000 / 100.000)]

Defines RGB gain for colors close to magenta.

Yellow R; G; B

[100; 100; 0 (-100.000 / 100.000)]

Defines RGB gain for yellows.

Curves:

The parameters related to the Curves panel are internal Mistika parameters,  although they
can be used to reset the different curves from here.
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R-R

Reed channel curve.

G-G

Green channel curve 

B-B

Blue channel curve  

L-L

Luma curve

S-S

Saturation curve

L-S

Saturation curve proportional to luma

H-H

Tones curve

H-S

Saturation curve relative to tones

H-L

Luma curve relative to tones 

Lo / Hi

Buttons for modifying zoom in the lower (Lo) or upper (Hi) part  of the curve, allowing
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greater, more detailed control over the points in this area.

Cx / Cy

Buttons that block horizontal (Cx) or vertical (Cy) offset of the points being modified.

Sm / Sh / CT / IT

Options  that  control  the  transition  of  the  points  of  the  curve,  and  also  of  their
tangents.

Pc0 / Pc1 / Pc3

These three functions have effect when a hue has been selected via Select, adjusting
the curves to the selected hue. 

Pc0: adjusts without adding control points in the curves.

Pc1: adds a control point in the selected hue.

Pc3:  adds  a  control point  in  the  selected  hue  as  well  as  one  either  side  (in  the
curves with Hue the distance between the points is16,66%, in others it is 20%).

Add Pts / Rst Sel /Rst All

Options that, respectively, add points by default  on the curves, return to the original
curve of the selected curve or return to the original curves  of all the curves.

Gang RGB

Switches  between  the  joint  modification  of  the  three  RGB  curves  and  if  they  are
deactivated, to one curve at a time.

RGB Tab 

Curves  that  correspond  to  each  of  the  three  primary  colors,  representing  their
complete range, from the lowest  value, 0 (lower left  corner) to their maximum value,
100 (upper right corner).

L-L S-S L-S Tab 

Curves that correspond to the luma of the image (L-L), saturation (S-S) and Luma vs.
Saturación (L-S). These curves allow corresponding modification of the values of luma
based on the values of luma in  the  image  (represented  on the  curve);  similarly  they
modify  the  saturation  based  on  the  saturation  value  of  each  pixel  or  modify  the
saturation based on the levels of luma.

Hue-Hue Tab 

Curve that  modifies  the  tones  of  the  image  according  to  the  tonal selection on the
curve.

Hue-Sat Tab 

Curve that  modifies  the  saturation of  the  image  according  to  the  tonal selection on
the curve.



435FX

SGO Mistika 8.6 © 2018 SGO

Hue-Luma Tab 

Curve  that  modifies  the  luma  of  the  image  according  to  the  tonal  selection  on  the
curve.

Partial Mutes:

This contains the different mutes for disabling the correction of that part of the corrector in
the image.

Mute Primary

[Off (Off / On)]

Activates/deactivates  the  of  the  subtab  of  Primary  of  the  selected  vector  in  the
image.

Mute Bands

[Off (Off / On)]

Activates/deactivates the of the subtab of Bands of the selected vector in the image

Mute Fixed

[Off (Off / On)]

Activates/deactivates the of the subtab of Fixed of the selected vector in the image

Mute Curves

[Off (Off / On)]

Activates/deactivates the of the subtab of Curves of the selected vector in the image

Setup:

The last subpanel Setup has options that affect the behaviour of the interface. 

Ball Sensitivity, Ring Sensitivity, Knob Sensitivity, Jog Sensitivity
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These define a scale in the drag sensitivity for the movement  of the balls and of their
outer  rings.  The  minimum  value  (1)  specifies  that  the  relation  between  drag  and
modification  of  the  parameter  is  1:1,  whereas  higher  values,  for  example  be  1:8,
specify that the manipulator is less sensitive to the actual movement. 

Draw Over

Activates  the  drawing  of  the  manipulators  in  the  Windows,  which can be  hidden  by
deactivating this mode.

CP Panels Reset

Button for resetting Tangent Devices in cases of incorrect or suspended functioning.

Highlight Mode

Defines  the  viewing  mode  of  the  Highlight  tool  of  the  Color  Grade  subpanel  Select.
These options can be used to choose if  viewing the color selection is done over black
(On Black), contrasted in white and black (Display Key) or by saturation (Hi Saturate).

Printer Lights Step

Editable field that indicates the relationship between the values Printer Lights and the
primary  color  parameters  of  Mistika.  This  value  should  never  be  modified  (default
value: 1.217).

The  Grade  Outside  folder contains  the  values  for modifying  the  effect  Color Grade  for an
image  defined  by  the  inversion  of  our  selection,  set  in  active  mode  in  Color  Grade-
>Select->Key->Key Inv Mode.  The  folders and values are the same  as  those  found  in
Grade Inside.

Manipulators_3:

This manipulator panel is especially designed for RGB color correction effects, and simulates
the  operation  of  traditional  telecine  systems.  This  panel  is  activated  when  selecting  an
Color Grade effect.

The  panels  have  manipulators  of  the  following  type:  Knob,  Qualifier  (Wheel  &  Slider)  and
Trackball.

Knob

A relative knob is a kind of button which is depressed and moved right to increase and
left to decrease the value it controls.
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Absolute  Knob  also  shows  an  absolute  value  over  the  parameter  that  is  being
manipulated,  and  has  a  small  reset  button below.  The  background  color  indicates  a
negative  (red)  or positive  (green)  value.  The  value  can  also  be  edited,  dragging  it
vertically.

The  knobs  present  in  the  corrector  can  control  tone,  saturation,  contrast,  and
brightness, color suppression, mask filter, level. 

Command Button

This button runs a specific command when clicked, but without the option of adjusting
the magnitude of the indicated effect.

Wheel Qualifier

This  qualifier allows  selection of  a  range  of  Hue  by  means  of  four  manipulators  like
clock hands, which define a portion of a color wheel. 

With the primary button, the central value of Hue  is  defined,  turning  the  pointers  to
the value of hue desired (corresponding to the Select H source parameter).

Holding down <Ctrl> at the same time defines a symmetrical inclusion tolerance in the
value,  which  translates  in  the  manipulator  as  an  increasing  angle  centered  at  the
previous  pointer.  It  is  also  possible  to  manipulate  this  directly  with  the  secondary
mouse or tablet button (corresponding to the Select H tolerance parameter). 

Holding down <Alt> at  the  same  time  defines  an asymmetric  decreasing  tolerance  (
soft) which appears as two new pointers beside the previous symmetrical tolerance. It
is  also  possible  to  manipulate  this  directly  with  the  third  mouse  or  tablet  button
(corresponding to the Select H Soft- and Select H Soft+ parameters).

Slider Qualifier

This  qualifier  allows  the  additional  isolation  of  the  color  range  to  be  corrected,
according to its saturation or luminance value. Two sliders exist  in this corrector, the
upper one defines saturation values, and the lower one luminance. 

The main button defines the total range to be included, by pressing the  sides  of  the
slider and moving  it  laterally  (corresponding  to  the  type  of  parameter Select  S toler
and Select L toler).

Pressing  <Alt>  at  the  same  time  defines  a  decreasing  range  of  tolerance  (soft)
towards  the  interior  of  the  selection.  This  range  is  shown  as  slope  within  the
manipulator.  It  is  also  possible  to  defines  this  directly  with  the  secondary  mouse  or
tablet button (corresponding to  parameter Select S soft and Select L soft).

Note: Each slider has two sides. The right represents the higher limit, and the left  the
lower limit. Each limit can defines its soft value independently.

Trackball

Trackballs are more complex manipulators which control sets of RGB parameters.

Each trackball has common characteristics. 

Ball 



438 FX

SGO Mistika 8.6 © 2018 SGO

The central ball specifies a correction vector that  indicates  the  saturation level with
its radius, and the selected hue with its angle. The ball is manipulated by pressing and
dragging it with the left mouse button. 

Ring

The  peripheral rings  act  on the  luminance  of  the  affected  range,  and  are  used  for
specifying the luminance level of the effected zone. 

Each ring is manipulated by pressing and rotating it  round the ball while holding down
<Alt>,  or  directly  with  the  secondary  mouse  or  tablet  button.  Rotating  clockwise
increases luminance, while anticlockwise reduces it.

Color Reference

Color  Reference  enables  viewing  of  the  correction  defined  in  the  ball  for  mid-gray
tones. 

RR

Resets the trackball ring to its default  position. When a color correction is  animated,
this button will add a keyframe with the default value to the parameters corresponding
to the restarted ring. 

RB

Resets the trackball to its default  position. When a color correction is  animated,  this
button will add a keyframe with the default  value to the parameters corresponding to
the restarted ball. 

Use and comments_3:

The Color Grade color corrector includes virtually all the functionality of all color correction
effects of the system, and can also carry out  other functions  related  to  the  processes  of
effects, generating masks or treating images.

Although it  has  many  parameters,  the  corrector is  easy  to  use,  thanks  to  the  number of
dedicated manipulators. 

When the appropriate hardware is available, this effect  carries out  color corrections in real
time in HD RGB 4:4:4, 2K and 4K formats without compression.

The Primary correction is recommended for the  first  adjustment  of  values,  in  which white
point, black point, a gamma value and a contrast value are defined.

The behavior of Primary is very similar to that of the primary color correction of telecine. It
is advisable to work generally with its special manipulator, the Trackballs. This is also useful
in  white  balancing,  by  selecting  the  white  point  with  the  Pick  White  function,  and  then
returning to Trackballs  to  make  a  Reset  Ring  of  the  White  ball.  This  way,  the  hue  of  the
white color is compensated, without altering its value.
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As well as applying  a general correction of hue and saturation, it  is recommendable to use
the correction Bands for a fine adjustment of luminance and color.

The  main  advantage  of  Bands  correction is  to  be  able  to  correct  high  and  low  lighting  (
highlights  &  shadows),  maintaining  black  and  white  values  intact.  This  makes  tasks  of
colormetric  balancing  between different  sequences  easier,  and  also  helps  to  enhance  the
brightness of any intermediate luminance value, thanks to the fact  that  this correction also
allows the modification of the ranges that specify the bands.

The example below shows the original image and one corrected by bands. Neither Black nor
White values  have  been modified,  whereas  the  Shadow,  Midtones  & Highlight  values  have
been tinted pink, orange and green respectively. This correction would not be possible using
only the primary correction.

Additionally,  the  function of  secondary  correction has  been  added  to  the  same  group  of
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processes, through correction of fixed vectors. 

The  fixed  vectors  are  modified  through  six  groups  of  three  HSB  sliders  dedicated  to  the
primary colors and their complements: red, green, blue, cyan, magenta and yellow. 

The first subpanel Select has a range of tools. Any color range can be selected, qualified for
hue, saturation and contrast (HSL Qualifiers). 

In addition, it is possible to create trackable basic geometric Windows such as lines, ellipses
and rectangles with the same  corrector,  and  also  to  use  vectorial  forms  generated  within
the  effect,  via  the  Shapes  manipulation mode,  in  which  forms  can  be  created  which  are
assignable to each of the vectors independently. 

A typical use of the Qualifiers and the Mask Filter is the simulation of filters. For example, it
is possible to restrict the high values of luminance via the Luminance Qualifier  and increase
the values of shadows in the result. Via the parameter Mask Filter  the restriction generated
can be softened, thus obtaining a simulation of the Promist filter.

It also has parameters capable of applying Sharpening and Blur filters, with different  modes
and variables, making possible such as Glow. 

Another of the important characteristics is the option to recover range of colors lost  either
through an extreme stylistic correction or simply because another input  or previous stage is
required. With  this  goal,  the  combination of  channels  with  previous  Inputs  and  Vectors  is
huge, as well as being able to define what and how much is recovered.

Even  more  importantly  is  the  fact  that  once  the  selection  has  been  carried  out  with
whichever image effect is chosen, or the recovery of ranges or a final mask final defined by
the  combination  of  qualifiers,  windows  and  channels,  both  internal  and  external  can  be
treated (by defining what  is external) as a  complete  correction,  using  Primary,  Bands  and
Fixed Vectors.

Example of a color correction_3:

The first  step is to carry out, in Primary, a first  adjustment  of  black and  white  points,  as
well as slightly modifying gamma, ignoring the tab Select, as  no  specific  selection is  to  be
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made and, by default this is fixed, in order to be able to work on the whole of the image.

The  Bands  tab  provides  greater  control  over  the  spectrum  of  color  and  luma  of  each
luminance range of the image.

Next  it  is possible to  exaggerate  the  coldness  of  the  image  and  neutralize  even more  the
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spectrum of the original image, by means of the Fixed Vectors; thus it is possible to work on
an image based in neutral tones.

Next, a mask is applied to the person with a new vector (Vector 2), which acts  as  a  new
layer,  highlighting  the  person to  be  able  to  recover  the  original  tones,  or  work  with  the
inherited  image.  The  qualifiers  of  saturation,  luminance  and  the  Wheel Qualifier  are  used;
also, a small amount of blur is added to the mask (Mask Filter).
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Recover Mode is activated, with the original image as Source, working on the mask that  has
been created, restricting it with a Line window to be able to achieve a horizontal degrading
of  the  recovery  of  tones  and  reducing  the  opacity  (Tolerance)  of  the  recovery.  A  small
amount of the Blur filter is also applied to the recovered color to further eliminate noise.

Next, Bands is used  both for the interior and exterior (Outside) of the mask, to achieve  a
different stylistic effect.
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Another mask is then created using a third vector, without degrading, in order to have more
control over the relative appearance of the person with respect  to  the  previous  horizontal
degrading. Blur is again applied, this time in Over mode, to add the effect  of an aura (Glow)
to the person.

Finally,  another vector is  used  to  fine-tune  luma  (Y),  and  to  legalize  the  whole  range  (
Legalize>On).
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Clearly, the options  have  a  wide  range  of  possible  uses,  and  the  combination of  different
tools and modes of the Select  panel for combining vectors or secondary inputs, as  well  as
being  able  to  carry  out  operations  in  isolated  channels,  means  that  the  possibilities  are
almost limitless.

B/W

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Color->B/W

This is simply the  RGBCorrect effect of the color correction, with a saturation value 0
assigned to its input.

Negative

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Color->Negative

This  is  simply  the  color correction  RGBCorrect  effect,  with  default  values  that  invert  its
input colors.

Unicolor

This  effect  allows  for  the  conversion  of  images  between  common,  standardised  colour
spaces.

I/O

Input:

Single input: image with optional alpha channel.

Output:

Image: colour converted image.

Alpha: without changes.

Input

Input Curve

[Linear Light, Rec709/Rec2020, sRGB, P3DCI, Cineon, SMPTE 2084 PQ, ACES CG,
ACES CC,  ACES Proxy,  Arri  LogC  V3,  Canon Log2,  RED Log Film,   Sony  Slog3,
Sony Slog2, Gamma 2.2, Gamma 2.4]

Select the gamma curve / transfer function of the image input.

 Input Gamut

[XYZ,  Rec709,  Rec2020,  sRGB,  P3DCI,  P3D60,  ACES  Primaries,  ACES  CG/CC/
Proxy Primaries, Arri ALEXA Wide Gamut, RED Dragon Color2,  Sony  S-Gamut3,
Canon Cinema Colour]

Select the colour gamut of the image input.
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Gamut Options

Convert Gamut 

[Yes, No]

Enable or disable  the  Gamut  conversion of  the  effect  function of  the  Convert  node.
When set  to No (default) the node will perform only a gamma curve conversion,  with
no impact on the colour gamut of the image.

Use Bradford Matrix

[Yes If Aplicable, No]

If enabled (default), and if  the white point  of the input  and output  gamut  parameters
do  not  match,  the  Convert  node  will  calculate  and  apply  a  Bradford  Chromatic
Adaptation Matrix to the image.

Output

Output Gamut

[XYZ,  Rec709,  Rec2020,  sRGB,  P3DCI,  P3D60,  ACES  Primaries,  ACES  CG/CC/
Proxy Primaries, Arri ALEXA Wide Gamut, RED Dragon Color2,  Sony  S-Gamut3,
Canon Cinema Colour]

Select the desired colour gamut of the image output.

Output Curve

[Linear Light, Rec709/Rec2020, sRGB, P3DCI, Cineon, SMPTE 2084 PQ, ACES CG,
ACES CC,  ACES Proxy,  Arri  LogC  V3,  Canon Log2,  RED Log Film,   Sony  Slog3,
Sony Slog2, Gamma 2.2, Gamma 2.4]

Select the desired gamma curve / transfer function of the image output.

Parameters Explained

Curves:

Linear Light: Equivalent to Gamma = 1.0

Rec709  /  Rec2020:  The  non-linear  transfer  function  common  to  ITU-R
Recommendations BT.709 and BT.2020 (approximately equivalent to Gamma = 2.4).

sRGB:  The  non-linear  transfer  function  of  the  standardised  sRGB  colour  space
(approximately equivalent to Gamma = 2.2).

P3DCI (RGB):  Gamma  = 2.6.   Used  for gamma  encoding  of  RGB images  (to  encode
XYZ images, use the DCDM option).

Cineon: A standard Cineon log-encoded gamma curve.

SMPTE 2084 PQ: The non-linear transfer function defined by SMPTE 2084:2014, used
for high-dynamic range display.
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ACEScg:  The  gamma  curve  defined  in  ACES  v1.0  for  the  ACEScg  colour  space
(Gamma = 1.0, equivalent to Linear Light).

ACEScc: The non-linear transfer function defined in ACES v1.0 for the ACEScc  colour
space.

ACESproxy: The non-linear transfer function defined in ACES v1.0 for the ACESproxy
colour space.

Arri LogC V3: The Arri Log C logarithmic encoding curve.

Canon Log: The Canon Log logarithmic encoding curve.

RED Log Film: The RED Log Film logarithmic encoding curve.

Sony S-Log3: The Sony S-Log3 logarithmic encoding curve.

Sony S-Log2: The Sony S-Log2 logarithmic encoding curve.

DCDM: The standardised transfer function used for gamma encoding of XYZ images in
DCI mastering.  Consists of  a  Gamma=2.6 power function,  normalised  to  a  reference
48 cd/m2 display luminance (to encode RGB images, use the P3DCI (RGB) option).

Gamma 2.2: simple gamma curve 2.2

Gamma 2.4: simple gamma curve 2.4

Gamut:

XYZ: The CIE 1931 XYZ colour space

Rec709: ITU-R Recommendation BT.709 primaries

Rec2020: ITU-R Recommendation BT.2020 primaries

sRGB: Standardised primaries of the sRGB colour space

P3DCI: P3 RGB primaries and DCI white point (SMPTE 321-2:2011)

P3D60: P3 RGB primaries and D60 white point

ACES Primaries: RGB primaries and white point as defined in ACES v1.0

ACES  cg/cc/proxy  Primaries:  RGB  primaries  and  white  point  common  to  the
ACEScg, ACEScc and ACESproxy colour spaces, as defined in ACES v1.0

Arri  ALEXA  Wide  Gamut:  RGB  primaries  and  white  point  used  by  the  Arri  ALEXA
camera family

RED Dragon Color2: RGB primaries and  white  point  used  by  a  variety  of  RED digital
cinema cameras

Sony  S-Gamut3:  RGB  primaries  and  white  point  used  by  a  variety  of  Sony  digital
cinema cameras
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Use and comments

The Unicolor node is intended for use as a flexible, general-purpose colour space conversion
utility. It provides the ability to quickly and easily convert clips between standardised colour
spaces 

Common applications for the node include:

Striping gamma from a source image to create a Linear Light output (or the inverse)

Converting a single clip or sequence on the Mistika's Node Graph to a different  RGB colour
space.

Converting clips from different cameras to be in the same colour space

Performing an RGB to XYZ conversion for DCI mastering.

For  a  typical  RGB  to  RGB  conversion  the  node  internally  performs  the  following  image
processing steps (some steps may not apply based on parameter selection):

1. Remove the user specified input gamma curve from the source image

2.Calculate and apply an RGB to XYZ matrix conversion, based on the user specified source
image gamut

3.Calculate  and  apply  a  Bradford  Chromatic  Adaptation  Matrix  (if  the  input  gamut  and
output gamut white points differ)

4. Calculate and apply an XYZ to RGB matrix conversion, based on the user specified output
gamut

5. Apply the user specified output gamma curve

To  use  the  Unicolor  node  correctly,  it  is  important  to  have  a  solid  understanding  of  your
desired colour workflow, and to properly understand the properties of both your input  (e.g.
the  gamma  curve  and  gamut  of  your  source  clips)  and  the  parameters  of  your  desired
output.

RGB to XYZ Conversion for DCI Mastering:

The Unicolor  node replaces the previous RGB to  XYZ  effect,  providing  more  flexibility
and also simplifying the colour conversion necessary for DCI mastering.

To convert a source RGB image to XYZ / DCDM space:

1. Enable Gamut Conversion within the Unicolor node (set Convert Gamut to Yes)

2. Select the Input Curve and Input Gamut of the source material

3. Set the Output Gamut to XYZ

4.Set the Output Curve to DCDM

Note:

The P3DCI (RGB) curve is a standard gamma of 2.6 across  the  full  range  of  Black to
White input values.  It is intended for use only on RGB encoded images.

The DCDM curve option is  a  combination of  a  2.6 gamma  curve  plus  an XYZ  scaling
factor, necessary for conformance to the Virtual White Point  capabilities of the DCDM
image  mastering  format  as  described  in  SMPTE  RP  432-1:2011.   The  DCDM  curve
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option should only be used on XYZ encoded images.

Remap

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Color->Remap

Resets the colors of an image by examining the color of a line of a second image. The line of
the  second  image  shows  from right  to  left  the  colors  that  correspond  to  the  luminance
values of the modified image in order from black to white. 

I/O

Inputs

Double input: The first is the image to be modified, and the second contains the line
to be examined to respecify the colors. 

Inputs

Image: Image with modified colors.

Alpha: Opaque.

Parameters

Line

[50 (0 / 100.000)]

Selects the horizontal line to be examined to reset the colors. 

This  value  is  a  percentage,  indicating  by  default  the  horizontal  center  line  of  the
image. Every 100 parameter units, it returns to the bottom line of the image. 

Cycle

[0 (0 / 100.000)]

Specifies a offset from the origin of the line exploration. 

The line is always read from left  to right, and even though an offset  is specified, the
line  exploration  is  completed  in  a  cyclical  manner,  reading  what  is  necessary  for
completion by returning to left  edge of the frame and then continuing until it  reaches
the point  of origin. The default  value indicates that  the line starts to be examined at
the left edge of the image; 50 specifies a start  from its center (50%); a value of 100
returns to its left edge. 

 In Alpha

[No (No /Yes)]

Restricts the influence of the  color correction to  the  area  specified  by  the  levels  of
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the alpha channel. 

Use and Comments

The parameters of this effect can be animated, generating psychedelic color effects. 

The uses of this effect  are varied. One classic  use is to  color the  image  of  the  first  input
with a color palette  that  the  user can specify  in  the  second  input,  obtaining  for example
images that simulate a heat detector, or for 0coloring black and white images.

In  the  following  example,  different  palettes  are  used.  The  first  simulates  gold,  and  the
second a heat detector. 

Another useful application of  this  effect  is  to  correct  mask  edges.  If  a  black  and  white
image representing a mask (which can be obtained with the ShowAlpha effect) is positioned,
it  can be blurred (with the Blur  effect, for example) and  inserted  as  the  first  input  of  this
effect.  As  second  input,  a  horizontal  Wipe  can  be  specified  (the  first  Wipe  of  the  wipe
library) and by controlling its Grade and Soft parameters the white surface of the first  input
could be shrunk or gently softened, or the outline of the mask border achieved. 

In  the  following  example,  a  blurred  mask  with  two  different  color  maps  is  used.  The
objective  of  the  first  map is  to  shrink the  opaque  surface  of  the  mask,  and  that  of  the
second to obtain the mask border. 



451FX

SGO Mistika 8.6 © 2018 SGO

This effect is also useful fir achieving a comic-book style image. 

Legalize

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Color->Legalize

Prevents values outside the RGB color space and limits abrupt  chroma transitions that  may
create illegal peaks in YUV422.

I/O

Inputs

Single input: Image with/without alpha channel.

Outputs

Image: legalized image.

Alpha: alpha of the input.

Parameters:

422 Cleanup

[ Off (Off / On )]

Prevents  values  outside  the  legal RGB value  of  scope  when sub  sampling  from RGB444 to
YUV422.
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Folder of parameters that  define the compression and its softness in the range of shadows
in the image.

Knee

[64 (64 / X )]

Defines  the  point  in  the  luma  curve  from which  the  shadows  will  be  softened  and
compressed to legalize the whole range.

Peak

[0 (-X / X)]

Defines the amount of softness for the compression of the legalizer.

Folder of parameters that define the compression and its softness in the range of high lights
in the image.

Knee

[940 (X / 940 )]

Defines  the  point  in  the  luma  curve  from which the  high lights  will  be  softened  and
compressed to legalize the whole range.

Peak

[0 (X /X )]

Defines the amount of softness for the compression of the legalizer.

RGB Levels

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Color->RGB Levels

This effect  allows the user to switch between the two standards of video signal,  ie.  video
and  data,  which are  normally  associated  with  the  terms  YUV,  RGB,  analog  and  digital.  All
automatic  conversions  carried  out  by  Mistika  between  RGB  and  YUV  are  done  with  the
proportion  1:1,  so  the  operator  has  absolute  control  when  changing  between  these
standards. The work flow with RGB Levels consists of applying it  to the selected clip, and if
it  needs  to  be  extended,  converting  the  effect  into  a  filter  via  Display  Filters  (Visual
editor->Dashboard->Display Filters). 

I/O

Inputs

Single Input: Image with or without alpha channel.

Outputs

Image: image with the signal converted to the selected range.

Alpha: alpha of the input.
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Parameters

Mode

[Video->Data (Video->Data /Data->Video)]

Switches between modes of conversion for legal video and data.

Use and Comments

Switching between different color ranges not  only means that  it  is necessary to match the
files used within the environment, but  it  also means there may  be  confusion with  different
standards  within  each  one.  Therefore,  Mistika  simplifies  the  functioning  of  this  type  of
conversion, making it possible always to work internally at  16 bit  RGB , by default  importing
and capturing all the video clips without  applying any conversion,  allowing  the  operator to
evaluate each video clip.

So, in a single workspace we may find image clips that are "video", using the values in a 8bit
representation scale,  between  16-235,  and  at  the  same  time  other  there  may  be  other
image files working as "data", ie from 0 to 255. The basic reason for this kind of change is to
have a common black point for all the files, avoiding having some at 0 and others at  16. So,
when  capturing  the  video,  Mistika  always  works  in  extended  range  (capturing  all  the
information  it  finds  on  the  tape)  without  fixing  a  a  black  point  to  the  video  standard,
allowing th operator to do this. If  there are digital files  received  as  "data" which we  know
should be in "video", the inverse correction can be applied.

ACES

This  effect  allows  conversions  and  changes  of  gamma  curves  in  material  with  ACES  color
space.

I/O

Inputs

Single input: Image with/without alpha channel.

Outputs

Image: image converted to color space or gamma curve as defined by the user.

Alpha: alpha of the input.

Parameters

The parameters of the ACES effect are as follows:

Input:

Input Curve

Indicates the gamma curve to be used as input.
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Input Space

Indicates the color space to be used as input.

Precision:

One  of  the  problems  that  ACES  presents  is  the  application  of  RRT  (Reference  Rendering
Transform)  which basically  applies  a  default  look over and  above  the  color  corrections  a
user  may  have  applied.  To  resolve  this,  a  LUT  can  be  used  to  scale  the  result  of  the
conversion, altering at the same time the gamma curve in order to specify how this scaling
should behave.

Gamma

[1,2,3]

Allows  the  Gamma  curve  to  be  altered  according  to  scaling,  giving  more  or  less
information to blacks.

Max Level 

[100%, 200%, 300%]

Allows  the  conversion carried  out  in  ACES  to  be  scaled,  in  order  to  avoid  the  RRT
being applied to color corrections. 

Output:

Output Space

Indicates the color space to be used as output.

Output Curve

Indicates the curve to be used as output.

ACES ODT

This  effect  allows  to  make  conversions  of  gamma  and  gamut  to  different  output  display
profiles.

I/O

Input

Single input: Image with/without alpha channel.

Output

Image: image converted to color space or gamma curve as defined by the user.
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Alpha: alpha of the input.

Parameters

Input

Input Curve

[linear Light,  Rec  709/Rec  2020,  sRGB,  P3DCI,  Cineon,  SMPTE  2084  PQ,  ACES
CG, ACES CC, ACES Proxy, Arri LogC V3, Canon Log, RED LogFilm, Sony Slog3]

Define the input gamma curve of the clip.

Input Gamut

[XYZ, Rec 709, Rec  2020,  sRGB,  P3DCI,  P3D60,  ACES Primaries,  ACES CG/CC/
Proxy, Arri Alexa Wide Gamut, RED Dragon Color2, Sony S-Gamut3] 

Define the input gamut of the clip

Use Bradfrod Matrix

[Yes If Aplicable, No]

Enable  the  use  of  the  Bradford  matrix to  make  the  Gamut  conversion.  It  is  a  more
accurate matrix, so it is recommended to enable it.

Output

Output Space

[Rec2020_100nits_dim,  Rec709_100nits_dim,  RGBmonitor_D60sim,  DCDM,
DCDM_P3D60,  P3DCI_48nits,  P3D60_48nits,  p3D60_PQ_1000nits,
P3D60_PQ_2000nits, P3D60_PQ_4000nits]

Select the output color space based on our output display. 

 Precision

[Normal, High, Higher, Highest]

Select the conversion precision (higher values demands more system resources).
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Keyer

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Keyer

This  menu  includes  tools  relating  to  obtaining  the  alpha  channel  from  and  image  and
posterior composing.

Blue Screen, Green Screen

Ref.  Mistika:  Node  Graph  Editor->Dashboard->Fx->Mistika->Keyer->Blue  Screen,
Green Screen

Although  Bluescreen  and  Greenscreen  are  two  separate  effects,  their  parameters  are
identical.  For  this  reason,  only  Bluescreen  is  described  here,  and  the  description  of
Greenscreen can be obtained by substituting blue for green. 

This  effect  is  specialized  in  generating  an alpha  channel from images  recorded  on  a  blue
background, although it also permits composition in a mixed cut mode.

This effect can be used in three ways, depending on the number of Inputs.

I/O

Inputs

Single input: Extracts an alpha channel from the blue color. 

Double input:  Extracts  an alpha  channel from the  comparison of  blue  colors  of  the
two inputs. 

To obtain a more optimized mask,  insert  the  background  image  without  character to
crop as a second input.

Triple  input:  Extracts  an alpha  channel  from the  comparison  of  blue  colors  of  the
second  and third inputs, and then composes the second input  on the first, adding an
additional fine control for edges and transparencies. 
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Inputs

Single input: 

Image: Image with suppressed cropping color. 

Alpha: Mask extracted from the image. 

Double input:

Image: Image composed on the background.

Alpha: Mask extracted from the image. 

Parameters

Key:

Folder containing parameters that specify the cut values. 

Toler

[0 (-100 / 100)]

Specifies the total transparency threshold in the alpha used for composing.

Soft

 [100 (0 / 100)]

Controls  the  range  of  smooth  transparencies  obtained  from the  total  transparency
specified by the tolerance parameter towards absolute opacity. A low value specifies
a small range of intermediate transparencies. 

PreBl X ; Y

[1 (0 / 100)]

Specifies  a  horizontal  and  vertical  blur  value  for  the  proxy  image  used  for  mask
extraction. 

This parameter is very useful since it rounds the outline of the mask extracted, due to
the fact that the blur filter associates the RGB values of neighboring pixels, smoothing
the  color  transition  of  between  the  background  and  the  figure  before  the  mask  is
extracted. 

Spill:

This folder contains parameters  to  suppress  the  blue  spill  that  might  remain  in  foreground
after the mask has been extracted. 

Pass>R ; Pass>G 

[-50 (100 / 100)]

Tolerance of color suppression. 



458 FX

SGO Mistika 8.6 © 2018 SGO

The  tolerance  is  adjusted  asymmetrically,  referencing  two  angles  forming  a  cone
centered  in  the  blue  vector in  a  chromatic  circle.  Pass>R  specifies  the  suppression
tolerance  towards  the  angle  of  the  red  vector,  whereas  Pass>G  specifies  the
suppression tolerance towards the angle of the green vector. 

Red; Green; Blue

[0 ; 0 ; 0 (100 / –100)]

Specifies a new color for the suppressed ranges. 

The default value specifies medium grey, thus achieving the desaturation of the edge
color. 

The cancellation values of the suppression, in the case of blue, are –50; -50;  50 for
RGB respectively. 

Lum

[0 (-100 / 100)]

Modifies the pixel luminance level of that made by the color suppression. 

Shrink

[0 (0 / 10.000)] 

Shrinks the opaque surface of the mask already generated in the alpha channel. 

EdgBld

[0 ( 0 / 2)]

Copies  the  RGB  values  of  the  nearest  pixel  with  an  opaque  alpha  to  the
semitransparent alpha channel pixels. 

By this means, this parameter pushes the color surface towards the edges, since they
are usually semitransparent in the alpha channel. 

Transp:

Folder containing parameters for fine control of transparency composition. 

This  folder  should  be  ignored  when  not  using  this  effect  with  triple  input,  since  the
transparencies are composed in the first  input  by  using  a  mask of  the  difference  between
the second and third. 

Remove

[2 (0 / 100)] 

Transparency mixing control. High values suppress mixing. 

OfsCor

[50 (-200 / 200)]
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Adds  saturation  to  the  transparencies,  since  transparencies  do  not  originally  have
saturation. 

Positive  values  will  tint  the  transparencies  towards  the  complementary  color  of  the
edges, whereas negative values the will tint towards the color of edges. 

Smth X; Y

[1 ; 1 (0 / 9)]

Specifies a blur of the individual transparencies in each axis, to smooth them. 

Crop:

Folder containing parameters that  permit  cropping the alpha channel of the inputs with the
four sides of the frame. 

Left

[0 (0 / 100)]

Left edge as a percentage of the image width. 

Right

[100 (0 / 100)]

Right edge as a percentage of the image width. 

Up

[100 (0 / 100)]

Top edge as a percentage of the image width.

Down

[0 (0 / 100)]

Lower edge as a percentage of the height of the image.

Use and Comments

This effect  is the most  suitable for cropping bluescreens  or greenscreens.  When double  or
triple input is used, the extraction of a high quality mask is guaranteed. 

A  shot  of  a  figure  walking  on a  green background  can  be  seen  in  this  example,  with  no
camera movement. The foreground clip that has the figure to be composed in Foreground is
used as the first input, and the second input is the empty set without the figure (Screen). 

When there are two inputs, the effect  generates a mask from both inputs and then runs a
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Difference mathematical operation for both  generated  masks.  The  result  is  the  removal of
the  imperfections  due  to  bad  on-set  lighting,  since  this  is  suppressed  in  the  comparison
between  background  and  background  with  figure,  thus  extracting  a  clean  mask  of  the
figure.  In  this  case,  it  can also  be  seen that  even the  shadow  cast  by  the  character  is
included in the mask, thanks to the high selection range in the histogram.

In some  cases,  it  is  difficult  to  obtain  the  background  image  (Screen)  without  the  figure
being included, because there are camera movements in the shot. In these cases, it  is very
helpful  to  work  with  Motion  Control  systems  to  make  an  additional  pass  of  the  empty
background. When a motion control camera is not  available,  the  construction of  a  “proxy”
background in movement  can be attempted with its virtual reconstruction, with the help of
the  ScreenBuild  effect,  or  by  animating  parts  of  the  original  background  by  using  the
tracking  tools.  In  the  final instance,  an empty  background  can be  artificially  specified  by
inserting a Solid effect as second input, specifying its color with the Color Chooser, carrying
out a Pick Color from the original background. 

It  is  important  that  the  background  set  is  the  purest  possible  blue  (or green).  The  Color
Chooser  can be used to analyze the background color. Frequently  it  will  be  seen that  the
color  tends  to  be  lightly  tinted  towards  cyan.  This  problem should  be  corrected  before
applying this effect, to obtain the widest possible tolerance histogram. 

When  this  effect  uses  three  inputs,  it  makes  the  final  composition  over  the  desired
background,  adding  additional  processes  in  order  to  work  with  transparencies.  Other
composition effects, such as Comp3D or HaloComp, do not carry out  this additional process
for transparencies. 

The following image is an example of how the three inputs in the effect should be arranged. 
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The  effect  parameters  should  be  set  in  the  same  way  as  when  using  two  inputs,  but  in
addition, the parameters of the Transp folder, which control the process of composition  of
transparencies, are used. The composition method of transparencies is different  and totally
independent  from  that  of  the  composition  of  the  foreground,  using  a  calculation  that
considers only the luminance of the transparencies. The two processes, divided into layers
composed on a grey background, are shown in the following image. The combined result  of
both processes takes maximum of the useful image information in order to create the mask,
being especially visible in transparent details, such as shadows. 

This effect, when used with triple input, provides an exceptional transparency background,
which can be very useful for preserving fine details of the figure to  be  extracted,  such as
for example transparencies of hair or glass (for example, car windows), projected shadows,
and above  all,  contact  shadows.  Contact  shadows  are  one  of  the  classical problems  in  a
composition: they are the kind  shadow  which an object  or character produces  in  contact
with the background set (for example, the floor), and which, when it is extracted and added
to  the  composition,  helps  to  integrate  the  composed  figure  on the  new  background,  and
avoid having the foreground “float” over the background. 

External Key

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Keyer->External Key

Assigns the luminance of a sequence to the mask of another one.

I/O

Inputs

Double input: The first  is the image to be composed and the second the image that
to be assigned as the external mask, interpreting its luminance as the alpha channel. 

Inputs

Image: Image of the first input. 

Alpha: Luminance of the second input.
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Parameters

The  External key  effect  is  basically  a  Channels  preset  with  the  Alpha  folder  changed  to
X=Luma.

Use and Comments

This effect  is limited to assigning (either normally or inverted) the luminance of the second
input as the alpha channel of the first. Thanks to its simplicity, its calculation is faster than
other more elaborate effects that  can cover the same functionality, such as  the  Channels
effect. Its uses can be very diverse. Since this effect  is  a  mask assigner and  not  a  mask
extractor,  its  use  is  valuable  for  assigning  a  mask  previously  extracted  from  image  to
another  image,  or  assign  any  mask  to  an  image  to  be  able  to  work  with  effects  that
function on the basis of the mask information or that  can limit  its functionality to the mask,
such as color correctors or spatial filters. 

In this example, the original image and the mask assigned by this effect  can be  seen.  The
mask was  previously  extracted  from the  small  image  that  accompanies  the  mask  with  a
Greenscreen  effect,  and  then  the  ShowAlpha  effect  shows  the  generated  mask  in
grayscale, so that the ExternalKey effect  can reassign the mask. The following four images
show different possible uses of this external mask assignment. 

The first  example is simply the composition of the original image on a different  image  using
an external mask, using the Comp3D effect. 

The second example is the LiquidBump effect. This effect must have an alpha channel to be
able to function and generate a relief and refraction at the edges of the mask, as well as to
be able to specify an interior color and a projected shadow. 

The third example consists of adding a color correction with the Mode->InAlpha  parameter
activated, and restricting the correction to the area delimited by the mask opacity. In this
case, the correction darkens the image in the mask. 

The last  example is the Comp3D effect  for composing the image on itself, but  specifying  a
projected shadow with the parameters of the Shadow folder. 

RGB Key

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Keyer->RGB Key

Effect for the extraction of masks from an RGB value.
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I/O

Inputs

Single input: Image from which an alpha channel will be generated. 

Double input: The first  input  is the image to be composed; the second image is  the
one from which the mask will be extracted. 

Inputs

Image: Input image. 

Alpha: Mask extracted from the image. 

Parameters

Toler

[0 (-100 / 100)]

Specifies  the  total  transparency  threshold  of  the  alpha  to  be  used  for  the
composition. 

Soft

[100 (0 / 100)]

Controls the range of smooth transparencies from the total transparency specified by
the tolerance parameter towards absolute opacity. 

Lower values specify a small range in intermediate transparencies. 

Red; Green; Blue

[0; 0; 0 (0 / 100)]

Specifies the color RGB selected to generate a mask. 

Invert

[No (No / Yes)]

Inverts the transparency and opacity values of the alpha channel.

Use and Comments

Although this effect is not the most suitable for creating a mask (since Color Key can use a
single or multiple selection), it  has the distinction of being able to animate a selected color
as a mask generator, since its parameters are the ones that specify that color.
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Color Key

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Keyer->Color Key

Effect  that  extracts a mask with  a  color selection,  which should  be  done  exclusively  with
Mistika->Visual Editor->Manipulators  Tabs->Pick Key.  This  color selection  cannot  be
animated.

I/O

Inputs

Single input: Image from which an alpha channel will be generated. 

Inputs

Image: Input image.

Alpha: Mask extracted from the image. 

Parameters

Toler

[0 (-100 / 100)]

Specifies  the  total  transparency  threshold  of  the  alpha  to  be  used  for  the
composition. 

Soft

[30 (0 / 100)]

Controls the range of smooth transparencies from total transparency specified by the
Tolerance parameter towards absolute opacity. 

Lower values specify a small range in intermediate transparencies. 

Invert

[No (No / Yes)]

Inverts the transparency and opacity values of the alpha channel.

Use and Comments

This effect allows the selection of a number of arbitrary colors for specifying a mask, which
is very useful in cases where objects or people that  were not  specially  registered  for that
purpose have to be cutout. 

In  this  example,  the  background  color (red)  is  chosen to  generate  a  mask.  This  effect  is
only a mask extractor, and has no parameters to improve the extracted  mask,  so  that  we
recommend treating  the  generated  mask with  other effects,  such  as  Shrink,  Blur  (in  the
mode  RGB-InA)  or  VectorPaint  for  example.  In  the  example  image,  the  mask  obtained
requires  a  correction,  since  the  color  selected  for  the  mask  is  noticeably  affecting  its
borders. 
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Color selection is accumulative, and any combination of colors can be selected to generate
a  mask.  In  some  cases,  where  a  cutout  figure  is  desired  in  the  image,  it  may  be  more
beneficial to select the colors of the figure instead of the background colors. 

This  effect  is  also  very  useful  for  generating  masks  that  restrict  the  action  of  another
subsequent effect. In this example, the mask was extracted from the skin by selecting the
colors of the face and inverting the mask with the Invert  parameter, and finally applying  a
blur filter trough the generated mask (for example, the  Blur  (Type  Gauss)  effect,  with  its
RGB-InA parameter activated). 

In cases of material with a blue or green background, we recommend using the effects that
are specialized for this purpose: BlueScreen and GreenScreen.

Luma Key

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Keyer->Luma Key

Generates a mask from the  selection of  low,  medium and  high of  luminance  values  of  the
image.

I/O

Inputs

Single input: Image from which an alpha channel will be generated. 

Inputs

Image: Input image. 

Alpha: Mask extracted from the image. 

Parameters

Low

[100 (0 / 100)]

Specifies the intensity of the mask in areas of low luminance. 
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Mid

[100 (0 / 100)]

Specifies the intensity of the mask in areas of medium luminance. 

High

[100 (0 / 100)]

Specifies the intensity of the mask in areas of high luminance.

Use and Comments

We  recommend  this  effect  for  extracting  masks  from  an  image  through  its  luminance,
ignoring saturation and hue. The masks obtained with this effect  can be improved with the
Shrink, Blur (in the mode RGB-InA) or VectorPaint effects.

In  most  cases,  the  Boolean operations  made  by  the  And,  Or,  Add,  Subtract  or  Channels
effects,  combined  with  color  corrections  are  more  recommendable  than  composing  with
masks,  although  this  effect  permits  the  selection  of  luminance  ranges  to  mask  color
corrections of spatial filters with the InAlpha parameter. 

In the following example, this effect is used in combination with Blur to simulate an image of
mist on the original landscape. 

In this case, the parameters were specified as follows: Low: 100; Mid: 0; High: 0.

Then a Blur (Type Gauss)  is  applied  with  the  RGB-InA parameter activated.  A  blur is  thus
obtained  in  the  low  luminance  values  of  the  image,  maintaining  the  details  in  the  medium
and high values, giving a misty sensation to the image, since the blur reduces the contrast
in the dark areas, but detail is maintained in the bright ones

Keyer Tools

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Keyer->Keyer Tools

This dropdown permits the selection of the tools Stroke, Edge Build and Screen Build.

Stroke

Ref. Mistika: Fx->Mistika->Keyer->Keyer Tools->Stroke

Adds a stroke (line) of color from the outline of a mask. This line can be  drawn outside  or
inside the outline specified by the alpha channel. In order to view this effect  correctly, it  is
necessary to compose the result on a background. 



467FX

SGO Mistika 8.6 © 2018 SGO

I/O:

Inputs

Single input: Image with alpha channel. 

Inputs

Image: Image composed with the stroke color. 

Alpha: Original mask added to the mask of the generated stroke.

Parameters:

Red; Green; Blue

[100; 100; 100 (0 / 100)]

Specifies the color of the stroke in RGB values.

Side

[0 (0 / 100)]

Position value of the stroke. 

Positive values increase the thickness of the stroke outside the original mask, whereas
negative  values  make  the  thickness  of  the  stroke  grow  inwards.  A  value  of  zero
specifies that the stroke should have no thickness, making it invisible.

Use and Comments:

This effect is normally used as a graphical tool to add an edge to composed images. This is
especially  useful  for  composing  text,  since  the  letters  can  be  outlined  any  edge  color,
making them easier to read. 

Bear in mind that the stroke generated by the effect is achieved by shrinking or growing the
mask, and therefore if  high values of  the  Side  parameter are  specified,  the  generated  line
will have geometrical borders that are not rounded. 

If  it  is  necessary  to  smooth  the  generated  edge,  a  Blur  (Type  Gauss)  effect  should  be
added on top of the Stroke effect to blur the outside of the line. 

Edge Build

Ref. Mistika: Fx->Mistika->Keyer->Keyer Tools->Edge Build

Improves the color of the pixels in the transparent area of a mask. 
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I/O:

Inputs

Single input: Image with alpha channel. 

Inputs

Image: Image with improved edges. 

Alpha: Mask without changes. 

Parameters:

None.

Use and Comments:

This  effect  copies  the  RGB  values  of  the  nearest  pixel  with  opaque  alpha  to  the
semitransparent  alpha  channel  pixels.  In  this  way,  this  effect  pushes  the  color  surface
towards  the  edges  of  the  mask,  since  they  are  usually  semitransparent  in  the  alpha
channel. 

In the example below, the difference between expanding the color with this  effect  instead
of shrinking the mask can be seen. Shrink may possibly remove the undesired edges, but  at
the cost  of shrinking the mask by modifying  the  outline  of  the  composed  figure.  However,
EdgeBuild keeps the mask intact, only affecting the color of the image outline and  not  the
shape of the layer outline. 

In this image the way the effect  works, by expanding the image color, instead of shrinking
the mask as with Shrink, can be seen in detail.

Screen Build

Ref. Mistika: Fx->Mistika->Keyer->Keyer Tools->Screen Build

Reconstructs the background color in the areas specified by its mask. 
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I/O:

Inputs

Single input: Image with alpha channel.

Inputs

Image: Image with background reconstructed.

Alpha: Opaque. 

Parameters:

Grow

[0 (0 / 1.000)]

Mask expansion value. 

Blur

[0 (0 / 10.000)]

Specifies an image blur with the Blur (Type Gauss) filter. 

Use and Comments:

This effect acts on the RGB channels of the image, filling the internal areas specified by the
mask with  an averaged  color.  The  Grow  and  Blur  parameters  permit  setting  of  the  areas
occupied  by  the  figure  in  the  mask with  either expansion or blur,  replacing  them with  an
average  color from the  surrounding  image,  with  the  intention  of  regenerating  the  original
background. 

For this effect  to function reasonably well, it  is necessary to maintain  the  original color of
the  background  intact,  avoiding  the  color  suppressors  that  may  be  running  during  mask
generation, since the main purpose of this effect  is to reconstruct  the  original background
of the set for later use as a second or third input of the Bluescreen or Greenscreen effects.

Spatial Key

This  effect  allows  advanced  selections  to  be  made  of  elements  in  a  scene,  based  on
multilayer information in EXR format (previously generated in a CGI program), and also based
on  Parallax  information  calculated  by  the  Stereo3D  effect.  Normally  in  Mistika  these
selections are stored as masks in the Alpha channel. 

The layers that  Mistika detects in an EXR are: IDs, position layer (XYZ information),  depth
layer (Z-axis information), and diffuse reflection (according to the normals of the object). 
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Ext Key

This allows boolean operations to be carried out  between different  Layers contained in the
EXR file. These Layers may be grouped together in three groups (Layer List  1, Layer List  2
and Layer List 3) in order to carry out operations together and generate a Key to be used in
different tools of Mistika.

Bear in  mind  that  many  of  the  layers  generated  by  CGI  programs  contain  purely  numeric
information that must be interpreted in RGBA before it can be correctly combined with other
layers.  This  is  the  case,  for  example,  with  Depth  Layers,  which  must  be  previously
normalized in order to be seen correctly in RGBA. 

The result of these operations can be modified with different  tools in Spatial Key in order to
achieve more precise selections, by using ID, depth, position or direction of normals

Object ID

Allows the selection of certain objects in an image based on their numerical ID as stored in
the Index Object  of the EXR file. This ID is set  in the external program that  generated the
file, and as a general rule, a unique number for each object of the scene is set.
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Parameters:

Layer

Defines  the  layer  the  effect  will  use  to  make  the  selection.  This  layer  is  set
automatically  using  the  tool  Pick  Object  ID  if  and  when  the  EXR  file  contains  a
recognizable layer as an ID index.

Object ID

Shows the ID number associated to the selected object.

Use and comments:

To be able to select  an object  by means of its ID, it  is only necessary to have  the  option
Pick Object  ID, in the Multilayer  tab of the Visual Editor (found on the right  of  the  effect)
active; then select  the desired object  in the image in  the  Visual Editor  (Evaluation Zone).
At this time, in Layer, the name of a layer automatically selected by Mistika should appear;
if not, the user must select one manually. 

Once the object  has been selected, this selection is maintained throughout  the whole clip,
whether or not the object goes outside the edges of the image or if  another object  passes
in  front  of  it.  The  ID  that  defines  this  object  is  unique,  so  there  is  no  chance  of  any
alteration happening in the selection, thus opening up a whole range of possibilities in both
composition and in Color Grading.  

Position

Allows the selection of a group of objects based on their XYZ position. The coordinates and
the information relative to their position must be included in the EXR file being used. 
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Parameters:

Layer

Defines  the  layer  the  effect  will  use  to  make  the  selection.  This  layer  is  set
automatically  using  the  tool  Pick  Position  if  and  when  the  EXR  file  contains  a
recognizable layer as position coordinates.

Shape

Allows the selection the shape of the selection mask. There are two options: 

Sphere

The mask will be a circle.

Square

The mask will be a square.

Center X

Shows and allows the selection of the X position of the mask.

Center Y

Shows and allows the selection of the Y position of the mask.

Center Z

Shows and allows the selection of the Z position of the mask.

Size X

Allows the size of the mask to be adjusted in the X-axis.

Size Y

Allows the size of the mask to be adjusted in the Y-axis.

Size Z

Allows the size of the mask to be adjusted in the Z-axis.

Size

Allows the size of the mask to be adjusted by the same amount in all axes. 
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Softness

Sets the amount of softness of the mask used.

Use and comments:

To  be  able  to  select  a  group  of  objects  in  an  image  based  on  their  position  it  is  only
necessary to have the option Pick Position, in the Multilayer  tab of the Visual Editor (found
on the right of the effect) active; then select  the desired object  in the image of the Visual
Editor (Evaluation Zone) to set the initial coordinates. At  this time, in Layer, the name of a
layer  automatically  selected  by  Mistika  should  appear;  if  not,  the  user  must  select  one
manually. 

From  this  point  the  user  can  configure  the  mask  by  means  of  its  parameters.  Unlike
selection by ID, when selection by  position  is  used,  we  do  not  isolate  whole  objects,  but
rather the areas found at the chosen coordinates. The risk of using this type of selection is
that, depending on the size of the mask used, fragments or small groups of pixels located in
the  same  position  as  the  areas  we  wish to  isolate  may  sometimes  be  introduced.  In  this
case, we can adjust  the softness of the mask, or combine the Alpha that  results from this
operation with a secondary manual selection via manual masks, or by using Color Grade.

Depth

Allows the selection of a group of objects based on their Z position. The information of the
Z-axis  or Depth Map must  be  included  in  the  EXR file  being  used.  This  data  can  also  be
generated from a stereoscopic image by calculating Parallax.

Parameters:

Layer

Defines  the  layer  the  effect  will  use  to  make  the  selection.  This  layer  is  set
automatically  using  the  tool  Pick  Depth  if  and  when  the  EXR  file  contains  a



474 FX

SGO Mistika 8.6 © 2018 SGO

recognizable layer as a Depth Map.

Shape

Allows the selecting of the depth mask that  is to be  used.  The  following  options  are
available:

Select Distance

Selects the objects found at the depth defined by the user in an EXR file.

Off Focus Distance

Selects the inverse of the previous mask.

Select Parallax

Selects the objects found at the depth defined by the user in a Stereo3D clip.

Off Focus Parallax

Selects the inverse of the previous mask.

Depth Z

Allows the adjustment of the position of the selection mask in Z.

Size Z

Allows the adjustment of the size of the selection mask in Z.

Softness Z

Sets the amount of softness of the mask used.

Use and comments:

To  be  able  to  select  a  group  of  objects  by  means  of  their  Z-axis  position,  it  is  only
necessary to have the option Pick Object  Depth, in the  Multilayer  tab  of  the  Visual Editor
(found on the right of the effect) active; then select  the desired object  in theimage in the
Visual Editor  (Evaluation Zone) to define its depth coordinates. At  this  time,  in  Layer,  the
name  of  a  layer  automatically  selected  by  Mistika  should  appear;  if  not,  the  user  must
select one manually. 

Once  the  initial  depth of  the  mask  is  set,  its  size  and  softness  can  be  adjusted.  Unlike
selecting  by  position,  in  a  Depth  Map  the  size  of  the  mask  in  X  and  Y  axes  cannot  be
adjusted,  since  it  uses  the  whole  range  of  coordinates  in  both planes.  The  advantage  is
that  the  selection in  Z  is  cleaner,  as  it  does  not  introduce  areas  or groups  of  unwanted
pixels that later have to be eliminated. 

Possible uses:

Although the  possibilities  of  these  selection tools  are  infinite,  thanks  to  the  possibility  of
combining them with other masks or effects in Mistika, perhaps the Depth Map effect  is its
most obvious use. Thanks to Spatial Key the workflow is very simple:

1- Selection mask

Import  the EXR clip and add the effect  Spatial Key. With  the  tool Pick Depth  choose
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the desired depth for our mask. Adjusting the parameters of the effect, we can adjust
the size and softness of the selection. The resulting mask is stored in Alpha.

2- Using the selection mask with Gaussian Blur effect

Next,  add  a  Blur  effect  and  configure  it  as  we  wish,  not  forgetting  to  to  set  the
parameter Mode as RGB-InA. This way, a selective blur effect  is applied based on the
mask done with the Spatial Key tool. 

Directional Light

Allows the selection of areas of reflection of the diffuse component of an image based on its
normals,  and  the  alteration of  these  position  in  order to  relight  a  scene.  This  information
must be included in the EXR file being used.

Parameters:

Layer Set

Sets  which  layer  the  effect  will  use  to  make  the  selection.  This  layer  is  set
automatically  using  the  tool  Pick  Direction  if  and  when  the  EXR  file  contains
information about the normals of the objects in the scene.

Tilt

Simulates the position of direct light as if it were a virtual sun.

RollZ

Allows the rotation of the zone of light  incidences around an object  in  the  Z-axis.  If
there are numerous objects in the scene, their shadows and light  incidences will  also
logically rotate. 
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Use and comments:

To be able to select the areas of light  sources of an image by means of the normals of the
objects  that  compose  it,  it  is  only  necessary  to  have  the  option  Pick  Direction,  in  the
Multilayer tab of the Visual Editor (found on the right  of the effect) active; then select  the
position of the light  incidence of a group of objects in the scene in the image in the Visual
Editor  (Evaluation Zone) to define its light  incidence. At  this time, in Layer, the name of a
layer  automatically  selected  by  Mistika  should  appear;  if  not,  the  user  must  select  one
manually. 

The most  obvious use of  this  tool is  the  possibility  of  re-lighting  a  scene,  and  completely
change the lighting information of the scene. For example, it  allows us to use the same 3D
environment at different times of the day, without  needing to carry out  different  renders in
the CGI program  from which the EXR comes.

Another use is the quick and easy selection of of light incidences in a 3D scene, allowing us
to calibrate the intensity of light and shadow with the Color Grade tool.  

Integration with Color Grade

The Spatial Key effect is especially useful in color correction as it  allows much more precise
selections than can be made with manual masks. As a result  of  this  Mistika  integrates  the
functionalities of Spatial Key in Color Grade, so that  the user does not  need to use Spatial
Key separately, and the selections made are imported automatically as External Keys to be
used as masks (see Color Grade for more information).

In  this  case,  the  parameters  of  each  of  the  selection  options  explained  above  can  be
viewed within  the  parameters  folder of  the  color vector on  which  we  wish  to  work.  The
automatic selection is done, however, via the Multilayer  tab of the Dashboard of the Visual
Editor. When using the effect  Spatial  Key  separately,  Mistika  opens  the  Visual Editor  with
the Multilayer tab already activated since it  the only one relevant  to this effect. However,
with Color Grade the default tab is that of the color correction panels, as the Multilayer  tab
is a secondary selection function. 

Thus, when we want to use the automatic selection tools of Spatial Key with Color Grade it
is only necessary to follow the following workflow: 

1- Import an EXR or Stereo3D clip.

2- Apply a Color Grade to it and in the Visual Editor, select the Multilayer tab. 

3- Use the automatic selection tools. 

4-  If  we wish to adjust  the mask, open the parameters folder of  the  chosen color vector,
and find the Multilayer subfolder. Depending on the tool used (Object  ID, Position, Depth or
Positional  Light),  we  will  have  to  open  different  options.  The  remaining  parameters  are
common to those already explained in Spatial Key.

Bear in mind that  when working in Color Grade, it  automatically imports the selection made
using  External  Key,  so  that  if  we  activate  the  Alpha  of  the  image,  we  cannot  see  the
selection;  for  this  reason,  we  should  activate  Highlight  in  the  color  vector.  Practical
examples of each of the selection option follow below:

Object ID
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Following this workflow,  we use the Pick Object ID tool in the Multilayer  tab and select  one
of the elements in the scene. Returning to the Grade tab and changing the Gamma, we can
see that  the selected object  automatically changes color. If  we  activate  Highlight  we  can
see the selection more clearly.

Position

In this second case, the automatic  selection is not  enough, so we have adjusted the mask
via the parameters in the Multilayer  folder of the vector in which we are working. Again, if
we activate the Highlight function we can see the selection more clearly.

Depth

This case is similar to the previous one, but  as explained  above,  the  depth selection does
not  take  into  account  the  X  and  Y  axes,  but  uses  the  full  range  of  objects  of  those
coordinates, so that  the intensity of the selection in those  axes  is  the  same.  Only  in  Z  is
there any alteration.

Directional Light

In  this  final  example  we  can  see  the  Highlight  in  the  selection  of  the  areas  of  light



478 FX

SGO Mistika 8.6 © 2018 SGO

incidence, and the color adjustment done in these areas. 

Alpha

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Alpha

The effects of the menu Alpha contain tools for manipulation of the channel alpha.

Note: the effects Grow, Shrink, Blur Alpha and ForeBlur  are not  documented here  as  they
are variations of eh effect Blur Filter.

Show

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Alpha->Show

More than an effect, ShowAlpha is a  tool that  changes  the  alpha  channel to  a  grayscale,
thus permitting working with this channel as if  it  were an ordinary  image.  In  this  way,  the
alpha channel of a clip can be separated so as to be able to use it  as an external mask of
another one for example, obtain the silhouette of a cutout  to be able to apply filters inside
it, use it as a displacement map, etc. In order to see examples of the use of this effect, see
the "Uses and Comments" of the ExternalKey effect.

Clear

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Alpha->Clear

The standard ClearKey is useful for preventing an  unnecessary mask from interfering in the
input of subsequent effects.

For example, there are some processes which need a mask in  order to  work,  although the
original mask is maintained intact in the output (HaloComp or Bump for example). This could
be a  problem if  rescaling  the  resulting  image  with  a  3DComp  is  required,  since  the  effect
respects the mask of the layer and composes it  on the background of the effect. To avoid
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this problem, add a ClearKey to the result of the process working with mask, and later apply
a 3DComp.

The standard  ExternalKey is limited to assigning (either normally or inverted) the luminance
of  the  second  input  as  the  alpha  channel  of  the  first.  Its  uses  are  diverse.  Since  this
standard is not a mask extractor, but  rather an assigner of masks, it  is useful for assigning
to an image a mask that has been previously extracted from a different  image, or to assign
any mask to an image to be able to work with effects that work based on the information of
the mask or that can limit their effect to within the mask, such as color correctors or spatial
filters.

In the example, the original image is seen, and then the mask assigned by this effect. The
mask was previously extracted from the small image that  accompanies  the  mask using  the
Greenscreen  effect,  and  later,  a   ShowAlpha  standard  shows  in  grey  scale  the  mask
generated, so that  the ExternalKey  standard  can reassign the  mask.  In  the  four following
images, different possible uses of this kind of assigning of external masks can be seen.

The first example simply composes the original image over a different  image using a external
mask, using the 3DComp effect.

The second example is the use of LiquidBump. In this effect, an alpha channel is obligatory
to function and generate relief or refraction at the edges of the mask, as well as to specify
an interior color and a projected shadow.

The  third  example  shows  the  addition  of  a  color  correction  with  the  InAlpha  activated,
restricting the correction to the area marked by the opacity of the mask. In this case, the
correction darkens the image within the mask.

The final example shows the use of the 3DComp effect  for composing  an image  on top  of
itself, whilst specifying a projected shadow via the parameters of the Shadow folder.

Invert

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Alpha->Invert

In  order to  simplify  certain  tasks,  InvertAlpha  has  been included  as  a  parameter  in  some
effects that are capable of assigning mask.

Remember that  Mistika assigns an opaque alpha channel to  the  images  without  a  mask by
default. Thus, if the image does not  have a mask, application of InvertAlpha will result  in a
completely transparent alpha channel.

This  process  is  especially  useful  for  making  the  alpha  channel  of  a  background  in  a
composition  transparent,  and  when a  ShowAlpha  is  added  on top  of  the  composition,  the
sum of the alpha channels of the composed layers will be seen as foreground. 

Three images are show in the following example. The first  has not  mask, so Mistika will add
an opaque value by default.
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If the images in this  example  were  composed  with  a  3DComp  effect  to  be  able  to  modify
their size and placement, the resulting mask would  be  white,  since  the  background  of  the
composition has an opaque mask assigned by default. 

To obtain the mask of the layers modified by the 3DComp effect, it  is  necessary  to  invert
the default mask of the background image.

Crop

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Crop

The menu Crop includes two tools for cropping the image.

Crop

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Crop->Crop

Resets the edges of the input to the four sides of the frame, applying an RGB color outside
the new limits, with a constant mask value. 

I/O

Inputs

Single input (with or without alpha information). 
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Inputs

Image: Cropped on four sides by the specified color value. 

Alpha: Mask cropped on four sides with the newly specified transparency value. 

Parameters

Modes:

Mode

[RGBA (RGBA / RGB / A)]

RGBA applies the effect in the RGB and alpha channels.

RGB applies the effect only in the RGB channel.

A applies the effect only in the alpha channel.

Crop:

Left

[0, (0 / 100)]

Left edge as a percentage of the image width. 

Right

[100 (0 / 100)]

Right edge as a percentage of the image width. 

Up

[100 (0 / 100)]

Top edge as a percentage of the image height. 

Down

[0 (0 / 100)] Bottom edge as a percentage of the image height. 

Color:

Red; Green; Blue

[0; 0; 0 (0 / 100)] 

Specifies the color to be applied from its new edges.
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Alpha

[0 (0 / 100)] 

Specifies the opacity level to be applied from its new edges.

Use and Comments

This  effect  is  useful for easy  redefinition  of  the  borders  of  a  layer,  although  this  effect
exists as a parameter in many mask extraction and composition effects, such as Bluescreen,
 Greenscreen and Comp3D. 

The redefinition of borders is useful in cases where undesired areas of the mask of  a  layer
are to be removed, produced, for example, by having undesired objects in the background,
or if the set does not fill the complete image. 

Another example is the removal of the black borders generated in some video formats by the
lack of signal from the mask, or when viewing the movie camera window. 

The  four  edges  can  be  specified  from the  Visual  Editor  by  using  the  crop  manipulators,
dragging them from their default position the original borders of the frame. The color can be
specified with the color Chooser, to use the effect for coloring an area of the frame. 

It is possible to apply tracking coordinates to each edge of Crop.

Crop Expand

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Crop->Crop Expand

Crops  the  input  alpha  channel on the  four sides  of  the  frame,  filling  the  discarded  image
area with an expansion of the color of the pixels in the new edge.

I/O

Inputs

Single input (with or without alpha information). 

Inputs

Image:  Cropped  on  four  sides  by  the  expansion  of  the  pixel  values  in  the  newly
specified edge. 
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Alpha: Mask cropped on four sides of the frame.

Parameters

Left

[0 (0 / 100)]

Left edge as a percentage of the image width. 

Right

[100 (0 / 100)]

Right edge as a percentage of the image width. 

Up

[100 (0 / 100)]

Top edge as a percentage of the image height.

Down

[0 (0 / 100)]

Bottom edge as a percentage of the image height.

Use and Comments

This effect  has a similar use to the  effect  Crop,  with  the  additional function of  expanding
the color of the pixels in the new edge.

Deform

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Deform

The effects that modify the forms of images.

Note: The effects Distort, Bump and LiquidBump, are not  documented here since they are
variations of the Refract effect.

Warper

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Deform->Warper

Permits the deformation of images with an advanced control based on a  wipe  that  can be
animated. 

This effect has two different typical uses: 
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Warping: complex deformation of an image. 

Morphing: complex transition based on a change of shape (metamorphosis). 

I/O

Inputs

Single input: Image with or without alpha channel for warping.

Double input: Images with or without alpha channel for morphing.

Inputs

Image: Warping or morphing of the images. 

Alpha: Warping or morphing of the masks.

Warper Editor

This effect has its own interface (Warper Editor) in which the deformation grid is controlled.
Access to the interface is in Mistika->Visual Editor->Dashboard->Warper.

To explain the functioning of this effect, the section of "Uses and Comments" has a simple
example of morphing between two fixed images of an apple and a pear.

The  interface  is  divided  into  four  areas:  Canvas,  Keyframe  Slider,  Quick  Access  and
Dashboard.

Canvas:

The Canvas is located in the upper part of the interface. It where the image to be deformed
is viewed and where the positions of the points that form the grid are defined.
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Inactive  Canvas  is  the  area  that  exceeds  the  image  resolution  for  which  the  system is
configured. Mesh points can be located in this area, although the result of the deforming will
not be seen, as it will exceed the  limit of the frame.

Meshes are made up of horizontal (Row) and vertical (Column) lines of a number defined by
the user.

The intersections of the lines define control points,  Mesh Points.  Each control point  has  a
definable  position  and  tangents  (Tangent)  for defining  angles  of  tension in  the  lines  that
meet.

The part of the mesh that delimits a rectangle joining four points is a Cell. Within each Cell,
a common polygonal subdivision is defined, allowing greater flexibility for distortions.

The polygonal subdivision is definable from the parameters of the effect, although it  is  not
visible  from the  manipulators.  However,  a  viewing  aid  is  available  which  shows  a  fixed
subdivision (Draw  Patches)  which is  useful for orienting  the  user in  the  polygons  within  a
Cell.  This  is  important  since  a  Cell  is  a  rectangle  which,  in  its  interior,  especially  when
editing tangents of a  Mesh Point, can contain polygons with an irregular distribution.

Keyframe Slider:

The Keyframe Slider  allows the addition of keyframes and specify their values according to
their position in time. In the case of animations, whether they are warping or morphing, at
least two keyframes are needed. in the case of a morphing, each source must  be animated
independently.

The  keyframes  that  the  mesh  contains  are  viewed  in  the  Keyframe  Slider.  To  move  a
keyframe, select it  with the mouse cursor  while holding down <Ctrl>. Its temporary value
within the effect thus changes.

If the effect Warper is to be used to carry out  a warping effect  (whether animated or not)
the interface  automatically  deactivates  Source,  viewing  and  control modes  in  the  Canvas
and  the  Dashboard.  If,  on  the  other  hand,  a  morphing  effect  is  to  be  carried  out,  the
Warper Editor works in two image modes: Source and Destination. Source keyframes will be
red triangles in the upper margin,  and  Destination  keyframes  will  be  green triangles  in  the
lower margin. In the whole interface, Source  is  identified  by  red  and  Destination  in  green.
The white diamond indicates the currently viewed frame.
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Quick Access:

Quick Access is an access bar for frequently used commands. It has two basic  functions for
controlling  viewing:  zoom and  playback.  There  is  also  the  button  Exit,  which  returns  the
user to Visual Editor.

Dashboard:

In  the  lower  area  is  the  Dashboard,  which  possesses  different  groups  of  functions,
described below:

Drag Mode

Activates and  deactivates  this  editing  mode  for editing  points.  This  mode  facilitates
the  location  of  mesh  points,  since  various  points  can  be  dragged  simultaneously,
according to the radius of influence defined.

Drag rad

Permits the definition of a value to the radius of a stroke for dragging the points of a
grid according to the direction of the stroke.

Source controls the origin position of the mesh.

Show Image

Shows the origin image in the Canvas, corresponding to the first input of the effect.

Show Mesh

Shows the origin mesh, in red. Both for warping and morphing, the shape of the origin
mesh must replicate the origin image.

Reset Key

Eliminates the modifications of position of the Mesh Points, returning the mesh to the
standard position.

Delete Key

Deletes the keyframe present in the current frame.

Bring Key

Pastes a copy of the position of the current  frame of the opposing source, creating a
keyframe.
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Clear All Keys 

Deletes all keyframes of the current source.

Bring All Keys

Pastes  a  copy  of  all  the  keyframes  of  the  opposing  source,  making  both  sources
identical. This function eliminates all previously established keyframes  of  Source,  and
so this action requires confirmation to be activated.

Destination controls the destination position of the mesh.

Show Image

Shows the destination image in the Canvas, corresponding to the second input  of the
effect. If the effect has only one input, Destination is viewed as first input.

Show Mesh

Shows  the  destination  mesh,  in  green.  In  cases  of  morphing,  the  shape  of  the
destination mesh must replicate the destination. In the case of warping, the shape of
the destination mesh is irrelevant.

Reset Key

Eliminates the modifications of position of the Mesh Points,  returning  the  mesh to  its
standard position.

Delete Key

Deletes the keyframe present in the current frame.

Bring Key

Pastes a copy of the position of the current  frame of the opposing source, creating a
keyframe.

Clear All Keys

Deletes all keyframes of the current source.

Bring All Keys

Pastes  a  copy  of  all  the  keyframes  of  the  opposing  source,  making  both  sources
identical. This function eliminates all  previously  established  keyframes  of  Destination,
and so this action requires confirmation to be activated.

If  both  buttons  of  Show  Image  are  active,  the  result  of  the  effect  in  the  current
frame is shown, indicated by the slider.

If both buttons of Show Mesh are active, the result  of the interpolation of  the  mesh
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between Source and Destination is shown, as a blue mesh.

Note:  there  is  no  function  that  allows  the  copying  of  a  keyframe  of  the  mesh  to
another position in time in the same source. However, there is a trick for achieving the
same result via Bring Key:

Copy the keyframe to the other source (Bring Key)

Move the copied keyframe to the new destination position.

Use  Bring  Key   again  in  the  other direction to  bring  the  keyframe  to  the  previous
source, and then delete the intermediate copy.

View controls the viewing of components of the mesh.

Draw Points

Activates the viewing of control points of the mesh.

Draw Lines

Activates the viewing of mesh lines.

Draw Thicker

Activates the viewing of a black frame round the lines of the mesh,  to  make  viewing
easier.

Draw Tang

Activates the viewing of the tangents of the control points of the mesh.

Draw Patches

Activates the viewing of an orientative subdivision of the cells of a mesh.

Dim Other

Makes the viewing of the unselected part  of  the  mesh semitransparent,  thus  helping
concentrate attention on the points being edited.

Undim All

Undoes Dim Other, making the viewing of the whole mesh opaque.
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The Edit functions modify parts of the mesh.

Select All

Selects all Mesh Points of the visible mesh.

Select Row

Selects other points in the horizontal line that pertain to the selected points.

Select Column

Selects other points in the vertical line that pertain to the selected points.

Add Line

Duplicates  the  selected  line.  After clicking  this  button,  the  position  of  the  new  line
must  be defined by clicking in another part  of the mesh. The temporary  state  of  the
line without a defined final position is shown in white, for ease of identification among
the lines of the mesh.

Delete Line

Deletes the selected line of the mesh.

Reset Tang

Resets the default values of the tangents of the selected points. The edited tangents
are yellow, while those with default values are the same color as the mesh.

Key has two buttons.

Auto Fix

Automatically adds a keyframe in the Node Graph each time a modification in the grid
of the Canvas is done.

Add Key

Manually adds a keyframe in the current frame.

File has three buttons.

Save Mesh

Saves the source position that  is viewed as a grid, making possible the future of this
in other  Warper effects.

Load Mesh

Loads one source position of the grid.
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New Mesh

Defines  a  new  grid,  defining  the  subdivision of  the  frame  by  number of  vertical  and
horizontal cells.

Note: the extension of the grid file is .msh. The grid files are deposited in the OUTPUT folder
of the current project.

Parameters

Grade

[0 (0 / 100)]

Evolution of the interpolation of the mesh position sources.

A value of 0 indicates  the  Source  position;  a  value  of  100 indicates  the  Destination
position.

Mix

[0 (0 / 100)]

Evolution of the mixing of distorted inputs. 

A value of 0 indicates the image of the first  input; a value of 100 indicates the image
of the second input. If there is no second input, this parameter will be ignored.

Subdiv

[10 (0 / 128)]

Polygonal subdivision of the mesh cells.

Dir

[0 (0 / 1)]

Reverses  the  direction  of  the  mesh  position  sources,  interchanging  Source  and
Destination.

Use and Comments

This  effect  has  two  typical  uses:  transformation  between  two  images  for  a  transition  (
morphing) or distortion of an image (warping), which can have multiple uses.

Warping  can be  used  to  distort  an image  arbitrarily,  and  we  recommend the  use  of  Drag
mode in the additional interface in this case.

It is also the ideal tool for correcting perspectives. To do this, only a few mesh lines should
be used, in order to match the image escape lines with the Source, and then correct  them.
In this case, we recommend aligning the Source Mesh Points in the inactive area (outside of
the image), thus making it possible for a few lines to control the perspective of the image to
be corrected. 

This tool is ideal when it  is necessary to distort  a texture to cover a figure in an image, as
Source  can be  specified  as  a  flat  mesh,  and  Destination  as  the  shape  of  the  figure,  and
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thus give texture to the desired figure. A typical example of this is the replacement  in post-
production of the label of a cylindrical container, such as a  bottle.  Other effects,  such as
CornerPin, cannot distort the image adequately, since they do not  have control points with
tangents. 

Another common use, whether for warping or morphing, is the joining of cuts from different
takes to produce a single longer sequence, when it is not possible to shoot as a single shot.
An example might be a shot that appears to enter from outside a window to inside in single
take without cuts. 

To  explain  a  simple  method  of  creation  of  Morphing,  a  basic  example  of  transformation
between static images of an apple and a pear will be used. 

Start by selecting a viewing mode of the Source image and the Source mesh. 

Next, specify a new subdivision of the mesh with the number of cells. 

Pressing the New Mesh button will cause a dialog to appear, in which subdivisions in X and Y
will each be specified to have a value of 1.

To add horizontal and vertical lines, it is recommendable to duplicate those already created.
To do this, use the commands Select Row and Select  Column or select  an area by dragging
the mouse. Once selected, the lines can be duplicated via the command Add Line. By means
of this method, we can locate the lines in the best  places in order to wrap the image with
them.

To carry out  this adjustment, it  will be necessary to move the Mesh Points to locate them
on the  shape  of  the  figure  and  fix the  points  of  the  interior  of  the  figure  simulating  the
image's volume.  To  do  this,  it  is  best  to  edit  the  tangents  of  the  points,  activating  their
visualization via the command Show Tangents.
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The mesh should cover the image, simulating the parallels and meridians of a globe.

Once the mesh has been situated in Source, select  the image  and  mesh view  Destination.
Then bring the shape of the opposite mesh with Bring Key.

If the grid is not very visible, its black border can be activated with Show Thicker.

Once  the  opposing  mesh  is  obtained,  the  mesh  points  of  the  target  image  should  be
readjusted. In this example, the shape of the apple can be seen superimposed on the image
of the pear. 

When adjusting the points, try to reassign their positions to more coherent  places that  can
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be considered of similar meaning.  For example,  the  points  that  surrounded  the  apple  stalk
should be placed around the pear stalk, the points of the apple outline in the pear outline,
and the interior points in such a way as to resemble the shape of the pear.

The mesh is correctly placed on the image target. But  the polygonal subdivision in each cell
is poorly distributed, so that it does not correspond to the image volume. 

Show Patches should be activated as a viewing guide for the adjustment  of  the  interior of
each cell. Then adjust the tension of the tangents to improve the distribution of the patch. 

This same should also be done with the Source mesh. 

When the tensions of the tangents have been adjusted, the functioning  of  the  effect  can
be checked. 

To do this, the view of both images should be activated, and the current  frame then moved
with the slider. 

If  there  are  anomalies,  the  mesh  can  be  adjusted  by  viewing  the  average  degree  of
interpolation. This is very useful for interactively viewing  the  changes  in  the  mesh caused
by interpolation of the effect, especially to adjust  the points that  are in the outlines of the
figures. Bear in  mind  that  in  order not  to  create  unwanted  keyframes,  the  Auto  Fix mode
should be turned off, thus making  sure  that  all  the  changes  will  be  applied  to  the  original
mesh in the first frame.
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To adjust  the internal points of the figure, it  is very  useful to  be  able  to  see  the  warping
that is produced in each image separately. To see the warping of a single image, the value
of the Grade parameter should be reset. 

This  way  we  can view  how  the  texture  is  adjusted  in  the  deformations  produced  by  the
effect. To adjust the texture, its tangents should be used. 

The end result  of the effect  is, in sum, two contrary deformations that  are mixed together
with a fade.

The progress of the fade is set in the Mix parameter, and the evolution of the deformation is
set via the Grade parameter. 

We  recommend experimenting  with  these  parameters  (accelerating  and  decelerating  their
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curves) since when the fade is less visible, the impression of metamorphosis of the effect  is
better. 

The invert  parameter is recommended to return to a previous warp. For example, if  a copy
of the same Warper is placed on top  of  the  warping  made,  but  with  the  invert  parameter
with a value of 1, the deformation will be reversed, since it will be applied inversely. 

The higher the value of the subdiv parameter, the better the deformation will react  to  the
tension and angle of the tangents. Subdiv does not specify a global polygonal subdivision for
the whole image,  but  only  for the  internal subdivision of  the  cell,  and  for this  reason the
number and size of the mesh cells should be borne in mind. 

Subdivision with excessive values  can slow  the  render time,  and  we  recommend adjusting
the parameter unit by unit, and always viewing the image result. After a certain value it  will
be  seen that  more  subdivision does  not  improve  the  quality  of  the  deformation,  and  this
subdivision threshold gives the optimum value.

For standard resolutions, a good generic  value is 10, whereas for high definition a value  of
25 is generally recommended. 

In cases where the inputs of the effect  are images in movement, the position of the points
of the mesh should be adjusted in each frame, generating keyframes both in source and in
destination. 

This the reason that  morphing between images  in  movement  is  much more  complicated  to
configure than morphing between static images. 

Refract

Ref.  Mistika:  Node  Graph  Editor->Dashboard->Fx->Mistika->Deform->Refract
(Relief)

The  parameter Refract  generates  a  distortion  in  the  image  via  the  interpretation  of  the
borders of a refraction map, resulting in an effect to refraction. 

I/O

Inputs

Single  input:  Image  with  alpha  channel.  The  alpha  channel will  be  used  as  a  relief
map.

Double  input:  The  first  input  (with  or  without  alpha  channel)  is  the  image  to  be
distorted,  and  the  second  input  is  the  relief  map.  Thus  the  alpha  channel  of  the
second input is preserved, 

Inputs

Image: Distorted image.

Alpha: No change, or eroded by refraction, as specified in RebuildK parameter.
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Parameters

DisplaceMap:

Folder containing the parameters that specify the sense of height of the effect.

Blur

 [1 (0 / 100.000)]

Blurs the distortion map before  being  applied.  The  result  of  this  blurring  reduces  the
details of the refraction and magnifies the edges of the relief.

ClampLo

 [0 (0 / 100)]

Lower limit of the generated relief. Visually, this means a threshold is created, giving a
sensation of lifting slightly from the relief.

ClampHi

 [100 (0 / 100)]

Upper limit  of the generated relief. Visually, this means  a  cut  that  creates  a  plateau
sensation.

Amplitud

 [100 (-100.000 / 100.000)]

Specifies  the  simulated  height  of  the  relief  effect.  This  means,  visually,  a  greater
contrast  of light  and shadow affecting the edges created by the distortion map,  and
also the amount of refraction generated.

Liquid

 [Off (Off/On)]

Activates a liquid-style refraction mode. Visually,  this  means  a  feedback of  specified
refraction.

RebuildK

 [Off (Off/On)]

Specifies  that  the   alpha  channel  of  the  out  put  of  the  effect  is  placed  in  the
refraction map modified by the same erosion as the generated refraction.
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Mode:

Folder that contains the parameters that specify the render mode of the effect.

Mode

[Hware (Hware/Sware)]

Specifies the processing mode (hardware graphic or just software).

Distort:

Folder that contains the parameters that specify the applied refraction.

DirX ; Y

[0;0 (-100.000 / 100.000)]

Amount of horizontal and vertical distortion.

Zero

[50 (-100.000 / 100.000)]

Distortion map value that specifies X and  Y without distortion.

Refract

[0 (-100.000 / 100.000)]

Amount  of  refraction  applied  (visible  at  the  edges  of  the  relief).  To  make  these
borders bigger, increase the Blur parameter) 

Angle

[0 (-100.000 / 100.000)]

Specifies a rotation angle  for the interior of the refraction.

Antialias

[x1 (x1, x2, x3, x4, x8, x15, x24, x66)]

Number  of  sample  for  the  refraction  effect.  High  values  specify  greater  quality
samples, noticeably improving the resulting image quality, visible in the details.

Ambient:

Folder that contains the parameters that specify ambient light.

Intensity

[100 (0 / 100.000)]

Intensity of the ambient light.
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Red

[100 (0 / 100.000)]

Defines the value in the red channel of the ambient light.

Green

[100 (0 / 100.000)]

Defines the value in the green channel of the ambient light.

Blue

[100 (0 / 100.000)]

Defines the value in the blue channel of the ambient light.

Diffuse:

Folder that  contains the parameters that  specify the appearance of the lighting  generated
by the effect .

OffsetX

[26,430 (-100.000 / 100.000)]

Position of the virtual light  of the effect. This parameter can be  defined  with  the  2D
manipulation mode.

OffsetY

[73,570 (-100.000 / 100.000)]

Position of the virtual light  of the effect. This parameter can be  defined  with  the  2D
manipulation mode.

Intensity

[0 (0 / 100.000)]

Intensity of the virtual light of the effect.

Red

[100; 100; 100 (0 / 100.000)]

Defines the value in the red channel of the ambient light.

Green

[100; 100; 100 (0 / 100.000)]

Defines the value in the green channel of the ambient light.



499FX

SGO Mistika 8.6 © 2018 SGO

Blue

[100; 100; 100 (0 / 100.000)]

Defines the value in the blue channel of the ambient light.

Specular:

Folder that contains the parameters that specify the specularity of the processed image. 

Gloss

[24 (24 / 100.000)]

Specifies the gloss the processed image. 

The  higher this  value,  the  more  the  intensity  of  the  gloss  produced  by  the  virtual
lights will be concentrated.

Intensity

[0 (0 / 100.000)]

Intensity of the specularity of the processed image.  The  higher this  value,  the  more
the brightness produced by the virtual lights will be reflected. 

Red

[100 (0 / 100.000)]

Defines the value in the red channel of the color of the specularity of  the  processed
image. This parameter colors the brightness produced by the virtual light.

Green

[100 (0 / 100.000)]

Defines the value in the green channel of the color of the specularity of the processed
image. This parameter colors the brightness produced by the virtual light.

Blue

[100 (0 / 100.000)]

Defines the value in the blue channel of the color of the specularity of the processed
image. This parameter colors the brightness produced by the virtual light.
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Image:

Folder containing the parameters that  transform the  image  before  being  processed  by  the
other parameters of the effect.

Zoom

[100 (-100.000 / 100.000)]

Amount of zoom of the image.

Anamorp

[0 (-100 / 100)]

Defines the anamorphic aspect of the applied effect.

The default  value indicates that  the filter will act  symmetrically between the  vertical
and  horizontal  axis.  Positive  values  restrict  the  action  of  effect  the  vertical  axis
gradually, while negative values restrict it to the horizontal. 

OffsetX

[0 (-100.000 / 100.000)]

Amount of  horizontal offset applied to the original image.

OffsetY

[0 (-100.000 / 100.000)]

Amount of vertical offset applied to the original image.

Perspective:

This attribute is applicable to stereoscopic images. 

InterOcular

[0.2 (0 / 100.000)]

Modifies  the  values  of  the  interaxial  separation  of  the  distortion  applied  to  the
stereoscopic  image.  The  higher  the  InterOcular  value,  the  more  exaggerated  the
stereoscopic effect will be.

Use and Comments

This effect is accessed via the effect buttons Refract, Distort, Bump and  LiquidBump. 

This effect has many possible applications, such as to simulate refraction or reflection. The
refraction map,  in  contrast  to   distortion  or  other  maps,  is  interpreted  according  to  the
detected edges of the image, and not the luminance values of its pixels, so the color of the
image is also taken into account. A solid color as  a  distortion map produces  no  distortion,
whatever  the  color,  since  it  is  the  contrast  between  the  pixels  that  is  evaluated  in
refraction map.
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The results of this effect can also be combined with other effects to simulate reflection, for
example.

This effect is very useful for creating metallic materials for logos etc.

This  effect  is  also  useful  for  distorting  reflections  or  shadows  added  to  a  composition,
copying the relief onto which they are projected

In this example, it can be seen how the Refract effect can be useful in copying the relief of
a background (even in movement)  and applying the distortion for the shadow projected to
integrate  the  character onto  the  new  background.  in  this  example,  the  same  background
image is used as both refraction map and shadow mask.



502 FX

SGO Mistika 8.6 © 2018 SGO

The effect can also be used to copy the relief of surfaces where it  is necessary to apply a
reflection.  In  this  example,  it  is  necessary  to  add  a  reflection  of  a  composed  character,
since the wet ground reflects people walking on it, as can be seen in the background shot.
This reflection must  be  distorted  to  match the  roughness  of  the  ground.  In  this  example,
the same background image is used for the refraction map of the reflection.

The DirX; Y  parameters  distort  an image  using  a  distortion map horizontally  and  vertically
independent. 

Following the luminance of the pixels of the distortion map image, the pixels of the distorted
image are moved horizontally or vertically, as defined in the parameters of the effect.

This allows it to be used, for example, to distort projected shadows or reflections that  need
to copy the visible roughness of a surface, such as water, floors, leaves etc.

Although the parameter Refract can achieve a similar result  (and sometimes better), Distort
also has a different distortion map for each axis. 
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In  this  example  we  see  the  usefulness  of  the  distortion  parameter  DirX,  working  just
horizontally. The distortion map that is used simulates the split  focus ring of a stills camera
viewfinder. If the parameter OffsetX is animated between positive and negative values, we
see that the image distorts as if through a stills camera lens being focussed.

The distortion map has a mid-grey  background,  which will  not  distort  the  image  since  the
Zero parameters of the effect are at 50, while the black distorts in a direction the opposite
to white.

This  effect  is  also  generally  useful  for  assigning  a  material  to  a  layer,  for  example  text
generated with the effect Title or a logo.

This effect can later be composed thanks to the fact  that  the deformations of the edge of
the layer are also reflected in the alpha output channel, via the parameter RebuildK.

By  properly  controlling  the  parameter Refract,  materials  similar to  water or glass   can  be
simulated, and with negative values, metal or mirrors can be simulated.

This effect is also generally used for adding relief to the edges of a layer, for example text
generated with the effect Title or a logo.
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In this example, the alpha channel assigned to the image functions as a distortion and relief
map.

Negative values invert the direction of the relief. By controlling the height  of the relief with
the parameters ClampLo and ClampHi, it  is possible to create bevelled edges. Because  the
alpha channel is conserved intact in the output  of the effect, it  is possible to compose the
processed layer over other images.

Twirl

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Deform->Twirl

Creates a spiral-shaped distortion based on a definable center.

I/O

Inputs

Single input: Image with or without mask.

Inputs

Image: Distorted image.

Alpha: Distorted mask.

Parameters

Twirl:

Ang

[0 (-100.000 / 1.000.000)] 

Spiral distortion angle.

NRad

[50 (-100.000 / 1.000.000)]

Specifies the value of the radius between the center of the spiral and its first  torsion
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ring. When this parameter is animated, the spiral created by the effect rotates.

Move X; Y

[50; 50 (-100.000 / 1.000.000)]

Center of the spiral as a percentage of the image. 

Zoom

[100 (-100.000 / 1.000.000)]

Scale of the result of the effect.

Offset:

Folder containing two-dimensional image repositioning parameters.

Shift X; Y

[0; 0 (-100.000 / 1.000.000)]

Offset of the original position of the image on the spiral distortion. 

Use and Comments

This effect is useful for making fast and simple deformations of images.

For more complex deformations, we recommend using the Warper effect. 

Thanks to the spiral deformation of the effect, it  is  possible  to  create  spirals  that  can be
animated,  based  on distorting  a  simple  mesh that  divides  the  image  into  black  and  white
halves. 

In  these  examples,  the  NRad  parameter acts  on the  rotation of  the  spiral.  In  the  "Spiral"
example, the rotation of the spiral will produce a psychedelic  effect  as  a  result.  A  part  of
the periphery of the spiral can be  seen in  the  "Waves" example,  and  when the  parameter
NRad is animated, the waves will be seen to advance as a result. 

This  effect  can  be  used  as  an  interesting  deformation  for  application  to  any  mesh;  for
example, curving stripes. 
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Another powerful effect for generating waves is the effect Wave.

Kaleido

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Deform->Kaleido

Generates a kaleidoscopic effect in the image, cutting it into reflective triangles.

I/O

Inputs

Single input: An image with or without mask. 

Inputs

Image: Image with kaleidoscopic effect. 

Alpha: Mask with kaleidoscopic effect. 

Parameters

Angle

[0 (0 / 100.000)] 

Specifies a rotation angle for the kaleidoscope triangles.

Size

[20 (1 / 100)] 

Size of the kaleidoscope triangles.

Use and Comments

The purpose of this effect is simply to simulate a rotating triangular kaleidoscope.
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Image

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Image

Amongst  others  effects,  this  menu  includes  tools  relating  to  Optical  Flow  (Motion
Estimation)  technology,  such  as  the  modification  of  playback  speed  of  a  sequence  or
restoring  an image.

It also includes tools for drawing on an image or generating vectorial masks and adding grain
in the style of film.

Note: the effects Grow and Shrink are not  documented here,  since  they  are  variations  of
the Blur effect.

VectorPaint

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->VectorPaint

This effect permits freehand drawing or by using shapes and rotoscopes, including different
brushes, based on vectors that  can be animated. It  can be  used  in  many  types  of  tasks,
such as: 

Freehand painting with brushes or geometric shapes.

Manual restoration of images, using Repair Mode (Motion Estimation) and with brushes such
as Clone and Reveal.

Creating masks, manually frame by frame or with the assistance of tracking tools. 

Manual composition of parts of an image on another.

I/O

Inputs

Single input: Image with or without alpha channel.

Double input: Images with or without alpha channel for composing.
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Inputs

Image: Image with specified vectorial drawing (at 16 bits per channel color depth).

Alpha: Mask with specified vectorial drawing.

Parameters

These parameters simply possess the coordinates for the position of tracker animation.

PosX; PosY

[50; 50 (-10.000 / 10.000)]

Two-dimensional  coordinates  that  can  be  pasted  to  the  vectorial  shapes  that  the
effect has.

Paint Editor

Ref. Mistika: Visual Editor->Dashboard->Paint

Paint  is the extra interface of Vectorpaint  in which vectorial  shapes  are  drawn.  Access  to
the interface is in Mistika->Visual Editor->Dashboard->Paint.

The  use  of  vectors  for painting  on the  image  and  the  alpha  channel  maintain  intact  the
original source files, allowing a non-destructive functioning.  The vectorial information of the
brushstrokes  is  stored  as  data,  thus  avoiding  the  modification  of  the  original  or  the
obligatory creation of a new file.

Thus the  brushstrokes  pertain  to  the  clip  of  the  effect,  and  can be  applied  to  any  other
clip, moving or copying this effect in the Node Graph Editor.

To illustrate the normal functioning of this effect, an image of a face on a red  background
will be used as input. In the examples where the image mask is seen, a mask extracted by
the  selection of  the  red  background  is  used.  In  examples  where  a  second  input  is  seen,
noise generated by the Noise effect is used as the background.

The Paint  interface is divided  into  four areas:  Canvas,  Quick Access,  Keyframe  Slider  and
Dashboard.
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Canvas:

The Canvas is located in the upper part  of  the  interface.  It  is  where  the  image  is  viewed
and where the positions of the vectors are defined.

Keyframe Slider:

The  Keyframe  Slider  allows  the  addition  of  keyframes  and  the  specifying  of  their  values
according to their positioning in time. In the case of an animation, at  least  two  keyframes
are necessary.

In  this  frames  grid,  the  keyframes  added  to  the  selected  shape  can  be  seen  as  green
triangles. These keyframes can be moved in time, thus redefining their temporal value. The
white  triangle  indicates  the  current  frame  within  the  ruler.  The  grey  box  of  the  white
triangle indicates the current  frame. To move a keyframe, select  it  with  the  mouse  cursor
while holding down  <Ctrl>. This changes its temporal value within the effect.

The Position Box  allows the user to jump directly to the desired frame by the  introduction
of the corresponding value.
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Fields activates the vector draw mode by fields for interlaced images. Each field of a frame
can have different vectors. Interpolation of the vectorial animations is also done with fields.
 

This mode should be specified before beginning to draw on the image, since any subsequent
change  of  mode  can  provoke  temporary  disorder  in  the  location  of  the  vectors  already
generated.

The Back button returns the user to the Visual Editor.

Quick Access:

Quick Access is an access bar to frequently used commands.

Hide

Gives  the  option  of  hiding  the  Dashboard  for  better  viewing  and  working  on  the
Canvas, once the tool and its parameters are selected.

Zoom In; Zoom Out; Zoom Center;  Zoom Reset

Modifies the viewing size of the  Canvas.  They  also  control the  zoom via  the  central
mouse wheel.

Go to Header

Establishes the first frame of the effect as a new position.

Prev K

Establishes  the  frame  immediately  prior  to  the  current  one  containing  a  defined
keyframe as a new position.

Prev F

Establishes the frame immediately prior to the current one as a new position.

Play F / Stop

Controls the frame to frame playback of the effect.

Next F

Establishes the frame immediately after the current one as a new position.
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Next K

Establishes  the  frame  immediately  after   the  current  one  containing  a  defined
keyframe as a new position.

Go to Tail

Establishes the last frame of the effect as a new position.

Dashboard:

The Dashboard operates in  the  modes  Paint,  Text  and  Setup,  which can be  accessed  via
their corresponding Options Tabs.

The submode Paint  Editor  works  with  three  principal modes  (Paint,  Select  and  Transform)
whose activation displays or hides specific command groups.

View

Image activates viewing of the input image of the effect.

Alpha activates viewing of the alpha channel of the effect.

When  Image  is  also  active,  the  alpha  channel  is  superimposed  on  the  image  in  a
definable color (blue by default).

The value box Display controls the opacity of the mask superimposed ion the image.

Image

Mix Frames activates mixed viewing, useful for comparing two images while working on
the effect.
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FG sets the image to be mixed in the viewing of the original image as the  foreground
(or the second input if there is one). 

If BG is active, the mixed image is the background (first input).

The Mix values box controls the mix level between the original image original and  the
image specified to be mixed.

The  Offset  values  box  indicates  the  number  of  frames  of  temporary  offset  for  the
image specified to be mixed.

Alpha

The command Clear alpha eliminates any mask that the input may possess, replacing it
with a transparent  mask. Once the original mask original of  the  input  is  eliminated,  a
new mask can be drawn.

The mode Composite is used so that  the effect  functions like a composition effect  in
both its inputs at the same time. Thus, this mode is ignored if  the effect  has only one
input.

This mode is recommended in cases where it is necessary to create masks of an image
but  view the result  of the composition, allowing the user to paint  interactively in  the
alpha channel while viewing the final composition.
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Color

Pick Color allows the defining of a paint color by copying the color of an image's pixel,
selected by clicking this button.

Above this button a box shows the current color.

Pick Alpha  allows  the  defining  of  the  alpha  channel level for the  paint  by  copying  a
pixel value from the selected mask.

Above  this  button a  box shows  the  current  level,  representing  a  transparency  over
black of the defined color for tinting the viewing of mask.

The  sliders  and  buttons  of  the  Color  Chooser  define  the  paint  color.  The  tabs
represent  available  palettes:  RGB,  HSL,  Color  Wheel (Hex)  and  a  library  of  definable
colors (Lib). It  is also possible to change the viewing  mode  by  activating  the  button
WYSWYG. The button Pick Color  of the Color Chooser, unlike the button Pick Color at
the head of the group, works when holding the mouse button until the cursor is over
the chosen color and then releasing it.

Apply

This group allows the defining of which vectorials or shapes  are  to  be  applied  in  the
image  channels  (Apply  Image),  in  the  alpha  channel  (Apply  Alfa)  or  in  both.  The
Pressure box defines the level of opacity of the brush. The box Level defines the level
of opacity of the brush applied in the alpha channel.

Stencil

The  Obey  button  specifies  that  the  paint  applied  to  the  image  only  affects  the
transparent areas of the alpha channel, protecting the opaque areas of the same from
being painted. In other words, it activates the use of the alpha channel as a mask.
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Brush

The  size  of  the  brush  is  defined  from  the  values  box  Brush  Size  or  by  pressing
<Ctrl>+<Shift> with the mouse cursor over the image (only when the Paint  mode is
set as brush).

The default  command Soft  activates  a  brush with  soft  edges.  If  the  button Hard  is
active, the brush will have hard edges.

The default brush is Paint.

Paint  paints  on the  image  with  the  color specified  in  the  Color  Chooser  and  on  the
alpha channel with the level specified in the box Level (Alpha) of the group Apply.

Tint  paints by modifying the hue and saturation of the  image  according  to  the  value
specified in the Color Chooser, ignoring the brightness of the selected color.

Tint is not applicable to the mask.

Lighten lifts the brightness of the colors of the image without  bleaching them, ignoring
the value specified in the Color Chooser.

In this mode the value specified in the Pressure box alters the intensity of brightness.

Lighten is not applicable to the mask.
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Darken  darkens  the  brightness  of  the  image  by  half  with  each brushstroke,  ignoring
the value specified in the Color Chooser. Unlike painting in black paint  with Paint, the
same brushstroke cannot accumulate the effect of repeated strokes.

Darken is not applicable to the mask. 

Drag pushes the pixels of the image and  the  mask in  the  direction brushstroke,  with
the force equivalent to the speed of the brushstroke.

In  this  mode  the  value  specified  in  In  this  mode  the  value  specified  Pressure  box
scales the force of the stroke Pressure box scales the force of the stroke.

Extend  paints  on the  image  and  mask with  the  color and  level of  mask of  the  pixel
where  the  stroke  begins,  ignoring  the  value  specified  in  the  Color  Chooser  and  the
Level (Alpha) box of the group Apply.

Blur gently blurs the pixels of the image and mask.

In this mode, the value specified in the Pressure box scales the force of the blurring.

Reveal Fore  paints  on  the  original  image,  reverting  the  actions  of  other  strokes  in
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other modes. If the effect has two inputs, Reveal Fore specifies that  it  will paint  with
the first input.

Reveal Back is a brush designed to work with two inputs. In this case, Reveal Back will
paint by composing the background (first input) over the foreground (second input). If
the effect has only one input, Reveal Back behaves identically to Reveal Fore.

Clone Fore paints with an offset copy of the original image. To select  the origin of the
offset,  select  one  point  of  the  image  while  holding  down  <Alt>.  Then  choose  the
destination of the offset by drawing directly on the image.

If VectorPaint has two inputs, Clone Back will copy the background (first input) on the
foreground  (second  input).  If  the  effect  has  only  one  input,  Clone  Back  behaves
identically to Clone Fore.

Distort  applies  a  distortion in  the  image  and  mask according  to  the  direction of  the
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stroke, with the size of the brush being the limit of the action. In this mode, the brush
is  viewed  mush  larger  than  the  defined  size.  The  speed  of  the  stroke  defines  the
amount of distortion applied.

In  this  mode  the  value  specified  in  the  Pressure  box is  ignored,  as  the  size  of  the
brush is more important.

Repair  with  virtual  Frame  is  an  image  restoration  mode.  The  brush  uses  motion
estimation  techniques  to  reconstruct  the  areas  where  it  is  applied.  Thus,  when
drawing on damaged areas of a frame, tracking of the same pixels in the previous and
subsequent frames is carried out without taking the current frame into account, which
normally permits the reconstruction of the area below the brush. This mode  can only
work if there is only one input in VectorPaint.

Mode

The work mode of the interface is defined with Mode.

Brush activates the creation of brushstrokes on the image. In this mode, the vectors
are hidden.

Select  activates  the  mode  allows  the  selection  of  vectors,  showing  the  points  and
vectorial lines that make up shapes and brushstrokes.

Transform activates the vectorial shape manipulator once it has been selected.
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This manipulator is a rectangular box with small square manipulators in its corners and
midpoints of each side. When the side manipulators are pressed, rescaling in the  axis
dividing the square is activated.

When  the  corner  manipulators   are  pressed,  rescaling  of  the  selected  shapes  is
activated.  To  rotate  a  shape,  click  on  any  manipulator  while  holding  <Alt>  at  the
same time to set the angle of rotation.

When  clicking  inside  the  manipulator  without  touching  the  small  squares  or  the
keyboard, the manipulator will move the selected shapes.

Undo/Redo

Undo Point undoes the creation of the last generated vectorial point.

Redo Point redoes the last vectorial point undone by Undo.

Last Shape undoes the creation of the last  generated vectorial shape.

Grid

Snap activates the mesh magnet.  When moving  a  shape,  the  only  possible  positions
will be the mesh intersections, and drawing will only be possible along the mesh lines.

Creation

Rectangle specifies the creation of rectangles. If regular rectangles are required, hold
<Shift> while defining the rectangle.

Circle  specifies  the  creation of  circles.  If  regular  circles  are  required,  hold  <Shift>
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while defining the circle.

Poly Line specifies the creation of  polygonal shapes  by  means  of  control points  that
are set with each click on the image.

Curve Line specifies the creation of rounded shapes by means  of  Bezier-type  control
points created with each click on the image.

Modify

Insert  inserts control points in any vectorial line.

Add continues adding points after the last  point  created, thus modifying the selected
shape.

Type of points

Sharp  eliminates  the  tangents  of  the  selected  control  points.  When  dealing  with  a
shape, it will become a polygon.

If Smooth is active the shape or line created will be formed by B-Splines. As there is
less control of the tangents than the Bezier-type splines, manipulation and work with
B-Splines is easier. Furthermore, the  precision of  B-Splines  is  usually  sufficient  when
adjusting a shape.

If Connected Tang is active the shape or line created will be created with Bezier-type
splines whose nodes can be modified together.

If Independent  Tang is active the  shape  or line  created  will  be  created  with  Bezier-
type splines whose nodes can be modified independently.

Edit shapes

Cut moves the selected vectorial shape to the clipboard.

Copy makes a copy of the selected vectorial shape on the clipboard.

Paste pastes a copy of the  selected  vectorial  shape  on the  clipboard  in  the  current
frame.

Del deletes the selected vector.

Shape attributes

Close closes the selected vectorial  shape, joining its first and last points with a line.

Fill fills in closed vectorial shape. When Fill is active, the vector ignores the size of the
brushstroke, since the vector is only used only to limit  the  shape,  in  the  paint  mode
possessed by the vector.

Shadow  creates  a  shadow  by  duplicating  the  result  of  the  vectorial  shape,  and
assigning color opacity and offset values.

Soft activates a pair of tangents (called Radials) in each control point  of the selected
shape, which define a gradient  of opacity towards the inside or outside of the shape,
commonly known asSoftness. 
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Softness

These  two  boxes  allow  the  setting  of  the  gradient  value  for  opacity.  Softness  has
both an interior and exterior limit, which are viewed as cyan-colored lines that  join the
ends of the radial tangents. 

The radial tangents can be edited like any tangent and also via the manipulators Width
and Offset.

Width is a Knob-style box which when dragged  sideways  increases  or decreases  the
length  of  the  radial  tangents  of  the  selected  control  points,  proportionally  to  the
internal and external radials. This allows the level of Softness to be set easily.

Offset  is a Knob-style box which when dragged sideways increases  or decreases  the
length  of  the  radial  tangents  of  the  selected  control  points,  inversely  proportional
between the internal and external radials. This button allows the internal and external
offset of Softness to be set easily.

Shadow attributes

Offset X and Offset Y define the offset of the generated.
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Opacity defines the opacity of the shadow as a percentage.

Select shapes

Current frames selects all the shapes found in the current frame.

All Frames selects all the shapes found in all the frames of the effect.

File

Load opens a dialog box for loading a vectorial shape into the effect .

Save opens a dialog box for saving the selected vectorial shape with the  extension  .
shp.

Shapes Order

The dropdown Order contains three commands:

Forward moves the selected shape one plane forward or backward, according  to  the
drag movement of the button (up/down).

Backward sends the selected shape behind all other shapes.

Front brings the selected shape in front of all other shapes.

Tangents reset

The dropdown Tangent contains three commands:

Reset All resets all default values of the tangents or radials of a control point.

Reset  Radials  assigns  default  values  to  the  tangents  of  the  selected  control points,
without changing the radials.

Reset  Radials Angle assigns  default  values  only  to  the  angles  of  the  radials,  without
changing the tangents or the length of the radials of the selected control points.
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Add key

Selected Shapes adds a keyframe to the selected shapes  in  their current  position.  A
keyframe  is  only  assignable  to  a  whole  shape,  and  so  it  is  impossible  to  assign
keyframe  to  only  one  control  point.  Shapes  that  possess  keyframes  will  be  visible
throughout the duration of the effect.

All Shapes adds a keyframe to all the shapes found in the current frame.

Edit key

Cut Key moves the current keyframe of the selected shape to the clipboard.

Copy Key copies the current keyframe of the selected shape to the clipboard.

Paste Key pastes the keyframe found in the clipboard to the selected shape.

Delete Key deletes the keyframe assigned to the selected shape in the current frame.

Animation

Copy  Tracks  pastes  the  tracking  coordinates  that  the  parameters  of  the  effect
possesses to the selected shape, incrementally to the values of the keyframes in the
shape.

Tracking  can only  be  pasted  in  the  keyframe  of  a  shape  once.  Tracking  cannot  be
pasted in a shape that does not have at least one keyframe. This process is explained
at the end of this chapter.

Delete  Anim  deletes  all  the  keyframes  that  the  shape  has  in  the  duration  of  the
effect. To delete all keyframes, select the shape in one of its keyframes. 

The  shape  will  now  exist  only  in  the  frame  where  it  was  originally  created,  with  its
original shape.

Shape animation

Time Editor edits animation curves.

Text  opens  a  window  for  creating  text  vectorials,  enabling  selection  of  font,  alignment,
kerning, etc, as with the Title effect. 

These vector texts are created as vectors when the Convert  To Shape button of the Text
interface is pressed. 

These  vectors  are  identical to  other vectors,  and  can  be  animated  and  specified  in  any
draw mode.
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Safe Area

The  command View  Safe  Area  activates  the  viewing  of  an indicator of  a  safe  area.
The boxes X and Y  define the values as percentages of the  width  and  height  of  the
safety area.

Snap Area

The commands Snap X  and  Snap Y  activate  the  viewing  of  a  mesh that  divides  the
image. The values in X and Y define the number of divisions on each axis of the image.
The values set inOffset define the offset of the start of the mesh.

Vector Colors

The color boxes allow the user to define the colors of the different types of vectors in
order to avoid confusion with the colors of the image.

To change a color, first  define it  in the Color Chooser  of  Paint  Editor  (Paint  Editor-
>Option Tabs->Paint->Color) and then click with the mouse cursor over the  color
box to be modified.

The Reset  Colors  button returns  the  colors  of  the  vector types  to  their the  default
values.

Point defines the color of the control points of unselected vectors.

Select defines the color of the control points of selected vectors.

Shape defines the color of vectorial lines that join control points.

Key defines the color of vectorial lines that join control points that a keyframe has.

Transf defines the color of the manipulator Transf of the vectors.

Box defines the color of the band of selection.

Alpha defines the color that represents the alpha channel.

Pressure

By  means  of  defining  a  curve  in  this  graphic  we  can  control  the  sensitivity  of  the
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Wacom-type graphic tablet.

Render

Auto Render manually activates the redesign of the of the effect  of the vectors over
the input. On some occasions, if there are many vectors in a large image, the redesign
may be slow, in which case it is possible to detain the redesign via this option.

Shadows in Back specifies that  all shadows of the  vectorial  shapes  are  drawn in  the
background  regardless  of  their  order,  thus  avoiding  one  vectorial  shape  casting  a
shadow on another. 

Animation In Back specifies that que all animated shapes are drawn in the background,
so  that  unanimated  shapes  are  drawn  in  front.  If  this  function  is  deactivated,  the
animated shapes are drawn in front of the unanimated ones.

Animation

The mode Auto Fix adds one keyframe for each change of position in the shapes.

Spline  is  an interpolation mode  for the  position  of  a  shape.  When  it  is  deactivated,
interpolation of  the  position  of  the  selected  vectorial  shape  creates  a  straight  path
between the keyframes  that  it  possesses.  When it  is  activated,  the  interpolation of
position creates a curved path between the keyframes it possesses.

Show  Path  shows  the  path  of  the  movement  between  keyframes  in  the  selected
shape.

Shapes

Auto Select is a mode that automatically selects the last vectorial shape generated.

Hide Tang hides the viewing of the tangents of the vector control points.

Composition

The  command  With  CBlack  specifies  that  the  composition  should  be  carried  out
without multiplying the alpha channel over the foreground, since it pre-multiplied.

Cache

The command Use activates the memorization of the  evaluations  of  each frame  that
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has  been  modified,  storing  the  resulting  frame  in  a  disk  cache  to  avoid  having  to
redraw all the vectors each time we come to the same frame. 

If the input of the effect changes, the cache is not  automatically updated, so it  must
be deleted (Clear) to avoid memorized frames from a previous input  affecting the final
evaluation of the effect.

The cache is created in disk archives, in the directory defined inMistika Setup (Mistika
Setup->FilePaths->Paint tmp cache dir). It is important the locate this directory in
the quickest storage available, so the effect can perform in real time when evaluated.

The command Clear deletes the cache where the evaluations of the effect are stored.

Time Editor:

Time  Editor  is  a  curves  editor  that  contains  the  parameters  of  the  selected  animated
shape. To return to Paint Editor select the Time Editor button.

Folder that  contains the parameters that  defines some properties of the brush used  in  the
selected shape.

Size

[12 (1 / 256)]

Defines the size of the brush.

Opacity

[100 (0 / 100)]

Defines the pressure of the stroke.

Level

[100 (0 / 100)]

Defines the mask level of the drawn line.

Red; Green; Blue

[100 (0 / 100)]

Defines the color of the line.
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Folder that  contains  the  parameters  that  control  the  appearance  of  the  shadow  of  the
selected vectorial shape.

DX; DY

[10 (-100.000 / 100.000)]

Defines a horizontal and vertical offset of the shadow.

Red; Green; Blue

[0 (0 / 100)]

Defines the color of the shadow.

Opacity

[100 (0 / 100)]

Defines the intensity of the shadow.

Start

[0 (0 / 100)]

Defines the start of the line drawn. 

The value of the parameter is expressed as a percentage value of the total length of
the line.

Length

[100 (0 / 100)]

Defines the length of the line drawn. 

The value of the parameter is expressed as a percentage value of the total length of
the line.

Active

[1 (0 / 1)]

Activates or deactivates the drawing of a line. 

The value 0 deactivates the influence of the line in the image. 

The following image shows how the parameters Length and Start work.
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Bear in mind  that  in  some  cases,  many  parameters  will  have  no  effect,  since  each shape
obeys the attributes it has, if it has fill, shadow its paint mode, etc.

For example, a change of brush size makes no sense in a filled shape, nor the color of a line
if the paint mode is Drag.

Use of Motion Tracking with VectorPaint

Carry out this task by following the following steps:

Assign the effect VectorPaint to a clip.

From the  Visual  Editor  select  the  Tracking  tab  (Mistika->Visual  Editor->Manipulators
Tabs->Tracking) and carry out a motion tracking from a point in the usual way.

Apply  the  motion tracking  via  the  button  Move  (Mistika->Visual  Editor->Manipulators
Tabs->Tracking->Apply->Move). We will note that the parameters PosX and PosY  of the
VectorPaint are now animated, although they are not yet assigned to any shape.

Go  to  Paint  Editor  (Mistika->Visual  Editor->Manipulators  Tabs->Paint).  Select  the
shape to be animated, activating the mode Select double-clicking over it.

If the shape has no keyframe, at least one must be created in order to create its animation
curves. To do so, click the button Add key->Selected shapes. 

Click the button Animation->Copy  Tracks,  which will  copy  (in  the  Manipulators  Tabs  of
the Visual Editor) the animation that we have in PosX and PosY to the selected shape. 

Note that the shape now moves in the desired way.

Although it is the most  direct  way, it  is not  necessary for the motion tracking operation to
be  carried  out  from the  effect  VectorPaint.  It  is  possible  to  access  and  use  the  tracking
interface from any effect  that  allows it  (such as  Comp3D and  Color  Grade).  In  this  case,
after operating in the Tracking interface, it should be accessed via the VectorPaint effect in
order to apply the motion tracking to the PosX and PosY parameters of the effect.

Timewarp

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Timewarp

Effect  that  modifies the reproduction speed of a sequence, generating intermediate frames
through Optical Flow (Motion Estimation)  algorithms.  The  main  purpose  is  to  produce  high
quality Slow motion effects. 

In spite of its name, this effect  should not  be confused  with  the  Timewarp  groups,  which
carry out classic accelerations and slow-motions. This effect provides much greater realism,
but  is  not  an  editing  function  as  the  others  are,  but  rather  an  effect  that  requires  a
considerable amount of manual work.

If applied to make a clip longer, remember that  the effect  clip will  have  to  have  a  greater
duration than its  input  clip.  For example,  if  a  Speed  parameter  value  of  25% is  set,  the
duration of the effect  will have  to  be  forced  so  that  it  lasts  four times  the  length of  the
original clip (if we want to see it complete).

I/O

Inputs

Single input: Image with or without alpha channel.
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Inputs

Image: Image sequence with speed altered by the effect.

Alpha: Opaque mask.

Parameters

Timewarp:

Dropdown  folder  containing  the  parameters  that  control  the  reproduction  speed  of  the
sequence.

Note: the user must  choose which of the two  parameters  is  to  be  used.  Only  one  of  the
two should be used, and that which is not used should have a value of zero. 

Time-Time

[0 (0 / X)] 

Parameter which indicates the number of the original frame viewed as current frame .

Speed

[100 (0 / 1.000.000)] 

Parameter as a percentage which scales the reproduction.

Optical Flow:

Dropdown folder containing the parameters that control the Optical Flow logarithm.

MinLevel

[1 (0 / 8)] 

Factor that  divides  in  half  the  drag  resolution.  The  higher the  number,  the  less  the
resolution, thus accelerating the calculation speed of the effect.

Levels

[7 (1 / 8)] 

Refines the direction of the vectors of movement.

Iterations

[25 (0 / 1.000)] 

Revision of movement in areas with little detail.

Smoothness

[10 (0 / 1.000)] 
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Softens the direction of crossed vectors, making them more parallel.

Display:

Dropdown folder containing the  parameters  that  control viewing  mode  of  the  Optical Flow
logarithm.

Mode

[Warp (MixFrames / Warp / Vectors / Slopes)] 

Provides  different  output  modes,  which  mainly  help  in  adjusting  other  parameters.
MixFrames  obtains  new  frames  by  mixing  previous  and  following  frames  (instead  of
using  Motion  Estimation  techniques,  and  is  useful  for  comparing  with  a  traditional
timewarp or if  we  have  too  many  artefacts  that  cannot  be  corrected).  Warp  is  the
most usual mode and is that which will produce the best  results via Motion Estimation
techniques;  Vectors  show  tracking  for  each  pixel,  and  Slopes  show  the  amount
movement of each pixel by means of different colors.

One use of Vectors and Slopes is to analyze what  is happening in areas that  produce
artefacts: if we observe sudden, unexpected changes in direction of the vectors or in
the  amount  of  movement,  increase  the  Softness  parameter  or  vice  versa,
respectively.

Sometimes,  Slopes  modes  can  be  used  to  obtain  masks  close  to  objects  that  are
moving  at  a  different  velocity  to  that  of  those  around  them,  by  means  of  their
posterior extraction with a vector of the Color Grade effect.

VecsScale

[1 (0 /100)] 

Softens the direction of crossed vectors, making them more parallel.

Deinterlace:

Drop-down folder that contains the parameters of the mode for treating interlaced material.
In a Timewarp effect, the fields of an interlaced sequence  can generate  complete  frames,
therefore, the deinterlace mode uses the effect of its own parameter internally.

Mode

[Default (Default/Adaptive)] 

Defines  the  deinterlace  mode.  The  Default  value  defines  the  deinterlace  mode  by
current  interpolation,  while  Adaptive  mode  defines  interpolation  in  which  values  are
explored diagonally, giving better visual results.

Note:  This  parameter only  works  in  cases  in  which the  render is  done  by  fields.  In
progressive mode render, the value of this parameter is ignored.

Use and Comments

As in all the effects that use Optical Flow, pay attention to objects that  get  hidden behind
other objects, crossed trajectories, and dynamic changes in light.

To deal with this type of sequence, the Parameters must  be set  evaluating the behavior of
the vectors, using the Vector viewing mode, with a high VectScale value.
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Denoise

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Denoise

High quality effect  that  reduces image  noise  or grain  via  Optical Flow  (Motion Estimation)
algorithms. 

It  is  also  suitable  for reducing  cine  image  grain,  electronic  video  camera  noise,  and  noise
produced  by  image  compression  algorithms  common  in  all  types  of  cameras  and  VTRs
(mpeg2, mpeg4, etc.).

I/O

Inputs

Single input: Image with or without alpha channel.

Inputs

Image: Image sequence with reduced noise or grain.

Alpha: Compositing mask.

Parameters

Denoise:

Dropdown folder containing the parameters that control application of grain remover. 

Scope

[3 frames (none, 3frames, 5frames, 7frames, 9frames, 11 frames)] 

Parameter that  indicates  the  number of  frames  included  the  Optical  Flow  algorithm.
The  higher  the  number,  the  greater  the  noise  reduction,  but  with  the  increased
possibility problems of accuracy.

Mode

Combined (Temporal, Spatial, Combined)

Noise reduction modes.

Temporal applies Optical Flow to detect  noise  and  remove  it,  using  images  distorted
by the Optical Flow algorithm.

Spatial applies a spatial filter to remove noise, similar to a Median filter.

Combined combines both modes a mask generated by the Mask parameter. This mode
is recommended in the majority of cases, once the correct  mask is created properly.

Spatial

[0.050 (0/100)]

Spatial filter application radius for noise removal (not visible in  Temporal mode).



531FX

SGO Mistika 8.6 © 2018 SGO

Mask:

Folder that  contains the parameters that  modify the mask, where  the  Spatial  filter can be
combined with the Temporal filter.

NGamma

[1 (0/100)]

Specifies a grey value as a start point for mask generation.

Filter

[0.2 (0/100)]

Specifies a blur value prior to the extraction of the mask, reducing detail.

Level

[0 (0/100)]

Specifies a transparency in the generated mask.

Scale

[40 (0/100.000)]

Scale of opacity values in the generated mask. 

Optical Flow:

Dropdown folder containing the  parameters  that  control viewing  mode  of  the  Optical Flow
logarithm. 

Note:  This  algorithm  automatically  generates  a  mask  at  the  intersections  of  crossed
vectors, which will vary when editing these  parameters.  The  Mask parameters  function as
post-process from the mask generated by Optical Flow.

MinLevel

[1 (0 / 8)] 

Factor that  divides  in  two  the  drag  resolution.  The  higher the  value,  the  lower  the
resolution, accelerating effect  calculation speed (with a value  of  0,  the  Optical Flow
carries out tracking of all the pixels of the image). Higher values drag areas whose size
is specified by this number of pixels.

Levels

[7 (1 / 8)] 

Refines the direction of movement vectors.

Iterations

Revision of movement in areas with little detail.
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Smooth

[10 (0 / 1.000)] 

Softens the direction of crossed vectors, making them more parallel.

Use and Comments

As in all the effects that use Optical Flow, pay attention to objects that  get  hidden behind
other objects, crossed trajectories, and dynamic changes in light.

To adjust the parameters of the effect  correctly, it  is necessary to follow the order of the
procedure detailed below.

In  Temporal  mode,  specify  the  Optical  Flow  parameters  (the  parameters  that  are  most
sensitive to editing are Smooth and MinLevel), with the  aim of  reducing  to  a  minimum the
deformation  generated  in  cases  of  crossed  trajectories.  The  example  shows  the  typical
problems of occlusion (similar objects crossing one beyond the other) in Optical Flow, since
the original image is a sequence in which the character moves  from left  to  right  of  frame,
“dragging” the foreground character.

Specify  the  mask  using  the  Show  Alpha  mode  of  the  Visual  Editor.  The  mask  gives  the
impression of  seeing  the  outline  of  the  figures,  although in  reality  what  is  drawn  are  the
areas  where  crossed  movements  are  detected.  So,  the  outlines  of  one  figure  are  visible
during a movement, and do not remain still. 

First  specify an NGamma  value which makes  the  noise  homogeneously  visible  in  the  light
and dark areas of the image. Then defines  the  Level parameter to  exclude  from the  mask
areas  of  little  occlusion,  since  Optical Flow  will  probably  not  generate  occlusion  errors  in
these areas. To make the mask areas larger, edit the parameters Scale and Filter.
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Once the mask containing the occlusion errors generated by Optical Flow is defined, modify
the parameter Mode to  Combined.  Finally,  specify  Spatial  at  a  low  value  to  equalize  both
combined modes and to make the transition between one mode and the other via the mask
is not apparent.

Then adjustments of any type can be made to the parameters, especially Level and Scale,
viewing the final result  in order to hide the occlusion problems by expanding the mask that
combines the spatial filter with the temporal. 

The  Spatial  filter itself  never manages  to  remove  noise  whilst  conserving  detail  that  the
Temporal filter recognizes, so the combination of  both  methods  gives  the  best  results.  In
the example that follows, a detail is exaggerated from the previous image to better view the
difference between the application of the spatial filter and the combined.
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This effect is recommended for treating material before extracting masks, doing chroma key
processes, secondary color corrections, or simply reducing grain in 16 mm film material. It  is
also useful for eliminating noise from video with gain problems. 

It  is also very useful for improving  the  precision of  Motion Tracking,  in  cases  of  annoying
vibrations of tracked areas.

The default parameters usually give good results.

Grain

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Grain

Adds grain noise to the image.
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I/O

Inputs

Single  input.  If  the  input  contains  alpha  information,  the  noise  pattern  can  be
adjusted to this area of the image. 

Inputs

Image:  The  noise  pattern  acting  on  either  the  entire  image,  or  restricted  to  the
opaque area of the mask. 

Alpha: Unmodified. 

Parameters

Repeat

[1 (1 / 100.000)]

Number of frames in which the random position of the grains will be repeated. 

Rad

[3 (1 / 100.000)]

Radius of the spherical points applied to the image. 

Gain

[100 (-100.000 / 100.000)]

Multiplies  the  brightness  of  the  image  by  a  percentage  value  before  processing  the
grain. 

This  luminance  correction is  useful to  compensate  the  loss  of  brightness  caused  by
the amplitude of the grain. 

Ampl

[30 (0 / 100.000)] 

Applied amplitude of the granulated noise. 

Gamma

[0 (-100 / 100)] 

Specifies  gamma  correction  for  the  granulated  noise.  Higher  values  specify  greater
transparency from the center of the grain, and vice-versa. 

In Alpha

[No (No /Yes)]



536 FX

SGO Mistika 8.6 © 2018 SGO

Restricts the influence of the effect to the area specified by the alpha channel levels.

Use and Comments

The purpose of this effect  is simply  to  add  grain  to  the  image  to  simulate  a  photographic
emulsion. 

In  many  cases  of  composition,  it  is  necessary  add  grain  to  layers  originally  without  it  to
integrate them with film material, or even video (although in this case it  will be noise rather
than grain),  as  for example  the  replacement  of  the  contents  of  an current  poster with  a
digital file. 

In this example, as the logo is a synthetic  image it  has no grain, which should be added to
integrate it better with its background.

FrameRepair

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->FrameRepair

Effect that is used to eliminate hairs, dust or other small foreign bodies that  often appear in
images. It uses Optical Flow (Motion Estimation) algorithms.

I/O

Inputs

Single input: Image with or without alpha channel.

Inputs

Image: Image sequence with repaired “drops”.

Mask: Mask showing where the repair takes place.

Parameters

FrameRepair:

Dropdown folder that contains the parameters that control the frame repair application.

Mode

RepairF(Off,RepairF,RepairB,DirtMaskF,DirtMaskB,RepairFB,DirtMaskFB,
RepairDirt,Composition)

Except  for  the  Composition  mode,  the  other  modes  can  be  considered  “modes  for
adjusting other parameters", in other words,  they  can be  used  during  the  setting  of
other  parameters,  but  ultimately,  Composite  is  what  is  used  to  the  final  render.
Exceptions are indicated at the appropriate time.                 
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Off: effect off.

RepairF:  in  this  mode,  the  Optical  Flow  (henceforth  OF)  is  calculated  between  the
previous frame and the posterior frame to the current. The result  of this  effect  is  to
recreate the present frame, (the original current frame will not enter into the process)
applying OF as Warper to the previous frame. As well as the current  image created, a
mask is calculated  which indicates  the  areas  of  the  image  in  which the  OF  has  had
tracking problems, normally caused by occlusions in the movements in the sequence.

Note:  with  all  values  at  their  default  settings,  the  FrameRepair  effect  in  RepairF
mode,  is  that  which  is  used  internally  when  the  Repair  option  in  VectorPaint  is
activated. If the user needs to modify the values of Repair, instead of using the Repair
option in  VectorPaint,  FrameRepair can be  used,  applied  to  a  copy  of  the  input  of
VectorPaint as a SECOND input in VectorPaint. The Reveal Back brush acts exactly like
the Repair  option, while giving full control over the recreation process  values  for the
current frame, which can be used to patch up the current damaged frame. 

RepairB:  Identical to  RepairF,  except  that  it  interchanges  the  two  frames  used  for
calculation,  the  next  and  the  previous.  The  OF  calculation  is  not  a  symmetrical
process, since in one direction the calculation may be able to create objects that  are
being hidden better, while in the other direction it  may be the objects that  are being
revealed that are easier to calculate.

DirtMaskF:  Calculates  the  OF  between  the  current  frame  and  the  next  obtaining  a
mask that  indicates  areas  where  tracking  problems  exist.  This  mode  only  serves  to
show an intermediate phase of the process of automatic repair. 

DirtMaskB: Similar to DirtMaskF, using the current frame and the previous one.

RepairFB: Gives a result  by combining the modes RepairF  and  RepairB.  The  combined
mask generated can be interpreted as “areas of complex movements" which cannot  be
repaired automatically. Also, a Grow process is applied to the mask,  specified  by  the
parameter of the same name, with the purpose of adding a safety margin to the areas
of complex movements. 

DirtMaskFB: Gives a combined mask from the  modes  DirtMaskF  and  DirtMaskB,  which
indicates areas of possible defects. 

RepairDirt: As an image, this returns the image recreated the same as inRepairFB, as a
morphing between the previous and posterior frames to the current one. As a mask,  it
returns a combined mask from the previous phases: areas detected in RepairFB as the
areas of complex movements subtracted from areas detected in  DirtMaskFB (possible
defects). Ideally, this mask only contains areas of defects in the image. 

Composition: The final result of the automatic repair: it  is composed of the image and
mask resulting from the RepairDirt phase over the original image, only patched in areas
of defects. 

DistBck

[1 (1/100.000)]

Offset, in frames, from the previous frame with which the repair or Dirt is to be done.

DistFwd

[1 (1/100.000)]

Offset, in frames, from the next frame with which the repair or Dirt is to be done.
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Mask:

Folder that  contains  the  parameters  that  modify  the   mask,  to  defines  the  areas  of  the
image that are to be used to carry out the morph between frames.

NGamma

[1 (0/100)]

Specifies a grey value as start point for the mask generation.

Filter

[0.2 (0/100)]

Specifies a blur value before the extraction of the mask, reducing detail.

Level

[0 (0/100)]

Specifies a transparency threshold in the generated mask.

Scale

[40 (0/100.000)]

Scales the opacity values of the generated mask.

Grow

[0.5 (0/100.000)]

Increase in the edges of the mask.

Optical Flow:

Dropdown folder that  contains the parameters that control the Optical Flow algorithm. 

Note:  this  algorithm  automatically  generates  a  mask  at  the  intersections  of  crossed
vectors, which will vary when editing these parameters. The Mask parameters function as a
post-process of the mask generated by Optical Flow.

MinLevel

[1 (0 / 8)] 

Factor which divides by two the resolution of the tracking. The higher the value, the
lower the resolution accelerating the calculation speed of the process (if  the value is
at  0, the Optical Flow carries out  the tracking of all  the  pixels  of  the  image).  Higher
values track areas specified by this number of pixels.

Levels

[7 (1 / 8)] 



539FX

SGO Mistika 8.6 © 2018 SGO

Refines the direction of the movement vectors.

Iterations

[100 (0 / 1.000)] 

Revision of movement in areas of little detail.

Smooth

[10 (0 / 1.000)] 

Smooths the direction of crossed vectors, making them more parallel.

Use and Comments

As in all the effects that use Optical Flow, pay attention to objects that  get  hidden behind
other objects, crossed trajectories, and dynamic changes in light.

To adjust the parameters of the effect  correctly, it  is necessary to follow the order of the
procedure detailed below.

Look for a frame that  contains a hair, scratch or other localized interference. The  example
shows a single frame that contains a hair over the model's left arm.

In RepairF mode, specify the Optical Flow (the parameters that are most sensitive to editing
are Smooth and MinLevel) with the aim of reducing to a minimum the deformation generated
in cases of crossed trajectories.

Specify  the  mask  using  the  Show  Alpha  mode  of  the  Visual  Editor.  The  mask  gives  the
impression of  seeing  the  outline  of  the  figures,  although in  reality  what  is  drawn  are  the
areas  where  crossed  movements  are  detected.  So,  the  outlines  of  one  figure  are  visible
during a movement, and do not remain still. 
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First  specify an NGamma  value which makes  the  noise  homogeneously  visible  in  the  light
and dark areas of the image. Then defines  the  Level parameter to  exclude  from the  mask
areas  of  little  occlusion,  since  Optical Flow  will  probably  not  generate  occlusion  errors  in
these areas. To make the mask areas larger, edit the parameters Scale and Filter.

Once  the  mask  is  specified,  it  is  selected  in  RepairDirt  mode  and  the  mask  that  is  not
considered interference disappears, leaving, in the example, just  the mark off the hair over
the model's arm.

Once  this  has  been viewed,  go  to  Composite  mode  and  activate  the  image  in  the  Visual
editor. Finally, the result  -  the result  of  the  morph between the  previous  and  subsequent
frames to the one with the problem - substitutes the marked area with the mask.
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Reverb

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Reverb

Generates an echo of the image, with a definable duration.

I/O

Inputs

Single input: Image with or without mask. 

Inputs

Image: Image with echo.

Alpha: Mask with echo. 

Parameters

Reverb

[0 (0 / 100)] 

Specifies the mixing level with the previous images.

Use and Comments

Reverb  is  an  accumulative  effect.  It  cannot  be  seen  in  a  single  static  frame  before
rendering,  since  it  must  be  evaluated  sequentially.  Therefore,  if  the  monitor  cursor  is
dragged randomly over the frames, anomalous results can occur. 

It is not possible have more than one Motion Blur effect in the same stack. If more than one
of these effects is grouped in the same stack, it  is necessary to  render to  calculate  each
effect. As with Feedback, the results of this effect depend on the temporary order in which
they  are  being  evaluated,  so  that  the  result  will  be  different  for  normal  and  reverse
playback. 

Bullet Time

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Bullet Time

The Bullet Time effect allows the  creation of digital cameras located between real cameras
around  a  scene.  This  allows  smooth   rotations  around  a  scene  on  shoots  with  multiple
cameras.

The effect also includes a Timewarp in order to accelerate, slow down or stop time at  the



542 FX

SGO Mistika 8.6 © 2018 SGO

same time as performing the effect.

I/O

Inputs

Multiple inputs: Each input will be one of the cameras located around the scene. The
result improves with more inputs.

Inputs:

Image: Final sequence with desired movement, regarding both positioning around the
scene and time.

Alpha: opaque mask.

Parameters

Bullet Time:

Dropdown  folder  that  contains  the  parameters  that  control  the  playback  speed  of  the
sequence.

Note:  the  user must  decide  which of  the  first  parameters  to  use  (Time-Time  or  Speed).
Only one must be used; the other parameter must be set at zero.

Time-Time

[0 (0 / X)] 

Parameter  that  indicates  the  number  of  the  original  frame  that  is  currently  being
viewed.

This is useful for slowing down or accelerating by simply mapping the time.

Speed

[100 (0 / 1.000.000)] 

Parameter in percentage that scales playback speed.

This is useful for slowing down or accelerating by indicating a velocity.

Angle

[0 (-1.000.000 / 1.000.000)] 

Parameter in degrees that indicates the value of the angle for positioning the camera,
allowing the camera to be rotated around the scene.

The  effect  supposes  that  the  cameras  are  located  equidistant  around  the  scene
covering 360º, so that:

- 0º  is the first camera 

-  any value  greater than that  will  be  interpolated  towards  the  second,  third,  fourth
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cameras etc (as many as are desired) and from the last  camera we return to the first
when reaching 360º.

The range is greater than 0 to 360 in order to allow repeating the circling around the
scene continuously as many times as required.

Optical Flow:

Dropdown folder that contains the parameters that control the algorithm of Optical Flow. 

MinLevel

[1 (0 / 8)] 

Factor that divides in half the drag resolution: higher values indicate lower resolution,
thus accelerating the speed of calculation of the effect.

Levels

[7 (1 / 8)] 

Refines the direction of movement vectors.

Iterations

[25 (0 / 1.000)] 

Reviews movement in areas with little detail.

Smoothness

[10 (0 / 1.000)] 

Smoothes the direction of crossed vectors, making them more parallel.

Display:

Dropdown folder that contains the parameters that control viewing modes of Optical Flow.

Mode

[Warp (MixFrames / Warp / Vectors / Slopes)] 

Provides  various  output  modes,  which mainly  help  when adjusting  other parameters.
MixFrames  obtains  new  frames  by  mixing  previous  and  following  frames  (instead  of
using  Motion  Estimation  techniques,  and  is  useful  for  comparing  with  a  traditional
Timewarp or if there are too many artefacts que that  cannot  be corrected). Warp will
be the usual mode of use  and  will  be  the  one  that  obtains  the  best  results  through
Motion  Estimation  techniques.  Vectors  shows  the  tracking  vectors  of  each  pixel.
Slopes represents the amount of movement of each pixel using different colors.

One practical use of Vectors and Slopes is to be able to analyze what  is happening in
areas that produce artefacts: if abrupt and undesired changes happen in the direction
of  the  vectors  (or  in  the  amount  of  movement),  we  should  increase  the  Softness
parameter, and vice versa.
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Sometimes,  Slopes  mode  can  be  used  to  obtain  masks  close  to  objects  that  are
moving at a speed to what  is around them, through their subsequent  extraction using
a free vector of the Color Grade effect.

VecsScale

[1 (0 /100)] 

Increases/decreases the size of the vectors viewed when Vectors  is  selected  in  the
Mode parameter.

Deinterlace:

Dropdown folder that  contains  the  mode  parameter  for  treating  interlaced  material.  In  a
Timewarp effect, the fields of an interlaced  sequence  can generate  whole  frames,  so  the
Deinterlace mode that the effect uses internally has its own parameter.

Mode

[Default (Default/Adaptive)] 

Defines  the  deinterlace  mode.  The  Default  value  defines  a  deinterlace  mode  by
sequential interpolation,  while  the  Adaptive  value  defines  an interpolation mode  that
explores the values diagonally, producing better visual results.

Note: this parameter only works in cases where the render is run by fields. Render in
progressive mode ignores the value of this parameter.

Use and Comments

The  main  use  of  this  effect  is  to  create  the  sensation  of  time  stopping  and  the  camera
revolving around the action. These visual effects can be managed independently.

JellyTime receives a variable  number of  sequences  of  images  as  its  input.  Each sequence
comes from a camera within  a  group  of  equidistant  cameras  that  complete  a  full  circle  of
360º around the scene. 

Via the Optical Flow (Motion Estimation) algorithm, Mistika calculates the frames missing in
the movement between consecutive cameras.

As  in  all  effects  that  use  Optical  Flow,  pay  attention  to  occlusions  of  objects,  crossing
paths and drastic light changes.

To manage this type of sequence, set  parameters, evaluating the behavior of the vectors,
using the viewing mode Vectors, with a high value set for VecsScale.

Optical Motion Blur

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Optical Motion Blur

Effect that simulates motion blur, based on Optical Flow (Motion Estimation) algorithms.

I/O

Inputs

Single input: image with or without alpha channel.
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Inputs

Image: image sequence with speed altered by the effect.

Alpha: opaque mask.

Parameters

MotionBlur:

Dropdown folder that  contains the parameters that  control the intensity and quality of the
blur trail. 

ShutterTime

[40 (0 / 1.000.000)] 

Parameter that defines the exposition time to be generated by Optical Flow. The value
is in milliseconds.

Quality

[1 (1 / 10)] 

Sample  rate  of  the  render  process.  Higher  values  set  higher  numbers  of  samples,
notably improving mage quality.

Optical Flow:

Dropdown folder that contains the parameters that control the Optical Flow algorithm. 

MinLevel

[1 (0 / 8)] 

Factor que that divides in half the drag resolution: higher values set  lower resolution,
accelerating the speed of calculating the the effect.

Levels

[7 (1 / 8)] 

Refines the direction of the movement vectors.

Iterations

[25 (0 / 1.000)] 

Reviews movement in areas with little detail.

Smoothness

[10 (0 / 1.000)] 

Smoothes the direction of crossed vectors, making them more parallel.
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Display:

Dropdown folder that contains the parameters that control viewing modes of Optical Flow.

Mode

[Warp (MixFrames / Warp / Vectors / Slopes)] 

Provides  various  output  modes,  which mainly  help  when adjusting  other parameters.
MixFrames  obtains  new  frames  by  mixing  previous  and  following  frames  (instead  of
using  Motion  Estimation  techniques,  and  is  useful  for  comparing  with  a  traditional
Timewarp or if there are too many artefacts que that  cannot  be corrected). Warp will
be the usual mode of use  and  will  be  the  one  that  obtains  the  best  results  through
Motion  Estimation  techniques.  Vectors  shows  the  tracking  vectors  of  each  pixel.
Slopes represents the amount of movement of each pixel using different colors.

One practical use of Vectors and Slopes is to be able to analyze what  is happening in
areas that produce artefacts: if abrupt and undesired changes happen in the direction
of  the  vectors  (or  in  the  amount  of  movement),  we  should  increase  the  Softness
parameter, and vice versa.

Sometimes,  Slopes  mode  can  be  used  to  obtain  masks  close  to  objects  that  are
moving at a speed to what  is around them, through their subsequent  extraction using
a free vector of the Color Grade effect.

VecsScale

[1 (0 /100)] 

Increases/decreases the size of the vectors viewed when Vectors  is  selected  in  the
Mode parameter.

Deinterlace:

Dropdown folder that  contains  the  mode  parameter  for  treating  interlaced  material.  In  a
Timewarp effect, the fields of an interlaced  sequence  can generate  whole  frames,  so  the
Deinterlace mode that the effect uses internally has its own parameter.

Mode

[Default (Default/Adaptive)] 

Defines  the  deinterlace  mode.  The  Default  value  defines  a  deinterlace  mode  by
sequential interpolation,  while  the  Adaptive  value  defines  an interpolation mode  that
explores the values diagonally, producing better visual results.

Note: this parameter only works in cases where the render is run by fields. Render in
progressive mode ignores the value of this parameter.

Use and Comments

This effect  is especially useful for combining  real images (generally with some motion blur)
and  CGI.  It  is  also  possible  to  set  motion blur values  in  a  stereo  clip  in  order  to  correct
differences that material from a shoot might have.

As  in  all  effects  that  use  Optical  Flow,  pay  attention  to  occlusions  of  objects,  crossing
paths and drastic light changes.

To manage this type of sequence, set  parameters, evaluating the behavior of the vectors,
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using the viewing mode Vectors, with a high value set for VecsScale.

Filter

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Filter

The  effects  the   Filter  menu  contain  image  alteration  tools  based  on  spatial  algorithms,
corrections of RGB values and luminance.

Glint

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Filter->Glint

Adds a blurred version of the image in its horizontal, vertical and  diagonal axes,  simulating
flashes of light in a camera lens.

I/O

Inputs

Single input: Image with or without alpha channel.

Inputs

Image: Image with glints. 

Alpha: No change. 

Parameters

Intensity:

Folder containing the parameters controlling the intensity of the glint. 

Global

[0 (-100.000 / 100.000)] 
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Global intensity of the glints in the image. This value multiplies the local values of each
direction by a specified percentage. 

Horizontal

[200 (-100.000 / 100.000)]

Intensity of the horizontal glint. 

Vertical

[200 (-100.000 / 100.000)]

Intensity of the vertical glint. 

DiagUp

[200 (-100.000 / 100.000)]

Intensity of the diagonal glint coming from the top left corner. 

DiagDwn

[200 (-100.000 / 100.000)]

Intensity of the diagonal glint coming from the bottom left corner. 

Glint:

RadImg

[3 (0 / 100)]

Radius of the glint affecting the image. 

Chroma

[0 (-1.000 / 1.000)]

Specifies a coloring of the glint, simulating a chromatic aberration produced by a lens. 

RadAlpha

[3 (0 / 100)]

Radius of the glint affecting the alpha channel. 

AddImg

[100 (0 / 100.000)] 

Adds the original image to the effect. 
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Use and Comments

This effect is frequently used to simulate the behaviour of direct  incidence of light  sources
on  a  camera  lens.  Normally,  concentrated  light  emanating  from  a  spotlight  in  complete
darkness (such as the headlamps of a car at night) produce a glint with geometrical forms in
the lens. In video cameras, these glints are cross-shaped, sometimes diagonal or even star-
shaped, depending on the type of lens. Certain lower quality optics can even produce visible
chromatic aberrations, which can be simulated with the Chroma parameter. 

Glint  is  the  ideal  effect  to  obtain  this  type  of  glint,  be  controlled  with  the  intensity
parameters for each direction of the glint. Bear in mind that  the result  of the effect  will be
the sum of the intensities of each direction, and negative values may be  specified  for any
intensity parameter, which are totaled to the Global parameter. 

If only the image of  the  glint  is  wanted,  without  being  composed  over the  original image,
simply set the AddImg parameter to zero. 

In the following example, the action of the effect on an image can be seen. 

Crystallize

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Filter->Crystallize

Forms a mosaic  of irregular polygons, with or without  an edge, colored by the predominant
values in the original image.

I/O

Inputs

Single input: Image with or without alpha channel. 

Inputs

Image: Mosaic image.

Alpha: Mosaic mask. 

Parameters

Size

[5 (0 / 100)]

Specifies the size of the polygons. 

Borders

[0 (0 / 50)] 
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Specifies  shrinkage  of  the  polygon  surfaces,  thus  creating  a  black  border  between
them. This shrinkage also affects the mask. 

Seed

[0 (0 / 100.000)] 

Seed for the random positioning of the mosaics. 

This  parameter  can  be  animated  so  that  the  positions  of  the  mosaics  are  moved
randomly.

Use and Comments

This  effect  has  the  simple  purpose  of  simulating  an  image  constructed  from  irregular
mosaics, and also the control of border size for simulating of stained glass images.

QuadTree

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Filter->QuadTree

Forms a mosaic of different-sized rectangles of solid colors, based on copying similar colors
of neighboring pixels, controlled by a tolerance.

I/O

Inputs

Single input: Image with or without alpha channel.

Inputs

Image:  Image  formed  by  a  mosaic  of  different-sized  rectangles  generated  by  the
effect. 

Alpha: Edges of the rectangles generated in the mosaic. 

Parameters

Toler

[20 (0 / 100)] 

Modifies  the  difference  tolerance  between  the  pixels  to  be  joined  in  a  rectangular
mosaic  of  a  single  color.  The  higher the  value,  the  greater the  difference  tolerated
between pixels that form part of the mosaic. 
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Max Lev

[16 (0 / 16)] 

Maximum level of detail allowed  in  the  generation of  subdivisions  of  the  mosaic.  The
higher the value, the greater the level of detail preserved in the image.

Invert

[No (No /Yes)]

Inverts the opacity values in the edges of  the  rectangular mosaics  generated  in  the
alpha channel.

Use and Comments

This effect is used to simulate images derived from highly compressed file formats. 

The mask generated by the effect  can also be used  to  add  a  rectangular grid  adapted  to
the image to the original one, thanks to its “technological” look. 

In  the  following  example  the  result  of  the  effect  can be  seen in  both the  image  and  the
alpha channel.

MosaicTiles

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Filter->MosaicTiles

Creates the effect of small tiles on an image, similar to an image created by mosaics.

I/O

Inputs

Single input: Image with or without alpha channel.

Inputs

Image: Image modified by tiles. 

Alpha: No change. 

Parameters

Repeat

[1 (1 / 100.000)]

Number of frames in which the random position of the tiles will be repeated.
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In Alpha

[No (No /Yes)]

Restricts the influence of the effect to the area specified by the alpha channel levels.

Use and Comments

This effect is used to add tiles to an image, simulating a mosaic. 

In the following example the result of the effect can be seen.

Dither

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Filter->Dither

Produces a random change of position of the image pixels.

I/O

Inputs

Single input: Image with or without alpha channel.

Inputs

Image: Image with the pixels moved to the new position. 

Alpha: No change. 

Parameters

AmountX

[0 (-10.000 / 10.000)] 

Specifies the maximum horizontal distance by which the pixels will have their positions
interchanged. 

AmountY

[0 (-10.000 / 10.000)] 

Specifies the maximum vertical distance  by  which the  pixels  will  have  their positions
interchanged. 
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Repeat

[1 (1 / 100.000)]

Number of frames in which the position change pattern is repeated.

In Alpha

[No (No /Yes)]

Restricts the influence of the effect to the area specified by the alpha channel levels.

Use and Comments

Dither is a basic effect that moves pixels from their original positions, mixing them randomly.
Its  usefulness  is  related  to  adding  noise  to  the  image  without  changing  its  color  palette,
since the same pixels create noise when they are mixed up. 

Another  possible  use  is  to  add  a  Dither  effect  to  a  mix  with  the  Amount  parameters
animated to dissolve and restore an image, for example, during a transition. 

In the following example, the results of using different parameter values can be seen. 

Contrast Band

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Filter->Contrast Band

Specifies  a  subdivision  of  the  image  luminance  range  to  increase  the  contrast  in  each
subdivision.

I/O

Inputs

Single input: Image with or without alpha channel.

Inputs

Image: Contrasted image depending on the specified bands. 

Alpha: No change.

Parameters

Bands

[1 (1 / 256)] 

Specifies  the  number  of  subdivisions  or  bands  applied  to  the  levels  of  the  RGB
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channels.

Grade

[100 (-10.000 / 10.000)]

Increase of contrast applied to each band.

By Luma

[No (No /Yes)]

Specifies whether the effect works based on luminance rather than RGB values.

 In Alpha

[No (No /Yes)]

Restricts the influence of the effect to the area specified by the alpha channel levels.

Use and Comments

The  contrast  generated  in  this  effect  with  the  parameter ByLuma  set  to  0  is  applied  to
each  RGB  channel,  and  acts  in  a  very  different  way  to  the  contrast  control  of  a  color
corrector based on luminance contrast. One possible use is for increasing the contrast  of an
image of a cloudy day so that it  appears sunny. Since the contrast  of this effect  increases
at the same time as the saturation, the skin color of people in the scene will be increased,
together with the contrast. Negative values of the Grade parameter are useful for creating
very simply images that simulate a heat detector. For example, setting the Grade parameter
to –200 and Bands  to  3,  and  adding  a  blur -with   Blur  (Type  Gauss)  for example-  to  the
input  image before ContrastBand, gives an acceptable effect. In the following example  the
results of different  parameter values  can be  seen.  A  gradient  from black to  white  can be
seen below  each image,  representing  the  result  of  the  effect  on  the  luminance  of  each
example.

Spot Poster

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Filter->Spot Poster

Creates a posterizing effect, by randomly selecting areas with a selection tolerance.
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I/O

Inputs

Single input: Image to be processed. 

Inputs

Image: Modified image. 

Alpha: Opaque mask.

Parameters

Toler

[20 (0 / 100)] 

Posterizing  tolerance.  Higher  values  include  areas  limited  by  their  details,  whereas
lower values restrict the posterizing action. 

Size X; Y

[20; 20 (0 / 100.000)] 

Specifies the maximum horizontal and vertical size of the posterizing areas. 

Seed

[0 (0 / 100.000)] 

Seed for the random pattern for specifying the zone selection.

Use and Comments

The result of this effect is very similar to Posterize, with the difference that it also randomly
selects areas using a tolerance which allows the effect  to maintain frame  areas  that  have
detail.

FlareFx

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Filter->FlareFx

This effect allows the generation of different  types of optical effects in the image, such as
glows,  rainbows,  lens  flares,  light  rings,  and  optical  effects  of  stars  with  any  number  of
points. It has noise parameters to make the effect more or less irregular.
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I/O

Inputs

Single input: Image with or without alpha channel.

Inputs

Image: Sequence with applied the effect. 

Alpha: Mask with the flare effect.

Parameters

Origin:

This  group  represents  the  original position  of  the  optical effect.  It  contains  the  following
parameters:

CentX 

[50 (-1.000 / 1.000)]

X position of the origin.

CentY 

[50 (-1.000,1.000)]

Y position of the origin.

Dest.:

This  group  represents  the  target  position  of  the  optical  effect.  It  contains  the  following
parameters:

CentX

[50 (-1.000, 1.000)]

X position of the target.

CentY

[50 (-1.000, 1.000)]

Y position of the target.

Glow:

This group represents the glow effect to be generated in the image. This effect  comprises a
ring of light around the origin of the effect.
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 Color Red; Color Green; Color Blue

[100; 50; 50 (0 / 100)]

RGB Components of the color of the effect.

Glow Active

[No (No / Yes)]

Specifies if the effect is activated.

Glow Intensity 

[50 (0, 1.000.000)]

Intensity of the effect.

Glow Radius 

[50 (0.001, 1.000)]

Radius of the effect.

Glow Decay 

[2 (0.5, 1.000)]

Decay of the effect with distance.

Ray:

This group represents the ray effect  to be generated in the image. This effect  comprises a
star of light beams that radiate from the origin of the effect.

 Color Red; Color Green; Color Blue

[100; 50; 50 (0 / 100)]

RGB components of the color of the effect.

Rays Active

[No (No / Yes)]

Specifies if the effect is activated.

Rays Intensity 

[60 (0 / 1.000.000)]

Intensity of the effect.
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Rays Radius

[100 (0.001 / 1.000)]

Maximum  radius  of  the  effect.  Represents  the  maximum  distance  from  the  origin
reached by the rays.

Rays MinRadius

[0.100 (0.001 / 1.000)]

Minimum radius  of  the  effect.  Represents  the  distance  from the  origin  to  where  the
rays begin to appear.

Rays Rot.

[0 (-1.000.000,1.000.000)]

Rotation of the light rays.

Rays N.Spikes

[5 (1 / 100)]

Number of rays.

Rays Thickness

[20 (0.0001 / 100)]

Thickness of the rays.

Rays AngleNoise 

[50 (0 / 1.000)]

Noise in the ray angles. Use this parameter to break up the uniform angular distribution
of the rays.

Rays LenNoise 

[50 (0 / 100)]

Noise in the length of the rays. Use this parameter to break up the uniform length of
the rays.

Rays ThickNoise

[50 (0 /100)]

Noise  in  the  thickness  of  the  rays.  Use  this  parameter  to  break  up  the  uniform
thickness of the rays.
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Flares:

This group represents the lens flare effect. This effect  comprises a series of flares that  are
distributed along the line joining the origin and target of the effect.

 Color Red; Color Green; Color Blue

[100; 50; 50 (0 / 100)]

RGB Components of the flare color.

There is one flare that  has special treatment  due to its impact  on the result  of the effect.
This is the one produced in the origin of the effect. Its parameters are in the First block and
are:

First Active 

[Yes (No / Yes)]

Specifies if the effect is activated. 

First Intensity 

[100 (0 / 1.000.000)]

Intensity of the effect.

First Radius 

[100 (0.001 / 1.000)]

Radius  of  the  effect.  Represents  the  distance  between  the  origin  and  the  point
reached by the rays.

Flares Active 

[No (No / Yes)]

Specifies if the effect is activated.

Flares Intensity 

[30 (0 / 1.000.000)]

Intensity of the effect.

Flares Radius 

[20 (0.001 / 1.000)]

Maximum  radius  of  the  effect.  Represents  the  maximum  distance  from  the  origin
reached by the flares.
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Flares Length

[150 (-1.000 / 1.000)]

Length of the line along which the effect  is distributed. Represents the percentage of
the distance between the origin and the target.

Flares Rot

[0 (-1.000.000 / 1.000.000)]

Rotation of the flares.

Flares MinDecay 

[0.05 (0.05 / 1.000)]

Minimum decay of the flares.

Flares MaxDecay 

[1 (0.05 / 1.000)]

Maximum decay of the flares. 

Flares N.Flares 

[10 (1 / 100)]

Number of flares.

Flares N.Vertex 

[0 (0 / 100)]

Number of sides of the flares. 0 sides represents circular flares.

Flares SizeNoise 

[80 (0 / 100)]

Noise in the size of  the  flares.  Use  this  parameter to  break up  the  uniformity  in  the
size of the flares.

Flares HueNoise

[50 (0 / 100)

Noise in the tone of the flare color. Use this parameter to break up  the  uniformity  in
the color of the flares.

Ring:

This group represents the effect of a ring of light around the origin of the effect.
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 Color Red; Color Green; Color Blue

[100; 50; 50 (0 / 100)]

RGB components of the color of the ring.

Ring Active

[No (No / Yes)]

Specifies if the effect is activated.

Ring Intensity 

[50 (0,1.000.000)]

Intensity of the effect. 

Ring Radius 

[70 (0.001 / 1.000)]

Radius of the ring.

Ring Size 

[1  (0.1 / 1.000)]

Thickness of the ring. 

Ring Decay 

[1 (0.5 / 1.000)]

Decay of the ring towards its edges.

Rainbow:

This group represents a rainbow effect around the target of the effect.

 Color Red; Color Green; Color Blue

[100; 0; 0 (0 / 100)]

RGB Components of the color of the ring.

Rainbow Active 

[No (No / Yes)]

Specifies if the effect is activated. 
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Rainbow Intensity 

[50 (0 / 1.000.000)]

Intensity of the effect. 

Rainbow Radius 

[40 (0.001 / 1.000)]

Radius of the ring.

Rainbow Size 

[5 (0.1 / 1.000)]

Thickness of the ring. 

Rainbow Decay 

[0.5 (0.5 / 1.000)]

Decay of the ring towards its edges.

FlareFx:

Intensity

[100 (0 / 1.000.000)]

Specifies the global intensity of the effect. Affects all types of optical effect.

Radius

[50 (0.01 / 100)]

Specifies the global radius of the effect.

Rot.

[0 (-1.000.000 / 1.000.000)]

Specifies the global rotation of the effects.

Seed

[0 (0 / 1.000.000)]

Specifies the value of the random seed used to generate the effect.
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Use and Comments

This  effect  is  highly  optimized  for  speed,  and  real-time  can  be  achieved  in  modern
workstations.

Posterize

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Filter->Posterize

Simulates lower depth of color.

I/O

Inputs

Single input: Image with or without alpha channel. 

Inputs

Image: Image degraded by a lower depth of color. 

Alpha: No change. 

Parameters

Depth

[8 (1 / 256)] 

Specifies  the  depth of  color by  number of  levels.  The  number  of  levels  of  an  8  bit
channel is 256, the maximum value of this parameter.

ByLuma

[No (No / Yes)]

Specifies  whether  the  effect  works  based  on  luminance  rather  than  chrominance
values.

InAlpha

[No (No / Yes)]

Restricts the influence of the effect to the area specified by the alpha channel levels.

Use and Comments

This effect simulates a lower depth of color for the video color depth, which has 256 levels. 

This effect  can be used to simulate deterioration of quality, or to make the images  appear
colored as in a comic for example.
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Pointillize

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Filter->Pointillize

Paints  circular  spots  of  color  on  an  image,  which  when  joined  form  straight  cuts,  thus
achieving  the  appearance  of  an irregularly-shaped  mosaic.  The  spots  can  be  anamorphic
circles of any size, which can be  rotated  and  controlled  by  a  rotation map.  The  edges  of
the spots generate an alpha channel mask offering possibilities for later use.

I/O

Inputs

Double input: The first  is used as the background over which the  circular spots  will
be drawn. The second is used as a color map, so that the spots have the color of the
pixel that coincides with the center of the circular spot. 

Triple  input:  The  third  additional input  works  as  a  rotation  map,  making  the  spots
rotate proportionally to the  luminance  of  the  pixel that  coincides  with  the  center of
the circular spot. 

Inputs

Image: Color spots in the first input. 

Alpha: Mask of the edges of the spots.

Parameters

Density

[100 (0 / 100.000)] 

Specifies the density of the spots on the background image. High values increase the
number of spots, and vice-versa. 

Size X; Y

[1; 0.5 (0 / 100)] 

Horizontal and vertical sizes of the spots. 

Angle

[0 (-100.000 / 100.000)]

Initial rotation of the spots, expressed in degrees. 
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Bear in mind that  the rotation will not  be visible if  the circular spots are regular, with
identical values of Size X; Y.

Seed

[0 (0 / 100.000)] 

Seed for random positioning of the spots. This parameter can be animated so that  the
position of the spots are moved randomly.

Slopes

[Luminance (Luminance / Contour)] 

Permits  varying  the  rotation  of  the  brushstrokes  by  interpreting  the  rotation  map
based  on its  luminance  values  (Luminance)  or  on  outline  detection  (Contour).  This
parameter is not used when the effect does not have a fourth input.

Blur

[0 (0 / 100)] 

Blurs the  fourth  input,  thus  achieving  smoother luminance  transitions  in  the  rotation
map, and less sudden rotation of the brushstrokes. 

ColorVar

[0 (0 / 100)] 

Specifies random variability for the brushstroke color.

Chain

[0 (0 / 1.000)]

Creates  copies  of  the  original brushstrokes  in  the  form of  a  chain,  joined  from their
right-hand edge . 

This parameter is ideal at  high values, so that  the brushstrokes behave like lines that
change direction depending on the rotation map.

SizeVar

[0 (0 / 100)] 

Specifies a random symmetrical variability of the spot size.

E-Blur

[0 (0 / 100)]

Blurs the mask of the spot edges created in the alpha channel.
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E-Gain

[100 (0 / 100.000)]

Multiplies the intensity of the mask of the spot  edges created in the alpha channel by
the specified proportion.

Use and Comments

This  effect  is  almost  identical to  Brush Stroke,  except  that  Pointillize  only  works  with  an
internal circular brush, whose appearance can be specified. 

This effect has several orthodox uses, inserting copies of the same clip in all its inputs. The
first  frequent  use  is  to  generate  an  effect  of  irregular  mosaics  on  an  image,  simulating
stained glass. To do this, specify large circles (Size X; Y), and high densities (Density). 

Another use is to simulate a painted image. For this, specify high densities (Density) and try
different, preferably asymmetric, size values (Size X; Y). If  there  is  a  third  input,  the  Blur
parameter can attenuate sudden changes of rotation of the spots, making them appear to
be  continuous  brushstrokes.  The  Chain  parameter  is  also  highly  recommended  for  giving
brushstrokes longer tracks on the image. The colorVar  parameter can also transform colors
randomly to give an impressionistic effect. 

Another possible use is to compose the result of this effect  on the original image. The mask
generated by the effect consists only of the edges of the spots. If high values of Size X; Y
and  Density  are  specified,  the  composed  borders  give  the  sensation  of  looking  at  the
background image through broken glass.

Mosaic

Ref. Mistika: Fx->Mistika->Filter->Mosaic

Forms a mosaic  of rectangles  of  the  same  size,  colored  by  the  predominant  values  in  the
original image.

I/O

Inputs

Single input: Image with or without alpha channel. 
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Inputs

Image: Color mosaic. 

Alpha: No change.

Parameters

SizeX

[0 (0 / 100)] 

Horizontal size  of  the  mosaic.  This  parameter  is  expressed  as  a  percentage  of  the
image height.

SizeY

[0 (0 / 100)] 

Vertical size of the mosaic. This parameter is expressed as a percentage of the image
height.

 InAlpha

[No (No / Yes)]

Restricts  the  influence  of  the  effect  to  the  areas  specified  by  the  alpha  channel
levels.

Use and Comments

This effect is typically used in television to prevent  recognition of an area of the image, for
example, a product name or the face of a protected witness. For this purpose, the InAlpha
parameter can be  used,  which will  restrict  the  action of  the  effect  to  the  area  of  mask
opacity. 

Outlines

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Filter->OutLines

Combines an original image with an unfocussed copy with the Difference operation. 

I/O

Inputs

Single input: Image with or without alpha channel. 



568 FX

SGO Mistika 8.6 © 2018 SGO

Inputs

Image: Image resulting from the comparison. 

Alpha: No change. 

Parameters

Blur

[1 (0 / 100)] 

Blurs the copy of the image to be combined with the Difference operation.

Gain

[100 (-100.000 / 100.000)] 

Multiplies the luminance of the resulting image by the specified percentage.

Use and Comments

This  effect  normally  is  used  to  obtain  an  image  of  the  outline  of  figures  that  can  be
distinguished in an image. 

This  effect  can be  simulated  with  other  effects,  by  combining  a  Blur  (Type  Gauss)  with
Channels.

Band Dither

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Filter->Band Dither

This effect reduces banding problems that can exist in images. 

Banding is an artifact that can appear in images that have deteriorated as a result  of digital
processes, seen as recognizable color bands in areas where there should be a subtle grading
between colors. 

The  Band  Dither  effect  makes  these  bands  less  conspicuous,  softening  their  edges  by
randomly intermixing pixels of adjacent  areas, thus breaking up the regularity of the bands.
The  human eye  is  much  more  tolerant  of  noise  (such  as  dithering),  and  considers  it  as
something natural in the image, compared with bands of isolines, which seem very unnatural
to an observer. 

The  difference  between this  effect  and  normal Dither  is  that  is  capable  of  detecting  the
true borders belonging to image details and differentiating  them from the  banding,  so  that
the latter can be removed without  affecting  the  borders.  The  Cutoff  parameter should  be
adjusted to do this.
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I/O

Inputs

Single input: Image with or without alpha channel.

Inputs

Image: Image without banding. 

Alpha: Mask without banding. 

Parameters

Amount

[2 (0 / 100)] 

Specifies  the  maximum pixel intermixing  distance  for  adjacent  bands  when  dithering
the effect. 

Cutoff

[3 (0 / 100)] 

Specifies the application tolerance of the effect depending on contrast. 

If  the tolerance is low, only  pixels  of  similar values  will  be  affected,  thus  preventing
the  effect  having  influence  on  important  details  of  the  image.  If  the  tolerance  is
greater, pixels that with greater mutual contrast will also be affected. 

Seed

[0 (0 / 100.000)]

Seed for noise generation. 

This  can  be  animated  if  necessary  to  simulate  moving  noise  in  static  images  of
computer graphics, usually to integrate them better with sequences from video or cine
sources.

Use and Comments

Bear in mind that the reduction of banding originally contained in an image can only be done
with the use of random noise, which in  some  cases  can become  markedly  visible.  For this
reason,  the  parameters  of  this  effect  should  be  carefully  specified,  since  there  are  no
values that can be recommended for all possible cases. 

In the first  image of the example below, the  original image  is  shown,  and  in  the  second  a
detail in which its banding can be seen, in the form of recognizable green bands. The third
image  shows  the  suppression  of  this  defect,  leaving  intact  the  character’s  details  and
affecting only the bands.
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Note: Although the effect  removes the banding  correctly,  the  image  in  the  example  could
still show banding depending on the type of printing or graphics  mode  employed  to  see  it,
given  that  many  of  these  modes  and  compression  formats  for  documents  can  cause
deterioration of color quality.

Enhance

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Filter->Enhance

Enhances contrast in a detail size range.

I/O

Inputs

Single input: Image with or without alpha channel. 

Inputs

Image: Blurred image. 

Alpha: Opaque mask.

Parameters

RadL

[0.5 (0 / 100)] 

Lower limit of the detail range, specified by the minimum detail radius to be enhanced. 

RadH

[1 (0 / 100)] 

Upper limit  of the detail range, specified  by  the  maximum radius  of  the  details  to  be
enhanced. 

Ampl

[100 (-1.000 / 1.000)] 

Amount of enhancement to be applied to the range. Negative values blur details within
the range.
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Use and Comments

This filter is ideal for enhancing contrast  in image areas  without  detail,  thus  balancing  the
areas of contrast in the entire image. 

If the RadL parameter value  is  higher than the  RadH,  the  effect  will  invert  its  range,  and
therefore its application will be reversed, similar to using the Ampl parameter with negative
values. 

If the range specifies low levels of detail, for example with RadL set  to 0 and RadH to 0.3,
the effect  will enhance the details in exactly the same way as the Sharpen effect  with its
Amount parameter set to 0.3. The difference compared with Enhance is that  the latter has
a parameter specified by an action threshold set  by a detail size that  can be adjusted with
the RadL parameter. 

A typical use of this effect  is to compensate for the contrast  normally found in the details
of images obtained by video cameras. If Enhance is applied with its default  values, average
detail values are emphasized. 

By experimenting with the parameters of Enhance, the optical filters that  are often used in
telecines can be simulated. 

The following example shows the results of using different parameter values.

Brush Stroke

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Filter->Brush Stroke

Paints  color brushstrokes  with  a  definable  shape  on an image.  The  size,  appearance  and
rotation can be modified, and a rotation map can also be used.

I/O

Inputs

Triple input:

The first is used as the background upon which the brushstrokes will be drawn. 

The second is used as a color map, giving the brushstrokes the color of the pixel that
coincides with the center of the brushstroke. 

The third input  specifies (via its luminance) the shape of  the  brushstroke,  which has
the color specified by the color map. 

Quadruple input: The fourth additional input  is  used  as  a  rotation map,  making  the
brushstrokes rotate proportionally to the luminance of the pixel that coincides with the
center of the brushstroke. 

Inputs

Image: Image with the applied effect. 
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Alpha: Opaque mask.

Parameters

Density

[100 (0 / 100.000)] 

Specifies  the  density  of  the  brush  strokes  on  the  background  image.  High  values
increase the number of brush strokes, and vice-versa.

Size X; Y

[1; 0.5 (0 / 100)] 

Resets the horizontal and vertical size of the brush strokes.

Angle

[0 (-100.000 / 100.000)]

Initial angle or rotation of the brush strokes, expressed in degrees.

Seed

[0 (0 / 100.000)] 

Seed for the random positioning of the brush strokes. This parameter can be animated
so that the positions of the brush strokes are moved randomly.

Slopes

[Luminance (Luminance / Contour)] 

Permits the rotation of the brush strokes to be varied by interpreting the rotation map
based  on its  luminance  values  (Luminance)  or  on  outline  detection  (Contour).  This
parameter is not used when the effect does not have a fourth input.

Blur

[0 (0 / 100)] 

Blurs the  fourth  input,  thus  achieving  smoother luminance  transitions  in  the  rotation
map, and less sudden rotation of the brush strokes.

ColorVar

[0 (0 / 100)] 

Specifies a random variability of the brush stroke color.

Chain

[0 (0 / 1.000)]
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Creates  copies  of  the  original brush strokes  in  the  form of  a  chain,  joined  at  their
right-hand side. 

This parameter is ideal set  at  high values, so that  the brush strokes  behave  as  lines
that change direction based on the rotation map.

SizeVar

[0 (0 / 100)] 

Specifies a random symmetrical variability in the brush stroke size.

Use and Comments

The most common use of this effect is to simulate impressionist painting styles.

The brushstrokes act as bitmaps colored by a color map that can control the appearance of
the brushstrokes by their luminance, and so the position of these brushstrokes can also be
controlled, making a mask or color correction in  order to  select  color ranges  in  the  image
that  will  be  the  color map.  Thus  we  can add  star-shaped  brushstrokes,  for example,  and
add definable glints to highlights. This possibility in BrushStroke allows us to add bitmaps in
selected pixels.

The rotation map also allows us to use this effect  as a simple way of rotating brushstrokes
in accordance with the luminance of the fourth input. If the fourth input  is assumed to be a
Circle  effect  with  Rad  and   Soft  values  of  25,  the  distance  of  the  brushstrokes  to  the
center  of  the  circle  provokes  a  proportional  rotation,  behaving  in  a  similar  way  to  an
expression  specifying  that  the  nearer  the  brushstroke  to  the  center  of  the  circle,  the
greater the rotation.

In the example, the results of different parameter values can be seen. 

In  certain  cases,  different  rotation  and  color  maps  are  used,  which  will  appear  as  small
images to the left of each image. The effects in which no parameter value exists are to be
interpreted as keeping the value of the previous example.
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Rain Fx

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Filter->Rain Fx

This effect creates the appearance of raindrops on water which evolve with time, producing
the corresponding waves, and giving the sensation of rain in the input  image. The raindrop
areas can be  generated  either with  random shapes,  or based  on input  images.  Effects  of
ship's  wakes  or  other  effects  of  waves  on  liquids  can  also  be  generated  by  using  the
animation present in the inputs.

I/O

Inputs

Multi-input: With or without alpha channel. 

The first input is the one applied to the effect. 

The  remaining  inputs  will  be  used  to  generate  drops  using  the  luminance  of  each
frame. (The light areas in each frame produce new impacts).

Inputs

Image: Sequence with the effect applied.

Alpha: Texture of the distortions in water.

Parameters

Drip Rad

[0.1 (0 / 50)]

Specifies the radius of the random drops generated by the system as a percentage of
the image width. 

Life

[1 (0,01 / 100)]

Specifies the life of the drop to the time of its disappearance. Higher values increase
the life of the drops. 

A value close to 0 will cause the drop to disappear almost as soon as it falls. 

This value is not measured in frames. 

Hits

[0 (0 / 1.000)]

Specifies the number of drops that  fall per frame. A value  of  less  than 1 produces  a
single drop every few frames. 
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Depth

[60 (-100 / 100)] 

Specifies the force with the drops fall. A negative value means that  the drops lift  the
water, instead of sinking it. 

Seed

[0:100.000 (0 / 100.000)] 

Specifies the seed for the generation of random numbers. 

Refr.

[0 (-100 / 100)]

Specifies  the  refraction  factor  of  the  water.  Negative  values  change  refraction  to
reflection. 

AntiAlias

[0 (0 / 7)]

Specifies the number of multiple samples to be made for antialiasing the effect. 

The greater the value, the greater the antialiasing. 

Obey Msk

[No (No / Yes)]

Restricts the influence of the effect to the area specified by the alpha channel levels.

Use and Comments

If the effect only has one input, this will cause the raindrops to fall on it. 

If it  has more than one input, the second and further ones will be used for the creation of
additional  drops,  by  making  the  luminance  of  each  pixel  produce  a  drop.  With  these
additional images it  is possible to make  the  drops  fall  in  the  desired  place,  or achieve  the
effect  of  a  trail  produced  by  an  object  in  movement  and  making  the  drops  are  move
following any path.

Very interesting drop effects can be achieved by applying the Bump effect  to the output  of
this effect.

Important  note:  The  result  of  the  Rain  Fx  effect  is  an  effect  with  feedback.  In  other
words,  each image  depends  on the  result  of  the  previous  one.  Thus  the  result  seen in  a
frame  during  playback,  will  not  be  the  same  as  the  one  seen  if  the  frame  is  accessed
directly to  the  frame  without  carrying  out  playback.  In  addition,  when playing  in  reverse,
the distortion map of the water is reset, so that, to remove the distortion map at  any time
to clean up the image, simply go back a frame in the clip. 
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Generate

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Image

The  Generate  menu collects  together a  wide  variety  of  “generating”  effects  for  creating
new entities not existing in the input images, such as text, noise, degrades, etc.

Title

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Image->Title

Generates texts by means of a vectorial plane that can be animated.

I/O

Inputs

This  effect  can function without  input,  generating  a  white  text  on black,  or a  solid
color with the text generated in the alpha channel

Single  input:  Image.  The  alpha  channel  will  be  replaced  by  the  image  of  the
generated text or will be superimposed by the generated text, according to the Apply
parameter. This effect can therefore be used directly to generate text and compose it
on an image,  since  it  can apply  the  text  on the  input  of  the  effect  (specifying  the
Apply parameter in Image value).

Inputs

Without input:

Image: color image of the generated text depending on the Apply parameter. 

Alpha: Opaque mask or with generated text depending on the Apply parameter.

Single input:

Image:  Image  without  changes  or with  superimposed  text  depending  on  the  Apply
parameter. 
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Alpha:  Opaque  mask or with  image  of  the  generated  text  depending  on  the  Apply
parameter. 

Title Editor

Ref. Mistika: Visual Editor->Dashboard->Title

This  effect  has  an  extra  interface  extra  (Title  Editor),  in  which  texts  are  written.  It  is
accessed via Mistika->Visual Editor->Manipulators Tabs->Title.

This interface is divided into two zones: Input Area and Attributes.

Input Area

This is where the texts to be generated are written.

To  use  characters  pertaining  to  the  language  used  (accents,  monetary  symbols  etc),
configure the keyboard via the OS application Keyboard Layout.

Attributes

This area has different sets of buttons that define the characteristics of the texts created.

To  change  the  attributes  of  a  character or paragraph already  typed,  simply  highlight  the
text, select Attributes, and define the new value.

Current Font

This box indicates the name of the current font or typeface.

Font List

This list  allows the font  to be set. The selection mode is direct  by clicking with the mouse
over the name of the font to be used. 

To install fonts in the system, consult the appendix of this document.

In  all  cases,  once  the  fonts  are  loaded  in  the  correct  place,  refresh the  list  of  fonts  by
clicking Reload Font  List. Unlike versions prior to v2.0, this list  of fonts shows the name  of
the font and not the name of the file containing the font. 

Font Size

Value defining the size of the font. Bear in mind that  the  size  of  all  fonts  can be  modified
with the zoom parameters of this effect.

30, 50, 70 and 100 are quick access buttons to predefined values.

Kerning

Value defining the space between characters.

Normal, Medium and Wide are quick access buttons to predefined values. 

Leading

Value defining the space between text lines.

Normal, 1.2 and 1.5 are quick access buttons to predefined values.

Slant Angle

Value defining the inclination of the characters.

Oblique defines the default value. 

Normal defines no inclination.

Align
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Set of buttons that define the alignment of characters to different margins of the image.

Left aligns the text to the left.

Center aligns the text to the center.

Right aligns the text to the right.

To the right of the Input  Area there is a set  of buttons for animating and storing the texts
created.

Roll Up and Roll Down

Set  of  buttons  that  define  Roll  animations  in  the  values  of  the  parameters  of  the  effect,
affecting all texts generated.

Roll Up defines an upward roll, as seen in the final credits of movies.

Roll Down defines a downward roll of the text.

The box OffsetX defines an additional offset value at the start of the Roll movement.

Crawl

Set  of buttons that  define Crawl animations in the values of the parameters of the effect,
affecting all texts generated.

Crawl Left  defines a text  animation moving right  to left, as  seen in  the  final credits  of  TV
programs or legal texts superimposed in TV commercials.

Crawl Right defines a text animation moving left to right.

The box OffsetY defines an additional offset value at the start of the Crawl movement.

File

Set of buttons for saving and loading text in the interface.

Load  Text  opens  a  dialog  box to  load  texts  without  attributes  that  have  previously  been
saved by the same effect  or external text  processing  applications.  This  function can only
load ASCII type unformatted text.

These files must have the .txt extension 

Save Text opens a dialog box to save texts typed in Input, ignoring their attributes. These
files will have the .txt extension and will be saved by default in the Output folder.

Load Formatted opens a dialog box to load texts with attributes that  have previously been
saved by the same effect.

Save Formatted opens a dialog box to save texts typed in Input, ignoring  their attributes.
These files will have the .ftxt extension and will be saved by default in the Output folder.

Back closes the Title interface. 

Parameters

Color:

Parameters that defines the color and opacity values of text.

Red; Green; Blue

[100; 100; 100 (0 / 100)]

Specifies  the  color of  the  text.  This  color  is  unique  for  all  fonts  generated  by  the
effect.
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Level

[100 (0 / 100)]

Specifies the opacity of the generated text  (alpha channel value),  assigning  a  single
opacity value for all the text generated by the effect.

Title:

Parameters that defines disposition of text.

Rot X; Y; Z

[0; 0; 0 (–900.000 / 900.000)]

Specifies the amount of rotation in each axis. The center of rotation is determined by
the Center parameter.

Wide

[3 (1,33/ 10.000)]

Specifies  the  leakage  of  the  distortion  of  the  vectorial  plane  where  the  text  is
generated. The leakage is only visible if the vectorial plane is rotated in X or Y.

Zoom X; Y

[100; 100 (–100.000 / 100.000)]

Specifies the scale (amount of zoom). The scaling center is determined by the Center
parameter.

Move X; Y

[0; 0; 0 (–900.000 / 900.000)]

Specifies the amount of offset in each axis. The position of the axes X and Y  are can
be specified with the 2D manipulation mode.

Cent X; Y

[50; 50 (–10.000 / 10.000)]

Specifies the position of the centers of rotation and scaling.

Samples

[4 (1 / 32)]

Number of samples in the render processes. 

High values specify greater number of samples, noticeably improving the image quality
of the result, very visible in the details of the font, edges and in text  that  has  been
reduced in size.
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ArcsDiv

[1 (1 / 10)]

Specifies  into  how  many  segments  the  curves  of  vectorial  text  are  subdivided.  The
greater the number of segments, the smoother the curves.

Reveal

[100 (0 / 100)]

Sets the percentage of hidden/visible text. A value of 0 totally hides the text  and 100
totally reveals it. The text can be viewed gradually by animating this parameter.

GapsX

[0 (–900.00 / 900.000)]

Scales  the  kerning  parameter  (space  between  letters)  respecting  the  alignment  of
each line.

GapsY

[0 (–900.00 / 900.000)]

Scales the parameter of leading (space between lines).

Size

[100 (–900.00 / 900.000)]

Scales  the  parameter  of  size  (size  of  letter)  without  altering  the  kerning  (space
between letters).

Angle

[0 (–900.00 / 900.000)]

Scales the parameter of Angle (inclination between letters).

Apply

[Image (Image/Mask)]

Defines the channel where the text is generated. 

Image: The text  is generated in the channels of the image  (RGB).  If  the  effect  has
one input, the text is drawn on the image. If the effect  has no input, it  is drawn on a
black background.

Mask: The  text  is  generated  in  the  alpha  channel,  without  altering  the  channels  of
the image. 
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Use and Comments

All the texts  generated  by  Title  are  written in  a  plane  that  can be  positioned  in  a  "three
dimensional space" via animable parameters, and can be scaled without losing quality thanks
to the vectorial typefaces.

Note  that  the  processing  speed  of  this  effect  is  very  closely  linked  to  parameters  that
increase  the  resulting  image  quality,  such  as  Samples  and  ArcDiv  for  example;  we
recommend that these are carefully set to the minimum values that give the desired quality,
since misuse of these values can slow down the performance of the effect. 

The effect  generates fonts without  texture, so that  they can be  used  with  other effects.
Some examples of textures generated in combination with other effects  of  the  system are
shown below:

Solid

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Image->Solid

Generates an image with a single color.

I/O

Inputs

None. 

Inputs

Image: Assigned color. 

Alpha: Opaque mask. 

Parameters

Red; Green; Blue

[0; 0; 0 (0 / 100)] 

Specifies the RGB value of the solid color. 

Format

[HDR-HW (RGBA8b / YUV422 / RGB10b/ HDR-HW)] 

Specifies the color space  used  to  generate  that  which will  generate  the  solid  color.
This may be YUV 422, RGB.
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The RGBA8b space assigns 8 bits or RGB 10 per channel and additionally 8 bits for the
alpha channel. The other two modes do not generate alpha.

Alpha

[100 (0 / 100)] 

Specifies  the  alpha  value  of  the  solid  color  (only  available  in  RGBA8b  and  HDR-HW
formats)

Use and Comments

The purpose of this effect is simply to create a solid color.

This  effect  has  no  field.  To  defines  the  color  use  the  panel  Set  Color  (Visual  Editor-
>Manipulators  Tabs-Set  Color),  activated  by  doubleclicking  on  the  effect  in  the  Node
Graph.

Grade

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Image->Grade

Generates a color gradient from all of the four corners of an image.

I/O

Inputs

None.

Inputs

Image: color gradient from the four corners. 

Alpha: Opaque.

Parameters

Mode

[HDR-HW (SW-RGBA8b /HDR-HW )]

SW specifies that the calculation is done by software.

HW-HDR specifies that the calculation is done by hardware, in 16 bits color depth per
channel (HDR stands for High Dynamic  Range). This mode is recommended fro  images
that have more than 8 bits per channel, typically those obtained from a film scanner.

UpLeft R; G; B

[100; 100; 100 (0 / 100)] 

Specifies the color of the top left corner.
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UpRight R; G; B

[100; 100; 100 (0 / 100)] 

Specifies the color of the top right corner.

DownLeft R; G; B

[100; 100; 100 (0 / 100)] 

Specifies the color of the bottom left corner.

DownRight R; G; B

[100; 100; 100 (0 / 100)] 

Specifies the color of the bottom right corner.

Use and Comments

This effect  has no field. To defines  the  use  Set  Color  (Manipulators  Panels),  activated  by
doubleclicking on the effect in the Node Graph. 

The purpose of this effect is simply to create a color gradient from the four corners.

Remember  that  all  four  corners  can  be  colored  with  the  same  color,  by  selecting  the
subfolder of each corner and using Copy Curve  and  Paste  Curve  in  the  Parameters  Panel.
(Mistika->Parameters->Clipboard->Copy Curve/Paste Curve)

Circle

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Image->Circle

Generates white circles on a black background, of sizes that  can be specified, with control
of the smoothness of their edges. 

This  effect  is  used  to  generate  WipeCircle  of  the  Wipe  Library  (Mistika->Node  Graph
Editor->Dashboard->Edit->Wipes);  as  such,  its  description  and  parameters  are  the
same as WipeCircle.

This effect is easy to combine with other effects. Its uses can be different and varied. 

It  can basically be used as a mask, or a  rotation,  distortion,  blur or displacement  map for
different effects that use these types of map.

Stripe

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Image->Stripe

Generates  patterns  of  bands,  with  control  of  the  smoothness  of  their  edges,  width  and
spacing between them.

This effect is used generate the wipes of the Wipe Library (Mistika->Node Graph Editor-
>Dashboard->Edit->Wipes);  as  such,  as  such,  its  description  and  parameters  are  the
same as WipeStripe.
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This effect is easy to combine with other effects. Its uses can be different and varied. 

It  can basically  be  used  as  a  mask,  or  rotation,  distortion,  blur  or  displacement  map  for
different effects that use these types of map.

Wave

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Image->Wave

Generates an image of concentric waves.

I/O

Inputs

None. 

Inputs

Image: Pattern of concentric waves. 

Alpha: Opaque mask. 

Parameters

Wave_1:

Dropdown folder that contains the parameters of the default wave. The layers created later
are added to this  one,  as  an identical folder identified  by  its  number that  is  increased  as
they  are  created.  Creation,  copying  and  deletion  of  layers  are  controlled  from  the
commands  tab  located  in   Mistika->Node  Graph  Editor->Mistika->Main  Tabs-
>Parameters->Folder.

CentX; Y

[50; 50 (-100.000 / 100.000)] 

Position of the wave generator, in percentage values of the image size. 

WLen

[20 (0,001 / 100.000)]

Length of the waves. 

Phase

[0:400 (-100.000 / 100.000)] 

Evolution of  the  waves.  This  parameter  should  be  animated  so  that  the  generator
sends the waves from its center towards the periphery. 

Ampl

[100 (-100.000 / 100.000)]
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Specifies the amplitude of the waves. The greater the value, the greater the contrast
between the generated waves. 

Decay

[65 (0 / 1.000.000)] 

Specifies the decay of the amplitude as a function of the distance of the  wave  from
its generator. 

Count

[100 (0 / 1.000.000)] 

Specifies the maximum number of wave phases that the effect will generate. 

Use and Comments

This effect is easy to combine with the other effects. Its uses can be widely different  and
varied. 

It can basically be used as a mask, or as a rotation, distortion, blur or displacement  map for
different effects that use these types of map.

Noise

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Image->Noise

Permits generating noise animated with a color option.

I/O

Inputs

None.

Inputs

Image: Noise pattern in black and white or color. 

Alpha: Opaque mask. 
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Parameters

Seed

[0 (0 / 100.000)]

Seed  of  the  random generation of  noise.  Can be  animated  if  necessary  to  simulate
noise in movement. 

Rad X ; Y

[0 (0 /100.000)] 

Specifies the average horizontal and vertical radius of the noise. 

Qual

[2 (0 / 3)]

Specifies the filtering quality of the effect. 

Color

[No (No / Yes)] 

Pan X; Y

[0; 0 (-100.000 / 100.000)] 

Specifies the offset of the noise. This parameter can be manipulated with the Set  Pos
mode. 

Cycle

[0 (-100.000 / 100.000)]

Specifies the evolution of  the  noise,  producing  a  gradual change  of  the  positions  of
the spots generated by the effect. 

Mode

[Normal (Normal / Plasma)]

Specifies type of noise required: normal or plasma. 

Use and Comments

This effect is a tool that is very easy to combine with other effects. Its uses can be widely
different. 

It  can be  used  basically  to  generate  a  smoke  or steam texture,  as  a  rotation,  distortion,
refraction, blur or displacement map for different effects that use these types of map. 

Simulation of  textures  and  materials  can  be  attained  by  manipulating  its  parameters  and
combining it with other effects. 
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In  the  first  image  of  the  following  example,  color  corrections,  offset  maps  and  three-
dimensional lights are  used  within  the  Comp3D effect  to  simulate  clouds  and  seas.  In  the
second image, the same effect  is  used,  but  to  imitate  wood.  In  the  third  image,  the  Blur
(Type Grow) effect  is used to Blur  (Type  Schrink)  the  red  channel and  enlarge  the  green
channel of the image produced with Noise, with its Mode parameter set to No.

If the Cycle parameter is animated, noise evolution is achieved, which is useful for imitating
the behaviour of waves or steam.

Fractal

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Image->Fractal

Generates an image of animable fractal noise, optionally in color.

I/O

Inputs

None.

Inputs

Image: Noise pattern in black and white or color.

Alpha: Opaque mask.

Parameters

Seed

[0 (0 / 100.000)]

Seed for the random generation of noise. It  can be animated if  necessary to simulate
noise in movement. 

Levels

[8 (4 / 16)]

Number of  noise  levels.  The  more  levels,  the  greater the  size  of  the  noise  pattern.
Decimal values are allowable, which specify mixing from one level to the next. 

Decay

[2 (1 / 6)]

Decay of the visibility of noise details.  The  lower the  value,  the  more  noise  detail  is
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viewed.

Contrast

[200 (-100.000 / 100.000)]

Control of the noise contrast. 

Color

[No (No / Yes)] 

Option to obtain noise in random colors. 

Pan X; Y

[0; 0 (-100.000 / 100.000)] 

Specifies the noise offset. This parameter can be manipulated with the Set Pos mode. 

Cycle

[0 (-100.000 / 100.000)]

Specifies the progress of the noise, producing a gradual change of the positions of the
marks generated by the effect. 

Mode

[Normal (Normal / Plasma)]

Specifies type of noise required: normal or plasma. 

Use and Comments

This effect is a tool that is very easy to combine with other effects. Its uses can be widely
different. 

It  can basically  be  used  to  generate  a  smoke  or steam texture,  as  a  rotation,  distortion,
refraction, blur or displacement map for different effects that use these types of map. 

Unlike Noise, this effect generates synthetic  noise which thanks to its reproduction method
hides its cyclical pattern, making it less recognizable.

In the first  image of the following example,  color correction is  used  to  simulate  marble.  In
the second image, LiquidBump is used to simulate mercury. In the third image, two Fractal
effects  are  combined  with  And,  one  to  generate  the  basic  color  texture  (with  the  Color
parameter set to Yes) and the other to simulate the shape of a nebula. 
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Mandelbrot

Ref. Mistika:Node Graph Editor->Dashboard->Fx->Mistika->Image->Mandelbrot

Generates an algorithmic Mandelbrot-type texture.

I/O

Inputs

None.

Inputs

Image: Mandelbrot image.

Alpha: Opaque mask.

Parameters

ShadeCount:

Folder that contains the parameters that  specify the base color from which the Mandelbrot
will be generated.

Red;Green;Blue

[64; 64; 64 (1 / 512)]

RGB value of the base color.

Box_1:

Dropdown folder that contains the parameters of the default viewing box. These boxes allow
the  specification of  which part  of  the  Mandelbrot  is  to  be  viewed,  in  a  similar  way  to  a
magnifying glass. 

Boxes that are created later will be added to this one, as an identical folder identified by its
number, which is increased as they are created. Creation, copying and deletion of boxes are
controlled  from  the  commands  tab  located  in  Mistika->Node  Graph  Editor->Mistika-
>Main Tabs->Parameters->Folder.

Left

[0 (0 / 100)]

Left edge of the viewing box as a percentage of the image width. 

Right

[100 (0 / 100)]

Right edge of the viewing box as a percentage of the image width. 



590 FX

SGO Mistika 8.6 © 2018 SGO

Up

[100 (0 / 100)]

Top edge of the viewing box as a percentage of the image height. 

Down

[0 (0 / 100)]

Bottom edge of the viewing box as a percentage of the image height.

Mandelbrot:

Iterations

[64 (0 / 256)]

Number of branches of the texture.

Box_#

[256 (0 / 256)]

Specifies which box will be viewed. Decimal values indicate a gradual change from one
box to the next.

Use and Comments

The purpose of this effect  is simply to  generate  a  Mandelbrot  image  from which a  part  of
the texture with the parameters of Box_1 can be selected, in order to amplify and visualize
it  in  detail.  In  addition,  animations  can  be  created  with  an  the  interpolation  of  different
Boxes, with the Box_#.parameter. 

In the example, different levels of detail can be seen. 
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Blur/Sharp

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Blur/Sharp

The menu Blur/Sharp contains spatial filters, blur filters and effects to increase the detail of
a image.

Blur

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Blur/Sharp->Blur

This  effect  views  a  clip  name  composed  of  its  two  first  parameters,  so  this  description
makes reference to the name of the effect according to its type and application mode.

It  is  an effect  that  applies  spatial  filters  to  any  of  the  channels  of  the  image  (RGBA  or
chrominance),  blurring,  shrinking  or increasing  its  bright  surface,  optionally  controlling  the
radius of the application according  to  an attenuation map,  and  also  ,  in  "figure”  mode  for
clips that are composed in a prior process.

The  effect  can  be  accessed  via  the  effects  gallery,  the  hotkey  presets  and  a  specific
button within the gallery, but  in  fact  only  this  effect  is  accessed  since  it  brings  together
many possible functions.

I/O

Inputs

Single input: Image with or without alpha channel.

Inputs

Image: Image with the specified filter applied.

Alpha: Mask with the specified filter applied
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Parameters

Modes:

Folder that  contains the  parameters  that  specify  the  type  of  spatial  filter and  application
and calculation modes.

Type

Gauss, Box, Circle, Median, Grow, Shrink

Specifies the type of matrix applied as filter.

Gauss is a classic soft defocussing and blurring filter.

Box is a classic  soft  defocussing  and  blurring  filter,  quicker to  calculate  than Gauss,
but with a square matrix that is reconcilable with hight radius values.

Circle  is a blurring filter that uses a circular matrix, with a slower processing time, but
is recommended for emulating camera blurs.

Median is a classic noise reduction filter.

Note: some graphics cards do not  support  the median-type filter, so in this case it  is
recommendable to use Sware render mode.

Grow is a classic filter for expanding bright zones in the image channels.

Shrink is a classic filter for shrinking bright zones in the image channels.

Note:  The  type  of  matrix specified  is  viewed  as  the  first  part  of  the  name  of  the
effect clip in the Node Graph.

Mode

RGB, RGB-InA, Chroma, Chroma-InA, R, G, B, A, RGBA, Foreground, RGB-RadA

Specifies the application mode of the type of filter set.

RGB applies the filter to the RGB channels, leaving the alpha channel unchanged.

RGB-InA applies  the  filter to  the  RGB channels  according  to  the  opacity  set  by  the
alpha channel, leaving the alpha channel unchanged.

Chroma  applies  the  filter  to   the  chrominance  values  of  each  pixel,  leaving  the
luminance values unchanged.

Chroma-InA applies the  filter to   the  chrominance  values  of  each pixel according  to
the  opacity  set  by  the  alpha  channel,  leaving  the  luminance  and  alpha  channel
unchanged.

R, G, B, A applies the filter only to red, green blue and alpha channels.

RGBA applies the filter to RGB and Alpha channels.

Foreground applies the filter to the RGB channel according to the opacity set  by  the
alpha  channel,  adding  a  “divide”  function  to  de-premultiply  the  background  figure,
leaving the alpha channel unchanged.

RGB-RadA  applies  the  filter to  RGB channels,  leaving  the  alpha  channel  unchanged,
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using the alpha channel the Radius parameter as attenuation map.

Note: The type of matrix specified is viewed as the second part  of  the  name  of  the
effect clip in the Node Graph. For example, a blur filter of Gaussian type only in mask
mode will be viewed as Gauss:A. A Box type filter applied in Foreground mode  will  be
viewed as Box:Foreground.

Render

HWare, Sware

Specifies that the processing will be calculated by software or hardware.

Note:  the  default  option  (HWare)  is  recommended  as  modern  graphics  boards  are
optimized to work even in depth of up to 16 bits per pixel.

Radius:

Folder  that  contains  the  parameters  that  control  the  application  radius  of  the  specified
filter.

Radius

[0 (0 / 100)]

Controls the application radius of the specified filter.

Note:  if  an  attenuation map  (for  example  the  alpha  channel  in  RGB-RadA  mode)  is
used, this parameter specifies the maximum application radius.

Anamorph

[0 (-100 / 100)]

Specifies an anamorphic aspect to the matrix used by this effect. 

The default  value indicates that  the  filter acts  symmetrically  between the  horizontal
and  vertical axes.  Positive  values  gradually  restrict  the  action  of  the  effect  to  the
vertical axis, whereas negative values restrict them to the horizontal axis

Units

[10.000 (1 / 1.000.000)]

Scales the value of the Radius parameter.

Note: this parameter should be used to find the best scale for the size of the image to
be processed, the Radius parameter is relative to image  size,  and  a  low  radius  value
for  SD  resolution  might  be  much  greater  in  HD.  Use  this  parameter  to  reset  the
parameter  scale  that  specifies  the  radius.  To  use  the  scale  in  versions  of  Mistika
earlier than v4.0, the parameter should be set at 100.

Use and Comments

The Box spatial filter averages the pixel values  with  a  square-shaped  matrix of  decreasing
radial influence.  This  results  in  the  softening  of  the  transitions  between  opposing  values,
with an appreciable blurring of the outlines.
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In the following example, it can be seen that, when the Amount parameter of the effect  has
high values, the square matrix that the filter uses for blurring becomes noticeable. With the
Anamorph parameter, the action of the filter can be gradually restricted to either of the  2
two-dimensional axes.

The  Gaussian  spatial  filter averages  the  pixel  values  with  a  circular  matrix  of  decreasing
radial influence.  This  results  in  the  softening  of  the  transitions  between  opposing  values,
with  an appreciable  blurring  of  the  outlines,  similar  to  seeing  an  image  through  a  misted
glass. 

In the following example it  can be appreciated that  the  Gauss  filter,  compared  to  the  Box
filter, requires a lower Amount  value to blur the image, and the shape of the matrix of  the
filter is imperceptible. When the filter action is restricted  entirely  to  a  single  axis  by  using
the Anamorphparameter, the result of the effect  is almost  identical to that  of  Box since in
the latter case it does not take advantage of the shape of the matrix of theGauss filter.

The Circle spatial filter averages the pixel values with a circular-shaped matrix. This softens
the transitions between opposing values, giving a visual result  that  enlarges  and  roughens
outlines, similar to defocussing. Thus this filter is the most appropriate for simulating camera
blurs. 

In the following example, it  can be seen that  when the effect  has  high Amount  parameter
values, the circular matrix used by the filter for blurring is clearly visible.

In RGB-RadA mode, the alpha channel is used as an attenuation map and does not  defines a
level of opacity in the application of the filter, but  rather attenuates the defocussing value
defined by the Radius parameter, and therefore it  is not  the same as using the  Blur  effect
with the  RGB-InA mode activated..

In the following example both effects are compared.

The attenuation map can be generated for example with VectorPaint to simulate a reduction
of the depth of field. In the following example a practical use can be seen.
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The filters  Grow and Shrink are basic  filters which can be used to achieve various results.
One  possible  use  is  to  control the  brightness  of  an image  modifying  RGB channels  by  the
same small decimals values. High value make the filter's geometry visible in the image.

If  channels  are  modified  with  different  values,  the  result  is  a  halo  of  the  higher  color
surfaces around the white surfaces. The third image shows the result  subtracting from the
original  image  (with  the  Boolean  effect  Sub)  a  copy  of  the  shrunk  channels  (as  in  the
second image above) to obtain an image of the edges. 

The  Gauss:Chroma  spatial  filter  is  recommended  for  applying  to  images  derived  from
compressed  digital  video  formats  or  those  with  subsampling  color  to  hide  the  damage
caused by compression which may be exaggerated by later color corrections. In the case of
needing to hide a problem of subsampling color (for example 4:2:2 digital betacam, or  4:1:1
DV), use this filter horizontally (with the anamorph parameter in -100).

Use of spatial filters only in the alpha channel are described below.

The Box:A spatial filter averages the pixel values with a  square  matrix of  decreasing  radial
influence. This results in the softening of the transitions between opposing values, with an
appreciable blurring of  outlines. 

The last image of the following example has a high blur value and an additional contrast, to
make the shape of the matrix used in the effect visible. 

Bear  in  mind  that  a  mask  blur  produces  a  symmetrical  softening  at  its  boundaries,
contracting  and  expanding  the  total opacity  surface.  This  can  be  a  problem in  cases  of
composition  of  cutouts  made  on  greenscreens  or  bluescreens,  since  part  of  the  original
background of the figure can leak into the composite layer. 
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The following image demonstrates this problem:

To avoid this problem, shrink the mask (for example with Shrink:A) before applying the blur. 

The  Gauss:A  spatial  filter  averages  the  pixel  values  with  a  circular-shaped  matrix  of
decreasing radial influence. This results in the softening of the transitions between opposing
values, with an appreciable roughening of the outlines, similar to seeing an image through a
misted glass. 

The last image of the following Example has a high blur value and an additional contrast, to
make the shape of the matrix used in the effect visible.

The  spatial  filter in  Foreground  mode  (for example  Gauss:Foreground)  is  ideal  for  blurring
layers composed on a background or on other layers,  virtually  simulating   depth of  field  in
the composition, 

A simple sum of blur filters for alpha  channel and  image  applied  at  the  same  time  (Gauss:
RGBA for example) would create image imperfection at the edges, since the image blur would
associate  the  pixel colors  of  the  original background  with  the  pixels  of  the  cutout  figure.
Foreground is the mode for blurring foregrounds, since it  affects all the canals of its input,
adding  in  the  image  an  additional  operation  that  prevents  problems  of  invasion  of  the
foreground by the cutout figure.

In this example, the difference between blurring the image and  mask and  using  this  effect
can be seen. In the second image, the problem of foreground invasion by the cutout  colors
is clearly seen, in this case as a gray border, creating  a  halo  image  around  the  composed
figure.

Shrink:A shrinks masks to exclude the borders of a character or object  from a composition,
since  the  boundaries  are  usually  the  areas  critical  to  the  integration  of  images.  In  the
following example, although the extracted mask itself  looks very good, it  allows part  of the
background of the original cutout  to be  seen in  the  borders  of  the  composed  figure,  as  a
very  thin  gray  exterior  line.  The  same  layer  with  a  little  Shrink:A  corrects  this  problem,
removing the exterior border of the mask opacity.
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This should only, however, be a last  resort, since Shrink:A contracts the mask on the basis
of copying the values of neighboring pixel. Therefore, if  this effect  is misused, artifacts can
be generated in the composition, since the original shape of the mask is being modified and
an outline that  does not  correspond to the original geometry of the composite layer will be
made  visible  in  the  composition.  This  will  be  especially  visible  if  the  mask  has  areas  of
internal transparency. 

In this  example,  it  can be  seen that  small  shrinkage  values  do  not  substantially  alter the
original shape of the mask, whereas high values deform and even break up the mask, in this
case separating the hand from the arm.

Thin masks (such as masks of hairs for example) are often most  affected by misuse of this
effect, and other solutions should be sought to correct  the mask, such as using the Remap
effect combined with other effects for example.

Very occasionally, an expansion of the mask may be required such as an outline with Grow:
A. A possible case would be expanding mask drawn with VectorPaint, but  almost  never will
the of a mask extracted with Bluescreen, be required, for example.

A  useful  example  of  mask  expansion  would  be  to  enlarge  text,   although  within  certain
limitations, since a great degree of expansion would lead to a geometrical problem.

Note  that  with  high  values,  Grow:A  will  make  the  text  lose  its  original  geometry,  most
markedly in rounded forms of the letter “e”, where the generation of internal angles begins
to be noted. 

To attain more rounded results, we recommend using the Remap effect combined with other
effects.

Dir Blur

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Blur/Sharp->Dir Blur

Makes  a  Directional  type  blur,  in  a  specified  direction.  Its  result  is  similar  to  the  moved
image produced by a rapid camera pan.
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I/O

Inputs

Single input: Image with or without alpha channel.

Inputs

Image: Blurred image. 

Alpha: Blurred mask.

Parameters

Amount

[0 (0 / 100)] 

Specifies the blur length. 

Angle

[0 (–100.000 / 100.000)] 

Specifies the angle of the blur direction. 

Use and Comments

In  addition  to  simulating  the  blurring  of  an image  produced  by  a  panning  movement,  this
effect can be used to create luminous rays, by combining the Boolean Add effect.

Radial Blur

Ref.  Mistika:  Node  Graph  Editor->Dashboard->Fx->Mistika->Blur/Sharp->Radial
Blur

Makes  a  Polar  type  blur  from  a  specified  coordinate.  Its  result  is  similar  to  an  image
movement produced by a rapid camera zoom movement.

I/O

Inputs

Single input: Image with or without alpha channel.



599FX

SGO Mistika 8.6 © 2018 SGO

Inputs

Image: Blurred image. 

Alpha: Blurred mask.

Parameters

Zoom X; Y

[100; 100 (-100 / 100.000)]

Specifies  an  expansion  or  contraction  produced  by  the  filter,  individually  for  the
horizontal and vertical axes. 

Center X; Y

[50; 50 (-200 / 300)]

Sets the two-dimensional coordinate  of  the  filter pole.  These  values  are  percentage
coordinates of the image size. 

Angle

[0 (–10.000 / 10.000)]

Sets the  rotation angle  of  the  effect.  The  blur can be  rotated  with  this  parameter,
emulating a camera roll effect in the depth axis (roll). 

Use and Comments

In addition to simulating the blurring of an image produced by a zoom or roll movement, this
effect  can be used to create luminous  rays,  by  combining  the  result  of  this  effect  with  a
copy of the original clip with the Add effect. 

The following example shows the results of using different parameter values.
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Slope Blur

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Blur/Sharp->SlopeBlur

Makes a Slope type blur, which blurs the image in the direction determined by the boundary
detection of a second input.

I/O

Inputs

Single input: The same input is used as the image to be processed and the blur map. 

Double input:  The  first  input  is  the  image  to  be  processed;  the  second  is  the  blur
map.

Inputs

Image: Blurred image. 

Alpha: Opaque mask.

Parameters

Blur

[0 (0 / 100)] 

Blurs the blur map, softening  it  by  expanding  the  boundaries  that  specify  the  stump
range. 

Amount

[0 (0 / 100)]

Image blur level in the direction specified by the blur map.

Angle

[90 (-100.000 / 100.000)] 

Specifies a rotation in the direction specified by the blur map. 

Use and Comments

This  effect,  unlike  other Blur  effects,  does  not  have  an  a  natural  optical  equivalent.  Its
results, when used  with  a  single  input  and  with  high blur values,  are  somewhat  similar to
what occurs when a painting is treated with a solvent. 

It is useful for creating surreal or dream-like images. 

In the following example, the results of different  parameter values  are  shown,  and  also  of
using the same image as a blur map or a different image.
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Sharpen

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Blur/Sharp->Sharpen

Sharpens detail in the image by increasing the outline contrast.

I/O

Inputs

Single input: Image with or without alpha channel. 

Inputs

Image: Image with enhanced details. 

Alpha: No change or with enhanced details.

Parameters

Modes:

Folder that contains the parameters that specify the type of matrix and calculation mode to
be used.

Type

[Gauss / Box / Circle / Median]

Specifies the type of matrix to be applied as filter.

Gauss is a circular, unfocussed matrix.

Box is a square matrix.

Circle  is a circular, sharp-focussed matrix.

Median is a low-pass-type matrix.

Note: some graphics boards  do  not  support  median filters,  so  in  this  case  render in
Sware mode.
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Mode

[ RGB / RGB-InA / A]

Specifies the calculation mode of the set filter.

RGB applies the filter to the RGB channels, leaving alpha channel unchanged.

RGB-InA  applies  the  filter  to  the  RGB  channels,  with  the  opacity  set  by  the  alpha
channel, leaving alpha channel unchanged.

A applies the filter only to the alpha channel.

Render

[HWare, Sware]

Specifies that the processing will be calculated by software or hardware.

Note:  the  default  option  (HWare)  is  recommended  as  modern  graphics  boards  are
optimized to work even in depth of up to 16 bits per pixel.

Radius:

Folder that contains the parameters that control the radius of the filter application.

Radius

[0 (0 / 100)]

Controls the radius of application of the specified the filter.

Anamorph

[0 (-100 / 100)]

Specifies and anamorphic aspect to the matrix that uses the effect.

The  default  value  indicates  that  the  filter  acts  symmetrically  in  the  vertical  and
horizontal axes. Positive  values  restrict  the  action of  the  effect  to  the  vertical in  a
gradual  manner,  while  negative  values  restrict  the  action  of  the  effect  to  the
horizontal.

Units

[10.000 (1 / 1.000.000)]

Scales the value of the Radius parameter. 

Note: this parameter should be used to find the best  scale for the size of the  image
to be processed, the Radius parameter is relative to image size, and a low radius value
for  SD  resolution  might  be  much  greater  in  HD.  Use  this  parameter  to  reset  the
parameter scale that specifies the radius.
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Sharpen:

Folder that contains the characteristic parameters of this type of spatial filter.

Amount

[50 (0 / 100.000)] 

Amount of contrast applied to the details.

Threshold

[0 (0 / 100)] 

Threshold of details where the improvement is applied. 

Use and Comments

One frequent use of this effect is to improve the definition of images. 

It  should be  mentioned  that  it  is  not  possible  to  focus  an unfocussed  image  during  post-
production. Existing detail can only be emphasized, even though it  is not  very sharp. When
the contrast of the detail is increased, the image noise also always increases. This increase
in noise will be more noticeable in image sequences than in a single frame.

Fields

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Fields

The menu Fields contains filters for the control of fields.

Interlace

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Fields->Interlace

Interlaces its two inputs, interpreting each as a field.
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I/O

Inputs

Double input: Image with or without alpha channel. 

Inputs

Image: Two interlaced inputs.

Alpha: Two interlaced input masks. 

Parameters

None.

Use and Comments

This effect has the simple purpose of interlacing its two inputs. 

The example shows how the effect works with two very different  inputs. The first  input  will
be inserted in the first  field that  is read depending on the standard specified in the system
configuration.

When rendering, it is essential to activate the Interlaced option, as otherwise the effect will
be ignored. 

Mixed Field

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Fields->Mixed Field

De-interlaces  its  input,  creating  a  de-interlaced  frame  containing  a  mix  of  the  images  of
both the original fields.

I/O

Inputs

Single input: Image with or without alpha channel.

Inputs

Image: Image without fields, with a mix of the two images of the original fields.

Alpha: Mask without fields, with a mix of the two masks of the original fields.
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Parameters

Quality

[On (Off / On)]

Activates  or deactivates  a  higher  quality  interpolation  method,  although  processing
speed is lost.

Use and Comments

This effect  is  generically  recommended for de-interlacing  sequences  with  little  movement,
since mixing of two very different fields can create an undesirable effect, similar to “filage”.
That said, field mixing gives a better result  than line interpolation, which the lower stepping
of the diagonal lines in the de-interlaced image makes clear, and even noticeable  with  the
Quality parameter set to ON.

In  the  following  example,  three  details  are  shown.  The  first  is  the  original  image.  The
silhouette is fixed, and so both fields form the  same  image.  The  following  images  compare
this effect  with InterpField, which uses a method of interpolation between the lines of  the
same field. The result of MixedField is in this case notably better. 

The following example shows that  the Quality parameter noticeably  increases  the  resulting
image quality, gaining sharpness when the parameter value is set to ON.

The  precise  interpretation  of  the  Field  parameter  depends  on  the  video  format.  The
consecutive field order varies between PAL and NTSC. The De-Interlace calculation always
corresponds to the temporary field order, not to the odd or even lines. 

When rendering, it is essential to deactivate the Interlaced option, as otherwise the effect
will be ignored.

Interp. Field

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Fields->Interp. Field

De-interlaces its input, creating an image by interpolation between lines in the field that  is
removed.
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I/O

Inputs

Single input: Image with or without alpha channel.

Inputs

Image: Image with a field created by interpolation between lines, and with the other
field intact.

Alpha:  Mask with a field created by interpolation between lines, and  with  the  other
field intact.

Parameters

Field

[Field-0 (Field-0 / Field-1)]

Specifies the field to be extracted. A value Field-0 extracts the first  field in time,  whereas
the second is extracted with a value of Field-1.

Use and Comments

This effect is generally recommended to de-interlace sequences with a lot of movement. For
sequences with little movement, we recommend the MixedField effect. 

The first example image shows that  the two fields contain very different  images, as occurs
in video sequences with a lot  of movement. The interpolation filter achieves a better image
in these cases than the mix filter used  by  the  MixedField  effect,  since  mixing  fields  would
cause loss of sharpness. 

The  precise  interpretation  of  the  Field  parameter  depends  on  the  video  format.  The
consecutive field order varies between PAL and NTSC. The De-Interlace calculation always
corresponds to the temporary field order, not to the odd or even lines.

When rendering, it is essential to deactivate the Interlaced option, as otherwise the effect
will be ignored.

Duplicate Field

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Fields->Duplicate Field

De-interlaces its input, creating an image by copying lines in the field that is removed.
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I/O

Inputs

Single input: Image with or without alpha channel.

Inputs

Image: Image with a field created by copying lines from the other field, and with the
other field intact.

Alpha: Mask with a field created by copying lines from the  other field,  and  with  the
other field intact.

Parameters

Field

[Field-0 (Field-0 / Field-1)]

Specifies  the  field  to  be  extracted.  The  value  Field-0  extracts  the  first  field  in  time
whereas the second is extracted with a value of Field-1.

Use and Comments

Generally, the InterpField effect  achieves better image quality than this effect, although in
some special circumstances it  may be necessary to copy the field without  interpolation. In
the following example, three details are shown.

The  first  image  is  the  original.  The  silhouette  is  fixed,  and  so  both  fields  form the  same
image.

The second image uses DuplicField.

The third has the effect InterpField  applied, which uses a method of interpolation, resulting
in a notably better quality of image than that of duplication.

The  precise  interpretation  of  the  Field  parameter  depends  on  the  video  format.  The
consecutive field order varies between PAL and NTSC. The De-Interlace calculation always
corresponds to the temporary field order, not to the odd or even lines. 

When making a render, it  is essential to deactivate the Interlaced option, as otherwise the
effect will be ignored. 
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Stereo 3D

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Stereo 3D

Mistika's tools for manipulating stereoscopic images and sequences are found in this group.

The stereoscopic image

In the real world,  objects are positioned in three-dimensional space.

A  projected  image  is  flat,  in  which objects  are  located  only  two-dimensionally.  The  third
dimension, which corresponds to depth, is lost.

However, a process called Stereopsis is enough to convince the human eye to perceive this
missing dimension; it  consists of interpreting the difference between two  images  projected
to each eye.

Although there  is  only  a  single  image  formed in  the  brain,   the  interocular  distance  -  on
average  65 mm -  obliges  each  eye  to  focus  and  center  on  a  close   object,  make  both
images  converge  into  one.  Closer and  more  distant  objects  are  seen  doubled  and  out  of
focus.

If the object  being viewed is very  far away,  the  eyes  stop  trying  to  make  their individual
images  converge,  since  at  large  distances,  the  visible  viewing  point  is  greater  then  the
interocular distance of 65mm and so they stay in parallel.
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Stereoscopy  is  a   technique  that  takes  advantage  of  stereopsis  to  create  the  illusion  of
depth of an image, combining a pair of  images  that  arrive  separately  to  each eye,  so  the
human brain tries to make them converge into a single image.

This "trick of the eye" is based on the fact  that  human sight  will accommodate  this  effect
to view a screen, while  the observer can choose the convergence of the pair of images in
an interocular distance that does not correspond to the accommodation plane for the focus
that the eyes naturally try to find.

The means that  a viewed object  can seem to be closer to the observer than the screen (
negative  parallax)  or  behind  the  screen  (positive  parallax).  A  pair  of  stereoscopic
images, given the differences they have as  a  result  of  the  differing  camera  positions  with
relation to the same perspective, allows the viewer to choose the depth plane  required  to
be converged, but  cannot  correct  the focus of that  plane, since the focal plane is  set  at
the moment  of obtaining the images during filming. For this  reason it  is  important  to  make
sure  that  the  convergence  plane  is  sharply  focussed  in  the  original  material.  The  most
visually comfortable convergence plane for the spectator is  always  that  which coincides
with  the  accommodation  plane,  or  in  other  words,  the  screen,  which  defines  zero
parallax.
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Positive  parallax is limited by  the  interocular distance  (an average  of  65 mm),  which is
why it should be remembered that  the larger the stereoscopic image, the more limited
its positive parallax will be, since images that are separated by more than the interocular
distance cannot be converged.

For this reason a better stereo effect is achieved in monitors than in large cinema screens.



611FX

SGO Mistika 8.6 © 2018 SGO

A useful method for simulating greater positive parallax is to trick the viewer by creating  a
frame around the screen that simulates a negative parallax, which by reference creates the
illusion  of  greater  positive  parallax.  This  frame  creates  a  floating  window  which  virtually
brings  the  screen  closer  to  the  viewer.  This  method  is  also  very  useful  to  avoid  visual
discomfort  caused  by  objects  that  "touch"  the  edge  of  the  shooting  frame,  a  situation
which forces the viewer to perceive two convergence planes simultaneously.  With Floating
Window it is possible to relocate the frame of the image next  to the negative convergence
plane of this object, for example.

The  difference  between  the  accommodation  plane  and  the  convergence  plane  usually
requires  unnatural movements  from the  viewer's  eyes,  which could  provoke  headaches  or
visual discomfort, and so it is important to understand the limitations of the system in order
to take maximum advantage of its effect, and avoid the possible difficulties it might cause.

Sudden changes of  convergence  plane  generated,  for example  by  cutting  between shots,
can be softened by Mistika's dedicated effects.

For  greater  visual  comfort,  it  is  important  to  correct  stereoscopic  material,  using  the
interocular balance tools in the effects of Mistika.

It  is  also  possible  to  edit  even  the  sense  of  depth,  modifying  the  complete  interocular
distance; it  is possible to divide the sense of depth into segments  to  be  scaled  at  a  later
moment. These characteristics are unique to Mistika.

The  general processing  of  effects  in  Mistika  treats  the  stereoscopic  image  clip  as  a  unit
instead of as a stereo pair of images.  This  makes  postproduction tasks  a  lot  easier,  since
there  is  no  need  to  duplicate  them,  allowing  real  time  color  correction  with  Color  Grade
effect.  Moreover,  the  effects  Comp3D  and   Refract   have  a  parameter  for  use  with
stereoscopic  clips:  InterOcular,  which  allows  the  resetting  of  the  value  of  interocular
distance.

Mistika's  versatility  when  working  with  stereoscopic  images  allows  the  ungrouping  and
regrouping  of  the  stereoscopic  clips,  if  it  is  required  -for  example-  to  correct  each  eye
separately.
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Both effects have a common manipulation tool, Stereo3D

Stereoscopic Workflows in  Mistika

The  most  common  settings  for  a  stereoscopic  workflow  in  Mistika  are  detailed  below,
focussing on the combined use of different tools. 

The tasks included in stereo mode are divided into two different  phases; although the same
tools are usually used in both, principally based around the Stereo 3D effect  (Node Graph
Editor->Dashboard->Fx->Mistika->Stereo 3D->Stereo 3D):

Phase 1 - Technical settings

Phase 2 - Creative settings

Before  starting,  we  recommend the  user takes  note  of  certain  basic  rules  for  working  in
stereo:

Tasks in the technical settings phase must be done without  using stereoscopic
viewing devices, or using them as little as possible.

Mistika  has  various  2D viewing  modes  for analyzing  and  correcting  problems  without
needing  to  use  3D viewing  modes  prematurely,  which could  produce  headaches  and
dizziness until the images are correctly adjusted.

Any small difference of color, geometry or time de-synchronization between the
two eyes will badly affect the stereoscopic effect.

If these differences are significant, they could completely destroy the effect  and
cause discomfort when viewing. 

If the differences are small, they may go unnoticed when viewing a small number
of  clips.  However,  even  small  vertical  misalignments  of  a  pixel  or  other  less
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noticeable  differences  can  result  in  headaches  and  dizziness  when  viewed  in
larger works. 

The possibility of resolving problems in post-production has its  limitations  and
should never be used as a replacement for adequately-shot material.

A good Stereographer is essential  on set  to  ensure  the  quality  of  the  stereo  image,
just as their presence is required later in the creative phase. 

Phase 1 - Technical adjustments

The adjustments of the technical phase refer principally to resolving problems produced  by
technical limitations  in  the  shoot,  and  it  is  recommended  that  they  are  done  before
starting any other phase of postproduction, including offline edits.

Bear in mind that  the viewing of unadjusted material can be  extremely  uncomfortable,  and
that  decisions  taken  in  this  phase  of  production  will  affect  all  the  elements  involved  in
postproduction, so it is recommended that these are done before any other.

Once these adjustments have been made, a compressed version can be produced form the
Output  tab  (Node  Graph  Editor->Dashboard->Output);  or  a  version  in  Side-By-Side
format  can be  produced  for offline  systems  (usually  MXF,  which has  sufficient  quality  for
offline and provides timecode); and another version in master quality (without  compression
at full resolution) for VFX applications (usually in DPX).

Most  problems result  from the use of two lenses in the shoot: this produces  differences  in
the  image  that  are  not  perceptible  in  normal viewing,  or because  of  the  limitations  of  3D
viewing devices. 

Many problems (especially those related to geometry) can be caused by working with Beam-
splitter rigs:  two  cameras  at  45º  to  a  semitransparent  mirror (one  vertically  shooting  the
reflected image, the other horizontally shooting through the mirror). This system is used  in
stereo shoots because high-quality lenses are too big to be placed side-by-side (since they
would exceed the interocular distance of the human eye). Small misalignments of the lenses
or mirror can produce significant geometric differences that need to be corrected.

As well as geometry, both for shoots with two side-by-side cameras and and those using a
mirror, there may be differences in  time  synchronization,  color,  focus,  lens  quality,  optical
effects etc. 

The  steps  to  be  followed  in  this  technical setting  phase  are  detailed  below,  divided  into
basic techniques (to be applied indiscriminately and can be processed in realtime) and other
more advanced techniques that need more time and should only be required selectively.

Basic technical adjustments (quick, realt-time techniques:

In  the  technical adjustments  phase,  the  following  problems  are  addressed  (usually  in  the
order below):

1. Choosing the dominant eye

2. Organizing material from a shoot

3. Time synchronization differences between the two eyes 

4. Basic color differences

5. Basic geometric adjustments (vertical movement, rotation, size and Keystoning) 

6. Resolving retinal rivalry using floating windows

The following steps generally require the adjustment  of one eye to balance the other, so it
is necessary to decide which is the eye to be modified, although sometimes both eyes  are
modified at the same time (LR option) in order find a balance between the two. 
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When  adjusting  Stereo3D  effects,  the  dominant  eye  is  selected  via  Balance  Geometry
Balance Geometry->Apply(L,LR,R) and  Balance Color BalanceColor->Apply(L,LR,R).

The  norms  to  be  followed  are  established  by  the  stereography  artist,  and  normally  the
following situation should be taken into account:

If the production of VFX is going to require camera tracking or other complex effects
depending  on  studio  cameras,  it  will  be  necessary  to  maintain  one  eye  without
modifications  to  be  used  later  in  calculating  the  virtual  camera  in  other  systems;
thus only one eye will be adjusted matching it with the first. 

In  cases  in  which  the  images  for  one  eye  are  better  than  the  other,  it  is
recommendable  to  set  this  as  the  dominant  eye  and  only  modify  the  other  (for
example, in beam-splitter rigs, the image with worse quality would be that  reflected
in the mirror). 

That said, this decision may be more complex than it  first  appears: with some shots
it  may   be  necessary  to  carry  out  the  opposite,  if  it  not  possible  to  improve  the
poorer image, in which case the solution is to introduce the same problem (such as
loss of focus, flashes and glints in one eye etc) into the other eye to balance it  and
produce matching stereo images.

Setting  one  eye  as  dominant  also  allows  the  stereography  artists  to  carry  out
postproduction tasks in parallel: for example, colorists can work on a  creative  color
correction  in  the  eye  NOT  to  be  modified,  while  stereo  and  match  grading
adjustments can be done by modifying only the other eye in parallel. They can later
be joined quite simply.

When  there  are  no  prior  requirements,  it  is  usually  recommendable  to  allow
modification in both eyes (LR mode) in order to find a balance  between both,  since
this  way,  less  quality  of  image  is  lost  in  the  laterals  (this  loss  is  due  the  need  to
move,  rotate,  and  scale  images  to  make  them coincide,  leaving  established  black
borders). This loss is compensated for in Mistika by increasing the image beyond the
lack borders, and is less visible in balanced correction mode. 

These kinds of decisions definitively affect  the  whole  subsequent  workflow.  They  must  be
taken at  the start  and  they  should  be  documented  in  Node  Graph,  for example  via  Notes
(Node Graph Editor->Dashboard->Edit->Edit->Cursor/Notes).

This aspect of the work is usually time-consuming and consists of loading and preparing the
material from the shoot. 

Loading  all  the  clips  (via  tape  capture  or  using  the  Import  All  Movies  tool  (Node
Graph Editor->Dashboard->Media->Import  All  Movies)   for non-tape  formats,
and optionally conforming if and EDL is available).

Aligning the clips of both eyes in the Node  Graph,  bearing  in  mind  that  the  clip  for
the left eye must always be in a track above that of the right  eye, sin the Stereo3D
effect always needs to find them in this order. 

Note: This step is not  necessary for clips in .js 2xYUV422, Cineform Stereo, or SXR
formats,  as  these  already  contain  both eyes  in  a  single  clip.  For this  type  of  dual
clip, we only need to separate the two eyes in the Node Graph (Edit->StereoBreak
) in case it is necessary to apply different effects to each.

It  is important  to verify visually that  left  and right  eyes have not  switched places  in  some
clips, since it is a common mistakes made on shoots.

Apply the Stereo3D effect  to each pair (or each dual stereo  clip)  to  prepare  it  for
the following steps. 

If  the  image  in  one  eye  is  vertically  or  horizontally  inverted,  use  the  Mirror
parameters to undo the inversion. 

Normally, it is necessary to apply the same adjustments to all clips (or at  least  those
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from  the  same  camera  rig),  so  use  the  Propagate  function  (Visual  Editor-
>Parameters->Propagate->Propagate  Selected/All)  to  propagate  the
adjustments to these parameters across to the other Stereo3D clips.  This  tool can
also be useful for many of the following steps, since it  is logical to assume that  the
clips from the same scene require the same treatment.

In the Node Graph, check that both eyes have the same timecode.

Open the visual editor (double-click Stereo3D), and visually check that  the left  and
right eyes show the same image for that moment (do not simply trust  the timecode).
 

The recommended viewing mode for this comparison is B&W + Anaglyph (Stereo3D Editor-
>Quick Access->S3DDisp->B&W + Anaglyph), since it neutralizes all color in the image,
leaving  red  and  cyan  only  at  the  edges  of  the  objects,  according  the  eye  to  which  it
pertains  (red  =  left  eye,  cyan  =  right  eye),  making  comparison  of  movement  and
geometry easier.

Look for obvious  incidents  of  time  de-synchronization,  such as  clapper-boards,  footsteps,
blinking eyes etc. If the two clips are out  of sync, use Shift  Clip (Stereo3D Editor->Quick
Access->S3DDisp->Shift Clip),  to sync them.

Note: Remember that this control does not  modify the duration or position of the clips, but
simply  moves  their content  in  time.  For this  reason,  if  the  clips  are  not  trimmed  at  their
head or tail, they should also be cut in the Node Graph, so that no clip has frozen images at
the start or end. 

These  problems  can  be  corrected  by  modifying  either  of  the  two  clips,  but  it  is  always
recommendable to be consistent  in the choice of dominant  eye to make organizing material
easier. 

Note:  An  extreme  case  consists  of  the  use  of  two  cameras  with  no  video  syncing
mechanism between them, which may produce fractional differences in time that  cannot  be
solved with Shift applied to a whole number of frames, and which will be discernible in shots
containing  a  lot  of  movement.  In  these  cases,  the  only  solution  is  to  use  Timewarp  to
interpolate new intermediate frames that allow us to synchronize the action. 

It  is  common  for  color  differences  to  exist  between  the  two  cameras,  mainly  due  to
differences  in  the  electronic  settings  and  the  way  light  interacts  with  the  mirrors  and
lenses. 

Color differences should  be  corrected  as  much as  possible,  as  they  cause  dizziness  when
viewing uncorrected stereoscopic images for long periods.

It  is  recommendable  to  do  a  first  color  adjustment  via  the  button  Match  Colors  (Visual
Editor->Manipulators  Tabs->Stereo3D->Actions->Match  Colors)  in  the  Stereo3D
Editor before doing geometric  adjustments. This is because color balancing will also help
the accuracy of other tools. Many of these are based on identifying the position of each
element in the two images, and will be more accurate if  both have the same color).

For color adjustments, the recommended viewing mode is Checkerboard (Stereo3D Editor-
>Quick Access->S3DDisp->Checkerboard), which combines the images  from both eyes
as the squares of a checkerboard. This allows the comparison of each small area separately.
It  can also be used in combination with the AlignWarp button, which allows the distorting
of the elements of one eye to make it  coincide with its position in the  other eye,  and  the
Checkerboard makes this easier to interpret.
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If color is successfully matched in one area, but  in doing so other adjustments are undone
in other areas, it is usually due to problems with light  polarization in the mirror and requires
more complex techniques to resolve: see Advanced technical adjustments  below.  If  this  is
the case, for the moment  simply match color in  the  most  important  areas  (that  which will
the viewer's focus area) with Match Light  / Match Dark, as these tools allow clicking on an
area  to  be  balanced,  leaving  a  more  precise  adjustment  for  a  later  time  (as  described
below).

This  section  refers  in  terms  of  geometry  to  the  discrepancies  between  the  two  images
provoked  by  misalignment  of  cameras  or  by  their  differing  positions  with  relation  to  the
mirror. These discrepancies are very common owing to mechanical limitations of camera rigs
and  limited  time  available  during  shooting  for  changing  lenses  or  making  corrections.
Advanced rigs are robotized and can correct some of these discrepancies, in realtime during
the shoot, but they are not perfect and can also produce errors.

The following steps are  aimed at  eliminating  differences  in  vertical alignment  between the
same element  in  the  two  images:  a  person's  eyes  clearly  see  things  at  the  same  relative
height and the brain is accustomed to see images in this way. Any vertical deviation (even
just  one line of one pixel) can cause problems and dizziness.These  problems  are  caused
by  a  variety  of  reasons  which  are  dealt  with  below,  but  they  all  share  the  same
problem:  vertical  displacement  between  what  the  two  eyes  see,  and  which  is
different in each area of the image, for which reason it is not sufficient just to move
the image in one eye up or down , but also to resolve each possible cause separately
.

Differences  in  horizontal  displacement  (Disparity)  are  normal  and  intentional,  since  these
form the basis of stereoscopic vision. However, they can be adjusted to increase or reduce
the stereoscopic  effect  selectively for creative reasons, as explained in the section below.
The present section deals only with vertical alignment. 

To  resolve  problems  of  geometry  we  can  normally  use  automatic  techniques  (
MatchGeometry button), although there are also semi-automatic  techniques if  these  first
are not successful, or if a problem analysis is required in order to improve the chassis (used
in shoots with "Mistika Live"). 

Completely  automated  systems   (such as  those  available  on  advanced  cameras  rigs)  are
only recommended for live transmission or for adjustments  made  before  shooting,  although
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they  are  not  totally  accurate,  and  the  mechanism or  software  can  produce  errors  (it  is
often impossible  to  identify  100% the  same  pixel in  the  two  eyes).  A  human  operator  is
slower but  can do  this  process  much  more  accurately  in  the  postproduction  phase  with
Mistika.

As  a  first  step,  click  MatchGeometry,  which  will  automatically  resolve  the  majority  of
problems, and increase the size of the image in S3DDisp->BW Anaglyph viewing  mode  in
order to check that both eyes are well aligned vertically in all areas of the image.

If this function is not  enough, or if  we  require  a  more  detailed  analysis,  then follow  these
steps:

Prepare the interface and initial recommendations

Adjust differences in position 

Adjust differences in size

Adjust rotation

Fine tune adjustments 

Adjust Keystoning

Make other geometric adjustments

Recover the original convergence (cancelling PosX horizontal displacement)

Lock future vertical displacement using Y-constraint

Select both clips and apply Stereo3D, and double click this to load it  into the Visual
Editor. 

Activate Automatch as a first  step. This will command Mistika to  look for the  same
element in the two images each time we click the image, and try to make it  coincide
via the image transformation operation that is selected (Match Move, Match Size, or
Match Rotation). (If Automatch is deactivated these  adjustments  have  to  be  done
manually, by dragging the cursor in the image).

Activate  B&W + Anaglyph  viewing  mode,  which,  as  previously  stated,  is  especially
useful for comparing geometry.

Check that  the  Y-Constraint  button is  deactivated.  This  informs  Mistika  of  vertical
discrepancies  in  the  image,  so  that  when clicking  in  any  area,  it  is  not  limited  to
looking for them in the  same  vertical position  in  the  other eye,  since  they  may  be
found lower or higher. 

During the adjustment of position, scaling, and rotation it is important to choose elements in
the image that are not near to the corners (a useful rule is always to choose points that
are  at  least  a  third  of the  distance  from  the  corners),  since  distortions  produced  by
camera lenses in these areas produce inaccurate alignment.

Also,  we  will  always  have  sufficient  zoom in  the  image  for  accuracy  (up  to  the  level  of
seeing each pixel clearly). and we will look for elements that  are clear and sharply focused
that can be reconciled (unfocused areas make it difficult to align accurately).

In the following steps, remember that  each time we click the image,  the  scaling  pivot  and
rotation moves to that position. This pivot  also provides a cross to the edges of the image
that is useful for comparing alignment.
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Before adjustment (problems of size and rotation):

Corrected geometry:

The recommended workflow for aligning geometry is as follows: 

Locate  4 points  that  more  or  less  form  a  cross  in  the  image.  The  2  points  in  the
vertical of the center are used to set position and scale, since it is clear that where
differences exist in the central vertical axis of the image, they are due to differences
in size between images, but hardly any rotation is visible. 
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On the  other hand,  the  2  points  on  either  side  of  the  central  horizontal  axis,  are
useful for aligning rotation,  since  rotations  are  much more  notable  in these  areas,
while  differences  in  size  will  not  produce  notable  vertical  misalignment  in  the
horizontal central area. Both these assertions can be checked further in the images in the
following sections that deal with scaling and rotation. 

Note: all the example images have suffered exaggerated distortions for illustrative purposes:
distortions in material from shoots would be much less noticeable.

Activate  Match  Move  and  click  on  an  element  in  the  image  in  which  the  vertical
misalignment  can be seen, which is close to the vertical of the center of the  image  (since
later the size ill be changed; if  the example image is used, click in the center of the upper
"M").

This action should make the selected element  is automatically matched in both eyes  (both
horizontally and vertically, as this tool also fixes convergence at the established point). 

Further  clicks  in  the  same  zone  may  be  necessary,  until  the  pixels  of  the  element  are
aligned (red and cyan anaglyphs will coincide at this point, so their color will disappear). 

If  an exact  match cannot  be  achieved,  try  using  another zone,  or deactivate  Automatch
and drag the image to align it  manually. These recommendations also apply to the following
steps.

Let's now look at  another element  of the image,  more  or less  following  the  vertical of  the
previous one.

If we note vertical misalignment  in this new element  it  will be because the two images  are
not  the same size, since rotation would only produce horizontal differences  in  these  zones
(as can be seen in the image in the next section). 

Activate Match Size and click the new element in the image to adjust  its size (following the
example,  click on the  lower "K").  Both  anaglyphs  should  be  aligned  to  their  pixels  in  the
vertical (the setting of the previous point  is not  undone, since by clicking previously, it  will
be doing a scaled pivot).

Note that  the scaled pivot  was established in the previous action via  Match Move.  This  is
because  the  manipulator Match  Move  is  also  fundamental  in  rescaling  and  rotation
operations,  so  when fixing  the  convergence  in  a  point  it  sets  an  optimum rotation  and
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scaling pivot in order to carry out these adjustments.

This  correction  is  done  after  setting  size  because  it  is  the  least  common  and  serious
rotation adjustment in beam-splitter rigs. 

To adjust it: 

Look for an element  near to  the  central horizontal axis  of  the  image  and  which  is
close to the left or right edge, and carry out a Match Move at this point to converge
the rotation pivot here (in the example, we do  Match Move in the center of the left
"M"). 

Now look for a  point  of  interest  at  the  other side  of  the  image  close  to  the  same
horizontal, and check the  vertical misalignment  vertical between both anaglyphs  in
this  area.  It  is  clear  that  the  vertical  differences  in  this  area  must  be  ones  of
rotation, since size difference would only cause horizontal misalignment  in this area,
which now doesn't matter. Correct it with  Match Rotate (in the example, we do this
in the center of the "A" on the right).

Once the previous process is complete, look at the center of the image: this central point  is
never  affected  by  misalignments  of  rotation,  scaling,  lens  aberrations,  Keystoning,  etc.
Thus,  there  must  be  no  misalignments  whatsoever  in  this  area.  If  there  are,  use  Match
Move to correct. This action may  undo  other adjustments  done  in  peripheral areas,  which
means that there exist other problems, mentioned in later sections.

Sometimes, in the previous steps, the mistake of adjusting size and rotation to compensate
differences that  in fact  have other causes: in this case it  will  be  necessary  to  repeat  the
three steps  one  or more  times  to  achieve  perfect  alignment.  This  is  especially  true  when
finding  elements  that  may  have  accumulated  within  the  recommended  zones:  repeating
steps will fine-tune these.

Keystoning  is  the  distortion  of  perspective  that  both  images  suffer  when  two  cameras
converge on one point  (it  only occurs when shooting with two parallel  cameras,  that  is  to
say,  cameras  that  do  not  converge  ),  although  some  camera  rigs  have  advanced  image
processors to deal with the problem). It is generally barely perceptible, and therefore it
not always necessary to adjust it, or if so, only to a minimal degree. 

This  distortion  of  perspective  is  inverse  in  the  two  cameras  since  they  are  viewing  the
scene  from horizontally  symmetrical perspectives.  The  vertical  misalignment   produced  in
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the elements of the image are usually only evident near the corners of the image.

Positioning the pivot so that its horizontal line crosses areas in the upper or lower regions of
the  image  (not  the  central  area)  with  geometrically  recognizable  patterns  helps  the
detection of the problem. Also, look for the evolution of the problem along the whole of the
horizontal line of the pivot, as this helps distinguish the effect of this distortion with respect
to those produced by other causes. 

To  correct  it,  drag  the  cursor  in  the  Keystone  parameters  (Balance  Geometry-
>Keystone)   while  pressing  <Alt> to  carry  out  the  adjustment  with  greater  detail  (the
correction is usually very small, and this action offers greater sensibility). 

It  is  important  to  remember that  Keystone  distortion  is  related  only  to  convergence
and has nothing to do with the use of mirrors or distortions caused by optical lenses,
although these other issues may make the detection and  correction difficult,  by  producing
curved perspective lines and other geometric aberrations.

As  previously  mentioned,  sometimes  during  adjustments,  some  processes  need  to  be
repeated until the optimum vertical alignment is achieved for all the reconcilable elements in
the image. 

However, there may be other complex problems that  cannot  be resolved with  the  previous
techniques, so do not attempt to resolve them by applying the same steps again and again.
Experience  is  necessary  in  order to  acquire  the  best  habits  for  solving  problems  such  as
those  caused  by  mirror angle,  the  glass  of  the  lenses,  zoom,  focus,  etc.  These  complex
aberrations are dealt with the section on Advanced Technical Adjustments.

During the previous steps convergence has been set  at  different  point  that  were useful for
setting  pivots  and  points  of  reference  for  comparison.  When  adjustment  has  been
completed  it  is  important  to  eliminate  changes  made  in  the  horizontal  (X-axis)  of  the
images; if not, the convergence point will be different  from the original one. The position of
this convergence point is an artistic decision (normally set by the stereography artist on the
shoot), so that  at  the  end  of  the  adjustments  phase  it  should  be  left  as  it  is.  To  do  so,
when  all  adjustments  have  been  done,  select  the  PosX  parameter  (Balance
Geometry->PosX) and click Del to eliminate changes made.

Once  there  are  no  vertical discrepancies  anywhere  in  the  image,  it  is  recommendable  to
activate the Y-Constrain control.

There is also the option of using the tool Match MoveX, with has the same effect  as using
Match Move when the control Y-Constrain is active.

These functions  indicate  that  only  elements  that  have  the  same  vertical position  in  each
eye  que  are  looked  for,  which  considerably  improves  the  accuracy  of  the  Optical  Flow
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algorithms that will be used in the following phases of stereo adjustments.

The questions of retinal rivalry and floating windows require a more exhaustive document  to
explain them in depth. However, in this section describing basic  adjustments, we can give a
simplified version of them, focusing on the most important case that will need to be resolved
in this phase of adjustment.

The situation that  we will deal with here is that  of elements that  enter or leave the image
at  the edges or are cut  off by it  (and so must  be  viewed as  if  passing  behind  the  screen
frame) and thus cause retinal rivalry resulting in dizziness, if  in  the  part  in  which they  are
within the image they are being perceived as if  located  in  front  of  the  frame  (by  value  of
having  negative  parallax).   This  creates  the  paradox of  having  an object  being  perceived
both in front of and behind another object at the same time. Furthermore, it  is evident  that
an object close to the cameras and that leaves by one edge only appears in the camera on
the same side as it.

The Floating Window technique mitigates this problem by creating the optical illusion of a
frame close to the spectator, "in front of" the conflictive objects in a natural and consistent
way. This artificial frame also crops the border and hides objects that are only visible to one
camera due to being located in this area of retinal rivalry. 

To achieve this illusion of moving the screen frame, it  is  only  necessary  to  crop  a  a  small
area on the left-hand side of one of the images, and a similar area on the opposite side of
the other image at the same time, which can be done interactively dragging the parameters
in the folder Floating Window. 

This  technique  can  affect  creative  decisions  related  to  depth  perception  and  also  the
perception of original images, so it should not be used indiscriminately, when not  necessary.
 

Furthermore, for the optical effect to work, it  is necessary for the real frame of the screen
being viewed by the spectators to be very dark, with  no  light  leakage  around  the  area  of
the visible image (such as unfortunately happens with LCD screens, that do not successfully
cut out the backlight in dark areas), so this effect works well for cine versions, low range or
old 3D televisions.  

Remember that in Mistika there are also other advanced and radical techniques for resolving
such problems, via optical flow and selective adjustment of depth, although they are slower
to  carry  out  and  do  not  offer realtime  solutions;  thus  they  fall  outside  the  range  of  this
section of the document.

Advanced technical adjustments:

Common errors:

Advanced polarization and color adjustment problems (color discrepancies in different
areas of the image)

Convergence jumps in consecutive clips 

Optical aberrations caused by camera lenses 

Mirror rotation problems and other asymmetric deformities

Ghosting (double image) problems

Noise and grain problems

Differences in Motion Blur

Glints, optical effects and other imperfections occurring in one eye 

Differences in Zoom, focus and depth of field

Setting minimum and maximum depths (Depth Budget).
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How to solve these problems in Mistika is described below:

Sometimes  it  is  impossible  to  match the  color  in  the  two  images  by  means  of  the  basic
settings  previously  mentioned.  This  occurs  when  different  corrections  are  required  for
different parts of the image. 

This problem is normally caused by light  losing part  of its polarization when reflected in the
mirror,  thus  affecting  the  color  perceived  by  the  sensor.  The  original  polarization  differs
according to the surface o which the light is reflected, so the changes produced depend on
each area.

In  order  to  resolve  it,  the  effect  Stereo3D  includes  the  parameters  of  the  folder
ColorBalance2 that  automatically allows the balancing of color pixel by pixel. Normally,  it  is
only  necessary  to  choose  whether  we  wish  to  modify  the  left  or  right  eye  via  the  Fix
parameter. If this is not enough, we can modify the MaXDiff parameter which allows more or
less radical color modifications; if  this is not  enough, modify the Softness  parameter which
indicates to Mistika if  the image contains sudden or smooth movements   and  optimize  the
accuracy of the calculation for these situations.

When two  consecutive  clips  have  their viewer's  focus  zones  in  different  planes  of  depth,
the resulting effect is uncomfortable, as it forces the viewer to rotate the eyes dramatically
in order to focus. This can be corrected via the Depth Transition effect, which animates the
convergence plane to achieve a progressive depth transition. This effect  works in a  similar
way to a Mix effect, and similarly, should be done only in the final edit.

To adjust for this problem, first  obtain the disparity values from both clips by selecting one
a t a tine and Pick disparity Head controls (selecting the area of viewer's focus at  the start
of the second clip) or Pick disparity Tail (selecting the area of viewer's focus at  the end of
the  first  clip),  and  then apply  an animation of  the  Depth Transition  effect,  selecting  and
clicking Set Stereo Depth Transition Effect.

Most  lenses  produce  spherical  deformations  in  images.  Generally,  these  produce  visible
vertical  misalignments  if  the  cameras  are  not  parallel  (and  thus  produce  differences  in
perspective when converging at  one point), and furthermore they will  be  increased  by  the
Keystoning effect.

This problem is more evident  depending on the focal length of the lens used. Stereographic
artists usually use fairly open lenses to achieve greater depth in  the  scene,  usually  in  the
range 18mm-50mm, which can therefore produce this problem in postproduction. 

Such aberrations are accentuated with smaller lenses.

In order to detect this problem, once the geometry is aligned, look for vertical misalignment
in the corners of the image, which is where the problem is visible.

Another technique  for correcting  these  problems  is  Corner Pin:  create  4-point  tracking  in
the  dominant  eye  and  apply  them to  the  same  points  in  the  other  eye  to  make  them
coincide, via the Corner Pin parameters of Comp3D.

Sometimes this is not  enough and it  is necessary to use the effect  Warp, especially if  this
problem  is  combined  with  another  of  mirror  rotation,  which  will  produce  asymmetric
differences that cannot be solved using Corner Pin.

This  is  one  of  the  most  complicated  problems  to  resolve,  especially  when  combined  with
others. If a mirror is slightly rotated around the vertical axis, asymmetrical discrepancies are
produced (which will be very exaggerated in a corner, and different in each corner.)

When  the mirror  is  not  perfectly  aligned  with  the  lenses  in  a  mirror rig,  use  the  Mistika
Match Shear tool to compensate horizontal "shear" distortions.

To  set  this  value,  find  a  vertical object  in  the  middle  of  the  scene:  a  column,  lamppost,
tree,  vertical  edge  of  a  building  whose  top  point  is  about  the  same  distance  from  the
camera as the bottom one. 

To set  it, use Match MoveX mode on the top point  of the object, then use  Match ShearX
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on the bottom one. 

In other asymmetric distortion cases, an alternative is to apply the Fx->Warp effect  to the
non-dominant eye to make the vertical alignment coincide zone by zone.

First,  delete  the  default  grid  of  the  Warp  and  construct  another  made-to-measure  grid,
usually with 9 points (3 vertical and 3 horizontal lines).  

The central point  is very important  as it  anchors the area perfectly (vertical misalignments
are  never acceptable  in  the  central area).  Then,  pull  the  corners  one  by  one  to  correct
them.

When  using  lenses  with  different  aberrations  it  may  be  necessary  to  add  more  grid
correction points. This  problem can occur when using  lenses  from differing  manufacturer's
batches. 

Sometimes it  is necessary to compensate for relative scale mismatch in the  horizontal axis
only. For example, if  the mirror used was deformed and not  completely  flat  (ie  concave  or
convex mirror problems).

To fix it, use the Match ScaleX tool:

To do so, find two objects at  the edges  of  the  images  (preferably  at  the  same  height  on
the  screen)  that  can  be  assumed  to  be  at  a  similar  distance,  yet  they  seem  to  have
different parallax, owing to the distortion. Use Match MoveX on one of these objects, then
use Match ScaleX on the other, to locate it at the same distance as the first.

A  related  tool  that  may  help  to  compare  both  eyes  when  looking  for  these  problems  is
Match MoveX: it  is identical to Match Move action with  Y_Constraint  activated,  but  using
just one click.

These  issues  produces  very  complex  situations  in  which  each  area  requires  a  different
amount  of warping to fix it, because linear geometrical adjustment  that  fixes  discrepancies
in one area will produce a problems in other areas.

These cases are easy to detect when using the geometry matching tools as the background
and foreground features will be seen to require different  geometrical adjustments,  which is
obviously impossible to fix with standard geometry transformations, and so a complex warp
is required.

Typical causes in mirror rigs are:

* When the mirror is not at exactly 45 degrees to both camera.

* When both lenses are not at an angle of exactly 90 degrees to each other.

* When both lenses are not  at  the same distance from the mirror. This can happen if  a
camera is slightly displaced or if the zooms are not in identical positions.

* When the lenses have slight differences in geometry.

* When the mirror is  slightly  deformed or rotated.  Mirrors  are  usually  fixed  in  place  at
only 3 of their 4  corners.  (four points  would  create  tension that  could  lead  to  the
mirror breaking). This leaves the fourth corner free,  which avoids  this  problem,  can
create slight mirror deformation due to mechanical stress.

In  theses  cases,  first  use  Balance_Geo_2->KeystoneX,  because  these  situations  may
produce scale mismatch in the X axis.

You may then need to use the AlignXY  tool, which will identify each pixel of one eye in the
other eye and warp one eye at a pixel level in order to match the remaining deformations of
both images.

Note:  Sometimes  the  corners  of  the  image  can  not  be  completely  fixed,  and  it  will  be
necessary to also apply a small amount  of zoom to  get  rid  of  these  areas  after using  this
tool.
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Access to this tool is via Stereo3D->OpticalFlow->Mode->AlignXY.

This should be the last step of geometrical adjustments for two reasons: its calculation will
benefit  from previously  carried  out  adjustments,  and  because  motion estimation tools  can
create  artifacts  in  some  situations,  so  it  should   only  be  used  if  strictly  necessary  (if
artefacts appear, you may need to  use  the  FX->Warp  tool to  manually  warp  the  images
rather than using this tool).

This  refers  to  the  problem of  a  double  image  in  one  of  the  eyes,  sometime  due  to  an
electronic  fault  in the camera (as might  happen in 2D), but  mainly this  is  a  problem in  the
reflected eye when using beam-splitting rigs: the mirror has  a  thickness  which produces  a
secondary  reflection on the  rear surface  of  the  mirror.  This  reflection is  weaker,  but  still
visible in the brightest parts of the image.

In  order to  solve  this  problem,  an effect  that  works  surprisingly  well  is  Substract,  which
removes one copy of the image, previously aligned with the double image (via Comp3D) and
a  Color  Grade  or  Channels  effect  to  control  the  intensity  of  the  image  removed.  This
technique  works  well  thanks  to  the  fact  that  the  problem is  usually  only  visible  in  the
brightest parts of the image.

On  certain  rare  occasions  other  problems  caused  by  secondary  reflections  in  the  mirror
when the cameras are not  well-protected from unwanted light, which may  be  reflected  by
the camera hood. These problems cannot usually be solved with this technique.

Noise is usually  produced  by  the  camera's  electronics,  caused  by  the  use  of  codecs  with
compression, or by film grain when using  filmstock negative.  This  may  seriously  affect  the
perception of the stereo image, since each grain  or compression will  be  visible  n  only  one
eye, causing discomfort when viewing the stereo image and reducing its effect.  

In order to solve such problems, the best results are obtained using Denoise in Mistika.

Differences in the settings of the shutter and un-calibrated sensors can cause  Motion Blur
discrepancies between the two eyes. 

Solve this problem with the effect Optical Motion Blur. 

This  effect  can also  be  applied  to  CG elements  derived  from VFX  to  give  them the  same
Motion Blur that a real image has, which is especially important in stereo compositions. 

These problems tend to be very time-consuming to correct. 

If  it  is not  possible to eliminate artifacts  that  appear only  in  one  eye,  they  should  be  are
softened  as  much  as  possible  and  introduced  into  the  other  eye  with  composition
techniques, in order to maintain consistency in both eyes.

In extreme cases, it  is impossible to remove the artifacts, so the shot  has to be discarded
and reconstructed using the other eye, by, for example,  cutting  the  elements  the  are   at
different  depths  and  locating  them in  the  3D space  with  the  effect  Comp3D,  (this  effect
has two virtual cameras when use in stereo mode). 

DepthMap can sometime be useful as a base for working with  cut  masks,  but  they  usually
only  have  defined  edges  in  some  parts  of  the  image.  If  this  is  not  the   case,  another
technique is to blur the DepthMap and use  it  like  Displacement  Mapping  in  the  Comp3D
effect, making sure the polygonal subdivision is set as high as possible.

Problems sometimes arise when variable Zoom lenses are used in the shoot,  and  when the
zooms are not  exactly the same, and therefore the lenses are not  the same distance  from
the mirror, and thus the focus is not the same. 

In this kind of situation, the main symptom is that  if  we adjust  the geometry of elements in
the foreground (in negative Parallax) elements in the background (in  positive  Parallax)  lose
their setting, and vice versa  (and  thus  a  problems  of  geometry  is  also  created,  as  well  a
lack of focus in one eye).

There are various  techniques  that  can be  used  to  deal with  this  problem,  even though it
may be problematic:
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Mistika also has a very powerful tool for dealing with these situations, which means the user
can deal with an unfocussed eye by taking each pixel of the focussed eye and moving it  to
its corresponding position in the other eye (the unfocussed eye will be discarded but  first  it
is used to ascertain where each pixel is to be positioned). To do so, select  the  eye  to  be
modified via ColorBalance2->Fix and reduce the parameter ColorBalance2->Smoothness to 0
if necessary. It is also usually recommendable to change the parameter OpticalFlow->Range
to None 

The previous method may resolve both problems (geometry and focus) but  will not  function
in  all  cases,  since  in  certain  cases  it  may  result  in  deforming  the  image  or  produce
artefacts. The following are some partial alternatives for resolving geometry:

A  first  approximation is  to  try  to  establish  an  intermediate  geometric  balance  using  both
settings, always forcing the center of the image to remain correctly aligned. 

The Stereo3D->OpticalFlow->Mode->AlignXY  tool may  solve  these  geometry  issues  in
many cases. This tool, which will identify each pixel of one eye in the other eye  and  warp
one eye at a pixel level to in order to match the remaining deformations of both images.

Note: Sometimes the image corners can not be fully fixed, and it  is necessary to also apply
a small amount of zoom to discard these areas after using this tool. 

The access of this tool is in Stereo3D->OpticalFlow->Mode->AlignXY.

This should be the last  step of  geometrical adjustments,  both  because  it  will  benefit  from
previous adjustments and because motion estimation tools that can create artifacts in some
situations 

On some occasions, it  is possible to use other techniques based on creating two (or more)
versions  with  different  settings,  one  for each significant  depth layer,   and  later  compose
them with Mistika's different composition tools.

The FX->Warp effect  may help to resolve very complicated areas  but  may  be  very  time-
consuming. 

Mistika  has  unique  tools  for  subsequent  adjustments  of  interocular  distance  and  for  the
control of  the  depth of  the  stereoscopic  effect.  This  section  only  deals  with  its  use  for
adjusting extremes of maximum and minimum depth.

Each stereoscopic screen has a maximum and minimum depth that can be shown, and which
depends on the distance from the spectator and the quality of the technology employed.

The limits of disparity depend on each specific  situation (normally, tables or simple formulas
that relate real depth with the number of pixels of disparity for the intended 3D display are
used as reference). Generally, it can be said that:

For 3D televisions, use positive parallax, locating the majority of the action "behind"
the screen. 

For cinematic productions, the action should be located at  the depth of the screen,
without abusing the effects of negative parallax, 

For  large-scale  screens  with  considerable  distance  between  screen  and  viewers
(such as  IMAX)  it  is  possible  to  position  a  large  part  of  the  action  between  the
spectator and the screen.

To adjust  for different  versions, remember that  independent  of  the  3D display  available,  it
can be used to simulate larger or smaller screens, only by changing the spectator's distance
from the screen distance. 

The following adjustments require the supervision of the  stereography  artist,  since  as  well
as  solving  technical  problems  they  may  also  affect  the  fundamental  perception  of  the
scene.

To center the scene between the depth limits, modify the parameter PosX. 
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To obtain a good visual reference, there are two possibilities: 

Open  the  viewing  mode  panel  ShowDepth  (Optical  Flow->Mode->ShowDepth),
which shows the depth (disparity) of each pixel in grayscale.

Choose the viewing mode Warp (Optical Flow->Mode->Warp)  and open the panel
 DepthGraph:

Before  using  these  graphics,  the  geometry  needs  to  have  been  correctly  adjusted  as
detailed  earlier,  and  color  matching  and  other  questions  need  to  have  been  addressed,
otherwise,  these  graphics  will  make  no  sense.  Also,  activate  the  ConstrainY  button  for
greater accuracy.

If it has not yet been done, adjust the Negative Split and Positive Split  parameters (Optical
Flow->NegativeSplit/PositiveSplit) is acceptable for the intended 3D display.

The vertical lines of the DepthGraph represent the limits of negative, positive and the plane
of  the  screen  (convergence  plane).  When  the  convergence  plane  is  changed  (PosX
parameter), we can see how both graphics change interactively.

The DepthMap allows us to see the depth associated with  each element  of  the  scene,  so
we know which elements exceed the limits (although it  is not  always necessary  to  correct
them),  and  we  know  if  the  full  depth  is  being  adequately  used  for  elements  that  are
subjectively important.

Phase 2 - Creative stereoscopic adjustments

Some  creative  stereoscopic  techniques  and  their  method  of  employment  in  Mistika  are
described  below.  Generally,  they  should  be  carried  out  under  the  supervision  of  a
stereoscopic  artist.  They  should  not  be  begun  until  the  technical  setting  phase  is
completed, for the many reasons previously mentioned.

- Choosing and animating the convergence point 

- Setting interocular distance and dwarfism/gigantism

- Setting selective depths for different ranges of depth 

- Narrative use of floating windows 

- Using DepthMap as a mask for other effects
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Choosing and animating the convergence point:

The  convergence  point  has  the  virtue  of  attracting  the  viewer's  attention as  the  default
focus point in the screen. It can be use in a manner correlating to the focal point in 2D. 

To set  it,  select  Match Move  and  click on the  character to  be  converged,  or modify  the
PosX parameter if no clear convergence point exists.

The  PosX  parameter can also  be  set  via  keyframes  so  that  the  convergence  follows  the
required element when moving (or if the camera moves) changing depth in each scene.

The animation of the convergence point can be combined with the animation of the floating
window to achieve greater dynamism and accentuate changes in depth, or in productions in
which a more subjective, or contemplative  viewpoint,  is  required,  in  which case  the  same
plane needs to be maintained as long as possible.

Adjusting interocular distance and dwarfism/gigantism:

For obvious reasons, if the distant between the cameras lenses exceeds that  of the human
eye (average 6.5cm), characters in foreground (negative parallax) are "dwarfed", while more
distant characters in positive parallax suffer from gigantism.

If the distance is less than that between the two eyes, then the reverse is observed.

Mistika  has  unique  tools  for  adjusting  interocular  distance  in  postproduction,  either  to
correct such effects or to provoke them intentionally for narrative effects.

Activate  Warp  (OpticalFlow->Mode->Warp)  and  YConstrain  (OpticalFlow-
>YConstrain).

Modify the parameters All (OpticalFlow->All) to adjust the interocular distance.

Furthermore, if  the whole range of depth is not  being fully utilized (the stereoscopic  effect
is hardly visible) or both extremes are being exceeded, use the parameters All to change the
interocular distance, compressing or expanding the space within the scene. 

Note: This cannot be seen in the graphic  DepthGraph, since Warp is a subsequent  process
based on the results calculated by this graphic. If  a graphic  of the result  is needed, render
the current frame for both eyes and view the graphic in a new stereo effect.

Adjusting depths selectively for different ranges of depth:

The Positive, Middle and Negative parameters in the Optical Flow folder allow the  selective
adjustment  of interocular distance for each of the three zones (behind the screen,  central
and  close  to  the  spectator).  This  allows  the  selective  adjustment  of  the  depth  offering
different  narrative  possibilities.  This  way,  shots  that  are  acceptable  in  certain  areas,  but
which  contain  depth  problems  in  others  can  be  be  kept:  so  acceptable  zones  remain
unmodified when All mode is used to to correct others.

Narrative use of floating windows:

Animation of  floating  windows  can also  be  used  to  achieve  effects  of  zooming  in  or  out,
useful when the convergence can no longer be altered, or in conjunction with the animated
convergence. 

Using DepthMap as a mask for other effects:

A  DepthMap  (OpticalFlow->Mode->ShowDepth)  can sometimes  be  obtained  for  use  in
other effects  (especially  if  there  is  no  occlusion,  i.e.  no  object  passing  behind  another,
which would prevent tracking pixels at the edges). 
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To  obtain  a  good-quality  DepthMap,  both  geometry  and  color  need  to  be  set  perfectly.
Activate YConstrain, and improve the quality parameters of optical flow (increase Iterations
 and lower MinLevel). 

The  Smoothness  parameter can also  help  improve  results.  This  parameter  tells  Mistika  if
sudden changes of tracking vectors are allowed, which helps to choose the correct  solution
for the tracking vector of each pixel. For example, if  there are clapping hands in the image,
it is necessary to allow the tracking vectors to "bounce" with each clap, whilst  if  the hands
cross instead of clapping, then it  should be increased, to  prevent  vectors  bouncing  during
occlusions.

Then,  add  a  certain  amount  of  blur to  the  result  of  the  DepthMap to  soften problems  at
edges, and contrast it with RGBCorrect.

These maps can be a useful base for constructing masks which can be  used,  for example,
to:

Blur backgrounds or sharpen blurred images

If well focussed, they can help create composition masks in combination with  other
techniques.  For example,  they  can help  clean up  badly-lit  Chroma  keys,  combining
both masks. 

If they are correctly set, they can help create composition in combination with other
techniques. For example, they can help clean up badly lit Chroma keys, by combining
both masks,  or by  inserting  elements  in  a  scene  at  a  certain  depth,  so  that  they
pass behind other elements and in front of others. 

Re-light  scenes  with  movement  in  3D.  This  may  be  required  for  scenes  with  "flat"
lighting,  or for  more  creatives  results:  apply  DepthMap  as  a  displacement  map  in
Comp3D.  Blur the  map  a  little  and  apply  Color  Grade  or  Channels  to  extract  the
correct range and contrast it. Use the 3D lights of the Comp3D effect  to obtain new
lighting.  If  the  displacement  map  is  applied  to  a  dark  gray  image,  masks  can  be
obtained (ideally for each light  source)  with  which secondary  color corrections  can
be applied in Color Grade or other effects to simulate lighting for each light.

Stereo 3D

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Stereo 3D->Stereo 3D

The  Stereo3D  effect  allows  settings  changes  and  the  redefining  (by  means  of  the
application of the Optical Flow algorithm) of the values of a stereoscopic image.

I/O

Inputs

Input Stereoscopic: stereoscopic image

Inputs

Image: stereoscopic image

Alpha: opaque mask 
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Parameters

Mirror:

Mirror Left Eye; Mirror Right Eye

[None (None / Horizontal / Vertical / Rotate]

Undoes  the  mirror  effect  in  the  pairs  of  stereo  images  obtained  from  mirror  rig
systems, inverting the image horizontally, vertically or both ways.

Adjust Geometry:

Global setting parameters for the appearance of the stereoscopic image.

PoxX; PosY

[0; 0 (-100.000 / 100.000)]

Sets global values of X and Y  for geometric  correction of the image. The pivot  of this
parameter is always the center of the image.

Zoom

[100 (-100.000 / 100.000)]

Sets global scaling values of for geometric  correction of the image. The  pivot  of  this
parameter is always the center of the image.

Roll

[0 (-100.000 / 100.000)]

Sets  a  global value  for roll  for geometric  correction of  the  image.  The  pivot  of  this
parameter is always the center of the image.

Balance Geometry:

Apply

[LR (L Only / LR / R Only)]

Specifies the range of application of the settings for geometry: left  image, tight  image
or both images.

PoxX ; PosY

[0; 0 (-100 / 100)]

Specifies  the  value  of  the  convergence  point,  transforming  the  selected  point  into
zero parallax.
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Zoom

[100 (50 / 150)]

Specifies the value of the size of both images of the stereo pair.

Roll

[0 (-90 / 90)]

Specifies the value of rotation of both images of the stereo pair.

Keystone

[0 (-10 / 10)]

Applies a compensation of the Keystone effect, eliminating the trapezoidal deformation
caused by badly projected images in stereo capture systems.

Adjust Color:

Black:Red; Black:Green; Black:Blue

[0; 0; 0 (-100 / 100]

Defines the values of black in the RGB channels.

White:Red; White:Green; White:Blue

[100; 100; 100 (0 / 200]

Defines of the whit point in the RGB channels.

Balance Color:

Apply

[LR (L Only / LR / R Only)]

Specifies  the   range  of  application of  the  color  settings:  left  image,  right  image  or
both images.

Black:Red; Black:Green; Black:Blue

[0; 0; 0 (-100 / 100]

Specifies the RGB value to be corrected to black in both images of the stereo pair.

Higher values specify a lighter color as a black point, so that  the color correction will
darken the image if this value increases, and vice versa. 

White:Red; White:Green; White:Blue

[100; 100; 100 (0 / 200)]
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Specifies the RGB value to be corrected to white in both images of the stereo pair.

Lower values specify a darker color as a white point, so that  the color correction will
lighten the image if this value decreases, and vice versa. 

Wedge:Red; Wedge:Green; Wedge:Blue

[100 (0 / 200)]

Specifies the RGB value of the gradient of correction in both images of the stereo pair.

This parameter allows  the  correction of  differences  in  color between images  derived
from mirror rig systems. In these systems, the mirror is close to one of the two lenses
but too far from the other producing gradual differences in color.

Note: If acceptable results are not  obtained, it  is recommended to use Fix Left  or Fix
Right of the Fix parameter in the Balance Color 2 folder of this effect.

Floating Window:

Warning:  this  is  the  old  version  of  Floating  Windows  to  maintain  the  backward
compatibility. You can find the current version in FW Left Edge and FW Right Edge.

Left Width; Right Width

[0; 0 (-100 / 0)]

Specifies the crop value of a window floating over the convergence plane.

Left Slant; Right Slant

[0; 0 (-100 / 100)]

Specifies the value of inclination of a window floating over the convergence plane.

Balance:

Setting parameters for convergence and balance between the pair of stereoscopic images.

Geometry PoxX ; PosY

[0; 0 (-100 / 100)]

Sets  the  value  of  the  convergence  point,  transforming  the  selected  point  to  zero
parallax.

Geometry Zoom

[0 (-100 / 100)]

Sets the size of both images of the stereoscopic pair.

Geometry Roll

[100 (50 / 150)]
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Sets the roll value of both images of the stereoscopic pair.

Geometry Keystone

[0 (-10 / 10)]

Applies  a  compensation  of  the  Keystone  effect,  which  eliminates  the  trapezoidal
deformation that badly projected images can suffer in a stereoscopic capture system.

Geometry FloatWin

[0 (-100.000 / 100.000)]

Sets the cropping value  of  a  window  floating  over a  convergence  plane  at  negative
parallax.

Color-Black R; Color-Black G; Color-Black B

[0 (-100 / 100)]

Sets the RGB value to be corrected to black in both images of the stereoscopic pair.

Higher values set  a lighter color as  the  black point,  so  that  the  color correction will
make the image darker if this value is increased, and vice versa.

Color-White R; Color-White G; Color-White B

[100 (0 / 200)]

Sets the RGB value to be corrected to white in both images of the stereoscopic pair.

Lower values set a darker color as the white point, so that the color correction will lift
the brightness of the image if this value is decreased, and vice versa.

Optical Flow:

Mode

[Off (Off / ShowDepth / Warp / Align)]

Defines the four possible viewing modes of the optical flow effect, as follows:

Off. Deactivates the warping effect.

ShowDepth. Viewing mode for the depth of the stereo pair, shown in grayscale. Darker
grays  represent  objects  with  negative  parallax,  lighter grays  represent  objects  with
positive parallax.

Warp.  Activates  the  warping  effect,  allowing  the  scaling  of  depth  by  means  of  the
Optical Flow algorithm.

Align. This mode is automatically activated when selecting the Align Warp manipulator
based on theOptical Flow algorithm. With the  Checkerboard  viewing  mode  activated,
Align Warp allows the viewing of both cameras as if  they were identical frames, which
assists color correction of both simultaneously.

AlignXY.  Activates  the  deforming  effect  that  allows  the  correction  of  vertical
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alignment cause when the angle between the lenses and the mirror is not  exactly 45º,
or when the distance between each of the lenses and the mirror is not  the same (as
for differences in zoom).

Y-constrain

[No (Yes / No)]

Limits warping to the horizontal axis, avoiding undesired warping in the vertical axis.

Range

[Medium (None/Small/Medium/Large)]

Indicates the interpolation that Optical Flow will use.

MinLevel

[1 (0 / 8)] 

Factor that  divides  the  drag  resolution in  half:  the  higher  the  value,  the  lower  the
resolution, thus accelerating the calculation of the effect.

Levels

[7 (1 / 8)] 

Refines the direction of the movement vectors.

Iterations

[100 (0 / 1.000)] 

Reviews of movement in areas with little detail.

Smoothness

[10 (0 / 1.000)] 

Smoothes the direction of crossed vectors, making them more parallel.

Min

[-96 (-1.000 / 1.000)]

Defines  the  minimum values  of  depth  to  be  included  in  the  viewing  range  of  the
histogram represented by the Depth Graph tool.

Max

[32 (-1.000 / 1.000)]

Defines  the  maximum values  of  depth  to  be  included  in  the  viewing  range  of  the
histogram represented by the Depth Graph tool.



635FX

SGO Mistika 8.6 © 2018 SGO

All

[1 (0 / 3)]

Scales the sensation of the whole depth range.

Negative Split

[-32 (-1.000 / 0)]

Defines  the  limits  between the  negative  convergences  and  those  of  the  mid-range.
This value is represented in the Depth Graph with the blue guideline.

Negative

[1 (0 / 3)]

Scales depth in the negative range of convergences.

Middle

[1 (0 / 3)]

Scales depth in the middle range of convergences.

Positive Split

[16 (0 /1024)]

Defines  the  limits  between positive  convergences  and  those  of  the  mid-range.  This
value is represented in the Depth Graph with the red guideline

Positive

[1 (0 / 3)]

Scales depth in the positive range of convergences.

Balance Color 2:

These  parameters  specify  the  correction  values  used  by  Mistika's  advanced  tools  for
balancing color in the two images of the stereo pair. For more information on the functions
of the Balance Color 2, group, see  Advanced polarization and color problems.

Gain 1; Gain 2; Gain 3

[1 (0,100/ 10)]

These  parameters  store  values  for  the  Match  Color  manipulator  and  should  not  be
manually modified.

Offset 1; Offset 2; Offset 3

[0 (-1 / 1]
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These  parameters  store  values  for  the  Match  Color  manipulator  and  should  not  be
manually modified.

Fix

[Off (Off / Fix Left / Fix Right]

Specifies which of the two  images  of  the  stereo  pair (Fix Left  or Fix Right)  is  to  be
modified to balance the color.

Smoothness

[1 (0 / 100]

Specifies which type of Optical Flow solution should be chosen. Higher values indicate
to Mistika that the solution should not allow sudden color changes, and vice versa. 

Max Diff

[5 0 / 100]

Specifies the maximum permitted limit  of the range of the color correction.

Balance Geo 2:

Parameters that  define the correction values used by the Match Shear and  Match ScaleX
tools.

ShearX

[0 (-10 / 10)]

Value in the horizontal axis for correcting shear distortion.

ScaleX

[100 (50 / 150)]

Scale value for the horizontal axis, which is needed when viewing two objects at  the
same depth in the shot  that  have different  parallaxes. This is caused when the mirror
used in the chassis is not totally flat. To correct this, select two objects at  the edges
of the image (preferably at  the  same  height)  at  a  similar distance  from the  camera;
using Match MoveX click on one of them, then with Match ScaleX click on the other.
Mistika corrects the difference in scale between the two eyes.

KeystoneX

[0 (-10 / 10)]

Keystone value for compensating scaling issues between upper an lower parts  of  the
image; this can be caused the by the mirrors on the  chassis  being  misaligned  or the
cameras not being at exactly 90º. This parameter is not usually necessary, and so can
only be adjusted manually.

Note:  Once  this  is  used  it  may  be  necessary  to  use  AlignXY,  as  these  cases  also
sometime have image deformation issues.
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Image:

These parameters define final modifications for the stereo pair.

Gamma

[1 (0 / 10)]

Sometimes,  the  zonal  Match  Color  tool  (Fix  Left  /  Fix  Right)  works  better  if  a
logarithmic scale with a gamma values is applied to the correction.

Border

[Extrude (Extrude / Fill Black)]

Indicates whether there is an extrude (if a bigger original image is required) or black fill
at  the  edge  of  the  original pair of  images;  an extrude  is  produced  by  dragging  the
values of the final pixel of the original border to the edge of the final image.

FW Left Edge:

This allows the control of the values of the Floating Window and the Crop of the left  side of
the image.

Crop

Controls the value of crop of the left  side of the image. This affects the whole of the
stereo pair.

Top

Controls the values of the Floating Window at the top left of the image.

Both

Control values of the Floating Window values of all of the area left of image.

Bottom

Controls the values of the Floating Window at the bottom left of the image.

FW Right Edge:

This allows the control of the values of the Floating Window and the Crop of the right  side
of the image.

Crop

Controls the value of crop of the right side of the image. This affects the whole of the
stereo pair.
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Top

Controls the values of the Floating Window at the top right of the image.

Both

Control values of the Floating Window values of all of the area right of image.

Bottom

Controls the values of the Floating Window at the bottom right of the image.

HIT:

Functionally, the HIT  parameter acts like the PosX value in Balance Geometry, ie it  defines
the value of the convergence point. But  while PosX is a technical feature, the value of HIT
serves a creative tool. Thus its use is indicated as the final step: once the stereo pair has
been adjusted technically, the creative phase begins using this parameter.

Quick Access

The following tools are found in the direct  access bar dedicated to the Stereo 3D mode of
the Visual Editor.

Use Stereo Mode.

Activates the stereoscopic viewing mode.

S3D Disp.

Sets the stereoscopic viewing mode for the visual editor.

S3D Live.

Sets the stereoscopic viewing mode for the video output.

Note:  some  modes,  such  as  Anaglyph,  may  be  viewed  badly  in  non-calibrated
monitors, with imperfections in the YUV video signal.

Viewing modes.

The possible modes are described below:

Left Eye. Mode for viewing only what will be seen by the left eye of the viewer.

Right Eye. Mode for viewing only what will be seen by the right eye of the viewer.

Anaglyph. Color viewing mode for anaglyph glasses, red for the left  eye and  cyan for
the right eye.

B&W Anaglyph. Black and white viewing mode for anaglyph glasses, red for the left eye
and  cyan for the  right  eye.  This  mode  is  more  comfortable  than  common  anaglyph,
since  by  eliminating  the  color in  the  stereo  pair,  it  avoids  the  problem of  darkened
objects where colors are saturated.
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Interlaced. Interlaced stereoscopic viewing mode. Each one of the stereoscopic pair is
viewed in a different field within the same interlaced signal.

Note:  This  mode  does  not  work  with  progressive  sources  such  as  an  interface
monitor.

Side By Side. Viewing mode that scales the resolution of the stereoscopic  pair to half,
in order for both images to be viewed side by side.

Note:  Many  devices,  such  as  active  glasses,  recognize  this  mode,  in  order  to
automatically activate their own stereoscopic system later.

Difference.  Viewing  mode  in  which  the  stereo  pair  is  superimposed  to  detect
differences  between  the  images.  This  mode  helps  the  user  to  set  zero  parallax,
indicated  by  the  vanishing  silhouettes  of  the  objects  found  in  the  accommodation
zone.

Checkerboard. Viewing mode that overlays the stereo pair with a checkerboard mask.
This mode helps the user with balance of brightness and color in the stereo pair.

Note: To maximize the  use of this mode, activateWarp->Mode in Warp.

Mix. Viewing mode in which the stereo pair is mixed into a single image.

Dual Link. Viewing mode in which the video output  uses the two  dual link outputs  as
independent signals.

Shift Clip

Allows  the  setting  of  input  and  output  points  of  an  image  without  changing  its
duration.  Applied  to  a  stereo  clip,  this  command is  very  useful  for  balancing  out  of
sync cameras in the Node Graph.

Stereo3D Editor

Ref. Mistika: Visual Editor->Manipulators Tabs->Stereo3D

It is common to find pairs of images with imbalances, owing to the use of mirrors, or simply
a lack of care when setting the two stereoscopic lenses.

These commands define behavior of clicking over a point  in the stereoscopic  image. Mistika
reconstructs the depth map that  the parallaxes of the pair of images create, thus allowing
them to  be  edited   interactively.  Thus  when  clicking  over  a  point,  it  will  automatically
recognize the convergence shot to which it pertains.

The interactive selection modes are used to change the convergence point, and match size,
rotation and  brightness  of  both  images.  The  matching  of  the  stereoscopic  pair  maximizes
the effect of depth and improves visual comfort.
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Match Tools:

Set Pivot

Selects the pivot point for the balance correction between the two images. This point
must  be set  as a first  step  before  trying  to  set  the  Match Rotation  and  Match Size
points.

Match Move

Interactively  matches  the  position  of  both  images  of  the  stereoscopic  pair.  This  is
used to reset the convergence point, transforming the selected point to Zero Parallax.

Match Size

Interactively  matches  the  size  of  both  images  of  the  stereoscopic  pair.  It  is
recommended to first select a Pivot point with the mode Set  Pivot, and then a second
point that, vertically anchored to the Pivot, will reset the size of both images. 

Example of use: The cross  manipulator is  useful for looking  for a  good  pivot  point,
since we will need to  find  an object  that  can be  measured  vertically.  The  first  click
with  Set  Pivot  should  be,  for  example,  on  the  upper  edge  of  a  vertical  post.  The
second  click should  be  done  with  Match Size,  on  the  lower  edge  of  the  post.  The
vertical  distance  between  both  points  will  define  a  size  that  Mistika  will  balance
between the pair of images.

Match Rotate

Interactively  matches  the  rotation  of  both  images  of  the  stereoscopic  pair.   It  is
recommended to first select a Pivot point with the mode Set  Pivot, and then a second
point  that,  horizontally  anchored  to  the  Pivot,  will  reset  the  horizon  line  of  both
images. 
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Example of use: The cross  manipulator is  useful for looking  for a  good  pivot  point,
since we will need to find a straight  line in  order to  define  the  camera  roll.  The  first
click with  Set  Pivot  should  be,  for example,  a  point  on the  horizon,  or the  top  of  a
table. The second click should be done with  Match Rotation,  at  the  opposite  end  of
the  tabletop.  The  inclination  defined  by  both  will  create  an  angle  that  Mistika  will
match between the pair of images.

Match Shear

Interactively corrects the shear effect that one image in a stereo pair might have with
relation  to  the  other.  It  is  recommended  first  to  select  a  pivot  point  with  Match
MoveX mode, then select a second point with Match Shear which, anchored vertically
to the pivot, corrects the shear distortion.

Example of use:  The cross-shaped manipulator is useful for helping find a good pivot
point, since we need to find a straight  line to establish the degree of incline (camera
roll). Once an object that shows the shear distortion has been found, click the bottom
or lower part  of  the  object  with  Match  MoveX  (in  the  example  the  bottom of  the
corner). The second  click should  be  done  with  Match Shear  at  the  other end/edge.
The shear distortion will be corrected with the second click.
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Match ScaleX

Interactively  equalizes  the  the  horizontal size  of  both  images  in  a  stereo  pair.  It  is
recommended first  to  select  a  pivot  point  with  Match  MoveX  mode,  then  select  a
second  point  with  Match ScaleX  which,  anchored  horizontally  to  the  pivot,  corrects
the difference in horizontal scale.

Example of use:  The cross-shaped manipulator is useful for helping find a good pivot
point, since we need to find a straight  line to establish the degree of incline (camera
roll).  The  first  click with  Match MoveX  should  be  done  on  one  of  the  sides  of  the
image, such as on an object with a horizontal shape or one which has the same depth
on the other side of the image. The second click is on the other side of the image with
 Match ScaleX. Mistika corrects the difference between the  two  images  in  horizontal
scale.

Match Corner

Interactively matches the geometry of both images of the stereo pair in the selected
corner without  modifying  the  other three  corners.  This  is  not  a  simple  warper,  but
rather modifies position, rotation, scale and keystone.

Match Dark

Interactively matches the levels of dark in both images of the stereoscopic pair.

For both  Match Dark and  Match Light,  first  select  "Checkerboard"  mode  in  the  S3D
display to check that the setting has worked.

Example of use: Select a point where the image is dark, although it does not have to
be absolute black. Mistika will match the levels of dark between the pair of images.
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Match light

Interactively matches the lightness in both images of the stereoscopic pair.

For both  Match Dark and  Match Light,  first  select  "Checkerboard"  mode  in  the  S3D
display to check that the setting has worked.

Example of use: Select a point where the image is light, although it does not have to
be absolute white. Mistika will match the brightness levels between the pair of images.

Pick Tail

Sets the disparity value in the output clip in a Depth Transition.
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Pick Head

Sets the disparity value in the input clip in a Depth Transition.

Pick Floating Window Depth

Interactively sets a floating window of negative parallax over the convergence shot.

Note: the floating window can only be defined in negative parallax, since it only allows
the simulation of the closeness of  the  viewer to  the  screen by  means  of  the  virtual
floating window.

Match MoveX

This  tool  allows  access  to  the  same  function  carried  out  by  Match  Move  with  Y-
Constrain activated in just one click.

Interface Modes:

Auto Match

Activates  the  automatic  correction  mode  of  the  manipulators  of  the  Match  Tools
group. To match or line up the cameras, just left click in the area within  Canvas.

Equaleyes:

The Equalize function in  Mistika   allows  the  automatic  setting  of  different  geometries  and
colors in stereoscopic images.

Match Geometry

Specifies an automatic  geometry correction (position,  size,  rotation and  keystoning).
This preliminary correction allows the resetting of differences between the two images
of the stereo pair.

Match Colors

Specifies  an  automatic  color  correction.  This  preliminary  correction  allows  the
resetting of differences between the two images of the stereo pair.

Disparity Handoff:

The function and use of these manipulators is explained with the Depth Transition effect.

Stereo3D effect modes:

Align Warp

The Align Warp manipulator, based on the Optical Flow  algorithm,  activates  the  Align
mode which allows the viewing of both cameras as if they were identically framed.
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Y Constrain

Limits  the  warping  to  the  horizontal axis,  avoiding  undesired  warping  in  the  vertical
axis.

Manip Speed Reduction:

These buttons define a scale of sensitivity of drag  for the  movement  of  the  manipulators.
The minimum value (1) defines that the relation of drag and modification of the parameter is
at  1:1,  while  higher values  define  it  at,  for  example,  1:128,  making  the  manipulator  less
sensitive to the drag movement.

CP Speed Reduction:

These  buttons  specify  a  scale  of  drag  sensitivity  for the  Tangent  Devices  controls  when
doing  Depth  Grading  controlling  parameters  of  the  Stereo3D  effect,  which  requires  a
different  sensitivity  than  when  doing  Color  Grading  (the  RGBCor  effect  has  its  own
sensitivity  control).  The  minimum value  (1)  specifies  a  drag  and  parameter  modification
relation of 1:1,  while  higher values  ,  for example,  values  such as  1:128,  specify  that  the
manipulator is less sensitive to the drag movement.

Depth Graph

This toggle allows the selection of different monitor types in order to evaluate depth of the
stereo image.

Histo Depth:

This monitor displays a Depth statistics graphic as a histogram.

The vertical axis shows the number of  pixels  with  the  same  convergence  value  that  have
been found in the image; the horizontal axis shows the convergence planes.
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This histogram shows the convergence planes found between the parameters Max and Min,
allowing  the  user to  modify  these  parameters  to  set  the  depths  of  field  indicated  by  the
graphic.

The graphic  has three vertical guides. The  red  guideline  indicates  Zero  parallax,  the  plane
where the screen is best situated. The blue guideline indicates the Negative Split  parameter
and the green guide indicates Positive Split.

The histogram therefore represents the  number of  pixels  found  in  the  convergence  planes
closest  to the spectator to the right  of the green guideline, while to the  left  of  the  green
guideline is the number of pixels further from the spectator.

The depth range found to the left  of the blue guideline can be scaled using the  parameter
Negative.  The  depth range  between the  blue  and  red  guidelines  can be  scaled  using  the
parameter Middle,  while  The  depth range  found  to  the  right  of  the  red  guideline  can  be
edited using the parameter Positive.

Use the parameter All to scale the whole depth range.

Note: this tool only shows the original depth of the stereo image, and not  the result  of the
depth scales defined in this effect.

Depth Radar:

This monitor displays a Depth statistics graphic in wave form.

The vertical axis  corresponds to  the  image,  showing  the  different  depths  of  the  pixels  in
this part of the stereo pair. 

The wave  form corresponding  to  the  the  stereo  pair is  displayed  along  the  the  horizontal
axis.  The  three  horizontal guidelines  correspond  to  the  parameters  Negative  Split  (blue),
Zero parallax (green) and Positive Split (red).

Note: this tool only shows the original depth of the stereo image, and not  the result  of the
depth scales defined in this effect.

Depth Trace:

This monitor displays a Depth statistics graphic in the form of traces or strokes.

The vertical axis shows the different frames that have been viewed over the course of time,
from top to bottom, with the lowest trace being the most recent.

The horizontal axis shows the  maximum and  minimum depth levels  (Depth Budget)  used  in
the given frame, by mean of three depth guides.

Note: this tool only shows the original depth of the stereo image, and not  the result  of the
depth scales defined in this effect.

Depth Transition

Ref.  Mistika:  Node  Graph  Editor->Dashboard->Fx->Mistika->Stereo  3D->Depth
Transition

The Depth Transition effect is a transition between two Stereo3D effects.

The general use of this transition is to bring the convergence points of  two  images  whose
distance  apart  could  be  uncomfortable  for  the  viewer  when  cutting  from  one  shot  to
another closer together.

Just  like  other transitions  in  Mistika,  Depth Transition  should  be  positioned  over  the  two
clips (or in this case, Stereo3D effects) to be applied. The  duration of  Depth Transition  is
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set by this transition.

The  only  parameter of  this  effect  is  Balance->PosX,  which  defines  the  position  of  the
mixed convergence point during the transition.

The most practical way of applying Depth Transition is to use the Visual Editor  with its Eval
Tree and Storyboard tools.

Once  the  Depth  Transition  is  applied  in  the  Node  Graph,  drop  down  the  Eval  Tree  and
Storyboard toggles in the Visual Editor

In the Storyboard, choose a position with the command <Ctrl>+<LeftClick>. Use the Pick
Tail manipulator in  the  Dashboard  of  the  Visual Editor   to  define  the  output  convergence
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point, and left click on the Canvas. The  Disparity Tail box in the Disparity Handoff  group of
the  Dashboard  is  updated  with  the  value  shown.  This  box  also  allows  values  to  be  set
manually.

Next, select the input image using Storyboard again. With the Pick Head manipulator, define
the  input  convergence  point  as  before.  The  Disparity  Head  box  in  the  Disparity  Handoff
group of the Dashboard is updated with the value shown. This box also allows values to be
set manually.

Finally,  to  apply  the  transition,  select  Depth Transition  from the  Eval Tree  toggle  by  left
clicking  and  then  select  the  command  Set  Stereo  Depth  Transition  Effect  in  the  group
Actions of the Dashboard.

Stereo Extract

Ref.  Mistika:  Node  Graph  Editor->Dashboard->Fx->Mistika->Stereo  3D->Stereo
Extract

This tool allows the conversion of  a  simple  clip  to  a  stereo  clip  with  stereo  information in
SBS (Side-By-Side) format, extracting both eyes in separate images, normally to be passed
to the effect Stereo3D. Generally, this type of format  is derived from stereo recording done
on VTRs que that do not allow dual stream recording.



649FX

SGO Mistika 8.6 © 2018 SGO

I/O

Inputs

Single input: Image in SBS (Side-By-Side) format.

Inputs

Image: Stereoscopic  image (SBS-Auto)  or simple  image  (SBS-Left,  SBS-Right)  scaled
to the current resolution.

Alpha: Opaque mask.

Parameters

StereoExtract:

Parameter which specifies how SBS images are processed.

Extract

[SBS-Auto (SBS-Auto / SBS-Left)/ SBS-Right]

Specifies whether the extraction produces a stereo image (SBS-Auto) or a simple one.
If it  is the latter case, the value specified as resulting  image  may  correspond  to  the
left eye (SBS-Left) or the right eye (SBS-Right) 

Note: Owing  to  the  process  of  selection and  rescaling  the  resolution of  the  original
image will be visibly reduced.

Depth Grade

The main function of this new effect is to transform a 2D image to a 3D image using mainly
depth  maps and masks (manually created or extracted from an Index map).  It  also  allows
to  compound  in  Z-  Depth,  using  the  Depth  values  of  the  scene  and  the  alpha  channel
information. The depth grade node generates the stereo pair based on a p-map (a parallax
map created  with  depth maps),  allowing  in  the  composition  to  control  depth  adjustment
independently by layer based on its masks information.

I/O

Inputs

Multiple Inputs: RGB image with a p-map (parallax map generated with depth maps),
and (optional) mask layers top adjust independently the elements of the image. 
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Output

Output: Stereo Image.

Parameters

Global:

The Global parameters control the general depth adjustment of the scene. 

Target Eye

Specifies the range of application of the settings for geometry: left  image, right  image
or both images.

Pushing Range

Specifies the depth range application of the settings for geometry.

Z-Preview Near

Extend or stretch the Depth Graph visualization using negative parallax as  reference.
It doesn't affect the clips, it's just pure visualization.

Z-Preview Far

Extend or strecht the Depth Graph visualization using positive parallax as reference. It
doesn't affect the clips, it's just pure visualization.

Z-Translate

Moves the objects in Z using the value in InterAxial Center as reference.

Interaxial Center

Controls the position of the convergence plane. It  works as reference for Z-Translate
and InterAxial Scale.

Interaxial Scale

Scales the interocular value using InterAxial Center as reference.

Compress Near

Moves the Negative Split  in Depth Graph (in blue). It's used as  reference  for Compr.
Direction.
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Compress Far

Moves  the  Positive  Split  in  Depth Graph  (in  red).  It's  used  as  reference  for  Compr.
Direction.

Compr. Direction

Compress  the  parallax  difference  of  the  clip  without  pass  the  Compress  Near/Far
reference.

Layer:

Depth Grade effect works with a Layer system based on Depth Maps and masks. Because of
this,  the  Depth  Grade  node  allows  to  composite  one  entire  scene  using  the  depth
information of each individual layer or even elements  inside  that  layer.  The  structure  of  a
Layer in Depth Grade is quite different  from other layers in Mistika. In the following example
we can see the different objects in a layer:

The  layer  is  composite  by  one  RGB  image  (the  2D  main  image),  a  depth  map  or  p-map
(which information will be used for generate  the  Stereo  pair),  and  finally  3  masks  created
with an Index Map to control the depth of each individual element. This group (RGB+Depth
map+masks) is an entire layer. If we would like to add a second layer, we will need to use
another RGB image with a Depth map for that image (masks are optional, only if  we want  to
have more control of the layer).

The  parameters  of  each  layer  are  the  same  that  Global,  with  the  difference  that  only
affects  the  selected  layer  and  not  the  entire  composition.  This  control  allows  us  to
composite all the layers not only based on the alpha channel or by operations like Blennding
Modes, but  using the depth information as well to adjust  each layer in Z, and then control
the general depth of our composition with the global parameters. 

Add  or delete  new  layers  is  the  same  than in  other effects  (Comp3D or  Color  Grade,  for
example). 
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Switch Eye

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Stereo 3D->Switch Eye

The effect Switch Eye allows the isolation of one of the two clips that  form the stereo pair;
they can be modified separately, only one eye worked on, or the 3D effect  simply inverted,
changing both clips and recombining them with their positions inverted.

I/O

Inputs

Single input: Pair of stereo images.  

Outputs

Image: Original image or single image corresponding to one of the images created by
the stereo pair, according to the option selected.

Parameters

Switch Eye

[Both (Both /Only Left / Only Right)]

Switches  between  the  different  possible  outputs  that  the  effect  offers.  It  can  be
applied with no immediate effect on the stereo pair (Both), preserving both images, or
can be selected so that the output is only one of the images.
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F-2 Misc

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Misc

The menu Misc contains various effects that do not belong to other groups.

Framing

Ref. Mistika: Node Graph Editor->Dashboard->Fx->Mistika->Misc->Framing

This  effect  allows  direct  access  to  the  Framing  tab  in  the  Visual  Editor  (Visual  Editor-
>Dashboard->Framing)  without  needing  to  apply  an  additional  effect  (such  as  Color
Grade or Comp3D).

As  well  as  the  possibility  of  adjusting  rescale  and  cropping  values  via  its  manipulators,
Framing  offers  parameters  that  are  relative  to  the  preparation of  stereo  clips  and  to  the
management of different image resolutions in the same project.

For more information relating to the use of the manipulators in the Visual Editor, consult  the
chapter dedicated to the Framing tab.

I/O

Inputs

Single input: image with or without alpha channel.

Inputs

Image: Cropped and rescaled; with the original resolution or with that  corresponding
to the current project (depending on the parameter Result Size).

Alpha:  Cropped  and  rescaled  mask;  with  the  original  resolution  or  with  that
corresponding to the current project

Parameters

Options

Mirror

[None (None / Horizontal / Vertical / Rotate]

Corrects  the  mirror  effect  in  the  stereo  pairs  deriving  from  mirror  rig  systems,
inverting the image la horizontally, vertically or both ways.

Result Size As

[Input (Input / Project]

Specifies  the  resolution  of  the  output  of  the  effect.  The  Input  option  sets  the
resolution  as  the  same  as  the  original  clip.  The  Project  option  sets  the  output
resolution as that of the current job (mConfig->RenderFormat ).

The Input  option is especially useful,  when the  clip  has  a  higher resolution than the
project  and  it  is  desirable  to  maintain  this  resolution to  be  applied  to  other  effects
later, such as Comp3D and Color Grade which can work in full resolution and  extract
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greater detail from the working resolution.

The Project option has two modes: Project Anamorphic scale, which rescale the clip in
X  and  Y  to  the  project  resolution;  and  Project  1:1  which  maintain  the  original
resolution of the clip inside the project resolution. 

The Live option has two modes: Live Anamorphic scale, which rescale the clip in X an
Y to the Live Video resolution (video output); and Live 1:1, which maintain the original
resolution of the clip inside the Live Video resolution.

Quality

[Bilinear (Nearest / Bilinear / Bicubic / 7 Taps / 15 Taps)]

Specifies the quality of the rescale filter.

The qualities available are shown in the dropdown list  of the parameter, from lower to
higher from top to bottom. It  is recommendable to  use  the  lowest  quality  that  gives
appreciable improvements, since the higher the quality, the   more  calculation time  is
required. 

Roll

Roll

[0 (-100 / 100)]

Rotates the whole image around its center point. 

Note:  This  parameter works  in  degrees,  unlike  the  majority  of  Mistika  parameters,  which
work with percentage values.

Scale

Scale X; Y

[100; 100 (0 / 100.000)]

Specifies the percentage value  of the output  image size to which the original will be
rescaled. This value is relative to the configuration set in Options.

Note:  The  percentage  value  is  relative  to  the  resolution of  the  output,  not  to  the
original  resolution  of  the  file  to  be  rescaled.   To  see  the  values  in  pixels,  it  is
recommended to use the manipulation mode  User   Resize  and  Offset  in  Pixels  of  the
Visual Editor->Framing manipulator. 

Offset

Offset X; Y

[0; 0 (-100.000 / 100.000)]

Specifies a two dimensional offset of the output image, expressed in percentage units.

Note:  The  percentage  value  is  relative  to  the  resolution of  the  output,  not  to  the
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original  resolution  of  the  file  to  be  offset.   To  see  the  values  in  pixels,  it  is
recommended to  use  the  manipulation mode  User  Resize  and  Offset  in  Pixels  of  the
Visual Editor->Framing manipulator. 

Crop

Crop Left; Right; Top; Bottom

[0; 100; 100;0 (0 / 100]

Specifies  the  cropping  of  an  image  from it  four  borders,  coloring  the  cropped  area
black and at the same time cropping the alpha channel.

Note:  The  percentage  value  is  relative  to  the  resolution of  the  output,  not  to  the
original  resolution  of  the  file  to  be  cropped.   To  see  the  values  in  pixels,  it  is
recommended to use the manipulation mode  User  Crop  in  Pixels  of  the  Visual Editor-
>Framing manipulator. 

GLSL

This effect  allows the application of GLSL code and controls its parameters via  the  Mistika
interface.

This  code  is  supported  natively  by  Nvidia  GPU  and  is  implemented  via  the  three  floating
variables in each of its 5 parameters. 

The intention of this is to permit the programming of user effects that  can be processed at
great speed or in real time.

I/O

Inputs

Single input: Image with or without alpha channel.

Inputs

Image: Image with changes specified by the GLSL parameters.

Alpha: Mask with changes specified by the GLSL parameters.

Parameters

GLSL Code

GLSL Code

Allows the selection of the source code to be applied. These codes must  be installed
in the directory /home/Mistika/Mistika-ENV/etc/GLSL.

If the directory does not exist, it must be created.
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Parameters: paramX

This  folder  contains  a  group  of  5  parameters  each  with  3  different  values.  all  of  these
parameters can be specified via the application of source code.

The use of these parameters allows the direct  implementation of effects processed  by  the
GPU.

paramX.r; paramX.g; paramX.b

[0; 0; 0 (0 / 100.000)]

Value fields for the selected source code.

LUT 3D

This effect allows the application of LUTs 1D and LUTs 3D directly to a clip in real time. 

Unlike the 3DLUTs of RGBCor effects (which all use the same 3DLUT), this effect  allows  us
to apply different LUTs to each type of clip. 

It also allows advanced combinations of LUT1D and LUT3D. 

We normally only need to apply one of the three possible LUTs, but  up to  three  LUTS  can
be  combined  at  the  same  time  in  various  ways.  IF  they  are  defined,  the  three  LUT  are
applied in the order that they appear (LUT 1D a, Lut 3D, LUT 1D b) (see Use and Comments
section for more information). 

I/O

Inputs

Single input: Image with or without alpha channel.

Inputs

Image: Image with the color values processed and modified by the LUTs.

Alpha: Unchanged.

Parameters

Input

Scale

[1 (-100.000 / 100.000]

Specifies the value of the gain of the input.

Offset

[0 (-100.000 / 100.000]

Specifies  a displacement of the luminance values of the input.
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Gamma

[1 (-100 / 100]

Specifies the value of the gamma curve of the input.

Use

[Direct (Direct / Inverse]

Specifies whether the input parameters are applied directly or inversely. Inverse mode
is normally only used when using  the  effect  to  reverse  the  application before  in  the
same LUT n a different effect

Lut 1D a

Dropdown LUT  File which allows  the  selection of  the  LUT  1D file  to  be  applied  before  the
application of the LUT 3D.

Lut 3D

Dropdown LUT File which allows selection of the LUT 3D to be applied.

Lut 1D b

Dropdown LUT File which allows the selection of the LUT  1D file to be applied subsequently
to the application of the LUT 3D.

Output

Scale

[1 (-100.000 / 100.000]

Specifies the value of the gain of the output.

Offset

[0 (-100.000 / 100.000]

Specifies a displacement of the luminance values of the output.

Gamma

[1 (-100 / 100]

Specifies  the value of the gamma curve of the output.

Use

[Direct (Direct / Inverse]
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Specifies  whether  the  output  parameters  are  applied  directly  or  inversely.  Inverse
mode allows the reversal of the effect of the application of the Lut 1D to which it  was
applied before the LUT 3D.

Use and Comments

The effect  LUT  3D allows the application of a correction via 1D LUTs  before  and  after the
application of a  LUTS 3D.

The order of the process is the same as that  of  the  folders  of  the  parameters,  that  is  to
say: the Lut 1D a correction will be applied to the result of the Input correction parameters,
and so on up to the Output parameters.

The default format for these files is .itx. This format  is compatible with other systems such
as Lustre (16bit), Nucoda, Nuke, Quantel, Shake, SRW and Blackmagic HDLink.

The Input  and Output  groups  of  parameters  allow  additional corrections  to  be  carried  out
before and after applying the main LUT. For example, if the effect  is applied to a clip whose
color space is logarithmic, it  is possible to change the value of Gamma in the input  of  the
effect  (Input) to linear, via, for example, a LUT1D, since LUTs 3D are more accurate when
working  in  a  linear  space.  Once  the  LUT  3D  is  applied,  it  is  possible  to  reverse  the
conversion of Gamma in the output (Output) to be able to return to the original color space
. To do so, we directly invert the original LUT1D without needing to have a file with it.

Layer Route

The effect Layer Route works in a similar way to the effect  Channels, but  in this case using
the layers contained in the relevant EXR clip as interactive elements. Depending on the EXR
file used, the number of layers can vary, as can their names, since these are characteristics
that are generated when the file is created. 
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I/O

Inputs

Single Input: EXR image  

Inputs

Image: any of the information layers contained in the RGB channels of the EXR file.

Alpha: any of the information layers contained in the Alpha channel.

Parameters

Layer Set:

Allows the selection of the layer to be used as general information for the clip.

Layer to R

Allows the selection of the layer to be used as information for the red channel of the
clip.

Layer to G

Allows the selection of the layer to  be  used  as  information for the  green channel of
the clip.

Layer to B

Allows the selection of the layer to be used as information for the blue channel of the
clip..

Layer to A

Allows the selection of the  layer to  be  used  as  information for the  alpha  channel of
the clip.

Use and comments

As  with the effect  Channels, this effect  can have multiple  uses.  The  most  obvious  is  the
possibility of extract the different information layers contained in the OpenEXR file. Some of
these layers (like Depth, Position, ID, etc), need the use of the Special Key effect, because
they have pure numeric information that need to be translated to RGB to work with them.

It is also possible to have an information layer that is different  in each of the channels, and
perform general  operations  between  them with  effect  such  as  Channels,  Color  Grade  or
directly with Comp3D for compositing. 
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F-3 OFX and compatibilty with other applications

This tab provides access to external plugins previously installed in the system.

Mistika  supports  the  API of  OFX  plugins.  API is  public  and  allows  external  developers   to
create effects that can be used with the softwares that  support  them. These plugins must
be  installed  in  the  folder /usr/OFX/Plugins.  The   Plugins  folder may  not,  in  this  case,
have  to  add  a  new  one.  Once  installed  using  the  manufacturer's  instructions,  a  new  tab
called OFX should appear in Mistika, where the plugins installed will be located.

At  the  publication  date  of  this  manual,  OFX  plugins  from  the  following  companies  are
available:

Sapphire. www.genarts.com

Ultimatte. www.ultimatte.com (Chroma key Ultimatte)

Imagica. www.vfxplugins.com

Compatibility with other non-OFX applications:

Mistika  is  compatible  with  the  3D  tracking  applications  of  Boujou  (www.boujou.com)  and
Syntheyes  (www.ssontech.com)  cameras.  Mistika  can  read  and  import  curves  from thee
applications,  and  thus  they  can  be  used  to  write  Comp3D  effects.  When  using  these
applications, select "Mistika" when exporting the camera .

It  also supports the color calibration and 3DLUTS generation of LightSpace CMS from Light
Illusion (www.lightillusion.com)  
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F-4 Legacy

This tab provides access  to  the   Legacy  type  effects  belonging  to  previous  and  obsolete
versions.  For  this  tab  to  be  visible,  it  needs  to  be  activated  in  Mistika  Setup  (Mistika
Setup->Interface->Show obsolete FX).
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SGO Mistika can be used in setups that  use different  external and  internal tools,  making  it
easier  to  carry  out  tasks  related  to  Mistika's  own  workflow,  and  also  to  increase  their
potential. The differences between the downloadable and/or external applications supported
by SGO and Mistika's functioning  are explained below
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G-1 SGO Mistika Transfer

SGO Mistika's Transfer application is used for copying and/or transferring files, whether they
exist  independently  or  are  referenced  by  an  environment  file  (.env)  or  an  EDL  used  by
Mistika.

Toolbar

Toolbar

The  different  operating  options  available  in  the  MTransfer  utility  are  accessed  from
this toolbar. Many of these tasks can be carried out  directly from their own graphics
panels or with <Right Click> on the file itself. 

File

New Mistika Project: This creates a new project, with all the associated folders, in
the directory specified as WORK. A text field for naming the new project  will appear.
The keyboard shortcut is <Ctrl+Shift+N>.

Save log: Saves the current  log in the specified directory with an .mlog extension.
This informative document can be opened as simple text.

Quit: Closes Mistika Transfer. The keyboard shortcut is <Ctrl+Shift+Q>.
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Edit

Refresh: Refreshes the Source and Destination panels, to check for new files and
directories.

Job

Create job  from  used media  in .env:  This  creates  a  task or job  in  the  Job  List
derived  from a  Mistika  environment  (.env)  which should  be  selected  via  a  window
that opens when executing this action. All the referenced media in the specified file
will therefore form part of the copy made by the job. 

Once the  environment  is  selected,  a  new  window  appears  in  which the  directory  to
which the media referenced in the environment is to be copied can be selected.

Finally, an information window will indicate the number of referenced files found, and if
they are to be ordered in the document according to their position in the timeline.

Mistika Transfer will request  confirmation for completing  the  text  document  with  the
indications of the specified copy and add it to the  Job List.  The  text  document
created  will  be  found  in  the  same  directory  as  the  selected  environment,  with  the
following  nomenclature:  mtEnvPaths_NombreEnv  (version  number).txt.  Example:
mtEnvPaths_rushes_R3D_day2 (1).txt

Create job from text file: This creates a task or job in the Job List derived from a
text  document  which should  be  selected  via  a  window  that  opens  when selecting
this  option.  Another window  will  then appear for indicating  the  directory  to  which
the  referenced  files  in  the  text  document  are  to  be  copied.  Information  is  shown
with the number of files referenced in the text document, and finally confirmation for
including it in the Job List will be requested.

Important Note: The order of  the  files  within  the  text  document  will  determine  the
order of the copy of the files when the task or job is started.

Transfer

Add to queue: Adds the file/s selected in the Source  panel to  the  Job list  to  be
copied to the directory in the Destination panel. If  they  are  environments  or text
documents  referenced  to  files,  the  files  they  indicate  will  not  be  copied:  the
previous Job tab exists for this case. The keyboard shortcut is <Ctrl+Shift+A>.

Process queue: Starts the processing of the differing pending tasks in the Job List.
 The keyboard shortcut is <Ctrl+Shift+P>.

Stop all copies: Stops all copying that is either underway or pending.

Checksum

Activate  checksum: Activates  the  checking  (checksum)  of  copies  of  new  tasks
created.

Save in checksum file: Allows the saving of the checksum  file as text  document.
The generated file will be saved by default in the Destination directory, although this
location can be modified by selecting the task in the Job List. The generated file will
indicate the  copied  files,  the  source  and  destination directories,  the  task creation
date  and  the  checksum  file  creation  date,  as  well  as  the  checking  algorithm
employed.  The  text  document  created  will  be  named  as  follows:
mtChksum_creationDate_CreationHour.txt.  Example:  mtChksum_20130121_155021.
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txt.

Confidence check: Enables the checking of a task via an existing checksum file. To
do so, select, select the checksum file of the required task: a dialog box will appear
indicating whether the  files  in  the  destination directory  coincide  with  those  in  the
source directory. In the case of an error, the file and its corresponding file path will
be indicated.

Md4, Md5, Sha1 y File Size: Different  checking algorithms from which one  can be
selected for new tasks created.  This  can be  modified  by  selecting  the  task in  the
Job List.

Number of repetitions: Number of times an attempt  is made to repeat  the copying
of the files detected to be in a checksum  process  which do  not  coincide  with  the
originals.

Show panel:  This  shows  a  panel with  the  Checksum  options  above  the  Source
and Destination panels. The keyboard shortcut is <Ctrl+Shift+K>.

Filters

When  copying  via  the  source  and  destination  panels,  by  dragging  the  material  or
folder, the files can be filtered in different ways. 

EDL:  Allows  the  filtering  of  files  via  an  EDL  that  must  be  opened  in
Filters>EDL>Open EDL. Only files referenced in the EDL will be copied. This option
can be  activated/deactivated  in  the  panel itself  without  needing  to  eliminate  the
selected EDL.

Extensions: Allows the filtering of files, even those found within an environment  or
text  document,  by  their  file  extension.  The  two  tabs  Extensions  and  Default
contain  standard  extensions  that  can  be  selected  and  combined;  Custom  allows
the inclusion of any extension (Enter Text) or via a text  document.  These  options
can also be shown in a permanent  panel found above the Source and Destination
panels, with the option Show Panel the keyboard shortcut is <Ctrl+Shift+F>.

Help

About:  This  shows  the  version of  Mistika  Transfer being  used  and  its  compilation
date. The keyboard shortcut is <F2>

Source and Destination Panels

Source & Destination Panels

The graphics panels, Source on the left  and  Destination  on the  right,  allow  for easy
browsing, transfer and copying of files, as well as having other options. 

In  the  upper  area,  both  panels  possess  an  editable  field  containing  the  file  path
currently being viewed. These panels are divided in  two  :  the  upper area  shows  the
path of the upper field, and the lower area shows the content of the folder selected in
the upper area.

<Right  Click>  on  the  panels  allows  various  actions,  such  as  creating  new  folders
directly from the application itself  (New), deleting folders (Remove), renaming them (
Rename) and calculating their size (Calculate Size). When Calculate Size is selected, a
window will appear above the panels showing the file path and the calculated size.

If the file is Checksum,  there  is  the  option for carrying  out  a  Confidence  Checksum



669Utilities

SGO Mistika 8.6 © 2018 SGO

(explained in more detail below in Utilities>SGO Mistika Transfer>Toolbar).

To copy, simply select  a file or directory  in the lower part  of the Source  panel (this
will  copy  everything  contained  within  it,  applying  a  filter  if  one  is  activated  in
Toolbar>Filters) and drag it  to the lower part  of the Destination panel (or to one of
the directories visible there, in which case the copy will made in that directory).

Job Box and Status Bar

Job Box

The list  of tasks (Job Box)  possesses  various  tabs,  indicating  the  different  jobs  that  are
pending,  their  current  status;  it  also  indicates  failed  and  completed  jobs,  and  has  an
information log.

Log

Information screen detailing Mistika Transfer processes.

Job List

List  of  pending  jobs  and  their current  status.  All  jobs  are  shown with  their source
route, destination, and any other data according to the options selected. 

The Enable on the left is for activating/deactivating jobs directly from the processing
queue.

It is also possible to edit jobs individually and organize the complete list  of jobs from
this  tab.  To  do  so,  <Right  Click>  over  the  selected  job;  a  dropdown  menu  will
appear showing various options: for starting or activating the processing of a queue
of  tasks  (Start  Here),  resetting  tasks  (Reset  task)  rewriting  the  creation  date,
checking that referenced files are not already found within the destination (Check for
files in the destination) and modifying priorities within the task's processing queue (At
First, Up, Down, To Last).

Tasks can also be deleted (Remove Selected, Remove all pending, Remove  all)  and
jobs can be individually edited (Edit job). On opening Edit Job a window will show the
characteristics of the  selected  job,  and  its  destination can be  changed,  checksum
can be activated/deactivated, and the algorithm can be changed.

Finally it is also possible to save the current jobs list in an XML list  by selecting Save
, in case the status of a job queue at a specific moment needs to be recovered at  a
later stage. To do so, simply Open and choose the required list.

Important  Note  :  When  a  task  is  eliminated,  only  its  processing  sequence  is
deleted, not the material it refers to.

Failed Jobs

List of failed tasks: like Job List, this tab allows various actions, simply with <Right
Click> over the  panel.  The  various  actions  available  include  selecting  which  failed
tasks  are  repeated  (Repeat  Task)  which  then  return  to  the  processing  list,  an
automatic  check  that  files  are  not  already  found  within  the  destination,  and  re-
attempt in cases when only the checksum has failed (Repeat only failed checksums).

To  assist  organization  and  clarity,  it  is  also  possible  to  Remove  selected  tasks,
remove canceled tasks (Remove all canceled), remove failed tasks (Remove all failed
), remove tasks in which the checksum has  failed  (Remove  all  checksum  not  pass)
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and remove all tasks (Remove all).

Important  Note  :  When  a  task  is  eliminated,  only  its  processing  sequence  is
deleted, not the material it refers to.

Completed Jobs

List  of jobs completed correctly. As in the previous tabs,  the  source  and  destination
of the tasks are shown, as  are  their dates.  Finished  tasks  can also  be  deleted  from
here.

Important Note : When a task is eliminated, only its processing sequence is deleted,
not the material it refers to.

Status Bar

The lower status indicates at  any given time tasks or jobs that  are waiting (Waiting Jobs),
those that have failed (Failed Jobs), those that have been completed (Completed Jobs) and
the status of the process (Status Process).

When  Checksum  is  activated,  the  algorithm  selected  for  checking  the  copy  will  be
indicated,  as  will  the  number of  attempts  specified  for  repeating  failed  tasks  (Checksum
Repetitions).
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G-2 Downloadable Applications

SGO  has  several  downloadable  applications  that  can  be  used  in  combination  or  to
supplement  work related to Mistika. These applications are  available  in  the  Android  Market
to be downloaded for mobile/cellular telephones and Tablets

SGO Mistika 3D Calculator

The  3D  Calculator  application  of  SGO  Mistika,  downloadable  for  Android  mobile/cellular
telephones, allows the evaluation of a series of common parameters for calculating the final
result to be obtained.

How to use it

The calculator has 3 main screens:

The Settings View: contains the main the configuration settings.

The Calculus View: performs the stereo calculations.

The Screen View: view and manipulate parameters related to screen viewing.

To move from one View to another, click on the background and slide horizontally.

Setting Views

The Settings View enables the user to configure the calculator settings we want  to
use. Those are:

Small  Units:  Sets  the  preferred  unit  to  measure  small  distances,  such  as
Interocular distance, Focal length, Screen sizes and Disparities.
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Large Units: Sets the preferred unit to measure large distances, such as on-set
distances and the spectator’s distance from the screen.

Camera  Model:  Defines  the  camera  being  used,  and  automatically  sets  the
Sensor Width and Sensor Height. If the camera used is not  in  the  list,  manually
adjust the size by selecting “User Defined”.

Sensor Width:  The  sensor  width  is  automatically  set,  based  on  your  Camera
Model. To set it manually, select the “User Defined” Camera.

Sensor Height:  The  sensor height  is  automatically  set,  based  on your Camera
Model. To set it manually, select the “User Defined” Camera.

Screen Size: The target screen size defines where the stereo 3D footage will be
displayed. There is a list  of standard sizes, but  a  different  one  can be  selected
via “User Defined”.

Screen Width: Screen width is automatically set  based on the  selected  Screen
Size. To set it manually, select the “User Defined” Screen Size.

Spectator Dist.: Distance from the spectator to the screen.

Interocular: Spectator's interocular distance.

Calculus View

This view allow us to perform the stereo 3D calculus.

The calculus view has 3 main areas.

On the  top  it  has  the  scale  area:  This  allows  the  user to  select  how  fast  we
want  to change numerical values: x1 means  it  will  use  unit  increments,  x10 will
use increments of 10, and so on.
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On the left there is a column of circular option buttons. Only one will be selected
(enhanced in green), and defines what  parameter the user wants the  calculator
to  automatically  calculate.  The  selected  parameter  will  be  automatically
recalculated every  time  any  other value  is  altered.  For example,  if  we  want  to
calculate  the  Positive  depth budget,  select  it,  and  then,  every  time  any  other
value  is  changed  the  positive  depth  budget  will  be  calculated  for  the  new
settings.

The central area includes all the parameters used for calculations.

The parameters of the central areas are:

Focal Length: Camera Focal length we are using.

Max.  Dist.:  On set  maximum distance.  The  distance  to  the  furthest  object  on
set. Just to the right of the name there is an infinite button. It  is used to define
the situation where the furthest object is really far away so it  can be considered
infinitely far. Such us with landscape environments.  

Converg.  Dist.:  Convergence  distance.  The  distance  from the  camera  to  the
point they are aiming at  regardless of parallel or converged shooting.

Min Distance: Minimum distance. The  distance  from the  camera  to  the  closest
object on set.

Max Interaxial: The distance between the cameras.

Roundness:  Roundness  represents  the  depth  relationship  between  the  real
scene  and  the  projected  scene.  It  is  measured  in  percentage.  To  better
understand this concept, suppose we shoot a perfect sphere:

100% Roundness of means the perception of the sphere in the projection will
be perfect. That is, it will be a sphere.

Roundness below 100% means the sphere will be flattened on the  projection
and will be perceived as  a  flattened  oval in  Z.  The  lower the  Roundness  is,
the more flattened it will be.

Roundness  over  100%  means  the  sphere  will  be  extruded  in  Z  on  the
projection and will be perceived as bigger in the Z  axis  than in  the  X  and  Y
axes.

     A color visual warning tells you how far are you from perfect  roundness (100%).
The number color changes from green (good) to Red (bad).

Pos.: Positive disparity. This is represented in screen units and in percentage. If
the positive disparity is bigger than the interocular distance, a visual warning will
advise you by changing the disparity numbers color to red.

Neg.: Negative disparity. This is represented in screen units and in percentage.

There are 3 ways to change the values:

Using the increment/decrement  arrows:  using  the  arrow  increases  or decreases
the value selected in the scale area .

Holding  and  sliding  the  value:  pressing  the  value  box  and  sliding  a  finger
horizontally  or  vertically  the  value  will  be  increased  (moving  up  or  right)  or
decreased  (moving  left  or  down).  Although  the  increase/decrease  value  will
depend  on  how  much  you  move,  the  relative  speed  depends  on  the  selected
scale value.

Double  clicking  the  value:  to  enter a  specific  value,  double  click  on  the  value
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box. A dialog box will allow you to enter a number.

Screen View

On  this  view  is  displayed  the  parameters  related  to  final  image  display.  Its
components are:

The Screen representation: This is a visual representation of the screen. On it
is shown the positive and negative disparities in percentage of the screen size as
well as the distance in screen units. If  the Far disparity is uncomfortable for the
spectator, the display will show an ‘uncomfortable’ warning. This warning is either
"slightly  uncomfortable"  or  "uncomfortable"  depending  on  how  intense  the
sensation would be. If the far disparity is too large to be perceived as 3D by the
spectator, the warning will say Double Image!!!

Screen Size: This is the same value as in Settings View. It is available here as it
is closely related to this view.

Screen Width: This is the same value as in Settings View. It  is available here as
it is closely related to this view.

Spectator Dist: This is the same value as in Settings  View.  It  is  available  here
as it is closely related to this view.

Roundness: This is the same value as in Calculus View. It  is available here as it
is closely related to this view.

Pos:  This  is  the  same  value  as  in  Calculus  View.  It  is  available  here  as  it  is
closely related with to view.

Neg:  This  is  the  same  value  as  in  Calculus  View.  It  is  available  here  as  it  is
closely related with to view.
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SGO Mistika Remote Control

The  SGO  Mistika  application  Remote  Control,  which  is  downloadable  for  Android  Tablets,
allows the remote use of Mistika viewing functions.

Remote Control has a screen with three zones of buttons: Upper bar, Buttons for controlling
the Node Graph (Node Graph Controls) and Jog Panel.

Upper bar 

The upper bar has a button with two fields:

Start

Button  that  establishes  the  remote  connection  with  Mistika.  The  Remote  Control
application disables the Feedback mode (in the Visual Editor) by default; if  flashes are
observed in the video output, its disabled state should checked.

Mistika IP

The IP of the Mistika in use is defined in this field. 

Mistika Port

The  default  value  of  the  port  Mistika  will  use  for remote  connections  should  not  be
modified.

Proxy IP

When Mistika packets arrive  at  the  application via  an intermediate  proxy,  such as  a
local network, this field must include the IP of said proxy. Normally this field is empty,
but check with the network administrator in case of doubt.
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Node Graph Controls

Delete Mark

Deletes the User Mark that we are over in the Monitor, as well as that  which is active
(if another is selected in the Node Graph).

Add Mark

Adds a User Mark.

Prev Mark

Moves the Node Graph to the previous mark.

Next Mark

Moves the Node Graph to the next mark. 

Prev Edit

Moves the Node Graph to the previous edit.

Nex Edit

Moves the  Node Graph to the following edit.

Play Backward

Activates playback of the Node Graph in reverse.

Stop

Stops playback of the Node Graph.

Play Forward

Activates forward playback of the Node Graph.

Jog Panel

Scaling buttons  x1 x2 x4 x8 x16 x32

Allows scaling of the sensitivity of the virtual shuttle.

Jog

Dynamic control for modifying the position of the Monitor over the Node Graph.
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H-1 Annex 1: Autoconforming and format conversion techniques

Before reading this chapter, the user should be familiar with Mistika’s  EDL conforming  tools
and how to deal with normal situations, as explained  in  the  chapter Conform.  This  section
expands on the information is the aforementioned chapter, and will not normally be required;
this section therefore covers methods for dealing with difficult  cases, such as non-standard
formats, or when filming, offline and conforming systems work with different  frame rates or
different video formats.

General considerations

In general, when conforming, the following must be borne in mind: 

Mistika  allows  the  user  to  work  independently  from the  output  in  terms  of
reproduction speed  and  timecode  format.  This  means  that  work can start  in
one format and later be switched to a different format. 

For  example,  we  can  conform an  EDL  PAL  file  in  HD 25p,  and  later  switch
format to HD 24p. In such cases, we will obtain the same Node Graph content,
but it  will be played out  at  a different  frame rate, and the timecodes will also
be different, without  adding  or removing  frames  or needing  additional action.
This is achieved thanks to Mistika’s ability to work internally with dimensions in
absolute numbers of frames rater than timecodes.

Thus, whenever importing  an EDL,  Mistika  calculates   where  each clip  in  the
Node  Graph  begins  (and  also  measures  internally  the   number  of  absolute
frames)  and  the  absolute  number  of  frames  between  the  input  and  output
points of each clip. From this point on Mistika uses this information internally. 

Many  of  Mistika’s  interface  tools  can  independently  display  the  number  of
frames in Timecode format, but this timecode information will be generated on-
the-fly, based on the current user Preset.

In summary, all editing projects are actually stored as  an absolute  number of
frames  and  thus  do  not  change  between  different  formats,  although  their
timecode  representation  depends  on  the  presets  selected  for  each  work
session.

This allows the user to switch between different  image  playback speeds,  but
audio is not affected in the same way, since audio speed only depends on the
Sampling  Rate  value  (44Khz,  48Khz,  etc).  As  a  result,  if  we  switch  to  a
different  f.p.s. preset,  the  audio  tracks  will  be  out  of  sync  with  the  images,
depending on the f.p.s. of each preset.

Whenever we  have  conformed an edit  offline,  it  is  highly  recommended  that
the  offline  version is  loaded  into  a  Node  Graph  track in  order  to  compare  it
with  the  conformed  version.  This  is  the  best  way  of  detecting  in  time  any
possible errors. The offline version can be obtained by capturing it  from video,
via an .avi file or from a numbered sequence of image files.

In special cases, it  may be necessary to work with playback speeds  that  are
different to the video formats supported by the video board, for example, if  we
wish to playback at 24f.p.s. our video card only has 25 or 30 f.p.s. formats. In
this case, we use Monitor Display to to play video at  a different  speed, if  the
f.p.s.  value  has  been  modified  in  Mistika  Setup  (Mistika  Setup->Render
Format->Render Format->Frames Per Second).

The  playback  speed  in  the  video  output  (Monitor  Display->Menu->Live
Video) will always be forced  to  the  format  selected  in  Mistika  Setup  for the
video  board  (Mistika  Setup->Video  I/O->Video  Board  Options).  This
obliges us to choose between the few options supported by each video board.
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We can also achieve a change of format via effects with rescale capability but
these work in a different way, as they only affect  the clips to which we apply
the effect. In this case, first  we load the preset  corresponding to the  output
format  desired  and  then apply  the  rescale  effect  to  the  clips  that  are  at  a
different resolution to the said format. For example, we can be working in PAL
and load an HD clip, to which we apply an effect with rescale to obtain its PAL
version and  thus  integrate  it  into  the  edit.  Generally,  the  tool  that  provides
the best quality for rescales is the Framing tab (Visual Editor->Dashboard-
>Framing), increasing its quality parameters as necessary. 

When  working  in  NTSC,  pay  special  attention  to  the  Drop  Frame  option
(Mistika  Setup->Video  I/O->Video  I/O->Drop  Frame)  in  Mistika  Setup
corresponding  to  the  possible  variants  of  NTSC.  Its  incorrect  configuration
 can produce  inconsistencies  between  the  timecodes  of  the  EDL  and  those
observed when capturing or transferring video.

When recording to camera, the camera operator should follow these rules: 

° When connection to the VTR is via direct cable (RS232-RS422), a 5 seconds

preroll  is  required  in  order  to  capture  each  cut  defined  in  the  EDL,  so  if
recording with timecode “jumps”, at least  5 seconds extra must  be recorded
at the start of each shot. If the tape has timecode jumps between the start
of a cut  and the previous 5 seconds, the VTR might  not  be able to  provide
the  images  correctly  during  capture  in  Mistika.  In  this  case,  the  segments
with timecode jumps will need to be captured manually using the Start  Free
feature.  (Node  Graph  Editor->Dashboard->VTR->VTR  Capture->Start
Free).

° Even when there  is  enough preroll  in  each segment,  if  different  recordings

made on the same tape introduce timecode jumps, the VTR may not  be able
to find in-points as requested by Mistika. To capture a cut  of this type, use
the shuttle within any continuous timecode segment  to select  the timecode
and then request its capture. 

Mistika  can  import  audio/video  EDLs  with  cuts,  timewarps,  mixes,  fades  to
black  and  SMPTE  wipes.  Any  other  effect  included  in  the  EDL  will  not  be
imported by Mistika.

From  version  3,  Mistika  can  also  conform  EDLs  against  numbered  image
sequences (.dpx). To do so, use the  Import tab in the Dashboard of the Node
Graph  Editor.  For  more  complex  cases  the  external  tool  Sequencer  is
recommended.

In all cases, before importing an EDL, it  is essential to be in the Mistika Setup
preset  that  has  the  same  f.p.s.  speed  as  that  used  to  make  the  EDL.  Once
conformed, the preset then can be changed as required. 

MXF

Mistika can read .mxf files based on the following codecs:

DV-25

DV-50 (DVCPRO)

DV-100 (DCVPRO-HD)

MXF  uncompressed 

The  reading  of  these  clips  has  been  optimized  in  order  to  be  carried  out  in  realtime.
Conversion to another format is not necessary.

Note: Audio is not supported within MXF files.
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AAF

Mistika  supports  AAF  files  generated  with  Avid  Adrenaline®  systems,  and  those  which
reference MXF files as described above. Their main function is to avoid the need to capture
an EDL in  order to  conform the  edit,  reusing  the  MXF  file  already  captured  by  the  offline
system.

AAF files should only contain the usual effects: cuts,  mixes,  SMPTE wipes,   black spaces,
and linear timewarps.

When  creating  AAF  files,  choose  the  external  media  option  as  referenced  (media  files
referenced by .aaf files should only be external .mxf files, since media inserted in the AAF is
not supported).

AAF files should be located in the same directory as the mxf files that it references.

AAF files must be imported with the external Sequencer application, which creates a Mistika
.env file with the edit itself with the necessary links. 

Note: for optimum work flow, capture in uncompressed mxf  is recommended during  offline,
ideally  on  a  shared  storage,  type  S.A.N.  This  produces  optimum  quality,  and  avoids
duplication of files  since  both systems  (offline  and  Mistika)  can work on the  same  files  in
realtime.

Conflictive cases

The following points refer to situations where the offline system does not  work in the same
video format as the online system, in which case special techniques must be applied in order
to maintain timecode consistency.  The  following  points  cover the  most  typical cases,  but
the user will be able to solve other cases by combining the techniques described. 

Shooting in Sony HDCAM at 24p, offline to  PAL with TC at 25 (interpolated) fps for conforming to HD 24p

The  majority  of  HD VTR  permit  playback of  original  24p  tapes  in  25p.  In  this  case,  the
images are reproduced more quickly, in a ratio 25:24, and there are various solutions to deal
with timecode issues. This example covers the methods that  maintain the original timecode
original, and also those that “interpolate” the new timecode. 

The “interpolated” method consists of the VTR providing the timecode to 25 that  is closest
to the original to 24. In this case, the output  timecodes will not  be consecutive but  will be
"missing" one timecode per second . (Note that it is not in image frame that is missing, but a
timecode that  has been skipped). The advantage of this  method  is  the  news  timecode  do
not go out of sync  with the originals, although not  all offline systems can capture this kind
of timecode with jumps (these cases are dealt with in the following point).

Thus, when the offline system has the capacity to capture even when timecode is missing,
we can work in the manner explained in the following image:

 

A variation of this example would be converting the EDL to 24fps once the offline  edit  has
been done (if the offline system being used offline allows the export of EDL carrying out  this
conversion).  In  this  case,  configure  Mistika  to  24p  format  before  importing  the  EDL,  and
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maintain this format for the rest of the processes .

Notes on some steps in the example:

Step 3:  Configure  Mistika  in  25p  and  import  the  EDL (double  click  on  the  EDL
file). To capture new clips, the HD VTR must  be  configured  in  24 converted  to
25 mode, as the remote commands will send the  in-points  received  in  the  EDL,
and so there may be in-points that only exist in 25p. 

Step 4: Once the capture is completed in order to  carry  out  the  conform (and
not  before),  reconfigure  Mistika  to  work in  the  final  format  (preset  24p).  This
change  from 25p  to  24p  is  transparent  to  Mistika,  since  to  avoid  problems,  it
always  works  internally  with  dimensions  measured  in  an  absolute  number  of
frames and not  timecodes. Once the  edit  is  finished,  also  configure  the  VTR in
HD 24p (without any kind of conversion) and transfer the master.

Shooting in Sony HDCAM at 24p, conversion to  PAL “converted timecode” (non-interpolated) at 25 fps for
conforming to cine or HD 24p

This method is usually used when the offline system cannot  capture when the VITC  is  not
consecutive,  and  so  is  necessary  to  create  a  new  25fps  converted  timecode  (not
interpolated). 

It  can also  be  used  in  the  offline  phase  if  only  SD versions  with  converted  timecode  are
available, even if the system is able to capture with discontinuous timecodes.

As an example, image capture is via a Sony HDCAM VTR with  the  option of  converting  HD
and PAL by means of accelerated playback of the images (with the ratio 25/24). 

The original vertical timecode (24fps VITC) contained in one line of each original frame  will
also  be  present  in  one  line  of  each  frame  converted  to  PAL,  or  it  can  be  an  “timecode
interpolated to 25” (depending on how the VTR is configured and on the copy used for the
offline).  In  this  example,  the  Offline  system  cannot  capture  with  either  the  original  or
interpolated  timecodes  (note  that  when  converting  to  PAL,  frames  have  been  neither
inserted nor removed, but rather that  the VITC executes one timecode jump per second as
compared to standard PAL).

Furthermore,  the  VTR HDCAM allows  the  activation of  the  TC  convert  option  in  order  to
generate  a  new  25fps  continuous  timecode,  as  required  for  PAL  standard.  This  new
timecode will match the original timecode  only  at  one  reference  point  (configurable  in  the
VTR menu). From that point onwards, an offset of one frame per second will result. The new
timecode will only be present in the TC out connector of the VTR, and it  not  in the VITC of
the video signal. 

In  this  example,  a  second  VTR  or  any  other  device  capable  of  generating  video  signal)
receives both the new timecodes and the SD video signal, allowing it to be inserted into the
VITC code of the video out signal with continuous 25fps VITC timecode. From this moment,
the output  signal will be PAL standard for all  effects  and  with  continuous  25fps  timecode,
and can be captured in any Offline systems, whatever limitation it might have. 

However,  bear in  mind  that  the  new  25fps  VITC  does  not  match  the  original  24fps,  but
rather goes  out  of  sync  at  a  rate  of  one  frame  per  second  (in  relation  to  the  timecode
reference).  For  this  reason,  when  the  EDL  is  captured  in  Mistika,  keep  the  same
configuration of the VTR HD (timcode converted to 25).
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Notes on some  steps in the example: 

Step 1: A second VTR is required in order to insert the new converted TC (25fps
continuous) into the VITC of the video signal. Other devices can be used for this
task instead of a VTR, but their use lies outside the scope of this document). 

Step 2: The offline is made  based  on 25fps  converted  timecodes.  The  EDL will
also  generate  25fps  timecodes.  For  correct  synchronization  with  audio,  if  the
system so allows, playback can be at 24fps to the graphics monitor instead of to
the video output, so that the playback speed of both sound and image coincides
with that  of  the  Master (thus  versions  of  audio  tracks  at  different  speeds  are
not required). 

Step 3: Configure  Mistika  in  25p  and  import  the  EDL (double  click on the  .EDL
file). To capture new clips, the VTR HDCAM must  be set  to the converted to 25
mode used for the Offline (in the case of Sony HDCAM, “TC convert  On”) as the
remote commands send the in-points received in the EDL, and it is essential that
the VTR interpret them as 25fps “converted” timecodes. In addition, the HD VTR
must have the same initial timecode “reference point” (the only timecode where
both original and converted timecode will match), because occasionally Mistika is
used for capture with a different VTR from that used for the Offline capture, and
the user must  avoid having this parameter set  differently. Also,  check that  the
VTR is configured to use converted timecodes via the remote port. 

Step 4: To carry out  the conform, after finishing the capture (and not  before),
reconfigure Mistika in order to work in the final format  (preset  24p). This change
from 25p  to  24p  is  transparent  in  Mistika,  since  in  order  to  avoid  problems,
Mistika  always  works  internally  with  average  dimensions  in  absolute  number  of
frames and not with timecodes. Once the edit is finished, also configure the VTR
to HD 24p (without any kind of conversion) to transfer the master.

As in the previous case, a possible variation is to convert  the EDL to 24fps after
finishing the offline edit, if  the offline system allows the export  of the EDL doing
this  conversion.  Also,  the  EDL  converter  must  bear  in  mind  the  “Reference
point”, (the only point where both timecodes will match). In this case, both the
VTR and  Mistika  should  be  configured  to  24p  format  before  beginning  the  EDL
import, and this format maintained during the remaining processes. 

Shooting in 720p with Panasonic cameras

This case is applied when the material to be processed was shot  with Panasonic  camera in
HD 720p format with a non-standard frame rate, and which will be edited in SD (PAL/NTSC)
and conformed a cine or video

The Panasonic  Varicam (like VTR D5-HD and  DVCPRO-HD)  can work in  HD 720p  (1280x720
60fps) with a user-definable frame rate. This special characteristic, which is not  available in
other cameras, means that this camera is sometimes used for working when the final format
is not HD 720p. 

In  fact,  despite  its  theoretical  variable  “frame  rate”,  the  video  tape  actually  runs  at  a
constant  speed at  all times (corresponding to 720p of  60 frames  per second).  Panasonic’s
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solution is that recording of the last available image continues until the next  is available. So
the tape always contains 60 frames per second, and if  the during the recording a different
frame rate is selected, images are repeated as necessary to complete the 60fps.

To capture, it  is only necessary to activate the option Use SDI User Data in Mistika  Setup
(Mistika  Setup->Video  I/O->Video  Board Options  Use->SDI User Data).  This  allows
correct  capture  without  repeating  frames.  If  the  offline  system  does  not  have  said
capability, a new master tape can be generated from Mistika so that  the offline system can
capture it correctly.

Switching between 24 fps and 25  fps formats

If an audio/video environment has been created and then a format  with a different  speed is
used to open the edit, the audio tracks will be  out  of  sync  in  relation to  previous  format,
because  the  audio  tracks  maintain  the  original  duration  but  the  video  tracks  do  not.  To
solve  this  problem,  the  following  alternative  methods  are  available,  either  to  change  the
duration of either the image or the audio. 

Method A: speeding up/slowing down the image

Apply a Timewarp to the video tracks so they last  the same amount  of time as the original
version. 

Via the Timewarp group from the Edit tab of the Dashboard. In general, use a
high value for the width parameter of the Timewarp group to  achieve  smooth
playback and avoid “jumps”  where  a  frame  has  been removed  or added.  The
advantage  of  this  method  is  that  it  is  simple  and  requires  no  manual
adjustment of the parameters, though it may produce loss of image sharpness,
or even that  some  small  jumps  may  still  be  visible.  Thus,  whenever possible,
alternative methods are recommendable.

Via  the  Timewarp  effect  from  the  FX  tab  of  the  Dashboard.  This  effect
produces higher quality but  may require manual adjustments that  are different
in each shot. 

When dealing with audio tracks, only the metadata of the clips needs to be regenerated, so
the audio tracks of the original edit  should  be  deleted  (or silenced  via  the  Console  tool in
the Audio tab) and then the original audio files re-imported (double click on the .wav or .aiff
audio files), but only after switching to the new preset. 

Nevertheless, if  the audio has also been edited within  the  edit  in  Mistika,  another process
must  be carried out  in Mistika, since the in/out  points contained in  the  metadata  for each
audio  clip  will  no  longer  be  valid  after  the  change  of  format.  In  this  case,  follow  these
steps: 

1.  While in the original Preset, do a render with audio for the whole environment
(the image format  is  not  important,  because  only  the  audio  file  produced  by
this render process is used later). 

2.  Switch Mistika to the new Preset and open Mistika again.

3.  Import  the  new  .aiff  file  produced  in  Step  1.  Note  the  need  to  navigate  in
order to  find  the  .aiff  file  which will  be  stored  in  the  directory  specified  for
audio  as  defined  in  the   Mistika  Setup->File  Paths->File  Paths->Audio
option.  Import  this  file  again,  as  it  is  not  sufficient  just  to  load  the  clip
obtained form the render (since the in and out  points of the metadata will not
be correct for the new format).

Method B: speeding up/slowing down audio

Make a new version of the audio tracks, accelerated or decelerated by factors of 1/25 of a
second, in  order to  match the  new  image  track duration.  In  this  case,  a  timewarp  is  not
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needed for the image tracks, since these are  simply  reproduced  at  a  different  frame  rate,
changing the total environment duration. 

This  can  be  done  with  the  tools  in  the  audio  tab  (Node  Graph  Editor->Dashboard-
>Audio->Tools). See the chapter Audio for more information.

Coversion between 24fps/25fps and 30fps formats

Cases of switching between 24 (or 23.97) fps progressive and 30 (or 29.97) fps  interlaced
(typically from 24p or cine to NTSC or 1800_30i / 1080_60i) do  not  require  modification of
audio  tracks,  because  these  cases  are  solved  with  a  3:2  pulldown  Render  3:2  Pulldown
Mode  so  the  total duration of  the  edit  does  not  change.  (Note:  this  process  loses  some
image  quality,  but  is  the  only  reasonable  alternative.  This  is  because  the  difference
between 24fps  and  30  fps  is  too  evident  and  it  cannot  be  resolved  simply  by  changing
playout speed, as in 24<->25  conversions.)

For format conversions between HD_25p and formats at 30 (29.97) fps (typically 1080_60i /
1080_30i  or NTSC)  a  standard  direct  method  with  acceptable  quality  does  not  exist,  so
using the 24p format as an intermediate format is recommended.

For  progressive  formats,  one  possible  alternative  is  to  use  the  effect  Timewarp  (Node
Graph  Editor->Dashboard->Fx->Mistika->Timewarp),  although  this  can  be  time  -
consuming).

Audio in different variants of NTSC and HD formats

When importing a clip with audio, Mistika uses the Frames Per Second parameter of  Mistika
Setup  (Mistika  Setup->Render Format->Render Format->Frames  Per  Second)  as  a
reference to synchronize it with the image.

When  working  with  the  variants  of  NTSC  and  HD  with  values  of  30fps,  29.97fps  and
23.97fps  differences  may  be  noted  in  the  synchronization.  If  in  the  playback  of  these
formats  the  user notices  the  outputs  of  audio  and  video  are  not  in  sync,  this  parameter
should be checked as a possible cause.
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H-2 Annex 2: Transfer with Original Timecode (Crash Record)

As an open system allowing perfect  integration with other post-production systems, Mistika
is the new standard in digital color grading. 

This annex analyzes the color correction process  of  a  production shot  on film,  but  whose
output format will be video. One example could be the advertising market.

Traditionally, the first step is to make a telecine with one light  to be able to edit  an offline
copy. Using the EDL of this edit, color correction is done using a telecine set  up for SD or
HD formats.  The  result  is  transferred  to  video  tape.  The  tape  is  given to  the  client  who
continues the post-production process.

The disadvantage of this method is that the transfer process is limited by the capabilities of
the telecine suite.

Furthermore,  this  method  is  not  compatible  with  the  use  of  high-quality  scanners,  for
example.

If a producer requires a high-quality scan, to carry out a color correction in a system digital
and add other post-production processes, they will receive an HD or SD tape with a  post-
produced  version of  the  edit.  The  tape  will  contain  fades  between  cuts  that  cannot  be
eliminated and the possibility of conforming the EDL original is lost. 

In  the  work sequence  proposed  below,  Mistika  is  located  in  the  middle  of  the  production
process:

1. A  traditional  telecine  work  sequence  starts  with  an  offline  version  being
edited.

2. An EDL is exported in any system (or using Mistika, but  in this case it  is not
important).

3. The  EDL  is  sent  to  a  cine  scanner  or  to  a  datacine  and  all  the  files  are
scanned  (normally  .dpx).  These  files  will  maintain  the  information  of  the
timecodes and the number of frames within the name of the file.

4. The  same  EDL is  loaded  into  Mistika  (using  the  software  Sequencer  or  by
means of Browser (Node Graph Editor->Dashboard->Import->Import All
Sequences), which will conform the EDL with the .dpx files (for more details
see the Help menu of Sequencer). 

5. The  color  correction  and  other  necessary  post-production  processes  are
done in Mistika.

6. The complete HD or SD production is recorded to tape to be sent  to another
system as if Mistika were the original telecine.

7. In Mistika, apply the command Linearize (Node Graph Editor->Dashboard-
>Edit->Edit->Macros->Linearize). This command puts all the clips utilized
in  an environment  in  order,  according  to  the  original timecode  of  each  clip
(derived  from the  EDL original).  It  eliminates  all  fades  and  wipes,  and  adds
sufficient head and tail time between the clips in order to be recaptured at  a
later date without pre-roll problems.

8. A  new  tape  (HD RGB 4:4:4,  HD 4:2:2,  or SD)  is  recorded,  establishing  the
recording  of  the  original  timecode  of  the  EDL.  This  action  will  produce
timecode  jumps  in  the  tape,  but  they  will  be  "legal"  ascending  jumps  and
there will be sufficient  space  between clips for later pre-rolls. This situation
is  valid  for  the  majority  of  VTRs  and  capture  systems.  To  carry  out  this
action, the TC button and the  Assemble mode, both located in the VTR tab
(Node  Graph  Editor->Dashboard->VTR->VTR  Play  Out)  must  be
activated.
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9. This  tape  can  be  sent  to  another  post-production  system.  Thanks  to  the
ordered  transfer via  Linearize,  any  external system will  be  able  to  capture
and conform the original EDL,  receiving all the cuts separately and being able
to add fades non-destructive. 

Note: The jumpers of the Centaurus video card must be changed in order to obtain the LTC
through audio  channels  7/8 (XLR  connection)  and  connect  the  other  end  to  the  LTC-IN
input of the VTR.
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H-3 Annex 3: Mistika Tangent Devices

SGO Mistika is compatible with a range of external control surfaces for the operation of
Mistika's effects, especially those related to color correction and stereo image adjustment. 

CP200

Note: It  is important  to note that  references in this chapter to "keyboard" are to those of
the color correction surfaces,  the  functions  <F1>-<F9>  and  the  <Alt> key  and  not  the
keys on the computer keyboard. 

Mistika's  interface  has  three  control panels,  assigned  to  different  functions  depending  on
the module selected.

The main use of the panels is to control the Color Grade, allowing colorists to work with the
traditional workflow with which they are familiar. It  is also possible to control the  Framing
and Stereo3D effects with this system.

The  Tangent  CP200  surfaces  have  various  kinds  of  button  and  displays  which  provide
information  regarding  the  function  associated  with  each  button  at  any  time.  Rotating
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buttons or Knobs are used for adjusting parameters rapidly and intuitively. Selection buttons
are used as direct access to different functions.

Text  appears in the displays over two lines. The upper line indicates the function assigned
to the Knobs. The lower line indicates the functions assigned to the selection buttons.

This control consists of two elements: the central Trackball whose movement  is associated
with  the  control  Ball  of  the  Color  Grade  effect,  and  is  used  for  selecting  colors.   The
external ring  is  associated  with  Ring  of  the  Color  Grade  effect  for  manipulating  levels  of
correction.

Panel de Selección y Transporte 
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This panel provides access to the controls allowing us to move shot  to shot  via the  Visual
Editor or in real time via the Node Graph Playout. It also allows us to directly select  Presets
of effects and manage memories and other functions associated with Color Grade.
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Prev/Next Edit

These buttons allow the movement  between shots in the Visual Editor,  selecting  the
corresponding Color Grade effect for later modification.

Functionality with <Alt>: This allows the movement between frames.

Reverse/Stop/Play

These buttons allows  movement   through  the Node Graph in real time to obtain the
evaluation of corrections done, seen in the the Record Monitor.

Functionality with <Alt>: The combination <Alt>+<Stop> allows the use of the Go
To  Selected  function in  the  Storyboard.  The  combination  <Alt>+<Play>  does  the
same thing in the Play Multiple function of the Visual Editor.

Jog/Shuttle Switch

This button switches the VTR control dial between Jog and Shuttle.

Jog/Shuttle Control

This dial works in the same way as traditional VTR controls. In Jog mode, rotating the
dial moves the Visual Editor forward or back frame by frame. In Shuttle mode, rotating
the dial moves the current location quickly through the Node Graph.

Display

In Jog  mode,  nothing  shows  in  the  display.  In  Shuttle  mode,  the  display  shows  an
illuminated rectangle to indicate the stop position of the shuttle, or triangles to show
the direction of movement ion the Node Graph.



692 Annexes

SGO Mistika 8.6 © 2018 SGO

Alt

This button is used in conjunction with other selection buttons to access  alternative
functions.
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Do

Each modification done  in  the  color corrector can be  saved  in  an  unlimited  History.
Each  time  we  press  the  <Do>  button,  the  correction  in  progress  is  saved  in  the
history.  To  indicate  the  state  of  the  history,  a  number  appears  in  the  Storyboard
which is associated with the shot being worked on and which shows the total number
of stored corrections and the position of the correction being viewed at  any time. For
example, 2/5 means we are viewing the correction of the second history from a total
of five stored corrections. To browse the history, use <Prev>/<Next> in conjunction
with the button <Alt>. 

The <Do> button is equivalent to the Bring OK  function in the Mistika interface.

Functionality with Alt: The combination <Alt>+<Do> eliminates the correction being
viewed  at  the  time  (Delete  Current  History  of  the  Bring  tab,  and  organizes  the
remaining ones from oldest to newest.

Undo

This button undoes the last  modification created by  any  change  in  parameters.  It  is
also used in conjunction with the correction history in order to reestablish the value of
a specific history after modifying its parameters.

Redo

Every  time  a  shot  is  loaded  into  the  Visual Editor with  the  buttons  <Prev>/<Next
Edit>  a  double  buffer  is  created  in  which  corrections  can  be  stored.  Each  time
<Redo>  is  pressed,  we  switch  between  one  buffer  and  the  other   in  order  to
compare  different  corrections  of  the  same  shot  (the  same  as  Bring  Modified).  This
double buffer empties each time a new shot is loaded using<Prev>/<Next Edit>.

Functionality  with  Alt:  To  make  correcting  or  balancing  with  other  shots  easier,
combine  <Alt>+<Redo>  which swaps  the  current  correction with  the  defined  shot
HeadB (the same as the command Swap Playheads of the Bring tab).

Cue

This  button takes  a  snapshot  of  the  current  correction  (Snapshot  Selected  of  the
Snapshot toggle).

Functionality with Alt: <Alt>+<Cue> takes a snapshot of the preset selected.

Prev/Next

These buttons allow movement  through the Storyboard clip by clip: a white appears
over  the  current  shot,  corresponding  with  the  functions  of  the  buttons  <Prev>/
<Next Edit>.

Functionality with Alt:  This permits navigation through the history of the corrections
stored with the button <Do>. This navigation through the history is the equivalent  of
the functions Bring Older and Bring Newer in the Mistika interface.
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Mark

This shows the content  of the snapshot in the last mode selected. Pressing a second
time returns us to the current  shot;  this  works  as  a  toggle  between Show  Live  and
Show Split/Show Snapshot).

Functionality with Alt: <Alt>+<Mark> works in the same way, though in  this  case
between the different modes of Snapshot (thus toggling between the current shot and
the snapshot, but in the way defined here, either Show Split or Show Snapshot).

In/Out

Defines  the  input  or  output  keyframe  for  the  dynamic  color  correction.  It  is
represented by a green triangle in the Node Graph of the Visual Editor. With it, we can
define  a  dynamic  correction  between  one  point  in  the  shot  and  another,  setting
different  values  before  and  after  the  input/output  points.  Use  with  the  "Autokey"
button  inactive.  Simply  position  in  any  frame  before  or  after  the  transition  region
defined by the green bar between the two  input/output  points.  The  positions  of  the
input/output  points  can be  modified  in  the  Node  Graph of  the  Visual Editor  by  left-
clicking them with the mouse while holding "ctrl".

Functionality with Alt: <Alt>+<In> lock the selected object, avoiding the possibility
of moving on the TimeSpace.

           <Alt>+<Out> Center the view on the selected object. 

Mem

Saves the current correction on the list of FX Presets in Mistika to be used later.

Functionality with Alt: Replaces the preset  that  the clip has with that  selected from
the different effects.

Grade

Automatically applies the color correction of the selected shot  (on the red  frame)  to
the  shot  or clip  being  worked  on;  this  is  the  same  as  the  Bring  Fx  function  of  the
Visual Editor.

Functionality with Alt: Replaces the preset  that  the clip has with that  selected from
the different effects.

Del

Inserts a  keyframe (or control point) in the  current  frame  with  the  default  value  (a
Neutral Key).

Functionality with Alt: Resets the  values of a keyframe to the default  values of the
color corrector (Remove Points).
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Numerical buttons 0-9

To  assign  a  Preset  to  the  current  shot,  simply  press  the  corresponding  numerical
button.

Our Presets can be assigned to these buttons by selecting the appropriate Preset  and
pressing <Alt> with the number required; thus up to 10 Presets are accessible at  the
single touch of a button.
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Mode

Together  with  the  numerical  buttons,  this  assigns  the  current  correction  to  a
temporary  buffer  which  memorizes  the  dynamic  correction   so  that  it  can  be
recovered  whenever  the  corresponding  numerical  button  is  pressed.  For  example,
<MODE>+<1> stores  the  current  correction in  button number <1>,  so  that  when
we press button number 1, this stored correction is taken to any other shot  selected
by using <Prev>/<Next Edit>.

NOTE: The content  of the buffer is lost  when Mistika is closed, so it  is not  advisable
to  use  it  as  a  substitute  for  the  FX  Presets.  It  is  also  lost  when  assigning  an  FX
Preset  to the numerical button. Thus, if  we assign a temporary buffer to a  numerical
button again that previously had an FX Preset assigned, this latter will be lost  in favor
of the temporary buffer.
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00

This button is used in conjunction with other selection buttons to access  alternative
functions.  When combining  them with  the  numerical buttons,  they  bring  the  history
corresponding to that level (the numbers <1>-<9> correspond to Bring H1-H9;  <0>
corresponds to Bring H10, the most recent).

.

The <.> Button inverts the current  frame  to  the  assigned  frame  with  HeadB;  which
means, bring the HeadB and assign the one we had previously assigned new HeadB to
the old we had. In combination with <Alt>, it  allows  us  to  assign the  HeadB to  the
selected frame (red framework).

+/-

These  buttons  allow  navigation between Preset  FX,  selecting  and  applying  them to
the current shot with with <Alt>+<Mem> or <Alt>+<Grade>.

The  combination  <Alt>+<+>/<->  allows  the  adding  or  eliminating  of  Color  Grade
folders (to add Free Vectors).

Clear

Delete all the historical record we have memorized for the clip.

More

This button shows the FX Preset panel in the left monitor´s dashboard. 

Snap

Open the snapshot menu.
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Framing

Direct  access  to  the  Framing  tab  in  the  Visual  Editor´s  dashboard,  either  through
Color Grade effect or Framing effect.

Stereo3D

Direct access to primary parameters of the Stereo 3D of Stereo 3D effect.

Color

Direct access to the Color Grade controls in the Visual Editor´s dashboard.

Highlight

Activate the Highlight view.

Panel de Trackballs:

The  Trackbalĺ s  panel contains  the  ball/ring  type  controls  that  allow  us  to  make  intuitive
adjustments over the interface controls of Mistika. It  also has direct  access buttons to the
different modules of the Color Corrector.
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By each trackball, we have a group of buttons, 3 for functions and 2 for executing a reset
of values for the corresponding Trackball. 

Each Trackball is assigned to the respective color control of the Color Grade. In the case of
the  primary  correction,  the  left  Trackball  will  control the  black point  (Black Point)  and  its
color,  the  central Trackball  will  adjust  the  gamma  and  the  right  Trackball  will  adjust  the
white point (White Point).



700 Annexes

SGO Mistika 8.6 © 2018 SGO

Panel de Botones

With this panel, we can manipulate the parameters  of  the  modules  of  the  color corrector.
The assignment  of the buttons will change depending on the module in  which we  are,  and
its  description  will  appear  on  the  display  immediately  above  to  each  set  of  buttons.
Therefore  this  panel is  directly  associated  with  each  of  the  3  function  buttons  <F1>-
<F2>-<F3> of the Trackballs panel, and in turn to the options that  appear on the display
of the Selection and Transport panel.

Botones F1 F2 F3 F4 F5 F6 F7 F8 F9

Through these buttons we acces to the modes of the Color Grade effect  (F1:Primary, F2:
Bands, F3:Fixed Vector, F4:Curves, F5 and F6: Add and remove Vectors, F7:Keyer  and F9:
Window) and Stereo modes (F1:Adjust, F2:Balance and  F3:Optical).  Also  the  we  have  the
function to navigate through the Knobs tabs with F9. 

Color Grad: F1 Primary

Once the Color Grade: Primary is active in SDR mode, the Trackball panel will be enabled. In
the lasts versions of Mistika there is an additional control in which exists an access through
the same <F1> button with the name of SoftC Y/N, which enables the right trackball as a
fourth ball and whose operation is exclusive in the Mistika to work with the illumination
zones of the Color Grade Primary HDR mode.
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Primary y Printer Lights

The Color Primary mode will enable button panel that shows the Knobs (rotating buttons)
assignment to the global level [Level] and Contrast [Cont] and of the same settings, in
this case for each RGB channel separately. 

In the Printer lights, mode button panel proceeds to execute the controls of this color
tool. In this case, other controls associated with <Alt>+ button from the Selection and
Transport panel have to be kept in mind. The Controls that appear on the button panel in
this mode are the rotary knobs that allow modifying the tool’s proper values. To those
controls, their associated reset has to be added, which in each case is the button that
accompanies each knob. 
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<Alt>+boton
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F9: + PRINTER

The first time that we press the <F9> button in Primary section, Printer Lights in the
White, Gamma and Black mode will be enabled. The second time that we press the <F9>
button, the controls corresponding to the HDR mode will be enabled; these controls are at
the same time related to the fourth trackball. It is important to have in mind that there are
more controls associated with <Alt>+button or to <Alt>+knobs from the Selection and
Transport panel. The controls that appear in the button panel in this mode are the rotary
knobs. They allow modifying the proper values of this tool. To these controls it is necessary
to add its associated reset, which in each case is the button that accompanies each rotary
dial (knob). To those controls their associated reset has to be added, which in each case is
the button that accompanies each knob. 

  
<F9>+knobs <Alt>+botón
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<F9> (knobs)
<Alt> botones
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Color Grade: F2 Bands

<F2> in SHC mode will enable the trackball controls where the switch will be in this case
the same <F2> button to change between the axes of the trackballs controls: Black and
White with its corresponding central trackballs: Shadows, Medium tones, and Highlights. The
controls that appear in the buttons panel are the rotary dials (knobs) which allow to
modifies the own value of this tool. To those controls, their associated reset has to be
added, which in each case the button that accompanies each knob.
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<F9> in Ranges mode will enable the complementary controls to Bands SHC mode whose
switch will be as the previous case of a <F9> button. Being in this mode, the Mistika
interface will still be showing the Bands mode. The controls that appear in the buttons panel
are the rotating knobs that allow to modifies the Ranges values. The assigned knobs to [Hi
Limit] and [Lo Limit] controls the protection zones of the white and black points, while the
assigned knobs to [Hi Slope] and [Lo Slope] modify the curves whose intersection defines
the color ranges which will affect the band's correction. The controls that appear in the
buttons panel are the rotating knobs that allow modifying the own values of this tool. To
those controls, their associated reset has to be added, which in each case the button that
accompanies each knob.
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Color Grade: F3 Fixed Vectors

When entering in the Fixed Vectors mode, the Hue and Sat  controls (6 fixed vectors visible
on the buttons panel) will appear by default. To switch between the Hue/sat  and Hue/Lum
it is necessary to use the <F9> switch from the Trackball panel. The controls that  appear
on the  buttons  panel  in  this  mode  are  the  knobs  that  allow  modifying  this  tool’s  proper
values. To these controls, their associated reset  has to be added, which in each case the
button that accompanies each knob.

<F9>+knobs
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     <F9>+knobs
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Color Grade: F7 Keyer

When entering to Keyer mode its controls will appear on the button panel. To switch
between the Sat and Lum it is necessary to use the <F9> switch from the Trackball panel.
The controls that appear on the buttons panel in this mode are the knobs that allow
modifying this tool’s proper values. To these controls, their associated reset has to be
added, which in each case the button that accompanies each knob.

<F9>+knobs
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<F9>+knobs
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Color Grade: F7 Window

When entering the Window mode its controls will appear on the button panel. To switch
between the Dst and Win mode it is necessary to use the <F9> switch from the Trackball
panel. The controls, that appear, on the button panel allows modifying the tool’s proper
value. 

    
<F9>+botón
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<F9>+knobs
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Color Grade: F4 Curves

The Curve button gives the access to the [Curve] mode, showing the correspondent  panel
on the Dashboard. We have to use the <F9> switch on the Trackball panel in order to see
more Curve mode options. The buttons panel will show the following configuration: 

<F9>+ botones          
<F9> knobs +botones
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The buttons that appear in this mode on the button panel are the rotary knobs. They allow
modifying this tools proper values.To these controls, their associated reset has to be
added, which in each case the button that accompanies each knob.

Boton F2  

When selecting the Framing button the Framing mode and its corresponding options on the
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Selection and Transport panels, as well as in the Buttons panel will be enabled.

Go to Framing

Inside the Framing the Trackball panel will be enable. In this panel we observe in the display
that the <F9> switch allow the access to different options in the buttons panel which is
shown below:

     <F9>+knobs
<F9>+botones
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The controls that appears in the buttons panel are the rotating knobs that allow modifying
the proper values of this tool. To these controls it is necessary to add its associated reset,
which in each case is the button that accompanies each rotary dial (knob).

Stereo

The Stereo button allows direct access to the main parameters of the Stereo 3D effects in
the Stereo 3D Editor. Their big groups will be seen reflected in the Selection and Transport
panel, as shown below.

El botón Stereo permite el acceso directo a los parámetros  principales  del Stereo3D Editor
del efecto  Stereo3D cuyos  grande  grupos  se  verán reflejados  en el panel de  Selección  y
Transporte como vemos en la imagen a continuación:
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Border

 With the <F6> button is possible to switch between the different  options to choose
how the stereoscopic image edge is displayed.

Stereo Mode

The <F7> button activates or deactivates the stereo mode within the Mistika. 

S3D VE View / S3D Live View

<F4><F5>  allow  to  change  the  visualization  mode  of  the  stereoscopic  images,
commuting cyclically between the different  modes; both for visualization in the visual
editor and in the video output (Live).

Stereo: F1 Balance

Balance. The  controls  that  appears  in  the  buttons  panel in  this  mode  are  the  knobs  that
allow modifying the proper values of this tool. To these controls it  is  necessary  to  add  its
associated  reset,  which  in  each  case  is  the  button  that  accompanies  each  rotary  dial
(knob).                 

 
<F9>+knobs    
<F9>+knobs
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Stereo: F2 Adjust

The controls that appears in the buttons panel in this mode are the knobs that allow
modifying the proper values of this tool. To these controls it is necessary to add its
associated reset, which in each case is the button that accompanies each rotary dial
(knob).
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<F9>+knobs
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Pos X / Pos Y

 Modifies the image stereoscopics in its horizontal and vertical position.

Zoom

Modifies the total zoom of the stereoscopic image.
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Roll

Modifies the total rotation of the stereoscopic image.

L Width / R Width

Allows  to  modify  the  size  values  of  the  stereoscopic  window  in  its  left  and  right
margin.

L Slant / R Slant

Adjusts the inclination of the stereoscopic  window borders in its left  and right  margin.
 

Stereo: F3 Optical

If we have selected the Stereo->Optical in  the  Modes  panel,  we  can modify  the  related
parameters with the correction based in Optical Flow.

The  parameters  correspond  to  those  in  Stereo3D->Optical  Flow.  They  are  defined  in
Stereo3D->Stereo3D->Parameters->Optical Flow.

    

         <F9>+knobs
  <F9>+knobs

 <F9>+knobs
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Change Apply Color Option / Change Apply Geometry Option

Cyclically  switches  between the  options  that  indicate  on  which  image  to  apply  the
settings.  

Mirror L / Mirror R

Cyclically switches between the options that  indicate if  there  is  a  need  to  rotate  or
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invert any of the images.  

Y Constrain

Activates or deactivates the Y Constrain.

Match Color / Match Geometry

Realizes the automatic color and geometric balance on the image(s).

Pos X / Pos Y

Manually modifies the pair of images to make the stereoscopic balance of the image.

Zoom

 Modifies the zoom difference between both images.

Roll

Modifies the horizontal rotation difference of the both images.

Keystone

Adjusts the keystone parameter value in order to correct  the trapezoidal deformation
on the lateral sides of the image.

Shear X / Scale X / Keystone X

Modifies  the  advanced  geometrical  adjustments  folder  for  the  Shear  X,  Scale  and
Keystone X.

Gamma 

Modifies the final gamma of the stereoscopic image.     

Elements

Mistika has six interface controls to which different  functions can be assigned according to
the module selected at any time.
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The primary use of these panels in to work with the RGBCorrect  effect, allowing the use of
the traditional workflow that  colorist  are used to. It  is also  possible  to  control the  effects
Framing and Stereo3D with this system.

The  Elements  panels  possess  a  range  of  buttons  and  displays  that  provide  information
relating to the button selected. The Knobs allow the adjustment  of parameters quickly and
intuitively. The selection buttons  are  used  for direct  accesses  to  different  functions.  The
buttons with alternate functions <A> and second functions page <B> allow a single panel to
be used for different functions related to the panel and effect selected. 

Texts appear in  the  displays  in  4  lines  indicating  the  function assigned  to  each button in
each specified effect in order.

This  control has  2  elements:  the  central  Trackball  is  a  ball  whose  movement  is  usually
associated with the Ball function of the RGBCorrect effect for selecting color.

The  outer  element  is  associated  with  the  Ring  function  of  the  RGBCorrect  for  adjusting
correction levels.

Also, in the navigation panel, the Ring is associated with the Jog/Shuttle function.

Although many of the uses of the various panels are common to different  effects (such as
RGBCorrect  and ColorGrade) or to different  modes,  they  are  divided  into  different  chapter
for greater clarity, according to the effect in which they are used.

Selection and Transport Panel 

The Selection and Transport  panel is  common to  all  the  modes  and  effects  found  in
Mistika.
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This panel provides access to the controls for moving between shots via the Visual Editor  or
in  realtime,  between the  Playout  in  the  Node  Graph.  It  also  allows  for  directly  adjusting
modes in the Snapshot tool and the function in the Storyboard.
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Prev/Next Edit

These buttons allow  movement  from shot  to  shot  in  the  Visual Editor,  selecting  the
corresponding RGBCorrect effect to be modified later.

Functionality with <A>: Allows jumping to the start/end of the current clip.

Reverse/Stop/Play

These  buttons  allow  movement  via  the  Node  Graph  in  realtime  obtaining  the
evaluation of corrections using the Record Monitor.

Functionality  with <A>:  Allows  movement  through the  Node  Graph or the  current
clip, frame by frame.

Jog Control

The Ring of this panel functions like traditional VTR controls.

Key In/Out

Defines  the  input  or  output  keyframe  for  a  dynamic  color  correction.  This  is
represented by a green triangle in the Node Graph of the Visual Editor. This allows the
definition  of  a  dynamic  color  correction  between  differing  points  in  a  shot,  setting
differing values before and after the defined input/outputs. It  must  be used  with  the
button Autokey deactivated; simply locate in any frame before or after the  region of
transition defined by the green bar between the two input/output  points. The position
of the input/output  points can be modified in the Node Graph of  the  Visual Editor  by
left-clicking over them while pressing <ctrl>.
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Prev Key / Next Key

Navigates within the range of the clip between the different defined keys.

Functionality with <A>: Activates the functions Autokey of the timeEditor  and Lock
Selection in the Bring tab.

Bring FX

Applies the correction of the clip selected in the Storyboard, indicated by a red frame,
to the active clip being worked on, indicated with a white frame.

Functionality with <A>: Activates the Autokey function of the timeEditor.

Select Prev/Next

These  buttons  are  used  to  move  the  selection  via  the  Storyboard  clip  by  clip,
indicating the selected frame with a red frame.

Functionality  with <A>:  allow  the  application of  a  correction from the  previous  or
next clip (with reference to the current  one being worked on), being indicated with a
white frame in the Storyboard. This corresponds to the functions Bring Prev and Bring
Next of the Bring tab.

Snapshot from Selected

Allows a Snapshot of the selected clip in the Storyboard to be taken, indicated with a
red frame.

Functionality with <A>: This  takes  a  Snapshot  of  the  active  clip,  indicated  with  a
white frame in the Storyboard.

Show Snapshot

Switches between the view of the Snapshot (in any of its modes) and the current  clip
(Live).

Functionality with <A>: Changes the viewing mode of the Snapshot.

Swap / Bring Mod

These buttons allows the switching between the last modification and the state of the
effect before the last change.

Functionality  with  <A>:   The  functionality  changes  to  manage  the  HeadB  of  the
Storyboard,  allowing  the  fixing  of  the  selected  frame  as  HeadB  or  locking  its
movement  along with any frame which can be  selected  in  the  Storyboard,  indicated
with a red frame.

Delete All

Eliminates all modified parameters, returning them to their default values.
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Center Selected / Center Current

Centers the Storyboard view on the selected or the currently active shot.

Functionality with <A>:  Resets the position of the selected shot, with a red frame,
to the current shot.
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On the second functions page, some of the functionalities of the buttons change.

Repl Preset

Replaces the memorized correction of the selected  preset  with  the  one  found  in  the
active clip, identified with a white frame in the Storyboard.

Functionality  with <A>: creates  a  floating  button  of  the  effect  preset  above  the
active clip.

Prev Preset / Next Preset

Buttons for navigating through the different stored presets.

Snapshot Preset

Allows changing the different viewing presets in Snapshot.

Swap HeadB

Switches between active or current shot with that designated HeadB.

Color_Grade_panels

The  controls  and  mapping  for panels  corresponding  to  the  Color  Grade  effect  are  shown
below. 
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Modes, Functions and Knobs Panels

The  Modes  panel  allows  the  selection  of  the  effect  in  which  the  parameters  are  to  be
modified via the Functions, Knobs and Central panel.  The  functions  available  in  the  Modes
panel are seen above, depending on which of  the  3 effects  is  pressed  (Color,  Framing  or
Stereo); this  also  activates  this  effect  in  the  current  stack (navigating  between them,  if
there are more than one).

Big Modes

[ Color / Framing / Stereo]

Access buttons to the 3 big modes. Inside one of  each big  mode  there  are  different
modes, that charges on the rest of the keypad were the big modes are.

Add FVector

Adds a new folder in the Color Grade, making use of a new Free Vector.

Functionality with <A>: Eliminates the free vector in which we are currently located.

Prev FVector / Next FVector

 Permits navigation between different free vectors to be worked on.
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Submodos

[Primary  /  Bands  /  Fixed V /  Keyer  /  Window  /  Curves  |  Adjust  /  Optical  /
Balance]

Buttons  that  activate  the  functionality  of  the  others  panels  according  to  the
parameters to be modified for each one.

Note:  In  the  Framing  mode  and  Stereo  mode,  these  buttons  appear  with  another
name, corresponding to each of the modes.

Functions  related  with  the  tools  of  the  Storyboard  and  different  viewing  modes  on  the
second page of functions <B >of the mode panel. 

Lib Active

Activates the window or toggle of the  presets,  in  Visual Editor>FX Presets,  to  be
used in color correction or any other effect.

Lib Max

Maximizes the presets window.

Snapshot

Activates or opens the Snapshot toggle in the Visual Editor>Snapshot.
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SB Active

Activates viewing of the Storyboard in the Visual Editor.

SB More / SB Less

Adds/deletes  viewing  of  a  new  line  or level in  the  Storyboard,  vertically  expanding/
contracting.

View RGB / View Alpha / View RGBxA

Modifies the viewing mode of Visual Editor.
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Scope 1, 2, 3, 4

Activates/deactivates the toggles of the Scopes in order to view them.

Depth Grade

Activates the Depth Grade toggle to be used with the effect Stereo3D.

Hilgt

Activates the Highlight.

In-Out

Switch between the display mode Vector’s Inside and Outside mode.

Mute

Mutea el Vector actual.

Delete Vector

Remove the parameters of the Vector in which we are at the moment. 
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Remove Vector

Eliminates the vector in which we are currently located.

Storyboard Max

Maximizes viewing of the Storyboard.

Storyboard Min

Reduce the viewing of the Storyboard.

View R, G, B

Modifies the viewing mode of Visual Editor.
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When selected in the Color>Primary mode, the Functions panel also allows the running of
various Printer Lights  functions (corresponding to the section of commands related to the
workflow based on printer lights, in RGBCorrect->Primary).
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When selected in Color->Primary mode, the Knobs panel also  allows  the  running  of
Printer Lights (functions corresponding to the  section  of  commands  related  to  the
workflow based on printer lights, in Color Grade->Inside Grade->Primary).
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With the knobs corresponding to each range (All, High, Mid, Dark) we can adjust  Hue,
Saturation and Contrast. This setting  also  depends  on the  selection made  in  Range,
which modifies these ranges (and will automatically to the Range panel).

The knobs assigned to Hi Limit and Lo Limit control the protection of the black and
white points, while the knobs assigned to Hi Slope and Lo  Slope  modify  the  curves
whose  intersection defines  the  ranges  of   color  which  will  affect  the  correction  of
bands.

(modo Bands)
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(modo Range)
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In  Fixed  Vectors  mode,  only  the  Knobs  panel has  adjustable  parameters,  with  the  Knobs
corresponding to each color, Red, Blue, Green, Cyan, Yellow and Magenta, Hue saturation, (
Sat) and luminance (Lum), with the last being accessible via the <B> functions page.



757Annexes

SGO Mistika 8.6 © 2018 SGO

In  Fixed  Vectors  mode,  only  the  Knobs  panel has  adjustable  parameters,  with  the  Knobs
corresponding to each color, Red, Blue, Green, Cyan, Yellow and Magenta, Hue saturation, (
Sat) and luminance (Lum), with the last being accessible via the <B> functions page.
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In these 3 lower buttons in the Modes panel, when Color is selected, manipulation of  free
vectors can be accessed. In Source, the range of the selected color can be modified  and
manipulated.
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L Soft

This knob adjusts the softness range of the left selection of the Hue Qualifier.

Hue Range

This knob adjusts the softness range of the total of the Hue Qualifier.

R Soft

This knob adjusts the softness range of the right selection of the Hue Qualifier.

Lum Lo/ Lum Hi

Adjusts the limits of the color selection based on luminance. The Lum Lo Knob adjusts
the lower limit of the selection; Lum Hi sets the maximum limit.

Sat Lo/ Sat Hi

Adjusts  the  softness  ramp  of  the  selection  for  minimum  or  maximum  values  of
luminance  or saturation,  depending  if  this  is  on the  <B>  function  page  or  not  (for
saturation).

Hue Angle

Adjusts the rotation angle of the selection of the Hue Qualifier.

Soft Lo/ Soft Hi

Adjusts  the  softness  ramp  of  the  selection  for  minimum  or  maximum  values  of
luminance  or saturation,  depending  if  this  is  on the  <B>  function  page  or  not  (for
saturation).

K-Blend

Vector transparency value.

K-Blur

Applies a blur filter to the defined mask.

K-Softness

Controls  the  range  of  soft  transparencies  from  total  transparency  defined  by  the
parameter  Tolerance  towards  total  opacity.  A  low  value  sets  a  small  range  of
intermediate transparencies (corresponding to RGBCorr->Key->Softness).

K-Tolerance

Defines  the  total  transparency  threshold  in  the  alpha  generated  (corresponding  to
RGBCorr->Key->Tolerance).



761Annexes

SGO Mistika 8.6 © 2018 SGO

B-Blend

Amount  of  focus  and  blur of  the  effect.  Negative  values  are  understood  as  a  focus
(sharpen) and positives as blur (blur).

Defocus

It allows controlling the amount of Defocus type

B-Radius

Controls the amount of blur in the Pre-key options.

B-Gamma

Gamma value applicable to previous defocus that  is done to produce  a  Glow  effect  (
Glow)
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In Window, it is possible to choose some types of mask to restrict  the selection and color
of the areas defined; parameters can also be modified.

Key Mode

Activates the Source mode.
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Show Key

Shows the alpha created by the key mode (corresponding to Show Alpha).

Exp Key

Activates export key mode.

Line / Ellipse / Square

Allows the selection of the standard type of mask to be used: line, ellipse or square.

Shape

Uses  any  mask,  created  in  VisualEditior->Shapes  tab,  as  mask to  be  used  in  the
free vector.

Win Key

Uses the alpha input as the mask to restrict the color selection of the free vector.

Inverse

Inverts any type of selection (defined masks, shapes or alpha).

Hilgh

Activates the Highlight.

Mute

Activates the Mute button.

MoveX / MoveY / Rotation

Defines the position and rotation of the wipes.

SizeX/SizeY

Defines the dimensions of the wipes. Has no effect when wipe is a line.

Softness

Defines a soft border to wipes.

Mask Filter

Applies a blur filter to the defined mask.
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Soft

Controls  the  range  of  soft  transparencies  from  total  transparency  defined  by  the
parameter  Tolerance  towards  total  opacity.  A  low  value  sets  a  small  range  of
intermediate transparencies (corresponding to RGBCorr->Key->Softness).
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Add Points

Adds three equidistant points in all the curves of the mode in which we are working.

Reset Sel

Resets the selected point/s to the initial position.

Reset All

Resets all the curves to their original positions.

RGB Curve / L-L / L-S /S-S /Hue-Hue/Hue-Sat/Hue-Luma

Navigates through the different curves.

In the Curves mode, the knobs  allow  us  to  manually  manipulate  the  points  of  our curves.
The panel allows up to 6 editing points.

Panel de Memorias

The  memory  panel  allows  access  to  different  saved  memories  and  histories,  as  well  as
applying saved presets. 
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Bring Ok

Every adjustment  in  the  color corrector can be  saved  in  an unlimited  history.  When
this  button  is  pressed,  the  current  correction  is  saved  in  the  history.  A  number
appears in the Storyboard that indicates the state of the history associated with the
shot  being  worked  on,  showing  all  the  saved  corrections  and  the  position  of  the
correction being viewed at each moment. For example, 2/5 means correction number 2
of a total of 5 stored is being viewed.

Bring Original

Recovers the previous values to the last modification carried out.

1 - 9

Allows rapid access to the saved presets or temporary  memories  (the  last  defined  is
accessed).
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Del History

Deletes  the  correction  currently  being  navigated,  ordering  the  remaining  ones  from
oldest to newest.

Bring Older / Bring Newer

Allows navigation via the history of corrections stored in the given shot.

History 1 - 9

Brings the history corresponding to the given level.
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Save Lib

Saves a new preset in the folder FX Presets (corresponding to Save Preset).

Def TMP 1 - 9

Assigns  the  current  correction to  a  temporary  buffer that  memorizes  the  correction
which can be recovered when the assigned number is pressed. 
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Del Lib

Eliminates selected the preset (corresponding to Delete Preset).

Def Lib 1 - 9

Defines  the  presets  stored  in  FX  Presets  with  a  numerical  shortcut,  for  access  to
from the default mode of the Memories panel by simply pressing the assigned number.
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Panel Central

The Central panel contains the ball/ring manipulators that allow intuitive setting adjustments
of the Mistika interface. 

Each manipulator has a pair of buttons, for resetting the ball (dot) and ring (ring).
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When Color->Primary  is  selected  in  the  mode  panel,  each  Trackball  is  assigned  to  the

respective  color manipulator of  the  RGBCorrect.  The  left  Trackball  will  control Black  Point

and  its  color,  the  central  Trackball  will  adjust  Gamma  and  the  right  Trackball  will  adjust

White Point. In the second bank of primary <B>, the right ring controls the Post  Sat  of the

image, the central ring controls Levels which modifies the levels of three ranges at the same

time and the last trackball, and if they control ring controls the Superwhites or Softclip.
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In Color->Bands mode, the 3 balls of the Trackballs are assigned to the bands Shadows,
Midtones and  Highlights. In mode <B>, the left Trackball is assigned to Black and the right
Trackball to White.

In Color->Source mode, the Ring of the central Trackball also has the function of rotating
the angle of selection of the Wheel Qualifier.
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In the Color->Window mode, the Trackballs regulate the windows of Color Grade. The left
Trackball  controls  the  position  and  rotation of  the  mask.  The  right  Trackball  controls  the
size  and  the  softness  of  the  mask.  The  upper  buttons  are  for  resetting  the  previous
parameters. 

Framing

Controls of the Framing effect (when activated in the Modes panel) are shown below.

Modes, Functions and Knobs Panels



774 Annexes

SGO Mistika 8.6 © 2018 SGO



775Annexes

SGO Mistika 8.6 © 2018 SGO

If the Framing option is selected in the Modes panel, the Functions and Knobs panels  will
show the values to be modified in this effect.
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Change Mirror Option / Change Source Option / Change Quality Option

Cycles  between  the  various  options  of  each  tab  (as  explained  in  the  chapter  FX-
>Misc->Framing).

Reset Scale

Resets the scale values to their default value.

Lock Current Ratio / Lock Result Ratio

Locks the selected ratio so that  it  remains  unmodified  by  any  subsequent  change  in
setting.

2.35, 16/9, 1.85, 4/3, Apply Custom

Applies an image frame defined according to the standard selected or a variant  set  by
the user.

Reset Crop

Resets crop values to their default value.

Lock Crop

Locks the crop parameters so that they remain unmodified by any subsequent  change
in setting.

Roll

Adjust the rotation of the image.

Scale X, Y

Adjusts horizontal and vertical scale.

Offset X, Y

Adjusts horizontal and vertical position.

Left / Top / Right / Bottom

Adjust the size of the image frame used for cropping frame.
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Stereo3D

The Controls of the Stereo3D effect are shown below.

Modes, Functions and Knobs Panels

The  Modes  panel  allows  the  selection  of  the  effect  in  which  the  parameters  are  to  be
modified via the Functions, Knobs and Central panels. The functions available in the Modes
panel can be  seen above,  according  to  which  of  the  three  effects  is  depressed,  (Color,
Framing or Stereo), causing this effect to be activated in the stack in which we are located
(navigating between them if there are more than one).

Primary, Bands, Fixed Vectors / Select / Balance, Adjust, Optical

Buttons  which  activate  the  functionality  of  the  other  panels  according  to  the
parameters to be modified in each one.

Add FVector

Adds a new folder in the Color Grade effect  that  contains the new Free Vector  to be
used.

Functionality with <A>: Eliminates the free vector in which we are located.

Prev FVector / Next FVector

Allows navigation between different free vectors to be able to work on them.
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Source, Window, Destination

Selects the modes or phase of work within each free vector. According to whichever
is selected, the Functions and Knobs panels will show different  parameters of the free
vectors to be worked on.

Inside / Outside

Switches between correction modes for the inside and outside of the mask.

Border

Switches  between  the  different  options  for  choosing  how  the  edge  of  the  stereo
image will be viewed.

Stereo Mode

Activates/deactivates stereo mode in Mistika.

S3D VE View / S3D Live View

Allows  the  changing  of  the  viewing  mode  of  the  stereo  images  by  cycling  between
them; this is valid for viewing in Visual Editor and in the video output (Live).
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If Stereo->Balance is selected  in  the  Mode  panel,  parameters  for matching  both images
(left/right) can be adjusted with the Functions and Knobs panel 
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Change Apply Color Option / Change Apply Geometry Option

Shuttles between options that indicate which images are to be adjusted

Mirror L / Mirror R

Shuttles  between  options  that  indicate  the  need  to  rotate  or  invert  one  of  the
images.

Y Constrain

Activates/deactivates Y Constrain.

Match Color / Match Geometry

Carries  out  an  automatic  color  and  geometry  matching  of  the  image  or  images
(according to the option selected).

Pos X / Pos Y

Manually modifies the balance of the pair of stereo images.

Zoom

Modifies the difference in zoom n between the two images.

Roll

Modifies the difference in rotation between the two images.

Keystone

Sets the keystone parameter value in order to correct  the trapezoidal deformation at
the edges of the image.

Shear X / Scale X / Keystone X

Modifies  the  values  in  the  advanced  geometry  folder  for  Shear  X,  Scale  X  and
Keystone X.

Gamma 

Modifies the final Gamma of the stereo image.
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If  Stereo->Balance  is  selected  in  the  Mode  panel,  parameters  for  matching  the  stereo
image can be adjusted with the Knobs panel.

Pos X / Pos Y

Modifies the vertical and horizontal position of the stereo image.

Zoom

Modifies the total zoom of the stereo image.



782 Annexes

SGO Mistika 8.6 © 2018 SGO

Roll

Modifies the total rotation of the stereo image.

L Width / R Width

Allows adjustment of the width (left and right) of the stereo window.

L Slant / R Slant

Adjusts the slant of the left and right edges of the stereo window.
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If  Stereo->Optical  is  selected  in  the  Mode  panel,  parameters  related  to  the  correction
based on Optical Flow can be modified.

The  parameters  correspond  to  those  in  Stereo3D->Optical  Flow.  They  are  defined  in
Stereo 3D->Stereo 3D->Parameters->Optical Flow.

Central Panel

When using the Stereo effect, the Central panel will control the  geometric  settings  of  the
pair  of  images.  The  left  Trackball  adjusts  the  horizontal,  the  central  Trackball  sets  the
vertical and the right Trackball adjusts the scale relationship between the two images.
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H-4 Annex 4: Precision Panels

Precision Panels are a  system that  allows  Mistika  to  be  controlled  via  a  series  of  displays
and buttons. Specifically, it is designed for working with color correction etc, but  thanks to
its numerous control options (such as its tablet  and tactile keyboard), all the functionalities
of Mistika are catered for.

Introduction

Before explaining how the Precision Panels work, we should clarify that  they are currently in
an early stage of development  and constant  evolution, so some buttons and  functions  are
not yet integrated or in use.

The Precision Panels are  divided  into  three  main  parts:  the  Transport  Panel (with  specific
functions  for navigation in  the  TimeSpace),  the  TrackBall  Panel  (including  the  main  color
correction functions via the balls and rings), and the Tablet  Panel (with Learning Mode and
tactile keyboard functions).

The Precision Panels also have 5 tactile displays: 4 identical ones in the upper area, and a
larger one in the Tablet  Panel. The 5 panels work independently of each other,  and  this  is
especially useful with regard to the first  4, which can this control up to 4 different  tools at
once. The fifth panel's specific functions will be discussed later.

Each display of the 4 upper panels has a group of associated buttons, composed of 10 dials,
a  joystick  and  5  normal  buttons.  The  3  on  the  right  (Tools,  ISO  and  Lock)  control  the
different groups of tools that are currently supported: 

· Tools: groups the tools of the color effect Color Grade (Primary, Bands, Ranges and Fixed
Vectors).

· ISO: groups the selection tools contained in the Select  and  Window  menus  of  the  Color
Grade effect (selection via HSL, Filters, Windows and Shapes), a well as certain important
miscellaneous  color  correction  functions,  such  as  Snapshot   and  (in  some  versions)
functions relating to Canon monitors.

· Lock: Dashboard contains the functions of Mistika: Project, Import, Conform, Media, Edit
, FX, VTR, Audio and Output  (some of these options may not  be activated because their
integration is still in development).

Navigation  through  the  different  menus  can  be  carried  out  by  touch  or  by  rotating  the
associated joystick. Depending on the menu selected, certain buttons (like the dials of the
display)  will  change  their function.  This  is  because  the  work Precision Panels  based  on  a
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series  of  Layers  and  Modifiers  which  change  the  functionality  of  the  different  buttons.
Precision  Panels  have  a  default  mapping  which  mostly  works  independently  of  any  tool
currently in use. However, if  a Modifier  is activated, this mapping switches to provide  new
functions. Let’s define a Modifier and a Layer: 

Modifier: buttons such as CTRL/ALT/SHIFT/DELETE/ENTER (on the left). When activated,
they are illuminated in white, and change the mapping of the entire  table,  independently
of whether a new function has been assigned to a button or not; in this case the button
will remain ‘empty’, without  a function. For example: with the CC  of  the  Transport  Panel
we create a new vector in Color Grade; if we activate Delete, the CC button is now used
for deleting  a  vector.  The  remaining  buttons  are  left  without  function  unless  they  are
assigned one with Delete activated.

Layer: buttons such as Shape, Track and Mems are Layers (and are illuminated in yellow
to distinguish them better). The main difference is that Modifiers only change the function
of  those  buttons  that  are  they  affect,  while  the  default  mapping  of  other  buttons  is
maintained. The Dials have the same functioning, whose functionality changes depending
on the menu in the display and internal options  selected  (we  will  see  this  in  more  detail
below).  For  example:  by  default,  the  Play  button  in  the  Transport  Panel  makes  the
TimeSpace  play,  but  if  the  Track Layer  is  activated,  the  Play  button  then  becomes  a
Track Forward. The remaining buttons maintain their function if not affected by the Layer
Track.

Thanks  to  this  system,  Precision  Panels  can  cover  many  functions,  since  each  the
functionality of each button can change depending on the Modifier or Layer activated.

Basic Controls

Undo/Redo: To undo or redo actions.

CTRL+Save: To save an Environment. The Save button is used for saving Presets, since
during a session it is a function that used more than the regular save.

Cursor

The  Cursor  button is  a  special  button  in  the  Precision  Panels.  For  practical  purposes,  it
functions as a Layer, changing the functionality of the fourth ball and ring. When activated,
the ring becomes a zoom, like the classic control with a mouse wheel, and the ball changes
to control the cursor. 

The upper buttons (usually with a Reset function) act like the left and right mouse buttons.
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Displays

The  use  of  the  Displays  is  somewhat  special,  but  follows  the  scheme  of  Modifiers  and
Layers as explained above. There are different  types  of  menus,  but  most  follow  the  same
pattern:
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As we can see, the menu consists of different areas:

The upper menu of tools contained in that  group (remember: Tools, ISO and Lock).
They can be navigated by touch or by rotating the joystick. 

The  central menu with  two  columns  of  buttons,  left  and  right,  and  a  mini  central
informative  panel.  The  column on the  left  controls  the  upper dials  of  this  display,
and the right column controls the lower dials. It is important to keep this in mind, as
each of  these  buttons  functions  as  a  Layer  that  affects  only  the  corresponding
dials,  so  the  user can set  not  only  what  tool  they  want  to  use,  but  also  which
functions  of  that  tool.  For example,  in  Primary  we  have  on the  left  the  functions
White, Gamma and Contrast, and on the right Gamma, Black and Levels; so we can
configure Primary so that  the upper dials control White  and  the  lower dials  control
Levels.

Lower menu (purely informative) with the name of the current  Dial function and the
numeric value of the parameter. 

Each display also has a series of associated buttons. As mentioned, the functionality of the
Dials changes depending on the tool selected in the upper menu, and the parameters of the
left and right columns. Below each dial there are two, horizontally-arranged buttons. These
buttons increase/decrease by +1 or -1 the value of the parameter controlled by this Dial. If
CTRL  is  activated,  these  buttons  change  their function in  order to  control the  degree  of
sensitivity of the Dial they affect; so if  we press the right  button with CTRL activated, the
sensitivity scale of the Dial changes from 1 to 10, to 100 or to 1000, depending on whether
we press the button 1, 2 or 3 times (the  more  intense  the  green light  is,  the  greater the
scale). Similarly, by pressing the left  button, we change  the  scale  to  0.1,  0.01 and  0.001
(the more intense the blue light is, the lower the scale).
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In addition to the dials, there are other associated buttons:

Tools, ISO and Lock: switch between the different groups of the panel's tools.

Bypass and Reset: currently in development for the majority of tools.

Joystick:  The  Joystick  can  be  operated  in  two  ways:  rotating  it  navigates  the
upper menu of  the  Display;  pressing  it  makes  the  Display  active  (in  which  case,
lights around the joystick will illuminate).

The  Active  Display:  to  understand  how  the  Precision  Panels  work,  it  is  necessary  to
understand  the  Active  Display  System.  Activating  a  Display  means,  in  general,  assigning
functions  of  the  tool of  that  display  to  the  rings  and  balls  of  the  panels.  The  remaining
Displays will continue to work correctly, but the Trackball will only have the functions of the
active Display. This happens  with  most,  but  not  all,  of  the  tools.  When an active  Display
has  functions  not  associated  with  the  Trackball,  it  will  maintain  the  functions  of  the  last
active  tool.  This  system can change  if  a  specific  Layer  assigns  specific  functions  to  the
Trackball of the panels, in which case, the Layer  has  priority  over the  Active  Display.  For
example, if we activate the Primary display by pressing the joystick, the Trackball will have
the functions of  Primary  (Black,  Gamma,  White  and  Level).  But  if  we  activate  the  Shape
Layer (clicking the Shape button in the panels), the Trackball will now control the Windows
and Shapes we are using. This way, we  can quickly  switch  the  functions  of  the  Trackball
without exiting the tool.

Normally, every tool of the Display has an associated interface in Mistika (in Color Grade, for
example, we have Primary, Bands, Ranges, Fixed, etc.) If we are in Primary in the interface
of Mistika, the Display with Primary in the panels with be the active one. If we activate the
Display of Bands by pressing the corresponding joystick, the Mistika interface will change to
Bands.  That  is  to  say,  the  Mistika  interface  is  synchronized  with  the  active  Display,  and
whenever  it  is  changed,  the  interface  changes  (as  long  as  the  active  Display  has  an
associated interface in Mistika). 

TimeSpace Navigation

The  main  tools  for navigating  the  TimeSpace  are  found  in  the  Transport  Panel.  To  work
properly  with  Precision  Panels,  firstly  in  Edit  ->  Setup  activate  the  function  Auto  Sync
Editor to Timeline, which improves communication between TimeSpace and Visual Editor.

In the following graphic we can see the navigation controls:
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Jog:  Allows  rapid  navigating  in  the  TimeSpace.  Thanks  to  the  activation  of  the
function mentioned, the movement  of the Jog communicates with the Visual Editor,
which is synchronized by selecting the shot where the monitor is active.

Backward Play, Stop and Play Forward: Controls playback of the TimeSpace.

Go Next/Prev: Navigates the TimeSpace frame by frame.

Go to the Start/End: Navigates to the beginning or end of the selected shot.

Next/Prev Frame: Navigates the TimeSpace frame by frame.

Wheel: Navigates only in the selected shot, without changing clip.

Loop: Activates/deactivates Loop mode when in Play.

Cut: Although mostly used in editing, this makes a cut  in the position of the Active
Monitor.

In, Out, In/Out: Inserts playback marks to specify the area we want  to Play. With
the Modifier Delete and the In/Out buttons, we can eliminate these marks.

Color Correction: General

Management of vectors

Before going into detail about the specific color correction functions, let's see how to
manage Color Grade vectors in the Precision Panels. This management is done via the

Transport Panel. In the following graphic we can see the main controls:
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To create a new vector, use the button CC. With the Modifier DELETE on, CC will delete the
selected  vector.  After  deleting  the  vector,  the  Modifier  DELETE  will  automatically  be
deactivated as a safety measure.

To navigate the vectors, use the joystick, either by rotating or pushing up and down.

The  Lyr  buttons  allow  navigation to  the  desired  vector  without  needing  to  pass  through
previous ones; for example, from Vector 1 (Lyr 1) to Vector 5 (Lyr 5).

Base allows us to go to the first vector always.

Inside/Outside

The Color Grade effect  allows different  corrections in a Vector by considering the Inside or
Outside of a mask if one is being used. There are several ways to choose whether we want
to work Inside or Outside:

By  Display:  all  the  Displays  related  to  the  Color  Grade  effect  have  a  button  for
selecting the Inside and Outside; this selection affects the remaining Displays  as  it
is a general color corrector parameter.

By  Joystick:  The  Trackball  panel  has  a  central  Joystick  with  many  functions.
Moving the joystick left to right switches between Inside and Outside.

Each  menu  of  Color  Grade  can  mute  the  Inside  and  Outside  related  to  each  tool.  The
controls are located on the respective Displays. 

Mute

To mute a vector, we must use the Byp All button, which will perform a general muting of a
selected vector. If  we want  to mute a specific  tool within  that  vector (such as  Primary),
we  will  use  the  corresponding  display  controls,  muting  the  Inside  or Outside  (or both)  as
required.
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Reset vector HiLgt

To reset  a vector use the button M Reset. If  we want  to reset  the whole  color corrector,
activate the Modifier Delete and click M Reset.

HiLgt

If we are using a Window/Shape or a selection by HSL, and want  to see what  this selection
affects, activate the HiLgt with the Show K button in the Trackball Panel.

Scopes

We can activate or deactivate the Scopes using the ABCD buttons with the CTRL Modifier.

 

Color Correction: Tools

All  the  parameters  and  menus  shown  in  this  section  are  a  representation  of  the  Mistika
interface itself with effect Color Grade, so the different tools are not  explained here. For an
in-depth explanation of the Mistika’s color corrector, consult the section Color Grade. 

Primary 

The  first  menu in  Tools  is  Primary.  As  we  can  see  in  the  graphic  below,  there  are  two
columns  with  different  functions:  on the  left,  White,  Gamma  and  Contrast;  on  the  right,
Gamma, Black, Levels.

As discussed previously, the menu on the left controls the functions of the upper dials, and
the menus on the right the lower dials. In certain cases, such as in Primary, there are dials
that  never change  their function,  in  this  case  All  Levels  and  All  Contrast.  The  remaining
functions affect the RGB of the image independently. For example, if  we activate White, we
see the  functions  White  R,  White  G and  White  B in  the  upper dials.  It  is  the  same  for all
other functions: Gamma will be Gamma R, Gamma G and Gamma B, and so on for the rest.

The Trackball  Default  in  Primary  controls  Black,  Gamma,  White  and  Levels.  Depending  on
the Modifier we activate, the functionality changes as follows:
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We must remember that  if  there is no mapping applied to the rings or balls when a Modifier
is activated, the last  mapped functions are used. That  is to say, if  we activate  CTRL,  the
first  ring  will  be  Level  All,  but  since  withCTRL  the  first  ball  does  not  have  an  assigned
function, the function that it takes as default is Black Color (the previous one).

Bands

The  Bands  menu works  the  same  as  the  Primary  menu.  We  have  two  lateral  menus  for
selecting the functions of the upper dials (left  column: Hue, White, Highlight  and Contrast)
and the lower ones (right column: Midtones, Shadows, Black and Saturation).

With the Trackball we have an important  detail: the interface of Mistika has 5 rings/balls (
Black,  Shadows,  Midtones,  Highlights  and  White),  while  in  the  panel  there  are  4.  So  the
Trackball default  in Bands is (from left  to right): Black,  Shadows,  Highlights  and  White.  To
access Midtones, we must activate the Enter Modifier, which is the Enter button to the left
of the Trackball panel (the other Enter works as a normal button, as we will discuss later).

Depending on the Modifier we have active, the functionality varies, as follows:
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Ranges

The Ranges menu pertains to Bands, so the parameters are the same, but  with controls of
the graphic always active in the left and right dials. The Trackball also behaves as in Bands.
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Fixed

The  Fixed  menu  differs  slightly  from the  others.  Unlike  other  menus,  the  buttons  in  the
columns do not follow the classic structure of left column  upper dials, right column  lower
dials.  In  fact,  each option (Hue,  Saturation  and  Luma)  affects  all  the  dials,  locating  the
controls for primary colors RGB above, and the secondary colors  (CMY)  below  (although in
this case the order is YCM, following the order in the interface of Mistika).

Depending on the Modifier we have active, the Trackball works as follows:

Color Correction: ISO

The  group  ISO  contains  all  the  selection tools  of  the  effect  Color  Grade,  including  some
important  functions  within  a  color correction workflow,  such  as  Snapshot  and  the  Canon
menu. The menus contained in ISO are: HSL, Filters, Windows, Snapshot and Canon.
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HSL

 

The  HSL  menu  controls  the  selection  modes  for  Hue,  Saturation  and  Luma.  The  control
system is the same as in other menus, selecting the functionality that  we want  to  control
the lateral columns of the display. As well as the typical functions of HSL, we have a group
of  common  filters  (grouped  in  Key  Filters)  we  can  use  without  needing  to  move  to  the
Filters menu.

The  HSL  menu  does  have  not  functions  in  the  Trackball,  so  it  maintains  the  previously
assigned functions.

There are a couple of important buttons within the selection functions:

HiLgt: As mentioned previously, if  we wish to view  our selection,  we  can activate
the HiLgt with the Show K button.

Key  Mode:  To  switch  between selection different  modes  by  Hue  (Proportional  or
Simple Hue-Sat), we  can use  the  Key  Mode  button to  cycle  through the  different
functions.

Reset: Although we can reset the selection values for Hue, Saturation and Luma by
pressing the related dials, to carry out a general reset  of each of the tools, we can
use a Modifier plus the Reset button as follows:
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Since  the  HSL display  is  linked  to  the  Select  menu,  we  can  see  other  related  functions,
such as managing  Keys.  The  controls  External Key,  Key  Source  and  Recover are  found  in
the Joystick of the Transport Panel, as follows:

Key Source: CTRL + Transport Panel Joystick Rotate changes the Key Source. CTRL
+ Joystick Down changes Key Channels.

External Key: SHIFT  + Joystick Rotate controls the External Key Source.  SHIFT  +
Joystick Up changes the External Key Mode. SHIFT  + Joystick Push D controls  the
External Key Channel.

Recover:  ALT  + Joystick Rotate  controls  the  Recover Source.  ALT  + Joystick  Up
controls the Recover Mode.  

Filters

The Filters menu groups all Color Grade effect  image filters, including  some  functions  such
as muting RGB, Luma  and  Chroma  channels  (Legalize  controls  are  in  development,  and  for
the moment can only be accessed through the interface of Mistika).
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The Filters menu is not  linked  to  any  interface  of  Mistika,  since  the  idea  is  to  be  able  to
control  the  filters  independently  of  the  user’s  current  menu  location.  In  fact,  the  Blend
parameter can be controlled at any time from the vertical TrackBall Panel wheel.

 

Filters has  no  functions  assigned  to  the  trackball,  so  it  maintains  the  previously  assigned
functions.

Window

The Window menu controls  the  system of  masks  and  Windows  of  the  Color  Grade  effect.
Although very similar to other displays, the Window menu is  different.  The  columns  on the
left and right are not related to the dials, and these always have the same functionality (for
more information, see Color Grade).

The column on the left selects the type of mask we want to use: 

Window: Line, Ellipse, Rectangle

Shape

We can also insert the masks from the corresponding physical buttons of the Trackball Panel
:
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In the right column, we activate the following functions:

Invert: Invert the mask selection.

Conv. Shape: Converts a Window into a Shape.

Insert Point: Enables the possibility of adding points to a Shape.

Anim. Autokey: Activates the Autokey mode for Shapes.

 If the Window Display is active, the Trackball acquires the following functions:

 No functions are assigned to active Modifiers

 

To  access  these  Trackball  functions,  we  so  not  necessarily  need  to  be  in  the  Window
Display.  To  make  working  with  Windows  and  Shapes  easier,  there  is  a  Layer that  can be
activated in the Shape button.

 

If  this  Layer  is  activated,  independently  of  where  we  are,  the  Trackball  acquires  the
functions of Window. Thus we can speed up our management  of masks. For example, if  we
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are working in Primary and we want  to move or adjust  a mask, we can simply activate the
Modifier in order to control the mask, and deactivate it again to regain control of Primary in
the Trackball.

 

Shape Track:

Another important Layer related to the Window display is Track. It  works in a similar way to
the Layer Shape but  with the difference that  it  affects  Play  controls  rather than those  of
the  Trackball.  If  we  want  to  Track a  Shape  simply  create  the  Shape,  confirm that  it  is
selected, select  the Track Layer,  and  Play  (Forward  or Backward).  If  we  have  more  than
one Shape we can select  one or another by rotating the central Joystick of the Transport
Panel (the same one used to  navigate  between Vectors  in  other Displays),  as  long  as  we
are in the Window display or have the Shape Layer active.

Snapshot

The Snapshot menu is very different  from other menus we have seen, mainly because as in
Window,  the  buttons  do  not  control  the  dials,  which  always  maintain  their  original
functionality.  Additionally,  in  the  case  of  the  Snapshot  menu,  the  buttons  correspond
directly  with  their  counterparts  in  the  interface  of  Mistika  (for  more  information,  see
Snapshot).

There are two major shortcuts related to Snapshots (as physical buttons):

Comp:  the  Comp  button  (in  the  Tablet  Panel)  carries  out  a  Selected  Snapshot
(reference shot, usually HeadB) 

Show: the Show button (in the Trackball Panel)  alternates  between two  Snapshot
modes. For example, if  we click on Show Live, and then on Show Snapshot, we see
first  the current  shot  (Live) and then that  of the Snapshot. From this  moment,  we
can switch between the two with Show.

We can control the  position  and  size  of  the  image  of  the  Snapshot  and  the  current  shot
using  the  dials.  If  the  active  display  is  that  of  the  Snapshot,  the  Trackball  acquires  the
following functions:
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Storyboard Navigation

When  navigating  in  the  Storyboard  we  have  two  main  controls.  Rotating  the  central
Joystick  of  the  Trackball  panel  controls  the  selection  of  the  Active  Shot;  rotating  the
Joystick of  the  Tablet  Panel  changes  the  Reference  Shot  (called  Selected  in  Mistika  and
usually linked to HeadB). With this in mind, we can center the Storyboard view in the active
shot or the reference shot by pushing the corresponding Joystick up. 

On the other hand, if we press the Joystick of the Tablet Panel, we interchange the position
of  the  active  shot  and  the  reference  shot;  if  we  press  the  Trackball  Panel  Joystick,  we
move the active selector to the position of the reference shot.

Related to both, there is a Lock next  to the calculator for locking the difference of position
between the active shot and the reference shot.
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Bring Functions 

To bring a color correction from a reference shot  we use the Recall button in the Trackball
panel. Here we also find the button Turbine, which manages the Bring Preview. Holding the
Turbine button down gives us a preview of the correction; we apply it by double-clicking.

With the Revert button we return to the original correction.

Save Histories

If we want  to keep a record of a correction, click on Enter, on the right. If  we repeatedly
click Enter we save different record of the same shot. Then we can browse the histories by
activating the Layer Vers. and rotating the Trackball Panel Joystick.

With the Modifier Delete we can remove histories that  we longer need by clicking the Enter
button (following the same pattern of use as that  for the creation or elimination of Vectors
with CC and Delete).
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FX Presets

In this section, not all the functions related to FX Presets are explained, only those
related to Precision Panels (for more information, see FX Presets). 

If we want  to save a preset  of a  color correction or of  any  other effect,  simply  click the
Save button.

 

We can view the stored presets in the FX Presets window which can be opened  using  the
Book M button. This only displays the window of presets, it does not offer control over it  for
browsing, importing, etc. To do this, we must  activate the Mems layer in the Tablet  Panel.
This  button  is  especially  important  because  it  changes  the  focus  of  attention  of  the
controls between the Storyboard and the FX Presets. Its  use,  therefore,  is  very  common.
To  explain  the  following  controls  related  to  FX  Presets,  we  will  assume  that  the  Mems
button is activated.

Navigation

 

Navigation is done by rotating the Tablet Panel joystick.

If we want to delete a preset, simply follow the usual sequence: Delete Modifier and in this
case click on Save, which is the button that creates the presets.
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Bring Functions 

If  we  want  to  bring  a  preset  to  a  particular effect  (usually  a  Color  Grade,  for  example),
simply  navigate  to  the  preset  and  follow  the  Storyboard,  and  click  on  Recall.  Another
method when importing a preset  is  the  Append  button,  which has  the  On Top  function of
the FX Presets window, and which basically locates the preset  above the current  stack of
effects added to the clip.

Temp. Memories

We  can save  certain  presets  as  Temp Memories  related  to  the  session  in  which  we  are
working. From Precision Panels up to 8 memories can be stored. Simply navigate the preset
to  be  saved,  activate  the  CTRL  Modifier,  and  press  the  number  we  want  in  the  number
panel of  the  TrackBall  Panel.  This  preset  will  be  saved  for this  session with  the  specified
number.  Thus,  if  we  click on that  number (without  CTRL  Modifier)  this  preset  is  brought.
This functionality does not need Mems activated in order to import the presets.

Animation and Keyframe Control

Mistika  has  several  Keyframe  systems  depending  on  what  is  being  animated.  We  have
already  seen an Autokey  in  the  Window  menu for  shapes;  however,  the  general  Autokey
(found in the Visual Editor) is the button A-Kfrm found in the Trackball Panel. Next  to this is
the button K Frm, which is used to insert new Keyframes.

If we want to use a dynamic in a Color Grade, the Keyframes In/Out are the most  common.
In this case, by activating the Modifier Dyn, the In/Out  buttons of the Transport  Panel will
control the insertion of this type of Keyframe.
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BTV Brighton & London:

BTV Post  is a cutting edge facility house leading the  way  in  HD and  3D.  Blending  creative
talent with advanced experience of technology, the company manages and delivers complex
workflows and projects to clients.

Das Werk Berlin:

PICTORION das werk GmbH is one of the  leading  post  production groups  in  Germany.  With
five  offices  across  the  country,  they  offer the  complete  range  of  digital  post  production
services.  Their  customers  are  advertising  agencies,  commercial  and  film  producers,  TV
broadcast stations and industrial enterprises.

Framestore London:

Framestire has been working in digital film and video for over 20 years, creating original and
astonishing work that has helped make it  the largest  visual effects and computer animation
studio un Europe.
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Hocus Focus Oslo:

Hocus  Focus  is  a  postproduction company  located  in  Oslo.  Established  in  1999  and  have
been using SGO Mistika from the very beginning. Hocus Focus  Prime  Focus  is  commercials,
documentaries, shorts and feature films.

Visor Studios Madrid:

With 25 years  experience,  Visor Studios  is  an excellent  production boutique,  to  tailor and
make reality any project in time and with the best quality of service.
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I-1 Glossary of Terms

3:2 Pulldown: A process consisting of dividing the original movie frames into fields (one with
the odd lines and other with the even) to obtain 48 fields (2x24), with which to create the
60 fields per second that  NTSC requires. This is done by repeating a  field  when necessary
(first  every  three  frames,  then  every  two,  then  three  frames  again  and  so  on,  and
alternating the field to be repeated between the odd and even ones). 

Antialiasing: An effect  that  softens the edges of an image for removing the tooth  effect.
High quality Antialiasing (as referred to in Mistika by the word “Antialiasing”) is not  based on
smoothing the existing edge by using a simple blur of the mask edge, but  rather it  uses the
edges of polygonal or vectorial objects and is based on the calculation for each pixel of the
percentage of their area that would be included in the polygonal or vectorial object, so that
the  pixel color is  not  simply  that  of  the  interior  or  exterior  of  the  object,  but  one  that
reflects  this  percentage.  Antialiasing  can  be  calculated  with  more  or  less  accuracy,
depending  on  the  number  of  samples  of  subpixels  that  are  taken  to  calculate  these
percentages. 

Aspect Ratio: Relation between the height and width of an image. 

Banding:  Band  effect  that  occurs  because  of  problems  of  color  depth  when  degrading
between neighboring colors in the color space. It  can be eliminated by using the  Bandither
effect. 

C-Black: When processing images originating in computer graphics that  were created on a
black background  with  a  mask,  the  color of  their  edges  tends  towards  black  because  of
antialiasing  with  the  black  background.  This  effect  can  be  combated  by  using  prior
multiplication of the mask by the image color before composing, a process which is called C-
Black. 

Cache:  Provides  fast  access  to  information  for  speeding  up  viewing  and  calculation
processes. 

Channel Alpha: Mask channel (see Mask). 

ClipBox: When converting movie material to NTSC or PAL the  original image  is  cut  on the
left and right. This process is called ClipBox. 

Chroma key: See Keying.

Animation curve: The curve resulting from the interpolation of the keyframes that  specify
the animation of a parameter. 

Dynamic Tracking: Process in which a VTR is capable of slowing down or accelerating the
video signal. 

Drag  &  Drop:  A  quick  and  easy  technique  for  copying  of  information  from  one  part  to
another part of the user interface. This tool works by selecting the object to be copied, and
with the left mouse button pressed, dragging it  to the place where it  is to be copied. Once
there, release the mouse button and the object will be copied to its target. 

The Drag & Drop technique controls the type of object copied so that, if  the position where
the object  is released for copying does not  accept  objects of  this  type,  the  object  is  not
copied. 

Foreground: The first (and frontal) element of a composition, 

Keyframe: The Keyframe concept is used in animation. To animate a parameter in time, its
value  must  be  specified  at  every  instant.  This  could  be  done  with  an  infinite  list  of
parameter  values  for  every  possible  time  value,  but  this  would  not  be  very  practical.
Therefore, the values of the parameter at  certain important  control points of the animation
are specified, and the intermediate points are the calculated by interpolation. These control
point values, which determine the whole animation, are called keyframes. 
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Keying: The process of generating mask information from the image contents. 

Letterbox: When movie material is converted to NTSC or PAL, the material is scaled so as
to view the entire image at  the desired size, with black bands that  appear at  the  top  and
bottom of the image. These black bands are called Letterbox. 

LUT: See LookUp Table. 

LookUp  Table:  These  are  color  index  tables  used  to  extract  the  desired  color  from  its
position in the  table.  This  technique  is  used  in  color palettes  to  extract  the  RGB color of
each position in the color palette. 

Mask: Grey tone image that  specifies the intensity to be applied to an effect  in each pixel
of the original image. Pixels that have a black mask are not  affected by the effect, and the
intensity of the effect increases to 100% corresponding to the pixels of a white mask. 

Morphing: Image interpolation or other warping techniques used on the original and target
images to achieve a more adequate transition. 

Motion Blur: Blur effect  produced in objects that  move rapidly. This effect  is  produced  as
the sampling of the capture system (video and movie cameras, etc) usually captures 24, 25
or 30 frames per second, so that each capture shows 1/24, 1/25 or 1/30 of a second. When
an object  moves at  high speed, it  will move a considerable  distance  in  these  times,  which
will produce a stump or blurring effect in them. 

Motion Tracking:  A  technique  permitting  the  specification of  the  path to  be  followed  by
one or several areas of a sequence for its later use. 

NTSC: Standard video signal used in America. 

PAL: Standard video signal used in Europe. 

Playback: Viewing of a video or audio sequence. 

Postscript: Vectorial file format. 

Point of control: See keyframe. 

RGB: Abbreviation of Red, Green and  Blue.  Refers  to  a  color specified  by  its  primary  color
components.

Shape: Also called vectorial objects or vector shapes. Vectorial figures produced with Paint
are included in this category. 

VITC: Acronym of Vertical Interval Time Code. Represents a timecode storage system that
allows current timecodes to be read without needing to have the tape in Play.

Warping: Image deformation technique achieved by animation of the position of the pixels. 

WYSIWYG: Abbreviation of “What  You See Is What  You Get”. Used on many occasions  to
reflect that what is seen on the screen, is the end result that will be obtained. 

YIQ: color space definition system used in the NTSC standard. The Y, I and Q components
are specified as follows: 

Y = 0.299R+0.587G+0.114B 

I = 0.74(R-Y)  0.27(B-Y) 

Q = 0.48(R-Y) + 0.41(B-Y) 

YUV: color space definition system used in the PAL standard. The Y, U and  V  components
are specified as follows: 

Y = 0.299R+0.587G+0.114B 

U = 0.493(B-Y)

V = 0.877(R-Y)
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Zbuffer: Map of depth of each pixel used to hide geometry that is not visible in 3D.
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